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1.1 Introduction 

 
in-edit  

 
Idea & overall design: Tom N1MM 
Overall programming: Tom N1MM 

Programming: John K3CT, Nick NA3M, Rick N2AMG, Steve N2IC, Terry AB5K, Andy 
KU7T 

Documentation/Help: Larry K8UT, Pete N4ZR, Rich VE3KI, Thomas PA1M 
N1MM Logger logo artist: Julio, LU5MT 

Testing and proposals: Members Yahoo groups - Thanks!!! 
 
This revised documentation is based on that for N1MM Logger Classic, which was 
initially released in wiki form in May of 2011, and is organized in three main sections:  

Table of contents 

 N1MM Logger Documentation  
 1. Getting Started  
 1.1 Introduction  

 1. Getting Started Description  
 2. Digging Deeper Description  
 3. References Description  

o 1. PC Requirements  

 1.1. Minimum Hardware Requirements  
 1.2. Supported Operating Systems  

 

1. Getting Started Description 

Getting Started is intended to guide the new user of N1MM Logger+, or a user making 
the transition from N1MM Logger classic, in chronological order to the point where 
he/she has a correctly installed version of N1MM Logger+ with basic logging 
functionality.  

The experienced N1MM Logger user may want to refer to 
((What's_New_in_N1MM_Logger_Plus|this page)) for a complete, window-by-window, 
function-by-function discussion of what's new and different in N1MM Logger+  



 

2. Digging Deeper Description 

The Digging Deeper section will provide in-depth information for configuring and 
operating N1MM Logger+, beyond what is covered in Getting Started. The information 
in Digging Deeper is arranged by topic areas.  

 

3. References Description 

The purpose of the Reference section is to provide a location for information not directly 
related to supporting the N1MM Logger+ software - but still information that users will 
find useful.  

1. PC Requirements 

1.1. Minimum Hardware Requirements 

Click Here for the section of Getting Started that describes the minimum hardware 
requirements.  

1.2. Supported Operating Systems 

 Windows XP SP3 - if you wish to continue to use Windows XP past the April 
2014 end of Microsoft support  

 Windows Vista 32/64  
 Windows 7 32/64  
 Windows 8 32/64  

 
Linux and other Operating Systems will not be supported.  

 

1.1.1 PC Requirements 

Table of contents 

 1.1.1 PC Requirements  

o 1. Minimum Hardware Requirements  
o 2. Supported Operating Systems  

1. Minimum Hardware Requirements 

http://n1mmplus.hamdocs.com/tiki-index.php?page=PC+Requirements


N1MM Logger+ incorporates the latest multi-threading technology, and will take full 
advantage of multi-core CPUs. It's difficult to set an absolute minimum configuration that 
will work under all circumstances. A single-core 1.6 GHz processor is probably the 
minimum required, but the CPU requirements depend quite heavily on which program 
options, modes, etc. are selected, so this may not be adequate depending on how you 
use the program. The program itself does not require a large amount of memory, but the 
more memory you have, the more smoothly Windows multitasking works.  

The recommended minimum graphical resolution is 1024 by 768 (SVGA), or 1366 x 768 
(720P) for wide-screen monitors, with many hams running higher resolutions and dual 
screens. At vertical resolutions of less than 768 pixels, like many netbooks, several of 
the larger windows will not fit entirely on the screen.  

Radio control can be done through serial ports or through a USB-to-serial adapter. CW 
keying, FSK RTTY and PTT can be done through serial or parallel ports, through a 
USB-to-serial adapter, or through K1EL's Winkeyer (an excellent solution which offloads 
CW processing entirely). For PTT with MMTTY, an extra serial port is needed. For 
AFSK, PSK31 and other modes requiring audio interfacing, the same methods 
described for phone interfacing can be applied.  

SO2R "boxes" may be controlled through a hardware LPT port under 32-bit operating 
systems or 64-bit operating systems. Alternatively, the MicroHam USB SO2R Control 
Protocol and the K1XM Open Two Radio Support Protocol are both supported, for use 
with devices that accommodate them.  

USB-to-serial converters and USB interface devices are supported through virtual serial 
ports provided by their associated driver software. USB-to-LPT converters cannot be 
used for either SO2R control or CW/PTT functions, except for the PIEXX SO2RXLAT  
(which is specifically designed for this purpose).  

For more information see the Interfacing section.  

2. Supported Operating Systems 

 Windows XP SP3 - if you wish to continue to use Windows XP past the April 
2014 end of Microsoft support  

 Windows Vista 32/64  
 Windows 7 32/64  
 Windows 8 32/64  

 
Linux and other Operating Systems will not be supported.  

 

1.2 Downloading the Software 

 1.2 Downloading the Software  

http://piexx.com/
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o 1. Download site  
o 2. Full Installer  
o 3. Latest Update  

1. Download site 

 
Download links:  

o Full Install: >Files >Full Install  
o Latest Update: >Files >N1MMplus Latest Updates  

 
To download a brief video tutorial on downloading and installing the N1MM Logger 
Classic program (the instructions for Plus are broadly similar), click the icon below  

 
Download video  

 
 
 

2. Full Installer 

Installing N1MM Logger+ for the first time requires that you download two files - the Full 
Installer and the Latest Update. Except during beta testing, he Full Installer file will 
change infrequently, whereas the Latest Update file changes often, sometimes more 
than once per week (daily during beta testing).  

Locate the Full Installer file on the download site under the menu selection >Files >Full 
Install. Save the file, named N1MM Logger+ FullInstaller [version number].exe, to 
your download directory or the desktop of your PC.  

× 

 You only need to do one Full Install! 

During beta testing, new Full Installers will be posted frequently. If the first part of the 
version number (initally 0.18) is the same on the latest Full Installer as it is on your 
already-installed copy of the program, you do NOT need to run the new Full Installer. To 
update the program, just download and install the latest Update. 

 

3. Latest Update 

Locate the Latest Update file on the download site under the menu selection >Files 
>Latest Update. Save the file to the same location where you saved the Full Install file. 

http://n1mmplus.hamdocs.com/tiki-index.php?page=Full+Install
http://n1mmplus.hamdocs.com/tiki-list_file_gallery.php?galleryId=15
http://n1mmplus.hamdocs.com/tiki-index.php?page=Video+-+Download+%26+Install#Video_Download_Install


(Exception: if the version number on the Full Install file is the same as the version 
number on the Latest Update, there is no need to install the Latest Update over the Full 
Install.)  

× 

 You only need one Latest Update file! 

Each Latest Update file includes the improvements and fixes from all of the preceding 
files. It is only necessary to download and install one Latest Update file — usually the 
most recent — to create a completely up-to-date version of N1MM Logger 

× 

 Filename Convention for Latest Updates 

The syntax for naming Latest Update files is N1MM Logger+ Update [version 
number].exe. The version number is in the format x.yy.zzzz, where x is a major revision 
number (initially 0, and likely to change only rarely), yy is the major version number, and 
zzzz is the minor version number. Changes to the major version number yy indicate that 
there has been a change in the system files needed to support the program. Update 
installers whose yy is different from the installed version's yy will not install over the 
existing version. Therefore any time yy changes, users will have to download a new Full 
Installer program with the new yy number and go through the Full Install process before 
updating. On the other hand, if the yy number on the current Full Installer is the same as 
the yy number on your already-installed copy of the program, you do *not* need to do a 
new Full Install; just download and run the latest update installer. The minor version 
number zzzz changes every time a member of the development team makes changes 
to the program. New update installers are not created every time this happens; 
therefore, there may be gaps in the zzzz numbers. This is not a problem; unless there is 
a specific reason to revert to an older version, just install the latest update (the one with 
the highest zzzz number). 

 

1.3 Installing and Upgrading N1MM Logger 
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1. First-Time Installation Instructions 

 
Please Note - These instructions apply both for first-time users and for experienced 
users of N1MM Logger Classic starting out with N1MM Logger+. Note that you can 
leave N1MM Logger Classic on your PC, and even continue to run it alternatively with 
N1MM Logger+. Just don't try to run the two simultaneously.  

1.1. Installing 

N1MM Logger+ has adopted the Windows convention for file locations, so you should 
be able to install program files in the default locations provided by the Installer: 
C:\Program Files for 32-bit systems, and C:\Program Files (X86) for 64-bit systems. 
Program files will be installed in one or the other as appropriate, and all user data files 
will be installed elsewhere. By default the user files location will be in your My 
Documents folder, in a sub-folder titled N1MM Logger+. We strongly recommend 
accepting the default locations, and installing for a single Windows logon. If you 
have to have more than one, your options are here.  

Here are the contents of the user data/user files folder:  

 

This folder is important, because the program looks in these sub-folders for support files 
that it needs - things like your stored message files, call history files, and so on. When 
created or modified by N1MM Logger+, files are placed in their correct folders, but if you 
want to move files from your N1MM Classic installation, you need to move them to the 
appropriate Document folder. Any .wav files used for SSB contests should be stored in 
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the Wav folder; if you use the {OPERATOR} macro for wave files in individual operators' 
voices, those wave files should be stored under sub-folders within the Wav folder titled 
with the operator's callsign.  

Be sure not to delete the four files below the folders.  

During a Full Install, the installer downloads so-called "prerequisite" files from 
the Internet. For this reason, please be sure you are connected to the Internet 
when doing a Full Install. Also, make sure that other programs that might be 
using system components that are part of the install (such as digital mode 
programs) are not running when you do the Full Install.  

× 

 Avoiding Security Problems During Installation 

N1MM Logger+ uses a number of .dll and .ocx files - for example, inpout32.dll is used 
as its interface to LPT ports, and n1mmv5wav.ocx powers the audio recording and 
playback functions. Various security provisions in Windows, as well as various after-
market security software, can prevent the installation or registration of these files.  
A few simple steps can work around these problems. First, download the Full Installer 
and Latest Update installers to a regular (non-temporary) directory on your hard drive. 
Then when you run the Full Install, right-click on the filename and select "Run as 
Administrator". This may be necessary even if your User account has Administrator 
privileges.  

Once you run the Full and Latest Update installers as an Administrator, the needed .dll 
and .ocx files should all be properly registered. If you are using the parallel (LPT) port 
for CW, PTT or antenna selection, you will also need to run the program itself for the 
first time by right-clicking and selecting "Run as Administrator", so that some internal 
file-shuffling can take place. This should not be necessary thereafter - just run as usual 
from a desktop icon or shortcut. 

1.2. Windows Settings that may affect program operation 

 
There are some default settings in Windows that can affect the way the program 
operates. To avoid problems, it is suggested that you change these settings. Note that 
these changes are in Windows, not in N1MM Logger+.  

The first has to do with USB hubs (ports). The Windows default behavior for USB hubs 
is to shut them down to save power after a period of inactivity. Unfortunately, the only 
activity Windows appears to be aware of is keyboard or mouse activity. A USB port that 
is being used for something else, such as a USB-to-serial adapter, looks to Windows as 
if it is inactive, and Windows shuts that USB hub down after a few minutes. This will 
cause the port to stop working, and if you go into the Configurer to make changes, the 
program will be unable to open the port when you exit the Configurer.  

The solution to this comes in two steps. The first is to open Device Manager, expand 
the section on Universal Serial Bus controllers, and then open each entry labelled either 



"Generic USB Hub" or "USB Root Hub", open its Properties dialog, select the Power 
Management tab, and uncheck the check box called "Allow the computer to turn off this 
device to save power".  

The second involves Power Options on the Control Panel. You will not necessarily find 
all of these settings on every system, but every system running N1MM Logger+ or any 
other logging software should be set to minimize Windows "power saving".  

Open the Control Panel and select Power Options. One of the "Plans" will be "High 
Performance" - select it. Then click "Change plan settings" and set "put the computer to 
sleep" to "never". If found, also select "Change advanced power settings" and set 
"Sleep | "Hibernate after" to "Never" and "Allow hybrid sleep" to "Off". In "USB Settings" 
set "USB selective suspend setting" to "Disabled" and under "PCI Express" set "Link 
State Power Management" to "Off". Also set "Wireless adapter Settings" to "Maximum 
Performance".  

These settings should prevent the computer from going to sleep, shutting down USB 
ports and disabling the network interface when it is plugged in - when you want to keep 
background tasks running.  

Here is another tip that has nothing to do with power management, and does not 
actually affect program operation, but may have an impact on your ability to find some 
of the N1MM Logger+ files. In Windows Explorer, under the Tools option, select Folder 
Options. Click on the View tab, and look down the list for a check box called "Hide 
extensions for known file types". The default for this option is checked, requiring you to 
identify file types by their icons alone. If you leave it at the default, you may have trouble 
finding files referred to either in the documentation or by people giving help instructions 
on the user group. If there are files with similar file names except for different 
extensions, you may have trouble telling which is which. Unchecking this option will 
make the full file names visible in Windows Explorer.  

Regarding Windows time settings, you do not have to set your computer to UTC in 
order to get UTC times in your log, though you can of course do so. If you set your 
computer to your correct time zone including the correct DST setting, set the computer's 
time to match your local time, Windows and N1MM Logger+ between them will take 
care of the rest.  

You can even operate straight through the daylight savings time switch in March or 
November (e.g. during Sweepstakes CW) and while you will see your computer's time 
display change by an hour at 2 am if you look closely, N1MM Logger+ will not skip a 
beat; it will log all of your contacts with the correct UTC time.  

1.3. Beginning the Installation 

These instructions are specifically for the first installation on a computer. See the 
section below on Installing the Latest Update for instructions on subsequent updates.  

Download the Full Install from the Files area on the n1mmplus website here.  

The full installer will be a file with a name in the form N1MM Logger+ FullInstaller 
x.yy.zzzz.exe . First, if you are running other programs that use the same system 
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components (including digital-mode programs like 2Tone and WinWarbler), shut those 
programs down. Now run the full installer program. Windows will give you the standard 
installation prompt asking whether you want to allow the program to make changes - 
answer "Yes". You should then see the following welcome dialog:  

 

Click on Next. You will be asked to agree to a straightforward freeware license:  



 

Click on Next. You will be given a choice of files to install. At the time of initial release, 
there is only one option, but at some future date other optional components may be 
added, and this dialog will be where you choose the options to be installed:  



 

N1MM Logger+ requires two separate installation locations. One is for the program 
itself, plus support files that are never changed except by the update installer. The other 
location is for all files that may be written to either by the program during operation or by 
the user, to store user-defined preferences and support information; these include the 
databases, ini files, error logs, function key message files, call history files, country files, 
super check partial files, wav files, qso recordings, user-defined contest (UDC) files, and 
so on and so on.  

The first location, for the program itself, defaults to C:\Program Files\N1MM Logger+ 
on 32-bit systems, or C:\Program Files(x86)\N1MM Logger+ on 64-bit systems. For 
99% of users, this default location is suitable and should not be changed. The dialog 
window in which this location is specified looks like this:  



 

The second location, for user-modifiable or program-modifiable files, defaults to a 
location inside your My Documents folder. In Windows Vista, Windows 7 and newer 
systems, this is at C:\Users\[Your Windows Username]\Documents\N1MM Logger+ 
(in Windows XP SP3, this would be C:\Documents and Settings\[Your Windows 
Username]\Documents\N1MM Logger+). For a typical single-user system, this default 
is appropriate, and even on multiple-user systems it is suggested that you accept the 
default for the initial install.  



 

When you click Install, the Full Installer will  

 Install all needed files on your computer to run N1MM Logger+  
 Update your system files where needed  

 
You will find that certain parts of the Full Installer installation routine take quite a long 
time. The installation program has not failed, so just let it run to completion. Subsequent 
updates are much faster. Once the installation has completed, you should see the 
following window:  



 

× 

 Do Not Overwrite Newer System Files 

When running the Full Installer your computer may report that certain system files are 
already installed on your system and are newer than the ones you are trying to install. If 
it asks if you want to replace a newer, existing file with an older file in the Full Install, 
select 'No'. You do not want to overwrite newer system files. 

 
After you click on the Next button, you will see the following window:  



 

The installation process requires that the computer be rebooted in order to finalize the 
installation of some system files (you should be familiar with this from Windows Update 
and from other program installation processes). This only happens with the Full 
Installer, not on incremental updates. Leave the "Finish and reboot the computer" check 
box checked and click on Finish. You will be prompted one more time to confirm:  

 

After the computer reboots, if this is the first time N1MM Logger+ has been installed on 
your computer, the installer will ask you to set up an initial empty database and enter 
your station information into that database. If the installer asks you to browse for the 
folder in which user files will be placed, make sure that this is the same folder that was 
specified as the User Files folder earlier in the installation process:  



 

The next dialog will ask you to create a new database. You will notice that this dialog 
also offers the option of converting an existing N1MM Logger Classic mdb database. 
Because there is a possibility that an existing database may have minor problems that 
don't stop it from working in Classic but may cause the conversion routines to stumble, it 
is strongly suggested that at this point you create a new database. There is a menu 
option in Logger+ to convert Classic databases to Plus which you can use later, but on 
the initial install it is safest to ensure that you have a known-good new empty database 
to work from.  

 

Choose the "Create new N1MM Logger+ database" option and click on OK. You will be 
presented with a new file dialog in which you can specify the name of the new 
database; the default file name is ham.s3db . You can change the "ham" to something 



else, but do not change the filename extension. Do not delete any of the three files that 
were placed there by the Installer; the program needs these files in addition to the new 
database you are creating.  

 

Finally, the program will present you with the Edit Station Information dialog:  



 

Fill in the information in this dialog. At an absolute minimum, you will need to fill in the 
Call box and the ARRL Section box.  

The Call box contains the station callsign that will be used for all contest logs in this 
database; this is the callsign that is output in every QSO line in exported Cabrillo files. It 
is also the callsign that is inserted into function key messages using the {MYCALL} and 
* macros.  

The ARRL Section box contains the ARRL/RAC section for stations in the US, US 
possessions and Canada; all other stations must fill in this box with the letters DX . This 
box is used in many contests, not just ARRL contests, so even if you don't plan to enter 
any ARRL contests you should fill it in.  

If you want the program to display correct beam headings to stations you work, you 
should also fill in the Grid Square box with the correct grid square for the location you 
are operating from. Doing so will automatically fill in your Latitude and Longitude; 
alternatively you can fill in the Lat and Long and the program will compute your Grid 
Square.  



The name and address boxes are output in the header of Cabrillo files, so it is 
recommended that these be filled in as well. Note that this is your mailing address, not 
necessarily the address from which you operate.  

The Club box denotes the club towards which your scores will be counted in club 
competitions in those contests that support this.  

Once your station information has been entered and stored in the database, the initial 
installation process is complete.  

1.3.1. Installing the Latest Update 

After you have completed the initial install, you should go back to the n1mmplus web 
site and find the update file for the latest version you find there. The updated version 
installer will have a file name in the form N1MM Logger+ Update x.yy.zzzz.exe . If the 
version number zzzz is different from (higher than) the version number of the full (or 
your most recent) install, you should download this file, start it, and follow its simple 
steps (essentially the same as the first few steps of the full install process) to get fully up 
to date. The update will take a much shorter time to install than the full install did.  

Note that updates are cumulative; you do not need to install all of the updates you find 
on the web site, just the latest one. During the initial beta testing phase, new update 
installers will be uploaded frequently (probably daily, at least initially). Always make sure 
you have the latest update installed before reporting bugs or problems.  

There may also be new full installer versions uploaded frequently during beta testing. If 
there is a new full installer with a newer version number than the one you originally 
installed, but the first part of the version number (the x.yy part) is the same as before, 
you do NOT need to download or run this newer full installer. Just download the update 
with the new version number and run it. The only time you need to run a new full 
installer after the first time is when the first part of the version number (x.yy) changes.  

× 

 A Note on N1MM Logger+ Version Numbers 

The version number for N1MM Logger+ releases contains three components x.yy.zzzz 
(as in 0.18.3241). The first component, x, denotes major program revisions or status 
changes (e.g. "production" vs. "beta") and is not expected to change often. The second 
component, yy, denotes a major update level. When you are doing updates, the "yy" in 
the update installer must agree with the "yy" in the already-installed version. If yy has 
been changed, you will have to go through the Full Installation process again with a new 
Full Installer before you can install updates with the new yy version number. The third 
number, zzzz, is the minor update number. This number may change as often as 
several times in a single day as members of the development team make changes. 
There will not be a new update installer created every time this number changes, so 
don't be surprised if the numbers on consecutive updates differ by more than 1. 
Changes at this level are always cumulative, i.e. you don't need to worry about 
intermediate updates, just download and install the latest update (highest minor update 
number) over the existing program, as long as the major update level is the same. 



1.4. Using the Program the First Time 

1.4.1. Edit Station Information 

The first thing to do after starting the program is to enter your station information if you 
have not already done so. This dialog will open automatically with your first launch of 
N1MM Logger+. For subsequent changes, select Change Your Station Data from the 
Config menu in the Entry window.  

Your Station Data dialog will be similar to this one. Note: a "dialog" is simply a 
window in which you can enter information. The term is often used 
interchangeably with "window".  

 

The information in this dialog is self-explanatory, but it is very important that it be 
accurate. The ARRL Section is used to distinguish between in-state and out-of-state 
status for QSO parties, and between W/VE and DX in a number of ARRL contests. CQ 
and ITU zones are essential for some contests. Your full mailing address is inserted in 
the Cabrillo file header, and tells contest organizers where to send your certificate. In 
order for the program to calculate accurate beam headings, you will need to put your 
longitude and latitude into the appropriate textboxes; you can do this simply by entering 
your grid square into the grid square box.  



Also make sure that you enter your call as the station call sign, as this will be the call 
sign that appears in every QSO line in your Cabrillo files. Don't leave any example 
entries that may be in these fields at start-up.  

Many of the textboxes in this dialog are used when creating contests or during contests.  

 ARRL Section and State textboxes are used in some contests and QSO parties 
to determine if you are in or outside a state or province. Non-US/VE stations 
should enter "DX" here.  

 Latitude and Longitude are used to calculate the distance and bearing to 
another station/country (for HF contests)  

 For VHF contests (those with VHF in the contest name) the Grid Square 
textbox (4 or 6 digit) in the Station dialog is used to determine bearings, rather 
than latitude and longitude.  

 Contents of the Latitude and Longitude textboxes update when the Grid Square 
textbox is changed and vice versa.  

 Club normally has to be spelled out completely in order for it to be accepted by 
contest organizers in contests with a club competition, so for example enter 
Yankee Clipper Contest Club rather than YCCC.  

 

2. Adding Users 

This seemingly innocuous title actually addresses an area in which there are fairly 
significant changes from N1MM Logger Classic, in particular because of the adoption of 
Windows user file storage standards, described above. Because user files are linked to 
the log-on username currently in use, User A's files - not just databases, but all the 
types of files stored in the My Documents folder - will not be seen when User B logs 
onto the computer under a different Windows user name, or by using the Windows 
"Switch User" command. There are a number of ways of dealing with this:  

 Use one Windows logon identity for all operators, and use the OPON (Ctrl+O) 
function to identify the operator for any given operation. This way all of the user 
files will be shared, except for the .wav files used for stored phone messages, 
which will follow the operator's callsign. Operators can set up individual Window 
layouts with the Tools > Save Window Positions and Restore Window Positions 
functions. If desired, operators can also set up their own databases and switch 
manually from the File menu. This is the method that will be most familiar to 
users of N1MM Logger Classic.  

 Use individual Windows logon identities for each operator. When the new 
operator runs N1MM Logger+ for the first time, it will create a new user files area 
for the Logger in that user's My Documents folder. During the process, it will ask 
the user to create a new database and enter the station data. Once this has been 
done, each operator is free to edit anything in their personal user files area to 
suit. However, the new operator will not have access to any of the databases 
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created by other operators under separate logons. In effect, each user will have 
their own independent copy of the Logger, except that all of them will always 
have the same version of the program.  

 Use a shared document folder for user files for all logon identities. This method 
can be combined with the previous one. You can do this by creating a copy of the 
initial user file area in the first user's Documents folder in a publicly-accessible 
location. In Windows 7, 8 and 8.1, the logical location to do this would be 
C:\Users\Public\Documents\N1MMLogger+. In Windows XP, it would be 
C:\Documents and Settings\All Users\N1MMLogger+. Once this user file area 
has been created, all users on that computer will have access to it. Each user 
can then set up a second desktop icon for the program that uses a command-line 
option to allow the program to use a user file area that is different from the initial 
user-specific area. With a setup like this, users can choose either to use their 
own individual file areas or to use the shared user file area simply by choosing 
which desktop icon to run the program from. This is described in more detail in 
the Digging Deeper part of the manual.  

 

3. Subsequent Installation of the Latest Update of the Software 

× 

 Update philosophy 

Many of us are used to always being "one version behind" in the software we use, in 
order to avoid bugs that may have been introduced in the latest version. But because 
N1MM Logger+ is updated frequently, the opposite is true. You are always encouraged 
to use the latest version — in general, bug reports and feature requests should only be 
made after checking to make sure the latest version does not already include the bug fix 
or feature that you want, and also after checking the user group to see whether the 
request has already been made by someone else (please refrain from "me too" posts 
and requests). 

When it is started, the Logger checks the web site for new versions. If a new version 
has been released since the last time the program was run, the program will offer to 
download and install the newer version. It is not necessary to accept the offer, although 
it is recommended that you do so. This check will only be done once per new version, 
i.e. if you do not accept the offer to download and install a new version, you will not be 
informed again about that version. The next offer to update will be displayed only after 
an even newer version has been made available.  

An e-mail will also be sent out periodically to announce new versions (updates) of the 
program to the Yahoo reflector members. If you wish to do an update manually, 
download only the Latest Update installer. Use the link contained in the announcement 
e-mail to the Yahoo group, or open this web page  and select the update you want. If 
you have not updated for a while, you do not need to install any of the intermediate 

http://n1mmplus.hamdocs.com/tiki-list_file_gallery.php?galleryId=15


versions - just go right to the latest. The only exception might be updates that are 
marked as "Experimental" or otherwise explicitly marked as not for general use. These 
are very rare.  

The Latest Update installer contains the latest .exes and other necessary files. Run this 
installer and it will quickly overwrite any old versions in the program directory.  

Note that it is usually not necessary to run a new Full Installer. The only time this is 
necessary is when the major version number (the x.yy part of the x.yy.zzzz version 
number) changes. If the only change in version numbers is in the minor version number 
(the zzzz part), simply runnning the latest Update installer is all you need to do to 
upgrade to the latest version.  

If you attempt to run an update installer whose major revision number is different from 
the previously-installed version on your computer (e.g. if the installed version number on 
your computer is 0.18.zzzz and the version number of the new update installer is 
0.19.zzzz), you will see a message similar to the following:  

 

If you see this message, download the latest Full installer and install it. You do not need 
to uninstall the previous version; the new full installer will overwrite any old versions that 
need to be updated. After the full installer has run, you will be asked to restart your 
computer in order to complete the process of updating system files; this only happens 
with the full installer, not with normal updates using the latest Update installer. After the 
full install has completed and your computer has been restarted, you may proceed to 
install the latest update if its minor revision number is different from the minor revision 
number of the full installer you just ran.  

4. Moving N1MM Logger+ to a New Computer 

The easiest and best approach is simply to run the Full Installer and Latest Update to 
install the program on the new computer. Now copy your My Documents\N1MM 
Logger+ folder and subfolders from the old machine to the same location on the new 
one. Overwrite any "starter" versions of files and folders that are already there.  

We recommend deleting or renaming your old N1MMLogger.ini file, so that the 
program will create a new one. You can try it, but you will probably find that your old .ini 
file won't work properly, because port numbers, port addresses, sound card numbers 
and other hardware-related items in the .ini file will probably be different on the new 



machine. It is a lot easier to make those changes in the Configurer than using Notepad 
and editing the old.ini file.  

5. Moving Data from an N1MM Logger Classic Installation to N1MM 

Logger+ 

As mentioned above, N1MM Logger+ stores all user-created data, including databases, 
Function key message files, .wav files, Call History files, and User Defined Contest files 
in the N1MM Logger+ Documents folder. You will need to copy each type of file to the 
appropriate folder from wherever you were storing them in N1MM Logger Classic.  

Since N1MM Logger+ uses an entirely different database scheme, there is an option on 
the File menu in the Entry window to import and convert databases for use with N1MM 
Logger+. Click on Convert N1MM database to N1MM Logger+, select your old 
database, and a converted version will be placed in the right folder, ready for use. This 
only applies to databases, though - configuration information that was stored in N1MM 
Logger.ini cannot be converted automatically. You will have to configure these items 
using the N1MM Logger+ Configurer. Some other supporting files, such as function key 
message (.mc) files, User Defined Contest (.udc) files, Call History files, etc. will work 
directly; you can simply copy them from our N1MM Logger Classic program folder and 
copy them into the appropriate subfolder in the N1MM Logger+ user files area.  

× 

 Converting Old N1MM Logger Classic Databases 

There have been various changes to the N1MM Logger Classic database structure over 
the years. N1MM Logger Classic contained code to update its databases automatically 
if an older database was opened with a newer version of the code. This automatic 
upgrading code was not incorporated in the database conversion routines in N1MM 
Logger+. The only database format supported in the conversion routines is that 
used in N1MM Logger Classic version 14.0.0 (and newer). Therefore, if you wish to 
convert a database that was created in an older version of N1MM Logger Classic and 
that has never been opened by a program version 14.0.0 or newer, you need to perform 
the conversion in two steps: 1. Open the database in N1MM Logger Classic version 
14.0.0 or newer and then close N1MM Logger Classic (this will automatically update the 
database structure); and 2. Use the N1MM Logger+ File menu option mentioned above 
to convert the updated database to the .s3db format used by N1MM Logger+.  
 
Another common situation - you have more than one database in Classic, and 
you want to save them all together in one N1MM+ database. This detailed 
explanation from Rich, VE3KI:  

For safety, first shut down N1MM+ and make a backup copy of your existing N1MM+ 
database. It's in My Documents\N1MM Logger+\Databases, with the name you gave it 
when you converted it. The file extension will be s3db - for example, ham.s3db or 
Contests2014.s3db, or whatever you called it.s3db. There will also be some other s3db 
files in the same folder - just leave them alone.  



Start up N1MM Classic. Open the Classic database you want to convert. Do the 
following steps for each contest in that database: Open the contest and do an export to 
ADIF. Do not try to short cut by exporting all the contests at once. Each contest 
has to be exported separately so that it will have the correct Contest_ID in its ADIF file, 
and so it can be imported separately into its own contest instance in the N1MM+ 
database.  

Now close Classic and open N1MM+. Create a new contest in your database for the 
first one you exported from Classic. The contest type must be the same as it was in 
Classic. Set the start date and time correctly for that contest so you can tell contests of 
the same type apart in the new database. Once the contest is set up correctly, do a File 
> Import from the ADIF file. Use Tools > Rescore Current Contest to update the score 
for that contest. Repeat these steps for each of the other contests you exported. All of 
your contests should now be in the one N1MM+ database.  

6. Uninstalling the Program 

If you are thinking of uninstalling and reinstalling the program in order to fix a problem 
you have encountered, you should know that this is rarely the solution. The majority of 
problems encountered by users are configuration problems that are not resolved by 
uninstalling and reinstalling. If the problem is a configuration problem, uninstalling and 
reinstalling in the same location will not fix it. Instead, try looking at the Troubleshooting 
section, where you will find suggestions for other, less drastic methods.  

However ... if you really want to uninstall N1MM Logger+ entirely, including any registry 
entries, the best way is to navigate to the program directory and find the program 
cleverly titled Uninstall.exe. with the N1MM Logger+ icon. Run the uninstaller and 
follow any prompts you see. Note that this will not remove your user files area. If you 
want to remove all traces of the program, you will need to remove this folder as well.  

 

1.4 Digital Installation and Setup 

 1.4 Digital Installation and Setup  

o 1. Need-to-Know about Setting Up for Digital Modes  
o 2. Setting up N1MM Logger+ for Digital Modes  

1. Need-to-Know about Setting Up for Digital Modes 

In order to communicate in digital modes (RTTY, PSK, or other sound card digital 
modes), N1MM Logger+ can either use a computer sound card or an external device 
called a "terminal unit" or a multi-mode TNC. Terminal units and TNCs are relatively 
rare nowadays, and most digital communications now use a computer sound card.  

The Logger uses the sound card for digital modes via a separate process called the 
"digital engine". One digital engine, MMVARI, is pre-loaded when N1MM Logger+ is first 
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installed. MMVARI can do RTTY, PSK31, PSK63, and a few other digital modes that 
are not often used in contests. The Logger also supports several other digital engines, 
including MMTTY, 2Tone and Fldigi, but these engines are not pre-installed; they must 
be downloaded and installed separately. MMTTY and 2Tone can only be used for 
RTTY, whereas Fldigi supports a wide range of digital modes, most of which are not 
used for contesting.  

Configuring a digital engine is done within N1MM Logger+ in a few places, including the 
Configurer (Config >Configure Mode Control, Audio, Other) as well as in the Digital 
Interface window. The digital engines (MMVARI, MMTTY, 2Tone and Fldigi) also have 
their own configuration menus that need to be set up. If you are familiar with digital 
modes and are moving to the Logger from some other program, you might want to 
proceed directly to the setup instructions in the sub-sections below. If you are new to 
digital modes, you can find more information on RTTY and PSK in the General RTTY 
and PSK Information page in the Digging Deeper part of the N1MM Logger+ manual. 
RTTY is particularly complex for someone coming to it for the first time; there is an 
excellent introduction to RTTY on AA5AU's web pages  that is recommended reading 
for anyone starting out in RTTY.  

A few notes about hardware connections for sound card digital modes (using MMTTY, 
2Tone, MMVARI or Fldigi) follow. These depend on the radio, the sound card and the 
interface (if any) in use, and it is impossible to cover all of the possibilities in detail, but 
the following general comments apply:  

First, you must have some means of connecting the radio's audio output to the sound 
card's input. The ideal connection would be from a fixed-level ("line out") output on the 
radio to a "line in" input on the sound card. If your radio has one receiver, this will 
probably use the left channel of the sound card; with dual receivers, the second receiver 
may use the right channel. If your sound card does not have a line level input, you may 
need to use a microphone input, and in this case you may need an attenuator to reduce 
the line level output from the radio to the lower level needed for the microphone level 
input on the sound card.  

To transmit, there must be some means to convey modulation from the computer to the 
radio. For FSK RTTY, this is an on-off keying signal, which is normally generated by a 
serial port connected to the radio's FSK keying input through a simple keying circuit. 
This serial port cannot be the same port that is used for radio control or for a Winkeyer 
or other serial device. If it is a standard USB-to-serial adapter, FSK from MMTTY will 
require the EXTFSK or EXTFSK64 plugin. If you are using MMVARI for RTTY using 
FSK keying, select the appropriate plugin (FSK8250 for true serial ports, EXTFSK or 
EXTFSK64 for USB-to-serial adapters) in the Configurer under the Digital Modes tab). 
Fldigi can only do FSK keying with the help of an external circuit that converts the audio 
signals from these programs into an on-off keying signal.  

For AFSK RTTY and for all other sound card digital modes (e.g. PSK31), there must be 
a connection from the sound card's output ("line out", or speaker or headphone output) 
to the radio's audio input. If the only audio input on the radio is a microphone input, you 
may need attenuation to reduce the level to avoid overdriving the transmitter.  
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You also need some means to control TX/RX switching (PTT). The most common 
method is to use hardware PTT control from a serial or parallel port via a simple keying 
circuit. Hardware PTT can be controlled either from the digital "engine" (MMTTY, 
MMVARI or Fldigi), or from N1MM Logger+ itself. To use serial port PTT from the digital 
engine, you must use a different port from the one that is used by the Logger for radio 
control. If you have a serial port set up for FSK keying, you can use a control line (RTS 
or DTR) on this same port for PTT control from the digital engine.  

If you do not have a separate serial or parallel port available for PTT in digital modes, 
you can control PTT directly from the Logger. For example, if your radio control 
interface supports PTT using RTS or DTR on the radio control serial port, you can 
configure the Logger to use this method. If no method of hardware PTT control is 
available and if your radio supports PTT via radio command, you can use software PTT 
control from the Logger. Warning: Using both software and hardware PTT control at the 
same time can cause problems; do not use both methods in parallel.  

As an alternative to hardware and software PTT control, you may be able to use VOX. 
This does not work with all radios, it cannot be used for FSK RTTY, and setting of audio 
levels and VOX triggering levels can be tricky, but some users have found this to be the 
simplest method of PTT control, since it does not require any additional hardware 
connections. Some external interfaces (e.g. SignaLink) perform a VOX function external 
to the radio, i.e. they generate a hardware PTT signal based on the presence of an 
audio signal without any connection to a serial port on the computer. If you are using 
such an interface, or VOX within the radio, you do not configure any PTT in the Logger 
or in the digital engine, as PTT control in these cases is external to the software.  

2. Setting up N1MM Logger+ for Digital Modes 

First, make sure you are familiar with basic operation of N1MM Logger+ in CW and 
SSB. It's not a good idea to try to use the program in digital modes if you aren't familiar 
with at least the basic operation of the program.  

Once you are ready to begin, decide which digital engine(s) you want to use - an 
external TU/TNC, MMTTY, 2Tone, MMVARI or Fldigi. One of these (MMVARI) is built in 
to the Logger, but the others all will need to be downloaded. Each digital engine used by 
the Logger stores its configuration information in the directory the engine is run from. 
For that reason, you should create a separate directory for each copy, separate from 
the directory you use when you run it stand-alone or from some other logging program. 
If you use more than one copy of a digital engine (for example, for SO2V or SO2R, or 
for additional RX-only windows), you need a separate directory for each copy. For more 
detailed information, check out the sections on Downloading and Installing 
MMTTY/2Tone/Fldigi in the Digging Deeper part of the manual  

After these preliminaries, start N1MM Logger+ and open the Configurer (Config > 
Configure Ports, Audio, Mode Control, Other). Make sure the Hardware tab is 
selected (this is the tab the Configurer starts up in by default).  
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In what follows, it is assumed that you already have radio control, CW keying and PTT 
control configured and working, and what you are trying to do is add in the capability for 
digital modes.  

In many cases, especially if you are planning to use AFSK, you will already have PTT 
control configured from the Logger. If the same method you use in other modes is 
acceptable for digital modes, you don't need to do anything special about PTT for digital 
modes. If you are planning to use FSK for RTTY, you will be setting up a serial port for 
FSK keying from within the digital engine, and you can use that same serial port for PTT 
control in RTTY. If you are using VOX (or an external VOX such as a SignaLink), you do 
not need to configure PTT control in the Configurer.  

All that being said, there are two cases where you need to do something about PTT 
control for digital modes in the Configurer. The first is if you plan to use MMVARI as 
your digital engine, and you want to use a control line from a serial port for PTT control. 
In that case, you must designate that serial port in the Configurer, check the Digital 
check box for that port, set the appropriate control line (DTR or RTS) for PTT, and set 
the DigWndNr to 1 (or 2, for the second DI window in SO2R/SO2V). The second case 
occurs if you are using a single serial port interface for both CW/PTT keying in 
CW/SSB, and also for FSK keying in RTTY. In that case you must check both the 
Digital and CW/Other check boxes for that port, configure DTR and RTS for CW/SSB, 
and set the DigWndNr to 1 (2 for the second DI window in SO2R and SO2V).  

Next, you need to select the Digital Modes tab in the Configurer. First, set the TU Type 
to Soundcard (unless you happen to be using a hardware TU/TNC). If your main digital 
engine is MMTTY or 2Tone, then under DI-1 MMTTY Setup, select AFSK or FSK as 
appropriate for your setup and set the MMTTY Path to point to the copy of MMTTY.exe 
or 2Tone.exe you will be using with the Logger. If you will be doing SO2V or SO2R, 
repeat for a separate copy of the digital engine under DI-2 MMTTY Setup. If you will be 
using Fldigi, there are separate places to enter the paths to Fldigi.exe. For all of these, it 
is recommended that you do not try typing in the path directly. Instead, click on the 
Select button, which opens a standard Windows file Open dialog window, and then 
navigate till you find the desired .exe file and select it.  

Once the paths to the digital engines are set up, select the Mode Control tab in the 
Configurer. On the right side, beside RTTY, set the Mode sent to radio - this should be 
RTTY if you are using FSK, but if you are using AFSK, it should be either AFSK (if your 
radio offers a separate mode for AFSK RTTY), LSB (for most radios with MMTTY or 
2Tone), or USB (for Fldigi).  

This completes the basic steps in the N1MM Logger+ Configurer. For more detailed 
explanation of the various options available, see the Configurer section of the manual.  

Back in the main Entry window, if you have not already done so, choose a contest type 
that allows digital modes (i.e. not a CW- or SSB-only contest), and set the Mode 
Category in the Contest Setup window to one that includes RTTY or Digital (don't 
choose MIXED - that's for CW+SSB only; choose MIXED+DIG instead). Type RTTY into 
the call sign box and press Enter. This should open the Digital Interface window. If it 
does not, use the Window > Digital Interface menu item to open the Digital Interface 
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window (in SO2R/SO2V, each Entry window has its own Digital Interface window that 
opens from that Entry window's menu). If your preferred digital engine does not open 
(e.g. if you see the MMVARI window when you wanted MMTTY), then in the Digital 
Interface window use the Interface menu item to switch to the digital engine you want to 
use (use the MMTTY menu setting for both MMTTY and 2Tone).  

Select the Setup > Settings menu item in the Digital Interface window. Under Preferred 
RTTY Interface, select your preferred digital engine. Under Alignment Frequency, enter 
your preferred Mark audio frequency (e.g. 2125 Hz). If you are using MMTTY, then 
under MMTTY Window Settings, select either Normal or Control Menus, in order to 
have easy access to the MMTTY setup window. When you have completed the setup in 
the Digital Setup window, click on Save Configuration.  

There are a host of other options in the Digital Interface and Digital Setup windows. A 
complete reference manual for the menu options in the DI window, the Digital Setup 
window and the main DI window is here.  

You're not done yet. Now you have to complete the configuration inside the digital 
engine itself. This is especially important for FSK, since the configuration of the FSK 
port is carried out inside the digital engine, not in the N1MM Logger+ program. There 
are separate chapters in the Digging Deeper part of the manual for MMTTY, MMVARI, 
Fldigi, and TNCs/TUs. There are too many possibilities to cover here, so consult the 
chapter(s) appropriate to your situation and complete the setup as described there.  

 

1.5 Interfacing Basics 

in-edit  

 1.5 Interfacing Basics  

o 1. Operating without an Interface - Manual Mode  
o 2. Basic Radio Control Interfacing  
o 3. Interfacing for Phone, CW and PTT  

 3.1. Phone Interfacing  

 3.1.1. Interface Hardware  
 3.1.2. Trouble-shooting phone interfacing  

 3.2. CW Keying and PTT Control  

 3.2.1. CW Messages  

1. Operating without an Interface - Manual Mode 

There are many reasons why you could find yourself operating in manual mode. Maybe 
you're just getting started and have not had time to install and configure an interface? 
Perhaps your radio does not support PC integration, or you have a computer but it lacks 
the necessary I/O ports to connect a radio? Or maybe you're operating from a short-
term portable location and don't have the time or equipment to connect the radio to the 
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computer? Whatever the reason, there are special keystrokes that you need to enter in 
the Entry Window to inform N1MM Loggger+ of the band and mode that you are 
operating.  

Set your frequency by typing it into the Callsign textbox and hitting Enter. If you want the 
log to only indicate the band, and not specific frequency information, enter the 
frequency of the bottom of the band in kHz (note that some contest administrators 
request that manual frequency entries always be bottom of band). If you want the log to 
include the actual frequency, enter the complete frequency in kHz. For example 
14025.1 (or 14025,1 if your computer uses comma as the decimal separator). The new 
frequency will appear in the title bar of the Entry window.  

Enter mode changes similarly. Recognized entries are CW, RTTY, PSK and SSB, USB 
or LSB. If you enter SSB, the program will substitute the customary sideband (e.g., LSB 
on 40-160) USB and LSB can be used to enter the opposite sideband, should you ever 
need to. The mode to be recorded in the log is displayed in the title bar of the Entry 
window.  

For more details about these commands, see the Entry Window Text Commands in the 
Digging Deeper section of this documentation.  

2. Basic Radio Control Interfacing 

in-edit  

Regardless of whether you want to operate phone, CW or digital modes, the most 
useful and important interface is the one between your computer, N1MM Logger+ and 
your radio. Fortunately, virtually all modern radios incorporate a serial port to enable 
them to swap information and commands with the computer.  

A first step is to look up your transceiver in the manual section titled Supported Radios. 
Assuming you find your radio there, look for any specific settings or peculiarities that 
need to be addressed and make a note of them.  

USB is rapidly replacing both RS-232 serial ports and LPT parallel ports. If your radio 
has a standard RS-232 serial port, once you have purchased a USB-to-serial adapter 
and installed the drivers for it, N1MM logger can work with your radio just fine. If your 
radio uses either Icom's CI-V standard or another non-RS-232 serial port, you'll need an 
appropriate converter cable to get from either USB or RS-232 to your radio.  

Some USB adapters, particularly those using a Prolific chip-set, are erratic with some 
programs, particularly programs written in Visual Basic (like N1MM Logger Classic). If 
you encounter quirky performance or an 8020 error, that may be why. See the Error 
Messages section of Digging Deeper for details on this error, and USB Interface 
Devices for a full rundown on user experience with various specific adapters.  

Radios are starting to appear now with USB ports. If yours is one of these, check the 
Supported Radios entry for your radio (and the radio manual) to find USB interfacing 
details.  
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See this earlier section for information on avoiding problems with USB ports going to 
sleep.  

Once you have the hardware hooked up between your computer and your radio, start 
N1MM Logger+ and open the Config menu in the Entry window. Choose Configure 
Ports, Mode Control, Audio, Other. Ignore all the other stuff for now.  

That brings up the following, rather intimidating dialog. Don't worry, we'll walk you 
through the part you need now.  

 

You may want to select SO1V if this is your first experience with N1MM. SO1V allows 
N1MM to control VFO A in your transceiver. If you are an experienced contester and 
understand how to operate in split mode (for example, working DX on 40 meter 
sideband), and especially if you have a radio with dual receivers, you may want to 
select SO2V. It allows N1MM to simultaneously control both VFO A and VFO B in your 
transceiver. If you are an advanced contester, whose station is configured with TWO 
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transceivers (one for running contacts and the other for searching for new multipliers), 
then you will want to select SO2R.  

One of the advances in N1MM+ is that you can use any COM port numbered 1-99. Click 
the drop-down arrow to the right of the Port column, and you will see all the serial ports, 
hardware or USB/virtual, that are active on your PC. Select the one that is connected to 
your radio. Now click the drop-down arrow to the right of the Radio column, and select 
your specific radio model. Virtually all Kenwood models use the one common radio 
configuration, while Yaesu and Icom radios are generally designated by the specific 
model number - refer to the manual under supported radios for more information. Icom 
radios also require a Radio Address (Hex Code) - that's in the same place.  

Now click the "Set" button next to the port you have chosen.  

 

That will bring up this dialog, with connection details. Normally, N1MM Logger chooses 
the parameters in the first two rows for you, and does a good job. You might want to 
verify them with your radio manual, just in case. Radio/VFO number should be 1, so that 
your main VFO will be displayed in the main (first) entry window. The rest of the stuff on 
this dialog is not important right now, so just click OK to get back to the previous dialog, 
and then OK again to return to the Entry Window.  

If all is well (you did turn your radio on, right?), when that big multi-tabbed dialog closes 
and the Entry Window reappears, the title bar of the Entry Window will display the 
radio's frequency and mode. It's magic. The "+0.00" simply means that RIT is turned on, 
but set to zero (no offset)  
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Now that you have radio control, you can do a lot of neat things, but one of the most 
basic is that you will never again have to worry about accidentally logging QSOs on the 
wrong band or mode.  

3. Interfacing for Phone, CW and PTT 

in-edit  

Of course, controlling your radio through a serial port isn't the only way to interface 
N1MM Logger+ and your radio - in fact, long before there were computer-controllable 
radios, the pioneering logging software authors developed several standards for CW 
and PTT interfacing, using either serial or LPT (printer) ports.  

We'll start, though, with a discussion of phone interfacing, on the theory that this will be 
of most interest to new users. Once you're interfaced, you will be able to store voice 
messages and play them back through your radio, to save your voice during phone 
contests.  

3.1. Phone Interfacing 

This topic is covered in introductory form here, and in more detail in two parts of the 
Digging Deeper section. This rather awkward organization is necessary because N1MM 
Logger+ is transitioning from Classic's audio function setup, on the Audio tab of the 
Configurer, to a new improved option currently on the Config menu, Logger+ Audio.  

The Audio tab version works with all versions of the Windows operating system from 
Windows XP forward. Logger+ Audio works with Windows Vista and thereafter. If you 
check Logger+ Audio on the Config menu, and you are running an operating system 
after XP, the Audio tab on the Configurer will not be visible. If you are running Windows 
XP, the Config menu option is disabled.  

3.1.1. Interface Hardware 



Of course, you can always use one of the many commercial audio interfaces designed 
primarily for digital modes. However, if you have a sound card that permits feeding 
microphone input through it to the line output (most do), and has a mixer that will allow 
you to independently set the level of the microphone, .wav playback and internally-
generated audio (such as for AFSK), you really don't need an interface at all. On SSB, 
simply plug your microphone into the sound card mike input. Cable the sound card's 
Line Out to the Line In or Phone Patch input of your transceiver, and you're done.  

You may encounter hum, resulting from difference in AC potential between the chassis 
of your computer and that of your transceiver. In that case, a 600-ohm isolation 
transformer in the cable between sound card and transceiver is a likely cure. Another 
approach is to bond the transceiver and computer chassis together with a heavy wire. 
Many people do both.  

If you absolutely must feed the audio output of your sound card into the microphone 
jack of your transceiver, the level will be far too high. In that case, a simple 10:1 
resistive voltage divider is the solution, placed in the audio cable before the microphone 
jack.  

3.1.2. Trouble-shooting phone interfacing 

The following discussion is cribbed almost verbatim from audio trouble-shooting notes 
by David Robbins, K1TTT. If any mistakes have crept in, blame the manual team, not 
him. It assumes that you're running Windows XP, using the Configurer's Audio tab, and 
all the screenshots below are from that version.  

To begin with, make sure you close Windows Media Player, RealPlayer, Audacity, or 
any other sound playback/recording program you may have open. Start N1MM Logger. 
On the Config menu, open "Configure Ports, Mode Control, Audio, Other", also known 
as the Configurer.  

Now select the Audio tab:  



 

Select option 1 "Only use Radio 1 Output Device. Output on both channels."  

Choosing from the drop-down list at the upper left in "Tx Sound Card Setup", make sure 
that the Radio 1 Output Device is correct for your sound card. Typically, the name will 
appear as "Speakers" with the name of the associated sound device in parentheses. 
You can select Default as your Output Device, if you have set it as that in Windows, but 
depending on your version of Windows that may prevent you from muting your 
microphone while stored voice messages are playing.  

If you make an explicit choice of Output Device, you'll be presented with options under 
Select Port to Mute. Select Microphone. Then make sure that the Message Recording 
Device (sound card) is correct (typically the same as your Output Device), and that the 
Message Recording Port is set to Microphone. Make sure the Recording Sample Rate 
and the Recording Bits numbers are set to values supported by your sound card.  

Now OK out to save these settings, and close N1MM Logger. It's time to test.  



Plug your microphone directly into the microphone jack on your sound card. Plug your 
headset directly into its speaker output. Open the Windows Volume Control. It should 
come up with a set of sliders. In Windows XP, they look like this:  

 
 
 
 
Or this, in Windows 7, after you finally drill down through the options on the Control 



Panel, under Sound":  

 

× 

 Sound Cards Are Weird 

Unfortunately, sound card manufacturers have added a dazzling number of bells and 
whistles the past few years, including software-configurable input and output ports and 
other gadgets that affect recording. We have to leave you a little on your own here. The 
important thing is to find the microphone recording volume control, make sure it is 
selected, and that the level is about 50 percent.  

 
In Windows XP, you may have to go into Options>Properties to check the box to let you 
see the microphone volume control and those for other sound sources. Under 
Options>Properties, click the 'Recording' radio button, and make sure the microphone is 
checked on the list of controls:  



 
 
 
 
In Windows XP, make sure the Microphone slider is at mid-range and that there is a 
check in the Select box. If you are using a typical ham microphone, such as a Heil, and 
you have the "Advanced" button, click on it and select Mic Boost if that option is 
available, because it provides a 20-30 dB preamp. Now OK out.  

 



 
 
 
Now, when you talk in the microphone, you should be able to hear yourself in the 
headset. If you can't, then something is wrong with your settings, hardware or drivers. 
Try playing existing .wav files using the Windows Control Panel's Sounds option. 
Recheck volume and mute settings, check that the microphone is plugged into the right 
jack, try a different microphone, try a different headset. DO NOT PASS THIS POINT 
UNTIL YOU CAN HEAR YOURSELF!  

Now open Windows Sound Recorder, which is usually found in the Accessories 
category in your program list. DO NOT open Audacity, any of the audio tools that came 
with your sound card, or your other favorite tool. Some of them play with the mixer 
settings and we don't want that now that they are set. These are for QWindows XP and 
Windows 7, respectively.  

 
 
 
 

 

Click the Record or Start Recording button in Sound Recorder, and speak a few words 
into the microphone. You should see the level indicator deflect in time with your voice. 
Now press Stop. Press the Play button and you should hear what you just said. If you 
don't there is something wrong with your hardware or drivers. Check recording control 
settings, adjust volume, make sure the microphone is selected as the recording source, 
and get that 8 year old back to help again! DO NOT PASS THIS POINT UNTIL YOU 
CAN RECORD AND PLAY. If Windows Sound Recorder doesn't work, then N1MM 
likely won't work and since N1MM is much more complicated it is harder to troubleshoot.  

If it's working OK, now close the Sound Recorder and start N1MM Logger. Put the 
program in Run mode (Alt+U or click in the Running box) and your radio on USB or 
LSB, and make sure that the Entry Window's title bar specifies either USB or LSB (if you 
don't have a radio connected, type the appropriate mode in the callsign box and hit 
<Enter>).  

Right-click on any of the message buttons in the entry window. That will bring up the 
Function Key message editor:  



 

Don't be intimidated - we're just going to use this screen to set up a single function key 
to send a single message, so we can check out the entire flow from pressing a Function 
Key to having an audio message properly sent to your radio. The filenames and 
remarks you see in the editor now are the default filenames that are put into the table 
when you first install MM. If this is not your first time using N1MM Logger, these may not 



be the first ones you see. the full story on the message editor, see this page in Digging 
Deeper.  

For test purposes, we are just going to use one message, in the slot for Run F1. This is 
the message that will be sent when the program is in Run mode and F1 is pressed. This 
is intended to be the location for your CQ Message. If the editor shows "F1 CQ,CQ.wav" 
in the first row of the Run Messages section, then you're ready to go. Just close the 
window with the X in its upper right.  

XXXX 
× 

 The Difference Between "Save" and "Export" 

There is a critical difference between the "Save" and "Export" buttons in the bottom 
frame of the Function Key Message Editor. If you click "Save", the currently-displayed 
contents (including any changes you have made) are saved in your current database, 
for use the next time you press a function key. They are also written to the file-name 
shown in the upper frame of the editor. To save a change on the fly and get back 
quickly to using the program, all you need to do is click Save and then X in the upper 
corner to leave the editor and return to the Entry Window. However, if you want to retain 
the file that was loaded into the editor in its original form - as you might want to with 
the default files, for example - then you must first click Export, select a filename in the 
Save Macros to File dialog that opens, and then click Save. Then, you must click 
Save in the Function Key message editor to load the edited function keys into the 
current database. 

 
Now, make sure you are in Run mode - that is, that the Run checkbox in the Entry 
Window is checked. Now watch the bottom line of the Entry Window (called the Status 
Line) and press Ctrl+Shift+F1. You should see:  

 

 
One important thing to note here. If you have not entered your callsign under change 
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Station Data on the Config menu, you will not see your callsign in the status line. This is 
important - stop, go do that, and then repeat this step.  

If you speak into the microphone at this point, whatever you say will be recorded in the 
file CQ.WAV under WAV\<your callsign>.. Press Ctrl+Shift+F1 again (or ESC) to stop 
the recording, and look for this report in the same place:  

 

Now press F1. You should hear what you just recorded in the speaker. If you don't, 
make sure you're still in Run mode and look for an error message in the Status Line. We 
suggest using the Ctrl+Shift+Fx process to record within N1MM Logger, at least until 
you get truly comfortable with audio files, because a lot of the problems people run into 
are a result of recording with diofferent programs, or in filenames that are different than 
the program expects to see.  

Now that you've got things working, you need to program at least the first few function 
keys. It's best to follow the order in the example above, at least for F1-F8, because a 
little later, when we talk about ESM (Enter Sends Messages) mode, the order is 
important. Be sure that each Function Key message line begins with the Function Key 
number, a brief label (like CQ), a comma, and the content of the message  

OK, so now you have everything you need to play "canned" audio messages on the air. 
If you're content to use VOX to switch your transmitter, and you're not interested in CW, 
then you can stop here, for now.  

3.2. CW Keying and PTT Control 

 Unsupported Methods of CW Keying 

N1MM Logger+ supports several methods of CW keying, but two are not supported. 
The first of these unsupported methods is CW by audio tone, or MCW, as is done by 
software such as FLDIGI. The reason for this is that if it is not set up carefully, this 
method can produce unnecessarily wide signals, or even in some cases two closely-
spaced signals from one transmitter.  
The second unsupported method involves sending ASCII characters to the radio, which 
then converts them to CW. Only a few radios have this capability, and in most or all of 



these the resulting CW operation is far less suited to contest use than the Logger's own. 
N1MM Logger+ does not support this method directly, although it is possible for users to 
use this capability by means of radio control macro commands incorporated into 
function key messages, provided they are willing to accept some loss of functionality as 
compared with the directly supported methods.  

A full discussion of interfacing is in the Interfacing section of the manual.  

 
In its simplest form, CW is sent and PTT is controlled by switching lines on a COM or 
LPT port. This technique allows the simplest possible interface, but one is required. 
Here's a block diagram of the COM port setup. For LPT port keying, a USB adapter will 
not work. Your computer must have a hardware LPT port:  

 

Please note that only a very few radios permit CW and PTT via their built-in serial ports. 
The rest require that the interface be plugged into the CW key jack on the transceiver. 
The exceptions to this are covered under Supported Radios.  

The interface can be anything from the simplest - one resistor and one transistor - to 
one of the many units on the market that handle both CW and various digital modes.  

Let's assume you're going to use this method to start with. Begin by opening the Config 
menu to the Ports, other dialog:  
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For this example, our CW port will be on the second port we configure (the first port, 
COM6, will be used for radio control). let's choose COM2 as our CW/PTT port. After 
selecting COM2 from the pull-down list of available ports, put a check in the CW/Other 
box and you'll notice that the Set button is no longer greyed. Click on it, and open the 
dialog for that port:  



 

You can configure the DTR pin as either CW or PTT. Click the down arrow and you'll 
see the list of possibilities:  

 

Highlight the one you want, depending on your interface. Now do the same with the 
RTS pin:  

 

You can use either signal line (DTR or RTS) for either function (CW or PTT); just make 
sure your choice matches up with the way the hardware is wired up.  



 

Set the Radio Nr to 1. The PTT Delay setting is to protect the relays in an amplifier by 
making sure that the T/R relay is closed before the program starts sending CW. The 
default value of 30 ms. is fine even if you don't have an amplifier.  

OK, now to interface to the rig. The very simplest interface imaginable will work just fine 
for either the CW or PTT functions with any modern radio; again, there are many 
commercial options, but here's the Radio Shack parts solution:  

 
 
 
× 

 Using Winkey/Winkeyer for CW 

K1EL's Winkey/Winkeyer devices have become very popular with N1MM Logger+ 
users. The chips are built into a number of interfaces. The stand-alone Winkeyer USB 
will key two radios and provide PTT functions for both on all bands, simplifying changing 
modes considerably.  
Follow the instructions that come with your interface in setting up CW keying. For the 
stand-alone unit, You'll need to determine which port your Winkeyer is listening on, and 
then check its CW/Other box. Finally, click the Set button and check the Winkey box. 



That's all there is to it. Do NOT try to configure DTR or RTS for a Winkeyer; checking 
the Winkey check box automatically sets these to the correct settings for the Winkeyer.  

You will probably also need to review (and likely change) settings on the Winkey tab of 
N1MM Logger+'s Configurer (Config>Ports, Other). One important one with many 
transceivers is the Lead Time parameter, needed to prevent Winkey from starting to 
send CW before your transceiver is ready to make RF. A setting of 2 (20 mS.) is usually 
plenty; more can make manual keying difficult.  

3.2.1. CW Messages 

 
From the Config menu, you can select Change CW/SSB/Digital Function Key 
Definitions, and then Change CW Function Key Definitions, or you can simply right-click 
on one of the 12 function key buttons in the Entry window. That will bring up this 
window:  
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What it is displaying is the default function key message file that is now shipped with 
N1MM Logger+. There is much more on the Function Key Message Editor here, but for 
the moment, let's use what we find already in place.  

Going down from the top, note the macro {MYCALL}. An alternative to this is the single-
character macro *. Either one denotes your callsign, from the Station Data window. This 
is a text macro. There are two types of macros, text macros and action macros - text 
macros substitute a string of text for the macro, while action macros perform some 
program action. Both are often used in combination with regular text in a message, as 
shown here - when you press the function key or click the on-screen F1 button, the 
program will send CQ TEST N4ZR N4ZR TEST (substituting your call for the asterisk). 
There's a table of the many recognized ((Function Keys, Messages and 
Macros|Macros)) in the chapter by that name in Digging Deeper but for now let's go on.  

Conventionally, F2 is used for your contest exchange. The sample file uses the {EXCH} 
macro, which is a text macro that substitutes whatever you put in the Sent Exchange 
part of your Contest Setup. Say, for example, we were setting up for a contest where 
the exchange is signal report, your name and your state. When N4ZR sets up the 
contest, he puts PETE WV in the Sent Exchange. Now when he presses or clicks F2, 
the program will send PETE WV.  

Also in Run F2 is the macro {SENTRSTCUT}. Many of us just put 5NN explicitly in F2, 
but this macro is a little cleverer. It sends the signal report (nominally 599, but can be 
modified from the Entry window on a per-QSO basis). This macro substitutes whatever 
cut number style you choose in the Configurer here (e.g 599 -> 5NN, 579 -> 57N, etc.).  

One fine point - you might think of putting the 5NN in your Sent Exchange in the Contest 
Setup dialog - after all, everyone's 599, right? Well, don't, because it will screw up your 
Cabrillo log. Just resign yourself to putting 5NN or {SENTRSTCUT} in your function key 
messages wherever you want it sent.  

The next handy trick to notice is in Run F5, where ! is used. That always denotes the 
other station's call, grabbed from the Entry Window  

A final tip - most macros are in the form of {WORD}, where "word" is the macro. The 
curly brackets are necessary so that the program knows it's time to substitute something 
or take some action. It is awfully easy to type a square bracket or common parenthesis 
instead of the curly bracket, so look carefully.  

From now on, if you want to change the content of any message buttons, just right-click 
in the area of the buttons, and the editor we just left will reappear.  

OK - you've hooked up your interface, so now you're ready to send some canned CW. 
As explained above, you can either hit the function key F1, or click on the F1 button. 
Either way, the program will switch your radio from Receive to Transmit (assuming you 
have PTT connected - you can also use VOX or break-in, of course) send the message, 
and then go back to Receive again.  

http://n1mmplus.hamdocs.com/tiki-index.php?page=Stored+Messages+and+the+Function+Key+Message+Editor#The_Function_Key_Message_Editor_-_Editing_and_Managing_Function_Key_Message_Files
http://n1mmplus.hamdocs.com/tiki-index.php?page=Configurer#Configurefor%20the%20second%20digitr_REAL_GT_Function_Keys_Tab


 

There are two easy ways to adjust the speed of your CW - either click the up and down 
arrows next to the CW speed box (where it says "26" in the picture above), or press 
<Page Up> or <Page Down>, to increase or decrease speed in 2 word per minute 
increments. If you hit the wrong key or button, no problem - hit the <Esc> key to stop 
sending immediately.  
If you want to send CW manually, the easiest way is to parallel a keyer with the 
computer CW at the transceiver's key jack. Alternatively, if you prefer to use the 
keyboard instead of a paddle, hit Ctrl + K, and a CW window appears:  

 

Type the letters and numbers you want to send; as soon as you begin typing, the 
program begins sending; you can type ahead. Hit Ctrl+K again to close the window. See 
this page for more details on how the CW keyboard window works.  

 

1.6 Setting Up for a Contest 

 1.6 Setting Up for a Contest  

o 1. Setting Up for a Particular Contest  
o 2. Trying It Out  

1. Setting Up for a Particular Contest 

Now that you have set up the hardware interfaces to your radio, including radio control 
(often called CAT), PTT, CW, etc., let's move on to setting up for a particular contest.  
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Note that the first database the program creates is named ham.s3db by default - you 
can have as many databases as you want, and name them what you want. Some 
people prefer to create a database for every contest, while others create one for a 
period of time, like every year. If you want to create a new database, for example 
"2014.s3db", just click Files to drop down the menu, and then click on "New Database".  

 

That will open a standard file creation dialog in your N1MM Logger+ databases directory 
(inside the User files area):  



 

Name your new database and click Save. You'll be switched to the new database and 
ready to go.  

Back to the Files menu again. This time click "New Log in Database: XXXXXX" A new 
dialog opens, called the Contest Setup Dialog.  



 

This dialog has two important aids to completing it properly, the buttons labeled "Show 
Rules" and "Show Setup". Show Rules takes you (via Internet) to the sponsor's web 
page, while Show Setup takes you (again via Internet) to the Contest Setup page, 
located in the Digging Deeper section of the manual. Typically, the latter will give you 
what you need to fill in the Contest Setup dialog.  

The first thing to do is to click on the downward-pointing arrow in the Log Type field. 
That will open a list of abbreviated contest names. You can use your mouse to scroll 
through the list, or type the first letter of the contest to jump to the right general area. 
Once you have found the contest you want and highlighted it, click back in the original 
field and the drop-down list will close.  



 

When you set up a new contest, the Start Date defaults to the Saturday (usually) 
following the current date. This can be useful if you have several versions of a given 
contest in your database. Year to year, dates of contests change, but the day of the 
week usually remains the same. For this reason, the program assumes that the 
contest will actually start on the correct day of the week (and time of day) 
following the date when the new contest was set up. For example, if you set up a 
new contest on Wednesday, and that contest normally starts at 0000Z on Saturday, the 
program assumes that 0000Z on the following Saturday will be the actual start time, for 
purposes of computing time on or off the air, and for displaying any goals you have set 
in the Info window.  

To avoid confusion, it is best to set up the log you will actually use within a week before 
the start of the contest. You can always use a practice version earlier. So long as it is in 
the same database, you'll be able to set goals, set up your function keys and other 
associated files, and all of this will be available for use when you set up the "real" log. 
Just create a new log for that contest with the correct starting date and time and you're 
ready to go. You can delete the practice log or not, as you prefer.  

Next, fill in the information in the next few fields, denoting the class and category you 
intend to enter in the contest. In each case, you have drop-down lists available. 
"Overlay category" refers to contests like WPX, which have both regular classes and 
categories like Rookie or "Tri-bander plus wires". In most cases, "N", for not applicable, 
is the answer you want there.  

Beginning in 2011, some contests adopted the Cabrillo 3.0 standard for their log 
submissions, while others continued to require Cabrillo 2.0. The new standard 
(embraced by the ARRL, IARU and some others) required a different breakdown of 
information in the Contest Setup dialog. The one shown above is for Cabrillo 3.0. Both 
dialogs are self-explanatory, but you can find more information on the Contest Setup 
dialog for Cabrillo 3.0 here.  

Next comes the most important part of this dialog, the Sent Exchange field. This field 
specifies what will be entered in your Cabrillo file as your sent exchange and what is 
inserted in the {EXCH} macro in your function key definitions:  
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For many contests, the program guesses what you will want, based on the contest type 
and the contents of your Station Information dialog. For example, in this case, since the 
CQWW contest uses CQ zones as the exchange, it has already entered the zone, 
based on the zone already entered in my Station Information. Of course, this can be 
overridden if it is incorrect. Note the "Omit RST" warning - do not include 59 or 599 in 
the sent exchange. If the contest you choose has serial numbers, like WPX or the NA 
Sprint, then you need to put "001" at the start of the Sent Exchange field, separated 
from what follows by a single space if there is more to the exchange. Hence, for WPX, 
the Sent Exchange would read 001. An important exception is the ARRL Sweepstakes. 
The serial number is assumed for this contest only, so for example N4ZR's Sent 
Exchange for SS would read B 54 WV. More information on the Sent Exchange is in the 
Supported Contests section of the manual.  

Once you have filled in the Sent Exchange, you're done for now. Just Click OK and hit 
Enter.  

2. Trying It Out 

So really, that's all you need to operate contests with N1MM Logger controlling your 
radio - the Entry Window, the Check Window, the Log Window and the Bandmap.  

For the purpose of this guide, we'll assume that you're operating in the CQWW SSB 
contest. In that case, the Entry window will look like this:  

 

I'm assuming that you're going to operate phone to start, so I have typed in USB in the 
call-sign field, and hit <Enter>. I have left the default frequency (20M phone) in place, 
but if I wanted to show another band, I need only type a frequency (in KHz) in that band 
(like 21200, for example) in the call-sign field and hit <Enter> to change bands.  

When I've done these things, I then type a call-sign in the call-sign field. Even before I 
look at the Check window, I see that the call sign is color-coded green. This means that 
it is both a new contact and a double multiplier (in this case, both the new country of 
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Martinique and the new Zone 8). If I had already worked Zone 8 on this band, then the 
call sign would be color-coded red, signifying just a new country. If both the country and 
zone had been worked before, but the station has not, then the color code would be 
blue. If it is a dupe, the call sign will be coded grey, and the warning "Dupe!" appears to 
the right of the entry fields. There is also a column of band buttons to the left, all of 
which are also colored green in this example, indicating that this station would also be a 
double multiplier on each of the other bands. The beam heading is displayed below, as 
are the country, its zone and continent (which affects points per QSO).  

So, you call him, and he answers. At this point, just hit <Space> to fill in the expected 
signal reports and move the cursor to the Zone field. N1MM Logger uses the <Space> 
bar as a "smart tab." The idea is that it will skip fields you are unlikely to want to change 
and move immediately to the one you may need to. Note, too, that the zone is 
highlighted. This means that if you need to change it ... for example, if FM5BH really 
was in Zone 9 (he isn't) - you would just type "9" and the "8" would be replaced.  

 

Ok, but suppose he gives you a "57" report instead of "59". No problem - you just use 
the <Tab> key twice, and the cursor will be on the second digit of the received signal 
report, ready for you to type over. The <Tab> and Shift+Tab work just as you'd expect in 
Windows, moving forward or backward one field. Here's how it looks:  



 

If you need to correct the call-sign, use the <Space> bar to get you quickly there and 
edit as necessary. Then, once everything is as you want it (and the QSO is done), all 
you do is hit <Enter>, and the QSO will be logged.  

One thing that trips everyone up at least once is that the program checks to make sure 
that you have entered everything, and that everything is correctly formatted. For 
example, if you accidentally fat-finger the zone number, like "89", the program won't let 
you enter the QSO. This can be disconcerting at first - you get an error message in the 
status line, like this:  

 

If the program has blocked you from logging the QSO, just use the <Space> bar to 
move to the appropriate field, correct it, and hit Enter to log. If you absolutely can't figure 
out what the correction should be (for instance, with an ARRL section in Sweepstakes), 
you can hit Ctrl+Alt+Enter to bypass the exchange checking and log the QSO "as is". or 



you can just press Enter again, which will give you the following warning dialog and 
allow you to log the contact despite the error:  

 

Just in case you want to put a note in the log, when you use Ctrl+Alt+Enter to log an 
invalid contact, a note window opens. Type whatever note you want and Hit Enter, or 
just hit Enter to skip it and get back to the contest.  

Suppose you miscopied a call sign, or he didn't really come back to your call, so you 
now have a mistake in your log. If you need to delete the QSO altogether, just hit 
Ctrl+D. The program will ask you if you really want to move the QSO to a Deleted QSOs 
file. Just hit <Enter> to do so, or type N for No.  

If you need to edit the QSO, hit Ctrl+Q, and put the program in QuickEdit mode:  

 

You'll notice the words QuickEdit above the call-sign field. You can move through the 
fields as before and make your corrections. Then hit Enter and the QSO will be 
corrected in the log, or else hit <Esc> to get back to normal logging mode and cancel 



any changes. Be careful not to leave the program in QuickEdit mode for your next QSO, 
or you'll screw up two QSOs at once!  

As you log more QSOs, you'll note that the call-sign of your last previous QSO will 
appear in the space right above the call-sign field. This area, called the Call-Frame, will 
be very important once you have interfaced the program with your radio, but for the 
moment it is just a reminder of who that last guy was.  

× 

 Remember 

Remember, unless you have interfaced your radio, each time you change bands, you 
need to enter the frequency of that band in the call-sign field, and, if you change modes, 
enter that there too. For example, if you switch to 40M CW, you would need to enter 
7000 and then enter CW (separately) before you begin logging QSOs on that band. 

 

1.7 Learning Your Way Around 

 1.7 Learning Your Way Around  

o 1. The Entry Window  

 Program Menu Descriptions - in the Digging Deeper section  

o 2. The Check Window  
o 3. The Log Window  
o 4. The Bandmap  
o 5. Logging Essentials  

Take a few minutes to learn your way around the four windows that you need to make 
your first contest QSOs with N1MM Logger+. Additional information about each window 
will be found here.  

1. The Entry Window 

Let's get a little terminology out of the way first. The top blue part of this (or any) window 
is called the Title Bar. Each of the places where you can type information is called a 
textbox. The Title Bar displays the current frequency, mode (if one has been selected), 
and which radio it is (nominally, Radio A). You will have to enter a mode before you 
begin to operate, and a band and/or mode each time you change either. Simply type a 
frequency in KHz (3500, 7000, etc.) in the Call-Sign textbox (to the far left) and hit 
Enter; then type a mode (CW, USB, LSB) there, hit Enter again, and you're set.  

The Entry Window is your main starting place for everything you do with N1MM 
Logger+. The first row is a standard Windows-style menu, and we'll be using it in a 
minute. Take a moment and explore the various drop down menu choices, but don't 
change anything right now.  
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Below the menu is a set of entry textboxes. This row is where you log your contest 
QSOs. The left-most textbox is the Call-Sign textbox. You always enter the call-sign of 
the station you are working into this textbox.  

 

The rest of the data entry textboxes are titled above them - depending on how you have 
resized the window, the titles may not line up perfectly with the entry textboxes, but they 
are always in the same sequence as those textboxes. Depending upon the specific 
contest and the required contest exchange, the number of textboxes and the titles may 
be different from what you see here. The example Entry Window shown above would be 
used during the CQ WW Contest. This contest requires that a call sign, sent and 
received signal reports and the CQ Zone be logged for each contact  

For now, you can ignore the 'Run' and 'S&P' buttons, as well as the colored dots 
alongside them. These control one of the most important features of N1MM Logger+ - it 
distinguishes between Run and Search and Pounce modes, providing different features 
for each. However, these aren't really relevant until you get into sending stored CW and 
phone messages, which are covered later. The rest of the buttons in the Entry Window 
are related to this and to other advanced capabilities.  

If you want to save space on your screen, you can reduce the size of the Entry Window, 
like this. Right-click in an empty part of the window and uncheck the options for items 
you do not wish to have displayed.  



 

There are two more useful features of the Entry Window. The box in the lower left 
corner, called the Status Line, provides a lot of useful program status information. For 
example, if you enter a call sign, the Status Line will tell you what country it represents. 
If you have chosen to show bearing information in the right-click menu, it will also show 
you the distance and bearing above the status line, like this.  

 

To the right of the Status Line is the progress box, where you can keep track of your 
QSOs and multipliers without having another window open, and to its right is a running 
score.  

If you press the backslash (\) key (and the program is in SO2V or SO2R mode), the 
program opens a second, almost-identical entry window. The only difference is that it 
will have a "B" instead of the "A" in the title bar of the first entry window, and it may well 
have a different frequency and/or mode as well. But if you pop up the second Entry 
Window by mistake, and want to get rid of it, you simply close it by clicking the big red 
X.  

When you first open the program, it will be in SO2V (Single Operator Two VFOs) mode. 
The idea is this - most modern transceivers have two VFOs, or a main VFO and a sub-
VFO. There will be circumstances - during a contest on 40 meter SSB, for example - 



when you will want to receive on one frequency and transmit on another, widely-
separated one.  

For the moment, you should probably change to SO1V (Single Operator One VFO) 
mode. Select the Config menu, and under the dropdown menu, select Configure Ports, 
Telnet Address, Other and then click on the SO1V button. This will prevent the second 
Entry Window from opening.  

 

The Entry Window is the nerve center of N1MM Logger+. The program returns focus to 
this window automatically in many situations.  

Program Menu Descriptions - in the Digging Deeper section 

The Digging Deeper section of this documentation contains detailed information about 
the Entry Window's menu choices  



o File  
o Edit  
o View  
o Tools  
o Config  
o Window  
o Help  

2. The Check Window 

 

OK, another important window - the Check window. You open it by clicking on Check in 
the Entry window's Windows menu.  

This window is used to display the results of checking a call sign against any or all of 
the following: your log; a master list of calls, variously called the master.scp or Super 
Check Partial file; call signs that have been spotted and received in the Telnet window; 
and call signs in a user-defined file called the Call History file. A Super Check Partial file 
is provided when you install the program, and the process of updating is covered in the 
Tools Menu section of Digging Deeper.  

First things first, though. When you type a call sign in the Entry Window, the Check 
window displays whether a match was found or not in the various selected sources. Call 
signs that differ from the one you have typed in by only one letter have the different 
letter highlighted in red, while similar call signs that are longer than the one you have 
typed in have the additional characters highlighted in green: 
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In this example, all four possible sources have been selected. You are in the process of 
typing DL5AXX into the Entry Window, and so far you have typed DL5AX. This exact 
call sign (DL5AX) was found in the master.scp file, and therefore it is displayed in bold-
face italic font at the top of the master.scp pane. It is blue, indicating that you have not 
worked this call sign and it would be a valid QSO in the contest. Note in the left (log) 
pane that DL5AXX already appears in your log. A number of other call signs that differ 
from DL5AX in only one character were also found in the master.scp file.  

If you keep on typing until the entire call sign has been entered, you will see: 

 

Now the station's call appears in grey, meaning that it would be a dupe.  

There is much more on the Check window here.  

3. The Log Window 
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To begin with, click on Log in the Entry window's Windows menu. That will open a Log 
window on the screen, like this:  

 

First, you should notice that the title bar of the Log Window gives the current date and 
exact time, the name of the contest, and the database in use. As you log QSOs, they 
will appear in the log. One is logged one above just to indicate how it looks. You'll note 
that each column has a fixed label - these labels change between contests. CQWW is a 
2-multiplier contest, so the log shows columns for two multipliers: M1, which is the CQ 
zone, and M2, which is the country. The check mark in each multiplier column simply 
means that it is the first station for that multiplier on that band.  

If you click on any column heading, the entire log is sorted by that attribute - for 
example, if you click on the "Call" heading, the log will be sorted by call sign. Click on 
the MM-DD HH:MM heading to switch back to the normal chronological order.  

A further nice touch - if you click a second time on the column heading, for example the 
"Call", the sort order switches from Ascending to Descending, so that all your "Z" QSOs 
come first, and your "As" last. Same goes for the date/time heading - normally, you'll 
want to leave the Log Window in ascending chronological order, so that each QSO you 
log appears immediately at the bottom of the list.  

The Log window has two "panes"; the one above the grey bar is the normal log, while 
the one below the line is to show you previous QSOs with a station each time you type 
its call into the Entry Window. This makes it very easy to see quickly all the information 
about previous QSOs with a station, e.g. for that special someone who drops by and 
asks, "What was the serial number you gave me yesterday?"  

Check out this section of Digging Deeper for more details.  

Like all windows in N1MM Logger+, the Log window is resizable, as are the individual 
log columns - to resize the whole window, use your mouse to drag the lower right 
corner, and to resize a column grab the between-column divider and drag it right or left. 
You can move any window around the screen by dragging its title bar. Also, you can 
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change the font size in the Log window by clicking on the font sizer buttons at the top 
right.  

4. The Bandmap 

 
With an interfaced radio, you will find it useful to open a Bandmap window. Click 
Window, then select Bandmap, and the Bandmap corresponding to your entry window 
will be displayed.  

In the example at left, I have filled the Bandmap with spots from a packet cluster, just to 
illustrate how spots are displayed. The stuff in the top bar is pretty self-explanatory. The 



SH/DX button, when mouse-clicked, sends that request to the cluster (which you don't 
know how to set up yet). The button labelled Wide toggles filters in your radio, though 
you may have to set it up first (the process is explained in the manual). In any case, 
clicking on it switches TO the filter mode shown. The button labelled CQ will QSY the 
radio to your last CQ frequency, if there is one on this band. The RIT, XIT and CW are 
clickable. Clicking on RIT will turn RIT on and the label will turn red; ditto for XIT. The 
number between RIT and XIT is the RIT/XIT offset. The CW indicates the radio's mode; 
you can click on it to change modes on the radio. The four buttons below those are 
user-programmable buttons, typically used to control radio functions such as filters, 
noise blanker settings, AGC settings and so on.  

The color-coding of spots in the Bandmap is the same as in the Entry Window, so each 
of those red calls represents a new multiplier in the contest. Spots that came from a CW 
Skimmer on the Reverse Beacon Network are marked with a #. If a spot was newly 
spotted within the last two minutes, the word "New" will appear beside it. You can 
change the font size in the Bandmap window using the font sizer up/down arrows at the 
top right of the bandmap.  

If you want, you can mouse over a spot, and the program will tell you more about it.  

 
The information about the spot includes the frequency, who spotted it, how long ago the 
spot was posted, and spot comments (the comments on this spot came from a CW 
Skimmer). The second line in the balloon, telling you how closely you are tuned to the 
spot, only appears if the radio is tuned to a frequency close to the spot.  

 
 
In a busy contest, certain parts of the band can get pretty crowded with spots. Pressing 
the numeric keypad <+> key will zoom the Bandmap in and spread the spots out, like 
this:  



 

Pressing the numeric keypad <-> key will have the opposite effect. You can also zoom 
the Bandmap using the up and down arrow buttons in the lower right corner of the 
Bandmap window.  

Another useful thing about the Bandmap: If you single-click on a spot, your radio will 
automatically be sent to that spot. If, instead, you click on the frequency scale 
(anywhere within the width of the frequency hash marks), the radio will go to that 
frequency. There are also keyboard shortcuts that will move your radio from spot to spot 
up and down the band. More on this later.  

 

When you single-click on a spot, something else useful happens - the call-sign of that 
station is copied to the Call-Frame of the Entry window, like this. This is done this way 
so that if you discover that the station on that frequency isn't ON5KQ after all, you can 
just type in the correct call. This does happen now and then with packet spots.  



However, let's assume it's correct. In that case, all you have to do is call the station, get 
him to answer you, and hit <Space>. Here's what happens - the call sign is pulled down 
into the Call-sign field, and the QSO is all set for logging, once you complete the 
exchange.  

 

Another good thing can happen on the band-map when you complete a QSO and tune 
off the frequency - the spot's color code turns to grey, so that you know at a glance that 
you have worked the station already, and won't waste time when you come back to that 
frequency again.  

 

To turn on this feature, click Config, and then, in the dropdown menu, click on the two 
items checked called "QSYing wipes the call & Spots QSO in Bandmap (S&P)" and 
"Show Non-Workable Spots in Bandmap" (see below). You need them both because 
grey spots are regarded as non-workable, and they will disappear unless Show non-
workable spots is checked. If you hear a station and type in his call sign, but you don't 
work him and tune off his frequency, his call sign will appear in the appropriate color to 
denote whether he's a new multiplier or simply a valid QSO; either way you know to go 
back and work him later, if he's still there.  



 

By the way, even if you never plan to use packet spots, the Bandmap is a very useful 
window. As you S&P your way up and down the band, each station you've worked will 
be marked with a grey self-spot, so you can skip by them the next time even if you have 
no packet spots.  

You may be wondering how to move quickly up and down the Bandmap, hitting only the 
workable spots, or those that represent multipliers. This might be a good time to 
introduce another very useful section of the Manual. N1MM Logger+ makes extensive 
use of "hot-keys" to largely or entirely eliminate the use of the mouse during contest 
operations. There is a very useful section in Digging Deeper titled Key Assignments 
(Keyboard Shortcuts) which explains each and every such key combination. For 
example, under "Active Radio/Bandmap Key Assignments" it lists:  

Jump to Spots Note: If you are operating single mode, your mode won't change when 
jumping between spots.  
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 Ctrl+Down Arrow - Get next spot higher in frequency.  
 Ctrl+Up Arrow - Get next spot lower in frequency.  
 Alt+Ctrl+Down Arrow - Get next spot higher in frequency that is a multiplier.  
 Alt+Ctrl+Up Arrow - Get next spot lower in frequency that is a multiplier  

Try these and see - with a full Bandmap and these keystrokes, it is easy to work 100+ 
search and pounce QSOs per hour, something that used to be regarded as impossible.  

As we're finishing up this introduction to the Bandmap, it might be a good idea to offer 
another general hint when you're exploring the program. Be sure to right-click on each 
new window (other than the Entry Window), to see what options involving that window 
might be available to you. Each of these options is explained in the section of the 
manual dealing with that window.  

If you do this with the Bandmap, you'll see this right-click menu:  



 



Of the choices here, Telnet Filters is perhaps the most useful. Click there and set the 
timeout interval in minutes - both self-spots and spots from packet will disappear after 
however many minutes you choose. Note that you can also set the two Config options 
mentioned above from this window as well.  

 

The Reset Radios command in the right-click menu is also useful in case you lose 
control of your radio for some reason. Click it, and the program resets the connection.  

Check here for much more.  

5. Logging Essentials 

This listing pulls together a dozen (or so) keyboard commands that are essential in 
N1MM Logger. It was originally prepared to help a club planning first-time use of the 
program on Field Day  

General  

 Esc : stop, exit, abort, back out of whatever you are doing  

 
Logging  

 Spacebar or Tab : move between exchange elements  
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 Enter : log a completed valid QSO  
 Ctrl+Alt+Enter : log an incomplete/invalid QSO with a note in the log  
 Ctrl+N : add a note to the log  
 Ctrl+O : to enter the operator's name or call sign (or type OPON in call sign field) 

- optional, use to keep track of who was operating when  
 Alt+W : wipe whatever is entered so far (Alt+W again to undo the wipe)  

 
Changing logged contacts  

 Ctrl+D : delete last QSO from log  
 Ctrl+Q : Quick Edit last QSO  

o while in Quick Edit (blue background), use Ctrl+Q to go to earlier QSO in 
log, or Ctrl+A to go to later one  

o Enter to accept changes, Esc to abort and return to logging  

 
Changing current frequency & mode  

 To change modes, type CW or SSB or RTTY or PSK into Entry window, hit Enter 
- or, if your radio is interfaced for radio control, just change modes on the radio  

 To change frequency, type the frequency in kHz into the Entry window, hit Enter - 
or, if your radio is interfaced for radio control, change frequency on the radio  

 
CW/SSB/Digital (needs CW keying interface/voice keyer/Digital interface 
respectively)  

 Alt+U : switch between Run & S&P mode and messages  
 F1 : send CQ message and switch to Run mode  
 F4 : send your own call sign (S&P)  
 ; key or Ins : send his call sign + exchange message (F5 + F2)  
 ' key : send TU and log QSO (F3 + Enter)  
 = key : re-send last function-key message  
 Alt+K : edit current function-key message buttons  
 Ctrl+K : ad lib keyboard CW/digital text (use Enter or Esc or Ctrl+K to end)  
 PgUp/PgDn : CW speed up/down  

 

 

1.8 Operating a Contest 

 1 Before the Contest 
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 2 During the Contest 

 3 After the Contest 

 

1.8.1 Before the Contest 

 1.8 Operating a Contest  
 1.8.1 Before the Contest  

o 1. Update Your Data Files  
o 2. Test  

This section addresses, in a brief and informal way, steps that you should take to get 
ready for a contest season and for each contest. It is worth reading. Where appropriate, 
links are included to point you to more extensive information.  

1. Update Your Data Files 

Make sure you have imported the latest wl_cty.dat file into the database you will be 
using and downloaded the latest Super Check Partial (master.scp) file prior to the 
contest. Menu options for doing this may be found on the Tools menu of the Entry 
window.  

If you are using a Call History file, import that into the database also and make sure Call 
History Lookup is on. More information about Call History can be found in this section?.  

Load the function key definition file that you plan to use into the database too. If you 
make any changes during testing, export your function keys to make sure your changes 
are saved. An explanation of how to create function key definitions is found here for 
CW and here for phone. Click here to download Sample Function Key files for the 
major contests. Click here to watch videos about downloading and configuring your 
data files.  

2. Test 

Today, the program supports CW, SSB and multiple digital modes, close to 300 
contests, and a wide variety of radios and ancillary equipment. Contest rules change all 
the time, and organizers often forget to let logging software developers know. If this 
were a conventional software project, any sane programmer would declare it 
"untestable."  

Since its early days, the N1MM Logger project has relied on users to do most of the 
testing. Rapidly releasing relatively small updates, with the option of retreating a version 
or two if necessary, makes this a relatively low-risk approach, so long as users test 
each one enough in advance of the next contest they want to get into.  

If you are planning to operate in a contest a couple weeks from now, load the latest 
update NOW, create a contest "instance" as outlined here, sit down with your radio, 
computer, DX cluster connection, keyers, and whatever else you use, and simulate 
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logging a dozen contacts as if you were running (enter a make-believe call, type and hit 
function keys as fast as you can). Then log a few more in S&P mode. Make sure your 
messages and macros work as expected, make sure you can record and playback SSB 
messages on the fly, make sure the multipliers you think should be counted are scored 
right, log some contacts that shouldn't be multipliers or points and make sure they are 
handled properly. If operating Assisted, grab some spots, make some spots, check the 
color-coding of spots against the contest rules. Make detailed notes of problems, if any.  

A lot of problems are the result of a local issue - hardware settings, user options or the 
like. Do take the time to check the documentation first, but then don't hesitate to ask for 
help on the N1MM+ reflector . 4000 users and the N1MM team are there to help.  

With thanks to David Robbins K1TTT, from whose input this section was adopted.  

 

1.8.2 During the Contest 

 1.8.2 During the Contest  

o 1. Making Contest QSOs  
o 2. Bugs Encountered During a Contest  

1. Making Contest QSOs 

Make sure you have your CW or SSB or digital function key definitions set up the way 
you want, set up as outlined in Before the Contest.  

Now let's begin. There are several ways to make and log a contest QSO with N1MM 
Logger+, depending on how much you want to automate the process. The details are 
the same for either phone or CW. The 4 main ways you can use the stored messages 
are listed here in ascending order of speed and convenience.  

1. One key at a time - press a function key when you want to send the associated 
message. Use the <Space> bar to move your cursor. When you have everything filled 
in, press <Enter>, and the QSO will be logged. Done this way, a typical Run (CQ) QSO 
would look like this:  

1. F1 (CQ)  
2. Station answers - copy call in callsign box  
3. Say his callsign (phone) or press F5 to send it (CW)  
4. Press F2 to send the exchange (either a stored voice message or CW)  
5. Press <Space> to move the cursor to the exchange field  
6. Type in the received exchange  
7. Press F3 to send your acknowledgment  
8. Press <Enter> to log the QSO  
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2. Semi-CT Style - CT was the DOS logging program that pretty much started all this. It 
used the following convention to save keystrokes:  

Enter the callsign of the station calling you. Press the <Ins> key to send his call and 
your exchange (CW), or speak his call and then press <Ins>. Once you have copied his 
exchange, press F3 (TU) and <Enter> to Log. If you are calling other stations (Search 
and Pounce, or S&P), you would first press F4 to send your call, and when the station 
responds follow the sequence as above.  

3. Early N1MM style - Enter the callsign of the station calling you. Press the <;> key to 
send his call and your exchange. Copy his exchange and press the <'> (right next to <;> 
on US keyboards). The program sends the F3 (TU) message and logs the QSO. In 
S&P, you would hit F4 first, then <;>, and then <'>.  

This saves some keystrokes, but there's an easier way. A couple of decades ago, N6TR 
developed the idea of making TR Log "modal." By that, he meant that the program 
would behave differently depending on whether you were in Run or S&P mode. Making 
this distinction let him massively simplify and shorten the sequence of keystrokes 
required to complete a QSO.  

4. Enter Sends Messages - N1MM Logger has now evolved N6TR's invention into 
what is called Enter Sends Messages, or ESM for short. You'll find a full explanation of 
this mode in this section.  

In short, ESM enables you to enter a callsign and then step through the remaining steps 
in logging a QSO, simply by hitting the Enter key. The program anticipates what you'll 
want to do next, moves the cursor, and highlights what canned message will be sent if 
you press Enter the next time. Note that if you wish, you can still press individual 
function keys at any time, to send a repeat or otherwise bypass ESM.  

Once you've used ESM, we think you'll never go back to the old way again.  

2. Bugs Encountered During a Contest 

When a bug was missed during testing and comes out during the contest please report 
it on the reflector right after the contest or, during the contest if it is a show stopper. Tom 
and the developers participate in many contests but they also read the mail during 
contests and can suggest work-arounds or sometimes bring out a new version. In 
addition, there are many other hams available there who can help.  

Rather than writing down problems during the contest, try the following:  

1. Use Alt+N to write a Note that will be attached as a comment to the QSO  
2. At the end of the contest, use the menu option >View >Notes to see all the notes 

you have made during the contest  

 

1.8.3 After the Contest 
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 1.8.3 After the Contest  

o 1. First, a Word on Protecting Your Data  
o 2. Editing Individual QSOs  
o 3. Entering Multiple QSOs After the Contest  

 3.1. Change Time/Date for a Single Hand-Entered QSO  
 3.2. Change Time for Multiple Hand-Entered QSOs  

o 4. Change All QSO Times/Dates by a Fixed Amount  
o 5. How to Create Cabrillo Files  
o 6. How to Merge Contest Logs  

 6.1. Using N1MM Logger+ and ADIF Files to Merge Logs  
 6.2. Using Excel and Cabrillo Files to Merge Logs  

o 7. How to Print the Log  
o 8. How to Get Statistics  

1. First, a Word on Protecting Your Data 

After almost every contest, we hear from a new user (or sometimes even an 
experienced one) who is afraid he or she has lost the log from the contest just 
completed. Fortunately, it is usually not true, but here are a few things to remember:  

 Backup - this is just as important with logging software as with any other 
computer application. Data not backed up can be data lost if something happens 
to your hardware or you make a mistake while manipulating the log database if 
you haven't backed it up. N1MM Logger+ stores all your QSO data in a file with 
the extension .s3db. The name of the file is whatever name you assigned to it 
when you first set up the program. There are other databases also used by the 
program - N1MM Admin.s3db, N1MM Packet Spots.s3db, and 
Do_Not_Use_Or_Erase.s3db, but all the QSO data are in that first one. The 
easiest way to do really secure backup is to use a free backup program such as 
Syncback SE to back up your active QSO database to a USB "thumb drive." Any 
such drive you can buy today is plenty big enough, dirt cheap, and safe from 
virtually anything short of a ball peen hammer.  

 Save A Copy - Before you do anything, even if you just want to peek into your 
QSO database with an SQLite viewer, save a copy manually to a safe location. 
You are, after all, only human; we all can make mistakes, so it's wise to do what 
you can to protect yourself against them.  

 Transaction Files - During normal operation N1MM Logger+ saves the 
information about each QSO in a simple text file. These files are stored in a sub-
folder in the Databases folder in the user files area and can be used to recover in 
the event the database file is corrupted.  

o Here's an explanation of how you can use those files to recover your data 
quickly, during a contest, or at your leisure if you haven't done one of the 
two steps suggested above:  



 The transaction log is created for each contest you log to  
 The file is closed after each transaction and reopened to force the 

data to be written to disk  
 To keep things simple and foolproof, you are not allowed to change 

the name of the transaction log  
 The name is used to make sure you are loading it properly, and to 

prevent mixing logs of two contests. Example name: 'CQWWCW - 
2005-09-19 - 14.TRN' i.e.: Contest name - date log created - an 
internal index number  

 To Recover your log, you MUST import the transaction log into a 
NEW (empty) database and a NEW contest log. See this link  

 The new contest log must be the same contest as the contest from 
the transaction file (Example: if restoring CQWPXCW, the new 
contest must also be CQWPXCW). Why? To prevent a user 
recovering from a database problem making the problem worse. 
This will prevent any issues from duplicate contacts and a number 
of other problems  

 As you load the transaction log, a new transaction log is 
automatically made with the transactions in the first log. Thus you 
should never have to merge logs. You always use the last one  

2. Editing Individual QSOs 

The easiest way to edit a QSO is by double-clicking in the Log window on the data you 
want to change. In rare cases, you may need to select the QSO in the Log Window and 
right-click. Select "Edit Contact." The Edit Contact Window will appear - for full details 
see the explanation here.  

× 

 Crackdown on Post-Contest Logging Changes 

Contest sponsors are cracking down on post-contest log "massaging" that uses 
resources you access after the contest is over. The CQWW Contest Committee has 
recently been particularly explicit about this, saying that "the...Committee considers it 
unsportsmanlike to 'clean' your log post-contest using data sources such as recordings, 
call sign databases, etc." This kind of restriction is not intended to apply to post-contest 
log changes that are based on things you noted during the contest, such as problems 
with the CTY.DAT file, bad abbreviations for counties, states or provinces, etc. If you 
caught it during the contest, you should feel free to fix it afterward. 

3. Entering Multiple QSOs After the Contest 

Computer trouble? Made a paper log during (part of) the contest? The program has 
some nice features that will allow rapid QSO entry. You can either enter the time for 
each QSO, or there are features to let you set the date and time via interpolation. 
(Remember, exact QSO times are not critical for contest sponsors, just within reason).  
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 Type frequency band (4 or 5 digit numeric frequency, e.g. 7000, 14000) in the 
call-sign textbox of the Entry window and hit Enter. Then type the mode (CW, 
USB, LSB, etc.) and hit Enter.  

 Enter calls and exchanges, and log them, as long as they are on the same band. 
Don't worry about date and time right now.  

 When you need to change bands, enter the new frequency band and continue.  

3.1. Change Time/Date for a Single Hand-Entered QSO 

Updating the date and/or time of a single QSO is best done by double-clicking on the 
time stamp for that QSO and then using the date-time box that appears to edit the date 
and time. Alternatively, you can use the Edit Contact option in the right-click menu 
associated with the Log Window and edit the date and/or time in the Edit Contact 
window.  

3.2. Change Time for Multiple Hand-Entered QSOs 

This method can be used to interpolate approximate times for a series of contacts. This 
time interpolation feature is most useful if you have a bunch of QSOs to enter. If you 
have one or two QSOs whose times need changing it is easier to do it by editing in the 
Log  

× 

 Make a Copy of Your Log 

Make a backup copy of your log database. You cannot (automatically) reverse the time 
interpolation process below. You have been warned! 

 In the Log window, single-click the first QSO whose time and date you want to 
change. to highlight the row  

 With mouse over the Log window, right click  
 Select >Set Start Interpolation Time Row  
 Enter the new timestamp for the first QSO, and click <OK>  
 Now, click on the last QSO whose time/date you want to change, to highlight the 

row  
 With mouse over Log window, right click  
 Select >Set Stop Interpolation Time Row  
 Enter desired time for that last QSO, and click <OK>  

× 

 Changing QSO TIme and Date 

The utility will average out the time for each QSO in the group of QSOs you have 
selected. Remember there is no "undo" feature,. If you have a large gap in time in 
your hand log, enter the first batch of QSOs, and do the interpolation. Then enter the 
second group of QSOs and do a 2nd interpolation. 

4. Change All QSO Times/Dates by a Fixed Amount 
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× 

 Back Up Your Log Database 

While you could easily recover from a mistake during the following adjustment by 
performing another offset, it is still a good idea to play safe. 

This will fix a log where all QSOs are off by a fixed amount of time (for example, when 
the times are correct but the dates are wrong by one or more days because the QSOs 
were entered after the contest).  

 Right click in the Log window  
 Select >Change timestamps of the entire log by a fixed amount  
 A dialog box will open, and enter offset time (+ or -) in minutes  

 
The date will automatically adjust if the offset rolls a QSO into a different day. Time is 
entered in minutes, and can be negative time to go backwards. (You might need a 
calculator to determine the offset minutes if your date was off by many days, months, or 
years). For example, entering +1440 will shift a complete day forward; -2880 two days 
back.  

5. How to Create Cabrillo Files 

To submit your log, you need to export it from the database in the proper format. 
Cabrillo is used by all major contests.  

 Select File >Generate Cabrillo File.  
 Make sure that your Station information (Config >Change Your Station Data), 

and overall contest setup are correct (in the Contest Setup dialog, reached 
through File >Open Log in Database ...). For example, is your entry class 
correct? Your power classification? Whether Assisted or not? Are your State and 
ARRL Section both entered correctly in your station data?  

 Did you put the right information in the Sent Exchange field, and nothing else? 
For example, when the exchange in a contest is 5NN WV, it may be tempting to 
put the whole thing in the Sent Exchange. That will screw up the Cabrillo file with 
multiple signal reports for each QSO, so get in the habit of putting the signal 
report in your stored messages, not in this field.  

 A Cabrillo file will be created named <yourcall>.LOG. By default this is placed in 
the ExportFiles sub-folder in the N1MM Logger+ user files directory, but you are 
given the options of choosing a different name and/or of saving the file anywhere 
else you wish.  

It is a good idea to rescore your log (Tools >Rescore Current Contest) before 
generating the Cabrillo file.  

6. How to Merge Contest Logs 



If you ran a multi-op station but did not network your logging computers, you will need to 
combine the logs from each computer into a single log submission for the contest 
sponsors.  

6.1. Using N1MM Logger+ and ADIF Files to Merge Logs 

This merge method is the most automated and should require no manual log editing, 
but will only succeed if the contest types in each logging computer were identical. If the 
contest types were not identical, it may be possible to recover with the help of a text 
editor and some detective work, but it will likely not be easy. It's better by far to avoid 
this situation by using the identical contest types during the contest.  

1. Examine the logs to ensure that the contest types are identical in each computer: 
>File >Open Log in Database  

2. Export an ADIF file from each logging computer: >File >Export >Export ADIF to 
file. Assign a unique name to each ADIF file to distinguish it from others when 
importing. Before continuing, guarantee that the contest types from each 
computer were identical by opening each ADIF file with a text editor (like 
Notepad) and looking for the ADIF expression CONTEST_ID. They should all be 
the same length and contest name. For example: <CONTEST_ID:14>ARRL-
FIELD-DAY  

3. Copy all exported ADIF files to the computer that will create the merged log  
4. Launch N1MM Logger+ in the merge computer. If the merge computer is one of 

the ones that was used during the contest, you will need to create a new 
database for the merged log: >File >New Database. Now in the new database or 
on the new computer, create a new contest log for the merged records: >File 
>New Log in Database. Be careful to make the contest type identical to the 
contest type that was used during the contest  

5. Import the extracted ADIF files one after another into the new contest log: >File 
>Import >Import ADIF from file  

6. Use >Tools >Rescore Current Contest to rescore the contest  
7. Extract the new, merged contest log for submission to the contest sponsor: >File 

>Generate Cabrillo File  

6.2. Using Excel and Cabrillo Files to Merge Logs 

In some circumstances, it might be easier to combine logs outside N1MM Logger+ by 
importing the Cabrillo files into a spreadsheet program like Excel. As with the ADIF 
method, this works best if the contest types are identical, or at least use the same 
Cabrillo format (i.e. similar contest exchanges, same columns).  

1. Create a Cabrillo file from each log: >File >Generate Cabrillo file. Assign a 
unique name to each log file to distinguish it from others when importing  

2. Copy all exported Cabrillo log files to the computer that will create the merged log  
3. Combine the QSO records from each Cabrillo log into a single text file using a 

text editor (like Notepad). Open each Cabrillo file, and copy only the QSO 
records - leave out the header information in the beginning and END-OF-LOG 



statement at the end. Paste this QSO information into a new text document (a 
.TXT file) with the QSOs from every log.  

4. Launch Excel in the merge computer, and import the combined .TXT file into a 
spreadsheet. In Excel: >File >Open, set file type for TXT, and select the merged 
QSO log file. In the Excel text import wizard, declare the original data type as 
fixed width. In the Data Preview dialog window, adjust the field delimiters as 
necessary to begin each Excel column at the beginning of a log field. Press 
<Finish>. Examine the QSO columns in the spreadsheet to ensure that your 
import was successful  

5. Select the entire spreadsheet using your mouse or <ctrl-A>, then sort the 
spreadsheet by date and time: >Data >Sort, column D (date), and column E 
(time)  

6. Export the sorted log data to a space-delimited file: >File >Save as 
>FORMATTED TEXT (Space Delimited) .PRN  

7. Using an editor, copy/paste the Cabrillo header information and END-OF-LOG 
statement from one of the original Cabrillo logs into the sorted data file. Rename 
this file as a .LOG file type and submit it to the contest sponsor.  

7. How to Print the Log 

There is no specific option for printing a log directly. However, if you Click on Export on 
the File menu, there's a variety of options that can be used to create a file that you can 
then print a copy of:  

 

The most likely reason for wanting a printed log is for awards submissions or archiving. 
Because N1MM Logger+ is not intended as a general-purpose logging program, it does 
not offer award tracking functions. However the ADIF file option will give you a file that 
can be readily imported into any popular general logger. If you just want something for a 
notebook, the Generic export will give you a text file that can be printed from Notepad.  

8. How to Get Statistics 

From the View menu item in the Entry window, choose Statistics. This tool allows you to 
select any two data points of interest. For example, you can select hours for the Row 
and Zones for the Column, and the program will display a table of how many QSOs in 
which zones were worked in which clock hours. This is a lot easier to use than it is to 
explain in words, so give it a try.  

 



1.9 Finding Help 

 1 On-Line or Off-Line Documentation 

 2 N1MM Logger Discussion Groups 

 3 Tips and Tricks 

 4 Most Frequently Asked Questions or FAQ 

 5 Troubleshooting 

 

1.9.1 The On-Line Manual or Off-Line PDF Files 
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This wiki-based manual is now maintained in real-time by volunteer authors who make 
changes to this document as the program changes. If you are reading this on the web, 
you are reading the absolute latest version of the N1MM Logger+ manual. It may lag 
announced program changes by a few days, but hopefully not more than that.  

However, you may need to access the N1MM Logger+ manual from a location without 
Internet access; or you may prefer using Adobe Reader to view and search the 
manuals.  

There are two methods for accessing the pre-built copies of the documentation in 
Adobe PDF format. Instructions for downloading the files can be found here: Download 
Existing PDF Files  - these instructions are from N1MM Logger Classic, but the same 
methods should work for Plus.  

To make your own off-line copies of the current English manual (either printed paper 
copies, or electronic PDF / HTML copies), see the Off-line Copies of Wiki Documents 
chapter in the wiki Users Guide.  

 

1.9.2 N1MM Logger Discussion Groups 
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1. General Information 
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http://n1mmplus.hamdocs.com/tiki-index.php?page=On-Line+or+Off-Line+Documentation&structure=N1MM+Logger+Documentation
http://n1mmplus.hamdocs.com/tiki-index.php?page=N1MM+Logger+Discussion+Groups&structure=N1MM+Logger+Documentation
http://n1mmplus.hamdocs.com/tiki-index.php?page=Tips+and+Tricks&structure=N1MM+Logger+Documentation
http://n1mmplus.hamdocs.com/tiki-index.php?page=Most+Frequently+Asked+Questions+or+FAQ&structure=N1MM+Logger+Documentation
http://n1mmplus.hamdocs.com/tiki-index.php?page=Troubleshooting&structure=N1MM+Logger+Documentation
http://n1mm.hamdocs.com/tiki-index.php?page=Download+Existing+DPF+Files
http://n1mm.hamdocs.com/tiki-index.php?page=Download+Existing+DPF+Files
http://n1mmplus.hamdocs.com/tiki-index.php?page=Off-line+Copies+of+Website+Documents#N1MM_Users_Guide


Users of N1MM Logger Classic will be aware of the two user groups that were set up for 
N1MM Logger Classic. These groups, with literally thousands of members, are devoted 
to all aspects of N1MM Logger Classic, from proposed features to questions and reports 
of bugs.  

A new user group has been set up for N1MM Logger Plus. All the queries and reports 
related to N1MM Logger Plus should be sent to the N1MM Logger Plus user group , 
and not to the old groups.  

The development team will continue to track both old and new user groups, although 
N1MM Logger Classic was essentially frozen when N1MM Logger Plus was released.  

 
All program issues relating to N1MM Logger Plus  

Post message N1MMLoggerplus@yahoogroups.com  

Subscribe N1MMLoggerplus-subscribe@yahoogroups.com  

Unsubscribe N1MMLoggerplus-unsubscribe@yahoogroups.com  

List owner N1MMLoggerplus-owner@yahoogroups.com 

 
Everybody can read the messages from the support group. To send messages you 
have to join the group. Your first post must be approved by the moderator. This 
prevents spammers from using the list. There are close to 4000 members on the N1MM 
Logger Classic group, and we expect almost all of these users to migrate to the N1MM 
Logger Plus group during the first year or so after the release of Logger+.  

2. Rules for Posting to the Yahoo Reflector 
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1. When you report a problem you should have tried to reproduce it using the latest 
version. We don't support any but the latest version. Please include:  

1. Program version  
2. Operating system version, bits & memory  
3. CPU speed  
4. Contest name  
5. Radio types (and connection particulars if this is an radio i/f problem). 

Make sure you indicate whether you are using a usb to serial adapter.  
6. SO1V/SO2V/SO2R  
7. Any port sharing software (LP Bridge, VSPE, etc.). We don't support those 

but you are welcome to ask the group for advice.  
8. Any error code AND description in the original language and in English if 

you can translate it.  
9. Mode and method of interfacing to that mode:  

1. CW: LPT/Serial/Winkey?  
2. SSB: Sound card interface  
3. RTTY: interface, RTTY engine(s), AFSK/FSK, etc.  
4. A detailed description of the problem. Don't just say, "Hey I installed 

the program and I got an error! What's up with that? Anyone else 

http://groups.yahoo.com/groups/n1mmloggerplus


seeing that?" Save everyone some time. Document the situation in 
your post.  

2. Be proud of your callsign. Put it in every post. If you don't put it in your first post, I 
won't approve it.  

3. Don't spam. These are groups for discussing the program. People subscribed for 
that reason. They don't want for sale messages, announcements of your contest, 
or other off topic posts.  

4. Think about the topic of your post before you post it. Make the subject relate to 
the specific content of your post. The following are useless subjects:  

o N1MM  
o Hey!  
o A quick question  
o N1MM Logger bug report  

5. Add SOLVED to the title of a post that contains the solution to a problem you 
posted. PLEASE post the solution. People have put effort into helping you solve 
your problem. Do them the courtesy of posting the solution. I once sent an HF 
radio in for repair when I had accidentally turned the squelch and there was no 
audio. We all do embarrassing things. Fess up if you did something like that and 
asked for advice.  

6. Read all the posts about a subject before you post a response. If a post already 
says what you were going to say, avoid saying "me too!". It just clutters up the 
group with messages.  

7. If you have a post that is a digi problem, post it on the digi group.  
8. If you ask a question, check for answers. It is RUDE to check back 3 days later. 

Check back within an hour, 8 hours max. NEVER say, "please reply direct, I don't 
check the group for messages." If you are going to ask 4,000 people to read your 
post in order to get your problem solved, you owe it to them to have the answers 
posted on the group. Exception: You can ask for direct responses if you are 
doing a survey and post the results after compilation.  

9. Join the group before you have a problem. We approve new users several times 
a day, but sometimes we go on vacation (believe it or not) and only approve once 
a day.  

10. Post your message at the top of the message thread and include the whole 
thread. It saves us a lot of time researching problems if you follow this rule.  

11. Above all, remember that you are going before 4,000 people with your posting. 
Take some time to prepare what you are going to say, rather than just dash off 
some half-baked post. I'll never forget what Mrs. Peoples, my high school English 
teacher said about one of my error filled papers, "If you didn't bother to read this, 
why should I?"... Same thing applies here. If you want help, demonstrate your 
willingness to do your part of the work.  

 
73,  
Tom - N1MM  
posted to the reflector 2013-02-07  



 

1.9.3 Tom's N1MM Logger Tips and Tricks 
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This chapter gives some tips and tricks on using the program. All tips are from Tom, 
N1MM unless otherwise mentioned. The tips are examples how you could use the 
program, not how you should use it. That is up to you!  

1. Bandmaps, Entry Windows and the Mysteries Thereof... 
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Two Entry Windows  

Here is what you should be able to do:  

 Change keyboard focus with backslash \  
 Change keyboard and transmit focus with Ctrl+left/right arrow or toggle with the 

<Pause> key.  

 
With one vfo on one band, and another on the same or second band, you should be 
able to jump from spot-to-spot using Ctrl+up/down arrow on the main vfo. With 
Ctrl+Shift+Up/Down arrow , you should be able to jump from spot to spot on the 
secondary vfo. If your radio has dual receive (Orion, FT-1000 series), you should be 
able to listen to both VFOs at once. Alt+F12 swaps MAIN and SUB receiver. 
 
With the Orion and FT-1000 series, the way I envision this being used in S&P: You 
would find a station on the main vfo, and wait for it. In dual receive, you would used 
Ctrl+Shift Up/Down arrow to find another station that is ready to be worked. You would 
call whichever station is ready first. This could be done on two bands (SOA), or on a 
single band (MM). If one has spotted a number of calls locally (QSYing wipes the call & 
spots QSO in bandmap), one could use it on one or more bands in SO.  

Bandmaps - Clicking on a spot on either bandmap will set that vfo to keyboard & 
transmit focus, and put the call in the callframe. Double-clicking will put the call in the 
callsign field.  

Please print and read the keyboard assignments help. You will be rewarded with greater 
enjoyment of the program. Trust me.  

2. Bandmaps and the Available Window, What are They Good For... 
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The ONLY time they are to be used is for Search & Pounce AND the only thing they are 
good for is to do a quick match up of a partial call you hear on the radio with what you 
are seeing go by in the band map so you can keep moving instead of stopping to listen. 
That being said, the size of the band map can be kept small and well zoomed so it only 
shows a narrow part of the band...  

Now why you might ask?? I want to see multipliers that just got spotted at the bottom of 
the band when I'm CQ-ing up at the top of the band, or I want to see multipliers on 
another band. THAT is what the Available window is for! Learn to use it and it will serve 
you well in finding multipliers on other bands. So shrink the band maps and enlarge the 



Available window and  
be more efficient at both scanning the band yourself and grabbing spots. Now wait, 
what about if I want to tune up the band to the next multiplier, shouldn't I have more 
band map shown so I can click on the next one up the band??? NO, that is what 
Ctrl+Alt+Up Arrow/Ctrl+Alt+Down Arrow are for, if you want to click on mults use the 
Available window list instead... sort it by frequency  
if you must, but I prefer to go after the freshest spots first since they are most likely to 
still be there. 73, Dave K1TTT  

3. N1MM Logger Contest Technique 
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I can't emphasize this enough. All the pretty bandmap stuff is not there to look nice. It's 
there to help you make Q's. Here is how to do it...  

When there are lots of spots in the bandmap, you can work lots of stations with S&P. 
Start anywhere in the band. Press Ctrl+Up. Listen. Is he CLOSE to ready to be called? 
If yes, call him. If not, press Ctrl+Up again. Repeat this until you work through all the 
available Q's. This way you don't waste time listening to endless repeats when one 
station is working a weak one. I have made a 90/hr rate doing this.  

More tips: If a spot is dead, or not in a legal part of the band, use Alt+D to delete it. You 
won't have to stop at it next time.  

If you don't want to see spots for the wrong mode, right-click Allow spots for this 
contest's mode(s) only in the packet window. Be careful using this one on 80 & 40.  

Print the Key Assignments for how to jump between mults.  

Variation: You are CQ'ing, but the rate is slow. Use the S&P technique to jump between 
spots. Then quickly return to your CQ frequency with Alt+Q.  

Unassisted S&P: DO NOT TURN OFF "Show non-workable spots". The only exception 
is for Sprint contests, such as the NA Sprint, EU Sprint and AP Sprint, where stations 
change their frequency after every QSO. Here is my recommendation. Tune up or down 
the band, listening and watching the entry window for band edges, but also for calls that 
you have heard before or worked before in the callframe. If the call is unworkable, 
speed up your tuning, and find the next station. When you come to a station who is 
working someone else, type in his callsign. Work him if it is quick. If not, tune on, and 
the guy's call will be spotted. Tune up for a short time, then return to his freq with 
Ctrl+Up or Ctrl+Down. If he is ready, work him, if not repeat the process of trying to find 
another station.  

The bandmaps are not supposed to be nice & clean. They are supposed to show you 
where stations can be worked. The bandmaps can be zoomed with the numeric +/- keys 
or by right-clicking on the bandmap. It is important to know if a frequency is in use to 
save time listening to a dupe or non-workable station.  

The final, dirty little secret... What do you call a spot where there is no station? Your 
new CQ frequency...  



Rate is everything...  

4. Start of the Contest Season 
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Approaching CQWW SSB means the start of the main part of the contest season. 
Enhancements to the program will be curtailed during this part of the year to focus on 
eliminating any bugs or performance problems.  

4.1. Testing 
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Please start testing with your favorite fall/ winter contest in the autumn. Make a copy of 
ham.mdb (or whatever you have called it), and use last year's contest as a test platform. 
Why?  
Some problems only appear with larger logs. Find out performance issues. I rely on the 
users to let me know about them.  
See Before the Contest for suggestions on how to test. Be sure to test anything that is 
unusual in your station set-up, in caase a gremlin has crept in that other testers haven't 
discovered. Report what you find on the reflector.  

4.2. Key Assignments 
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Now is also a good time to review the Key Assignments. That is a good place to start to 
pique your interest in what the program can do. The Key Assignments Shortlist is great 
to print and hang beside the radio.  

4.3. Enter Sends Messages (ESM) Mode 
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If you are planning to operate CW or RTTY, you MUST learn about ESM (Enter Sends 
Messages). It reduces fatigue and errors by sending the right message each time just 
by pressing Enter. It may take you a while to understand and set up ESM, so don't leave 
this to the last minute. Believe me, those that learn to use ESM, love it.  

4.4. Dual Entry Windows 
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It would be a good idea to try those out, so you don't get frustrated during the contest. 
For your reference:  

\ backslash switches keyboard focus, Ctrl+left/right arrow and <Pause>change 
keyboard & transmit focus.  
Also, Ctrl+Fn, and Ctrl+Enter send on the radio that does NOT have focus.  

4.5. Configurer Options 
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http://n1mmplus.hamdocs.com/tiki-index.php?page=Before+the+Contest#Test


Finally, make sure you understand what settings you want for the following Configurer 
options:  

 SO2V/SO2R  
 Send corrected call  
 Send partial calls  
 Stop sending CQ when callsign changed  
 ESM only sends your call once in S&P, then ready to copy received exchange  
 Config/QSYing wipes the call & spots QSO in bandmap  

4.6. Autocompletion Mode 

old-edit  

Later in a contest, you hear a lot of stations that you have already worked, whether on 
this band or another band.  

If you check Autocompletion mode (Configurer | Other tab) the program will match the 
first characters that you typed to previous callsigns. It will then pre-fill the callsign field 
with the rest of the call. The portion of the call that you did not type will be highlighted, 
and you can remove it with the delete key. However, if you press space, the call will be 
kept in its entirety.  

This function is similar to the technique used in Internet Explorer to "guess" which URL 
you are typing.  

Some like it, some don't. Try it with an existing log that has a large number of QSOs.  

5. Log Editing 
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You should rarely/never have to use the edit window during a contest. To get back to 
your last QSO, press Ctrl+Q. To go back another QSO, use Ctrl+Q again. And again. 
To go forward, use Ctrl+A. These keys ignore QSOs made by other stations when in 
Multi-User mode. It is also much better, because you are using the same Entry window 
to edit that your fingers have gotten used to. To abandon edit of a QSO, press Escape. 
The background color of the text panes changes while in "QuickEdit" mode.  

6. Force to Log Whatever Heard 
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Ctrl+Alt+Enter will force the program to log whatever it doesn't recognize in the 
exchange field. The receive frequency is being reset to the transmit frequency.  

6.1. Country Not Found When Logging Contact (no mulitplier credit) 
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1. The preferred way to handle this is to load the latest wl_cty.dat file prior to the contest 
 



2. A second way to handle it is to force a particular call to a country with >Tools >Add 
Call to Country 

o Note that this addition will be wiped out on the next reload of the country 
file  

3. A third way to handle it is to add a note (Alt+N) to the QSO, and fix it later. >View > 
Notes will help you find those QSOs with notes  

7. Having F1 NOT Always Send CQ 
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Pressing F1 will send the F1 message. Typically, F1 is defined as the CQ-key in the 
Function keys tab in Configurer. Pressing the CQ-key (i.e. F1 will place the program in 
Run mode. If you do not want to go to automatically switch to Run mode when you 
press the CQ-key, use the {S&P} macro in the F1 S&P key (13 th row).  

8. Silence the Function Keys 
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If you want to 'silence' the function keys so they do not send anything and do not PTT 
the radio, just put a single blank space in the Fkey contents of the button you want to 
silence. A space is a real character, but not one that is transmitted, and the program 
knows not to switch the PTT in that case.  

9. How I Recommend to S&P on a New Band 
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1. Look at the Available window. Are there any Mults to be had? (You should 
already know this, since you just chose this band.)  

2. If there are mults to be worked, use Ctrl+Alt+Up/Down to jump to them on the 
Bandmap. Look at the Call-Frame for the callsign. Use your ears to decide if 
that's the station and that they are near ready to work you  

3. Jump through all the mults until you have worked those that you can in a 
reasonable time. You may need to repeat the search several times to get them 
all. Note that you don't want to spend a lot of time waiting for them. Just keep 
going up and down the band and clean 'em out  

4. Repeat the process with Q's that are available (Ctrl+up/down). When you find a 
dead frequency, try a short CQ. Maybe you can get a run going. Otherwise, clean 
out the available QSOs  

5. Once you have worked all the spotted stations (assuming assisted), start manual 
S&P. Turn on "QSYing wipes the call..." option. If a station is hard to work, just 
keep going. The call will be spotted on your computer(s) only. You can use the 
technique in steps 1-4 to work him  

6. Spot non-workable stations if you are a good typist. It's nice to know where they 
are so you don't waste time on them during the next sweep.  



10. Setting Contest Goals 
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How do you get better at contesting? One way is to set goals for yourself.  

The info window supports this by allowing you to set how many QSOs per hour you 
want to try to accomplish. As you are contesting, the four rate panes will let you know if 
you are at less than 50% of goal (red), between 50-100% of goal (yellow), or ahead of 
goal (green).  

Note whatever goals you set for an hour will continue until the hour for the next goal is 
reached.  

What if you want to beat last year's score?  

The program supports that as well. Just open LAST year's log, and click the Import 
Goals button. Choose the day (1 or 2) and press enter. You goals are now set to your 
hourly totals from last year. Don't forget to start a new log for this year!  

The goals will be kept until you reset them explicitly or until you LOAD A NEW 
DATABASE. If you forget this, the goals won't make any sense, because they will not be 
the ones from last year's version of your current contest.  

You don't want to have a different database for each (small) contest. This is a common 
misconception.  

11. Problems During a Contest 

old-edit  

What do you do if you have problems during a contest?  

1. Make sure you have a previous version of the logging program around that you 
have used successfully in the past.  

2. Make sure you have tested the program ahead of time using the modes you 
plan to use during the contest. Log a few sample QSOs. Check all the windows 
you plan to use. Connect to packet or telnet if that is your plan. You might want to 
run through a test plan.  

3. If you find problems before the contest, please send the bugs in to be fixed as 
much before the contest as possible  

4. Check the update page on the N1MM website. We frequently fix problems 
during the contest. The problems that we try to fix are either fatal ones, or low-
risk ones. Nonessential functions that present some risk to fix, are left until after 
the contest.  

12. Using Up/Down Arrows to Tune 

The Up and Down arrow keys can be used to tune your radio. If you are in S&P, then 
just use them to tune in the station you are trying to work. This is particularly good for 
packet spots.  



If you are Running, you might try this technique. Set your radio up for split, and use the 
up/down arrows as RIT.  

The amount to be tuned up/down with each keypress is set in the Configurer >Other 
tab.  

13. CW Tips 

13.1. CW Macro Tip 

old-edit  

Some calls have letter combinations where it's hard for to copy correctly. For example, 
6Y2A is often copied as BY2A. To help make your call easier to copy, Go to >Config 
>Change Packet/CW/SSB/Digital Message Buttons >Change CW Buttons, and try 
changing the default F1 and/or F4 message where * is used for your call. In this 
example, 6Y2A changes F4 from * to >6<~Y2A. 
 
Result: the 6 is sent 2 WPM slower compared to the rest of the call, and an additional 
half space is added between the 6 and Y. Try other combinations of <, >, or ~ to make 
your call easier to copy.  

13.2. Contest Spacing for CW 
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Select >Config >Ports, Mode Control, Audio, Other >Function Keys >Use Contest 
Spacing for CW. The box is default ON. This setting changes the spacing between 
words in your CW, where "N1MM 599 5" is 3 words. Default is 6 bits for "contest 
spacing". When this box is not checked, 7 bits between words is used, which is "normal 
spacing".  

14. Working Dupes 
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The default is to work them if you are the CQing station, but not to call them if you are 
S&Ping. The theory behind working dupes while running is that it's faster to work them 
than it is to argue, and you might really not be in their log. If that is the case, and they 
submit a log, you'll lose points by not working them.  

The "work dupes" option in the Configurer is for ESM and running mode. All it does is 
determine what is sent when a dupe calls you AND YOU PRESS ENTER.  
When using Enter Send Message (ESM) mode the behavior is as follows:  

 In S&P using ESM, if you press Enter with a dupe call in the Entry window 
nothing will happen (intentional), but you can always work him by pressing F4 
instead.  

 In Run, using ESM, with "Work Dupes" checked, when you press Enter you will 
send his call sign and the exchange whether he is a dupe or not. If you want to 
send "QSO B4" you can just press F6 instead.  



 If you don't have "Work Dupes" checked, then to work a dupe in Run mode you 
will have to press F5 and then F2 to send his call sign and the exchange; 
pressing Enter will send the F6 message.  

 
All that being said, you can work dupes in either situation (Run and S&P) by pressing 
the F-keys.  

A goal of the program is to promote good operating. Working dupes while running is 
good operating. That's why work dupes is the DEFAULT. It is an option because an 
argument was made that in a long exchange contest like SS, you might not want to 
automatically work dupes.  

What I suspect happened is that someone turned work dupes off while playing with the 
program. This is a complicated program. Changing options that you don't know the 
meaning of can lead to a lot of confusion. My advice is:  

1. Get the program working with your equipment  
2. Save the ini file  
3. Play with the options  
4. Discard that ini file and revert to the one from step 2  
5. Change any options you feel you truly understand and want changed  
6. If an option doesn't seem to "do anything" — watch out! You might want to set it 

back to the original setting  

15. What Setting Should I Use for Packet Spot Timeout? 
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For general DX-ing, 30 minutes is not too long. 
 
For a contest, you might want to crank it down to 20 minutes, since there is more 
movement of stations. Also, a lower timeout will mean fewer spots are managed by the 
program. This may help performance for those with marginally performing machines.  

For testing packet spot behavior when there are few spots, or for testing performance, a 
timeout setting of 1000 minutes might be right.  

16. How Should I Really Use this Program if I am Single Operator Assisted 

(SOA)? 
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Try these techniques:  

 Connect to a Telnet node. Do a sh/dx/100 to fill up the Bandmap initially.  
 Pick the band with the most mults as shown in the Available window.  
 Go to that band and use Ctrl+Alt+Up arrow and Ctrl+Alt+Down arrow to work all 

the mults on the band. Don't waste too much time on each one.  



 Go back through the band and use Ctrl+Up arrow and Ctrl+Down arrow to work 
all other stations on the band. If you find that a frequency is dead, do you know 
what you call that? You call it your new RUN frequency! Call CQ and get a run 
going.  

 When the run is over, go pick up any more mults or QSOs on this band.  
 Now, either move to another band and repeat, or try these techniques. Turn on 

"QSYing wipes the call & spots QSO in bandmap" Tune up or down through the 
band, looking for stations you haven't worked. Enter all or part of their calls, then 
tune off. The call will be "spotted" in the bandmap. You can use Ctrl+Up/Down 
arrow to work them later. Again, what do we call a dead frequency? That's right, 
it's a RUN frequency. ;-) (As you are doing this, if you can work the station 
without waiting, of course you should work it.)  

 If you don't want to type a call, and you know you don't want to work the station, 
you can mark the frequency busy with the Mark button (Alt+M).  

 As you are tuning, watch the Bandmap. It will give you big hints as to whether 
you should waste time listening to a station. If you start hearing "grumble 
grumble" 2 kHz away from the frequency marked with Joe down the street's call, 
you know to speed right by.  

17. How to Find a Worked Station in the Log? 
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There are three possibilities to find a worked call in the log. The results are shown in the 
bottom pane of the Log window.  

 When entering the beginning of a callsign in the Entry window, after 3 characters 
a worked station starting with these three characters will be shown automatically 
in the bottom pane of the Log window.  

 You can use the <?> wild-card character - for example entering N?M this is also 
enough to show N1MM and every other station that ends with N?M.  

 When you only have 1MM and missed the first part of the prefix you can place a * 
in front of the characters you have. *1MM will show N1MM and every other 
station that starts with 1MM in the callsign.  

Combinations are also possible:  

 *1?M will show N1MM but also K1MR, J41YM etc.  
 *3? or *3* will show all worked callsign with a 3 in the callsign  
 *3*Z will show every station with a 3 followed by a Z somewhere in the callsign 

like K3ZO, VA3UZ etc.  

Using a * is called a "like" search in SQL. The problem is that a "like" search is very 
slow so on slow computers this will take some time.  
In VHF contests use Alt+= (equal) and the program will search everything which 
matches the content of the callsign and the gridsquare fields.  

18. Databases versus Contests 
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There is a lot of confusion about how contests are stored in the logging program.  
To clear this up, let's start with a couple of definitions:  

Database - an Access 2000 format database file with a file extension of .mdb. Any 
number of contests may be stored in a database.  

Contest - a set of QSOs within the database. They are stored in rows in a table called 
DXLOG. Each contest row has a ContestNr which ties it to a ContestInstance entry.  

Much of the confusion comes from people thinking that they need to have only one 
contest in a /database. This is not the case. I have only one database that I log "official" 
QSOs in. (Of course I have many test & backup databases.) Why? because the 
performance of the program is not very sensitive to database size. I currently have 
about 14,000 QSOs in my database.  
Now if you plan to go on a DXpedition and log 25,000 QSOs, I would recommend a 
separate database for that. For most users, no.  

Another thing. Did you ever notice the option"Copy (and compact) Database". This is 
one I bet you never use, but should use. Deleted space in most databases is not 
recovered automatically, and Access is no exception. If you delete a contest, or delete 
contacts (see tip on deleting contacts), you will need to run this option to recover the 
space. Do you need to run it every day? No. Maybe once every 6 months would do for 
most people, or before archiving a database.  

The most important thing to remember about databases is to BACK THEM UP. 
Periodically copy your database to a backup device, or zip it up and copy to a floppy. 
Even e-mailing it to work would do! It is your entire record for all of your QSOs using the 
program. Don't lose it. Also, if you are going to import data, or delete data, that is a good 
time to back up your database. If you don't have the data any more, no one can help 
you!  

19. How to Upgrade the Database to a Newer Version? Move It to Another 

Machine? 
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The best way upgrade the database to the current version by opening it with a current 
version of the program on the first machine. Then you can open it with the same version 
on the second machine, and no database upgrades will need to be done.  

Please do a backup first!  

What is meant by a "database upgrade"? From time to time, columns, indexes, data etc. 
are added to the database. For each of those changes, the program queries the 
database to see if the change has already been made. If not, the program automatically 
makes the change. To the user of the program, this is automatic. All the user will notice 
is that program startup takes some additional time.  



This works very well. Haven't had any complaints. Nevertheless, a database that is a 
year or two since the last time it was opened will have quite a bit of updating to be done. 
Why not do it on a known, working machine?  

19.1. Deleting QSOs (especially important for Multi-User) 

old-edit  

This topic affects all users, but multi-user contesters the most.  

As part of the multi-user support, a DELETEDQS contest was implemented. When a 
contact is "deleted" with Alt+D or the Delete key, it is not really deleted. It is moved to 
the DELETEDQS contest. Yes, you could go to DELETEDQS, and remove it, but that 
would not be wise. Why?  
Because there is no reason to delete it, and there are good reasons not to. With it in 
DELETEDQS, you can recover it by exporting it to an ADIF file, changing the ADIF file 
and importing it into the original contest. That, however is not the overriding reason not 
to touch DELETEDQS. The main reason is a Multi-User reason.  

In multi-user, DELETEDQS is how I determine to "delete" a contact in the logs of other 
stations. Since no contact is ever really deleted, I need only gather all the QSOs and 
DELETEDQS logged by a station and add or update them in the other station's logs. 
This lets me avoid the danger of deleting rows in a database. Therefore, DON'T MESS 
WITH DELETEDQS during the contest. Make a backup after the contest of all the 
stations' logs. Then you can do anything you want, and I can help you recover, since 

you have a backup. If you don't follow this advice, you will not be happy.  

Oh, but if it is a dupe, that's different, right? NO! Log dupes. Cabrillo doesn't care, the 
contest sponsor doesn't care, and it doesn't hurt your score. It CAN help your score. 
Log those dupes, and DON'T delete them.  

20. QSYing Wipes the Call & Spots QSO in Bandmap 
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Have you ever noticed that the logging program will "spot" dupes in the bandmaps. That 
is, if you type in the call of a dupe then tune away from it, the entry fields will be cleared 
(wiped) and the call placed in the bandmap.  

That feature is always active. There is a similar feature that you must turn on to use. It is 
called "QSYing wipes the call & spots QSO in bandmap". It does the same thing as the 
dupe spotting, but for other calls you enter. You must be in S&P mode for this to work.  

This option is good for combing a band for stations to work during a contest. If a station 
you hear is not finishing a qso, you can move on to find another. The program will spot 
the call in bold, and you can use Ctrl+Up/Down to go back through and work the ones 
you skipped.  

21. Exchange Abbreviations 

old-edit  



What are exchange abbreviations?  
Some contests require sections, counties or other entities for the exchange. These must 
be LOGGED with standard abbreviations. The menu item >Config >Change Exchange 
Abbreviations allows you to edit them.  

What if you don't like for example the standard ARRL abbreviations? Well, you can 
enter your own. Let's say you'd like to enter CONN for CT. You can ADD CONN CT in 
the exchange abbreviation list and if you enter CONN or CT, the program will LOG CT. 
Don't replace the abbreviations that are already there. It's best to just add the ones you 
like. (I use the presence of certain abbreviations to determine whether to reload some of 
the lists.)  

22. Too Many Calls on the Bandmap! 
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What do you do if the calls are crowded together on the bandmap? You need to zoom in 
or out... 
 
There are two ways to do it. On a traditional keyboard, using the numeric pad plus (+) 
and minus (-) keys will zoom the current bandmap. The current bandmap is the one with 
the cyan frequency display. If you want to do it with the mouse, hold the cursor over the 
bandmap you want to zoom, then right click. Choose zoom in or zoom out.  

It is also possible not to show "non workable contacts". This means that only the 
stations are shown in the bandmaps which are valid QSOs in the contest and not have 
been worked before (all normally gray contacts will disappear from the bandmaps).  

23. Gray Line Openings 
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Watch for gray line openings when your sunrise or sunset match the other station's 
sunrise or sunset. You must have entered your lat/long accurately (watch the +/-) in the 
Station dialog. Your sunrise & sunset times can be found in Help/About. 
 
Sunrise & sunset for a prefix or call can be found by typing it in the entry window, and 
looking at the Info window. Note that the sunset & sunset times are for whatever central 
point in that country is specified in the loaded country file (wl_cty.dat or cty.dat).  

24. QSO Confirmation 
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Some contest rules state that the received exchange must be acknowledged for the 
QSO to count.  
If a contest sponsor wants you to acknowledge (i.e. confirm) the exchange, they mean 
for you to send "QSL", "TU", or "R" to indicate receipt.  
This does not mean a resend from the report back to the station. A resend would 
provide verification, not acknowledgment. Only under rare circumstances would you 
ever repeat the other stations exchange.  



25. Packet/telnet Button Setup 
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Here are the buttons I currently use for AR-Cluster nodes: I don't think these are 
necessarily optimal, but they give you an idea of what is possible.  
NE only means (near) New England only. (W1 & W2). The first column is the command, 
the second column is the button label. & in the button label makes it an Alt hotkey.  
Anyone want to post a similar list for other cluster software? (Please test them first.) 
Also, what about screening out cw or ssb spots when in a single mode contest?  
Note that the menu item >Tools >Clear All Spots will remove all spots from the 
bandmap. You might decide that there was too many unreadable stations in the 
bandmap. You would set a filter (below), then clear all spots. You could then use 
sh/dx/100 to refill the bandmap.  

Button text Command  

BYE BYE  

CONN C K1TTT  

DI/N DI/N  

SH/DX SH/DX/30  

USERS SH/U  

WWV SH/WWV  

Clear NE set/filters dxorigstate/off  

Yes DX set/filters dxorigcty/off  

NE only set/filters dxorigstate/pass ny,nj,ct,ri,ma,nh,vt,me  

No DX set/filters dxorigcty/pass k,ve, xe  

No VHF set/filters vhf/reject  

K1TTT {MYCALL} 

26. Move RX Frequency from the Keyboard 
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At a local club meeting last night we watched the FO0AAA video. I've seen a number of 
other DXpedition videos before and they all show the operator reaching over after each 
or so QSOs and moving the RX frequency. Given this is standard practice for 
DXpeditions, both SSB and CW, I thought it would be a useful feature to have that 
function built into the logging program.  

There are already two ways to do this in N1MM Logger.  

1) If you are in Run mode, and turn on RIT on your radio, then the Up/Down arrow keys 
change the receive frequency without changing the transmit frequency.  

2) If one sets the radio on SPLIT and TXs on the second VFO, pressing either 
UP/DOWN ARROW moves the RX frequency up or down by the amount set in the 



Config/Configure Ports/Other screen. It also works well for regular contesting. Put the 
radio on SPLIT SIMPLEX (A=B) and use the UP/DWN arrows instead of the RIT for 
those off frequency callers when you're RUNNING. (thanks, Gerry, VE6LB/VA6XDX)  

 

 

1.9.4 The Most Frequently Asked Questions 

in-edit  

 1.9.4 The Most Frequently Asked Questions  

o 1. Installation and Updating  

 1.1. Q. I just downloaded the latest update and my virus software 
told me that it is infected. Is this true?  

 1.2. Q. I just installed the program for the first time, and it won't 
start. Why?  

 1.3. Q. I haven't updated in a while. Do I need to apply each update 
in order? If I apply the latest one, and it doesn't work for some 
reason, can I go back?  

 1.4. Q. Shouldn't I install a .0 version (like 12.0.0)? Aren't the .n 
versions (e.g.,12.11.3 ) less reliable? What if the latest one has a 
bug I can't live with?  

o 2. Operating  

 2.1. Q. The program won't let me log a contact. It keeps insisting 
that something is wrong with the exchange. What can I do?  

 2.2. Q. Why doesn't F1 send my call properly in S&amp;P mode? I 
can program it into the key, but when I use it the program switches 
to Run mode and I get crossed up.  

 2.3. Q. I see spots coming in on the Packet/Telnet window, but they 
aren't appearing on the Bandmap or in the Available Mults and Qs 
window. What to do?  

 2.4. Q. I've lost my Bandmap window (or Check, or Available Mults 
& Qs, or ...). How do I get it back?  

 2.5. Q. I know that TO7M is in Martinique, but the program says 
otherwise. How do I fix this?  

 2.6. Q. When I enter my callsign in the Entry Window, the Check 
Window says "Unique". Why?  

 2.7. Q. I can't find a contest that I want to operate in N1MM 
Logger+.  

 2.8. Q. What is the difference between SO2R and SO2V?  

o 3. Interfacing  

 3.1. Q. PTT or CW isn't working properly. Why not?  

http://n1mmplus.hamdocs.com/tiki-index.php?page=Check+Window


 3.2. Q. My Icom radio gets out of sync with the program on things 
like split frequencies, and I wind up spotting the wrong frequency 
sometimes, which is embarrassing. What is wrong?  

 3.3. Q. My CW seems to stutter sometimes. Why?  
 3.4. Q. My CW weight is way off. I'm using a USB-to-serial adapter 

and keying with RTS or DTR. Why?  

o 4. Other  

 4.1. Q. I'm having trouble importing an ADIF file. Some of the 
information seems to be missing or in the wrong place.  

 4.2. Q. I want to use N1MM Logger+ as my general logging 
program, but I can't find out how to track my DXCC, or whether I 
have sent or received QSLs. Why not?  

 4.3. Q. I got a cryptic error message. What do I do?  
 4.4. Q. I posted a problem on the reflector, but it never got fixed. 

Should I do something else?  

We have tried to pull together here the most frequently asked questions. As issues 
come and go, we anticipate changing this section, hopefully frequently, so if it comes up 
in a search of the web site, it could be worthwhile to check here first. Each answer also 
contains a link or links to the manual sections that address the issue in much 
more detail. The MFAQ is not intended as a substitute for the manual.  

1. Installation and Updating 
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1.1. Q. I just downloaded the latest update and my virus software told me that it is infected. Is this true? 

A. No. Software that accesses the outside world (DX clusters, the N1MM web site, 
contest sponsors' rules) is frequently mis-identified by anti-virus software. Depending on 
which one you have, you may have to disable it, or simply tell it that the program is OK, 
but there's no way that N1MM Logger is infected.  

1.2. Q. I just installed the program for the first time, and it won't start. Why? 

A. Did you install the Latest Update after you installed the Base Install? Both are 
necessary. Did you reboot your computer after the Full Install?  

1.3. Q. I haven't updated in a while. Do I need to apply each update in order? If I apply the latest one, 

and it doesn't work for some reason, can I go back? 

A. You can simply download and install the latest update. If not, you will need to redo 
the Base Install and then install ONLY the latest update. You can generally revert to a 
recent update from the latest one without any problem. In fact, this is the recommended 
procedure if you run into a problem, since you may be able to pinpoint exactly which 
update introduced it.  

1.4. Q. Shouldn't I install a .0 version (like 12.0.0)? Aren't the .n versions (e.g.,12.11.3 ) less reliable? 

What if the latest one has a bug I can't live with? 

http://n1mmplus.hamdocs.com/tiki-index.php?page=Installing+the+Software&structure=N1MM+Logger+Documentation#Subsequent_Installation_of_the_Latest_Update_of_the_Software


A. Each new version builds on the one before, so there is no benefit to installing or 
keeping an older one. If the new release has a bug that you can't live with, and you 
need a fix before the following week, you can easily reinstall the last previous version. 
There is nothing special about .0 versions. They are just the first update of that month.  

2. Operating 

in-edit  

2.1. Q. The program won't let me log a contact. It keeps insisting that something is wrong with the 

exchange. What can I do? 

A. Ctrl+Alt+Enter will force logging any contact, and open a note window, where you 
can put something to remind you to fix the QSO after the contest is over, when you've 
discovered what was wrong.  

2.2. Q. Why doesn't F1 send my call properly in S&P mode? I can program it into the key, but when I 

use it the program switches to Run mode and I get crossed up. 

A. In N1MM Logger+ the F1 key has special attributes; in particular it automatically 
switches from S&P to Run mode, which make it problematic to use it, as some are used 
to doing, for your own callsign. F4 is customarily used for this in N1MM Logger+. Note 
that if you use ESM (Enter Sends Messages), then in S&P mode the program will send 
your callsign (F4) when you press <Enter>; in Run mode it sends your CQ message, 
which is stored in F1.  

2.3. Q. I see spots coming in on the Packet/Telnet window, but they aren't appearing on the Bandmap or 

in the Available Mults and Qs window. What to do? 

A. On the Packet/Telnet Window's right-click menu, there is a "Why don't I see Spots?" 
selection. Choose it, then follow its suggestions and set up the Packet Filters options, 
which control which spots are passed to the Bandmap and Available windows. You 
must select at least one frequency range (HF, WARC, VHF) option or nothing will go 
through.  

2.4. Q. I've lost my Bandmap window (or Check, or Available Mults & Qs, or ...). How do I get it back? 

 
A. Most likely, it is invisible because its saved location is outside the dimensions of your 
screen. For windows that are part of N1MM Logger+ itself, there is a Find All Windows 
command on the Config menu. Click on it and all windows will be moved within the 
boundaries of an 800 x 600 screen. If you still do not see the missing window, it may 
have been closed; find it on the Window menu, and click to open it again.  
There is one special case:  
Rotor: Edit N1MM Rotor.ini and change Top & Left to 0 (zero) to bring the window to the 
top left corner.  

2.5. Q. I know that TO7M is in Martinique, but the program says otherwise. How do I fix this? 

A. Callsigns are identified by country files, which are produced and updated by AD1C. 
You probably need to update your wl_cty.dat file from his website, and then load it into 
your database. If you run into this problem during a contest, your best move is to log it 
and go on, placing a note in the log with Ctl+N to remind yourself to fix the log before 

http://n1mmplus.hamdocs.com/tiki-index.php?page=ESM+%28Enter+Sends+Messages%29&structure=N1MM+Logger+Documentation
http://n1mmplus.hamdocs.com/tiki-index.php?page=Packet+and+Telnet+Window#Right_Click_Menu
http://n1mmplus.hamdocs.com/tiki-index.php?page=Entry+Window#Config_Menu_Selections
http://n1mmplus.hamdocs.com/tiki-index.php?page=Rotator+Control
http://n1mmplus.hamdocs.com/tiki-index.php?page=Entry+Window#Tools_Menu_Selections
http://n1mmplus.hamdocs.com/tiki-index.php?page=Entry+Window#Tools_Menu_Selections


you submit it. After you load the wl_cty.dat with the corrected country data, run Tools > 
Rescore Current Contest to update your Score Summary and multiplier counts.  

2.6. Q. When I enter my callsign in the Entry Window, the Check Window says "Unique". Why? 

A. The program checks entered callsigns against a master.scp file, and that message 
means that the callsign was not found. These files are prepared and updated by WA1Z, 
based on people's past contest logs. Check the Super Check Partial website  for the 
latest version and download it into your N1MM Logger+ user files area in the Support 
Files folder. These do not need to be loaded into your database; you specify which file 
to use under the Associated Files tab in the Contest Setup dialog. If you have the latest 
version and your call doesn't appear, you just need to be more active in contests.  

2.7. Q. I can't find a contest that I want to operate in N1MM Logger+. 

A. Over 250 contests and QSO parties are supported directly by N1MM Logger+. You 
can look them up here. In addition, over 100 contests have been defined using our User 
Defined Contest editor, developed by NA3M. To use one of these, you will need to copy 
the relevant UDC file from this file gallery on the web site into the UDC folder in the user 
files area, and then re-start the program - the UDC will now show up on the list of 
possible contests in the Contest Setup Dialog. A final option, if you don't find your 
contest in either place, is to write your own UDC. It's not terribly hard if you thoroughly 
understand the contest's rules.  

2.8. Q. What is the difference between SO2R and SO2V? 

A. SO2R is the "single operator two radios" mode of contesting, where you control two 
radios from one logging program. SO2V (single operator two VFOs) is a technique for 
using two VFOs on a single radio to approximate the benefit of SO2R. Because you 
cannot listen on the same radio you are transmitting on, it will never be as flexible as 
SO2R, but you can use the second VFO to work stations S&P while continuing to run on 
the first VFO, particularly when things are slow. A fuller explanation is found here.  

3. Interfacing 

3.1. Q. PTT or CW isn't working properly. Why not? 

A. The program has a lot of different ways to "key" PTT, to accommodate the wide 
variety of radios and operator preferences. From within the program, you can assert 
PTT (another, more accurate verb) by the RTS or DTR pins of a serial port, via pins on 
a parallel port, or through serial radio control, for radios that can do that. CW can be 
sent through a serial or a parallel port, or by the use of Winkey. Here are some things to 
check:  

 Make sure you have only one PTT and one CW method set for each radio. The 
program will always use the first such method it finds, reading down through the 
list of serial and parallel ports that have the "Other" checkbox checked, so if you 
have set more than one, unpredictable things may happen.  

 If you are using a Winkey, and you have it configured to control PTT (yet another 
way to do it), it will do so for stored messages on all modes, not just CW. If you 
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want something else, the easiest thing is simply to pull the PTT line out of the 
PTT jack on the back of the Winkey to disable it.  

3.2. Q. My Icom radio gets out of sync with the program on things like split frequencies, and I wind up 

spotting the wrong frequency sometimes, which is embarrassing. What is wrong? 

A. Icom radios only send the frequency of the active (selected) VFO to the program. If 
you set split frequency operation on the radio, the program is not informed, and so it will 
spot your transmit frequency instead of the received frequency as it should. The solution 
is simple - use the keyboard to enter the split receive frequency (Alt+F7, frequency or 
split, e.g. 7067 or +5, Enter) .  

3.3. Q. My CW seems to stutter sometimes. Why? 

A. N1MM Logger+'s serial and parallel port CW options are a simple and easy way to 
generate CW, but if your computer is slow, you may find the CW is not always smooth, 
particularly when receiving spots from a Telnet cluster in a busy contest. If this happens 
with serial keying, try using a parallel port if you have one. If you don't, or if you want to 
put an end to CW issues once and for all, the answer is K1EL's Winkeyer USB, which 
handles CW and all-mode PTT by offloading these functions from the computer entirely. 
It is also an excellent stand-alone keyer with 4 built-in memories.  

First make sure you don't have a weight problem (see below). If it is hesitation, not a 
consistent amount added to each dit dah or space try these things:  

 Turn off Computer sounds. (Control Panel/Sounds)  
 Turn off virus programs - if this is a cause, find another program  
 Turn off packet - your computer might be overloaded by packet  
 Turn off call lookup  
 Less severe, close multiplier windows and turn off Available window counting of 

mults & Qs  
 Try a contest with a less complex multiplier - WPX is one of the worst  
 Close other programs and processes. Use Ctl+Shift+Esc to see which ones are 

using the most  
 Get a processor with multiple cores (but not a Core2 Duo)  
 Get more memory  

 

3.4. Q. My CW weight is way off. I'm using a USB-to-serial adapter and keying with RTS or DTR. 

Why? 

A. Some adapters have a lot of latency and will mangle your CW. Usually this can be 
corrected by finding a better driver for the adapter. Make sure you are running the latest 
vendor-provided driver for your operating system, not the one the OS picks. Some 
adapters allow you to set the latency in control panel. See this article .  

For Prolific chipsets run this program: http://n1mmplus.hamdocs.com/tiki-
download_file.php?fileId=2203 This will check your Prolific adapter for compatibility and 
install the latest driver, which has worked for many users.  

http://n1mmplus.hamdocs.com/tiki-index.php?page=Supported+Radios#Icom
http://www.digi.com/support/kbase/kbaseresultdetl?id=3418


FTDI and Edgeport USB to serial adapters have proven to create the fewest problems.  

If all the dits and dahs are the same length, you may have set the radio to expect 
paddles rather than a straight key. Turn off the "electronic keyer" function in the radio.  

4. Other 

in-edit  

4.1. Q. I'm having trouble importing an ADIF file. Some of the information seems to be missing or in the 

wrong place. 

A. ADIF implementations vary widely, and it is quite common for an ADIF file produced 
by another logging program to contain ADIF "tags" that N1MM Logger does not 
recognize. Here's how we suggest proceeding, to avoid these problems:  
1. Create an instance of the contest you want to import in your current N1MM Logger 
database.  
2. Log a "dummy" QSO. If there are different types of QSOs, e.g. different exchanges 
from W/VE vs. DX stations, log at least one QSO of each type.  
3. Export an ADIF file.  
4. Compare the ADIF file produced by N1MM Logger with the one you want to import. 
Each data item in an ADIF file is preceded by a "tag" including a number denoting the 
length of the data item. Here are some examples, part of a QSO record from a general 
logging program:  
<TIME_ON:6>003039 <CALL:6>YC6JRT <MODE:3>SSB <BAND:3>10m 
<RST_SENT:2>59 <RST_RCVD:2>59 <CQZ:2>28  
If the "tag" is different than N1MM Logger uses for the same content, use a word 
processor or other editor to change it as needed.  
5. Make sure the ADIF file you want to import contains a field tagged with the 
CONTEST_ID tag, and with the same contest name as in the ADIF file exported from 
N1MM Logger.  
6.Then go ahead and do the import, and everything should be fine.  
You can reverse this process to export an ADIF file, for example to a general logging 
program.  

4.2. Q. I want to use N1MM Logger+ as my general logging program, but I can't find out how to track 

my DXCC, or whether I have sent or received QSLs. Why not? 

A. N1MM Logger+ is a contest logger. While it has "DX" and "DX Serial" generic 
"contests" that can be used for general logging, it does not have many of the features 
needed in a general logging program. The best solution is to export your contest QSOs 
from N1MM, using ADIF, and import them into one of the many excellent general 
loggers that are available.  

4.3. Q. I got a cryptic error message. What do I do? 

A. Make a detailed note of the error message number AND message as accurately as 
possible. We need that information, together with the sequence of program operations 
that resulted in the error, in order to trouble-shoot and solve the problem.  

4.4. Q. I posted a problem on the reflector, but it never got fixed. Should I do something else? 

http://n1mmplus.hamdocs.com/tiki-index.php?page=Entry+Window#File_Menu_Selections
http://n1mmplus.hamdocs.com/tiki-index.php?page=Error+Messages


A. Yes. Go to the web site and file a Bug Report. Same goes for Feature Requests. 
While we try to respond to every problem that is reported on the reflector, the structure 
of these two systems helps us keep track of what's been fixed and what still needs to 
be.  

 

1.9.5 Troubleshooting 

in-edit  

 1.9.5 Troubleshooting  

o 1. Get Current  
o 2. Try Simplifying Your Configuration  
o 3. Search the Manual - some tips  
o 4. Looking for Help on the Reflector  
o 5. Asking for Help from the N1MM Team  
o 6. Trouble with RFI?  

 6.1. Resources  

 6.1.1. Electronic keyer RFI (from Chuck Counselman, 
W1HIS)  

o 7. Trouble with Keying Delays or Radio Timeouts  

The object of this page is to suggest how to proceed when something goes wrong. If 
you take these measures before posting a query on the reflector, you will greatly 
enhance your chances of getting good, solid, usable advice the first time around.  

1. Get Current 

Make sure you are running a recent version - no more than one or two behind. This is 
absolutely necessary because of the rapid evolution of the program, with typically 50 or 
so versions released each year. If you aren't running a recent version, update and see if 
the problem goes away - it could be something that was noticed and fixed while you 
were "away."  

Every year or so, typically, Tom (N1MM) publishes a new "Full Install" version of the 
program, which contains all the files you will need to run the program. Subsequent 
updates contain only those files that have changed, so simply downloading and 
installing the most recent version won't probably be enough unless you have first 
downloaded and installed the Full Install on which it is based. You do not have to install 
every intermediate update; the updates are cumulative.  

2. Try Simplifying Your Configuration 

in-edit  

http://n1mmplus.hamdocs.com/tiki-index.php?page=TRACKER+-+N1MM+Logger+Bug+Report
http://n1mmplus.hamdocs.com/tiki-index.php?page=TRACKER+-+N1MM+Logger+Feature+Request


Problems with the program often arise as the result of changes inadvertently made to 
the overall configuration of the program or corruption of the database you were using 
the last time the program was open, so a first step is to eliminate those two possibilities.  

First, rename your N1MM Logger.ini file so that the program will not recognize it - 
N1MM Logger.old is good. Try to restart the program. If it starts, though in very 
simplified form (one Entry window, etc.), then you know the problem was somewhere in 
your configuration, as stored in the .ini file. Then you can add back your personal 
configuration choices, one at a time. Start with radio control ports, then add PTT and 
CW options. Finally, set up your general options in the Configurer, and in the various 
specialized sub-menus that you use.  

XXX CHECK THIS XXX  
If the program still won't run, then leave the simplified configuration in place and try 
renaming your database. The program should then start up and create a new empty 
database (at least, with no QSOs in it.). If it doesn't start up then, you should probably 
consider yourself cursed, and take up a new hobby.  

No, seriously, if the problem does seem to be in the database(s), you can try switching 
to another database, if you have one, or creating a new database (from the File menu), 
or perhaps creating a new database based on an existing N1MM Logger Classic (.mdb) 
database.  

If it still won't start after all that, or if the function you're having trouble with still won't 
work, now and only now try a reinstallation. A corrupted installation is rarely to blame for 
the problems people have, but if there are missing program files, this may be 
necessary. Typically, this is caused by not installing the full installer before trying to 
install and run the latest update. Even if you think you've done this correctly, it may be 
worth the few minutes necessary to reinstall.  

If you feel you need to reinstall, take an extra minute and uninstall your current version 
from the control panel. This is normally unnecessary, but recently there have been a 
case or two where the uninstallation was necessary to fix persistent problems that did 
not respond to any normal troubleshooting methods.  

× 

 Where is the program installed? 

The program files are installed in the N1MM Logger+ program files folder, which by 
default is in C:\Program Files\N1MM Logger+ (32-bit Windows systems) or C:\Program 
Files(x86)\N1MM Logger+ (64-bit Windows). User files and files that the program may 
need to write to (such as N1MM Logger.ini) are stored in the N1MM Logger+ user files 
area, which is normally a folder within your My Documents file area (e.g. 
C:\Users\User\Documents\N1MM Logger+).  
If you are making a first-time installation of the full installer, the installer will 
automatically choose these locations. Thereafter, the update installer should point to the 
same place. It is recommended that you accept the defaults. However, if you do not 
accept the default locations during the initial full install, you will want to make sure that 
the updates are being installed to the same locations as the full install. As you can 



imagine, putting the full install in one place and updates in another can cause all sorts of 
problems. It's worth a double-check.  

3. Search the Manual - some tips 

old-edit  

Now that the manual is on the website in wiki format here , we are working hard to 
keep it up to date and to fix things that may have gotten broken along the way. You can 
help by letting us know when you notice things that should be changed. Drop a note to 
n4zr@contesting.com or k8ut@arrl.net unless you think that the subject would benefit 
from others' input, in which case, by all means, use the reflector .  

So, how best to use the manual for troubleshooting? We recommend using the search 
function on the web page. This is still evolving, but you'll find the latest information on 
using it in this section of the Website User Manual. These days, the Advanced Search 
(under "Website") is far better than the basic search.  

Once you've opened a page, though, you may discover that the topic you want is 
nowhere to be seen. Don't despair, just hit Ctrl+F to open your browser's search routine, 
and enter your search phrase there. This is necessary because some of the pages in 
the manual are very long, and your search topic may not appear in the first screenful.  

If the program is so badly broken that you can't do a Google search from there, just 
open the manual .  

4. Looking for Help on the Reflector 

OK, so you're really stuck. You have over 3,000 fellow users out there willing to help. 
You can make it more likely to pay off quickly if you follow this checklist for information 
you provide in your first message:  

 N1MM program version  
 Operating system  
 Relevant interfacing information  

o For radio control, whether USB or hardware serial port, and what radio  
o For CW problems, indicate whether you are using serial, parallel or other 

interface (Winkeyer, MicroHAM, etc.)  
o For voice message problems, what interface to the radio you're using  

 Symptoms  
o Include any error messages you received, and be sure to quote them in 

full  
 What you have already tried  

5. Asking for Help from the N1MM Team 

in-edit  

OK, so you've asked for help on the reflector, and your problem persists. Chances are 
one of the development team has already contacted you and asked for more 

http://n1mm.hamdocs.com/
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information. Here's what you can do to help him help you (I apologize in advance if this 
is elementary to many people - not everyone who uses N1MM Logger+ is a computer 
jock, or indeed other than an appliance user. That's OK, but you're our particular 
audience for this note, to help you do things to help us help you)  

 Make sure that your computer operating system is showing you the complete 
filenames, including the extension. Windows defaults this off, for some reason. 
Turn it on, because you'll need it to find the files we're going to ask you for. In 
Windows 7, you can find Folder Options from the search box just above the Start 
button. In Windows XP, the same choices are found in the top frame of Windows 
Explorer  

 Find the N1MM Logger.ini file in your N1MM Logger+ user files directory  
 Then find the current database file in the databases sub-folder within the user 

files directory - the suffix will be .s3db, and it should be the one you were last 
using when your problem occurred. If you have just started, chances are it will be 
ham.s3db.  

o Note - in addition to the database file, N1MM also creates what are known 
as transaction files, which are saved in the TransactionFiles subfolder 
within the Databases folder. Don't send us this file - it is useless for 
trouble-shooting.  

o If you aren't sure, start N1MM Logger+ and look in the top bar of the Log 
window to find the database filename. If you can't start the program, right 
click on each of the .s3db files in turn, and check the "modified" date. The 
most recent one is ... no surprise here ... the one we want.  

 Send both of these files by direct e-mail to the team member offering help. You 
can't attach files to messages sent to the reflector. If you're initiating contact, you 
can send the e-mail to n4zr@contesting.com, and he will forward it as needed.  

6. Trouble with RFI? 

Many of the quirky problems people experience are due to RFI (RF interference) from 
their own transmitters. If the symptoms become less serious, or go away altogether 
when you turn down the power or change bands, or both, then you probably need to 
look at filtering common mode currents on some or all of the cables in your station 
setup.  

6.1. Resources 

Chuck Counselman, W1HIS, has published an excellent tutorial on common mode 
chokes for RFI control and even for reducing your local noise level, The article can be 
found here .  

Jim Brown, K9YC, has also written an excellent tutorial, which can be found here .  

With these two references in hand, you will be well prepared for trouble-shooting RFI 
when it occurs (not if).  

http://www.yccc.org/Articles/W1HIS/CommonModeChokesW1HIS2006Apr06.pdf
http://www.audiosystemsgroup.com/RFI-Ham.pdf


An often overlooked problem is RFI affecting an electronic keyer. Chuck Counselman's 
article on this subject, reproduced below with his permission, also makes several 
excellent points about RFI suppression in general:  

6.1.1. Electronic keyer RFI (from Chuck Counselman, W1HIS) 

RFI trouble with USB-connected products such as computer keyboards is well known. 
Less well known is the extent of RFI trouble with rig-interface and CW-keyer products 
such as as microHAM's microKeyer, microKeyer II, etc. that utilize K1EL WinKeyer ICs. 
K1EL's own WKUSB product is also quite vulnerable to RFI.  

In the case of a keyer, not only the USB interface but also the paddle interface is 
vulnerable to RFI.  

Most hams, myself included, have underestimated these products' sensitivities to RFI. 
We have made the mistake of putting too little ferrite on the cables connected to these 
products, or failing to put ferrite on all the cables connected to them, and erroneously 
thinking we have eliminated our RFI problems just because we no longer experience 
RFI symptoms when we operate on our usual band(s). Then when a higher-frequency 
band is open, or when the beam is pointed at the shack, all h*ll breaks loose.  

RFI trouble recurs also when we rearrange, add, or even disconnect a cable in our 
shacks. Every cable acts as an antenna and has discrete resonances. All the cables 
behind or under your operating desk are coupled to one another, and this coupling 
affects their resonant frequencies and modes. When I disconnected both ends of a 
telephone extension cable behind my desk, the K1EL WinKeyer IC in my microHAM 
microKeyer began misbehaving when I transmitted on the 17-m band.  

From my own and others' mistakes I have learned to avoid recurring trouble by installing 
enough ferrite the first time. "Enough" means at least 1000 ohms of common-mode 
choking resistance on _every_ cable connected to a vulnerable device. Not only the 
USB cable, but also the cables for 12-VDC power, paddle, microphone, earphones, 
footswitch, audio to/from computer and radio, CW keying to the TX, "PTT" or T/R-
switching to transceiver and to amp., data-comm. to/from transceiver — every one. You 
cannot anticipate which cable will be "hot" with RF when you transmit on a particular 
frequency. If you determine which cable is hot today, then a different cable will be hot 
tomorrow after you change something. You will change something.  

I thought that the level of RF in my shack was trivial because, if I transmitted full power 
on any band, the RF field-strength shown by my laboratory-grade meter increased by 
less than ten percent above its normal background level due to AM broadcast stations 
more than a mile away. Wrong! My microHAM microKeyer was insensitive to the AM 
broadcast signals, but it was disabled by the relatively weak signal from my 18-MHz 
transmitter.  
-Chuck Counselman, W1HIS  

7. Trouble with Keying Delays or Radio Timeouts 

in-edit  

 Verify that the radio timeout is set to 15 seconds or greater.  

http://www.k1el.com/


 All recent vintage radio interfaces are tested at baud rates of 19200 and 38400. 
Do not assume that slower baud rates will produce better results. If your radio 
supports 9600 baud and lower data rates, use 9600 baud.  

 Verify that multi-user mode is not enabled for single computer configurations.  
 Close the Digital Interface when operating CW/SSB.  
 On multi-core computers, if WinKey is configured, do not use internally generated 

CW (COM or LPT CW). Use the WinKey to send CW. Multi-core computers that 
have WinKey configured will process spots while the CW is sending.  

 If you are using Telnet, try setting the spot timeout to a low value (10 minutes).  
 Compact the database (File > Copy and Compact Database). Then restart the 

program and open the compacted database. Computers with limited disk cache 
or slower hardware interfaces may be susceptible to fragmented databases. 
Compacting the database will unfragment the database.  

 Close all possible programs. Don't place them on the task bar.  
 Close all possible N1MM Logger+ windows. Don't place them on the task bar.  
 If using any high volume spot source (RBN, skimmer, combined spot sources, 

etc), delete all spots (right click in the Bandmap) to see if this has an impact.  
 Turn off anti-virus or computer security file scanning. Many users have found that 

the free Microsoft Security Essentials doesn't seem to use many resources and 
you can set the CPU limit in percentage for scanning activities.  

 Microsoft Recovery Console has caused sending delays with internally generated 
CW on single core 2.8 GHz CPU computers. Recovery Console usually displays 
text on the screen after the BIOS boot screen and before the Windows splash 
screen. Google for the steps to un-install Recover Console.  

 
There haven't been any reports of issues with WinKey generated CW.  

Intermittent delays may be caused by any of the following:  

 Automatic Windows updates. Change the Windows setting temporarily during 
contests so Windows doesn't check for updates, install them, or force a reboot.  

 Other program update checking, downloads, and installs - again, temporarily 
disable them during contests  

 Anti-virus or computer security file scanning.  
 Unreachable time server for Windows or separate time-setting programs. Solve 

the problem, or disable the time updates for contests.  
 Windows scanning/searching/connecting to wireless networks, printer, or other 

wireless devices that may be unreachable or disconnect/connect due to RF.  
 Transmitter RF causing wired and wireless networks to disconnect.  
 Some computers may be susceptible to sending delays if the amount of free 

RAM is not great enough for all active program temporary storage. Be aware that 
some computers use system RAM for video display and reduce the memory 
available for Windows by 256Meg. The impacts of disk paging is dependent on 
the amount of data and speed of all hardware interfaces involved. The hard disk 
activity LED may be a good indicator of how often and the duration of the disk 
activity. The Task Manager, Performance tab displays Available Free Memory.  



 
When all of the above actions have failed to produce results:  

 Some users have found success by renaming the N1MM Logger.ini file. Starting 
the program will build a new file with defaults.  

 Others have had success with uninstalling and re-installing the software (Full 
Install, reboot, Latest Update). Do not use any files from the old user files area 
until you have completely verified that there was no change in the program delay.  

 Open Task Manager and look at the number of running processes after a fresh 
reboot, no programs started. WinXp processes greater than 40 or Win7 greater 
than 55 may be an indication that unexpected or unnecessary programs are 
running. There are many websites that provide instructions for eliminating 
unnecessary programs at program start.  

 For advanced computer users: Make a restore point and use HiJackThis to scan 
your computer to display every item that is loaded when the computer starts. 
Account for each item, Google unknown ID's to see if it's an unwelcome guest.  

 For advanced computer users: Measure your computer's DPC latency when 
N1MM Logger+ is running. It is well known that some drivers misbehave and add 
significant delays to the PC operation. The Flex folks have found that some 
motherboard designs are simply not acceptable for low latency tasks. The URL 
for a DPC latency measuring programs is here .  
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2.1.1 Program Installation and Setup 
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o 2. Multiple Users on a Single Computer  
o 3. Multiple ini Files  

1. Initial Installation 

Downloading and installing the program is described in detail in the Getting Started 
section of the manual, at Downloading the Software and Installing the Software. The 
purpose of this section of the manual is to document advanced methods for setting up 
the program for multiple independent configurations. Users of basic single-user 
installations who do not need more than one configuration will not need to use the 
methods described in this section, and should consult the Getting Started section 
instead.  

1.1. Comments on the Transition from N1MM Logger Classic 

The file structure is changed in N1MM+ as compared with N1MM Logger Classic. The 
program itself is now installed under C:\Program Files (or C:\Program Files(x86) on 
64-bit systems), but none of the files it writes to are stored there. All user files 
(databases, ini files, error logs, mc files, wav files, ADIF files, Cabrillo files, UDC files, 
call history files, etc.) are stored in dedicated subfolders in a Logger+ user files area, 
which by default is installed inside your personal Documents folder. The installer offers 
the capability to change either of these locations.  

Digital engine files (MMTTY, 2Tone, Fldigi) have not been rewritten, and still need to be 
stored outside the C:\Program Files path in Windows Vista, 7 and 8, just as they did 
with Logger Classic. One solution is to leave them where they were with Logger Classic 
(e.g. under C:\Hamradio\MMTTY or C:\MMTTY or ...); a second solution is to create a 
folder inside your Documents folder for digital engines. Either way works.  

Your existing message files from N1MM Logger Classic will work. A partial exception is 
SSB message files, where the default location for wav files has changed; you can either 
keep the old mc files and bury your wav files one level deeper in the wav folder (i.e. 
create a wav subfolder within the wav folder that was created during the install, and put 
any operator-specific folders within that second-level wav folder), or you can remove the 
leading wav\ from filenames in the old mc file. Either way works.  
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Call history files and UDC (User Defined Contest) files should also transfer over without 
a problem. However, the Logger's ini file(s) will *not* transfer (you will have to redo your 
hardware configuration), and we recommend that you go with the Telnet cluster list 
supplied with N1MM+. It has recently been augmented and revalidated.  

2. Multiple Users on a Single Computer 

XXX This procedure is a work in progress. It applies to separate user profiles, and may 
be moved to the Multiple Operator section, or at least referenced from there XXX  
XXX Do we need a tutorial on Windows user accounts, shared and public documents, 
and so on? XXX  

N1MM Logger+ stores the station call sign and some related data in the same database 
file where the QSOs are stored. If you are happy with a single layout and setup but want 
to use multiple call signs, you can simply create a different database for each call sign, 
and you can probably skip the rest of this section. On the other hand, if you install 
N1MM Logger+ on a computer that is used by different users who have different 
preferences as regards screen layout, which windows are open, fonts, colors, etc., or if 
you want a way to switch hardware configurations back and forth among different 
setups, you will want to learn how to set up N1MM Logger+ for multiple different 
configurations on the same computer.  

First, you need to decide whether you will restrict the changes from one configuration to 
another to those that are controlled from the N1MM Logger.ini file (in a nutshell, 
hardware configuration items that are set up in the Configurer, window layouts, and the 
initial choice of which database and contest log the program starts up in), or whether 
you want more extensive differences between configurations. For most users, the 
former capability, which existed in N1MM Logger Classic, will be enough. This capability 
is described in the next section, on Multiple ini files.  

In the most complex setups, you may wish to set the program up for different users who 
will be using different Windows user accounts. If multiple Windows user accounts are 
used, each user can have their own independent Logger+ user files area stored in their 
own personal My Documents folder. Each Logger+ user file area will only be 
accessible to that particular user. Any changes that are made in one Logger+ user file 
area will not be reflected in other user file areas. This includes everything from 
hardware configuration changes to logging of individual QSOs. Nevertheless, if you 
want to use multiple Windows user accounts but allow all users to share a single 
Logger+ user file area, for example in order to log QSOs to a single shared contest log, 
there is a way to do this. You can place the Logger+ user file area in the Windows 
Public Documents folder instead of in an individual user's My Documents folder, so that 
all user accounts on that computer will have access to that user file area and can share 
the data in it, and then create desktop icons that can be used to direct the program to 
use the Public user files area instead of the one in My Documents.  

If multiple users share a single Windows user account, by default they will also share 
access to files (databases, message files, etc.). It is possible to create multiple user file 
areas under a single account, using customized desktop or start menu icons to start the 



Logger with different configurations, as described below, but most users will not need to 
worry about this level of complexity.  

Regardless of how many user accounts you may run the program from, the program 
itself is only installed once. The installation is a normal one. The program installation, 
both for the initial install and for subsequent updates, should be done from a user 
account that has administrative privileges on that computer.  

The program files will be installed to the program files area (normally C:\Program 
Files\N1MM Logger+ on a 32-bit system, or C:\Program Files(x86)\N1MM Logger+ 
on a 64-bit system). The Logger's user file area will usually be the file area you want to 
use with the first or main configuration. In Windows 7 or 8 this would likely be 
C:\Users\[username]\Documents\N1MM Logger+ where [username] is the user name 
you log into Windows with. In Windows XP SP3, the corresponding location would be 
C:\Documents and Settings\[username]\My Documents\N1MM Logger+.  

Now, for the second configuration, create a new folder in a location that the user of the 
second configuration will have access to. If that user is you, you might simply create 
another folder in your My Documents folder and give it a name that reflects the new 
configuration. If that user is someone else who is using a different user name to log in to 
Windows on your computer, it might be a new folder in that user's personal My 
Documents folder, either called N1MM Logger+ (so it will be called up from the default 
desktop or Start Menu icon) or named otherwise for use with a customized desktop 
icon.  

Now you need a way to tell N1MM Logger+ which user file area to use. The original 
N1MM Logger+ desktop icon created during program installation will start the program 
using the configuration and database files in the original user files area when the 
program is run from the account that was used to install the Logger, or from the 
assumed default location in the local My Documents folder when it is run from a 
different account. If you want to use a customized file area, you need a way to tell the 
program to use the new user files area you just created instead of the default.  

For reasons having to do with Windows User Account Control, you might not be able to 
simply copy the desktop shortcut that was created when the program was installed. 
Instead, while logged into the Windows account from which the program will be used, 
use Windows Explorer to find the N1MMLogger.net.exe file in the N1MM Logger+ 
program folder, right-click on the file in Windows Explorer and select "Copy", then right-
click on an empty area of the desktop and select "Paste Shortcut". This should create a 
new shortcut on that user's desktop.  

Rename the new shortcut to differentiate it from the original short cut. To do this, right-
click on the new shortcut, select Rename, and type the new name reflecting the new 
configuration you will use it with into the space just below the icon.  

Now right-click on the icon once more, and select Properties from the pop-up menu. 
You should see a dialog that looks something like this:  



 

Mouse-click to the right of the highlighted program name in the Target text box, type 
one space, then the keyword UserDir= and the full pathname to the new folder between 
quotation marks, e.g. either UserDir="C:\Users\[username]\Documents\[new folder 
name]" or "UserDir=C:\Users\[username]\Documents\[new folder name]" 
(Windows 7 or 8 - in Windows XP SP3, this would be "UserDir=C:\Documents and 
Settings\[username]\My Documents\[new folder name]"). There must be no spaces 
between the UserDir and the =, or between the = and the folder name. In the screen 
shot below, I have copied that same pathname (without the UserDir= keyword) into the 
"Start in" text box; the Target text box is not wide enough to show its entire contents:  



 

Click on OK to exit the Properties dialog. The new shortcut will now start the program up 
using the user files from the new folder instead of from the original N1MM Logger+ user 
files area. The first time it is run, the program will create a new set of user files from 
scratch, just as it did in the original installation. Open the program from the new 
shortcut, enter any changes in call sign and related data into the Station Information 
dialog (Config > Change Your Station Data), use the File > New Database menu item to 
create a new database in the new Databases folder to hold contest logs using the new 
configuration, and proceed to the Configurer to do the hardware setup. You can copy 
other user files (function key message files, call history files, etc.) from the original user 
file area to the corresponding places in the new user file area to save time in setting 
them up.  

From this point on, you can use the original N1MM Logger+ desktop icon to call up the 
program using the first configuration, and the new desktop icon to call up the program 
using the second configuration. In effect, you now have two virtual copies of the 



program. You can run either virtual copy, but only one at a time - you can't have two 
copies running simultaneously in the same computer.  

You can configure each of these virtual program copies independently; any new contest 
logs you create in one copy will not be visible to the other copy, and any changes you 
make to the configuration, databases, window locations and layout, skins, and so on in 
one copy will not have any effect on the other copy. Because of this, if you add new 
hardware that requires you to make changes in the Configurer, you will have to make 
those changes in both places. If you want to share user data, such as function key 
messages or call history files, you can make changes in one place and copy the 
changed files into the corresponding location(s) in the other user file area.  

Note that if you have two configurations that are used from different Windows accounts, 
users in one Windows account will have no access to the files in the user areas under 
other Windows accounts. If you would like the ability to easily share files among users 
by copying them back and forth between different N1MM Logger+ user file areas, you 
might want to consider placing the user file areas in the Windows Public Documents 
folder. All users on the computer can have direct (no password) access to this folder (on 
some systems, public folder sharing may need to be enabled from the Control Panel to 
make this possible). By creating customized program icons on each account's own 
desktop, you can set things up so that users in multiple accounts can run the program 
using the same shared user file area. Of course, for security reasons this might be the 
exact opposite of what you want, i.e. you might want to isolate user file areas from one 
another so users cannot inadvertently or maliciously change each other's user files. In 
that case, one way to copy files between users would be to use the Public Documents 
folder as a file transfer location, while keeping the actual user files areas hidden from 
each other under different Windows user accounts.  

3. Multiple ini Files 

Previous users of N1MM Logger Classic may be familiar with an intermediate capability 
to start the program with alternative .ini files without going "whole hog" and changing the 
entire program setup. A similar intermediate capability exists in Logger+. Basically, you 
follow the same procedure that is described above for creating a desktop shortcut 
pointing to a new user file area, except that instead of using the UserDir=[path to the 
user file area] command-line option, you use instead Ini=[Filename of the desired ini 
file] in the Target text box of the desktop shortcut. There must be no spaces between 
Ini and = or between = and the filename. If the file name contains any spaces, the 
command-line argument must be enclosed in double-quotes, e.g. "Ini=SO2R RTTY.ini" 
or Ini="SO2R RTTY.ini".  

The easiest way to create such a new ini file is to make a copy of the existing N1MM 
Logger.ini file in the same folder, rename it, make a desktop shortcut including the 
command-line argument referring to the new ini file name, then run the program from 
the new desktop shortcut and make the desired changes to the program configuration 
(e.g. in the Configurer, or by changing windows layouts, skins and/or fonts). Any 
changes you make to the configuration while running the program from that ini file will 
apply on future invocations of the program from that desktop shortcut, but will not affect 
the original ini file that is used from the originally-installed desktop shortcut or from the 



Windows Start menu. You can still share the same contest log database from both ini 
files, or you can set up each ini file to point to a different database, simply by using the 
File > Open Database menu item to change the database; this change will be 
remembered in the ini file that the program was started from, but not in other ini files.  

 

2.1.2 Configurer Dialog 
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 6.1. Mode Control Field Descriptions  
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The Configurer is our name for the tabbed dialog that appears when you click Config on 
the Entry Window top menu, and then choose Configure Ports, Mode Control, Audio, 



Other. The Configurer has many tabs with program settings influencing all aspects of 
the behavior of the program. Be careful in setting up items on the different tabs, to be 
sure that you understand that the option you are choosing is what you want.  

Configurer settings are remembered by the program in the N1MM Logger.ini file, which 
is in the N1MM Logger+ user files area. Function key definitions, telnet clusters, call 
history, and country information are not saved in the .ini file, but in the database that 
was in use when you loaded them. That means, for example, that function key 
definitions loaded or modified when you are using one database will only appear in that 
database. You will need to export them from that database and load them into another 
database before they would show up there. The N1MM Logger.ini file contains the 
name of the database file you were last using, which the program will load when it is 
started, as well as the name of the current contest and other recently-opened contests.  

If you have not unchecked "Hide extensions for known file types" in Windows Explorer 
Options, you will not see N1MM Logger.ini. You will see "N1MM Logger" with a Type of 
"Configuration Settings".  

1. Configurer >Hardware tab 

The Hardware tab is used to set up your radios, packet interfaces, telnet connections, 
CW/PTT/digital ports and the interfaces to other devices, such as SO2R controllers, 
multi-purpose interfaces, and keyers, if they require serial or parallel ports. Set the 
values appropriate to your station. If you do not have one of the items listed connected 
to a port, make sure the port selection is 'None' and the check boxes are not checked 
for that port.  

1.1. Hardware setup options 

The program supports up to 8 serial ports, each of which can be anywhere in the range 
COM1-COM99, and 3 parallel ports (LPT1 - LPT3).  
Set up each port depending on what equipment is connected and enter the appropriate 
information.  



 

This example screen shot shows a case in which three COM ports are being used. 
COM6 is used for radio control of an Elecraft K3. COM2 is being used for a Winkeyer 
for CW keying. COM10 is connected to a TNC or terminal unit for RTTY. The radio has 
two receivers and the program is configured for SO2V (Single Operator, 2 VFOs) with 
two Entry windows, one for each VFO/receiver.  

A more detailed explanation of each of the controls on this window follows.  

 Port - for each device that is to be connected via a COM port, the COM port 
number is selected in this column from a pull-down list:  



 

o This list displays all of the COM ports the program was able to open. In 
this example, COM1, COM2, COM5 and COM10 were found by the 
program when the Configurer window was opened. These ports might 
include real serial ports, USB-to-serial adapters, and/or virtual serial ports 
created by software drivers (e.g. microHam Router, LP-Bridge, etc.)  

o COM6 also appears on the example list above, but with an asterisk beside 
it. The asterisk indicates that this port was previously configured at this 
position in the N1MM Logger.ini file, but when the Configurer was opened, 
the program was unable to open the port. This could be the result of a 
USB-to-serial adapter being unplugged, or as the result of other software 
that had previously created a virtual serial port but that was not running at 
the time the Configurer was opened  

 If this asterisked device is left configured for COM6, after exiting the 
Configurer the program will issue a warning that it was unable to 
open the port. The function that should be provided by this port will 
be unavailable. This can be corrected by connecting the USB 
adapter or creating the software virtual port in the other software, 
then reopening and closing the Configurer  

 If a different COM port is selected from the list, the missing COM 
port denoted by the asterisk will disappear from the pull-down list  

 Radio - The pull-down list in the box in this column can be used to select a radio 
that is to be interfaced with the program using this port for radio control, i.e. 
control of the radio's frequency and mode. A maximum of two radios can be 
connected. Select 'None' if this port is not being used for radio control. If you 
have only one radio connected, only one of the boxes in this column 
should be configured to anything other than "None"  

 Digital - Checking this box means this port is used for digital communication 
(MMTTY/MMVARI/Fldigi engine or TNC). This box cannot be checked if this port 



is used for radio control. Conversely, if this box is checked the pull-down list in 
the Radio column is disabled. Not all ports used for digital communication are 
configured here; check this box only if one of the following conditions is met:  

o Use this to indicate a port that is used for a TU or TNC for RTTY  
o Use it to indicate a port that is used for PTT from MMVARI in digital 

modes. This is not necessary with the external digital engines (MMTTY, 
2Tone and Fldigi), only with MMVARI  

o Use it to indicate a port that will be time-shared between digital and non-
digital modes. This could be, for example, a port that is used for serial port 
CW keying when the operating mode is CW, and for FSK and/or PTT 
keying when the operating mode is RTTY. The CW/Other box will also be 
checked for such a time-shared port  

 If the only time the port is used is in digital modes from MMTTY, 
2Tone or Fldigi, it is not necessary to check this check box; simply 
configure the port directly within the digital engine without setting it 
up in the Configurer  

 If you control PTT from the radio control port or from a Winkeyer, 
do not check the Digital box for that port  

 If you are using a port for FSK keying with MMTTY or MMVARI via 
the EXTFSK or EXTFSK64 add-in, the port cannot be time-shared, 
and therefore you would not check the Digital box for this port  

 CW/Other - Check this box if this port is used for CW, PTT, a footswitch, a DVK 
or an SO2R controller. This selection may be made in combination with a Radio 
or Digital selection provided the uses are compatible (e.g. Winkeyer and radio 
control cannot use the same serial port, because both use serial 
communications, whereas keying CW on the DTR control line can be compatible 
with radio control on the same port if your hardware interface supports it). In 
addition to the serial ports, the CW/Other box can also be selected for one or 
more parallel ports (LPT1/2/3) to be used for CW or PTT keying or for other types 
of device control. Of course, you must specify serial or parallel port to be used  

× 

 Configuring a Port for a Winkeyer  

To configure a port for a Winkeyer, first select a port, in the left-most column of the 
Hardware tab. Then check the CW/Other box in that same row. finally, click the Set 
button and check the Winkeyer box in the dialog that appears 

 Use ONLY ONE method of PTT or CW keying 

Note that having multiple ports configured for CW or PTT can cause problems; for 
example, having two methods of PTT control operating at the same time can result in 
the radio failing to switch to transmit, or worse, locking up in transmit at the end of a 
function key message. Pick one method of CW keying and one method of PTT control, 
check the CW/Other box for the port or ports you need for them and complete the port 
configuration using the Set button, and make sure CW/Other is not checked for ports 
that you are not currently using. For digital modes, do not configure PTT control from 



the digital engine (MMTTY or Fldigi) if you have PTT control operating from the main 
N1MM Logger program. 

 Details - Click on the Set button in this column to open a window with a set of 
controls that depends on what is selected in the preceding columns (Radio, 
Digital, Packet, CW/Other). To the right of the details column is a summary of the 
detailed settings. See below for details.  

The radio buttons in the upper right corner are used to fit the program to your desired 
mode of operation.  

 SO1V - Single Operator 1 VFO  
o In SO1V mode, the backslash, Pause, Ctrl+Right-arrow, grave accent(`) 

and Ctrl+Alt+K keys are disabled to prevent opening the second Entry 
window. If the second Entry window and/or Bandmap window were open 
when the Configurer was opened, they will be closed when exiting the 
Configurer after selecting SO1V  

 SO2V - Single Operator 2 VFO (one radio, using both VFOs)  
o Permits using two separate Entry windows, one for each VFO; the full 

SO2V functionality is usable only with radios that have dual receivers  
 SO2R - Single Operator 2 Radios  

o Permits using two separate Entry windows, one for each radio  

1.2. Set button examples 

Some examples of the dialog box that appears when you click on the Set button are 
given here.  



For a port selected for radio control:  

 

 Speed - The speed of the serial port (check the manual of your radio)  
 Parity - The parity used (check the manual of your radio)  
 Data Bits - The number of data bits used (check the manual of your radio)  
 Stop Bits - The number of stop bits used (check the manual of your radio)  
 DTR - The following selections can be made for DTR (pin 4 on DB9 connector):  

o PTT - used for keying the radio  
o CW - used for sending CW to the radio  

 Note: The PTT and CW selections require either a keying circuit 
between DTR and the radio's PTT input or CW key jack, or a 
transceiver that can accept direct switching on the DTR line on its 
radio control port (such as an Elecraft K3). The CW/Other check 
box in the main Configurer window must be checked to enable PTT 
or CW switching via DTR  

o Always on - DTR is always 'high'  
o Always off - DTR is always 'low'  
o Handshake - DTR is used for handshaking  

 RTS - The same selections as for DTR can be made for RTS (pin 7 on DB9 
connector):  

o PTT - used for keying the radio  
o CW - used for sending CW to the radio  

 Note: The PTT and CW selections require either a keying circuit 
between RTS and the radio's PTT input or CW key jack, or a 
transceiver that can accept direct switching on the RTS line on its 
radio control port (such as an Elecraft K3). The CW/Other check 



box in the main Configurer window must be checked to enable PTT 
or CW switching via RTS  

o Always on - RTS is always 'high'  
o Always off - RTS is always 'low'  
o Handshake - RTS is used for handshaking  

 When both RTS and DTR are set to PTT they will both be keyed for 
PTT with the set PTT delay  

 When using a self-powered interface for radio control, set DTR 
and/or RTS to Always On to supply power to the interface  

 Icom Addr (hex) - The hex address for the radio. Enter without the "H" i.e. 26 
not 26H. This field is only shown when an Icom is the selected radio  

 Radio Nr - The radio controlled from this port:  
o In SO1V (one radio, one VFO used) Radio Nr = 1  
o In SO2V (one radio, two VFOs) Radio Nr = 1  
o In SO2R select the radio (1 or 2) that will be controlled from this port  

 PTT Delay (msec) - This box only appears if DTR or RTS is set to PTT. It is 
used to configure a delay between the time the PTT signal is switched and CW 
sending starts, in order to prevent hot-switching  

 Enable Both Hardware & Software - This check box allows both hardware and 
software PTT control methods to be used. USE WITH CAUTION. With some 
radios, using software and hardware PTT control at the same time can lead to 
problems such as the radio hanging up in transmit at the end of CW or RTTY 
messages  

 Allow ext. interrupts - Allow external interrupts from this port (DSR - pin 6), e.g. 
from a footswitch. An interrupt on this line will bring focus to the Entry window 
and stop a CQ in progress. See FootSwitch settings below  

 PTT via Radio Command Digital Mode - If this check box is checked, a 
software radio command will be used to control PTT in digital modes  

 PTT via Radio Command SSB Mode - If this check box is checked, a software 
radio command will be used to control PTT in SSB modes  

 PTT via Radio Command CW Mode - If this check box is checked, a software 
radio command will be used to control PTT in CW mode  

o By using these check boxes selectively, you can choose to control PTT in 
some modes and not others (e.g. controlling PTT in digital modes for FSK 
RTTY while using VOX for SSB and QSK for CW)  

 FootSwitch - Pin 6 on the serial port can be used for one of the following options 
(if the interface allows this line to be broken out from the radio control lines and 
external interrupts are enabled on this port):  

o None - No footswitch  
o ESM Enter - Pressing Footswitch will cause the same action as pressing 

Enter key in ESM mode  
o Typing Focus - Pressing Footswitch will switch typing focus  
o Switch Radios - Pressing Footswitch will switch the radios (in SO2R)  
o Normal - Pressing the footswitch it will behave if it was connected to the 

PTT of the active transmitter and is automatically connected to the proper 



(active) radio.When the footswitch is released the focus will be set to main 
Entry window  

o F1 - Pressing Footswitch will cause the same action as pressing function 
key F1  

o F2 - Pressing Footswitch will cause the same action as pressing function 
key F2  

o F3 - Pressing Footswitch will cause the same action as pressing function 
key F3  

o F4 - Pressing Footswitch will cause the same action as pressing function 
key F4  

o F11 - Pressing Footswitch will cause the same action as pressing function 
key F11  

o F12 - Pressing Footswitch will cause the same action as pressing function 
key F12  

o Band lockout - Implemented mostly for multi user stations to block a 
second signal on the same band/mode. It may be useful for single users 
as well. This mode should allow you to control PTT for both radios (in case 
of SO2R) in different modes (SSB/CW). The advantage of using it 
(compared to a foot switch directly connected to the radio) is that it stops 
AutoCQ and Dueling CQ's  

 It is possible to connect a separate footswitch to each serial or 
parallel port. A pull-up resistor is needed between DSR input (pin 6) 
and +12 VDC. Multiple footswitches (one per port) can be used with 
different settings for each one.  

 Help - used to display Help for the Configurer from the on-line manual  
 OK - save the settings and exit this dialog window  
 Cancel - exit this window without saving the settings  



 
For a port whose CW/Other check box is checked:  

 

 DTR - The following selections can be made for DTR (pin 4 on DB9 connector):  
o PTT - used for keying the radio  
o CW - used for sending CW to the radio  

 Note: The PTT and CW selections require a keying circuit between 
DTR and the radio's PTT input or CW key jack  

o Always on - DTR is always 'high'  
o Always off - DTR is always 'low'  
o Handshake - DTR is used for handshaking  

 RTS - The same selections as for DTR can be made for RTS (pin 7 on DB9 
connector):  

o PTT - used for keying the radio  
o CW - used for sending CW to the radio  

 Note: The PTT and CW selections require a keying circuit between 
RTS and the radio's PTT input or CW key jack  

o Always on - RTS is always 'high'  
o Always off - RTS is always 'low'  
o Handshake - RTS is used for handshaking  

 Radio Nr - The radio that this port is used with:  
o In SO1V (one radio, one VFO used) Radio Nr = 1  
o In SO2V (one radio, two VFOs) Radio Nr = 1  
o In SO2R select the radio (1 or 2) that this port is used with  

 PTT Delay (msec) - This box is used to configure a delay between the time the 
PTT signal is switched and CW sending starts, in order to prevent hot-switching 
an amplifier, for example  



 Allow ext. interrupts - Allow external interrupts from this port (DSR - pin 6), e.g. 
from a footswitch. An interrupt on this line will bring focus to the Entry window 
and stop a CQ in progress  

 Winkey - Select when using a Winkeyer. Speed, Parity, Data bits, Stop bits or 
Handshake settings do not have to be adjusted; they are fixed and set by the 
program. Settings for the keyer are made on the Winkeyer tab in the Configurer. 
If you select Winkeyer, DO NOT set DTR to CW.  

o Note: Only one Winkeyer is supported, but a single Winkeyer can key two 
radios  

 Two Radio Protocol - Support for an SO2R controller using a COM port. This 
provides USB-only SO2R control (no LPT port required). Protocol used may be 
either the microHam proprietary protocol (MK2R) or OTRSP (Open Two Radio 
Switching Protocol)  

o More info in the Digging Deeper chapter on supported hardware  
 FootSwitch - Pin 6 on the serial port can be used for one of the following options 

(if external interrupts are enabled on this port):  
o None - No footswitch  
o ESM Enter - Pressing Footswitch will cause the same action as pressing 

Enter key in ESM mode  
o Typing Focus - Pressing Footswitch will switch typing focus  
o Switch Radios - Pressing Footswitch will switch the radios (in SO2R)  
o Normal - Pressing the footswitch it will behave if it was connected to the 

PTT of the active transmitter and is automatically connected to the proper 
(active) radio.When the footswitch is released the focus will be set to main 
Entry window  

o F1 - Pressing Footswitch will cause the same action as pressing function 
key F1  

o F2 - Pressing Footswitch will cause the same action as pressing function 
key F2  

o F3 - Pressing Footswitch will cause the same action as pressing function 
key F3  

o F4 - Pressing Footswitch will cause the same action as pressing function 
key F4  

o F11 - Pressing Footswitch will cause the same action as pressing function 
key F11  

o F12 - Pressing Footswitch will cause the same action as pressing function 
key F12  

o Band lockout - Implemented mostly for multi user stations to block a 
second signal on the same band/mode. It may be useful for single users 
as well. This mode should allow you to control PTT for both radios (in case 
of SO2R) in different modes (SSB/CW). The advantage of using it 
(compared to a foot switch directly connected to the radio) is that it stops 
AutoCQ and Dueling CQ's  

 It is possible to connect a separate footswitch to each serial or 
parallel port. A pull-up resistor is needed between DSR input (pin 6) 
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and +12 VDC. Multiple footswitches (one per port) can be used with 
different settings for each one.  

 Help - used to display Help for the Configurer from the on-line manual  
 OK - save the settings and exit this dialog window  
 Cancel - exit this window without saving the settings  

 
For a COM port for which the Digital check box has been checked, either in order to use 
a TNC or to time-share the port:  

 

 DTR - The following selections can be made for DTR (pin 4 on DB9 connector); if 
the port is time-shared, these selections will only apply in non-digital modes:  

o PTT - used for keying the radio  
o CW - used for sending CW to the radio  

 Note: The PTT and CW selections require a keying circuit between 
DTR and the radio's PTT input or CW key jack. The CW/Other 
check box in the main Configurer window must be checked to 
enable PTT or CW switching via DTR  

o Always on - DTR is always 'high'  
o Always off - DTR is always 'low'  
o Handshake - DTR is used for handshaking  

 RTS - The same selections as for DTR can be made for RTS (pin 7 on DB9 
connector); if the port is time-shared, these selections will only apply in non-
digital modes  

o PTT - used for keying the radio  
o CW - used for sending CW to the radio  



 Note: The PTT and CW selections require a keying circuit between 
RTS and the radio's PTT input or CW key jack. The CW/Other 
check box in the main Configurer window must be checked to 
enable PTT or CW switching via RTS  

o Always on - RTS is always 'high'  
o Always off - RTS is always 'low'  
o Handshake - RTS is used for handshaking  

 Radio Nr - The radio this port is used with:  
o In SO1V (one radio, one VFO used) Radio Nr = 1  
o In SO2V (one radio, two VFOs) Radio Nr = 1  
o In SO2R select the radio (1 or 2) that this port is used with  

 Dig Wnd Nr - This MUST be set to indicate which Digital Interface window uses 
this port. If it is set to 0, the port will not be used in digital modes  

o If only one DI window is used (e.g. SO1V), select 1  
o If two DI windows are used, select the DI window number this port will be 

used for  
 Allow ext. interrupts - Allow external interrupts from this port (DSR - pin 6), e.g. 

from a footswitch. An interrupt on this line will bring focus to the Entry window 
and stop a CQ in progress; non-digital modes only  

 FootSwitch - Pin 6 on the serial port can be used for one of the following options 
(if the interface allows this line to be broken out and external interrupts are 
enabled on this port):  

o None - No footswitch  
o ESM Enter - Pressing Footswitch will cause the same action as pressing 

Enter key in ESM mode  
o Typing Focus - Pressing Footswitch will switch typing focus  
o Switch Radios - Pressing Footswitch will switch the radios (in SO2R)  
o Normal - Pressing the footswitch it will behave if it was connected to the 

PTT of the active transmitter and is automatically connected to the proper 
(active) radio.When the footswitch is released the focus will be set to main 
Entry window  

o F1 - Pressing Footswitch will cause the same action as pressing function 
key F1  

o F2 - Pressing Footswitch will cause the same action as pressing function 
key F2  

o F3 - Pressing Footswitch will cause the same action as pressing function 
key F3  

o F4 - Pressing Footswitch will cause the same action as pressing function 
key F4  

o F11 - Pressing Footswitch will cause the same action as pressing function 
key F11  

o F12 - Pressing Footswitch will cause the same action as pressing function 
key F12  

o Band lockout - Implemented mostly for multi user stations to block a 
second signal on the same band/mode. It may be useful for single users 
as well. This mode should allow you to control PTT for both radios (in case 



of SO2R) in different modes (SSB/CW). The advantage of using it 
(compared to a footswitch directly connected to the radio) is that it stops 
AutoCQ and Dueling CQ's  

 It is possible to connect a separate footswitch to each serial or 
parallel port. A pull-up resistor is needed between DSR input (pin 6) 
and +12 VDC. Multiple footswitches (one per port) can be used with 
different settings for each one.  

 Help - used to display Help for the Configurer from the on-line manual  
 OK - save the settings and exit this dialog window  
 Cancel - exit this window without saving the settings  

 
For an LPT port:  

 

 Pin 17 - always used for CW keying; greyed out because it cannot be changed  
 Pin 16 - used for PTT, except when an external DVK is used; greyed out 

because it cannot be changed  
 Radio Nr - The radio that this port is used with:  

o In SO1V (one radio, one VFO used) Radio Nr = 1  
o In SO2V (one radio, two VFOs) Radio Nr = 1  
o In SO2R select the radio (1 or 2) that this port is used with  

 If using an LPT SO2R box, set the Radio Nr for the first LPT port to 
Both. Pin 14 will be used to select the radio for CW, PTT, etc.  

 If using band data lines with this setup, band data for the first radio 
is routed to the first LPT port (Radio Nr = Both) and band data for 
the second radio is routed to the second LPT port (Radio Nr = 2)  

 LPT Port Numbers 



With N1MM, SO2R and LPT CW, the LOWEST numbered port must have the CW 
output set to BOTH if it is used with a conventional LPT SO2R box (DXD, KK1L, N6BV, 
etc.) or microHAM MK2R/MK2R+ in LPT (Classic auto control) mode, The LPT with 
CW, PTT and the TX/RX/Split controls must be connected to the SO2R controller. If 
N1MM is configured for CW on TWO LPT ports (first port: Radio=1, second port 
Radio=2) then CW will be present only on the port representing the radio with transmit 
focus. 

 PTT Delay (msec) - This box is used to configure a delay between the time the 
PTT signal is switched and CW sending starts, in order to prevent hot-switching 
an amplifier, for example  

 Allow ext. interrupts - Allow external interrupts from pin 15, e.g. from a 
footswitch. An interrupt on this line will bring focus to the Entry window and stop 
a CQ in progress  

 DVK - DVK interface for MK2R, W9XT & other external DVKs. See this page for 
detailed information, pinouts, and limitations  

o When DVK is selected, Antenna selection via the LPT port is disabled (the 
DVK pins and the antenna pins on the LPT port overlap)  

o When using an external DVK, all of the Run and S&P SSB function keys 
should be set to empty.wav and not left blank  

o microHAM MK2R: if DVK is checked, N1MM Logger will use the DVK in 
Router instead of its own DVK support  

 FootSwitch - Pin 15 on the parallel port can be used for one of the following 
options:  

o None - No footswitch  
o ESM Enter - Pressing Footswitch will cause the same action as pressing 

Enter key in ESM mode  
o Typing Focus - Pressing Footswitch will switch typing focus  
o Switch Radios - Pressing Footswitch will switch the radios (in SO2R)  
o Normal - Pressing the footswitch it will behave if it was connected to the 

PTT of the active transmitter and is automatically connected to the proper 
(active) radio.When the footswitch is released the focus will be set to main 
Entry window  

o F1 - Pressing Footswitch will cause the same action as pressing function 
key F1  

o F2 - Pressing Footswitch will cause the same action as pressing function 
key F2  

o F3 - Pressing Footswitch will cause the same action as pressing function 
key F3  

o F4 - Pressing Footswitch will cause the same action as pressing function 
key F4  

o F11 - Pressing Footswitch will cause the same action as pressing function 
key F11  

o F12 - Pressing Footswitch will cause the same action as pressing function 
key F12  
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o Band lockout - Implemented mostly for multi user stations to block a 
second signal on the same band/mode. It may be useful for single users 
as well. This mode should allow you to control PTT for both radios (in case 
of SO2R) in different modes (SSB/CW). The advantage of using it 
(compared to a footswitch directly connected to the radio) is that it stops 
AutoCQ and Dueling CQ's  

 It is possible to connect a separate footswitch to each serial or 
parallel port. A pull-up resistor is needed between DSR input (pin 6) 
and +12 VDC. Multiple footswitches (one per port) can be used with 
different settings for each one.  

 CW/PTT Port Addr - specify port address (Required!)  
o The initial default address in this box, if there is one, may not be correct in 

some computers or for some add-in cards; if the port does not work, check 
the port's properties in Device Manager to determine the correct address. 
There is more information on this topic in the Interfacing chapter  

 Help - used to display Help for the Configurer from the on-line manual  
 OK - save the settings and exit this dialog window  
 Cancel - exit this window without saving the settings  

 
Additional signals are also present on the parallel port. See Radio Interfacing for more 
detailed info.  

1.3. PTT Options 

Originally, Push-to-Talk (PTT) was actually a copyrighted term, describing how 
operators of one company's radios could press a button on their microphones to switch 
from Receive to Transmit. Over the years, however, it has come to denote any form of 
transmit/receive switching external to the radio. It could be as simple as a microphone 
button or a footswitch working directly with the radio, or as sophisticated as control by a 
logging program.  

N1MM Logger+ provides several options:  

 PTT via serial or parallel port - This option uses the RTS or DTR lines on a serial 
port or pin 16 on an LPT port. This more-or-less standard method usually 
requires a simple one-transistor interface to switch the radio. USB-to-serial 
adapters can be used for this function; ordinary USB-to parallel (printer) adapters 
will not work, because they lack the ability to control individual lines in the parallel 
interface - the one exception is the SO2RXLAT interface developed by PIEXX.  

 PTT via Winkeyer - If a Winkeyer, a keyer that emulates the Winkeyer, or an 
interface incorporating a Winkeyer chip is used, its PTT output can be used in all 
modes to control transmit/receive switching.  

 PTT via radio command - For radios that support it, this option eliminates any 
need for external hardware other than a serial port cable or a serial to USB 
converter. Check your radio manual for details.  
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Warning: At the moment, there is no provision for both controlling radio PTT via 
radio command and simultaneously introducing a delay before the Logger begins 
to send a stored message, so if you need to protect external equipment (see 
below) you should not use this option.  

1.3.1. PTT delay 

This is an important aspect of PTT operation. Some amplifiers are slower than many 
radios, so if the radio begins to transmit as soon as PTT is asserted, it may result in hot-
switching of the amplifier's internal transmit/receive relays, which can result in damage. 
In addition, for VHF operation, preamplifiers located at the antenna may need to be 
properly sequenced to avoid damage from transmitted RF.  

 In the case of PTT via serial or parallel port, this delay is set in the Configurer, on 
the Hardware tab, when configuring a port for PTT. Note that for a serial port, you 
will only see this option if you have first selected PTT on either RTS or DTR.  

 For Winkeyer PTT, set this delay (called lead-time in Winkeyer parlance) on the 
Winkeyer tab of the Configurer. This affects both hand-sent CW and stored 
messages. You will probably find that any value over 20 milliseconds (probably 
enough for most amps) throws off your hand-sent keying.  

1.4. Other Information 

Under 32 and 64 bit bit Windows operating systems, using the parallel and serial ports 
for PTT and CW keying requires a special dll called inpout32.dll. This dll is installed with 
the Logger, but if the file is not installed for some reason, information on finding and 
installing it can be found in the Installation chapter.  

2. Configurer >Function Keys Tab 
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Function key operation is controlled from this tab.  

2.1. Function Keys Field Descriptions 

 Send leading zeros in serial numbers - Send leading zeros to make into 3 digit 
number. In CW: Select leading T with the Cut Number Style selector. RTTY: In 
RTTY zeros will be added, so 1 will become 001  

 Send cut numbers - In CW this causes serial numbers, and RSTs if you are 
using the {SENTRSTCUT} macro, to be sent using the Cut Number Style set at 
the bottom of the dialog. Ctrl+G can be used to toggle this option while operating. 
The new status after toggling will be shown in the status line at the bottom of the 



entry window. Numbers other than serial numbers and {SENTRSTCUT} will not 
be affected by this option. This option does not apply to SSB or digital modes  

 Send corrected call before end of QSO - If the callsign is corrected after 
answering a call, then the corrected call will be sent before the End of QSO 
message (as configured by the End of QSO Key). E.g. 'PA1M TU DE N1MM' 
instead of 'TU DE N1MM'  

 Send partial calls - CW only. When sending a partial corrected call only the 
corrected part will be send (prefix or suffix). If not checked the whole call will be 
sent  

 Use CW contest word spacing - This setting changes the spacing between 
words in your CW, where "N1MM 599 5" is 3 words. Default is 6 bits for "contest 
spacing". When box is not checked, 7 bits between words is used, which is 
"normal spacing"  

 Stop sending CQ when callsign is changed - Typing a character in the callsign 
field will stop a (repeated) CQ  

 ESM sends your call once in S&P, then ready to copy received exchange - 
This is often called the "Big Gun / Little Pistol switch" . When selected and in 
Enter Sends Message mode the cursor moves to the Exchange field when there 
is something in the Callsign field and Enter is pressed (so it does not keep the 
cursor in the callsign field). If you don't usually get a station on the first call then 
deselect this option. Read more about Big Gun \ Little Pistol operation under 
ESM  

 Work dupes when running - This determines what is sent when a dupe calls 
you and you press Enter in ESM. Normally you DO want to work dupes, so this 
box would normally be checked. See the chapter Off topic for a discussion  

 String to use on cw between his call key and exchange key (default is one 
space) - Just as it says. Example ' ur '  

 Keycode of Ins Key Substitute - Enter the number for the Ins Key substitute as 
mapped below in this configurer dialog. Defaults to 186, the ; character. The 
program can automatically enter the keycode in this field . Place the cursor in the 
keycode field and press the key you want to substitute, it will put the correct 
keycode in. 186 is an extended key code. Not all keyboards map keys the same 
way. Note that you can't use a Shift, Ctrl, Alt etc. key. I would not advise using a 
key like Numeric + that is already in use. It may or may not work. In this case 
Numeric +, does NOT work  

 Keycode of TU/Log Key Substitute - Enter the number for the TU/Log Key 
substitute as mapped below in this configurer dialog. Defaults to 222, the ' 
character. The program can automatically enter the keycode in this field . Place 
the cursor in the keycode field and press the key you want to substitute, it will put 
the correct keycode in. 222 is an extended key code. Not all keyboards map keys 
the same way. Note that you can't use a Shift, Ctrl, Alt etc. key. I would not 
advise using a key like Numeric + that is already in use. It may or may not work. 
This particular case (Numeric +) does NOT work  

 Cut Number Style - the following cut number styles can be chosen:  
o T1234567890 (leading T) - leading 0 will be replaced with a T. So 007 will 

become TT7 and 030 will become T30  
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o O1234567890 (leading O) - leading 0 will be replaced with an O. So 007 
will become OO7 and 030 will become O30  

o T123456789T (all T) - all zeros will be replaced with a T. So 007 will 
become TT7 and 030 will become T3T  

o O123456789O (all O) - all zeros will be replaced with an O. So 007 will 
become OO7 and 030 will become O3O  

o T12345678NT (TN) - all zeros will be replaced with a T, all nines with an 
N. So 097 will become TN7 and 090 will become TNT  

o O12345678NO (ON) - all zeros will be replaced with an O, all nines with 
an N. So 097 will become ON7 and 090 will become ONO  

o TA2345678NT (TAN) - all zeros will be replaced with a T, all nines with an 
N, all ones with an A. So 091 will become TNA and 190 will become ANT  

o TA234E678NT (TAEN) - all zeros will be replaced with a T, all nines with 
an N, all ones with an A, all fives with an E. So 091 will become TNA and 
1590 will become AENT  

o TAU34E67DNT - the zero, one, two, five, eight, nine will be replaced with 
a T, A, U, E, D, N respectively  

2.2. Remapping Function Keys 

Select which function keys to send messages. Each type of message has a combo box 
for you to set the appropriate function key. If the program is sending the wrong message 
check here first. The only restriction is that a key must mean the same thing in Running 
and in S&P. Function keys do not have to be unique for a selected message. There is 
little reason to do so although if you want it can be done. For the following messages a 
function key can be selected  

 CQ Key - defaults to F1  
 Exchange Key - defaults to F2  
 End of QSO Key - defaults to F3  
 His Call Key - defaults to F5  
 My Call Key - defaults to F4  
 QSO B4 Key - defaults to F6  
 Again Key - defaults to F8 (can be disabled)  
 Next Call Key - defaults to Disabled  

ESM 
Mode 

Work 
dupes 
when 
running 

Mode 
QSO B4 
Key 

Again 
Key 

Action Result action  

On 
don't work 
dupes 

Run Disabled F-key 
DUPE callsign 
entered 

Send AGN message 
when Enter pressed  

On 
don't work 
dupes 

Run Disabled Disabled 
DUPE callsign 
entered 

Send the EXCH when 
Enter is pressed, 
station will be worked 
and logged with Enter, 



Enter  

On 
don't work 
dupes 

S&P Disabled F-key 
DUPE callsign 
entered 

Pressing Enter does 
nothing, no blue 
buttons in the Entry 
window  

On 
don't work 
dupes 

S&P Disabled Disabled 
DUPE callsign 
entered 

Pressing Enter does 
nothing, no blue 
buttons in the Entry 
window  

On work dupes Run - Disabled 

DUPE callsign 
entered. 
Mistake with 
received QSO 
data 

Send EXCH when 
Enter is pressed  

On 
don't work 
dupes 

Run - Disabled 
Mistake with 
received QSO 
data 

Send EXCH when 
Enter is pressed  

On - S&P - Disabled 
Mistake with 
received QSO 
data 

Send EXCH when 
Enter is pressed. After 
the user corrects the 
entry, it will log and not 
send anything 

 

3. Configurer >Digital Modes Tab 



 

The Digital modes tab is used to set up the interfacing to external Controllers (TNCs), or 
to digital engines (MMTTY/MMVARI/Fldigi/2Tone) for sound card digital modes.  

In SO1V mode, there is only one Digital Interface window, DI-1. In SO2V and SO2R 
modes, there are two Digital Interface windows, DI-1 and DI-2. Each DI window is 
associated with one of the two Entry windows. Each DI window is opened from the 
Window > Digital Interface menu item in the corresponding Entry window. The Digital 
Modes tab in the Configurer is used to configure both Digital Interface windows. The 
scrren shot above is for a two-radio setup in which the first radio is using a TNC (such 
as a PK-232) for RTTY, while the second radio is using MMTTY for AFSK RTTY.  

3.1. Digital Modes Field Descriptions 



 Digital Interface 1 / 2  
o TU type  

 None  
 Soundcard - use this selection for MMTTY, 2Tone, MMVARI or 

Fldigi sound card software  
 Other - use this selection for a TNC or TU such as a PK-232 or 

KAM  
 Dxp38 - for the HAL DXP-38 TU  

o Port, Speed, Parity, Data Bits, Stop Bits, Flow Control - Used when 
Other or Dxp38 is selected, to set the parameters for the COM port used 
to communicate with the TNC or TU (e.g. 9600 baud, N, 8, 1, no flow 
control for the DXP-38)  

 DI-1 MMTTY Mode | DI-2 MMTTY mode  
o When using MMTTY, select whether AFSK or FSK is being used  
o The serial port MMTTY will use for PTT and FSK has to be set in the 

MMTTY Setup. More information in the MMTTY support chapter  
 DI-1 MMTTY Path | DI-2 MMTTY Path  

o The path to the MMTTY engine goes here including the file name of the 
program  

o The path and file name can be selected using the Select buttons  
o The two instances of MMTTY should be in two separate folders. You must 

do this if you want the MMTTY settings in the two instances to be different 
(e.g. left vs. right channel, different sound cards, etc.)  

 DI-1 Fldigi Path | DI-2 Fldigi Path  
o The path to the Fldigi engine goes here including the file name of the 

program  
o The path and file name can be selected using the Select buttons  

 DI-1 MMVARI RTTY Mode | DI-2 MMVARI RTTY Mode  
o When using MMVARI for RTTY, select whether AFSK or FSK is being 

used  
o If AFSK is selected the serial port (if any) with a check in the Digital check 

box and with Dig Wnd Nr corresponding to the DI window number will get 
passed to MMVARI when the DI window is opened, so that MMVARI can 
use it for PTT control  

o If FSK is selected, the port to be used for PTT control is not passed to 
MMVARI. It must be defined in the FSK8250, EXTFSK or EXTFSK64 
setup window  

 DI-1 MMVARI FSKPort | DI-2 MMVARI FSKPort  
o Choose FSK8250 if you are using a true serial port or a device that can 

simulate a serial port and handle 5-bit codes at 45.45 baud (this does not 
include most consumer-grade USB-to-serial adapters, but it does include 
some commercial interfaces, such as interfaces specifically designed to 
support FSK RTTY)  

 When MMVARI is opened for FSK RTTY, a small window labelled 
FSK8250/16550 1.03 will open, or appear on the Windows Task 
bar. In this window you select the COM port number and the signal 
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line to be used for PTT (RTS or DTR). FSK keying will be done on 
the TxD line. If this is a USB device that simulates a serial port, 
check Limiting speed. You can use the _ box at the top right to 
minimize this window after completing the setup  

o Choose EXTFSK if you are using a regular USB-to-serial adapter  
 When MMVARI is opened for FSK RTTY, a small window labelled 

EXTFSK 1.05a will open, or appear on the Windows Task bar. In 
this window you select the COM port number and the signal lines to 
be used for FSK keying (normally TxD) and PTT (RTS or DTR). 
You can use the _ box at the top right to minimize this window after 
completing the setup  

o On high-performance multi-core systems only, you may choose 
EXTFSK64 instead of EXTFSK. EXTFSK64 uses a more accurate timing 
mechanism than EXTFSK, but this mechanism uses significant CPU 
resources. EXTFSK64 is not appropriate for use on XP based systems or 
hardware running older dual-core Intel/AMD CPUs or Atom based CPUs. 
On systems that are capable of supporting it, EXTFSK64 can key FSK at 
speeds other than 45.45 baud, and it can also key FSK from LPT ports as 
well as USB-to-serial adapters. See 
http://www.qsl.net/ja7ude/extfsk/indexe.html  for more detailed 
information on EXTFSK64  

 When MMVARI is opened for FSK RTTY, a small window labelled 
EXTFSK64 will open, or appear on the Windows Task bar. In this 
window you select the COM or LPT port number and the signal 
lines to be used for FSK keying (normally TxD) and PTT (RTS or 
DTR). You can use the _ box at the top right to minimize this 
window after completing the setup  

4. Configurer >Other Tab 

http://www.qsl.net/ja7ude/extfsk/indexe.html


 

The Other tab is used to set up default values and select special modes and functions.  

4.1. Other Tab Field descriptions 

 DVK Letters File Path - This is where you specify the sub-path (relative to the 
Wav\LettersFiles subdirectory in the N1MM Logger+ User Files area) where the 
program will look for individual letter and number files for voicing of call signs and 
serial numbers in SSB. You can use {OPERATOR}\ in this file path, in which 
case each operator (specified using OPON or Ctrl+O) will have their own 
separate letters file subdirectory within the wav\LettersFiles directory  



 Primary CW Speed Step - The primary speed step is used with PgUp/PgDn 
keys or the speed adjust buttons in the Entry Window  

 Secondary CW Speed - The secondary speed step is used when 
Shift+PgUp/PgDn is pressed. Alt+PgUp/PgDn adjusts the CW speed of the 
inactive radio/VFO in SO2R/SO2V mode  

 Repeat time in millisecs - Specify the CQ repeat interval in the Entry window 
(Auto-CQ). The default value is 1.8 seconds. Enter a value in seconds or 
milliseconds. The maximum value is 32767. This is the same as Ctrl+R or 'Config 
| Set CQ repeat time' in the Entry Window  

 Default # Spots in - The number of spots returned by the SH/DX command in 
the bandmap window. The default value is 30 spots. The number of returned 
spots for the SH/DX command in the Telnet window is not affected by this value 
and has to be changed in the Telnet Options window  

 SSB Tuning Tolerance (Hz) - SSB mode: Clicking on or next to a station in the 
bandmap window will put the call on the callsign frame (if the callsign field is 
empty) of the Entry window. This value gives the maximum frequency distance to 
the call on the bandmap when it will be put on the callsign frame. The value has 
to be between 0 and 20000 (20 kHz). The default value is 300  

 CW Tuning Tolerance (Hz) - CW mode: Clicking on or next to a station in the 
bandmap window will put the call in the callsign frame (if the callsign field is 
empty) of the Entry window. This value gives the maximum frequency distance to 
the call on the bandmap when it will be put on the callsign frame. The value has 
to be between 0 and 20000 (20 kHz). The default value is 300  

 RTTY Tuning Tolerance - RTTY mode: Clicking on or next to a station in the 
bandmap window will put the call on the callsign frame (if the callsign field is 
empty) of the Entry window. This value gives the maximum frequency distance 
(in Hz) to the call on the bandmap when it will be put on the callsign frame. The 
value has to be between 0 and 20000 (20 kHz). The default value is 300  

 CW Weight - Adjusts the CW weight (between 30-70% limits). The default value 
is 50. This weight command works not only for serial or LPT port CW but also for 
Winkeyer  

 SSB Up/Down Arrow Incr - This value gives the frequency jump amount (in 
kHz) of the up/down arrow keys in SSB  

o NB. Never make this smaller than the smallest step your radio can make 
in SSB. Older Icom rigs are known to have a smallest step of 100 Hz 
which is quite big. When the step is made smaller than the minimum step 
size the Up/Down Arrows don't seem to work. Also controls the amount of 
each frequency change when tuning the RIT on radios that support doing 
so from the computer  

 CW Up/Down Arrow Incr - This value gives the frequency jump amount of the 
up/down arrow keys in CW and digital modes  

o NB. Never make this smaller than the smallest step your radio can make 
in CW. Most rigs have a smallest step in the order of 10 Hz. When the 
step is made smaller than the minimum step size the Up/Down Arrows 



don't seem to work. Also controls the amount of each frequency change 
when tuning the RIT on radios that support doing so from the computer  

 PgUp/PgDn Incr (kHz) - This value gives the frequency jump amount for the 
{PGUP} {PGDN} macros (Note: the PgUp and PgDn keys are not used for this; 
the {PGUP} and {PGDN} macros must be used in function key macros. These 
macro names are holdovers from early versions of N1MM Logger Classic)  

 Clear automatically populated exchange on callsign change - When 
selected, if the callsign in the Entry window is changed by the operator, this 
option clears the contents of exchange fields in the Entry window that were 
populated (filled in) from a Call History file, from previous QSOs in the contest, or 
from a Telnet spot. Does not affect exchange data that have been manually filled 
in  

 Per Operator Function Key Messages -  

 Mute mic on supported radios - Mute the microphone during transmit. Normally 
used to enter audio via a radio input other than the microphone. Default is to not 
mute  

o Tentec Orion: If "Mute" is checked, it causes the Orion's mic input to be 
muted and the Aux input to un-mute during voice keyer events  

o Supported radios are: Tentec Orion and Elecraft K3  
 Use Reverse CW Radio 1 - When selecting CW send a command to the radio to 

use Reverse CW  

 Check for new program versions - At program startup, check for a new version 
and if one is available, offer to download and install it. If you choose not to 
download a newer program version when prompted, you will not be prompted 
again for that program version.  

5. Configurer >Winkey Tab 



 

The Winkeyer tab is used to control functions of the K1EL Winkeyer keyer chip. 
Winkeyer is designed by K1EL and G3WGV. To connect It is only active when the 
Winkeyer box has been checked on a serial port, and that port (whether real or 
virtual), has been connected either to a stand-alone keyer or to a device that 
embeds the Winkeyer chip, such as various MicroHAM and RigExpert products. 
Consult your unit's manual along with the Winkeyer chip manual for more 
information on these settings.  

To set up a port for a Winkeyer (or for a device that embeds a Winkeyer chip), consult 
this section.  

Winkeyer is fed ASCII characters from N1MM Logger (via COM or USB Ports), and 
converts the ASCII to timed CW. The pot speed range is from a minimum of 10 wpm to 
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a maximum of 55 wpm. Winkeyer can also be used to control PTT. Winkeyer PTT can 
be used on modes other than CW. Note: This only works for Winkeyer versions 10, and 
21 and greater. 

5.1. Winkeyer Field Descriptions 

 Keying Mode - Select the keying mode. Choices are: Iambic A, Iambic B, 
Ultimatic and Semi-Automatic. The default is Iambic B  

 Autospace - Select when the autospace feature should be used. When using the 
paddles to send, if a pause of longer than one 'dit' time is detected, THREE dit 
times of pause will be inserted before the next character. See the manual for 
more information  

 Pot is wired with two leads - Select when the potentiometer on the board is 
wired only with two instead of three wires. Under normal operation, leave 
unchecked. Unless you've built the keyer yourself, or your keyer vendor 
recommends this, leave unchecked  

 Pin 5 Function - Select the function of pin 5. Unless your keyer's manual tells 
you otherwise, the default of PTT is likely what you want here. The Winkeyer 
manual is also a good reference. The choices are:  

o PTT (default)  
o Sidetone  
o 2nd CW (second output, do not use for SO2R - see below))  
o None  

 Sidetone Frequency - Select the Winkeyer's sidetone frequency. The default 
sidetone frequency is 469 Hz  

 Reverse Paddles - Reverse the left and right paddle  
 Winkey Speed Pot Control - Three options:  

o Ignore Winkey Speed Pot (when N1MM+ is running)  
o Use Winkey Speed Pot (matches the N1MM+ speed to the pot setting)  
o Use Winkey Speed Pot for Paddle and Keyboard CW only (enables QRS 

for manual CW)  
 Lead Time - Set the lead time value in 10ms Increments (up to 2.55 seconds). 

This value reflects the amount of time that the Winkeyer PTT will be asserted 
BEFORE keying commences  

o If when sending CW you are missing the first dot or dash, or if paddle-sent 
CW doesn't seem responsive (again, missing the first character) set this to 
at least 10 mSec  

o NOTE that this field denotes 10 mSec intervals — '1' in this box means 10 
mSec  

o If Pin 5 function is set to PTT, set this value to at least 1 (10 mSec)  
 Tail Time - Sets the tail time in 10 mSec Increments (up to 2.55 SECONDS). 

This value reflects the amount of time that the Winkeyer PTT line will be held 
after keying stops. Tail Time = 1 results in a tail time of one dit time (v2.2; 10 
msec in earlier versions of Winkeyer), Tail Time = 2 adds 10 msec to that, Tail 
Time = 3 adds another 10 msec, and so on. If Tail Time is set to zero, then Hang 
Time is used instead  



 First Character Extension - Sets the extension time in 10 mSec steps (up to 
2.55 seconds). Normally ONLY used with older, slower-keying rigs at speeds 
above 25 wpm, this setting will add time to the first element sent to help with the 
lack of T/R speed of those rigs. This value is usually set by experimentation. See 
the Winkeyer manual for more information on setting this value  

 Keying Compensation - Normally only used with high speed (>30 wpm) QSK 
operation. Adds time (in 1 mSec increments) to both dashes and dots to adjust 
for rig switching delays (however slight). See the Winkeyer manual for more 
information  

 Hang Time - Provides a CW speed-dependent means of holding PTT during 
CW sending. Hang Time can be used to set a CW-speed dependent delay of 1, 
1.33, 1.67 or 2 letterspaces (not dit spaces) after the last paddle closure. Hang 
Time is only activated when Tail Time is set to zero.  

 Winkeyer 2  
o Sidetone - Gives a sidetone when sending CW (both when using a paddle 

and from computer input)  
o Paddle only sidetone - Gives a sidetone only when sending by paddle  
o Use 2nd output - If this option is checked, when the transmit focus is in 

the second radio Entry window, CW and PTT will be switched to Winkeyer 
Output 2. This is convenient for minimal CW SO2R, because no additional 
hardware is needed to switch CW and PTT between radios. You'll still 
need to do something about the received audio switching, though. Select 
this option only for SO2R operation.  

 Setting CW Speed and Weight in Winkeyer 

Speed setting is done just as with other keying methods. The PgUp and PgDn keys will 
increase or decrease the speed (default is 2 WPM steps). You can also overwrite the 
value in the speed window, or use its up/down arrows. Ctrl+PgUp/PgDn increases or 
decreases the speed by a larger amount (default is 4 WPM). Both values can be 
adjusted on the Configurer's Other tab.  
If the option to ignore the speed pot has not been selected, setting the speed using the 
speed control pot changes BOTH the paddle speed and the N1MM sending speed. 
Setting the speed using the entry window changes both the paddle sending speed and 
N1MM sending speed but ONLY UNTIL the next time the speed pot is adjusted, i.e. the 
absolute position of the speed pot then overrides any changes made in the entry 
window.  

CW weight for Winkeyer can be set on the Other tab, but is not usually changed from 
the 50% default. 

6. Configurer >Mode Control Tab 



 

The mode control tab determines how (and whether)the mode will be controlled on 
the connected radio, whether the program sets the mode when changing frequency or 
not, and what mode it changes it to. This dialog also gives you control over the mode 
used when contacts are logged.  

Mode logged vs. Radio mode  
In an ideal world, the mode in the log, the radio's mode and the mode in the software 
would all be the same. For traditional voice and keyed CW modes (CW, USB, LSB, AM, 
FM) this actually holds true. With the obvious exception of radios that do not support all 
of these modes, there is a one-to-one correspondence between the names of the 
modes on the radios, in the software and in the log. If these were the only modes that 
existed, it would always be possible to change modes on the radio and have the 



software follow (or vice versa) without risk of confusion or error, and there would be no 
need for mode control configuration settings.  

However, when digital modes are brought into the picture this one-to-one 
correspondence breaks down. Any SSB-capable radio can be used for digital modes 
using a sound card, even if the radio itself does not have any native digital modes. This 
results in a many-to-one relationship (many different modes in the log can map to a 
single mode on the radio). In the case of RTTY, some radios have a native RTTY mode 
using FSK keying, and when it exists, this mode is uniquely associated with RTTY and 
not with any other digital mode in the log. However, the reverse is not true; depending 
on the hardware configuration and the operator's choice, RTTY in the log may 
correspond with either RTTY or SSB on the radio. In the case of some radios, there 
may also be an additional mode or modes in the radio tailored either specifically for 
AFSK RTTY or for sound-card digital modes generally.  

For information about mode control for your specific radio, go to Supported 
Radios  

Because of this breakdown in the one-to-one correspondence, a radio-first priority 
system cannot be imposed in all situations - once digital modes are involved, setting the 
mode on the radio does not always uniquely identify the mode that should be logged. 
Instead, the primary rule is "software first". Setting the mode in the software always 
controls what the radio does. You can select the mode in the software simply by typing 
the name of the mode (CW, SSB, USB, LSB, AM, FM, RTTY, PSK) into the entry 
window in the callsign box and pressing the Enter key. Provided the mode you have 
chosen is supported by the contest (this is determined by the Mode category in the 
contest setup window), the software and the radio will switch to the mode you have 
commanded, and that is the mode that will be logged, When the MMVARI or Fldigi 
digital engine is used, the specific digital mode logged will depend on what mode has 
been selected within the digital engine. Since not all radios use the same radio mode for 
digital modes, there are settings in the right side of the mode control configuration 
window that determine which radio mode is used for each of RTTY and PSK.  

Automated Mode Switching  
Despite the lack of a complete one-to-one correspondence between the modes in the 
log and in the radio, there are many situations where some degree of automated mode 
switching is possible, based either on the radio's mode or on the frequency, and within 
the limits imposed by the current contest setup (i.e. what modes are supported within 
the current contest). The settings that control whether this kind of automation is used, 
and on what basis, are in the left side of the mode control window.  

One of these options is to use the band map. You may be able to use this within a 
single mixed-mode contest where the modes are kept well-separated in frequency. 
Unfortunately, this doesn't work in all situations. During major CW contests, for 
example, CW may be used pretty much throughout the normal digital sub-band. On the 
other hand, during a major RTTY contest you may find RTTY being used on frequencies 
that would normally be considered to be CW frequencies. For this reason, using the 
band map to determine the mode is not a foolproof set-and-forget option. Depending on 
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the modes supported by your radio and the nature of the particular contest(s) you are 
operating in, you may need to choose one of the other options.  

Digital Mode Behavior is Different  
There is a difference in mode control behavior between the situation where the DI 
window and digital engine window are open and the situation where they are closed. 
This is due to the way serial ports are used by the digital engines and by the Logger. 
The digital engines are separate processes from the rest of the Logger, and a single 
serial port cannot be shared between two processes. Since serial ports can be a scarce 
resource in a complex contest station, the Logger allows time-sharing of serial ports 
between digital (FSK & PTT) and non-digital (CW & PTT) uses. It does this by switching 
the ports between the processes depending on whether the DI window is open or not. 
When the DI window is opened, serial ports that have the Digital box checked in the 
Configurer are closed by the Logger so that they can be opened by the digital engine. 
When the DI window is closed, these ports are released so that the Logger can open 
them for use in other modes.  

Thus, whether the DI window is open or closed can make a significant difference to the 
hardware configuration. Whenever a serial port is time-shared between the Logger and 
a digital engine, that port cannot be used for PTT or CW keying in non-digital modes 
while the DI window is open.  

In order to support the wide range of possible hardware configurations in a hardware-
independent fashion, mode control in the Logger depends on whether the DI window is 
open or not. When the DI window is closed, radio-first mode control works between non-
digital modes, but switching the radio mode to (or through) a digital mode or tuning the 
radio's frequency into (or through) a digital band segment does not open the DI window 
and switch the software to digital mode. To switch into a digital mode, the DI window 
must be opened from the software. This can be done by using the Entry window to 
select RTTY or PSK mode in a contest that supports digital modes, or by using the 
Window > Digital Interface menu item.  

Once the DI window is open, changing modes on the radio does not close the DI 
window and the software does not switch out of digital mode, which means that radio 
mode-driven mode control does not work when the DI window is open. Mode changes 
in this state must be performed from the software. If the software is commanded from 
the Entry window to use a non-digital mode, the DI engine is closed by the software in 
order to free up any time-shared ports for the Logger to use.  

6.1. Mode Control Field Descriptions 

 Mode recorded in log - Set how to determine the mode that will be entered in 
the log  

o Use radio mode (default) - if the DI Window is not open, the mode is 
determined from the radio's mode setting. If the DI Window is open, the 
mode used depends only on the digital engine and not on the mode 
received from the radio, as follows:  

 In digital modes, the mode in the log will be RTTY if using the 
MMTTY or 2Tone engine or a TNC  



 When using the MMVARI or Fldigi engine, the mode will be as 
selected in the MMVARI or Fldigi window (digital modes only for 
Fldigi)  

o Follow band plan - the program will use the mode the bandplan gives for 
the frequency. For CW and Phone, this affects both what is entered in the 
log and what happens when you click on a spot in the Bandmap or the 
Available Mults and Qs window, but does not switch the radio 
automatically to a digital mode if you click within a digital band segment.  

o Use contest mode or bandplan - In a single-mode contest, that mode is 
both logged and sent to the radio. If the contest is mixed mode (e.g. the 
Russian DX Contest). the bandplan is followed as above.  

o Use contest or radio mode - In a single-mode contest, that mode is both 
logged and sent to the radio. In a mixed mode contest, the radio's mode is 
used.  

o Always: - always log the mode selected here (CW, SSB, RTTY, PSK31, 
PSK63, PSK125) regardless of the mode set on the radio.  

 Mode sent to radio - Select how to determine the mode sent to the radio  
o This applies only for digital modes. See the note below for details  

 Digital Mode Selection 

Every radio seems to have a different range of choices and names for digital modes. 
Some radios have no modes specialized for digital modes, some have only one digital 
mode for FSK RTTY (for sound-card digital modes, you use USB or LSB), some add to 
this a separate mode intended for sound-card digital modes like AFSK RTTY and 
PSK31, and some radios have three separate digital modes for FSK RTTY, AFSK 
RTTY, and other sound-card digital modes like PSK31. There may also be two versions 
of each of these, one "normal" and one "reverse" (opposite sideband). Every 
manufacturer uses different names for these specialized modes.  
For simplicity, N1MM Logger has its own radio-independent terminology. The Logger 
uses RTTY for the radio mode normally used for FSK RTTY (which is usually but not 
always called FSK or RTTY on the radio). If the radio has a mode that is designated for 
AFSK RTTY, the Logger calls it AFSK. AFSK-R is the "reverse" of this AFSK mode, i.e. 
on the upper sideband instead of LSB. If there is a mode intended for sound card data 
modes that is different from the AFSK-R mode, it will be called PSK in the Logger. Not 
all radios have all of these modes, so not all choices will necessarily be available, 
depending on what radio(s) is/are configured.  

The translation between the mode name used on the radio and the mode name used in 
N1MM Logger is described at Click here to see the table  

For RTTY, if you are using FSK, you should normally select RTTY. If you are using 
AFSK, you should normally select AFSK or LSB/USB, depending on whether your radio 
offers a specialized AFSK mode or not.  

For PSK, the choice would normally be one of: PSK (if available), AFSK-R (on some 
radios), or USB. 

http://n1mmplus.hamdocs.com/tiki-index.php?page=Supported+Radios#Digital_Mode_Mapping


7. Configurer >Antennas Tab 

in-edit  

 

The Antennas Tab defines how antennas can be selected by the program, if you have 
appropriate hardware, and also controls the rotor program. The example above 
illustrates the features of this tab.  

The program uses a variety of antenna-related interfacing options, depending on your 
hardware and preferences. For example, antenna selection can be controlled by using a 
band decoder in conjunction with a real LPT port. USB-to-parallel adapters do not work 
in this or other parallel port interfacing functions, because they do not allow program 
control of individual pins on the port.  

Antenna selection can also be controlled by one of two serial port protocols, the 
proprietary MicroHam protocol and the Open Two Radio Switching Protocol (OTRSP). 
Rotators can be controlled either by using the N1MM Rotor Program, or by various 

http://n1mmplus.hamdocs.com/tiki-index.php?page=Serial+Parallel+and+Sound+Card+Interfacing#Band%20decoder%20output
http://n1mmplus.hamdocs.com/tiki-index.php?page=Rotator+Control


third-party software packages that make use of UDP broadcasts sent by N1MM 
Logger+  

× 

 Tip 

Unlike most software you don't map bands to bcd outputs 0-15 with N1MM Logger. You 
map antennas to bcd outputs 0-15. You can still map bands, but the antenna approach 
is much more powerful. It supports multiple antennas per band, stacks, and multiple 
bands per antenna. See the screen shot above.  

7.1. Antennas Tab Field Descriptions 

 Code - The code which will be presented on the LPT port as binary coded 
decimal output, using pins 9, 8, 7 and 2  

o The codes themselves are pre-determined. Sixteen different codes are the 
most that can be represented by the state of 4 pins. In the example above, 
no antenna for Code O is defined - this is because in that case that code 
is used to select automatic operation from the front panel of the remote 
antenna switch.  

o Each code represents ONE ANTENNA,, and you can have many different 
combinations.  

 Antenna -Text to describe the antenna. This text will appear on the status bar of 
the Entry window when you change bands or switch antennas for a given band.  

 Bands - The bands on which this antenna will be selected  
o List bands in MHz e.g. 1.8, 3.5, 7, separated by commas if more than one 

is covered by the antenna, as in the illustration.  
o The first antenna in the table will be selected when changing to a band. 

Press Alt+F9 to toggle through all the antennas for the current band.  
o An antenna may be used on any number of bands  

 Rotor Description - enter the description as defined in setting up the rotor 
program. It must be exactly the same in both places, because these names make 
the connection between the two programs.  

o More than one rotor can be selected (separate using commas), for 
example to turn a stack where more than one rotor is involved.  

 Offset - This offset is added to the rotor position to determine the antenna 
position. This is useful for antennas that are mounted at 90 degrees for pattern 
interference reasons, or for antennas that have simply turned some in the wind 
over the winter. The offset can also be entered for the selected rotor in the rotor 
program  

 Bidirectional - Check this box if the antenna can be set bidirectional (0 = not 
bidirectional, 1 = bidirectional) (e.g. Steppir)  

 Start N1MM Rotor Program - Start the N1MM Rotor program automatically from 
the N1MM Logger+ main program. You will need to stop it manually  

 Display Rotors Used By This Station -  
 Display Rotors Responding From Network -  

http://n1mmplus.hamdocs.com/tiki-index.php?page=Rotator+Control
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 LPT Port Conflict 

When DVK is selected on an LPT port, antenna selection on that port will not work 
because the DVK pins and the antenna pins overlap. 

8. Configurer >Score Reporting Tab 

 

In N1MM Logger+, the Real-Time Score Reporting function has been integrated with the 
rest of the program. Instead of checking a box on the Other tab of the Configurer to start 
it, it now has its own tab in the Configurer.  

Following, left to right, are the options you will need to set up to use it.  



 Report Real-Time Score to Server - this checkbox is checked to start reporting 
real-time scores. It will stay selected until you uncheck it.  

 Exclude band breakdown - if you feel that for competitive reasons you don't want 
to disclose your band breakdown, revealing your band-change strategy, leave 
this box unchecked.  

 Score Reporting Server - At this time, the only real-time score reporting server is 
cqcontest.net. If any when others become available, they will be added.  

 Score Reporting Username and Password - For security reasons, cqcontest.net 
requires that you register your callsign and password. Once you have done so, 
enter them in the textboxes provided.  

 Update Interval - Adjustable from 2 minutes to 60 minutes.  

 
To be sure that your scores are being sent, check just above the lower text pane in the 
Info window. Each time a score is sent and acknowledged by the server, you'll see a 
notification there.  

9. Configurer >Audio Tab 



 

 Two audio methods 

If you have checked the "Use Logger+ audio" menu item in the Entry window's Config 
menu (not available in Windows XP), the "Audio" tab will not appear in the Configurer. 
In its place, use the "Logger+ Audio Setup" menu item in the Config menu to set up 
Logger+ audio. 

 Before We Start 

Any time you change the Default sound card in your Windows Control Panel while 
N1MM Logger+ is running, you must shut N1MM Logger+ down and re-start it. 
Otherwise, the program and the operating system may be on "different pages", and it 
can cause audio functions not to work or to work strangely. Moreover, any time that you 



change the Windows Default sound card, you will have to come back to this tab and 
reset your audio options. You can imagine how we found this out!  

9.1. Introduction 

 
Users of N1MM Logger Classic may recall when we deleted the QSO recording function 
from this tab in favor of a separate recorder, QSOrder by K3IT. QSO recording is 
configured there, and not in the Configurer. Currently, the Audio tab in the Configurer 
only controls settings that are used for playback of stored voice messages and for 
recording those messages. This includes on-the-fly re-recording, such as might be 
required in contests for split SSB operation on 40 meters, for example.  

Note: If your computer is using Windows XP SP3, then this audio setup is the 
only one available to you. If you are using a later operating system, you have the 
option of using either this setup or a new Logger+ audio configuration dialog, 
which is found on the Config menu of the Entry window. If you check the option 
on the Config menu, you will note that the Audio tab on the Configurer will no 
longer be visible, and you will need to use the Audio configuration dialog which 
is on the Config menu. Conversely, if you are using XP, the Config menu entries 
will disappear. Full details on Logger+ audio will be found in this section.  

If you are setting up this tab for the first time, a good beginning is to familiarize yourself 
with your computer's sound card(s). At the same time, you can assure yourself that all 
of your computer's audio settings are correct for recording from your microphone and 
playing back to your radio's audio input (microphone or line). A step-by step procedure 
for doing so is in the Interfacing section of Getting Started. A much more detailed 
treatment of the use of stored messages in SSB contests is here.  

9.2. Audio Output 

 1 - Only use Radio 1 Output Device, Output on both channels  
o One radio and one sound card, to play stored messages, record or re-

record messages and mute the microphone when playing stored 
messages.  

o Use this setting with two radios if you are using separate sound cards 
for the two radios.  

 2 - Two Radio, Output left channel on left radio, right channel on right radio  
o Use this setting if you are using a single sound card to play stored 

message files to two separate radios in SO2R (one channel for each 
radio)  

9.3. Tx Sound Card Setup 

 
This is where it gets a little messy, largely because of differences in the way Windows 
XP handles sound cards, versus the way they are managed in Vista, 7 and 8. Let's look 
at that a bit.  

http://n1mmplus.hamdocs.com/tiki-index.php?page=Third+Party+Software#QSOrder_by_Vasily_K3IT_
http://n1mmplus.hamdocs.com/tiki-index.php?page=Entry+Window
http://n1mmplus.hamdocs.com/tiki-index.php?page=Interfacing+Basics#Phone_Interfacing
http://n1mmplus.hamdocs.com/tiki-index.php?page=Stored+Messages+and+the+Function+Key+Message+Editor


In Windows XP,  

 Select Radio 1 Output Device - Select the sound card to use for sending stored 
messages (.wav files) on Radio 1.  

 
In Windows Vista and later operating systems, the pull-down list shows output 
(playback) ports available on the computer, including those on multiple sound cards if 
more than one is available.  

If there is a CODEC built in to Radio 1, choose that (CODEC is used here and 
elsewhere in this manual as a synonym for sound card). If not, choose the Line Out or 
Speaker Out port on the sound card that is connected to Radio 1's audio input.  

In Windows XP, the pull-down list shows sound cards available on the computer; 
choose the built-in radio CODEC in Radio 1 or the sound card whose Line Out or 
Speaker Out port is connected to Radio 1's audio input.  

 Select Radio 2 Output Device - Same as for Radio 1.  

 

9.3.1. CODEC 

Built-in sound card capability is just starting to appear in new-generation transceivers.  

 Radio 1 Output Device is an Internal Radio Codec - Check this box if you are 
using a CODEC built into Radio 1 instead of a separate sound card  

 Radio 2 Output Device is an Internal Radio Codec - Check this box if you are 
using a CODEC built into Radio 2 instead of a separate sound card  

9.3.2. Select Port to Mute 

 
Typically, this is used to mute the microphone during stored message playback, so you 
would select Microphone from the drop-down list. The two options are for Radio 1 and 
2, left to right  

9.3.3. Select Message Recording Device 

Select the sound card to use for recording stored messages for later playback on either 
radio. In Windows Vista and newer versions, the pull-down list displays playback ports 
available on the computer. Choose a port that is on the sound card that you will be 
using to record SSB messages. In Windows XP, select the sound card that will be used 
to record SSB messages.  

You may ask what playback ports have to do with recording - we'll just have to ask you 
to trust us on this one. you must select a device in order for recording ports to appear 
(see below).  

9.3.4. Select Message Recording Port 

http://n1mmplus.hamdocs.com/tiki-index.php?page=Stored+Messages+and+the+Function+Key+Message+Editor
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Having selected the sound card device, use this pull-down list to select the recording 
port you will use on the selected sound card device to record SSB messages. This is 
normally the microphone input  

9.3.5. Recording Bits and Sample Rate 

 Recording Bits - this setting determines how your sound card digitizes analog 
audio levels - generally, the lower the bit rate the smaller the file but also the 
lower the fidelity  

 Recording Sample Rate - This setting determines how your sound card digitizes 
analog audio__ frequencies. Select the sample rate to record. The lower the rate 
the smaller the files but audio quality will be less.  

 Max Recording Length - Upper limit on the length of a recorded message, in 
seconds.  

 Not All Sound Cards are Created Equal 

The Configurer lets you pick parameters that your sound card may not support. If you 
choose a parameter that is not supported by your card, you should see Error 4 in the 
status line of your Entry Window when you try to play back a message, but under some 
circumstances, this may not happen. Our best advice is to verify that sample rates 
match and test before the contest starts.  
This can be tricky. Even though playback rate is not specified, some sound cards permit 
playback only of .wav files recorded at a given sample rate, such as 44.1 or 48 KHz. 
Make sure your recording parameters match those, or you will not hear any output from 
your recordings (don't ask how we know). 

 

2.1.3 The Contest Setup Dialog - Basics 

in-edit  

 2.1.3 The Contest Setup Dialog - Basics  

o 1. Databases versus Logs  

 1.1. What Else is In a Database?  

o 2. Start a new contest log  

 2.1. Start Date  

o 3. Open an Existing Contest Log  
o 4. Contest-Specific Information  

 4.1. Contest Tab  

 4.1.1. Operator Category  
 4.1.2. Band Category  
 4.1.3. Power Category  
 4.1.4. Mode Category  
 4.1.5. Overlay Category  
 4.1.6. Station Category  



 4.1.7. Assisted Category  
 4.1.8. Xmitter Category  
 4.1.9. Time Category  
 4.1.10. Assisted Category  
 4.1.11. Sent Exchange  

 4.1.11.1. If the Exchange is a serial number  
 4.1.11.2. Starting with a Serial Number other than 

Zero  
 4.1.11.3. Using a Serial Number Server  

 4.1.12. Operators  
 4.1.13. Soapbox comments  
 4.1.14. Section Lists  

 4.2. Tab: Associated Files  

This dialog is reached from the File menu in the Entry Window, by clicking on either 
New Log in Database or Open Log in Database. It is used either to set up a new contest 
or to modify something about a contest that you have already created.  

× 

 There Are Contests, and Then There Are Contests 

As it is generally used in ham radio, the word "contest" refers to a competitive operating 
event of some kind. As the term is used in N1MM Logger+, it can refer either to such an 
event or to a specific occurrence of a particular event, for which you have set up a log. 
You can have an unlimited number of CQWWCW "contests" (distinct contest logs) in a 
single database - it might be better to call them "contest instances", but it is probably too 
late to find and correct every use of the term according to its meaning in context. In 
virtually all cases, what is meant will be obvious from context.  

1. Databases versus Logs 

 
Before starting your first contest, you should understand how N1MM Logger+ stores 
contests and contacts. The two key terms are Databases and Logs. As an analogy, 
think of your PC's hard disk as a large room containing computer stuff. Into this room, 
N1MM Logger+ places File Cabinets (Databases) and within those File cabinets, N1MM 
Logger+ adds individual Folders (Logs). For each contest that you operate, you will add 
a new Log to hold the contacts for that contest. Your large room with computer stuff can 
hold as many File Cabinets (Databases) and as many Folders (Logs) as you want - 
until, of course, your hard drive is full.  

N1MM Logger+ has transitioned to using SQLite as its database engine, and no longer 
uses a single database to store both contest logs and other administrative data.  

Continuing our File Cabinet and Folder analogy, there are many methods by which you 
can arrange your file cabinets (Databases). Here are three examples:  



1. DATABASE PER CONTEST TYPE - Some hams prefer to create a Database for 
each major contest type. The Databases folder in your N1MM Logger+ user files area 
might contain databases (>File >New Database) named CQWW.s3db, ARRLDX.s3db, 
ARRL160.s3db and CQWPX.s3db. When setting up each contest, you >File >Open the 
Database corresponding to the contest to be operated, then >File >New Log (folder) for 
that particular contest. So, one of these databases could contain CW, Phone, and RTTY 
logs from 2014, 2015, and 2016... for that particular contest. You might want to add a 
database like MISCELLANEOUS.s3db for the smaller contests or contests that you only 
plan to operate a couple of times.  

2. DATABASE PER CALENDAR YEAR - Some hams create a new Database each 
year. At the beginning of each year, you would >File >New Database a database 
named K8UT_2014.s3db, K8UT_2015.s3db or K8UT_2016.s3db. In each database 
would be the Logs (folders) for every contest you operate during that year. When setting 
up each contest, you would >File >Open Database for the correct year, then >File >New 
Log (folder) for that particular contest. So, this database would contain all contests (CQ 
WW, ARRL DX, CQ WPX...) worked during that year.  

3. DATABASE PER EACH CONTEST - Some hams create a new Database each time 
they operate a contest. The Databases folder in your N1MM Logger+ user files area 
would contain lots of databases - one for each contest that you operate. When setting 
up each contest, you would >File >New Database, and then within that database you 
would >File >New Log. Although some hams may find this the easiest method to 
understand, managing all of those files after many years may become a problem.  

These aren't your only Database/Log options, but perhaps one of them matches the 
way your brain works. How about organizing your logs by mode: CW.s3db, 
PHONE.s3db, DIGITAL.s3db? N1MM Logger+ can do any of these - choose the 
method that provides the easiest way for you to create new logs before the contest and 
find your old logs after the contest.  

1.1. What Else is In a Database? 

in-edit  

In addition to your QSOs, there are a number of tables in the database that contain data 
that may, and probably will vary from one contest to the next. These include such things 
as multiplier lists for particular contests, function key definitions for CW, SSB and digital 
modes, the contents of the last wl_cty.dat file that you loaded, and a Call History table 
(if one has been loaded).  

Why should you care? For several reasons:  

If you modify the function key definitions while operating, that modification applies only 
to the current database. Each database only has space for one set of function keys for 
each mode, one Call history file, one set of Telnet buttons, and a pointer to one 
master.scp file in the program directory.  
When you switch to another database, those definitions (and in particular, any changes 
you made) are left behind. That's why the program provides for exporting function key 
definitions (among other things) to text files, which can then be loaded into the database 



as needed. You can label these text files in a contest-specific way so that it will be easy 
to find when you set up for the next time.  
Master.scp files may change from contest to contest, too. You don't have to load them 
into the database, but you do have to make sure that you have pointed to the 
appropriate file for each contest. That is one reason for the Associated Files tab in the 
Contest Setup dialog - so that when you switch contests, the files you need (or pointers 
to them) are automatically loaded.  
The same thing applies to Call History files. One common error that Call History users 
often make is to forget to load the appropriate file into the database. They set up a 
contest and find they are getting the wrong information about stations they work 
because the Call History table still contains data that is appropriate for a different 
contest.  

The takeaway is this - when you change contests within a database, or change 
databases, your function keys, master.scp file, Call History file, and Telnet buttons will 
still be those from the last contest you worked using that database, UNLESS you have 
identified the appropriate files on the Associated Files tab while setting up the new 
contest.  

2. Start a new contest log 

Once you have chosen and opened the database you want to use, to start a new 
contest in that database select >File >New Log in Database. This will open the Contest 
Setup dialog.  

Initially, you'll see the name of the contest last used by the program from this database.  

 

Click the downward-pointing arrow to the right of the current contest name (called the 
"handle") to drop down the list of all supported contests.  



 

 You can search alphabetically by pressing the first letter of a contest's short 
name, and then scrolling to find the right one, or else repeatedly pressing the first 
letter until you get there.  

 
A list of supported contests can be found in the Supported Contests chapter. Check 
the contest website for the latest rules and check the contest setup information in the 
Contest Setup Instructions chapter.  

2.1. Start Date 

The Start Date distinguishes between multiple versions or instances of a given contest 
in your database. It is possible to have two instances of the same contest with the same 
start date and time, but it can get confusing trying to figure out which one is which, so 
the program allows you to change the start dates and times in order to distinguish 
between them.  

 When you set up a new contest, the Start Date defaults to the first following date 
corresponding to the day of the week on which the program expects that the 
contest will start, and the correct start time. Year to year, dates of contests 
change, but the day of the week usually remains the same. In the example 
above, a new CQWWSSB contest was created during the week of April 14. The 
program defaulted the start date and time to 0000Z on the following Saturday, 
April 19 (which is not, of course, the correct date for the actual CQWWSSB 
contest).  

 to enter the correct date (and time, if necessary), single-click on the date in the 
Start Date box.  

× 

 Don't screw up your contest goals 

In addition to distinguishing between multiple instances of a contest, the Start Date also 
affects calculation of on-off times and goals. If you set the Start Date to the "wrong" day 
of the week, then for purposes of computing time on or off the air and for displaying any 
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goals you have set in the Info window the program will assume the contest starts at the 
correct time on the correct day of the week following the Start Date you entered.  

 
To avoid confusion, it is easiest to set up the log you will actually use within a week 
before the start of the contest, or else to change the Start Date for that log to the correct 
date for the contest. If you want to practice ahead of time, you can set up a practice 
version of the contest with a different start date and/or time. As long as it is in the same 
database, you'll be able to set goals, set up your function keys and other associated 
files, and all of this will be remembered when you set up the "real" log. Just delete the 
practice log (or leave it in the database - no harm done, except for a bit of wasted 
space) and you're ready to go.  

3. Open an Existing Contest Log 

To open an existing contest log in the currently selected database. Select >File >Open 
Log in Database  

 In the top part of the dialog the currently available (already created) contest logs 
can be selected by clicking on the down arrow to the right of the textbox. Note 
that the textbox is captioned "Select Existing Log"  

 Contest-specific changes can be made in the Contest and Associated Files 
tabs. More information in the paragraph below  

 

To delete a contest, click on the contest in the contest pane, as shown above, so it is 
selected. Then press Delete.  
For example, the CQWWCW contest in the screen shot above is selected and can be 
deleted by pressing the Delete key.  

× 

 Don't Make This Mistake! 

Deleting a contest permanently removes the contest and all of its QSOs from the 
database; you won't be able to recover them. By contrast, if you delete individual 
QSOs from a contest log, they are not really deleted, just moved from the contest they 
were logged in to the DELETEDQS contest where you can still get at them if you need 
to. But if you remove an entire contest, those contest QSOs are gone, gone, gone! 



4. Contest-Specific Information 

Below the contest selection area is a section where you define your entry in this 
particular running of the contest. This is further divisible into Categories, Sent 
Exchange, Operators and Soapbox Comments  

Of these, the first is Categories - are you single op or multi-op, high or low power, and 
so on. Depending on the contest you will see one of two lists of categories to be 
chosen. This is because some contest organizers (the ARRL and IARU in particular) 
have adopted the Cabrillo 3.0 format for contest entries, while the others continue to 
accept Cabrillo 2.0. The Cabrillo file headers are different, requiring different lists.  

These lists may seem a bit daunting at first, but remember a couple of things. You can 
always change your selections before the contest if things don't come up as you expect 
them to, or after the contest if you have trouble getting the contest organizer to accept 
your Cabrillo entry. As a last resort, you can use a text editor on the header of the 
Cabrillo file.  



 

Always check these entry categories. Some of the defaults may not be correct for 
your entry in the new contest you are setting up.  

4.1. Contest Tab 

4.1.1. Operator Category 

Make a choice for your situation. Choices in Cabrillo 2.0 contests are:  

o SINGLE-OP  
o SINGLE-OP-ASSISTED  
o MULTI-ONE  

 In CQWW contests, you will be asked whether this station is a Run 
or a Mult station  

o MULTI-TWO  



 An identifier is needed for Station 1 and Station 2 that must be 
specified when setting up initially in this category. Each time the 
program is loaded or the contest changed, the program will ask you 
to specify Station 1 or 2  

o MULTI-MULTI  
o SCHOOL-CLUB  
o CHECKLOG  
o SINGLE-OP-PORTABLE  
o ROVER  

 If your entry is in this class, selecting Rover will enable some useful 
additional functions.  

o MULTI-UNLIMITED  
o MULTI-LIMITED  

 Choices in Cabrillo 3.0 contests are:  
o SINGLE-OP  
o MULTI-OP  
o CHECKLOG  

4.1.2. Band Category 

Make a choice for your situation. Choices are:  

o ALL  
o 160M  
o 80M  
o 40M  
o 20M  
o 15M  
o 10M  
o LIMITED  
o CHECKLOG  

 Choices in Cabrillo 3.0 range from ALL to LIGHT  

4.1.3. Power Category 

Make a choice for your situation. Choices are:  

o HIGH  
o LOW  
o QRP  
o MEDIUM  

4.1.4. Mode Category 

Make a choice for your situation. Choices are:  

o CW  
o SSB  



o RTTY  
o PSK  
o MIXED - both CW and SSB are allowed in this contest. The band buttons 

in the Entry window will show one column each for CW and SSB  
o DIGITAL = no CW & SSB, just RTTY and/or PSK (defined by the contest)  
o MIXED+DIG = CW & SSB & Digital all allowed  

4.1.5. Overlay Category 

Used in relatively few contests. In Cabrillo 3.0 contests, only N/A, TB-WIRES, NOVICE-
TECH, OVER-50 and ROOKIE are valid. Choices are:  

o N/A (default)  
o ROOKIE  
o BAND-LIMITED  
o TB-WIRES (tri-bander and wires)  
o OVER-50  
o HQ  
o NOVICE-TECH  
o EXPERT - The EXPERT overlay category in contests where it exists must 

be selected for the 5 minute band change counter to be inactive for 
SINGLE-OP stations.  

 
 
In CQ WPX CW and CQ WPX SSB, category overlay may be any combination of 
ROOKIE, BAND-LIMITED, or TB-WIRES. In STEW PERRY, the category overlay may 
be OVER-50. In IARU-HF, the category overlay may be HQ. In PACC the category 
overlay may be NOVICE-TECH.  

The following items are required by Cabrillo 3.0  

4.1.6. Station Category 

Choices are:  

o FIXED  
o MOBILE  
o PORTABLE  
o ROVER  
o EXPEDITION  
o HQ  
o SCHOOL  

4.1.7. Assisted Category 

o ASSISTED  
o NON-ASSISTED  



4.1.8. Xmitter Category 

o ONE  
o TWO  
o LIMITED  
o UNLIMITED  
o SWL  

4.1.9. Time Category 

o N/A  
o 6-HOURS  
o 12-HOURS  
o 24-HOURS  

4.1.10. Assisted Category 

o Xmitter Category  
o Time Category  

4.1.11. Sent Exchange 

o Sent exchanges are defined for each contest. Look in >Digging Deeper 
>Supported Contest Setup instructions for guidance. Usually a serial 
number, zone, state etc  

o Do not put 59, 599, or RS(T) information in the Exchange field  

× 

 No RST in the Exchange 

Do not put a signal report in the sent exchange. It will cause incorrect Cabrillo output. 
Typically, the program will warn you if you make this mistake. 

4.1.11.1. If the Exchange is a serial number  

o Enter the expression 001 in the Exchange field  

4.1.11.2. Starting with a Serial Number other than Zero  

o Some contests which have more parts/sessions there is the need to start 
a next session with the next number given in the previous part. So how not 
to start with 001?  

o There are two workarounds:  
 Start second part as a separate contest and make the first QSO 

with number 001 and log it, then correct (Ctrl+Y) to proper sent 
number  



 Start second part as a separate contest, enter fake QSO, open 
QSO in EDIT window, change SENT number from 001 to last 
number you sent in the previous part of the contest, save changes, 
et voila, it's done. When a couple of real contacts have been 
entered, delete the fake QSO  

4.1.11.3. Using a Serial Number Server  
N1MM logger supports a single sequence of serial numbers for SO2R, MS, M2 and 
MM.  

The serial number is reserved in S&P mode when the cursor leaves the callsign field or 
the Exchange key (F2 default) is sent either through spacing, tabbing, hitting Enter in 
ESM or pressing the Exchange Function Key. This is needed so you can enter calls to 
check for dupes while not reserving a serial number  

The serial number is reserved and displayed in Run mode as soon as you enter a letter 
in the call-sign field. This is because on SSB people frequently talk before they type, 
and they need to see the serial number displayed earlier.  

In SO2R and SO2V, typing Alt+W (wipe) after a serial number has been reserved or 
clearing the entry window through QSY will "un-reserve" that number.  

Because of the way the serial number server works, there are a few cautions:  

o Serial numbers issued by the second radio may be out of time sequence 
with those issued by the main one. This occurs because certain program 
actions cause a serial number to be reserved for the use of a station, and 
if that station does not use that number until after the other station has 
made several QSOs, when the log is viewed in chronological order the 
serial number will appear to be out of order. I don't think there is anything 
to be done about this  

o For similar reasons, depending on operator actions at one or the other 
station, such as shutting down the program while a number is reserved, 
there may be some gaps (numbers not issued) when reviewing the final 
log  

o The most important aspects of serial numbering are that the serial sent to 
a station be correctly logged, and that there be no duplicate serial 
numbers sent; the intent is always to meet both these criteria  

o Sometimes it's possible a number will be skipped when given out but not 
used (example: QSO not made after all or deleted). Contest committees 
do accept this behavior!  

o The maximum sent number to give is 32767. The maximum received 
number is 99999  

× 

 What Do Sponsors Look For? 



Most sponsors are more interested in serial number accuracy than in serial number time 
order. If you think about it, it is impossible to guarantee the order of serial numbers in a 
two radio situation. This assumes that you always log the time when the QSO is added 
to the log, which is the right time from a rules point of view. i.e. end of contact.  

 
 
Addendum by Steve, N2IC 
 
Let me say a few words about the way serial numbers are "reserved" in N1MM Logger. 
For the sake of this discussion, I'll assume that ESM is being used.  

When you enter a callsign in the Entry Window, and hit the Enter or Space key, a serial 
number is reserved and locked-in to that QSO. If it turns out that the QSO is not 
completed and logged, that serial number is "lost", and will be not used for a 
subsequent QSO.  

This gets to be especially interesting with SO2R and SO2V. Let's say you are running 
on Radio 1, and search-and-pouncing on Radio 2. You enter a call on Radio 2, and hit 
the Enter key, reserving a serial number on Radio 2. You get beaten out on Radio 2, 
and go back to running stations on Radio 1, advancing the serial number beyond the 
number reserved on Radio 2. A few minutes pass, and you finally work the station on 
Radio 2. Your log now appears to have non-sequential serial numbers. If you never 
work that station on Radio 2, the reserved serial number on Radio 2 is lost, and will not 
be used for any subsequent QSO.  

I can't speak for all contest sponsors, but for Sweepstakes and CW/SSB WPX, this is 
not an issue. There is no problem for these log adjudicators if your serial numbers are 
out-of-sequence, or if there are missing serial numbers in your log. Your log will be 
correctly processed. In addition, the N1MM Logger Summary window reports the correct 
number of successfully completed QSO's.  

In summary, stop fretting about out-of-sequence or missing serial numbers. The 

software is working as designed  

4.1.12. Operators 

o Enter here all the operators' callsigns  
o Update Ops from Log - If you have been using Ctrl+O or OPON to enter 

operator callsigns in the log, clicking the button 'Update Ops from Log' will 
transfer all operators from the contest log to the Operators field  

4.1.13. Soapbox comments 

o Your comments on the contest, results, propagation etc., for inclusion in 
your Cabrillo submission. This text is cleared when selecting a new 
contest.  

4.1.14. Section Lists 



 When operating a state QSO Party, select the State from the drop-down list. If in 
doubt, click on the Import Section List button to make sure you have the most 
current list of county abbreviations:  

 

o These selection buttons are only shown when the contest has a section 
list (like QSO parties)  

o In the example above the state QSO party for CA (California) has been 
selected  

o The Edit Section List button is used to edit the list  
 This function edits the section table in the current database. It does 

NOT edit the section text file. If you want to export your section file 
after editing, use the File export menu link in the upper left corner of 
the Edit Section List dialog  

o The Import Section List button is used to import a new list from a file. 
Section list files are stored in the SupportFiles folder in your N1MM 
Logger+ User files area, or in a subfolder of the SupportFiles folder  

o There may be two section lists, for in-state or in-country and for other 
entrants. You will be prompted to import both section lists if more than one 
exists  

o The appropriate section list is used to determine multipliers (States, 
Provinces etc.) for the contest, which will be shown in the Multiplier 
window  

o The name of the list is hardcoded and will be shown while importing the 
file  

 The Show Rules button opens an Internet browser to the contest sponsor's 
website where the rules can be found. QSO parties, new contests, and minor 
contests tend to change their website addresses and/or rules frequently. Please 
contact us so we can update the program when this happens  

 The Show Setup button opens the section of the N1MM Logger+ online manual 
that gives the setup instructions for this contest  

4.2. Tab: Associated Files 



 

× 

 Change fron N1MM Logger Classic 

In N1MM Logger+, the Associated Files designated for a given contest - e.g, ARRL DX 
CW, WAE RTTY - remain the same for all instances of that contest, regardless of the 
database. Put another way, if you have defined Associated Files for ARRL DX SSB in 
one database, and you open another instance of that contest in another database, the 
filenames you set up will be transferred to the new Associated Files tab. 

 
 
For each of the following Associated Files, the Change and Clear buttons have the 



same function - the Change button allows you to select or change the file to be used. 
The Clear button lets you clear the filename if you don't wish to load one.  

Function key files are stored in the FunctionKeyMessages folder within your N1MM 
Logger+ User files area. You can create subfolders within this folder, but you cannot 
load or save function key files from the program into a folder that is outside this folder. 
You cannot clear the function key file entirely; if you are not using a contest-specific 
function key file, or for modes that are not included in the contest, just set the file to the 
mode-specific Default Messages.mc file (as in the example above for the SSB and 
Digital message files).  

 CW Function Key Filename - Select the CW function keys to use with this 
contest  

 SSB Function Key Filename - Select the SSB function keys to use with this 
contest  

 Digital Function Key Filename - Select the Digital Interface function keys to use 
with this contest from the Entry Window (not the extra keys that can be set up in 
the Digital Interface)  

 Master.scp Filename - Select the master.scp file for this contest type. Normally 
this will be the Default file, but some contests may use a restricted version. Use 
the Change button to select a different file, or the Default button to return to the 
default. Master.scp files are stored in the SupportFiles folder (or a subfolder of 
that folder) within the N1MM Logger+ User files area  

 Call History Filename - You can select a Call History file to be loaded for use 
with this contest. This is entirely optional. See the manual section on Call history 
Lookup? for details. If you want to use a Call History file, don't forget to turn on 
Call History Lookup on the Config menu. Call History files are stored in the 
CallHistoryFiles folder (or a subfolder of that folder) within the N1MM Logger+ 
User files area  

 Goal Filename - You can select an optional Goals file to be loaded for use with 
this contest. The Goals file is used for the Goals area in the Info window. Goals 
files are stored in the GoalFiles folder (or a subfolder of that folder) within the 
N1MM Logger+ User files area  

× 

 Update Your WL_CTY.DAT File Before Each Contest 

In addition to these files, be sure always to load the most recent WL_CTY.DAT file 
before entering a DX contest. This is a 2-step process. Download the most recent 
country file from the Internet using >Tools >Download latest country file (wl_cty.dat) 
(Internet). Then import it into the current database using >Tools >Import country list 
from downloaded file. The program will warn you if you open a database whose CTY 
table is less recent than the wl_cty.dat file in your N1MM Logger program directory. 

 

http://n1mmplus.hamdocs.com/tiki-editpage.php?page=Advanced+Functions


2.1.4 Supported Contests 

 1 General Contest Logging - All Modes 

 2 Supported HF Contests - CW and SSB 

 3 Supported QSO Parties - CW and SSB 

 4 Supported VHF Contests - CW and SSB 

 5 Supported RTTY and PSK Contests 

 6 Supported User Defined Contests 

o 6.1 The User Defined Contest Editor 

 7 My Contest Isn't Here 

 

 

2.1.4.1 General Contest Logging (all modes) 

Contest  
Log Type and 
Setup Link  

Remarks 

DX (General 
log)  

DX  
Sent RST, Received RST fields, Name and Comment 
field 

DXPEDITION  DXPEDITION  Only has Sent and Received RST fields 

DXSERIAL  DXSERIAL  
Sent and received RST, Nr fields and a Comment field 
for Generic Serial number contests. Default multipliers 
and points. 

DXSATELLIT  DXSATELLIT  Only three fields: Call, Grid and Satellite 

VHFDX  VHFDX  
Sent RST, Received RST fields, Grid and Comment 
field 

VHFSERIAL  VHFSERIAL  
Sent and received RST, Nr fields and Grid fields. For 
generic VHF serial number contests. Comments 
possible. 

 
 
 

 

2.1.4.2 Supported HF Contests - CW and SSB 

All contests are supported 'both' sides unless specifically mentioned.  

 

http://n1mmplus.hamdocs.com/tiki-index.php?page=General+Contest+Logging+-+All+Modes&structure=N1MM+Logger+Documentation
http://n1mmplus.hamdocs.com/tiki-index.php?page=Supported+HF+Contests+-+CW+and+SSB&structure=N1MM+Logger+Documentation
http://n1mmplus.hamdocs.com/tiki-index.php?page=Supported+QSO+Parties+-+CW+and+SSB&structure=N1MM+Logger+Documentation
http://n1mmplus.hamdocs.com/tiki-index.php?page=Supported+VHF+Contests+-+CW+and+SSB&structure=N1MM+Logger+Documentation
http://n1mmplus.hamdocs.com/tiki-index.php?page=Supported+RTTY+and+PSK+Contests&structure=N1MM+Logger+Documentation
http://n1mmplus.hamdocs.com/tiki-index.php?page=Supported+User+Defined+Contests&structure=N1MM+Logger+Documentation
http://n1mmplus.hamdocs.com/tiki-index.php?page=The+User+Defined+Contest+Editor&structure=N1MM+Logger+Documentation
http://n1mmplus.hamdocs.com/tiki-index.php?page=My+Contest+Isn%27t+Here&structure=N1MM+Logger+Documentation
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+General+Contest+Logging+-+All+Modes#DX
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+General+Contest+Logging+-+All+Modes#DXPEDITION
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+General+Contest+Logging+-+All+Modes#DXSERIAL
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+General+Contest+Logging+-+All+Modes#DXSATELLIT
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+General+Contest+Logging+-+All+Modes#VHFDX
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+General+Contest+Logging+-+All+Modes#VHFSERIAL


Contest Name and Website 
Link  

Log Type & 
Setup Link  

Remarks 

9A CW Contest   9ACW  
CW only; 3rd full weekend in 
December 

AGCW Happy New Year  AGCW  Happy New Year 

All Asian DX contest CW / 
SSB   

ALLASIACW 
ALLASIASSB  

CW - Third Saturday of June (48 
hours) 
SSB - First Saturday of September (48 
hours) 

Asiatic Russia 
Championship  

ASRUCHAMP  

January, 6 hours, 160-40 meters, 
SSB/CW 

ARCI QRP Contests   ARCI  
This contest supports 7 ARCI QRP 
contests plus several other QRP 
contests with similar exchanges 

ARI International DX Contest

  
ARIDX  Per version 4.0.63 

ARRL 10 Meter contest   ARRL10M  
 

ARRL 160-meter contest  ARRL160  
 

ARRL Field Day contest   FD  
See ARRL Field Day Setup 
instructions. 

ARRL International DX 
contest CW /Phone   

ARRLDXCW 
ARRLDXSSB   

ARRL November 
Sweepstakes CW / SSB   

SSCW 
SSSSB   

ARRL Rookie Roundup   
RRSSB 
RRCW  

SSB in April, RTTY in August, CW in 
December 

Asia-Pacific Sprint Contest 
CW / SSB   

 
APSCW 
APSSSB  

In Spring, Summer, Fall (2 hours) 
 

Baltic contest   BALTIC  
Every year the next to last weekend in 
May - one week before WPX CW 
Contest 

 

BFRR CW/SSB 
Championship  

BFRRCW 
BFRRSSB 

For Belarus stations only 
 

Black Sea Cup International
 

BSCI First full weekend in February 
 

CNCW Spanish contest   CNCW  Local Spanish CW contest 
 

CQ-M International DX 
contest   

CQM Second weekend of May 
 

http://fw.hamdocs.com/?file=sponsors.csv&id=9ACW
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+HF+Contests+-+CW+and+SSB#9ACW
http://fw.hamdocs.com/?file=sponsors.csv&id=AGCW
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+HF+Contests+-+CW+and+SSB#AGCW
http://fw.hamdocs.com/?file=sponsors.csv&id=ALLASIACW
http://fw.hamdocs.com/?file=sponsors.csv&id=ALLASIACW
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+HF+Contests+-+CW+and+SSB#ALLASIACW
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+HF+Contests+-+CW+and+SSB#ALLASIACW
http://fw.hamdocs.com/?file=sponsors.csv&id=ASRUCHAMP
http://fw.hamdocs.com/?file=sponsors.csv&id=ASRUCHAMP
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+HF+Contests+-+CW+and+SSB#ASRUCHAMP
http://fw.hamdocs.com/?file=sponsors.csv&id=ARCI
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+HF+Contests+-+CW+and+SSB#ARCI
http://fw.hamdocs.com/?file=sponsors.csv&id=ARIDX
http://fw.hamdocs.com/?file=sponsors.csv&id=ARIDX
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+HF+Contests+-+CW+and+SSB#ARIDX
http://fw.hamdocs.com/?file=sponsors.csv&id=ARRL10M
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+HF+Contests+-+CW+and+SSB#ARRL10M
http://fw.hamdocs.com/?file=sponsors.csv&id=ARRL160
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+HF+Contests+-+CW+and+SSB#ARRL160
http://fw.hamdocs.com/?file=sponsors.csv&id=FD
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+HF+Contests+-+CW+and+SSB#FD
http://fw.hamdocs.com/?file=sponsors.csv&id=ARRLDXCW
http://fw.hamdocs.com/?file=sponsors.csv&id=ARRLDXCW
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+HF+Contests+-+CW+and+SSB#ARRLDXCW
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+HF+Contests+-+CW+and+SSB#ARRLDXCW
http://fw.hamdocs.com/?file=sponsors.csv&id=SSCW
http://fw.hamdocs.com/?file=sponsors.csv&id=SSCW
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+HF+Contests+-+CW+and+SSB#SSCW
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+HF+Contests+-+CW+and+SSB#SSCW
http://fw.hamdocs.com/?file=sponsors.csv&id=RRCW
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+HF+Contests+-+CW+and+SSB#RRSSB
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+HF+Contests+-+CW+and+SSB#RRSSB
http://fw.hamdocs.com/?file=sponsors.csv&id=APSCW
http://fw.hamdocs.com/?file=sponsors.csv&id=APSCW
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+HF+Contests+-+CW+and+SSB#APSCW
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+HF+Contests+-+CW+and+SSB#APSCW
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+HF+Contests+-+CW+and+SSB#APSCW
http://fw.hamdocs.com/?file=sponsors.csv&id=BALTIC
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+HF+Contests+-+CW+and+SSB#BALTIC
http://fw.hamdocs.com/?file=sponsors.csv&id=BFRRCW
http://fw.hamdocs.com/?file=sponsors.csv&id=BFRRCW
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+HF+Contests+-+CW+and+SSB#BFRRCW
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+HF+Contests+-+CW+and+SSB#BFRRCW
http://fw.hamdocs.com/?file=sponsors.csv&id=BSCI
http://fw.hamdocs.com/?file=sponsors.csv&id=BSCI
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+HF+Contests+-+CW+and+SSB#BSCI
http://fw.hamdocs.com/?file=sponsors.csv&id=CNCW
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+HF+Contests+-+CW+and+SSB#CNCW
http://fw.hamdocs.com/?file=sponsors.csv&id=CQM
http://fw.hamdocs.com/?file=sponsors.csv&id=CQM
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+HF+Contests+-+CW+and+SSB#CQM


Contest Name and Website 
Link  

Log Type & 
Setup Link  

Remarks 

CQ World-Wide 160 Meter 
DX Contest - CW / Phone   

CQ160CW 
CQ160SSB    

CQ World Wide DX contest - 
CW / SSB   

CQWWCW 
CQWWSSB  

CW - Last full weekend of November 
(48 hours) 
SSB - Last full weekend of October (48 
hours) 

 

CQ World Wide WPX 
contest - CW / Phone   

CQWPXCW 
CQWPXSSB    

CQSA SSB Contest   CQSASSB  
South America. Second full weekend in 
October  

Cup of the Russian 
Federation - SSB   

RFCCW 
RFCSSB  

Internal Russian contest in January 
 

Cup of the Russian 
Federation - CW   

RFCCW 
RFCSSB  

Internal Russian contest in January - 
see also RTTY version below  

CWops Mini-CWT Test  CWOPS  Several 1-hour contests each month 
 

CWops CW Open  CWOPSOPEN  
TBD - August 20/21 in 2011, 
September 1/2 in 2012  

DARC 10 meter contest   DARC10M  2nd full weekend in January 
 

DARC 
Weihnachtswettbewerb - 
XMAS contest   

XMAS  December 26 
 

European Sprint  

EUSCW 
EUSSSB  

In April and October, both modes, 4 
hours  

DIG contest - CW / Phone   
DIGCW 
DIGSSB  

SSB: Second weekend in March 
CW: Second weekend in April 
Also for short contests in June and 
October 

 

Elecraft QSO Party   EQSO  
Despite the name, handled as a 
separate contest  

EU HF Championship   EUHFC  
First Saturday in August (12:00 - 23:59 
UTC)  

FOC QSO Party   FOCBWQP  
First Class Operators Club (FOC) QSO 
Party  

FOC Marathon   FOCCW  
First Class Operators Club (FOC) 
Marathon. First full weekend in 
February 

 

Gagarin Cup   GCUP  April; CW, HF plus satellites 
 

http://fw.hamdocs.com/?file=sponsors.csv&id=CQ160CW
http://fw.hamdocs.com/?file=sponsors.csv&id=CQ160CW
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+HF+Contests+-+CW+and+SSB#CQ160CW
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Contest Name and Website 
Link  

Log Type & 
Setup Link  

Remarks 

GACW WWSA CW DX 
contest   

GACW  Second weekend in June. CW only 
 

HA DX contest   HADX  3rd full weekend in January 
 

Helvetia Contest   HELVETIA  
  

High Speed CW Contest -
HSC CW   

HSCCW  
  

Holyland contest   HOLYLAND  
  

IARU HF Contest   IARU  
  

IARU Region 1 Field Day   FDREG1  

Varying rules for Belgium, Germany, 
United Kingdom (SSB and CW), 
Netherlands, Switzerland, Ireland (only 
CW), Italy, Slovenia (S5) and Russia 
(UA, UA2, UA9) 

 

RSGB Islands On The Air 
Contest   

IOTA  
  

International Naval Contest

  
NAVAL  

  

JA-domestic  JADOMESTIC  
Generic support for Japanese domestic 
contests  

JIDX Contest   
JIDXCW 
JIDXSSB  

CW: 2nd full weekend of April 
PH: 2nd full weekend of November 
Sat. 0700 UTC - Sun. 1300 UTC 

 

JT DX Contest  JTDX 

Third weekend in November, CW or 
SSB (pick one)  

King of Spain contest   
KINGEACW 
KINGEASSB    

LOTW   
LOTWCW 
LOTWSSB    

LZ DX contest   LZDX  
The weekend before the last full 
weekend of November (weekend 
before CQWW CW) 

 

LZ Open and LZ Sprint 
contests   

LZOPEN  
For all three contests. LZ Open and 
both sprint contests (40/80 meter)  

Manchester Mineira DX 
Contest   

CQMMDX  
International contest by CWJF - 3rd full 
weekend of April  

Michigan QRP Contest   ARCI  
This contest supports 4 Michigan QRP 
contests. Select ARCI contest (same  
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Contest Name and Website 
Link  

Log Type & 
Setup Link  

Remarks 

rules) 

NA Sprint - CW / SSB   
SPRINTCW 
SPRINTSSB  

CW: First Sunday in February 
SSB: Sunday of first full weekend in 
February 
CW: Sunday following first Monday in 
September 
SSB: Second Sunday following first 
Monday in September 

 

NS Sprint and Sprint Ladder
 

SPRINTNS 
SPRINTLADD  

Both contests are weekly, CW only, 
identical except for dupe rules, which 
may change on short notice 
SPRINTLADD allows sasme-band 
dupes after one intervening QSO, while 
SPRINTNS does not allow same-band 
dupes. 

 

Minitest CW Test   MINITESTCW  
CW:Almost every Wednesday 1800-
1900Z  

North American QSO Parties 
- CW / SSB   

NAQPCW 
NAQPSSB  

CW: Second full weekend in January. 
First full weekend in August 
SSB: Third full weekend in January. 
Third full weekend in August 

 

NRAU-Baltic contest   
NRAUCW 
NRAUSSB  

2nd full weekend in January 
 

Oceania contest CW / SSB

  

OCEANIACW 
OCEANIASSB  

SSB: First weekend in October 
CW: Second weekend in October  

OK-OM DX contest   OKOMDX  Second full weekend in November 
 

PA-beker CW / SSB contest

  

PABEKERCW 
PABEKERSSB  

Second full weekend in November 
Local Dutch CW and SSB contest  

PACC contest   PACC  First full weekend of February 
 

Portugal Day Contest   PORTUGAL  Second Saturday of June 
 

QCWA QSO Party  QCWAQSO  

Despite the name, treated as a 
separate contest  

QSO parties (US and 
Canada)  

QSOPARTY  See next chapter/section 
 

RAC Canada Day Contest / 
RAC Canada Winter Contest

  

RAC  Both contests have the same rules 
 

RAEM Contest  RAEM  Fourth full weekend of December 
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Contest Name and Website 
Link  

Log Type & 
Setup Link  

Remarks 

(E.T.Krenkel contest)  

REF DX contest   
REFCW 
REFSSB  

CW: last weekend of January 
SSB: last weekend of February  

RF Championship   RFCHAMP  
For English text select on top 
"Translate to English"  

RSGB 160 Meter CW 
contests   

RSGB160CW  CW only. In February and November 
 

RSGB 21/28 MHz contest   RSGB2128  
  

RSGB 80 Meter Club 
Championship   

RSGB80MCC  
  

RSGB Affiliated Societies 
Contests  

RSGBAFS-C 
RSGBAFS-S    

RSGB Club Calls contest   RSGBCLUB  
  

RSGB Commonwealth 
Contest   

RSGBBERU  British Commonwealth stations only 
 

RSGB National Field Day, 
RSGB SSB Field Day   

FDREG1  

According rules for Belgium, Germany, 
United Kingdom (SSB and CW), 
Netherlands, Switzerland, Ireland (only 
CW), Slovenia (S5) and Russia (UA, 
UA2, UA9). 

 

RSGB Low Power Contest   RSGBLP  
  

RSGB ROPOCO   ROPOCO  Internal RSGB contest 
 

Russian District Award 
Contest  

RDAC  
  

Russian DX   RUSSIANDX  
  

Russian Radiosport Team 
Championship   

RRTC 
RRTCT  

Third Saturday in July 
 

Russian YL/OM contest   RUSYLOM  in Russian 
 

SAC - CW / SSB   
SACCW 
SACSSB  

Scandinavian Activity Contest 
 

SYLRA contest  SYLRA 

  

SP DX contest   SPDX  
First full weekend of April (15:00-15:00 
GMT)  

Stew Perry Topband 
Distance Challenge   

STEWPERRY  Last full weekend of December 
 

TRC DX Contest   TRCDX  
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Contest Name and Website 
Link  

Log Type & 
Setup Link  

Remarks 

UA1DZ Memorial Cup   DZCUP  
For English text select on top 
"Translate to English"  

UBA DX Contest CW/SSB   
UBACW 
UBASSB  

SSB: last weekend of January 
CW: last weekend of February  

UBA ON contest   UBAON  

Last Sunday September: 6 m 
Phone/CW 
First Sunday October: HF - 80 m SSB 
Second Sunday October: HF - 80 m 
CW 
Third Sunday October: 2 m Phone/CW 

 

UBA Low Band Winter 
Contest   

UBAWINTER  160, 80 and 40 meters 
 

UBA Spring   UBASPRING  

Second Sunday March: HF - 80m CW 
Third Sunday March: VHF-6m 
Phone/CW 
Fourth Sunday March: VHF-2m 
Phone/CW 
First Sunday April: HF - 80m SSB 

 

Ukrainian Championship   
UKRCHCW 
UKRCHSSB    

Ukrainian DX contest   UKRAINDX  First full weekend of November 
 

UN DX contest  UNDX Open Kazakhstan Championship 
 

WAEDC-Contest   
WAECW 
WAESSB  

The starter for the new Contest 
season.  

Worked All Germany contest

  
WAG  October, third full weekend 

 

World Wide Peace 
Messenger Contest   

WWPMC  
1200UTC Saturday to 1200 UTC 
Sunday, every second weekend of 
January 

 

World Radiosport Team 
Championship   

WRTC  
for on-site participants in World 
Radiosport Team Championship held 
every 4 years - others use IARU 

 

World Wide Iron Ham 
Contest  

WWIH 

Last full weekend in December (also 
RTTY)  

YO DX HF contest   YOHFDX  Last weekend in August 
 

YU DX Contest   YUDX  Third full weekend in April 
 

Independence of Venezuela 
Contest   

YV  First full weekend in July 
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http://fw.hamdocs.com/?file=sponsors.csv&id=UNDX
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+HF+Contests+-+CW+and+SSB#UNDX
http://fw.hamdocs.com/?file=sponsors.csv&id=WAECW
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+HF+Contests+-+CW+and+SSB#WAECW
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+HF+Contests+-+CW+and+SSB#WAECW
http://fw.hamdocs.com/?file=sponsors.csv&id=WAG
http://fw.hamdocs.com/?file=sponsors.csv&id=WAG
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+HF+Contests+-+CW+and+SSB#WAG
http://fw.hamdocs.com/?file=sponsors.csv&id=WWPMC
http://fw.hamdocs.com/?file=sponsors.csv&id=WWPMC
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+HF+Contests+-+CW+and+SSB#WWPMC
http://fw.hamdocs.com/?file=sponsors.csv&id=WRTC
http://fw.hamdocs.com/?file=sponsors.csv&id=WRTC
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+HF+Contests+-+CW+and+SSB#WRTC
http://www.ironham.com.br/arquivos/IRON_HAM_CONTEST_ENGLISH.pdf
http://www.ironham.com.br/arquivos/IRON_HAM_CONTEST_ENGLISH.pdf
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+HF+Contests+-+CW+and+SSB#WWIH
http://fw.hamdocs.com/?file=sponsors.csv&id=YOHFDX
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+HF+Contests+-+CW+and+SSB#YOHFDX
http://fw.hamdocs.com/?file=sponsors.csv&id=YUDX
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+HF+Contests+-+CW+and+SSB#YUDX
http://fw.hamdocs.com/?file=sponsors.csv&id=YV
http://fw.hamdocs.com/?file=sponsors.csv&id=YV
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+HF+Contests+-+CW+and+SSB#YV


Contest Name and Website 
Link  

Log Type & 
Setup Link  

Remarks 

Norwegian RRL Winter 
Contest   

NRRLVINTER  March. Rules in Norwegian, as .pdf file 
 

 

 

2.1.4.3 QSO Parties (CW/SSB) 

The QSO parties listed below are supported by N1MM Logger+.  
Select: QSOPARTY and select the correct state in the dropdown box which will appear.  
The QSO parties use a configuration file named 'QSOparty.sec' with the used sections 
per QSO party.  
See the QSO Party Setup Instructions for more information on QSO parties in general 
and some specifics. There are some scoring anomalies with some of the QSO parties.  

1. United States 

State and Website Link  Setup Link 

Alabama - AL   
 

Alaska - AK   
 

Arkansas - AR   
 

Arizona - AZ   
 

California - CA   
 

Colorado - CO   
 

Connecticut - CT   Inactive. See New England Contest NEWE 

Delaware - DE   
 

Florida - FL   FL Setup Instructions  

Georgia - GA   
 

Hawaii - HI   
 

Idaho - ID   
 

Indiana - IN   
IN Setup Instructions Same weekend: 7QP, Indiana QSO 
Party and the New England QSO Party 

Illinois - IL   
 

Iowa - IA   
 

Kansas - KS   
 

Kentucky - KY   
 

Louisiana - LA   
 

http://fw.hamdocs.com/?file=sponsors.csv&id=NRRLVINTER
http://fw.hamdocs.com/?file=sponsors.csv&id=NRRLVINTER
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+HF+Contests+-+CW+and+SSB#NRRLVINTER
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+QSO+Parties+-+CW+and+SSB#TOC
http://fw.hamdocs.com/?file=sponsors.csv&id=QSOP_AL
http://fw.hamdocs.com/?file=sponsors.csv&id=QSOP_AK
http://fw.hamdocs.com/?file=sponsors.csv&id=QSOP_AR
http://fw.hamdocs.com/?file=sponsors.csv&id=QSOP_AZ
http://fw.hamdocs.com/?file=sponsors.csv&id=QSOP_CA
http://fw.hamdocs.com/?file=sponsors.csv&id=QSOP_CO
http://fw.hamdocs.com/?file=sponsors.csv&id=QSOP_CT
http://fw.hamdocs.com/?file=sponsors.csv&id=QSOP_DE
http://fw.hamdocs.com/?file=sponsors.csv&id=QSOP_FL
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+QSO+Parties+-+CW+and+SSB#QSOP_FL
http://fw.hamdocs.com/?file=sponsors.csv&id=QSOP_GA
http://fw.hamdocs.com/?file=sponsors.csv&id=QSOP_HI
http://fw.hamdocs.com/?file=sponsors.csv&id=QSOP_ID
http://fw.hamdocs.com/?file=sponsors.csv&id=QSOP_IN
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+QSO+Parties+-+CW+and+SSB#QSOP_IN
http://fw.hamdocs.com/?file=sponsors.csv&id=QSOP_IL
http://fw.hamdocs.com/?file=sponsors.csv&id=QSOP_IA
http://fw.hamdocs.com/?file=sponsors.csv&id=QSOP_KS
http://fw.hamdocs.com/?file=sponsors.csv&id=QSOP_KY
http://fw.hamdocs.com/?file=sponsors.csv&id=QSOP_LA


State and Website Link  Setup Link 

MARAC - county 
hunters   

MARAC Setup Instructions  

Maryland DC - MD   
 

Michigan - MI   
 

Minnesota - MN   
 

Missouri - MO   
 

Montana - MT   
 

Nebraska - NE   
 

New England - NEWE

  

NEWE Setup Instructions Same weekend: 7QP, Indiana 
QSO Party and the New England QSO Party 

New Mexico - NM   
 

New Hampshire - NH   
 

New Jersey - NJ   
 

New York - NY   
 

North Carolina - NC   
 

North Dakota - ND   
 

Nevada - NV   
 

Ohio - OH   
 

Oklahoma - OK   
 

Oregon - OR   
 

Pennsylvania - PA   PA Setup Instructions  

South Carolina - SC   
 

South Dakota - SD   
 

Tennessee - TN   
 

Texas - TX   
 

Vermont - VT   
 

Virginia - VA   
 

Wisconsin - WI   
The 1.5 power multiplier is not supported. The score is stored 
as an integer. 

Washington Salmon 
Run - WA    

West Virginia - WV   
 

7th Call Area - 7QP   
7QP Setup Instructions Same weekend: 7QP, Indiana QSO 
Party and the New England QSO Party 

http://fw.hamdocs.com/?file=sponsors.csv&id=QSOP_MARAC
http://fw.hamdocs.com/?file=sponsors.csv&id=QSOP_MARAC
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+QSO+Parties+-+CW+and+SSB#QSOP_MARAC
http://fw.hamdocs.com/?file=sponsors.csv&id=QSOP_MD
http://fw.hamdocs.com/?file=sponsors.csv&id=QSOP_MI
http://fw.hamdocs.com/?file=sponsors.csv&id=QSOP_MN
http://fw.hamdocs.com/?file=sponsors.csv&id=QSOP_MO
http://fw.hamdocs.com/?file=sponsors.csv&id=QSOP_MT
http://fw.hamdocs.com/?file=sponsors.csv&id=QSOP_NE
http://fw.hamdocs.com/?file=sponsors.csv&id=QSOP_NEWE
http://fw.hamdocs.com/?file=sponsors.csv&id=QSOP_NEWE
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+QSO+Parties+-+CW+and+SSB#QSOP_NEWE
http://fw.hamdocs.com/?file=sponsors.csv&id=QSOP_NM
http://fw.hamdocs.com/?file=sponsors.csv&id=QSOP_NH
http://fw.hamdocs.com/?file=sponsors.csv&id=QSOP_NJ
http://fw.hamdocs.com/?file=sponsors.csv&id=QSOP_NY
http://fw.hamdocs.com/?file=sponsors.csv&id=QSOP_NC
http://fw.hamdocs.com/?file=sponsors.csv&id=QSOP_ND
http://fw.hamdocs.com/?file=sponsors.csv&id=QSOP_NV
http://fw.hamdocs.com/?file=sponsors.csv&id=QSOP_OH
http://fw.hamdocs.com/?file=sponsors.csv&id=QSOP_OK
http://fw.hamdocs.com/?file=sponsors.csv&id=QSOP_OR
http://fw.hamdocs.com/?file=sponsors.csv&id=QSOP_PA
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+QSO+Parties+-+CW+and+SSB#QSOP_PA
http://fw.hamdocs.com/?file=sponsors.csv&id=QSOP_SC
http://fw.hamdocs.com/?file=sponsors.csv&id=QSOP_SD
http://fw.hamdocs.com/?file=sponsors.csv&id=QSOP_TN
http://fw.hamdocs.com/?file=sponsors.csv&id=QSOP_TX
http://fw.hamdocs.com/?file=sponsors.csv&id=QSOP_VT
http://fw.hamdocs.com/?file=sponsors.csv&id=QSOP_VA
http://fw.hamdocs.com/?file=sponsors.csv&id=QSOP_WI
http://fw.hamdocs.com/?file=sponsors.csv&id=QSOP_WA
http://fw.hamdocs.com/?file=sponsors.csv&id=QSOP_WA
http://fw.hamdocs.com/?file=sponsors.csv&id=QSOP_WV
http://fw.hamdocs.com/?file=sponsors.csv&id=QSOP_7QP
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+QSO+Parties+-+CW+and+SSB#QSOP_7QP


State and Website Link  Setup Link 

IN7QPNE  

IN7QPNE Setup Instructions 
For users who are "out-of-state" for the IN, NEWE, or 7QP 
QSO parties 
Log all contests in one log and send the same cabrillo file to 
all sponsors 

2. Canada 

Province and Website Link  Setup Link  

 

British Columbia - BC   
  

Maritime QSO Party - MCC   
  

Ontario - ON   
  

3. Other QSO Parties 

For the Elecraft and QCWA QSO Parties, please visit the Supported HF Contests page.  

 

 

2.1.4.4 Supported VHF CW and SSB Contests 

Contest Name and Website 
Link  

Log Type and 
Setup Link  

Remarks  

 

ARRL January VHF 
Sweepstakes   

ARRLVHFJAN  January 
 

ARRL June VHF QSO Party   ARRLVHFJUN  June 
 

ARRL August UHF Contest   ARRLUHFAUG  August 
 

ARRL September VHF QSO 
Party   

ARRLVHFSEP  September 
 

CQ WW VHF Contest   CQWWVHF  July - 50 MHz and 144 MHz only 
 

IARU Region 1 50 MHz 
contest   

VHFREG1  Only 50 MHz - June 
 

IARU Region 1 144 MHz 
September   

VHFREG1  Only 144 MHz - September 
 

IARU Region 1 
UHF/Microwaves October   

VHFREG1  UHF and Microwaves - October 
 

Other Region 1 VHF and up 
contests   

VHFREG1  VHF and up - March, May, July 
 

http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+QSO+Parties+-+CW+and+SSB#QSOP_7QP
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+QSO+Parties+-+CW+and+SSB#QSOP_7QP
http://fw.hamdocs.com/?file=sponsors.csv&id=QSOP_BC
http://fw.hamdocs.com/?file=sponsors.csv&id=QSOP_MCC
http://fw.hamdocs.com/?file=sponsors.csv&id=QSOP_ON
http://n1mmplus.hamdocs.com/tiki-index.php?page=Supported+HF+Contests+-+CW+and+SSB&structure=N1MM+Logger+Documentation
http://fw.hamdocs.com/?file=sponsors.csv&id=ARRLVHFJAN
http://fw.hamdocs.com/?file=sponsors.csv&id=ARRLVHFJAN
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+VHF+Contests+-+CW+and+SSB#ARRL_January_VHF_Sweepstakes
http://fw.hamdocs.com/?file=sponsors.csv&id=ARRLVHFJUN
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+VHF+Contests+-+CW+and+SSB#ARRL_June_VHF_QSO_Party
http://fw.hamdocs.com/?file=sponsors.csv&id=ARRLUHFAUG
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+VHF+Contests+-+CW+and+SSB#ARRL_August_UHF_Contest
http://fw.hamdocs.com/?file=sponsors.csv&id=ARRLVHFSEP
http://fw.hamdocs.com/?file=sponsors.csv&id=ARRLVHFSEP
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+VHF+Contests+-+CW+and+SSB#ARRL_September_VHF_QSO_Party
http://fw.hamdocs.com/?file=sponsors.csv&id=CQWWVHF
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+VHF+Contests+-+CW+and+SSB#CQ_WW_VHF_Contest
http://fw.hamdocs.com/?file=sponsors.csv&id=VHFREG1
http://fw.hamdocs.com/?file=sponsors.csv&id=VHFREG1
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+VHF+Contests+-+CW+and+SSB#IARU_Region_1_contesting_-_50_MHz,_VHF,_UHF/Microwaves
http://fw.hamdocs.com/?file=sponsors.csv&id=VHFREG1
http://fw.hamdocs.com/?file=sponsors.csv&id=VHFREG1
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+VHF+Contests+-+CW+and+SSB#IARU_Region_1_contesting_-_50_MHz,_VHF,_UHF/Microwaves
http://fw.hamdocs.com/?file=sponsors.csv&id=VHFREG1
http://fw.hamdocs.com/?file=sponsors.csv&id=VHFREG1
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+VHF+Contests+-+CW+and+SSB#IARU_Region_1_contesting_-_50_MHz,_VHF,_UHF/Microwaves
http://fw.hamdocs.com/?file=sponsors.csv&id=VHFREG1
http://fw.hamdocs.com/?file=sponsors.csv&id=VHFREG1
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+VHF+Contests+-+CW+and+SSB#IARU_Region_1_contesting_-_50_MHz,_VHF,_UHF/Microwaves


Contest Name and Website 
Link  

Log Type and 
Setup Link  

Remarks  

 

Marconi CW contest 144 MHz 
/ 50 MHz   

VHFREG1  
  

NRAU Activity Contest   VHFNAC  
  

REF Departments contest 50 
MHz   

DDFM50  Only 50 MHz 
 

VHF/UHF Helvetia 26 contest

  
VHFHELV26  Swiss VHF and up contest 

 

VHF HG OB contest   VHFHGOB  Hungarian VHF contest 
 

VHF UA1DZ Cup   VHFDZCUP  Russian VHF contest 
 

VRZA - Nederlandse Locator 
Contest   

REGIOVHF  
WANLC - Dutch contest, every month 
NB selecteer: REGIOVHF  

UKSMG sporadic-E 
competition   

UKSMG  
  

 

2.1.4.5 Supported RTTY/PSK Contests 

All contests are supported 'both' sides unless specifically mentioned.  

Contest Name and Website 
Link  

Log Type and 
Setup Link  

Remarks 

10 Meter RTTY Contest   ARRLRTTY  
First full weekend of December (rules 
same as ARRL RTTY Roundup) 

ANARTS WW RTTY contest   DLDCRTTY  
Defunct - Replaced by DRCG Long 
Distance Contest 

Anatolian RTTY contest   ANATOLRTTY  
Discontinued contest? Third full 
weekend in May 

ARRL Rookie Roundup RTTY

  
RRRTTY  Third Sunday of August 

ARRL RTTY Roundup   ARRLRTTY  
First full weekend of January (not on 
January 1) 

BARTG HF RTTY contest - 
formerly the Spring RTTY 
Contest   

BARTGSRTTY  Third full weekend in March 

BARTG RTTY Sprint contest   BARTGRTTYS  Fourth full weekend of January 

BARTG Sprint75 contest   BAR75RTTYS  75 baud RTTY. April, September (4 

http://fw.hamdocs.com/?file=sponsors.csv&id=VHFREG1
http://fw.hamdocs.com/?file=sponsors.csv&id=VHFREG1
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+VHF+Contests+-+CW+and+SSB#Marconi_CW_contest
http://fw.hamdocs.com/?file=sponsors.csv&id=VHFNAC
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+VHF+Contests+-+CW+and+SSB#NAC_Activity_Contest
http://fw.hamdocs.com/?file=sponsors.csv&id=DDFM50
http://fw.hamdocs.com/?file=sponsors.csv&id=DDFM50
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+VHF+Contests+-+CW+and+SSB#REF_Departments_contest_50_Mhz
http://fw.hamdocs.com/?file=sponsors.csv&id=VHFHELV26
http://fw.hamdocs.com/?file=sponsors.csv&id=VHFHELV26
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+VHF+Contests+-+CW+and+SSB#VHF/UHF_Helvetia_26_contest
http://fw.hamdocs.com/?file=sponsors.csv&id=VHFHGOB
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+VHF+Contests+-+CW+and+SSB#VHF_HG_OB_contest
http://fw.hamdocs.com/?file=sponsors.csv&id=VHFDZCUP
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+VHF+Contests+-+CW+and+SSB#VHF_UA1DZ_Cup
http://fw.hamdocs.com/?file=sponsors.csv&id=REGIOVHF
http://fw.hamdocs.com/?file=sponsors.csv&id=REGIOVHF
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+VHF+Contests+-+CW+and+SSB#VRZA_-_Nederlandse_Locator_Contest_-_WANLC
http://fw.hamdocs.com/?file=sponsors.csv&id=UKSMG
http://fw.hamdocs.com/?file=sponsors.csv&id=UKSMG
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+VHF+Contests+-+CW+and+SSB#UKSMG_sporadic-E_competition
http://fw.hamdocs.com/?file=sponsors.csv&id=ARRLRTTY
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+RTTY+and+PSK+Contests#ARRLRTTY
http://fw.hamdocs.com/?file=sponsors.csv&id=DLDCRTTY
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+RTTY+and+PSK+Contests#DLDCRTTY
http://fw.hamdocs.com/?file=sponsors.csv&id=ANATOLRTTY
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+RTTY+and+PSK+Contests#ANATOLRTTY
http://fw.hamdocs.com/?file=sponsors.csv&id=RRRTTY
http://fw.hamdocs.com/?file=sponsors.csv&id=RRRTTY
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+RTTY+and+PSK+Contests#RRRTTY
http://fw.hamdocs.com/?file=sponsors.csv&id=ARRLRTTY
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+RTTY+and+PSK+Contests#ARRLRTTY
http://fw.hamdocs.com/?file=sponsors.csv&id=BARTGSRTTY
http://fw.hamdocs.com/?file=sponsors.csv&id=BARTGSRTTY
http://fw.hamdocs.com/?file=sponsors.csv&id=BARTGSRTTY
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+RTTY+and+PSK+Contests#BARTGSRTTY
http://fw.hamdocs.com/?file=sponsors.csv&id=BARTGRTTYS
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+RTTY+and+PSK+Contests#BARTGRTTYS
http://fw.hamdocs.com/?file=sponsors.csv&id=BAR75RTTYS
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+RTTY+and+PSK+Contests#BAR75RTTYS


Contest Name and Website 
Link  

Log Type and 
Setup Link  

Remarks 

hours each) 

CQ World Wide DX - RTTY   CQWWRTTY  
Last full weekend of September (48 
hours) 

CQ World Wide WPX - RTTY

  
CQWPXRTTY  Second full weekend of February 

CIS DX RTTY contest   CISDXRTTY  
QPSK63 in 2009/2010. Third full 
weekend of September 

Russian Federation Digital 
contest   

RFCDIGI  Second weekend of September 

Cup of the Russian Federation 
RTTY   

RUCUPRTTY  
For Russians only. Second weekend 
of September 

DL-DX RTTY contest   DLDXRTTY  First full weekend of July 

DMC RTTY   DMCRTTY  Third full weekend of July 

DRCG Long Distance RTTY   DRCGWWRTTY  Second full weekend of June 

EA PSK31 contest   EAPSK  Second full weekend of March 

EA RTTY contest   EARTTY  First full weekend of April 

EPC PSK World Wide DX   EPCWWDX  PSK63. First weekend in February 

EPC RU DX Contest  EPCRUDX  March BPSK63 

EPC PSK63 QSO party   EPCPSK63QP  
PSK63. Third full weekend of 
November 

EU PSK DX contest   EUPSKDX  PSK63. Third full weekend of May 

JARTS WW RTTY contest   JARTSWWRTY  Third full weekend in October 

JT RTTY DX Contest   JTDXRTTY Second full weekend in January 

LOTW RTTY contest   LOTWRTTY  Contest discontinued? 

Makrothen RTTY contest   MAKRORTTY  Second full weekend in October 

NA Sprint - RTTY   SPRINTRTTY  
Sunday of second full weekend in 
March. Sunday of second full 
weekend in October 

North American QSO Parties 
(NAQP) - RTTY   

NAQPRTTY  
Last full weekend in February. Third 
full weekend in August 

OK DX RTTY contest   OKDXRTTY  Third full weekend in December 

Quick PSK63 contest   SARTGRTTY  
PSK63. Uses SARTG rules. First 
Saturday of September 

Russian PSK DX Contest  RUSDXPSK PSK. Third weekend in February 

Russian DX RTTY contest   RUSDXRTTY  RTTY. First Saturday of September 

http://fw.hamdocs.com/?file=sponsors.csv&id=CQWWRTTY
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+RTTY+and+PSK+Contests#CQWWRTTY
http://fw.hamdocs.com/?file=sponsors.csv&id=CQWPXRTTY
http://fw.hamdocs.com/?file=sponsors.csv&id=CQWPXRTTY
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+RTTY+and+PSK+Contests#CQWPXRTTY
http://fw.hamdocs.com/?file=sponsors.csv&id=CISDXRTTY
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+RTTY+and+PSK+Contests#CISDXRTTY
http://fw.hamdocs.com/?file=sponsors.csv&id=RFCDIGI
http://fw.hamdocs.com/?file=sponsors.csv&id=RFCDIGI
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+RTTY+and+PSK+Contests#RFCDIGI
http://fw.hamdocs.com/?file=sponsors.csv&id=RUCUPRTTY
http://fw.hamdocs.com/?file=sponsors.csv&id=RUCUPRTTY
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+RTTY+and+PSK+Contests#RUCUPRTTY
http://fw.hamdocs.com/?file=sponsors.csv&id=DLDXRTTY
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+RTTY+and+PSK+Contests#DLDXRTTY
http://fw.hamdocs.com/?file=sponsors.csv&id=DMCRTTY
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+RTTY+and+PSK+Contests#DMCRTTY
http://fw.hamdocs.com/?file=sponsors.csv&id=DLDCRTTY
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+RTTY+and+PSK+Contests#DRCGWWRTTY
http://fw.hamdocs.com/?file=sponsors.csv&id=EAPSK
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+RTTY+and+PSK+Contests#EAPSK
http://fw.hamdocs.com/?file=sponsors.csv&id=EARTTY
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+RTTY+and+PSK+Contests#EARTTY
http://fw.hamdocs.com/?file=sponsors.csv&id=EPCWWDX
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+RTTY+and+PSK+Contests#EPCWWDX
http://fw.hamdocs.com/?file=sponsors.csv&id=EPCRUDX
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+RTTY+and+PSK+Contests#EPCRUDX
http://fw.hamdocs.com/?file=sponsors.csv&id=EPCPSK63QP
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+RTTY+and+PSK+Contests#EPCPSK63QP
http://fw.hamdocs.com/?file=sponsors.csv&id=EUPSKDX
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+RTTY+and+PSK+Contests#EUPSKDX
http://fw.hamdocs.com/?file=sponsors.csv&id=JARTSWWRTY
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+RTTY+and+PSK+Contests#JARTSWWRTY
http://fw.hamdocs.com/?file=sponsors.csv&id=JTDXRTTY
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Contest Name and Website 
Link  

Log Type and 
Setup Link  

Remarks 

SARTG New Year RTTY   SARTGNYRTY  January 1st 

SARTG WW RTTY contest   SARTGRTTY  Third weekend in August 

SCC RTTY Championship   SCCRTTY  Last full weekend in August 

SP DX RTTY contest   SPDXRTTY  4th full weekend of April 

TARA Grid Dip contest   TARAGRID  
RTTY and PSK. First Saturday of 
August 

TARA PSK Rumble   TARAPSK  PSK31. First Saturday of October 

TARA RTTY Melee   TARARTTY  RTTY. First Saturday of December 

TARA Skirmish   TARAPSK  Digital. Third Saturday of April 

Ukrainian RTTY 
Championship   

UKRCHRTTY  
For Ukrainian stations only. Third 
weekend of April 

Ukrainian DX RTTY contest   UKRAINRTTY  First full weekend of November 

Ukrainian Open RTTY 
Championship   

UKRTTYOPEN  First full weekend of March 

Ukrainian DX DIGI contest   UKRAINDIGI  
RTTY 75 baud, PSK63. Fourth full 
weekend of June 

Ukrainian DX Classic RTTY 
contest   

UKRAINDX  
DX Classic RTTY. Third weekend of 
June 

United Kingdon DX Contest - 
RTTY   

UKDXRTTY  Second full weekend of July 

Volta RTTY contest   VOLTARTTY  Second full weekend in May 

WAEDC RTTY contest   WAERTTY  Second full weekend in November 

World Wide Iron Ham Contest
 

WWIH 

Last full weekend in December (also 
SSB and CW) 

XE RTTY contest   XERTTY  First full weekend of February 

 

 

2.1.4.6 Supported User Defined Contests 

× UDC Installation Instructions  
Installation instructions for User Defined Contests are located HERE.  
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Contest Name and Website 
Link  

Log Type & 
Setup Link  

Remarks 

50RS VHF   EARSVHF  50RS VHF 

ACHAMPCW  ACHAMPCW  ACHAMPCW 

AEGEAN RTTY Contest   AEGEANRTTY  AEGEAN RTTY Contest 

AGB   AGB  AGB 

AGB NEMIGA/PARTY   AGB_RTTY  AGB NEMIGA/PARTY 

AGB Party   AGBPARTY  AGB Party 

ALASKA QSO Party   AKQP_RTTY  ALASKA QSO Party 

ARI RTTY 80/40m   ARIRTTY  ARI RTTY 80/40m 

ARI SEZIONI   ARI_SEZIONI  ARI SEZIONI 

Arktika Polar Radioman   ARKTIKAPR  Arktika Polar Radioman 

ARKTIKA-SPRING  AC-SPRING  ARKTIKA-SPRING 

ARR PSK63   ARR_RTTY  Portuguese ARR PSK63 

ARRL-EME   ARRLEMEVHF  ARRL-EME 

Battle of Carabobo Contest  YV_CARABOBO  Battle of Carabobo Contest 

Belgian Data Modes WW 
Contest  

BDMWWRTTY  Belgian Data Modes WW Contest 

Brazil Independance Day 
Contest   

BRAZ_IRTTY  Brazil Independance Day Contest 

Bucuresti Contest   BUCURESTI  Bucharest-HF-Contest 

CA HF   CAHF  CA HF 

Championship of Astrahan 
oblast   

R6U-CHAMP  Championship of Astrahan oblast 
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Contest Name and Website 
Link  

Log Type & 
Setup Link  

Remarks 

Comment   COMMENT  Comment 

CONCURSO NACIONAL 
FONIA   

EACNF  CONCURSO NACIONAL FONIA 

CQ Western Electric   CQWE_RTTY  CQ Western Electric Contest 

CSA-VHF   CSAVHF  CSA-VHF 

CUCALAMBE Contest   CUCALAMBE  CUCALAMBE Contest 

Deutschland Easter Contest  DC_EASTER  Deutschland Easter Contest 

DIG_PA Contest  DIG_PA  DIG_PA Contest 

DigiFest   VHF_DFRTTY  DigiFest 

DL_DTC   DL_DTC  
German Telegraphy Contest held 3rd 
October 

DNIEPER CUP   DNIEPERTTY  DNIEPER CUP 

Eesti LÃƒÆ’Ã‚Â¼hilaine 
KarikavÃƒÆ’Ã‚Âµistlused   

ES-LL-KV  
Eesti LÃƒÆ’Ã‚Â¼hilaine 
KarikavÃƒÆ’Ã‚Âµistlused 

EPC French DX Contest  EPCFR  EPC French DX Contest 

EPC Ukrainian DX   EPC-UKR-DX  EPC Ukrainian DX 

ES OPEN HF   ESOPENHF  ES OPEN HF 

EUCW Fraternizing Party   EUCWFP  EUCW Fraternizing Party 

EUCW ON5ME-160   EUCW160  EUCW ON5ME-160 

FGUP 2011   FGUP2011  FGUP 2011 

Finland Domestic Events   FINNDOM  Finnish Domestic Events 

Flight of the Bumblebees   FLTOTBBS  Flight of the Bumblebees 
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Contest Name and Website 
Link  

Log Type & 
Setup Link  

Remarks 

G3ZQS Memorial Contest  G3ZQSMEM  
Fists G3ZQS Memorial Contest - can 
be used for Fists Sprints 

GEDEBAGE DX Contest  GEDEBAGE  GEDEBAGE DX Contest 

GENERIC   GENERIC  GENERIC 

GENERIC2   GENERIC2  GENERIC2 

GENERIC RTTY   GENERRTTY  GENERIC RTTY contest 

HA3NS Memorial Contest   HA3NS  HA3NS Memorial Contest 

HA National Championship   HA_NChamp  HA National Championship 

International 2010   SWL  International 2010 

International Lighthouse Week 
2010   

ILLW-2010  International Lighthouse Week 2010 

IRTS80M   IRTS80M  IRTS80M 

IRTS CQIR   IRTSCQIR  IRTS CQIR 

JLRS Hina 33 Contest  HINA33RTTY  JLRS Hina 33 Contest 

JW-FD   JWFD  Jock White Memorial FD. 

Kanagawa   KANAGAWA  Kanagawa 

KCJ   KCJ  KCJ 

Keymens Club of Japan   KCJ_DX  Keymens Club of Japan 

Keymens Club of Japan   KCJ_JA  Keymens Club of Japan 

KT Serbian Cup   KTKUP  KT Serbian Cup 

Lighthouse Christmas Lights 
2010   

LCL-2010  Lighthouse Christmas Lights 2010 
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Contest Name and Website 
Link  

Log Type & 
Setup Link  

Remarks 

Lighthouse Spring Lites 2010 
 

LSL2010  Lighthouse Spring Lites 2010 

LY WAL Contest  LYWAL  LY WAL Contest 

Marconi Memorial Contest   MARCONIMEM  Marconi Memorial Contest 

Memory Lives Forever Contest

  
MEMORY  Memory Lives Forever Contest 

MOON CONTEST   MOONRTTY  MOON CONTEST 

Moscow-Championship   MA-CHAMP  Moscow-Championship 

MULAN WAP   MULANDXC  MULAN WAP 

North American QRP CW Club 
Sprints  

NAQCC  North American QRP CW Club Sprints 

NRL Cup   NRLC  NRL Cup 

NRRL TELEFONITEST   NRRLTELEFO  NRRL TELEFONITEST 

NZART   NZART  
NZART WW11 Memorial plus VHF and 
up. 

OBLAST   OBLAST  OBLAST 

OH-PARKS   OH-PARKS  OH-PARKS 

OKOM DX SSB Contest   OKOM DX SSB  OKOM DX SSB Contest 

Old New Year   OLDNEWYEAR  Old New Year 

Original QRP   OQRP  Original QRP 

OZ ACTIV Contest   OZACTIV  OZ ACTIV Contest 

OZCHR-VHF   OZCHRVHF  OZCHR-VHF 

PARLA   PARL  PARLA 
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Contest Name and Website 
Link  

Log Type & 
Setup Link  

Remarks 

PN QUICK CW Contest   PN_QUICKCW  PN QUICK CW Contest 

PODXS070 PSK 31 Flavors   FLAVORRTTY  Podxs070 PSK 31 Flavors 

PODXS 070 Contest   PODXS1RTTY  
Podxs 070 Contests: PSK FEST, JAY 
HUDAK Mem., PUMPKIN SPRINT, 
and Firecracker. 

PODXS 070 St. Patrick's Day 
Contest   

PODXS2RTTY  
Podxs 070 Contest: St. Patrick's Day 
Contest. 

PODXS Triple Play Low Band 
Sprint  

070TPRTTY  PODXS Triple Play Low Band Sprint 

PODXS Valentine Sprint 
Contest  

070VSRTTY  PODXS Valentine Sprint Contest 

Popov Memorial   POPOVMEMOR  Popov Memorial 

POPOV-VHF   POPOVVHF  POPOV-VHF 

PW 144 and 70Mhz   PW_144_70  PW 144 and 70Mhz 

QRP HF RTTY Contest   QRPHFRTTY  QRP HF RTTY Contest 

R3A Cup Digi Contest  R3A_CDRTTY  R3A Cup Digi Contest 

R3E-SC   R3E-SC  R3E-SC 

R4C Champ   R4CCHAMP  R4C Champ 

R4W (Udmurtia, Russia) Open 
Championship   

R4W-CHAMP  
R4W (Udmurtia, Russia) Open 
Championship 

R6H Champ   R6HCHAMP  R6H Champ 

RCWC 4 Seasons   RCWC4  RCWC 4 Seasons 

REGION-NR   REGION-NR  REGION-NR 

RSGB UKAC (VHF)   VHF_PAUL4  RSGB UKAC (VHF) 
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Contest Name and Website 
Link  

Log Type & 
Setup Link  

Remarks 

RSGB VHF Contests   VHFRSGB  
RSGB VHF Contests see 
VHF_RSGB_Read_Me.txt in 
VHFRSGB.zip 

RUSSIAN160   RUSSIAN160  RUSSIAN160 

SALMON-RUN   SALMON-RUN  SALMON-RUN 

SARA Spring Sprint   SARA  SARA Spring Sprint 

SARA Spring Sprint   SARA_OM  SARA Spring Sprint OM Stations. 

SCAG SPRINT   SCAG  SCAG SPRINT 

Seanet Contest   SEANETRTTY  Seanet Contest 

Several SARL Contests   SARL  
Several SARL Contests See Read_Me 
file in SARL.zip 

Silent Key Memorial Contest   SKMEM  Silent Key Memorial Contest 

SMIRK   SMIRK  SMIRK 

SP PGA Contest   PGATEST-DX  SP PGA Contest 

SP PGA Contest   PGATEST-SP  SP PGA Contest 

SPAR Winter FD   SPAR_FD  SPAR Winter FD 

SPEPC_RTTY Memorial 
Contest  

SPEPC_RTTY  SP WW EPC BPSK63 Contest 

SRR JR   SRRJR  SRR JR 

Suffixes XXIX National   EASUFF29  Suffixes XXIX National 

SV Triathlon Contest  TRIATHRTTY  SV Triathlon Contest 

TA VHF/UHF Contest  VHF_UHF_TA  TA VHF/UHF Contest 

TARA SKIRMISH   SKIRMRTTY  TARA SKIRMISH 
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Contest Name and Website 
Link  

Log Type & 
Setup Link  

Remarks 

TenTen QSO Party   TENTENRTTY  TenTen QSO Party 

Tesla HF Memorial Contest  TESLA_VHF  Tesla HF Memorial Contest 

Texas Parks On The Air  TX_PARKS  Texas Parks On The Air 

The Day of YLs   DOYLSRTTY  The Day of YLs 

UBA PSK63 Prefix Contest  UBAPSK63  
UBA PSK63 Prefix Contest 2nd 
Weekend in January 

UFT HF Contest   UFT-HF  
UFT HF Contest, First Weekend in 
December 

UK DXC BPSK63   UKDX63RTTY  
UK DXC BPSK63 2nd Weekend in 
January Replaced by UBA PSK63 

URAL CUP   URALCUP  URAL CUP 

USi W/VE Islands Qso Party   USI_QPRTTY  USi W/VE Islands Qso Party 

UT5EU-MEMORIAL-VHF   UT5EUVHF  UT5EU-MEMORIAL-VHF 

VHF GRIDS   VHFGRIDS  VHF GRIDS 

VHF-SPRING   VHFSPRING  VHF-SPRING 

VU Himalaya Contest  VU_HIMA_VU  Himalaya Contest 

VU International DX Contest  VU_DX_VU  VU International DX Contest 

VU Summer Contest  VUSUMMRTTY  VU Summer Contest 

Vytautas Magnus trophy   VMTROPHY  Vytautas Magnus trophy 

Worked All Britain Contest  WAB  Worked All Britain Contest 

Worked All China Provinces   BY_WAPC_BY  Worked All China Provinces 

Worked All China Provinces   BY_WAPC_DX  Worked All China Provinces 
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Contest Name and Website 
Link  

Log Type & 
Setup Link  

Remarks 

Worked all VKSHIRES  VKSHIRES  Worked all VKSHIRES 

World Lighthouse OTA   WLOTARTTY  World Lighthouse OTA 

WSEM minitest   WESM  WSEM minitest 

YACHAMP   YACHAMP  YACHAMP 

YL-OM   YLOM  YL-OM 

YO PSK31   YORTTY  YO PSK31 

ZOMBIE   ZOMBIE  ZOMBIE 

Contest Name and Website Link  
Log Type & 
Setup Link  

Remarks 

 

2.1.4.6.1 The User Defined Contest Editor 

in-edit  

XXX This page might fit better under "Setup User-Defined Contests" XXX  

Enabling users of a contest logger to define their own contests has always been a very 
difficult thing to do. With the proliferation of contests, often with (ahem) innovative rules, 
it has gotten harder in recent years. Normally, it requires someone with knowledge of 
the programming language to create a contest "module", and even then the rules may 
defy incorporation.  

In an effort to help with this problem, Nick, NA3M has written a very clever User Defined 
Contest (UDC) module in the Logger. This module uses a text file in a predefined 
format, called a User Defined Contest (.udc) file. These files may be created either with 
a text editor or with Nick's UDC Editor program, which can be downloaded from HERE

 .  

The description of how to use this editor program is found both here and in a Help file, 
also downloadable, which contains information in different languages selectable from 
the UDC File Editor. The Help file can be opened from the UDC File Editor by clicking 
its HELP button or by double-clicking a specific contest parameter line. Notepad will 
automatically start and display the Help file. Resize windows so you can see both the 
UDC Editor window and the Notepad window at the same time. Double-clicking on a 
parameter is particularly useful because Notepad then goes directly to that 
parameter in the Help file. The first time you call for help during an editing session, 
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you will be asked to select the language. This selection stays in memory until you close 
the editor. If the wrong language was selected, you will have to close and restart the 
UDC Editor.  

There are three ways that you can take advantage of the User Defined Contest feature: 
build your own UDC using the UDC Editor; use a text editor to build a UDC file, starting 
from a previous UDC file as a template; or download a UDC that was built by another 
ham and contributed to the Yahoo user group UDC file directory.  

Regardless of which method you use, the drop-down list of available contests in N1MM 
Logger+'s Contest Setup dialog will only list UDCs that have been copied to the 
UserDefinedContests folder in the N1MM Logger+ user files area at My 
Documents\N1MM Logger+\UserDefinedContests\.  

If you have developed and thoroughly tested a UDC file for a particular contest, please 
share it with other users by uploading it to the Files Section of the N1MMLoggerplus 
group on Yahoo. But please remember - UDC files are USER-defined, and bug fixes 
or feature improvements are the responsibility of the user who created the UDC, 
not the N1MM Development Team.  

× LimitationsWhile UDC files give a user extensive options for adapting N1MM Logger+ 
to the rules of many contests, they cannot provide the same control that a programmer 
has, or that may be required to fully implement them. For example, a contest defined 
with a UDC file can only give a fixed number of points per QSO. Many contests (WPX is 
a good example) are more complicated. Also, in many contests the rules are different 
for contestants from one area than for those from another - a good example is QSO 
parties with different rules for in-state and out of state participants. In those cases, it 
may make sense to create two UDC contests, for use by in-area and out-of-area 
contestants .  

1. List of User Defined Contests  
There are close to 200 User Defined Contests available for download from the website's 
Files Gallery. Select >Files >User Defined Contests, or click HERE   

2. The UDC Editor  
in-edit  

The UDC Editor is quite simple. When you open the Editor, you will first be asked to 
select a User Defined Contest file. You'll note that these files all have the extension 
".udc"), and are stored in the UserDefinedContests sub-folder in the N1MM Logger+ 
user files folder, at My Documents\N1MM Logger+\UserDefinedContests\.  
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When you open an existing contest file, you will be warned to do a "Save As..." unless 
you intend to edit the file you have opened. This is because any changes are saved 
immediately to the file you have opened. You have to be careful not to damage the 
existing User Defined Contest file that you are going to use as a starting point for your 
new contest file.  

Here is an example of a contest created by a user during testing, as viewed in the UDC 
Editor.  



 
 
 
 
To change a contest parameter, click once on it. You'll note that the parameter and its 
value appear in the gray pane to the right. Change the value in the Value field. Click on 
Set Value for Key to save it. This will save it in the file immediately. That is why the 
Editor does not have a Save button. When you are done editing a contest just exit, and 
your contest file will have all changes saved.  

Once the new (or modified) .udc file is ready to test, save it one last time into the My 
Documents\N1MM Logger+\UserDefinedContests\ folder and start N1MM Logger+. 
Go to File > New Contest in Database, and you should be able to see your new contest 
in the list of available contests. Test it to make sure everything works as you planned. If 
there is something wrong, you can edit the .udc file even while it is loaded in N1MM 
Logger+. To test any changes, just go to the Entry Window of N1MM Logger+, click on 
the File menu, and reload the contest from the drop-down list of recent contests.  



If you want to help with this project and add one more language - simply add your 
translation to an empty [Language...] section in the UDC help file and send the file to 
na3m@arrl.net, Please use UNICODE encoding when saving the file.  

3. Editing Tips  
 
The UDC Editor will not allow you to delete parameter names but you can erase or omit 
the value in the gray pane, in which case the default value will be used (these are 
marked with * in the list of values for each parameter). You should only use values 
mentioned below. At the moment, there is no check for correctness of the value 
supplied for a parameter. The wrong value may cause unpredictable N1MM Logger+ 
behavior, such as display of warning messages with the name of the wrong parameter.  

By default, the UDC editor does not show "empty" parameters, for which N1MM 
Logger+ will be using default values. You can see the full list of parameters by clicking 
on the "Show Default" check box, and edit them by assigning a non-default value. Do 
not attempt to remove "empty" parameters - they may be needed in case this file is later 
used as a template for another contest.  

Keep your .udc files in the My Documents\N1MM Logger+\UserDefinedContests 
folder. If you define a UDC and store it in the database, but subsequently remove its 
.udc file from the folder, then the next time you try to open that contest, a warning 
message will be displayed and the contest will not work.  

× Don't worry about messing upOne of the nice things about the UDC Editor is that you 
can't do much damage if you mess up. The only thing you are editing is the .udc file, 
and if it doesn't work and you can't fix it, you can always just delete it from the UDC 
folder and start over. 

4. Running a User Defined Contest  
 
User defined contests appear in the drop-down list of contests in the Select Contest 
dialog, just like those programmed at the factory.  

5. The UDC File  
 
Note: it is not recommended to use any language other than English for contest 
parameters. Take a look at the sample UDC files using a text editor, if you want to 
understand the file format, but we recommend you use the UDC Editor to edit or create 
a new file.  

5.1. File Format with Explanations  
This is the English-language text from the UDC Editor help file, describing how to 
configure a User Defined Contest for N1MM logger. Versions in Portuguese, Spanish, 
Russian can be found in the Help.txt file that is downloaded with every Latest Update.  

The most convenient way to use this information is to open the help.txt file from the 
UDC Editor, by pressing its HELP button or by double clicking on a contest parameter 
line. You will be asked to select a language. This selection stays in memory until you 
close the Editor. If a language is selected that is not there, you will have to restart the 



Editor. Assuming you choose one of the languages that is there, Notepad will 
automatically start and open the Help file.  

It's best to resize the Notepad window so you can see both the UDC Editor window and 
the Notepad window at the same time.  

To change a parameter in the UDC Editor, click once on it and change its value in the 
Value field. Click on Set Value for Key to save it. This will save it in the file immediately. 
That is why the UDC Editor does not have a Save button. When you are done editing, 
all you have to do is exit, and your contest file will have all your changes saved.  

Because of this, if you use an existing UDC file as a starting point for your new one, you 
will have to be careful not to damage it. Open it with the UDC Editor, and click the Save 
File As... button. Give your new contest file a name that positively identifies it (preferably 
its short name, like ARRLDXCW).  

Once the new (or modified) UDC file is ready, copy it into the N1MM 
Llogger/UserDefinedContests folder and start the Logger. You should be  
able to see your new contest in the list of contests in the Contest Setup Dialog.. Test it 
to make sure everything works as you planned. If there is something wrong - you can 
keep editing it even while it is loaded in the Logger. Once you make a change to a 
parameter of the UDC file simply reload the contest (select "File" and then your contest 
name in the drop down menu). Note: this will not work if you change the name of the 
contest while editing.  

If you decide to help with this project and add another language - simply add your 
translation to an empty section [Language..] and send the  
file to na3m@arrl.net so it can be included in the next update of this program. Note: Be 
sure to use UNICODE encoding when saving the file.  

The UDC Editor will not allow you to delete parameters, but you can set a parameter to 
"nothing". If you do this, the default value will be used marked with * in this file). You 
should only use values listed in this file. There is no check for correctness of the value 
in this Editor at the moment. A wrong value may cause unpredictable Logger behavior. 
Some wrong values may cause Logger to display warning messages with the name of 
the wrong parameter.  

By default, the UDC Editor does not show "empty" parameters. Logger will be using 
default values for them. You can see them by clicking on the "Show Default" check box. 
After that you will be able to edit them by assigning non-default values. Do not remove 
"empty" parameters - they may be needed in case this file is used as a template for 
another contest.  

Keep your .UDC files in the My Documents\N1MM Logger+\UserDefinedContests 
folder if you are planning to use contests defined by those files. If you try to load some 
previously used (and stored in the current database) User Defined Contest and the .udc 
file for it is not in the folder, Logger will not start the contest, and there will be a warning 
message displayed.  



To start the UDC Editor by clicking on a .udc file, right-click on one of them, select 
"Open with", "Choose program" and select "UDCeditor.exe" as the "Recommended 
Program" for this type of files.  

[Author] section  

/AuthorName/ =  
Put your name here. Users should know who will  
be able to help them with this contest file.  

/Callsign/=  
your callsign  

/Email/=  
your email  

[File] section  

/Revision/ =  
Start with 1.0.0 It is recommended that you increment it every time you modify the UDC 
file.  

/LastUpdate/ =  
Will be automatically filled with the current date if you create a new file (using Save File 
As...) or edit the current file.  

/Description/ =  
Short description of the contest type (one line). Example: "Finnish Domestic VHF 
Contest"  

[Contest] section  

/Name/ =  
This is the short name that will be used in the Contest Setup dialog. 10 Characters 
maximum, no spaces. Example: ARRLDXCW. RTTY contests must have RTTY 
somewhere in the name; VHF contest names must start with VHF.  

/DisplayName/ =  
Your choices, spaces allowed Example: ARRL DX CW  

/CabrilloName/ =  
Your choice, 15 characters maximum, no spaces. Example: ARRL- DX-CW This name 
will be used in the  
Cabrillo file header  

/Mode/ =  
Valid modes are: CW* SSB BOTH RTTY  

/DupeType/ =  
1 = All bands (stations may be worked only once in the contest)  
2* = Each band (common)  
3 = Each band & mode (stations may be worked on each band/mode combination (e.g. 



40 SSB, 40 CW, 40 RTTY))  
4 = no check)  

Also used in the Multiplier window to show modes (when 2 or 3) in the Section window.  

/Multiplier1Name/ =  
See list below  

/Multiplier2Name/ =  
See list below (mostly N/A if the contest recognizes only one multiplier type)  

/Multiplier3Name/ =  
See list below (mostly N/A if the contest recognizes only one multiplier type)  

Name Comment 

CountryPrefix 
Each country is a multiplier Example: DL, PA etc (uses 
WL_CTY.DAT) 

WPXPrefix Each prefix is a multiplier 

Sect 

Each Section is a multiplier Need a *.sec file loaded with button 
"Import Section File" in the Contest Setup dialog. The 
MultWindowType below should match the name of .sec file 

ZN Each CQ Zone is a multiplier (max. 40) 

MiscText Each misc. Text is a multiplier 

 
/Period/ =  
How many days is the contest (not used at  
the moment). Options are 1 or 2  

/PointsPerContact/ =  
Default 1*. May be any integer.  
You can put several parameters in one line. Separate each with a comma: For example 
OH, 5, SM, 5, MyCountry, 1, SameContinent, 2, OtherContinent, 3 (will award 5 points 
for QSOs with OH or SM, 1 point for contacts in your own country, etc.(NOTE: country 
prefixes should match those that are in wl_cty.dat file and be the first in line if used)  
Another example: SSB, 2, CW, 3, DIGI, 4, RTTY, 4, PSK, 5, FM, 2  
(2 points for SSB, 3 points for CW, 4 for RTTY and so on)  
And yet another: 160m, 5, 80m, 4, 40m, 3( 5 points for QSO on 160m and so on). In this 
type of entry, the allowed bands are 160ÃƒÂ•Ã‚Â¼, 80ÃƒÂ�Ã‚Â¼, 40ÃƒÂ�Ã‚Â¼, 
20ÃƒÂ�Ã‚Â¼, 15ÃƒÂ�Ã‚Â¼, 10ÃƒÂ�Ã‚Â¼, 6ÃƒÂ�Ã‚Â¼, 4ÃƒÂ�Ã‚Â¼, 2ÃƒÂ�Ã‚Â¼, 
1.25ÃƒÂ�Ã‚Â¼, 70cm, 33cm, 23cm, 13cm, 9cm. The values for this parameter can be 
mixed, but if the QSO meets two or more criteria (for example, 160m and OH), then 
priority order will be: band, mode, continent, country.  
IsMisc, 3,  
IsComment, 4 -  
give some point if there is any value in MiscText or Comment  
NOTE: for VHF contests the numeric value will be used as the multiplier, i.e. 



KM*multiplier. ! Exchange, * - use numeric value  
entered in Exchange as Points (do not replace *, just use "Exchange, *")  

/ShowMyCountryStations/ =  
True* Yes show My Country stations in the bandmap (normal)  
False No don't show them in the bandmap  

/ShowWarcBands/ =  
True Yes show the WARC bands (only for general logging (DX)  
False* No don't show them (all contests)  

/ZoneType/ =  
CQ* CQ type zones should be shown (for most contests)  
IARU IARU zones should be shown  

/MultWindowType/ =  
State US states  
StateProvince US states and Canadian Provinces are both valid entries  
Province Canadian Provinces (or 13P)  
Section* ARRL sections (or 48S14P, 48SDC14P, 49S8P, 50S8P, 50S10P, 50S13P, 
50S13PCY0, 50S14P, 50SDC14P, 50SDC10P, 71SEC13WB, 50SDC13P, 50S13RAC, 
50S9P, 50S11P, 50SNOLAB)  
Provincie Netherlands Provinces (for PACC Contest)  
DOK DOK letters letters: A to Z except Q, for WAG contest  
UBA ON contest  
Oblast Russian oblasts  
AnyName Prepare AnyName.sec file with the list of sections (look at any *.sec for 
sample). NOTE: This filename should not be longer than 9 characters!  

/CQZoneMultContest/ =  
True Contest uses CQ zones as a second multiplier e.g. CQWW  
False* It doesn't! (Mostly)  

/NumMults/ =  
0 for Field Day or other contests with no multiplier  
1* for most contests  
2 for CQWW (i.e. Country and Zone)  

/BonusPoints/ =  
Several bonus callsigns, DXCC entities, /P, /M or /QRP stations are allowed, use 
comma to separate bonus call from bonus points. Leave empty  
if no bonus station(s) or countries.  
Example: RM1DZ, 20, RA1DZ, 20, DL, 25, /M, 4, /P, 2, /QRP, 5  

/BonusPoints2/ = points, filename  
This allows using a file with a number of Callsigns that give bonus points.  
Parameter format: BonusPoints2 = 5, BonusPoints.txt (points, file name).  

Filename can be any name with the extension *.txt but the file must be in the main 
Logger program folder. Every callsign in the file should have a comma at the end, 
including the last one:  



<file starts>Call1, Call2, Call3, ..., LastCall,<file ends>  

or  

<file starts> Call1, Call2, Call3, ... LastCall, <file ends>  

BonusPoints2 extends BonusPoints but has higher priority. In other words, if the callsign 
is found in the BonusPoints string and also in the file  
BonusPoints.txt, then the bonus point assigned for BonuPoints2 will be used.  

/MultSqlString/ =  
1 MultSqlString = Country (new country will be counted as multiplier)  
2 MultSqlString = Section (new section will be counted as multiplier)  
3 MultSqlString = WPXPrefix (new WPXPrefix will be counted as multiplier)  
4 MultSqlString = N/A* (no multipliers)  
5 MultSqlString = Grid (new 4-character GridSquare will be counted as multiplier)  
6 MultSqlString = CallSign (new CallSign will be counted as multiplier). NOTE - uses 
NameText.  
7 MultSqlString = SGrid (new 6-character GridSquare will be counted as multiplier)  
8 MultSqlString = FirstQSO (first QSO on every band (mode) will be counted as 
multiplier)  

/MultSqlString2/ =  
Country (, Band)  
Section (, Band)  
N/A* i.e., no multipliers. See details above.  

/MultSqlString3/ =  
Country (, Band)  
Section (, Band)  
N/A* i.e. no multipliers. See details above.  

/DoNotCountMeAsMult/ =  
True Do not count Multiplier1 for my Country, Section or WPX prefix (depends on what 
was set as MultSqlString)  
False* Count Multiplier1 for my Country, Section or WPX prefix.  

/DoNotCountMeAsMult2/=  
True Do not count Multiplier2 for my Country, Section or WPX prefix (depends on what 
was set as MultSqlString2)  
False* Count Multiplier2 for my Country, Section or WPX prefix.  

/DoNotCountMeAsMult3/=  
True Do not count Multiplier3 for my Country, Section or WPX prefix (depends on what 
was set as MultSqlString3)  
False* Count Multiplier3 for my Country, Section or WPX prefix.  

/CountMultOnlyFor/ =  
Default value is empty. Set it to one or several countries from the wl_cty.dat file to make 
the multiplier work for those countries only.  
Example: CountMultOnlyFor =G, GW, GM, GI, GD, GU, GJ. Do not use too many 



countries here - it may stop working if the line is too  
long and also will slow down the computer .  

/CountMultOnlyFor2/ =  
Same as for /CountMultOnlyFor/ but will be applied for Multiplier2  

/CountMultOnlyFor3/ =  
Same as for /CountMultOnlyFor/ but will be applied for Multiplier3  

/CountMultOnlyForSec/ =  
Default value is empty. Set it to one or several sections from the .sec file to make the 
multiplier work for those sections only. Example: CountMultOnlyForSec = MA, MO. Do 
not use too many sections here - it may stop working if the line is too long and also will  
slow down the computer.  

/CountMultOnlyForSec2/ =  
Same as for /CountMultOnlyForSec/ but will be applied for Multiplier2  

/CountMultOnlyForSec3/ =  
Same as for /CountMultOnlyForSec/ but will be applied for Multiplier3  

/QsoErrorString/ =  
The exchange field will be checked according to this setting before logging QSO  
Numeric - only numbers allowed (like serial number) 12 characters max  
Any - both numbers and letters allowed (12 characters max) but some value is required.  
Grid - Grid Square Text, 4 or 6 characters  
If none of the above, put in some text ("Sect" for example), only exchange listed in .sec 
file will be excepted !  
Empty* If empty, then do not check (anything including empty field will be accepted, 12 
characters max)  

/LogInfo/ = SentReport, 500, SentNR, 500, ReceiveReport, 500, NR, 500, Points, 500 
SentReport, SentNR, ReceiveReport, NR, IsMultiplier1, IsMultiplier2, CountryPrefix, 
GridSquare, Exchange1, MiscText, Points, opname,  

Comment adjust the field names and spacing for the log window by adding/deleting 
relevant name and spacing (only names in the example  
are allowed)  

/FrameText/ = SntRpt SntNR RcvRpt NR  
These are the names displayed on top of each field of Entry Window, except for the 
callsign. Adjust the field names and spacing for the frame text by adding/deleting 
spaces in this line. Any names allowed.  

/EntryWindowInfo/ = SNTText, 500, SntNrText, 700, RCVText, 500, Exchange1Text, 
500 SNTText, SntNrText, RCVText, RcvNrText,  
GridSquareText, Exchange1Text, CommentText, NameText  
Adjust the field names and spacing for the main window by adding/deleting relevant 
name and spacing (only names in the line above are allowed)  



The following table shows possible EntryWindow Items, followed by the width normally 
used.  

Name Width 
Max. 
Length 

Comment 

SNT Text 450 10 Sent exchange field 

RCV Text 450 15 
Received exchange field (default 59 or 
599) 

NameText 855 20 Name field, only letters allowed 

CommentText 1695 60 
Comment field, space character allowed 
so space as tab does not work here 

SntNrTxt 625 5 
Sent following number field, auto-
numbered by the program 

RcvNrTxt 625 5 
Received following number field, only 
numbers allowed 

Exchange1Text 615 12 
Exchange field, numbers and letters 
allowed 

GridSquareText 600 6 Textbox for Grid Square 

MiscText 600 15 Miscellaneous textbox 

 
/DefaultContestExchange/ =  
001* this will show up in the contest selection window for editing. It may have two or 
three parts like this: "001 Prov", "001 NA123". If the first part is 001 the logger will 
generate a serial number for every QSO and the second part will be sent by F2 with the 
number unchanged  

/CabrilloFormat/ =  
1*= standard (use 0 if Cabrillo is not supported)  
2 = NAQP format  
3 = NASPRINT format  
4 = SS (Sweepstakes)  
5 = RFC (Russian Federation Cup)  
99 = handcoded, uses CabrilloString (see below)  

/CabrilloString/ =  
SNT, 4, SentNr, 4, CallSign, 13, RCV, 4, RcvNr, 4, Comment, 40  
Format: value1 name, value1 width, value2 name, value2 width, ... Will work with: SNT, 
SentNr, CallSign, RCV, RcvNr, Comment, GridSquare, Exchange1, Name, SentExch, 
SentExchPart1, SentExchPart2, SentExchPart3  

To add some number of spaces use Space, N (N - number of spaces)  

/IsWorkable/ =  
ExceptMyCountry  
Any*  



MyContinentOnly  
MyCountryOnly,ExceptMyCountry  
list of countries (prefixes from wl_cty.dat file) separated by comma: UA2, UA, UA9.  
In the last case make sure you are using correct prefixes  

/SpecialInstructions/ =  
Special Instructions. Any text terminated by CR/LF This message will show up after 
Cabrillo file was generated - use  
it for a note to the operator. Leave it empty if not needed.  

/DupeSqlString/ =  
Select clause that will uniquely identify a dupe:  
0*- turns it off,  
1 - use Section,  
2 - use whatever is in ExchangeText,  
3- use mode (this will allow QSO with same station but different modes  
(CW, SSB, FM, AM)  
4- use GridSquare; This is needed for qso parties where you can have mobile stations 
in different counties.  

/StartOfContest/ =  
Example 7, 1.5 First number - day of week (Saturday=1, Sunday=2, Monday=3,....., 
Saturday=7) Second number - offset in hours  
(1.5 = 1 hour and 30 minutes) relative to GMT time, i.e. if it starts at 00.00 GMT the 
offset should be 0. This will be used to calculate OFF  
times.  

/EndOfContest/ = 1, 1.5 Same format as for StartOfContest. This will be used to 
calculate OFF times  

/IsMultPer/ =  
0* NoMults  
1 OncePerBand  
2 OncePermMode  
3 OncePerBandAndMode  
4 OncePerContest  

/MinimumOffTime/ =  
30* Min. Off time in minutes  

/UsesWAECountries/ =  
False* Answer whether this contest uses the WAE countries list (countries with '*' in 
cty.dat). For example, for CQWW it should be True  

/SetSentTimeForContact/ =  
False* Used to set Sent Time in contests that require it. See CBARGT for use  

/ScoreSummaryMultNames/ =  
Sec  
Cty  
Grd Used to set title of Mult column in Score Summary  



/WebAddress/ = http://www.srr.ru/CONTEST/cup_raem_engl_08.php (example)  
Web address for the contest rules  

/GenericPrintString/ = SNT, 4, SentNr, 0, CallSign, 15, RCV, 4, RcvNr, 0, Comment, 12 
Format: value1 name, value1 width, value2 name, value2  
width, ... Will work with: SNT, SentNr, CallSign, RCV, RcvNr, Comment, GridSquare, 
Exchange1, Name, Points, SentExch, SentExchPart1,  
SentExchPart2, SentExchPart3, Multiplier1, Multiplier2, Multiplier3. This will configure 
Generic file output that can be used instead of Cabrillo.  

/GenericPrintStringHeader/ = Date Time Freq Mode MyCall RST Snt Call RST Rcvd 
Comment  
Adjust the names and number of spaces here according to the values in 
GenericPrintString (above)  

/MultiplierBands/ =  
1* All HF Contest Bands  
2 All HF Bands  
3 All HF Contest Bands plus 6 meters and 2 meters  
4 All VHF Bands  

/QsoNumbersByBand/ =  
0* Use a single sequence of QSO numbers (common)  
1 QSO Numbers by Band for all categories  
2 = QSO Numbers by Band for Multi-Multi category only  

/DigitalModeSqlString/ = False* Used to merge RTTY and PSK into one digital contest 
mode  

/MultipleSessions/ =  

 Leave it empty if the contest time is not broken into sessions  

Examples: 0000/30 - starting at 00:00 UTC, sessions = 30 minutes 0000/60 - starting at 
00:00 UTC, sessions = 60 minutes 0000/200 - starting at 00:00 UTC, sessions = 2.00 
hours It is OK to use 0000 for contest start time if it starts in the beginning of any other 
hour and sessions are < or = 60 minutes. Dupes will be allowed when new session 
starts. Dupes will be allowed when new session starts and the Multiplier window will be 
cleared upon first contact in the new session.  

/ResetMultsEverySession/ = 0*  
When MultipleSessions is used, this parameter will allow multipliers to be reset in the 
beginning of every new time  
session, if set to 1.  

/CabrilloVersion/ = 2.0*  
When set to 3.0 the log file will be saved using version 3.0 of Cabrillo format. Also new 
fields will show up in the contest configuration window. Any other value or if left empty 
will turn on Cabrillo version 2.0  

/MultMult/ = 1*  



/MultMult2/ = 1*  

/MultMult3/ = 1*  

When any of these 3 values is changed to 0, the multiplier will not be used for dcore 
calculation. This is useful when you need to use multipliers for display purposes only 
(Band Maps and Available windows).  

 
 

 

2.1.4.7 My Contest Isn't Here. What Can I Do? 

 
If the contest is not currently supported by the program there are four options:  

 Use the 'User Defined Contest' capability to create a new contest template.  
o This capability is under continuous development and may undergo further 

change. See the User Defined Contest Editor section.  
 Find another contest with a similar exchange and similar rules. If the only 

difference is in the scoring, you can run the contest and create the Cabrillo file, 
then edit the Cabrillo file to change the contest name. You can either score the 
contest manually after the contest, or enter a claimed score of zero and let the 
contest sponsor calculate the multipliers and points  

 Use a 'general' contest like DXSERIAL, DX, etc. Run the contest and do the log 
creation after the contest using Notepad or a similar text editor. When Cabrillo is 
the requested log format, create the Cabrillo log and update the header. The 
contest sponsor will calculate the multipliers and points. This is the easy way to 
go for many small, mostly local, contests  

 Request that the contest become one of the supported contests  
o Whenever someone requests support for a particular contest, it would be 

good to have an indication of the number of entries the contest received 
during the previous year's running. This is not to suggest that there is a 
threshold below which contests will not be supported, but that knowing this 
is helpful in prioritizing for the people who do the work. In the past we 
have had requests to support contests that had fewer than 10 entries the 
previous year  

o Since the programmers do not have unlimited time to respond to last-
minute requests, set yourself a target date (for example, a minimum of 
three months prior to the next running of the contest) to allow time for 
programming and proper testing  

o It is part of the nature of the N1MM Logger+ project that users, and 
particularly those users requesting support for a particular contest, are the 
people who are relied upon to test and be sure the contest module does 
what it is supposed to do. It is particularly important to test far enough in 
advance of the running of a contest so that any problems can be identified 

http://n1mmplus.hamdocs.com/tiki-index.php?page=The+User+Defined+Contest+Editor&structure=N1MM+Logger+Documentation


and fixed. Users will do well to check each contest as it is coming up, to 
make sure that any rule changes are reported to the programmers in time 
for changes to be made.  

 
If you identify bugs or propose contest-specific features during the running of a 
contest, don't expect an immediate response. Contest-specific things are on a calendar 
to be addressed before the next running. Of course, defects in Cabrillo output are an 
exception, since they need to be fixed in time for score submission and can be done in 
the weeks after the contest.  

 

2.1.5 Contest Setup Instructions 

 1 Setup General Contest Logging - All Modes 

 2 Setup HF Contests - CW and SSB 

 3 Setup QSO Parties - CW and SSB 

 4 Setup VHF Contests - CW and SSB 

 5 Setup RTTY and PSK Contests 

 6 Setup User Defined Contests 

 

2.1.5.1 Setup General Contest Logging 

 2.1.4 Supported Contests  
 2.1.4.1 General Contest Logging (all modes)  
 2.1.4.2 Supported HF Contests - CW and SSB  
 2.1.4.3 QSO Parties (CW/SSB)  

o 1. United States  
o 2. Canada  
o 3. Other QSO Parties  

 2.1.4.4 Supported VHF CW and SSB Contests  
 2.1.4.5 Supported RTTY/PSK Contests  
 2.1.4.6 Supported User Defined Contests  
 2.1.4.6.1 The User Defined Contest Editor  

 1. List of User Defined Contests  
 2. The UDC Editor  
 3. Editing Tips  
 4. Running a User Defined Contest  
 5. The UDC File  

 5.1. File Format with Explanations  

 2.1.4.7 My Contest Isn't Here. What Can I Do?  

http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+General+Contest+Logging+-+All+Modes&structure=N1MM+Logger+Documentation
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+HF+Contests+-+CW+and+SSB&structure=N1MM+Logger+Documentation
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+QSO+Parties+-+CW+and+SSB&structure=N1MM+Logger+Documentation
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 2.1.5 Contest Setup Instructions  
 2.1.5.1 Setup General Contest Logging  

o 1. General Information  
o 2. Generic Contest Types  

 2.1. DX Log  
 2.2. DXpedition  
 2.3. DX Serial  
 2.4. DX Satellite  
 2.5. VHF DX  
 2.6. VHF Serial  

o 3. Deleted QSOs  

1. General Information 

When a contest has a specific mode (SSB, CW or RTTY) then the Mode Category is 
automatically changed to that mode. So when you select CQWWSSB for the CQ World 
Wide SSB contest the Mode Category will be set by the program to SSB. You can 
change this but that will give wrong Cabrillo output and maybe even erroneous behavior 
of the program, so don't!!  
If the selected contest doesn't have a specific mode the program will set the Mode 
Category to MIXED.  
If the radio is interfaced, its mode will be changed. The frequency is not changed; it is 
up to the user to ensure that the radio is tuned to the correct part of the band.  

This is a contest program, but for general logging you can use DX as the selected 
contest. Dupes are allowed and an exchange is not necessary.  
To import a contest into your regular logging program use ADIF export (and ADIF import 
in your general logging program).  

When going through the possible contests you will see a "contest" DELETEDQS.  
This is not actually a contest. QSOs deleted from other contests will be put in here by 
the program. This is especially important for multi-user support.  

The maximum received serial number is 99999 (for serial number contests). Check out 
info about the serial number server in the Contest Setup Dialog chapter .  

 Read the Contest Instructions!Always read the instructions from the contest committee 
prior to the contest. Then you know how to set up the program, what exchange to give 
and what to expect in return, which hours to operate etc. 

2. Generic Contest Types 

 
 

2.1. DX Log 

Window: Select Log type  

 Log Type: DX  

http://n1mmplus.hamdocs.com/tiki-index.php?page=The+Contest+Setup+Dialog


 Mode Category: MIXED if you want to log both SSB and CW contacts, 
MIXED+DIG to add digital modes as well  

For general or DX logging.  

 Entered QSOs in General log (or DX log) don't need to have an exchange  
 Dupes are shown by the word Dupe! but the qso can be logged  

 
 

2.2. DXpedition 

Window: Select Log type  

 Log Type: DXPEDITION  
 Mode Category: MIXED if you want to log both SSB and CW contacts, 

MIXED+DIG to add digital modes as well  

For DXpedition logging  

 Entered QSOs in the DXPEDITION log don't need to have an exchange  
 Dupes are shown by the word Dupe! but the QSO can be logged  

 Working with split VFOs on a DXpedition - Rx on VFOa, Tx on VFObMost DXpedition 
operators will leave VFOb on a stationary transmit frequency while tuning the pile-up 
with VFOa in receive. For optimal results in N1MM+ perform the following three actions: 
Set >Config >Hardware for SO2V (Single Op 2 VFO) operation. Place the program and 
the radio in Split mode by typing ctrl+S. Disable Run/S&P auto-toggle by pressing 
alt+F11.  

 
 

2.3. DX Serial 

Window: Select Log type  

 Log Type: DXSERIAL  
 Mode Category: MIXED if you want to log both SSB and CW contacts, 

MIXED+DIG to add digital modes as well  

For general Serial Number contest logging  

 Entered QSOs in DXSERIAL don't need to have an comment  
 Dupes are shown by the word Dupe! but the QSO can be logged  
 'Standard' points calculation; 1 point per qso, DXCC countries are counted  

o All other kind of multiplier and point calculations have to be done by hand  
o This for all not supported serial number contests  



 
 

2.4. DX Satellite 

Window: Select Log type  

 Log Type: DXSATELLIT  
 Mode Category: MIXED if you want to log both SSB and CW contacts, 

MIXED+DIG to add digital modes as well  

For Satellite logging.  

 Entered QSOs in the DXSATELLIT log don't have an exchange and don't need to 
have a grid  

 When a grid is entered it needs to be 4 or 6 characters long  
 Dupes are shown by the word Dupe! but the QSO can be logged  

 
 

2.5. VHF DX 

Window: Select Log type  

 Log Type: VHFDX  
 Mode Category: MIXED if you want to log both SSB and CW contacts, 

MIXED+DIG to add digital modes as well  

For VHF and up logging.  

 Entered QSOs in VHFDX don't need to have a grid  
 When a grid is entered it needs to be 4 or 6 characters long  
 Dupes are shown by the word Dupe! but the qso can be logged  
 Bearing info is shown in the log window and saved in the Misc field  
 Distance info is shown in km in the log window and saved in the Points field  

 
 

2.6. VHF Serial 

Window: Select Log type  

 Log Type: VHFSERIAL  
 Mode Category: MIXED if you want to log both SSB and CW contacts, 

MIXED+DIG to add digital modes as well  

 
Comments need to be added using Ctrl+N. There is no room left in the Entry Window to 



add a separate field. Comments will be shown in the log window and added to the 
Cabrillo and generic output reports  

For VHF and up logging  

 Entered QSOs in VHFSERIAL don't need to have a grid  
 When a grid is entered it needs to be 4 or 6 characters long  
 Dupes are shown by the word Dupe! but the QSO can be logged  
 Bearing info is shown in the log window and saved in the Misc field  
 Distance info is shown in km in the log window and saved in the Points field  

 
 

3. Deleted QSOs 

DELETEDQS "contest"  

QSOs which are deleted from other logs using 'Edit Contact' are moved to this 'contest'.  
This is especially important for multi-user support. The moved QSOs can be exported.  

 

2.1.5.2 Setup HF Contests - CW and SSB 

in-edit  

 2.1.5.2 Setup HF Contests - CW and SSB  

o 1. 9A CW contest  
o 2. AGCW  
o 3. All Asian CW / SSB  
o 4. Asia Pacific Sprint CW / SSB  
o 5. Asiatic Russia Championship  
o 6. ARCI QRP Contests & Michigan QRP Contest  
o 7. ARI International DX Contest  
o 8. ARRL 10 Meter contest  
o 9. ARRL 160 Meter contest  
o 10. ARRL Field Day contest  
o 11. ARRL International DX contest CW / SSB  
o 12. ARRL November Sweepstakes CW / SSB  

 1. Entering Received Exchanges  
 2. Correcting what you copied  

o 13. ARRL Rookie Roundup  
o 14. Asia Pacific Sprint Contest CW / SSB  
o 15. Baltic contest  
o 16. Black Sea Cup International  
o 17. CNCW Spanish contest  
o 18. CQ M International DX contest  



o 19. CQSA SSB Contest  
o 20. CQ 160 Meter DX contest CW / SSB  
o 21. CQ World Wide DX contest CW / SSB  
o 22. CQ World Wide WPX contest CW / SSB  
o 23. CIS contest - CW / SSB  
o 24. Cup of the Russian federation RFC contest CW / SSB  
o 25. CWops Mini CWT  
o 26. CWops CW Open  
o 27. DARC 10 meter contest  
o 28. DARC Weihnachtswettbewerb XMAS contest  
o 29. DIG contest CW / Phone  
o 30. Elecraft QSO Party  
o 31. European Sprint CW/ SSB  
o 32. EU HF Championship  
o 33. Field Day Region 1  
o 34. First Class Operators Club (FOC) Marathon - members only  
o 35. First Class Operators Club (FOC) QSO Party  
o 36. GACW WWSA CW DX contest  
o 37. Gagarin Cup  
o 38. HA DX Contest  
o 39. Helvetia Contest  
o 40. High Speed CW Contest  
o 41. Holyland Contest  
o 42. IARU Radiosporting contest HF  
o 43. IOTA Islands On The Air Contest  
o 44. International Naval Contest  
o 45. JA domestic contests  
o 46. JIDX contest  
o 47. JT DX Contest  
o 48. King of Spain Contest  
o 49. Logbook of the World Contest CW / SSB  
o 50. LZ DX Contest  
o 51. LZ Open and LZ Sprint Contests  
o 52. Manchester Mineira Contest  
o 53. Michigan QRP Contest  
o 54. MiniTest CW Test  
o 55. NA Sprint CW / SSB  
o 56. SprintNS and Sprint Ladder  
o 57. NAQP North American QSO Parties CW / SSB  
o 58. NRAU Baltic Contest  
o 59. Oceania Contest  
o 60. OK OM DX contest  
o 61. PA beker contest  
o 62. PACC contest  
o 63. Portugal Day Contest  
o 64. QCWA QSO Party  



o 65. RAC Canada Day Contest / RAC Canada Winter Contest  
o 66. RAEM CW contest  
o 67. REF contest CW / SSB  
o 68. RF Championship  
o 69. RSGB 160 Meter CW Contests  
o 70. RSGB 21/28 MHz contest  
o 71. RSGB 80 Meter Club Championship  
o 72. RSGB Affiliated Societies Team Contests AFS  
o 73. RSGB Club Calls contest  
o 74. RSGB Commonwealth contest  
o 75. RSGB SSB Field Day & RSGB National Field Day  
o 76. RSGB Low Power Field Day  
o 77. RSGB ROPOCO  
o 78. Russian District Award contest  
o 79. Russian DX contest  
o 80. Russian Radiosport Team Championship  
o 81. Russian YL/OM contest  
o 82. SAC contest CW / SSB  
o 83. Spanish Towns contest  
o 84. SPDX contest  
o 85. Stew Perry Topband Distance Challenge  
o 86. Scandinavian Young Ladies Radio Association SYLRA  
o 87. UA1DZ Memorial Cup  
o 88. UBA contest CW / SSB  
o 89. UBA ON contest  
o 90. UBA Spring  
o 91. UBA Low Band Winter  
o 92. Ukrainian Championship  
o 93. Ukrainian DX contest  
o 94. UN DX Contest  
o 95. Independence of Venezuela Contest  
o 96. WAEDC contest CW / SSB  

 96.1. Introduction to WAE DX CW/SSB - based on an article 
originally written by Franki, ON5ZO  

 96.2. WAE from Europe (ON5ZO as an example)  
 96.3. WAE from the DX (non-Europe) side  
 96.4. Both sides  

o 97. WAG contest  
o 98. World Wide Iron Ham Contest  
o 99. World Wide Peace Messenger Contest  
o 100. WRTC contest  
o 101. YO HF DX contest  

1. 9A CW contest 

The 9A (Croatian) CW contest is a CW only contest.  



 Window: Select Log type  
o Log Type: 9ACW  
o Mode Category: CW  
o Sent Exchange: 001  

 
 

2. AGCW 

CW-only, on New Year's Day  

 Window: Select Log Type  
o Log Type: AGCW  
o Mode Category:CW  
o Sent Exchange: RST + Serial Nr + AGCW Member Nr.  

 
 

3. All Asian CW / SSB 

The All Asian contest can be used by Asian stations and DX stations.  

 Window: Select Log type  
o CW  

 Log Type: ALLASIACW  
 Sent Exchange:Your age Example: 34  

 XYL and YL stations may give 00  
o SSB  

 Log Type: ALLASIASSB  
 Sent Exchange:Your age Example: 34  

 XYL and YL stations may give 00  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are an Asian station or a non-Asian station.  
 

4. Asia Pacific Sprint CW / SSB 

The Asia-Pacific Sprint contest can be used by Asia-Pacific stations and DX stations.  

 Window: Select Log type  
o CW  

 Log Type: APSCW  
 Sent Exchange:001  

o SSB  
 Log Type: APSSSB  



 Sent Exchange:001  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are an Asia-Pacific station or a DX station.  

5. Asiatic Russia Championship 

 For Asiatic Russian stations only.  
 Exchange consists of 2-digit location (lat/long rounded up to nearest 10 degrees 

e.g. 59N 81E > 69) plus serial number  
o Use 001 for Sent Exchange, incorporate location in F2 message e.g. "69 

{EXCH}"  

 
 

6. ARCI QRP Contests & Michigan QRP Contest 

The ARCI contest supports 7 ARCI QRP Contests. The Michigan QRP Contest has 
almost the same rules. Several other QRP contests use the same exchange type, 
although the scoring may be different.  

 Window: Select Log type  
o Log Type: ARCI  
o Mode Category:  

 CW  
 for Spring QSO party ; HootOwl Sprint ; Summer Homebrew 

Sprint ; Fall Qso Party ; Holiday Spirits ; Michigan QRP 
Contest  

 SSB  
 for Winter Fireside  

 MIXED  
 for Topband Sprint  

o Sent Exchange:  
 First Part  

 State abbreviation for USA stations. Example: CT  
 Province abbreviation for VE stations. Example: ONT  
 Country abbreviation for non US or VE stations. Example: 

DL  
 Second Part  

 ARCI number for ARCI members  
 Sent power for non-ARCI members  

 Log Window: Mult = DXCC Mult2 = Section (State or Province) Example: CT  
 Power is recognized by containing a non numeric character. Example: 100W is 

power, 100 is a member number  



 There is a check on provinces and states, no check on countries. The program 
will give a proposal for the country prefix if non VE or K  

 No calculations made for power multi or Bonus Points, this has to be done by the 
operator after the contest on the summary sheets  

 Select CW, SSB or MIXED as 'mode Category 'to have the multiplier window 
work correctly  

 The program allows stations to work each other in the contests in both modes, 
even when only CW or SSB is allowed according the rules. We assume the 
operator knows the rules and follows them...  

 
 

7. ARI International DX Contest 

The ARI International DX contest can be configured for Italian stations and DX stations.  

 Window: Select Log type  
o Log Type: ARIDX  
o Sent Exchange:  

 001 for non-Italian stations  
 Your Province for Italian stations  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are an Italian station or a DX station.  

8. ARRL 10 Meter contest 

The ARRL 10M contest can be used by K/VE stations and DX stations.  

 Window: Select Log type  
o Log Type: ARRL10M  
o Sent Exchange:  

 Your state/province - for K/VE stations Example: NY  
 001 - for DX stations (non K/VE)  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a DX station or a W, KH6, KL7, VE station.  

All non-28 MHz spots are marked as unworkable.  

9. ARRL 160 Meter contest 

The ARRL 160M contest can be used by K/VE stations and DX stations.  

 Window: Select Log type  
o Log Type: ARRL160 (not ARRL160M if shown)  
o Mode Category: CW  



o Sent Exchange:  
 ARRL/RAC section - for ARRL/RAC stations Example: VI  
 DX stations should enter their prefix or "DX" here. By this contest's 

rules, DX stations only send a report, no further exchange, but this 
is needed nonetheless to ensure a correct Cabrillo file for 
submission to the contest sponsors. This means that DX stations 
should not use the {EXCH} macro in their messages for this 
contest, so if you are using the default CW messages, they will 
need to be edited.  

 
The callsign in the Station Information dialog (>Config >Change Your Station Data 
>Call) determines if you are a DX station or an ARRL/RAC station.  
The ARRL/RAC sections can be found at http://www.arrl.org/contests/sections.abv.html  
 
The contest module accepts ITU regions: R1, R2 or R3 for /MM and /AM stations. 
 
All non-160 meter spots are marked as unworkable.  

10. ARRL Field Day contest 

The ARRL Field Day contest can only be used by US (K, KL and KH) & Canada stations 
(i.e. there are more FD contests outside the US & Canada which are not covered by this 
contest type - see FDREG1).  

 Window: Select Log type  
o Log Type: FD  
o Sent Exchange:  

 Your Class Your section  

 
Here is word from Dan Henderson from the ARRL contest branch on using Cabrillo for 
your log submission.  

Field Day is not included in the Cabrillo format. It has no way to mark/indicate power 
sources, GOTA station callsigns, bonus points, NTS traffic messages, etc. Also, Field 
Day only requires Dupe Sheets, not full logs. It is perfectly acceptable to include the 
Cabrillo log in lieu of the Dupe Sheets, but Field Day must have a completely filled out 
Summary sheet that includes all necessary information. This can be done with a 
"reasonable facsimile" electronically. However, since "proofs of bonus" (i.e. copies of 
letters to newspapers, visitor logs, photos, etc) are abundantly provided, most people 
find it easier to do Field Day via the regular mail - and use a combined system of part-
electronic added to the paper summaries. Anything received electronically for Field Day 
will be receipted but we may have to manually follow up if we can't get the basic 
required information from the email.  

73' Dan Henderson, N1ND  

Here are some logging tips from Jim, VE7FO  



Q: I always have a problem with the FD GOTA log. Besides just logging the QSO, I also 
need to ID the operator, the operators age and the GOTA coach. This has always been 
difficult to reconstruct after the fact. Any body else seen this?  

A: Just give the GOTA coach the following responsibilities: When a new op comes on 
have him hit CTRL-O and enter his call or name followed by a space and his age. This 
gets two of the vital pieces of info into the log. Require the coach to keep a log of his on 
and off times at the GOTA position; or you could add the coach's call at the end of the 
CTRL-O stuff too. You'll have to increase the width of the operator column in the log in 
order to see all this.  

× Changing from HF to VHF (and back)ARRL Field Day is unusual because it includes 
both HF and VHF bands. Switching bands with Ctrl+ PgUp/Dn won't work for band 
changes across the HF/VHF divide, but you can operate, dupe and log on the right band 
by one of two methods:  

 if your radio is interfaced, just change bands on the radio and your log will follow.  
 If your radio is not interfaced, just type an appropriate frequency in KHz (such as 

50125 for 6 meters) in the Entry window's callsign field) and press Enter.  

In either case, the band buttons in the Entry window will continue to display HF bands, 
but the Available window and Bandmaps will display spots for the band you have 
selected.  

 
 

11. ARRL International DX contest CW / SSB 

 Window: Select Log type  
o CW  

 Log Type:ARRLDXCW  
 Mode Category: CW  
 Sent Exchange: Your state/province - for K/VE stations Example: 

NY  
 Sent Exchange: Power - for DX stations (non K/VE) Example: 200  

o SSB  
 Log Type:ARRLDXSSB  
 Mode Category: SSB  

 Sent Exchange: Your state/province - for K/VE stations Example: 
NY  

 Sent Exchange: Power - for DX stations (non K/VE) Example: 200  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a DX stations or a W/VE station.&&&  
The default power for DX stations is:  



 100 Watts - Default  
 200 Watts - For the following countries: UA, UA2, UA9, UK, UN, UR, R1FJ, 

R1MV  
 400 Watts - For the following countries: G, GM, GI, GD, GM, GM/s, GW  
 500 Watts - For the following countries: I, IS, IT9  

Use the Space bar when the cursor is in the callsign field to have the 'Power' field filled 
with the default power. The default power will only be entered when the Power filed is 
empty. If you type another power level, it will replace the default power that the program 
put in there.  

Some stations use K or KW for 1000 watts in the exchange. You don't have to enter 
1000, just type K. The log checking software from the contest committee will 
understand.  

Call History for DX stations: When Call History is selected and a file is imported with 
US callsigns and States, the bandmap will be checked against the log and the call 
history and colored for mults when needed. So incoming spots will be colored when 
they are a qso, dupe or mult and found in the log or call history.  

12. ARRL November Sweepstakes CW / SSB 

 Window: Select Log type  
o CW  

 Log Type: SSCW  
 Mode Category: CW  
 Sent Exchange box: Precedence Year first licensed ARRL/RAC 

section Example: B 70 EMA (and in this order!) (NOTE: This is not 
what you should send over the air; it's what you must enter into the 
Sent Exchange box in order to create a valid Cabrillo file)  

 F5 key: !  
 F2 key: Right click on the CW message buttons and change 

F2 to: # B * 70 EMA.  

If you have separate run & S&P buttons, you will have to do this for both of them.  

× Don't put a serial number in the Sent Exchange boxSweepstakes is unlike other serial 
number contests in that it does not require you to enter "001" (or #) in the Sent 
Exchange. In fact, you must NOT do that. The ONLY things you put in the Sent 
Exchange box are your Precedence, Check and Section.  
The standard default function key message file that you use in other contests will not 
work for Sweepstakes. Do not use the {EXCH} macro in your Sweepstakes exchange 
messages. Instead, program the full exchange explicitly in your Exchange messages: # 
(Precedence) * (Check) (Section), as in # A * 78 WMA . 

o SSB  
 Log Type: SSSSB  
 Mode Category: SSB  



 Sent Exchange box: Precedence Year first licensed ARRL/RAC 
section Example: B 70 EMA (and in this order!) (NOTE: This is not 
what you should send over the air; it's what you must enter into the 
Sent Exchange box in order to create a valid Cabrillo file)  

 F5 key: !  
 F2 key: Normally, you should plan on saying callsigns and 

serial numbers and then pressing F2 for the rest of a pre-
recorded exchange message, beginning with your 
precedence, then your call sign, your check (year licensed) 
and your section.  

 
We do not recommend using voicing of serial numbers in SSB contests, because 
experience has shown that serial numbers enunciated as "one two three one", no 
matter how skillfully recorded, are never as easily understood as "one thousand two 
hundred thirty one." However, if you want to explore voicing of serial numbers or 
callsigns, click here.  

Example of playing WAV files using ESM.  

Put a single space in the message column of the F5 line of the SSB function key table.  

Speak the callsign of the station you're working and the serial number and press Enter. 
Your exchange.wav file should be something like "Bravo N1MM Check 61 Connecticut"  

1. Entering Received Exchanges  
Entering the received exchange is different in Sweepstakes than for any other contest 
because SS uses a five part exchange (nr, prec, call, ck, section). After you enter the 
call and move to the Exchange window (either by ESM or by pressing the Space Bar) 
you can enter all five in one window, and the program will do its best to interpret what 
you enter.  

If you use a Call History file in Sweepstakes (don't forget to check Call History Lookup 
on the Config menu), when you enter a callsign that is in the file and press the Space 
bar, it will pre-fill the Check (CK) and Section (SEC) for you and position the cursor one 
space behind the pre-filled information. All you need to do, then, is type the Serial 
Number and Precedence as you copy them. They look like they are in the wrong order, 
but look above the Exchange textbox for the line of small black type. You'll see it in the 
correct order, as it will be entered in your log.  

You do not need to type the call again unless you had it wrong the first time, in which 
case you can type it into the echange box and you'll see the program magically correct it 
(again in the small black type). If the program thinks there may be a problem, it tries to 
signal that by changing the type color to blue, so be aware of that. If something is 
screwed up, we recommend backspacing to the point where the exchange (or partial 
exchange) looks right again, and then re-entering the information. You should never 
have to wipe, or highlight and hit Delete.  

There are a couple of important rules. You must always enter the Serial Number and 
Precedence as a single element - e.g. "23B" not "23 B". This helps the program tell a 

http://n1mmplus.hamdocs.com/tiki-index.php?page=Using+Stored+Messages+in+Contests+-+and+the+Function+Key+Message+Editor&structure=N1MM+Logger+Documentation#SSB_Function_Keys


check from a serial number. Otherwise, you should put a space between elements. This 
is probably a good habit to get into, because when you need to correct something you 
have copied (see below) you'll need to do this.  

2. Correcting what you copied  
This is where N1MM Logger+ gives you a real advantage in Sweepstakes. The basic 
idea is that you never have to tab or space back to the Callsign field, or to space back in 
the Exchange field, to make corrections. The basic rule is simply to type your correction 
at the end of the Exchange string you have already copied. This includes callsigns.  

You can confuse the parser (the routine that generates the black type above the 
Exchange window). Here are easy rules you can apply to help with proper parsing:  

 When you are correcting a Callsign in the Exchange field - make sure you set it 
off with spaces.  

 If you need to enter or correct a Serial Number, enter it with the Precedence, 
without a space between - e.g "99B", not "99 B". Similarly, enter the Check and 
Section as another "couplet" - e.g., "54WV", not "54 WV". If you do this, we don't 
think you will be able to make the parser get it wrong.  

 
 

13. ARRL Rookie Roundup 

Rookies (operators licensed 3 years or less) work everyone; non-rookies work only 
rookies. Rookie status is determined by the 2-digit licensing year as entered in the Sent 
Exchange field of the Contest Setup Window (reached by File > New Log in Database 
or Open Log in Database). BOB 08 WV in the Sent Exchange field tells the program 
Bob's a rookie; BOB 54 WV tells it he's not.  

You do not need any special suffix on rookie calls (do not use /ROK. This is a rule 
change since the first running). Rookies are encouraged to call "CQ Rookie Roundup" 
on phone and "CQ RR" on CW and digital modes. Non-rookies should call "CQ 
Rookies" on phone and "CQ R" on CW or digital modes. A sample CW function key 
definition (macro) file is here . The macros are set for Rookies, non-rookies will need 
to change the CQ RR to CQ R.  

Log the exchange in order — name, 2-digit year, and state. Check the space 
immediately above the exchange field, where the program will indicate how it has 
"parsed" the exchange, and correct if necessary. 4-digit years should not be sent or 
logged - it will only cause confusion  

Score summaries are due within 72 hours of the end of the contest - 2359 Wednesday 
evening UTC, or 1859 EST. Use the "Submit your score" link under "Score submission" 
at the ARRL web page  for the RR. ARRL says logs are not required or accepted.  

 Window: Contest Setup  
o Make sure that you have entered your 2-digit licensing year in the 

Sent Exchange field.  

http://n1mm.hamdocs.com/tiki-list_file_gallery.php?galleryId=12
http://www.arrl.org/rookie-roundup


 Select Log Type  
o Log Type: RRSSB, RRRTTY, RRCW (pick the appropriate one)  
o Sent Exchange: Name, two-digit check (year first licensed), and State or 

Canadian Province, Mexican call area (XE1-4), or DC (examples: PETE 
54 WV, BOB 67 XE1, MARY 09 NU, ANN 10 DX  

 
 

14. Asia Pacific Sprint Contest CW / SSB 

 Window: Select Log type  
o CW  

 Log Type: APSCW  
 Mode Category: CW (spring and fall)  
 Sent Exchange: 001  

o SSB  
 Log Type: APSSSB  
 Mode Category: SSB (summer)  
 Sent Exchange: 001  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a DX stations or an Asia-Pacific station.  

15. Baltic contest 

The Baltic contest can be configured for stations from the Baltic countries (ES, YL, LY) 
and DX stations.  

 Window: Select Log type  
o Log Type: BALTIC  
o Sent Exchange: 001  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a DX station or a Baltic station.  

16. Black Sea Cup International 

 Window: Select Log type  
o Log Type: BSCI  
o Mode Category: MIXED  
o Sent Exchange: ITU Zone  

 HQ stations: IARU society abbreviation  
 BSCC members: membership number, e.g. BS17  



 
 
 

17. CNCW Spanish contest 

The CNCW contest (EA CW NATIONAL CONTEST) is only for Spanish stations 
operating inside the national territory.  

 Window: Select Log type  
o Log Type: CNCW  
o Mode Category: CW  
o Sent Exchange: Spanish Province letters Example: SG  

 
 

18. CQ M International DX contest 

in-edit  

 Window: Select Log type  
o Log Type: CQM  
o Mode Category: Select what category you enter (SSB, CW or Mixed)  
o Sent Exchange: 001  

XXXVerify thisXXX  

× Special country file neededThe CQM contest uses a special country list. In order to 
score properly, you need to import that country list into the database you will be using. 
First download the file by selecting >Files >Additional Support Files and copying the file 
Cty-CQM.dat to your N1MM Logger+ user directory. Then, from the Tools menu, select 
Import Country List from Downloaded File, and select the special Cty-CQM.dat file. 
Import it, and you're good to go.  
After the contest, don't forget to re-import the wl_cty.dat file to restore the normal 
country list.  

If you discover after the contest that you skipped this step, just be sure to submit your 
log in Cabrillo format, and the organizers will re-score it for you. Alternatively, you can 
import this special country list and re-score the contest (Tools > Rescore), but if you do 
that be sure to back up the database first, just in case.  

 
 

19. CQSA SSB Contest 

 This contest uses the Cabrillo 3.0 log file format so be careful to check the 
Contest Setup Window (File > Open Contest) to make sure you have filled in 
appropriate entry class, etc.  



 
 

20. CQ 160 Meter DX contest CW / SSB 

 Window: Select Log type  
o CW  

 Log Type: CQ160CW  
 Mode Category: CW  

o SSB  
 Log Type: CQ160SSB  
 Mode Category: SSB  
 Sent Exchange:  

 Your state/province - for K/VE stations Example: NY  
 Your country abbreviation - for DX stations (non K/VE)  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a DX stations or a W/VE station.  

All non-160 meter spots are marked as unworkable. Spots are marked with state from 
call history lookup as mults (if needed) in Bandmap and Available windows.  

21. CQ World Wide DX contest CW / SSB 

 Window: Select Log type  
o CW  

 Log Type: CQWWCW  
 Mode Category: CW  
 Sent Exchange: Your zone Example: 14  

o SSB  
 Log Type: CQWWSSB  
 Mode Category: SSB  
 Sent Exchange: Your zone Example: 14  

 The default zone values for US (K,N,W,A) stations are  
o Zone 3 - If number in callsign is 6 or 7  
o Zone 4 - If number in callsign is 5 or 8 or 9 or 0  
o Zone 5 - If number in callsign is 1 or 2 or 3 or 4  

 The default zone values for Canadian (VE) stations are  
o Zone 1 - If callsign starts with: VY1  
o Zone 2 - If callsign starts with: VE2, VO2  
o Zone 3 - If callsign starts with: VE7, VC7  
o Zone 4 - If callsign starts with: VE3, VE4, VE5, VE6, VA3  
o Zone 5 - If callsign starts with: VO1, VE1, XJ1, VY2  

 Press the Space bar when the cursor is in the 'Callsign' field to have the 'Zone' 
field filled with the default value  

 The default zone will be selected, so that if you type another zone, it will replace 
the numbers that the program put in there  



 For US users, Ctrl+Up/Ctrl+Dn doesn't stop at US stations  
 US spots are not grayed out for Canadian users  
 Don't show and count own countries as workable in the Bandmaps and the 

Available window  
 A new zone will be shown in red in the Entry window  
 Band changes  

o The allowed band changes are 8 for all CQ Contests  
o The band change counter is reset to 0 on first contact after the top of the 

hour  
 The program will look up the zone if the call has been changed, provided no zone 

was typed by the user  

 
 

22. CQ World Wide WPX contest CW / SSB 

 Window: Select Log type  
o CW  

 Log Type: CQWPXCW  
 Mode Category: CW  
 Sent Exchange: 001 i.e Serial number Example: 001  

o SSB  
 Log Type: CQWPXSSB  
 Mode Category: SSB  
 Sent Exchange: 001 i.e Serialnumber Example: 001  

 Leading zeros are being forced on sent & received serial numbers  
 Multi-Single and Multi-Two entries have a single set of serial numbers across all 

bands; per the rules, in multi-single a single sequence of serial numbers is 
generated regardless of band.  

 Band changes (per hour)  
o The allowed band changes are 8 for all CQ Contests  
o The band change counter is reset to 0 on first contact after the top of the 

hour  

23. CIS contest - CW / SSB 

The Commonwealth of Independent States Contest where everybody can work 
everybody for QSO and multiplier credit.  

 Window: Select Log type  
o Log Type:  

 CW: CISCW  
 SSB: CISSSB  

o Sent Exchange:  
 CIS stations: CIS area code Example for Moscow City: RU11  
 Non-CIS stations: 001  



 
 

24. Cup of the Russian federation RFC contest CW / SSB 

The RFC Contest is an internal Russian contest only between Russian stations.  

 Window: Select Log type  
o Log Type:  

 CW: RFCCW  
 SSB: RFCSSB  

o Sent Exchange:Grid Example: 115  

 
 

25. CWops Mini CWT 

Several 1-hour mini-contests each month. Each 1-hour segment is a separate contest.  

 Window: Select Log type  
o Log Type: CWOPS  
o Mode Category: CW  
o Sent Exchange:  

 Name and membership no. (members)  
 Name and state/province/country (non-members)  

 
Call history lookup for member numbers in the Sect or Exch1 field of the call history file 
is supported.  

26. CWops CW Open 

Three four hour contests - September 6 (0000-0359Z, 1200-1559Z and 2000-2359Z) in 
2014  

 Window: Select Log type  
o Log Type: CWOPSOPEN  
o Mode Category: CW  
o Sent Exchange:  

 Serial no. and name (e.g. 001 JOHN)  

 
 

27. DARC 10 meter contest 

 Window: Select Log type  
o Log Type: DARC10M  
o Mode Category: MIXED or CW (depends on the entry class)  



o Sent Exchange:  
 DL stations:DOK Example: A12  
 non DL stations: empty  

 
Call history lookup for DOK's is supported. Make a text file with Call and DOK and 
import this in the program. See the chapter Before the Contest for information how to 
use Call History and how to create the text file. During the contest "Call History Lookup" 
has to be enabled under the Config menu. When a station (which is in the Callhistory 
lookup table) is entered, pressing SPACE when the cursor is in the callsign field will 
enter the DOK in the section field.  

The contest manager from the DARC 10 meter contest approved and will accept the 
files made by N1MM Logger+ and likes to receive:  

File  How to make...  Exported 

Log file  
>File >Export >Export to File (Generic) >Generic File 
Output sorted by time  

[callsign].txt 

Summary 
sheet  

>File >Export >Print Score Summary to File  [callsign].sum 

 Send the "Generic File Output sorted by time" as a txt-File named with your call 
like DL8WAA.TXT  

 Don't forget your used own call, category and if you are a DL station: own sent 
DOK. This can be put in the Email or sent in the Cabrillo file.  

 
 

28. DARC Weihnachtswettbewerb XMAS contest 

The DARC Weihnachtswettbewerb is a contest on December 26 from 08.30-10.59 UTC 
between any station on 40 and 80 meters.  
The DARC contest manager for the Xmas contest accepts the standard generic file as 
log together with the summary sheet..  

 Window: Select Log type  
o Log Type: XMAS  
o Mode Category: MIXED  
o Sent Exchange:  

 DL stations:Serial number + DOK Example: 001 A12  
 Non-DL stations: Serial number Example: 001  

 
During the contest info about suspicious DOK's are shown in the info bar and written to 



the Notes filed.&&&  
After the contest check >View >Notes for the following situations:  

 "DL station non DARC member" - no DOK is given (DL station who is not a 
DARC member)  

 "DL station with DOK length 1" - DOK length is only one  
 "DOK with only numbers" - no letters in DOK  

 
 

29. DIG contest CW / Phone 

 Window: Select Log type  
o Log Type:  

 CW: DIGCW  
 SSB: DIGSSB  
 Sent Exchange: anything as it is not being used (DIG members 

could enter their DIG number here)  

 
 

30. Elecraft QSO Party 

 Window: Select Log type  
o Log Type: EQSO  
o Mode Category: Mixed  
o Exchange: State/Province/Country, Rig code + Rig serial number, or 

Power (non-elecraft rigs)  
 e.g. K3 serial #1234 would send 31234  

 
 

31. European Sprint CW/ SSB 

 Window: Select Log type  
o CW  

 Log Type: EUSCW  
 Mode Category: CW  
 Sent Exchange: Serialnumber & Operator name Example: 001 Tom  

o SSB  
 Log Type: EUSSSB  
 Mode Category: SSB  
 Sent Exchange: Serialnumber & Operator name Example: 001 Tom  



 
Example: The Exchange key (F2) can look like this: de * # {Exch} where "#" is current 
QSO Number and "{Exch}" is the Operator name.  

32. EU HF Championship 

 Window: Select Log type  
o Log Type: EUHFC  
o Sent Exchange: Last two digits of the year of operator's first official 

amateur radio license Example: 82 (for 1982)  

 
 

33. Field Day Region 1 

The Region I field day contest can be configured for Region 1 stations and DX stations. 
Supported are the rules for stations in Belgium, Germany, United Kingdom (**), 
Netherlands, Switzerland, Ireland (only CW), Italy, Slovenia (S5) and Russia (UA, UA2, 
UA9).  

 Window: Select Log type  
o Log Type: FDREG1  
o Sent Exchange: 001  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call) determines if you are a Region 1 supported station or not and if you are /P etc. or 
not..  

N1MM Logger+ checks whether the callsign used is a portable or a fixed station by 
checking the callsign in the Station dialog under config! So using a /P, /M etc there 
could make a difference in scoring!  

United Kingdom: The ModeCategory selects the CW or the SSB version of the 
contest. The rules between the CW and the SSB version are very different.  

34. First Class Operators Club (FOC) Marathon - members only 

 Window: Select Log type  
o Log Type: FOCCW  
o Sent Exchange:membership number  

 
The calculation of bonus points for working the same station on 5 (10 additional points) 
or on 6 bands (an extra 5 points) is not supported by the program. 
 
Martin/OK1RR and John/G3WGV have posted contest routines to rescore the contest 
from a Cabrillo file to a fully correct (including the 5/6 band bonuses).  



35. First Class Operators Club (FOC) QSO Party 

 Window: Select Log type  
o Log Type: FOCBWQP  
o Sent Exchange:  

 FOC members: RST, Name and FOC Number  
 Non-members: RST and Name  

 
 

36. GACW WWSA CW DX contest 

The GACW WWSA CW DX contest can used by South American stations and DX 
stations.  

 Window: Select Log type  
o Log Type: GACW  
o Mode Category: CW  
o Sent Exchange: Your zone Example: 14  

 The rules are almost equal to the CQWW contests.  
 Default zones for US (K,N,W,A) and Canadian (VE) stations apply  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a SA station or a DX station.  

37. Gagarin Cup 

in-edit  

 Window: Select Log Type  
o Log Type: GCUP  
o Mode Category: CW  
o Sent Exchange: Your ITU zone (not CQ zone e.g., 8 rather than 5 for 

eastern USA)  

XXXVerify thisXXX  

× Special country file neededThe Gagarin Cup contest uses a special country list. In 
order to score properly, you need to import that country list into the database you will be 
using. First download the file by selecting >Files >Additional Support Files and copying 
the file Cty-CQM.dat to your N1MM Logger+ user directory. Then, from the Tools menu, 
select Import Country List from Downloaded File, and select the special Cty-CQM.dat 
file. Import it, and you're good to go.  
After the contest, don't forget to re-import the wl_cty.dat file to restore the normal 
country list.  



If you discover after the contest that you skipped this step, just be sure to submit your 
log in Cabrillo format, and the organizers will re-score it for you. Alternatively, you can 
import this special country list and re-score the contest (Tools > Rescore), but if you do 
that be sure to back up the database first, just in case.  

 
 

38. HA DX Contest 

The Hungarian DX Contest can be configured for HA stations and DX stations.  

 Window: Select Log type  
o Log Type: HADX  
o Sent Exchange:  

 non-HA stations: 001  
 HA stations  

 HADXC members: HADXC membership number Example: 
101  

 Other HA stations: two letters county code. Example: GY  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a HA station or a DX station.  

39. Helvetia Contest 

The Helvetia Contest can be configured for HB stations and DX stations.  

 Window: Select Log type  
o Log Type: HELVETIA  
o Sent Exchange:  

 001 for non-HB stations  
 001 Your Canton Example: ZH for HB-station  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a DX station or a HB station.  

40. High Speed CW Contest 

The HSC CW contest can be configured for members and non-members.  

 Window: Select Log type  
o Log Type: HSCCW  
o Mode Category: CW  
o Sent Exchange:  

 Non-members: NM  
 Members: HSC-Membershipnumber  



 
 

41. Holyland Contest 

The Holyland Contest can be configured for 4X stations and DX stations.  

 Window: Select Log type  
o Log Type: HOLYLAND  
o Sent Exchange:  

 001 for non-4X stations  
 Your Area Example: E15RH  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a DX station or a 4X station.  

42. IARU Radiosporting contest HF 

 Window: Select Log type  
o Log Type: IARU  
o Mode Category: CW or SSB or MIXED  
o Sent Exchange: IARU member society abbreviation for IARU member 

society HQ stations and IARU International Secretariat club station  
 AC for IARU Administrative Council  
 "R1," "R2," and "R3" for the three IARU regional Executive 

committees  
 ITU zone for all other stations Example: 27  

 
The zone is prefilled while typing the callsign to allow multipliers to be shown while 
typing the callsign.  

Call history lookup for HQ multipliers is supported. Correct format is: W1AW,,,,ARRL,,,  

 If Call History Lookup is enabled, and a Call History file containing HQ multipliers 
has been loaded, then when an HQ multiplier or partial HQ multiplier (at least two 
letters) is entered into the exchange field and there is no call sign in the call sign 
field, the Check window will display all call signs in the Call History file with that 
same HQ multiplier in the Reverse Call Lookup pane  

o The call signs can be clicked on with the mouse to transfer one of them to 
the call sign window  

o If there is a partial call sign in the call sign field, possibly using wild cards 
for missing characters, the list of call signs displayed will be limited to 
those matching the partial call sign  

 
 



43. IOTA Islands On The Air Contest 

 Window: Select Log type  
o Log Type: IOTA  
o Sent Exchange:001 NA123 (default exchange) Be sure to delete the 

"NA123" from the Sent Exchange field in the Contest Setup dialog if 
you are not an island station, because otherwise the program's 
scoring will be incorrect.  

 Your own IOTA reference must be in the form XXYYY where XX = 
letters and YYY = numbers.  

NB: The syntax for the sent IOTA reference must be in the form XXYYY where XX = 
letters and YYY = numbers. Example: 001 EU001 and not 001 EUTT1 or 001 EU1. If 
you wish to transmit your exchange with cut numbers or without leading zeros in the 
IOTA reference, you will have to hard-code your desired exchange in your exchange 
messages instead of using the {EXCH} macro  

 The received IOTA reference does not need the dash (-) when logged. Example: 
Enter EU123 in the IOTA field, not EU-123. The Cabrillo output will have the - 
added automatically  

 The IOTA contest has many multipliers and therefore the program will only show 
worked IOTA references and add a new IOTA reference when a new multiplier is 
worked. In the Multiplier window, choose the "Sect" tab  

o If Call History Lookup is enabled, and a Call History file containing IOTA 
references has been loaded, then when an IOTA reference or partial IOTA 
reference is entered into the exchange field and there is no call sign in the 
call sign field, the Check window will display all call signs in the Call 
History file with that same IOTA reference in the Reverse Call History 
pane  

o The call signs can be clicked on with the mouse to transfer one of them to 
the call sign window  

o If there is a partial call sign in the call sign field, possibly using wild cards 
for missing characters, the list of call signs displayed will be limited to 
those matching the partial call sign  

 If your Call History file contains a list of country prefixes and island codes for 
those DXCC countries that are entirely on islands (e.g. G, VK), then entering a 
call sign from one of these countries will automatically pre-fill the IOTA reference 
field with the most common IOTA code for that country (see the IOTA Call 
History.txt file distributed with the program - country references are at the end of 
the file)  

o Since in many cases there is more than one IOTA reference for the same 
country, you must be prepared to override this code; when the cursor is 
moved to the IOTA field, the second (numerical) part of the IOTA 
reference code is highlighted to make it easy to override the default 
number  



 
Note for multi-operator stations:  

 The IOTA contest allows multi-operator stations to use two radios, one of which 
is only allowed to work new multipliers. This is similar to the Multi-Single category 
in the CQ WW and CQ WPX contests; note that in this contest, the two stations 
are allowed to transmit simultaneously  

o If you wish to make use of two radios, in the contest setup window choose 
the MULTI-ONE category (Operator category MULTI-OP and Xmtr 
category ONE). Select Networked-Computer Mode on both computers 
(see the Networked-Computer Support section of the manual for detailed 
instructions)  

 At the multiplier-only station, check the following options under 
Config > Networked-Computer Tools: Is Mult Station, and Don't 
work non-mults  

 If you wish to allow simultaneous transmitting at both stations, 
check the Block my Tx Only if Other Stn Transmitting on Same 
Band&Mode (Multi-One) option. This will allow both transmitters to 
operate simultaneously. This option is not "sticky", i.e. you will have 
to check it every time you restart the program, otherwise your radio 
will be blocked from transmitting whenever the other radio is 
transmitting. WARNING: DO NOT rely on the software lockout to 
protect your radios - the lockout is intended only to facilitate 
compliance with contest rules, and should not be relied upon to 
protect against damage  

 
 

44. International Naval Contest 

 Window: Select Log type  
o Log Type: NAVAL  
o Sent Exchange:  

 Club+Membership number for Naval Club member, e.g. PN007  
 001 for non-Naval Club member  

 
2009 contest rules: are here .  

2010 dates: 8 / 9 May - CW and SSB, 15/16 May - PSK and RTTY;  

45. JA domestic contests 

This is a general contest class for Japanese domestic contests and only for use by JA 
stations.  

 Window: Select Log type  

http://www.nra.pt/php/bdContestRules.php?lang=en


o Log Type: JAdomestic  
o Sent Exchange: Section + class Example: 25M or 10L  

 
General rules:  

 Japanese stations may only work Japanese stations  
 Example exchange numbers in ALL JA contest with assuming as follows.  

o I am in Osaka with 100W output and another party is in Tokyo with 10W.' 
send:59925M receive:59910L  

o I am in Okinawa with 1KW output and another party is in Sapporo in JA8 
with 50W. send:59947H receive:599106M  

 Dupe and multiplier examples  
o 20 mtr JE1CKA 10H SSB 1 point + multiplier  
o 20 mtr JE1CKA 10H CW 0 points dupe, no multiplier  
o 20 mtr JE1CKA 10H SSB 0 points dupe, no multiplier  

 Same station should counts for 1 point only once on each band regardless of 
mode.  

 The multiplier counts once on each band regardless of mode.  
 When the SentExchange does not end on H, L, M or P then there is no 

Powercode check.  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a JA station.  

46. JIDX contest 

This JIDX contest contest can be configured for Japanese stations and DX stations.  

 Window: Select Log type  
 CW  

o Log Type: JIDXCW  
o Mode Category: CW  
o Sent Exchange:  

 non-JA stations: CQ Zone number Example: 14 (01 to 40)  
 JA stations: Your Prefecture Example: 34 (01 to 50)  

 SSB  
o Log Type: JIDXSSB  
o Mode Category: SSB  
o Sent Exchange:  

 non-JA stations: CQ Zone number Example: 14 (01 to 40)  
 JA stations: Your Prefecture Example: 34 (01 to 50)  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a JA or a DX station.  



47. JT DX Contest 

 Window: Select Log Type  
o Log Type: JTDX  
o Mode Category: CW or SSB, select one only  
o Sent Exchange: CQ Zone (e.g., 5, 14, 23, etc.)  

 
 

48. King of Spain Contest 

The King of Spain contest can be configured for EA stations and DX stations.  

 Window: Select Log type  
o CW  

 Log Type: KINGEACW  
 Mode Category: CW  
 Sent Exchange:  

 non-EA stations: 001  
 EA stations:Your Province Example: AV  

o SSB  
 Log Type: KINGEASSB  
 Mode Category: SSB  
 Sent Exchange:  

 non-EA stations: 001  
 EA stations:Your Province Example: AV  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a DX station or a EA station.  

49. Logbook of the World Contest CW / SSB 

 Window: Select Log type  
o Log Type:  

 CW: LOTWCW for the Digital part of the contest (LOTWRTTY)  
 SSB: LOTWSSB  

o Sent Exchange:  
 For North American stations: State/Province abbreviation Example: 

CT  
 For non North American stations: Countryprefix  

 
 

50. LZ DX Contest 

The LZDX contest can be configured for LZ stations and DX stations.  



 Window: Select Log type  
o Log Type: LZDX  
o Sent Exchange:  

 non-LZ stations: ITU zone  
 LZ stations:Your District abbreviation Example: BU  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a DX station or a LZ station.  

51. LZ Open and LZ Sprint Contests 

Supports all three versions of the contest (LZ Open contest, LZ Open 40 meter Sprint 
contest and LZ Open 80 meter Sprint contest)  

 Window: Select Log type  
o Log Type: LZOPEN  
o Sent Exchange: 001  
o Select LZOPEN contest. The Sent Exchange in the "contest selection 

window" is 001 or #.  
o Your F2 exchange message should be: {EXCH}{LASTEXCH} or 

#{LASTEXCH}  
o Since it is required, the program will always send leading zeros for this 

contest. Unchecking the leading zeros box in Configurer will have no 
effect  

o When a callsign is in the Entry Window, the Info Window displays the time 
since you last worked the station  

o If you have a radio interface enabled, the bandmap colors of the callsigns 
will update when you can work the station again for points  

 Set the Bandmap Packet Spot Timeout greater than 30 minutes  
o Do not enter received cut letters into the exchange box. They will not be 

converted to numbers  
o Read the contest rules  
o Submit the contest results with the Cabrillo output  

 
The 30 minute time period is computed per the organizers instructions. That is to ignore 
the seconds of the logged QSO when computing the 30 minute interval. The 30 minute 
interval is computed from the last QSO on the current band so it is not recommended to 
log a contact that will not produce any points.  

LZ Open and LZ Sprint contests display the sent exchange on the Entry Window status 
line. This addition expects that the {LASTEXCH} macro is used as required by these 
contests.  

52. Manchester Mineira Contest 

The Manchester Mineira Contest by CWJF is the major CW contest in South America. 
Since 2011 this contest is now open to stations anywhere in the world.  



 Window: Select Log type  
o Log Type: CQMMDX  
o Mode Category: CW  
o Sent Exchange: Continent (e.g. NA), or Continent + M (member), Y (YL), 

Q (QRP) or G (multi-operator group)  

 
 

53. Michigan QRP Contest 

See the ARCI contest which uses almost the same rules. 
 
Supported are: January CW Contest ; Memorial Day CW Sprint ; July 4th CW Sprint ; 
Labor Day CW Sprint  

54. MiniTest CW Test 

Almost every week on Wednesday at 18 GMT and lasts only one hour. It has 6 time 
periods  
(10 minute each). Band: 3520 - 3570 kHz, mode: CW, exchange: RST+serial.  
Every QSO gives 1 point, multiplier: the number of unique calls during this hour of the 
contest. Classes: 1- club station, 2 - SO, A- power > 100 W, B - power <= 100 W, 3 - 
SWL. The results can be submitted at 19.00 GMT on 3720 KHz (SSB) or on 3541 KHz 
(CW).  
The submitted information (QSO number, multiplier, class) will look like this: "125 36 A". 
The results are published here:  
http://www.minitest.narod.ru/2009/2009.htm  

55. NA Sprint CW / SSB 

 Window: Select Log type  
o Log Type:  

 CW: SPRINTCW  
 SSB: SPRINTSSB  

o Sent Exchange: 001 Tom CT  
 Serial number, your name and your location (state, province or 

country) Example: PA1M DE N1MM 123 TOM CT K  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a North American station or a non-North American station.  

 Example function keys can be found in the Example Function Keys chapter  
 Check out the Macros chapter. The {PGUP} and {PGDN} macros are useful in 

the Sprint.  
o By Tom - W4BQF: Open config - Confiigure Ports.... - Other. Under the 

'Other' tab, look at the right-most column, where you will see "CW 
Up/Down Arrow" and "PgUp/PgDown". These can be configured to QSY. 

http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+HF+Contests+-+CW+and+SSB&structure=N1MM+Logger+Documentation#ARCI_QRP_Contests_REAL_AMP_Michigan_QRP_Contest
http://n1mmplus.hamdocs.com/tiki-index.php?page=Function+Key+Examples
http://n1mmplus.hamdocs.com/tiki-index.php?page=Macros&structure=N1MM+Logger+Documentation


Configure the Up/Down Arrow keys to QSY, say 2 kHz each time you 
press your keyboard up or down arrow keys. Configure PgUp/Down to 
QSY 'x' kHz, and then use {PGUP} or {PGDN} as a macro assigned to any 
of the function keys. Example: F10 Freq UP, {PGDN} {run} F11 Freq DN, 
{PGUP}{run} 
In my case "PgUp/Down" will move my frequency 5.5 kHz and the "CW 
UP/Down Arrow" keys set to QSY 1.5 kHz. A little tricky because {PGDN} 
actually moves you UP in frequency, but it works very well.  

 
N1MM Logger Sprint Survival Tips - Version 1.7, by N2IC (written for Logger Classic, 
should be applicable to Plus)  

I thought I would share what I have learned about customizing N1MM Logger for  
this contest.  

I'm not going to try to explain how to operate the Sprint - for this, there is  
an excellent writeup by Tree, N6TR here .  

What I will do is describe how to get the most out of N1MM Logger in the Sprint.  
My operation is SO2R, and my configuration is optimized for that mode. However,  
I'm sure you SO1R guys will pick up a few tricks from what I have done for SO2R.  

The most important thing is to get your options, windows and function keys set  
up correctly before the Sprint starts.  

The Options...  

Start up N1MM Logger using version 12.1.0 or later, and create a new SPRINTCW  
contest.  

I assume that your radio(s) are interfaced to N1MM Logger, so that N1MM Logger will 
automatically track the frequency of each radio. If you do not have interfaced radios, this 
configuration and function key assignment will not work correctly for the Sprint.  

In the Config menu, select the following options:  
- Enter sends message (ESM)  

- QSYing wipes the call & spots QSO in bandmap  

- Do Not Automatically Switch to Run on CQ Frequency  

- Show non-workable spots  

- SO2R->Toggle CTRLFx Macro  

The "Toggle CTRLFx Macro" can also be toggled using Ctrl+Shift+L. This is handy  
if you need to turn off {CTRLFx} during the contest.  

The Windows...  

These are the only windows I have on my screen:  

- Entry Window (one for each radio)  

http://www.kkn.net/n6tr/sprint.html


- Visible Dupesheet (one for each radio)  

- Info  

- Log  

- Score Summary  

They all fit nicely on my small monitor. My screen layout is shown at  
http://www.kkn.net/~n2ic/sprint.bmp .  

The Visible Dupesheet is really nice once you get used to it. To see if a  
station is a dupe, you just scan the dupesheet with your eyes, rather than  
frantically type a call into the Entry Window.  

Open a Bandmap window. Right  
click and select "Packet Spot Timeout". Change the packet spot timeout to 1  
minute. That's right....1 minute. Hit OK. Now close the Bandmap window. Don't  
reopen it. It is of no value in Sprint, but it is important to change the packet  
spot timeout value to 1 minute. (Side note: This option should really be called  
"Bandmap Timeout" not "Packet Spot Timeout". It controls how long calls stay on  
the bandmap and the appearance of calls in the "on deck" frame of the Entry  
Window. We're obviously not using packet in the Sprint.)  

Notice that I do NOT have the "Available Mults & Q's" nor the Bandmap windows open.  

Function Keys ....  

Here are my function key definitions. I'll explain a few that aren't obvious.  

F1 CQ,{JUMPRX}cq na cq na * na  

F2 Exch,* # steve nm  

F3 TU,{CLEARRIT}t{END}{CONDJUMP}{STOPTX}  

F4 {MYCALL},*  

F5 Call,!  

F6 QSO B4,qso b4 *  

F7 Other Short,{CTRLF10}  

F8 Other Long,{CTRLF11}  

F9 GoS&&P,{S&P}  

F10,cq na * * na {RUN}  

F11 Long CQ,cq na cq na * * na {RUN}  

F12,-  

F1 S&&P CQ,{JUMPRX}cq na cq na * na  

F2 S&&P Exch,! # steve nm * {RUN}  



F3 S&&P tu,tu  

F4 S&&P,*  

F5 S&&P his call,!  

F6 S&&P,-  

F7 S&&P Other Short,{CTRLF10}  

F8 S&&P Other Long,{CTRLF11}  

F9 GoRun,{RUN}  

F10,cq na * * na {RUN}  

F11 Long CQ,cq na cq na * * na {RUN}  

F12,-  

-------  

 
With the Run F3 key, my "thank you" message is sent. When you QSY, you will  
automatically be changed to S&P mode. Do not include the {S&P} macro here - it  
will cause the last station worked to get "stuck" in the on-call frame of the  
Entry Window.  

With the S&P F2 key, as soon as I send my exchange, it immediate switches to Run  
mode.  

I can also force myself into Run and S&P modes with the F9 key.  

The F7 and F8 keys send CQ's on the "other" radio. This is very useful when the  
other station is sending his exchange, and you are going to lose the frequency  
(i.e. it will become "his" frequency). You can send a CQ on the other radio,  
while he is sending his exchange. Then, when he finishes sending his exchange  
and you need to send your "thank you" message to finish the QSO, all you have to  
do is hit Enter, which will stop the CQ on the other radio, and send your Run F3  
message on the active radio. After the "thank you" message is sent, the {CONDJUMP} 
macro in the Run F3 message will move your entry focus to the "other" radio, so that 
you will be ready to copy a new caller on the radio you were CQing on.  

When I'm CQing on the active radio, but simultaneously doing S&P on the other  
radio, and hear a new station, I can hit the Enter key. This will stop the CQ, and send 
my call on  
the other radio.  

One thing you need to do is keep an eye on where your transmit and receive focus  
is (the red and green dots on the Entry Window). When you're doing SO2R in the  
Sprint, there will be times where your focus is not where you might expect it,  
or want it. Always be ready with the \ and Pause keys to jump between radios.  
Yes, this takes lots of practice, and you will make mistakes. The Thursday night  
NCCC Sprints are good practice for this.  



NA Sprint CW by Kenny, K2KW  

North American Sprint CW is just a few hours away, and thought I would take a moment 
to help others get their CW messages ready. Your messages may differ slightly from 
mine, but I just wanted to highlight what's happening on the F2 and F3 messages which 
are the key setup items for Sprint. The F2 exchange is set up to give you the correct 
sequence for this contest using ESM, and the exchange sequence varies based on if 
you are Calling CQ, or you answered someone while S&P. F3 is used to confirm the 
message, and change your state from S&P to Running, or Running to S&P. The {RUN} 
and S&P} macros are inserted at the end of the F3 message, and will automatically 
change your state, and thus exchange sequence.  

I have also changed the Up/Down Arrow to move 1.5 kHz, giving you an "instant QSY" 
per the rules. You may choose to use a wider QSY increment, but the goal was to offer 
you an idea for QSYing so you can abide by the rules.  

If you are not aware of the uniqueness of the Sprint exchange and QSY rule, check out: 
http://n6tr.jzap.com/sprint.html and http://www.ncjweb.com/sprintrules.php  

73 and CU in the contest,  

 Set the Exchange:  
o >File >Choose Which Contest to Log >Sent Exchange  

 # yourname yourstate  
 Example: # KEN CA  

 Set QSY distance:  
o In the >Config >Configurer >Other window, change the CW Up/Down 

Arrow Incr = 1.5  
 That gives me an instant QSY somewhat greater than the minimum 

QSY required after you leave a frequency. Any value over 1 kHz is 
recommended  

 
 

56. SprintNS and Sprint Ladder 

Window: Contest Setup  

These contests are identical except for the dupe rule that is incorporated. SPRINTNS 
does not allow no in-band dupes, while SPRINTLADD allows dupes with one 
intervening QSO.  

 Log Type:  
o SPRINTLADD. SPRINTNS  

 Sent Exchange: 001 Tom CT  
o Serial number, your name and your location (state, province or country) 

Example: PA1M DE N1MM 123 TOM CT K  



 
The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a North American station or a non-North American station.  

See NA Sprint above for more information (rules for the NS Sprint and Sprint Ladder are 
derived from but slightly different than NA Sprint, so be advised!).  

57. NAQP North American QSO Parties CW / SSB 

 Window: Select Log type  
o CW  

 Log Type: NAQPCW  
 Operator Category: SINGLE-OP or MULTI-TWO  

 For Multi-Two see the extra info below!  
 Mode Category: CW  
 Sent Exchange:  

 For North American stations - Operator name and station 
location (state, province, or country) Example: Tom CT  

 For non-North American stations - Operator name only 
Example: Thomas  

o SSB  
 Log Type: NAQPSSB  
 Operator Category: SINGLE-OP or MULTI-TWO  

 For Multi-Two see the extra info below!  
 Mode Category: SSB  
 Sent Exchange:  

 For North American stations - Operator name and station 
location (state, province, or country) Example: Tom CT  

 For non-North American stations - Operator name only 
Example: Thomas  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a North American station or a non-North American station. 
Contest rules require the Multi-Operator stations use a single name throughout the 
entire contest.  

58. NRAU Baltic Contest 

This contest is only for stations from the following countries: ES, JW, JX, LA, LY, OH, 
OH0, OX, OY, OZ, SM, TF, and YL  

 Window: Select Log type  
o Log Type:  

 CW: NRAUCW  
 SSB: NRAUSSB  

o Sent Exchange: Section Example: AA  



 
When a station is logged the following checks are made:  

 Is the logged station from a valid country ( ES, JW, JX, LA, LY, OH, OH0, OX, 
OY, OZ, SM, TF, and YL)  

 Is the entered section a valid section (from NRAU.sec)  
 A warning is given when a qso is made an another band than 7 or 3,5 MHz. A 

note is made with the logged qso.  

 
 

59. Oceania Contest 

Supported are the CW and SSB version of the contest  

 Window: Select Log type  
o Log Type:  

 CW: OCEANIACW  
 SSB: OCEANIASSB  

o Sent Exchange: 001  

 
Note: The rules have special instructions for not complete portable callsigns so a prefix 
can not be deduced normally. Adding numbers like the rules state is not supported and 
should be done by editing the log file (afterwards). Example: N8BJQ/PA would be PA 
but is not a valid prefix and should become PA0 (add the zero).  

60. OK OM DX contest 

The OK-OM DX contest can be configured for OK/OM stations and DX stations.  

 Window: Select Log type  
o Log Type: OKOMDX  
o Mode Category: CW (it is a CW only contest)  
o Sent Exchange:  

 Non-OK/OM stations: 001  
 OK/OM stations: district abbreviation Example: BPZ  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are an OK/OM station or a DX station.  

61. PA beker contest 

The PA-beker contest is a local Dutch contest on 40 and 80 meters. The text below is in 
Dutch.  

 Window: Select Log type  



o Log Type:  
 CW: PABEKERCW  
 SSB: PABEKERSSB  

o Sent Exchange:  
 QSL regio Voorbeeld: 27 (en niet R27)  

 QSL regio ingeven en invoeren zonder R dus 27 en geen R27  
 Log, Entry en Score summary geven de juiste scores.  
 De multiplier window (Ctrl+J) geeft onder 'Sect' de gewerkte QSL regios alleen 

daar wordt de eigen regio wel getoond indien gewerkt.  
 Er zit geen beperking op banden (dus let op dat je op 40 en 80 meter logt).  
 In te zenden log bestanden:  

File  How to Make...  Exported 

Log file  >File >Export >Export to File (Generic)  [callsign].txt 

Summary sheet  >File >Export >Print Score Summary to File  [callsign].sum 

 
 

62. PACC contest 

in-edit  

The PACC contest can be configured for PA stations and DX stations.  

 Window: Select Log type  
o Log Type: PACC  
o Sent Exchange:  

 Non-PA stations: 001  
 PA stations: Your province Example:DR  

 
XXXVerify thisXXX  

PA stations ONLY have to import an adapted CTY.DAT file for the PACC contest so the 
right multipliers will be used. In the 'Entry window' go to 'Tools', and select 'Import 
country list from downloaded file'. This adapted country file can be downloaded from the 
N1MM website, under 'Files', select in the menu: 'Additional Support Files'. Don't forget 
importing the original CTY.DAT file again when entering other after the PACC contests.  

The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a DX station or a PA station.  

The PACC contest committee approved and will accept the files made by N1MM logger 
and likes to receive:  



File  How to Make...  Exported 

Cabrillo Log file  >File >Generate Cabrillo File  [callsign].log 

 
Note icon PA stations: Vergeet niet in de cabrillo log file te vermelden de klasse 
waarin je mee doet en de afdeling voor het afdelingsklassement!  
Note icon PA stations kunnen tijdens de PACC contest op 160 meter gelijktijdig 
meedoen aan de RSGB 1.8 MHz CW contest in de avonduren. N1MM accepeteert na 
het volgnummer ook de districtscode. Voorbeeld: 599 123AA (NB, geen spatie tussen 
het ontvangen volgnummer en de district code)  

63. Portugal Day Contest 

The Portugal Day contest can be used for Portuguese stations (CT, CT3 or CU) and DX 
stations.  

 Window: Select Log type  
o Log Type: PORTUGAL  
o Exchange:  

 District or Autonome Region for Portuguese stations  
 001 for DX stations (serialnumber)  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a Portuguese station or DX.  

64. QCWA QSO Party 

 Window: Select Log type  
o Log Type: QCWAQSO  
o Mode Category: Mixed  
o Exchange: Year licensed, Name, Chapter (or state/province/country)  

 The unique scoring for operating within 50 miles of the special events station and 
the one QSO rule for your home chapter are not supported.  

65. RAC Canada Day Contest / RAC Canada Winter Contest 

Both contests are supported with the same set of rules. These RAC contests can be 
used both for VE stations and DX stations.  

 Window: Select Log type  
o Log Type: RAC  
o Exchange:  

 Province or territory for stations in Canada  
 001 for VE0 stations and stations outside Canada (serialnumber)  



 
The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are from Canada, VE0 or outside Canada.  

66. RAEM CW contest 

The RAEM Contest is CW only and has no multipliers, only points. These points are 
calculated based on QSO points and distance between the stations (based on 
exchanged coordinates). Extra points are added for polar stations. Extra bonus points 
for RAEM memorial stations are not added because the call RAEM has no number is 
will not be accepted by the program. Use RAEM99 or so and update the log and score 
(300 additional points) after the contest. 10 band changes per hour are permitted, and a 
band change counter is activated when this contest is selected.  

 Window: Select Log type  
o Log Type: RAEM  
o Mode Category: CW (it is a CW only contest)  
o Sent Exchange: 001 & Coordinates Example: 001 53N6O  

 The own coordinates is the second token in Sent Exchange 
without spaces (one 'word')  

 
Coordinate rules: These rules apply for the 'Sent Exchange' and also when entering a 
coordinate in the Entry Window.  

 Own coordinates: Second token in Sent Exchange without spaces (one 'word')  
 First part is the Longitude with at the end N or S Example: 53N  
 Second part is the Latitude with at the end W or O (not E) Example: 6O  
 As a total this makes: 53N6O  

 
Log and rescore: To generate the log use the Generic log file and the Score summary. 
Always rescore and check the log. If a qso has 1 point then the Received exchange is 
not correct. If there are QSOs who have gotten 2 points then your Sent Exchange is not 
correct. Update your Sent Exchange in the contest setup and rescore. Check again.  

Call History: The call history can be used but... the coordinates have to be entered in 
the Name field of the Call History table. This is the only field which is capable of 
handling all different coordinates 1N2W but also 67N169O  

 
 

67. REF contest CW / SSB 

The REFContest can be configured for stations in REF countries and DX stations.  

 Window: Select Log type  
o Log Type:  



 CW: REFCW  
 SSB: REFSSB  

o Sent Exchange:  
 For DX stations: 001  
 For stations in REF countries - Department (F and TK) or Prefix (all 

other REF countries)  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a DX station or a station in a REF country.  

68. RF Championship 

The RF Championship is a contest for stations of the Russian Federation only.  

 Window: Select Log type  
o Log Type: RFCHAMP  
o Mode Category: Select mode used in contest (CW, SSB)  
o Sent Exchange: 001  

 
Please add the zone to sent in the Function keys. The points are calculated based on 
your callsign and the callsign received.  

69. RSGB 160 Meter CW Contests 

The RSGB 1.8MHz CW Contests can be configured for RSGB stations and DX stations.  

 Window: Select Log type  
o Log Type: RSGB160CW  
o Mode Category: CW (it is a CW only contest)  
o Sent Exchange:  

 For DX stations: 001  
 For stations in the UK - 001 & District Example: 001 ZE  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are in the UK or not.  

Serial numbers must be logged from UK stations.  
There is no check by the program if a serial number is entered for non-UK stations. This 
because there are often several other EU contests going on at the same time and an 
entrant in those may not sent a serial number just an area code like DR (PACC) or a 
French department like 78. If a non UK station sends a serial number it must be logged 
in the received serial nr field, if it sends a code like DR is must be logged in the districts 
field.  

70. RSGB 21/28 MHz contest 



The RSGB 21/28 MHz CW Contests can be configured for RSGB stations and DX 
stations  

 Window: Select Log type  
o Log Type: RSGB2128  
o Sent Exchange: 001  

 
 

71. RSGB 80 Meter Club Championship 

The RSGB 80 Meter Club Championship can be configured for RSGB stations and DX 
stations  

 Window: Select Log type  
o Log Type: RSGB80MCC  
o Sent Exchange: 001  

 
 

72. RSGB Affiliated Societies Team Contests AFS 

The RSGB Affiliated Societies Team Contests can be configured for RSGB stations and 
DX stations  

 Window: Select Log type  
o Log Type:  

 CW: RSGBAFS-C  
 SSB: RSGBAFS-S  

o Sent Exchange: 001  

 
 

73. RSGB Club Calls contest 

The RSGB Club Calls contest can be configured for RSGB stations and DX stations  

 Window: Select Log type  
o Log Type: RSGBCLUB  
o Sent Exchange: 001  

 
 

74. RSGB Commonwealth contest 

in-edit  



 Window: Select Log type  
o Log Type: RSGBBERU  
o Exchange: 001 (HQ stations enter 001 HQ in this box, with a single 

space between the 001 and the HQ)  

 
This contest is for British Commonwealth stations only. The callsign in the Station 
Information dialog (Config >Change Your Station Data >Call) determines whether you 
are in the Commonwealth or not.  

There are no multipliers in this contest. Contacts with Commonwealth stations outside 
your own Commonwealth Call Area (CCA) are worth 5 points; contacts within your own 
call area or with non-Commonwealth stations are worth zero points. There are bonus 
points for the first 3 contacts on each band in each CCA (25 points instead of 5 points). 
HQ stations send HQ after the serial number in the exchange (enter HQ in the HQ block 
in the entry window when you work one of these), and are also worth 25 points. You can 
work three bonus stations in each CCA on each band for 25 points each; any additional 
contacts in that CCA are worth 5 points each (unless there is an HQ station in that CCA 
- HQ stations are always worth 25 points). You can work the HQ station in your own call 
area for bonus points. HQ stations can work all CCAs including their own.  

Bonus stations (first three contacts in a CCA, and HQ stations) are shown in red in the 
Entry window; other Commonwealth stations are in blue. Non-Commonwealth stations 
and stations in your own CCA are shown in grey (including the HQ station in your CCA 
until the HQ box in the Entry window is filled in). If you wish to work and log a zero-point 
QSO, use Ctrl+Alt+Enter to force-log the contact.  

To have the Multiplier window show only Commonwealth Call Areas, go to the Files > 
Additional Support Files on this web site and download file cty-BERU-20100315.dat or 
cty-BERU-20110301.dat into your N1MM Logger+ user files folder, then use the 
Logger's Tools > Import country list from downloaded file menu item to import this list 
into the database. You will have to close and reopen the Multiplier window for this 
change to take effect. The Multiplier window only shows whether one station has been 
worked in that CCA. Remember to reload the normal wl_cty.dat file into the 
database after the contest is over and your log has been exported!  

Call History Lookup should be turned off in this contest to prevent state/section 
information for other contests from prefilling the HQ box.  

HQ stations are recorded in the "Sect" column in the log. Call areas are recorded in the 
"Exch" column. In the Score Summary window, the "Cty" column indicates the number 
of bonus-point QSOs (first three QSOs in a CCA), and the "Sec" column indicates the 
number of HQ stations worked.  

After the contest, review your Cabrillo file header using a text editor and compare it 
against the RSGB Cabrillo instructions . The RSGB uses some non-standard fields in 
its Cabrillo files, so you will probably have to make some changes.  

75. RSGB SSB Field Day & RSGB National Field Day 

http://www.rsgbcc.org/hf/information/cabrillo.shtml


The Region I field day contest can be configured for RSGB and DX stations.  

 Window: Select Log type  
  
o Log Type: FDREG1 <----  
o Mode Category: The ModeCategory selects the CW or the SSB version of 

the contest. The rules between the CW and the SSB version are very 
different..  

 CW for the CW Field day contest  
 SSB for the SSB Field day contest  

o Sent Exchange: 001  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a RSGB station or not and if you are /P etc. or not..  

N1MM Logger+ checks whether the callsign used is a portable or a fixed station by 
checking the callsign in the Station dialog under config ! So using a /P, /M etc there 
could make a difference in scoring!  

76. RSGB Low Power Field Day 

The RSGB Low Power Field Day can be configured for RSGB stations and DX stations  

 Window: Select Log type  
o Log Type: RSGBLP  
o Mode Category: CW (it is a CW only contest)  
o Sent Exchange: 001 Power Example: 001 2W5  

 
 

77. RSGB ROPOCO 

The RSGB ROPOCO is an internal RSGB contest and only available for G ,GD ,GI ,GJ 
,GM ,GU and GW stations.  

 Window: Select Log type  
o Log Type: ROPOCO  
o Mode Category: CW (it is a CW only contest)  
o Sent Exchange: Your postcode (taken from station info)  

 
NOTE. Use the macro {LASTEXCH} to send the postcode from the previous qso. 
Example F2 key: <<<5nn>>>{LASTEXCH}  

78. Russian District Award contest 

The Russian District Award contest can be configured for Russian stations and DX 
stations.  



 Window: Select Log type  
o Log Type: RDAC  
o Sent Exchange:  

 Non-Russian stations: 001  
 Russian stations: District code by RDA list (for example TB02)  

 Call History exchange field: Exch1  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a Russian station or a DX station.  

79. Russian DX contest 

The Russian DX contest can be configured for Russian stations and DX stations.  

 Window: Select Log type  
o Log Type: RUSSIANDX  
o Sent Exchange:  

 Non-Russian stations: 001  
 Russian stations: Your oblast code (two letters)  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a Russian station or a DX station.  
Example: Default RU1A would have SP, in the call hisotry RU1A could be added so it 
will give the correct exception LO.  
When a station is found in Call history it will use the section/oblast from it. IIf not found 
in Call history it will use the default oblast.  

Example Call history 
 
RA1AR,,,, LO 
 
RU1A,,,,LO 
 
RU6FA,,,,KM  

Log submission notes:  

'CATEGORY-OVERLAY'. In the RDXC you can submit one log and have it scored as 
two single band entries. Like operating 10m during day time and 160m at night. Now, 
this is particular to this contest and you need to submit your log like this:  

CATEGORY-OVERLAY: [operator-cat] [band-cat] [power-cat] [mode-cat] The category 
overlay of the log submission when appropriate. In RDXC, two single band entries are 
allowed from one participant. In this case, one entry must be listed under CATEGORY 
tag, the other one under CATEGORY-OVERLAY, such as:  

 CATEGORY: SINGLE-OP 80M HIGH MIXED  



 CATEGORY-OVERLAY: SINGLE-OP 15M HIGH MIXED  

 
 

80. Russian Radiosport Team Championship 

 Window: Select Log type  
o Log Type:  

 RRTCT (invited teams)  
 RRTC (everyone else)  

o Sent Exchange:  
 three-letter code (teams)  
 ITU zone (others)  

 
 

81. Russian YL/OM contest 

 Window: Select Log type  
o Log Type: RUSYLOM  
o Sent Exchange:  

 73 for male stations (OM)  
 88 for female stations (YL)  

 
YL stations (female) may only work OM stations (male) and vice versa.  

82. SAC contest CW / SSB 

The Scandinavian Activity Contest can be configured for Scandinavian stations and DX 
stations.  

 Window: Select Log type  
o CW  

 Log Type: SACCW  
 Sent Exchange: 001  

o SSB  
 Log Type: SACSSB  
 Sent Exchange: 001  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a Scandinavian station or a DX station.  

83. Spanish Towns contest 

The Spanish Towns contest can be configured for EA stations and DX stations.  



 Window: Select Log type  
o Log Type: CME  
o Mode Category: SSB  
o Sent Exchange:  

 non-EA stations: 001  
 EA stations: Your INE code Example: 18145  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a DX station or a EA station.  

84. SPDX contest 

The SPDX contest can be configured for Polish stations and DX stations.  

 Window: Select Log type  
o Log Type: SPDX  
o Multi-Op set Operator Category = MULTI-ONE  
o Sent Exchange:  

 001 for non-SP stations  
 Your province Example: B for Lubuskie  

The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a Polish station or a DX station.  
The band and mode change counter is shown in the Info window.  

85. Stew Perry Topband Distance Challenge 

The Stew Perry contest is CW only.  

 Window: Select Log type  
o Log Type: STEWPERRY  
o Power category:  

 HIGH when > 100 Watt  
 LOW when 10 - 100 Watt  
 QRP when less than 10 Watt  

o Sent Exchange:  
 Your four character grid Example: JO33  

 
The point calculation in the log is multiplied by a power multiplier for each qso point 
value. This factor depends on the selected Power category chosen. HIGH is multiplied 
by a factor 1, LOW by a factor 2 and QRP by a factor 4.  

86. Scandinavian Young Ladies Radio Association SYLRA 

 Window: Select Log Type  
o Log Type:SYLRA  
o Mode: Mixed+Dig  



o Sent Exchange: 88 for YLs, 73 for OMs  

 
 

87. UA1DZ Memorial Cup 

The UA1DZ Memorial Cup can be used by St.-Petersburg and Leningrad region 
stations and DX stations.  

 Window: Select Log type  
o Log Type: DZCUP  
o Mode Category: Select mode used (CW, Mixed, SSB)  
o Sent Exchange:  

 For non-St.-Petersburg and Leningrad region stations: 001  
 For St.-Petersburg and Leningrad region stations: RDA 

(administrative area)  

 
 

88. UBA contest CW / SSB 

The UBA DX Contest can be configured for ON stations and DX stations.  

 Window: Select Log type  
o Log Type:  

 CW: UBACW  
 SSB: UBASSB  

o Mode Category: CW  
o Sent Exchange:  

 For non-ON stations:001  
 For ON stations: 001 + Your province Example: 001 OV  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are an ON station or a DX station.  

Log submitting for non Belgian stations:  

Before submitting your log look at this page  from Franki, ON5ZO  
 
The information tells how to update the category in the Cabrillo file so you are placed in 
the right category.  
The UBA contest manager approved and will accept the Cabrillo output made by N1MM 
Logger+.  

IMPORTANT NOTE quoted from the rules as found on the UBA website, regarding log 
submission:  

http://www.on5zo.be/2012/02/12/how-to-edit-your-cabrillo-for-the-uba-dx-contest/


Log submission info from UBA: The UBA likes to receive a Cabrillo file  

Special Setup for Belgian participants:  

How to include your province abbreviation in the Cabrillo output?  
This MUST be done for both SSB and CW contests! Go to Config > Change your 
Station Data > State field: fill in the abbreviation for your province (OV, VB etc). It is 
VERY IMPORTANT to do this, as it will determine what you have sent in the log 
(Cabrillo output), and it is needed by the UBA Contest Team. The official abbreviation (2 
letters) for the Belgian Provinces is to be found on the UBA site, under the rules for HF 
contests.  
Non-Belgian participants can leave this field 'as is', it is only used for Belgian contesters.  

How to send your province abbreviation after the serial number in CW?  
When you have selected to begin a new log for the UBA DX CW contest, you must 
change the F2 button message to send your province.  
This is done like this; go to: Config > Change Packet /CW/SSB/Digital Message buttons 
> Change CW buttons In the right column, second row, there is:<<<5nn>>>{EXCH} This 
means the incrementing serial number. Now you have to add your province 
abbreviation, preceded by a slash (/). It should look like this: <<<5nn >>>{EXCH}/OV or 
<<<5nn >>>{EXCH}/AN  

WARNING: Never change the '001' as the Sent Exchange value in the Select Log Type 
window, as the software will no longer send serial numbers!!!  

89. UBA ON contest 

The UBA ON Contests (4 in total) can be configured for ON stations and DX stations.  

 Window: Select Log type  
o Log Type: UBAON  
o Mode Category: Select mode used (CW, Mixed, SSB)  
o Sent Exchange:  

 For non-ON stations:001  
 For ON stations - Serial + Your UBA gewest Example: 001 AAA  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are an ON station or a DX station.  

90. UBA Spring 

The UBA Spring contest (4 in total) can be configured for ON stations and DX stations.  

 Window: Select Log type  
o Log Type: UBASPRING  
o Mode Category: Select mode used (CW, Mixed, SSB)  
o Sent Exchange:  

 For non-ON stations: 001  
 For ON stations - Serial + Your UBA gewest Example: 001 AAA  



 
The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are an ON station or a DX station.  

91. UBA Low Band Winter 

The UBA Low Band Winter contest (4 in total) can be configured for ON stations and DX 
stations.  

 Window: Select Log type  
o Log Type: UBAWINTER  
o Mode Category: Select mode used (CW, Mixed, SSB)  
o Sent Exchange:  

 For non-ON stations:001  
 For ON stations - Your UBA gewest Example: AAA  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are an ON station or a DX station.  

92. Ukrainian Championship 

The Ukrainian Championship is run on CW, SSB and RTTY.(for Ukrainian stations only)  

 Window: Select Log Type  
o Log Type: UKRCHCW, UKRCHSSB, UKRCHRTTY  
o Sent Exchange: two-letter district designator, plus serial number - e.g., KV 

001  

 
 

93. Ukrainian DX contest 

The Ukrainian DX contest can be configured for Ukrainian stations and non-Ukrainian 
stations.  

 Window: Select Log type  
o Log Type: UKRAINDX  
o Mode Category: MIXED  
o Sent Exchange:  

 Oblast for Ukrainian stations Example: CH  
 001 for non-Ukrainian stations  

 
Note: Countries are counted per band for SSB, CW and RTTY, because RTTY is in a 
separate contest module they won't be counted correct when a station makes next to 
SSB and CW also RTTY q's or the other way around...  



The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are an Ukrainian station or a non-Ukrainian station.  

94. UN DX Contest 

Kazakhstan Open Championship  

 Window: Select log type  
o Log Type: UNDX  
o Mode Category: Mixed  
o Sent Exchange:  

 District code for Kazakhstan stations Example: L17  
 001 for non-Kazakhstan stations  

 
 

95. Independence of Venezuela Contest 

 Window: Select Log type  
o Log Type: YV  
o Sent Exchange: 001  

 
The YV call areas are shown in the Multiplier window, choose the tab "Sect".  

96. WAEDC contest CW / SSB 

in-edit  

The WAEDC Contest can be configured for European stations and non-European 
stations.  

 Window: Select Log type  
o Log Type:  

 CW: WAECW  
 SSB: WAESSB  

o Sent Exchange: 001  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a European station or a non-European station.  

96.1. Introduction to WAE DX CW/SSB - based on an article originally written by Franki, ON5ZO 

WAE has something no other contest has, that you'll either love or hate - the exchange 
of information on past contacts in the contest, or QTC. Except in WAE RTTY, a QTC is 
a piece of traffic that can only be sent from stations outside EU to EU stations. EU 
stations will beg to get them. Why? Simply because for both sides each QTC is added 
to the QSO total. If N1MM makes a QSO with ON5ZO, then they both get 1 point for the 
QSO. If they decide to exchange 10 QTCs during this QSO, they each earn 11 points, 1 



QSO + 10 QTCs. If, after the contest, ON5ZO made 300 QSOs, during which he got 
500 QTCs, his total count will be 800, multiplied by the number of multipliers.  

Each QTC has three main parts - time, call and received serial number of a QSO from 
the DX (non-European) station's log. Suppose that N1MM logged ON5ZO at 0123UTC, 
and ON5ZO gave '012' as his serial number. Later in the contest, N1MM can send the 
QTC to 9A7P, for example.: He would send 0123 ON5ZO 012.  

The rules say that a DX station can only send a total of 10 QTCs to a EU station, and 
that previous QSOs with the receiving station cannot be included in the batch of QTCs 
sent. Each QSO can only be sent once as a QTC, so a DX station can never have more 
QTCs sent than QSOs logged. A EU station however, can have many more QTCs than 
QSOs, as each non-duplicate QSO can yield up to 10 QTCs.  

A DX station can choose to send 10 QTCs to a single recipient during a single QSO, or 
piecemeal. In addition, QTCs do not have to be exchanged only during a non-dupe 
QSO. Suppose that early in the contest, ON5ZO is running, and N1MM calls on 20m. 
They have a regular QSO and exchange serial numbers. ON5ZO asks 'QTC?' but 
N1MM wants to make some QSOs first, so he declines. Towards the end of the contest, 
N1MM is running on 20m and ON5ZO finds him, ON5ZO sees that N1MM is a dupe 
because they QSO'd at the beginning of the contest. However, they didn't pass QTCs, 
so ON5ZO asks 'QTC? de ON5ZO'. N1MM sees that they have worked but indeed: 
there were no QTCs sent then, and N1MM is now eager to send 10 of his QSOs as 
QTCs. They do it, and both go away happy. The second QSO doesn't count, of course, 
but the QTCs do.  

Each set of QTCs must be numbered. The sending station initiates the series of QTCs 
with a "batch" number like 'QTC 11/10', which means that it is the 11th batch sent by the 
DX station, and there will be 10 QTCs in the batch.  

All this sounds terribly complicated, doesn't it?. Fortunately, N1MM Logger takes care of 
all the clerical work. Let's look at how it works in detail, starting with  

96.2. WAE from Europe (ON5ZO as an example) 

in-edit  

XXXSubject to change as code developsXXX  

After completing the QSO, where both stations exchange serial numbers, ON5ZO goes 
into QTC mode by pressing Ctrl+Z. In CW, the program can be set up so that this 
triggers the program to send 'QTC?' to ask the other station if he wants to send QTCs. 
This is controlled by a menu option "Config > WAE > Ctrl+Z sends QTC? automatically 
(EU stations, Run mode only)". In SSB, he might uncheck this option and ask the other 
station "Do you have QTCs for me?" before pressing Ctrl+Z. Either way, pressing Ctrl+Z 
opens a Receive QTC window like the one below:  



 

The cursor starts in the QTC header field, and ON5ZO logs the QTC batch number sent 
by the other station, such as '12/10'. If he only types the batch number without the 
forward slash and count, the program will assume the count is 10. ON5ZO then hits 
Space, which sends QRV in CW and moves the cursor to the first QTC window. In SSB 
he would have to tell the other station he is ready by using the microphone. Each time 
he copies a part of the QTC, he presses Space to move into the next box. If he doesn't 
copy the QTC, in CW he can click on the numbered "Agn" button for that QTC to ask 
the other station to send it again. When the QTC is received and logged, he presses 
Enter or clicks on the "Cfm" button and the program logs the QTC and in CW, sends a 
confirming 'R' (or whatever has been configured using the "Config > WAE > WAE 
Received QTC Confirmation" menu item), so that the other station knows ON5ZO got it 
OK and he can start transmitting the next QTC.  



 

When the series of QTCs is copied, ON5ZO presses the Exit button, the program sends 
a TU message and closes the QTC window, returning to normal QSO mode.  

Sometimes when conditions are poor or deteriorating or QRM is getting heavier, it is not 
possible to complete a batch of QTCs. If you want to start the batch over again, you can 
use the Clear button to clear the window and start fresh. Or, if you click on the Cancel 
button or press the Esc key, the QTC process is aborted. Note that both Clear and 
Cancel leave any QTCs that have already been logged still in the log. Depending on the 
circumstances, you can either leave those QTCs in the log, or if necessary (for 
example, if you start over and find you have duplicated some QTCs in the log) you can 
delete individual QTCs in the Log window.  

You can use Alt+W to wipe the current line, or Ctrl+Q to place the Entry window into 
Quick Edit mode to edit a QSO or QTC. Normally the program will prevent you from 
logging an invalid QTC (non-number in the time or serial number fields, or an invalid call 
sign). Whenever the Agn button is highlighted, you can override this validity checking 
and force-log the QTC using Alt+Enter, Alt+Space or Alt+Tab.  

Sometimes the number of QTCs in the header was miscopied, and the number of QTCs 
actually received is smaller or larger than the number originally expected. You can use 
Ctrl+A to remove the last blank line from the QTC window and reduce the count in the 
QTC header (and in logged QTCs in that batch) by 1. Or, you can use Alt+A to add a 
new blank line and increase the count in the header and the log (up to a maximum of 
10).  



Note: Sometimes DX stations don't repeat the two digits representing the hour in the 
time part of the QTC. They just send the minutes, because the hour is the same for a 
bunch of QSOs. For example, the DX station might send '1134' for the time of the first 
QTC, but then send 35 and 36 for the next two.  

When copying QTCs at 36 wpm or faster, you don't have the time to do anything but 
type what you copy. If you copy two numbers, and the next character is a letter, you 
usually know you need to press Space and begin typing the callsign. N1MM Logger will 
automatically add the two hour digits to your log. This doesn't work so well with number 
prefixes like 5B or 4Z unless the sending station is careful with his spacing, and we'd 
welcome suggestions on a better approach.  

The QTC process works in either Run or S&P mode. The same keystroke, Ctrl+Z, turns 
it on and off (in case you need to abort QTC mode).  

96.3. WAE from the DX (non-Europe) side 

 
The process is even easier from the non-European (DX) side. If you want to send 
QTCs, you simply press Ctrl+Z. If you've forgotten to log the QSO first, Ctrl+Z will do it 
for you. A pop-up window opens, asking you how many QTCs you want to send to the 
EU station:  

 

The pop-up defaults to the maximum number you can send that station, but if you want 
to send fewer, you can just type in the new number over the old one. When you exit 
from the pop-up by hitting Enter or pressing OK, the QTC header is sent to the other 
station, and a QTC window opens up, populated with all the information you need to 
send:  



 

Once the other station indicates he's ready, usually with 'QRV' in CW, you can press 
Enter to send each QTC in turn, waiting for the other station to acknowledge after each 
QTC. The following screen shot shows the window after the 5th QTC has been sent - 
note that the highlight is on the "Snd 6" button, because that is the one that will be sent 
if you press Enter at this point:  



 
If he asks for a repeat, you can press the = key, or you can click on the "Snd" button for 
the previous QTC, i.e. the one that was not yet received and acknowledged. If he asks 
for a repeat of only part of the QTC, you can right-click on one of the three parts to re-
send it, or you can press the 1, 2 or 3 keys to re-send just the time, call sign or serial 
number respectively. Once all of the QTCs have been sent and the European station 
acknowledges the QTC batch, you click on the Exit button to end the batch and log the 
sent QTCs. The Clear and Cancel buttons work the same way as for a station in EU.  

 

96.4. Both sides 

After you enter the callsign of the other station in the entry window, a new line in red 
type will appear below the buttons in the Entry Window to tell you the QTC status.  



 

This line will appear regardless of whether you have worked the station yet or not. The 
left-most number tells you how many QTCs you have already exchanged with that 
station. The next number tells you how many QTCs you still have available to send to 
that station (up to the maximum of 10), and the last number tells you the total number of 
unsent QTCs in your log.  

The Entry Window and the Bandmap window contain visual cues about the QTC status 
of stations spotted in the bandmap. A special color scheme for spotted call signs has 
been implemented, as follows (colors are configurable - these are the defaults):  
RED: the station is a new multiplier on this band (single multiplier color, the same as in 
other contests)  
GREEN: this is a new station on this band, and you can also exchange QTCs with him 
(you have not yet exchanged 10 QTCs with this station) (in other contests, this is the 
double multiplier color, but there are no double mults in WAE)  
BLUE: this is a new station on this band, but you have no more QTC's available that can 
be exchanged with this station (you have already exchanged 10 QTCs, or else you are 
both EU stations or both DX stations, so you cannot exchange QTCs) (normal QSO 
color in other contests)  
BLACK: this station is a dupe on this band, but you still could exchange QTCs with him 
for QTC points (this color is the "Color of a QTC callsign in the WAE contest" color in 
the Manage Skins, Colors and Fonts window)  
GREY: dupe, and there are no QTC that can be exchanged - this station is non-
workable for any kind of credit, so just pass him by (the same as in other contests)  

 
 

97. WAG contest 

The WAG contest is for German stations and non German stations.  



 Window: Select Log type  
o Log Type: WAG  
o Sent Exchange:  

 non-DL stations: 001  
 DL stations:  

 DARC member:DOK (example: V11)  
 non-DARC member:001  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a German station or a non-German station.  

Non DL stations may only give a number.  
DL stations give a DOK (DARC members) or a number (non DARC members)  
For stations not giving an exchange put 000 in the exchange field  

- minimal DOK length is 2  
- 0 is allowed to be entered  

Note: When updating a DOK in the log window you have to update not only the 
Exchange but also the Section by hand....only when the qso is in the Entry window the 
program strips the Section (V) from the Exchange (V11) automatically.  
 

98. World Wide Iron Ham Contest 

 Window: Select Log type  
o Log Type: WWIH  
o Sent Exchange: RS/RST and CQ Zone  

Note: The contest allows CW, SSB and RTTY, but there are specific limitations on how 
often a station may change modes. See the rules for complete details.  

99. World Wide Peace Messenger Contest 

The Peace Messenger Contest can be configured for Peace Messenger Contest 
stations and non Peace Messengerstations  

 Window: Select Log type  
o Log Type: WWPMC  
o Mode Category: CW, SSB or Mixed  
o Sent Exchange PMC station: 001 PMC abbreviation Example: 001 ABI  
o Sent Exchange non PMC station: 001 NON Example: 001 NON  

 
 

100. WRTC contest 



The World Radiosport Team Championship (WRTC) contest is fully supported for use 
by on-site participant teams  

 Window: Select Log type  
o Log Type: WRTC  
o Sent Exchange: 001 i.e Serialnumber Example: 001  

 
The WRTC follows the rules for the WPX contest (please check above) with some 
additional WRTC specific changes below.  

 Check Partial is disabled from master.scp for this contest only.  

 
 

101. YO HF DX contest 

The YO HF DX contest can be used by Romanian stations and non Romanian stations.  

 Window: Select Log type  
o Log Type: YOHFDX  
o Sent Exchange:  

 non-YO stations: 001  
 YO stations: Romanian county abbreviation (two letters) Example: 

AR  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a Romanian station or a non-Romanian station.  

 

2.1.5.3 Setup QSO Parties - CW and SSB 

old-edit  

XXX Screen shots and text on this page are from Classic. Needs new screen shots, 
needs to be verified against the new code XXX  

 2.1.5.3 Setup QSO Parties - CW and SSB  

o 1. Same weekend: 7QP, Indiana QSO Party, New England QSO Party  
o 2. Same weekend: NE, ND, and SD QSO Party 2013  
o 3. FL QSO party  
o 4. PA QSO party  
o 5. MARAC QSO Party  
o 6. Modifying and importing the QSO party county abbreviations  
o 7. Rover, Mobile, and County Line Support  



 7.1. Rover/Mobile Operation  
 7.2. QSO Party County Line Operation  

 Logging QSO Party County Line Stations  
 Operating From a County Line  

The program supports many US and Canadian QSO parties. Depending on the 
complexity of the rules, there may be minor scoring anomalies.  

 It is very important for proper operation of the program in QSO parties that the 
program "know" whether you are an in-area (state or province) or out-of-area 
participant. All QSO parties require different program operation and scoring rules 
for in-area and out-of-area participants.  

 
The program determines which you are from the ARRL Section that you have entered in 
the Station Data dialog (under the Config menu). When creating a new log for a QSO 
party, a message box will inform you whether the program thinks you are an in-state, or 
out-of-state participant, based on your ARRL section, so that you can correct things if 
anything is wrong.  

Non-US/VE stations should enter "DX" in the ARRL SECTION field. If you enter an 
ARRL section with a non-US/VE callsign, you will be warned to correct your Station 
Data before continuing.  

Effective with version 13.4.2, N1MM Logger offers greatly enhanced support for 
county-line operations, whether you are the in-state Rover on a county line or an 
out-of-state station wanting an easy way to log a QSO with a county-line rover. 
Full details are in the Mobile/Rover Support section below.  

 Window: Select Log type  
o Log Type: QSOPARTY  

 After selecting QSO Party, a list box shows up in the right-hand part 
of the contest selection dialog box, with buttons below it for 
importing and editing the section list. Click on the down arrow to 
choose the QSO Party you want (example image shows Hawaii HI) 
. When in doubt, do the import, to make sure you pick up any 
changes in the official abbreviations since the last running.  

 Example: The entry in the list of QSO Parties for the New England 
QSO Party is "NEWE" ("NE" is for the Nebraska QSO Party). Most 
of the entries in this list are states or provinces, except for the 
NEWE (New England) and MAQP (Mid-Atlantic) entries.  



 
 
 

o Mode Category: MIXED  
o Sent Exchange:  

 The exchange depends on the QSO party. Most use county for in-
area participants and state for those out of the area. Some use 
serial numbers as well.  

 Inside the selected State/Province - See contest instructions  
 Outside the selected State/Province - See contest instructions  
 if you need to send a serial number, enter 001 and the abbreviation 

for your location in the Sent Exchange field, to automatically 
increment the serial number for each QSO.  

 QSO Party Bonus Station Support - A few state QSO parties have "bonus 
stations", which you can work for extra point credit. When the state party has 
bonus station(s), the program will display the bonus station callsign list on 
program start and upon exiting the contest dialog.  

 

 

This list of bonus stations can be modified by the user by entering the command 
BONUS + Enter in the Entry Window callsign box.This will pop up a window where you 
can enter a revised list.  

Each callsign, and each variation (CALL, CALL/M, CALL/CTY) must be on the list in 
order to get credit for the bonus station(s).  

Note: The program does not store bonus station callsign changes, so if there are 
changes, you will need to re-enter the complete list each time you re-start the program 
or change logs to that QSO party. You can't simply enter the changes.  

To view the QSO's logged, enter the bonus station callsign in the Entry window and look 
at the lower portion of the Log window. To view the number of bonus stations counted in 
the score, export the Score Summary to a file.  



× Help Keep Your Favorite QSO Party up to DateYou can help keep N1MM Logger up 
to date for your favorite QSO Party by notifying the N1MM team of and changes in 
scoring, bonus stations, etc. Just post the changes in the N1MM Reflector, or send a 
Feature Request. Obviously, earlier is better. 

 Simple Call History Procedure - The steps for generating a Call History file from a 
previous QSO party are as follows:  

o Using program version 12.09.02 or newer.  
o Open last years QSO party contest log.  
o Click Tools, Clear Call History then Update with Current Log  
o Click File, Export Call History and export the data into a file.  
o Using NotePad add any new stations to the end of this file. The UserText 

field will allow you to make personal notes for specific callsigns. This 
display line appears below the Bearing information line. Make the height of 
the Entry Window taller to enable the display of this information.  

o Open the new QSO party contest log for the current year. Associating the 
saved call history file with this state party is possible using the Associated 
Files tab. Alternately, click on File, Import Call History after the contest is 
open.  

o Click on Config and place a checkmark in front of Call History Lookup.  

o The call history data is stored in the database. If you open a different 
contest and have Call History Lookup enabled, the program will use this 
data. So uncheck this option after the contest.  

o Users can combine exported call history files from several years. The 
recommended editor is NotePad. Some editors place non-ACSII 
characters in the file and this will cause import issues. Place the oldest 
contest at the top of the merged file. The import routine will merge the 
data and deal with duplicate entries. You can look at the result by 
exporting the call history and viewing it with NotePad.  

 
 

1. Same weekend: 7QP, Indiana QSO Party, New England QSO Party 

Three QSO parties - the 7QP (7th Call Area QSO Party), Indiana QSO Party, and New 
England QSO Party - are all on the same weekend. Since 2010, the program software 
allows users to log stations active in all three QSO parties and automatically determine 
the state multiplier from the received exchange (other contest county exchange). Log 
the exact exchange that is received and send the same Cabrillo output to all three 
contest sponsors. If you are an "in-state" user of one of these QSO parties, select the 
appropriate state party option in the QSO party contest selector. If you are "out-of-state" 
for all contests this weekend, select the IN7QPNE option in the dropdown state selector. 
The instructions are the same, log the exchange that you receive and send the same 



Cabrillo file without editing to all three sponsors. All sponsors re-calculate the score of 
all submissions.  

N1MM supports the 7QP shorthand county exchanges (e.g.,"ORDES/JEF" or 
"IDFRA/UTCAC") and will log one QSO for each valid exchange. Do not edit the QSO 
and force the exchange to be of the form: "ORDES/JEF". This will cause database 
errors and the program will not be able to score or rescore correctly.  

2. Same weekend: NE, ND, and SD QSO Party 2013 

For 2013 the ND, NE, and SD QSO Parties are held the same weekend but there are 
identical county abbreviations. After this is resolved and the sponsors accept combined 
logs and rescore, a combined QSO Party contest will be considered.  

3. FL QSO party 

For in-state users, the software automatically counts the first FL QSO as the FL 
multiplier.  

4. PA QSO party 

For in-state stations, the first EPA and WPA county worked will count both the county 
and the section multiplier in the score. Likewise, the first DXCC station worked counts 
as the single DX multiplier. See the information in the general section above for working 
bonus stations and county line stations. It it not necessary to include a Dupe Sheet with 
the contest submission when N1MM Logger is used for the PA QSO Party logging.  

5. MARAC QSO Party 

Sponsored by MARAC and also known as the U.S.Counties QSO Party. This QSO 
party has 3077 US county multipliers. Because of the screen area required, it is not 
recommended to display the counties in the Multiplier window. See the MARAC website 
for the county abbreviations.  

6. Modifying and importing the QSO party county abbreviations 

It is not expected that users will need to manually update or edit the county abbreviation 
list. It is easy to make a change that will effect the program operation or eliminate 
secondary information stored in other database fields during QSO logging. This is 
expecially true for the 7QP, IN, IN7QPNE, NEWE, and PA QSO parties. Please report 
any changes made by the QSO party sponsors to the development team several weeks 
prior to the contest.  

The county abbreviations stored in the database can be editted by opening the contest 
dialog (File, Open Log in Database) and select 'Edit Section List'. A sample edit window 
is shown below. The modification will remain in the current database until the 
developers make a change to any QSO party county abbreviation.  



 
 
 
To revert back to the original county and state abbreviation list provided by the 
developers, manually import the original files into the database with this procedure. 
Open the contest dialog (File, Open Log in Database) and select 'Import Section List'. It 
is not recommended that the user edit the state and county files provided by the 
developers.  

7. Rover, Mobile, and County Line Support 

N1MM Logger supports Rover/Mobile and County Line operation and for QSO party 
contests, the software contains features allowing the home station to quickly log the 
County Line station.  

7.1. Rover/Mobile Operation 

N1MM logger supports Rover or Mobile operation in the ARRL VHF contests and all 
QSO parties. It gives a Rover entrant a quick, easy way of changing counties, re-
programming F-key messages in one step, and produce a single composite log for the 
entire event.  

Rover mode is enabled when one of these selections is made in the Contest Setup 
dialog: Operator Category = Rover or Station Category = Rover, Mobile, Expedition. 
The option that appears in the Contest Setup dialog will depend on the Cabrillo version 
requested by the sponsor. When Rover mode is enabled, the Entry Window title bar will 
include the RoverQTH as shown in the snapshot below.  



 

The operating location or RoverQTH can be set:  

 in the Station Data window, RoverQTH box. This box will automatically update 
when you use any of the other methods of setting RoverQTH below.  

 by right clicking on the county or grid in the Multiplier window and selecting "Set 
RoverQTH"  

 by typing CTRL+H  
 or by typing ROVERQTH in the Entry Window callsign box and pressing Enter. 

This opens a window to input the county designator, typically 3 or 4 characters.  

 
If the RoverQTH is typed when a QSO party is selected, one of the approved county 
abbreviations must be entered. When the RoverQTH is changed, the Entry Window title 
bar is updated and the Station Data, RoverQTH box is updated. This saves the 
RoverQTH for program restart.  

The {ROVERQTH} macro, when placed in your F-key messages will alway send the 
current RoverQTH string. If, for example, your F2 key is defined as 
"5NN{ROVERQTH}", the macro will substitute the RoverQTH operating location in place 
of {ROVERQTH}. The operating location will also appear in the Log window for each 
QSO. If the {COUNTYLINE} macro (explained below) is included in the F-key message 
it will be ignored when the program is in rover mode. This allows a station to operate as 
a rover and county line station during the same QSO party without editing the F-key 
messages.  

RoverQTH can be 10 characters long but most Cabrillo output is limited to five or six 
characters.  

When a new ROVERQTH is set in the Entry window, the program checks with the list of 
accepted county designators for the current QSO party. If for some reason an unlisted 
county designator is required, it can be entered in the RoverQTH Field of your Station 
Data page.  

7.2. QSO Party County Line Operation 



County line operation is popular with in-state operators in QSO parties because you can 
give out more than one county designator from a single location. The out-of-state 
operators receive two or more counties - often rare ones - in a single QSO, and earn 
multiplier credit for each county. If the QSO party exchanges serial numbers, be sure to 
read the QSO party rules to determine if the county line QSO's need to be logged with 
incrementing serial numbers.  

Logging QSO Party County Line Stations  
Regardless of whether you are an in-state or out-of-state participant, if you work a 
county-line station, simply log it using the DAD/JEF/WAL format in the Exchange field. 
Separate QSOs will appear in your log, one for each county.  

If the QSO party exchanges serial numbers, the same received serial number will be 
used when logging the separate QSO's. If the sending station sends a different serial 
number for each QSO you can Quick Edit the QSO and change the received serial 
number. It is also acceptable to manually log indivdual QSO's without the compound 
exchange (DAD/JEF/WAL) entry.  

A limitation of county line logging with the multiple county exchange is that the 'same 
callsign' can not be logged again on any band or mode until the computer clock 
advances beyond the time stamp of the last logged QSO. This will unlikely be an issue 
for the home station.  

Operating From a County Line  
Begin by selecting Operator Category = Rover or Station Category = Rover, Mobile, 
Expedition in the Contest Setup dialog. The county line mode is enabled by entering the 
word COUNTYLINE (note, no space) in the callsign field of the Entry window and 
pressing Enter. A pop-up box will appear, asking you to enter the county abbreviations, 
separated by commas. If the QSO party exchanges serial numbers, a prompt will 
appear asking if the serial numbers of the subsequent logged QSO's should be 
incremented. The answer to this is dependent on the QSO party rules. The simplest 
operation for everyone involved is no incrementing serial numbers for county line QSOs. 
There is additional information about the selection to increment serial numbers below 
but when the entry is complete, the counties will appear in the title bar of the Entry 
window so you can be sure they will be right in the log.  

 



You must enter the standard abbreviations specified by the contest sponsors. If you 
can't remember, Windows > Multipliers > Other selection will display a complete list for 
the current QSO party. Unlike your RoverQTH, which becomes part of your Station Data 
page, in County Line mode you will need to re-enter the string of counties if you restart 
the program.  

 

The use of stored messages, for CW or digital modes is simplified with the use of the 
{COUNTYLINE} macro which sends the string of counties seperated with a "/" 
character. Simply use the {COUNTYLINE} macro in place of the {EXCH} macro 
normally used in Run F2 and S&P F2. If the {ROVERQTH} macro (explained above) is 
included in the F-key message it will be ignored when the program is in county line 
mode. This allows a station to operate as a rover and county line station during the 



same QSO party without editing the F-key messages.  

 

Now you're ready to go. Each time you work a station from a county line, the program 
will transmit all the county abbreviations you have entered, separated by a "/" - in this 
example, "DAD/JEF/WAL". It will also enter a QSO in the log for each county line county 
listed under the Rover QTH column in the Log window. A Log window example is shown 
below operating from the DAD/JEF/WAL county line. Three stations were logged W1AW 
- CT, W4ZZ-BAK, and another county line station W4AAA at LEO/PAS/WAL producing 



15 logged contacts.  

 

If you work a county-line station, you log it by simply by entering the received county 
abbreviations separated by a "/", as explained in the next section below. The logged 
result will be separate logged QSOs, one for each county combination.  

If incrementing sent serial numbers was selected when entering the county line 
counties, the following information is important. The program uses a serial number 
reservation system to insure that serial number does not change after it is reserved by a 
VFO, radio, or multi-user station. If a county line station chooses incrementing serial 
numbers and reserves a serial number on more than one VFO, radio, or multI-user 
station at the same time, the logged county line serial numbers will not be in sequential 
order. If the QSO party sponsor requires incrementing county line serial numbers and 
that they be in sequential order, the county line operation will be limited to one station, 
radio, and VFO. Contact the QSO party sponsor for the expectations of the sent and 
received county line QSO serial numbers.  

One limitation of county line logging is that the 'same callsign' can not be logged again 
on any band or mode until the computer clock advances beyond the time stamp of the 
last logged QSO. This will only be a concern when moving a station to another band or 
mode, operating from more than two county lines, and working another county line 
station.  

 



2.1.5.4 Setup VHF and Up Contests - CW and SSB 

old-edit  

 2.1.5.4 Setup VHF and Up Contests - CW and SSB  

o 1. ARRL August UHF Contest  
o 2. ARRL January VHF Sweepstakes  
o 3. ARRL June VHF QSO Party  
o 4. ARRL September VHF QSO Party  
o 5. CQ WW VHF Contest  
o 6. IARU Region 1 contesting - 50 MHz, VHF, UHF/Microwaves  
o 7. Marconi CW contest  
o 8. NAC Activity Contest  
o 9. REF Departments contest 50 Mhz  
o 10. VHF/UHF Helvetia 26 contest  
o 11. VHF HG OB contest  
o 12. VHF UA1DZ Cup  
o 13. VRZA - Nederlandse Locator Contest - WANLC  
o 14. YU DX Contest  
o 15. UKSMG sporadic-E competition  

In VHF and up contest it is the norm to give accurate signal reports. Use the Tab to go 
from the callsign filed to the signal report fields. You will note that it highlights the 
strength to allow quick modification of that.  

× FeatureWhen a grid is entered but no call, all QSOs with that grid will show in the 
lower part of log window 

 
 

1. ARRL August UHF Contest 

 Window: Select Log type  
o Log Type: ARRLUHFAUG  
o Sent Exchange: Your four character grid Example: JO33  

 
Exchange of signal report is optional. Foreign stations work W/VE amateurs only. 
 
Stations can be logged more than once from a different grid without being a dupe (for 
Rover stations). 
 
Dupe check on first 4 characters of grid. 
 
The score for Rover stations is not being calculated by the program!  

2. ARRL January VHF Sweepstakes 



 Window: Select Log type  
o Log Type: ARRLVHFJAN  
o Sent Exchange: Your four character grid Example: JO33  

 
Exchange of signal report is optional. Foreign stations work W/VE amateurs only. 
 
Stations can be logged more than once from a different grid without being a dupe (for 
Rover stations). 
 
Dupe check on first 4 characters of grid. 
 
The score for Rover stations is not being calculated by the program!  

3. ARRL June VHF QSO Party 

 Window: Select Log type  
o Log Type: ARRLVHFJUN  
o Sent Exchange: Your four character grid Example: JO33  

 
Exchange of signal report is optional. Foreign stations work W/VE amateurs only. 
 
Stations can be logged more than once from a different grid without being a dupe (for 
Rover stations). 
 
Dupe check on first 4 characters of grid. 
 
The score for Rover stations is not being calculated by the program!  

4. ARRL September VHF QSO Party 

 Window: Select Log type  
o Log Type: ARRLVHFSEP  
o Sent Exchange: Your four character grid Example: JO33  

 
Exchange of signal report is optional. Foreign stations work W/VE amateurs only. 
 
Stations can be logged more than once from a different grid without being a dupe (for 
Rover stations). 
 
Dupe check on first 4 characters of grid. 
 
The score for Rover stations is not being calculated by the program!  

5. CQ WW VHF Contest 



 Window: Select Log type  
o Log Type: CQWWVHF  
o Sent Exchange: Your four character grid Example: JO33  

 
Exchange of signal report is optional. 
 
Rover stations can be logged more than once from a different grid without being a dupe. 
 
Dupe check on first 4 characters of grid. 
 
The score for Rover stations is not calculated by the program.  

 Starting with program version 11.07.02, a Reverse Call History Lookup feature 
has been implemented for this contest  

o If Call History Lookup is enabled, and a Call History file containing grid 
squares has been loaded, then when a grid square or partial grid square 
(at least two characters) is entered into the exchange field and there is no 
call sign in the call sign field, the Check window will display all call signs in 
the Call History file with that same grid square  

o The call signs are entered in magenta color, and can be clicked on with 
the mouse to transfer one of them to the call sign window  

o If there is a partial call sign in the call sign field, possibly using wild cards 
for missing characters, the list of call signs displayed will be limited to 
those matching the partial call sign  

 
 
 

6. IARU Region 1 contesting - 50 MHz, VHF, UHF/Microwaves 

Region 1 contesting uses a serial number and gridsquare as exchange. The points per 
qso is the calculated distance between your sent gridsquare and the received 
gridsquare.  

 Station Information ('Config | Change Your Station data')  
o Grid Square: <gridsquare> Example: JO33fd  

 This grid square is used in calculating the distance between the 
stations (and is part of the exchange)  

 Window: Select Log type ('File | Choose Which Contest to Log')  
o Log Type: VHFREG1  
o Sent Exchange: 001 <gridsquare>  

 Example: 001 JO33fd  
 The sent exchange is not used by this specific contest otherwise 

the use in the macros for the function keys.  



 
This contest type has the possibility to use the CallHist table in which information can be 
stored which can be easy to have during a qso like name and gridsquares used in 
previous contests. This specific contest type uses the Name, Locator1 and Locator2 
fields from the CallHist table. Entering any information in this table is not necessary for 
the contest module to work but can be very handy. For this to work information has to 
be imported in the Call History table ('File | Import | Import Call History'), also this 
feature has to be enabled to work ('Config | Call History Lookup').  

 When a callsign is entered and the SPACE or TAB key is pressed the program 
will check next to the normal things like dupe check the following:  

o Check the log if the callsign is known and if already worked the gridsquare 
is entered from the log in the Entry Window grid square exchange field.  

o If not found in the log file it will check the CallHist table. If the callsign is 
found it will place the content from Locator1 in the Entry Window grid 
square exchange field. The callsign is 'normalized' before searching in the 
CallHist table which means that /P, /A, /2 etc. will be removed before 
searching. Information in the CallHist table should be in its normalized 
form.  

 Information from the CallHist table i.e. Locator1, Locator2 and the name field will 
be shown below the function keys.  

 Normally this feature is not turned on (it gives a very short delay while searching 
the table), to turn it on select:'Config | Call History Lookup'  

 Note: Any information already typed in the grid square exchange will not be 
overwritten by the log file or CallHist table search. So first entering a grid square 
and afterwards a callsign is possible without overwriting the already entered grid 
square information. A callsign already worked will be shown in the bottom pane 
of the log window and marked with the dupe message. If the station is not 
worked before and is present in the CallHist table, this information will always be 
shown below the function keys.  

 More information about importing information in the CallHist table can be found in 
chapter VHF and Up contesting. A zip file with an import file for the 'Call history' 
lookup function and a ready master file with known calls can be downloaded from 
the N1MM website, select 'Other Files' under 'Downloads'. Don't forget to turn on 
the lookup function under 'Config | Call History Lookup'  

 More information about VHF related contesting and features can be found in 
chapter VHF and Up contesting  

 
A QSO can not be entered when 

 The serial number is missing  
o Warning: "Missing Serial Number!"  

 The grid length is not 6  
o Warning: - "6 character grid required!"  

 The grid format is not correct.  



o Warning: - "Wrong format grid. Format = AA##AA"  

 
These checks will (only) be done: when trying to log the qso (mostly by pressing Enter)  

How VHFREG1 looks for a known grid square 

 Look in the log if the station has been worked before (on any band)  
o If found show the grid and calculate distance and bearing  

 If not found look for the call sign in the 'call history' table including any /P /3 etc 
when applicable.  

o If found show the grid and calculate distance and bearing  
 If not found look for the call sign in the 'call history' table with the /P /3 etc 

removed (normalized callsign)  
o If found show the grid and calculate distance and bearing  

 If not found add the 'big grid' from the country when known by VHFREG1  
o If found show 'big grid' (no calculations done)  
o If not show nothing in grid square field  

 The check will (only) be done: When space is pressed and the cursor is in 
Callsign field  

 
Bearing and distance calculations 

 When space is pressed and the cursor is in Callsign field  
 When trying to log the qso (mostly by pressing Enter)  
 The grid square length has to be 4 or 6 digits.  
 Bearing info is shown in the log window and saved in the Misc field.  
 Distance info is shown in km in the log window and saved in the Points field.  
 Use Rescore to have the bearing and distance (re)calculated.  

 
Check Grid with country 

 When a grid is entered the program will check if the 'big grid' is a possible grid for 
the entered callsign.  

o Example: A Dutch station is always in JO.  
 When the callsign is entered with /MM the check will not be done.  
 The check will (only) be done:  

o When space is pressed and the cursor is in Callsign field  
o When trying to log the qso (mostly by pressing Enter)  

 
Add 'big grid' to 4 digit grid (if last 4 digits entered) 



 When a 4 digit grid is entered the program checks if these are the last four 
characters from a 6 digit grid. If so it will add the 'big grid' from the country (for a 
Dutch station it will add JO).  

 The check will (only) be done:  
o When space is pressed and the cursor is in Callsign field  
o When trying to log the qso (mostly by pressing Enter)  

 
Add 'big grid' when no grid is found (from log or 'call history' table) 
 
When a station is entered in the callsign pressing SPACE will search the 'call history' 
table. When the entered callsign is not found the program will try to add the 'big grid' 
who belongs to that country. If more grids are possible it uses the grid which occupies 
the most space in the country (IO in England) or is the easiest workable grid from 
Western Europe (JP for Norway, most south grid. The Netherlands will always give JO 
because this is the only grid possible for PA.  

 The check will (only) be done:  
o When space is pressed and the cursor is in Callsign field  

 
For DL stations: The German contest manager hat informiert dass er die 
Logeinsendungen von N1MM gerne akzeptiert. Wie immer akzeptiert er den 
postalischen Versand des Logs, jedoch auch Email ist möglich, lediglich müssen die 
Daten druckfähig sein.  
Vorab also einige Hinweis:  

1. Jedes Log muß mit dem Generic-File-Output als TXT-Format sortiert nach Zeit 
abgespeichert werden und als Bezeichnung "CALLBAND.TXT" lauten. Also 
DH5HV2m.txt zum Beispiel für einen Contest unter DH5HV auf 2m.  

2. Bei der Einsendung mehrerer Bänder sollte man diesbezüglich den Generic-File 
erstellen mit "sorted by Band" und dann mit einem Editor kurz bearbeiten, sodass 
man als Beispiel eine 2m-Datei, eine 70cm-Datei, eine 23cm-Datei, etc. hat. 
Auch hier natürlich dann DH5HV2m.txt und DH5HV70cm.txt und DH5HV23cm.txt 
erstellen bzw. benennen.  

3. Und wie bisher auch üblich wird für jedes Band ein seperates Deckblatt benötigt, 
was nur komplett ausgefüllt gewertet werden kann. Man findet dies unter 
http://www.darc.de/referate/ukw-funksport/index.html  ganz unten als PDF- 
oder DOC-File.  

7. Marconi CW contest 

The Marconi CW contest is CW only. For settings see the VHF Region 1 contest.  

 Window: Select Log type  
o Select: Log Type: VHFREG1  

http://www.darc.de/referate/ukw-funksport/index.html
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+VHF+Contests+-+CW+and+SSB&structure=N1MM+Logger+Documentation#IARU_Region_1_contesting_-_50_MHz_VHF_UHF_Microwaves


 
 

8. NAC Activity Contest 

As there is no serial number needed in the NAC contest exchange serial numbers are 
not shown and not added to the EDI output (opposed to VHFREG1).  
In the EDI output the scoring, bonus and multipliers are calculated. The grid locator from 
the station information is used in the calculations. Also the antennas, heights etc. are 
taken from this dialog.  
For more settings and possibilities see the VHF Region 1 contest.  

 Window: Select Log type  
o Select: Log Type: VHFNAC  
o Sent Exchange: Nothing specific needed but the 6 digit grid would be fine 

to used it in the Sent Exchange macros.  

 
 

9. REF Departments contest 50 Mhz 

 Window: Select Log type  
o Log Type: DDFM50  
o Sent Exchange: Serial Number + Your four character grid Example: 001 

JO33  

 
 

10. VHF/UHF Helvetia 26 contest 

 Window: Select Log type  
o Log Type: VHFHELV26  
o Sent Exchange: 001  

 
Local Swiss VHF/UHF and up contest. Uses almost the same rules as VHFREG1 but 
with an added field for Swiss stations for exchanging Cantons which are also multipliers 
for the contest All features mentioned above for VHFREG1 can be used in this contest. 
Use in the Multiplier sheet the Sect tab to view the worked Cantons (select VHF and 
auto).  

11. VHF HG OB contest 

 Window: Select Log type  
o Log Type: VHFHGOB  
o Sent Exchange: 001  



 
Local Hungarian VHF contest. Uses almost the same rules as VHFREG1 but dupes per 
mode CW or FM/SSB (station may be worked twice per band). All features mentioned 
above for VHFREG1 can be used in this contest.  

12. VHF UA1DZ Cup 

 Window: Select Log type  
o Log Type: VHDZCUP  
o Sent Exchange: 001 gridsquare Example: 001 KO94BD  

 
Russian VHF contest. Exchange is RST + serial number + grid square.  

13. VRZA - Nederlandse Locator Contest - WANLC 

 Window: Select Log type  
o Log Type: REGIOVHF (is dus nu de WANLC contest)  
o Sent Exchange: 001  

 
Only for Dutch stations.  

Noot: Deze contest kent een aantal mogelijkheden om extra multipliers te halen middels 
een soort 'Rover' stations. Dit wordt niet ondersteund door het programma en deze 
stations worden een DUPE! Ofwel: De multipliers en punten voor /M en /P stations 
gewerkt voor een tweede keer worden NIET door het programma automatisch bepaald. 
Deze dupes dus WEL loggen en achteraf de score en multiplier aanpassen op 'generic 
log' en de 'summery sheet'.  

Cabrillo output wordt ondersteund (File, Export, Cabrillo).  

Voor stations in de secties B en J (Single Operator / Mixed mode)  
- Selecteer SINGLE-OP-ASSISTED (onder File, Choose Which Contest to Log, 
Operator Category) voor een doorlopende nummering over de banden heen!  

14. YU DX Contest 

 Window: Select Log Type  
o Log Type: YUDX  
o Sent Exchange: your ITU zone. (remember also to put RST in your 

exchange messages)  

 
 

15. UKSMG sporadic-E competition 

 Window: Select Log type  
o Log Type: UKSMG  



o Sent Exchange: Your four character grid Example: JO33  

 
Only the 6 meter band is shown in the Multiplier window.  
A 4 digit grid is required and 6 digit grid is allowed to enter.  

 

2.1.5.5 Setup Digital Contests - RTTY and PSK 

in-edit  

 2.1.5.5 Setup Digital Contests - RTTY and PSK  

o 1. ANARTS WW RTTY contest  
o 2. ANATOLIAN RTTY contest  
o 3. ARRL Rookie Roundup RTTY  
o 4. ARRL RTTY Roundup  
o 5. BARTG Spring RTTY contest  
o 6. BARTG RTTY Sprint contest  
o 7. BARTG Sprint75 RTTY contest  
o 8. CQ World Wide DX contest - RTTY  
o 9. CQ World Wide WPX contest - RTTY  
o 10. CIS contest - RTTY  
o 11. DL DX RTTY contest  
o 12. DMC RTTY contest  
o 13. DRCG Long Distance RTTY contest  
o 14. EA PSK31 contest  
o 15. EA RTTY contest  
o 16. EPC PSK63 QSO party  
o 17. EPC PSK World Wide DX contest  
o 18. EU PSK DX contest  
o 19. JARTS WW RTTY contest  
o 20. JT RTTY DX Contest  
o 21. Makrothen RTTY Contest  
o 22. Logbook of the World Contest - RTTY/Digital  
o 23. NA Sprint RTTY  
o 24. North American QSO Parties RTTY - NAQP  
o 25. OK DX RTTY Contest  
o 26. Quick PSK63 Contest  
o 27. Russian PSK DX Contest  
o 28. Russian DX RTTY contest  
o 29. Russian Cup RTTY contest  
o 30. SARTG New Year RTTY Contest  
o 31. SARTG WW RTTY Contest  
o 32. SCC RTTY Championship  
o 33. SP DX RTTY contest  



o 34. TARA Grid Dip contest  
o 35. TARA PSK Rumble  
o 36. TARA RTTY Melee  
o 37. TARA Skirmish  
o 38. Ukrainian DX Classic RTTY contest  
o 39. Ukrainian Open RTTY Contest  
o 40. Ukrainian RTTY contest  
o 41. Ukrainian DX DIGI Contest  
o 42. United Kingdom DX contest RTTY  
o 43. VOLTA RTTY Contest  
o 44. WAEDC RTTY contest  
o 45. XE RTTY Contest  

When doing RTTY and PSK contests always check the Mode tab in Configurer for 
correct settings!  

{TIME2} - how it works  

The time will be set if  

 You have a call sign in the Entry Window  
 The contents of the database field that holds the time is empty for that callsign, 

and one of the following conditions is met:  

 F2 is pressed or sent  
 Insert is pressed and the code that is run from the insert key sends the contents 

of the F2 macro  
 {TIME2} is contained in the macro string that is sent  

 
If you do not have a call in the Entry Window or the database field is not empty, the 
{TIME2} macro will be replaced by the Last Sent Time. So if you have not sent the time 
and you are trying the macro out you will see 0000 printed on the screen. But if 0512 
was the last time sent then that is what the {TIME2} macro will send. {TIME2} stays 
locked until the contact is logged or the callsign wiped.  

1. ANARTS WW RTTY contest 

The last running of this contest was in June 2009. It has been replaced by the DRCG 
Long Distance contest (DLDCRTTY).  

 Window: Select Log Type  
o Log Type: ANARTSRTTY  
o Sent Exchange: Zone Example: 14  

2. ANATOLIAN RTTY contest 

 Window: Select Log Type  



o Log Type: ANATOLRTTY  
o Sent Exchange: 001  

 
 

3. ARRL Rookie Roundup RTTY 

To create the Rookie Roundup log in your database:  
Select >File >New log in database  

 Window: Select Log Type  
o Log Type: RRRTTY  
o Sent Exchange: <your name> space <two digit year licensed> space <US 

state/Canadian province/Mexican call area> or "DX"  
 Examples:  

 JOHN 68 OH (non-rookie station, John, licensed in 1968, 
from Ohio)  

 JOSE 10 XE1 (rookie station, JOSE, licensed in 2010, from 
Mexican XE1 call area)  

 JEAN 09 DX (rookie station, Jean, licensed in 2009, from 
"DX" - outside of North America)  

 
Any licensed ham can run the ARRL Rookie Roundup RTTY, but scoring and log 
submission is limited to Rookie stations licensed within the last 3 years.  

Score summaries are due within 72 hours of the end of the contest - 2359 Wednesday 
evening UTC, or 1859 EST. Use the "Submit your score" link under "Score Submission" 
at the ARRL web page  for the RR. ARRL says logs are not required or accepted.  

Calling CQ  

 Use your standard callsign during the contest - no special suffix (do not use 
/ROK. This is a rule change since the first running). Rookies are encouraged to 
call "CQ RR"; non-rookies should call "CQ R." RTTY Rookies might want to 
download and use a Sample Macro file created specifically for the RRRTTY 
contest. See the website under >Files >Sample Macros files "ARRL 
RRRTTY.MC." The macros are set for Rookies, non-rookies will need to change 
the CQ RR to CQ R.  

 
Contest Exchange  

 Your name, year licensed (last two digits, example: 09), state/province 
abbreviation - for K/VE/XE stations (example: NY) or "DX" for other stations. The 
two digit year in your Sent Exchange automatically determines your status as a 
Rookie or a non-Rookie station. The 2 digit year in the Received Exchange 

http://www.arrl.org/rookie-roundup


determines the status of the station you are working. Do not use 4 digit years, it 
will only cause confusion for both Rookies and logging software.  

 
 

4. ARRL RTTY Roundup 

The ARRL RTTY Roundup can be used by K/VE stations and DX stations.  

 Window: Select Log Type  
o Log Type: ARRLRTTY  
o Sent Exchange:  

 Your state/province - for K/VE stations Example: NY  
 001 - for DX stations (non K/VE)  

o Sample Function Key file available: see ARRLRTTY.MC  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a DX stations or a W/VE station.  

Note: US stations who work US "/MM" stations are also allowed to log serial numbers.  

If you are using this contest type for the 10 meter RTTY contest, which uses the same 
rules, you should change the CONTEST: line in the Cabrillo header from ARRL-RTTY 
to TEN-RTTY (the contest submittal robot for the 10 meter RTTY contest will do this for 
you if you forget).  

5. BARTG Spring RTTY contest 

 Window: Select Log type  
o Log Type: BARTGSRTTY  
o Sent Exchange in the Contest setup:001  

 Sample Function Key file available: see BARTGSRTTY.MC  

 
Be careful not to confuse this contest with the BARTG RTTY Sprint contest.  

The actual sent exchange includes a signal report, serial number and the UTC time. 
Program this into your Exchange messages using the {TIME2} macro, e.g.: {TX} 599 
{EXCH} {TIME2} {RX}, or {TX} 599 # {TIME2} {RX}.  

 Testing the {TIME2} macroIf you test out the Exchange message using the {TIME2} 
macro without first entering a call sign into the Entry window, the Exchange message 
will send "0000". This is expected, and it does not mean there is something wrong with 
your Exchange message. The time sent by the {TIME2} macro will be initialized only 
after a valid call sign has been entered into the call sign box and the cursor has been 
moved into the exchange box. 

http://n1mmplus.hamdocs.com/tiki-list_file_gallery.php?galleryId=26
http://n1mmplus.hamdocs.com/tiki-list_file_gallery.php?galleryId=26


 
Needed W,VE,JA,VK call area mults in bandmap and available window are highlighted.  

Added EXPERT to list of overlay categories choices. The EXPERT overlay category 
must be selected for the 5 minute band change counter to not be active for SINGLE-OP  

6. BARTG RTTY Sprint contest 

 Window: Select Log type  
o Log Type: BARTGRTTYS  
o Sent Exchange:001  

 Sample Function Key file available: see BARTGRTTYS.MC  

 
Be careful not to confuse this contest with the BARTG Spring RTTY contest.  

Note that there is no signal report in the sent exchange, just a serial number.  

Needed W,VE,JA,VK call area mults in bandmap and available window are highlighted.  
Added EXPERT to list of overlay categories choices. The EXPERT overlay category 
must be selected for the 5 minute band change counter to not be active for SINGLE-OP.  

7. BARTG Sprint75 RTTY contest 

 Window: Select Log type  
o Log Type: BAR75RTTYS  
o Sent Exchange:001  

This contest type is used for the BARTG 75 baud sprints in April and September. For 
information on setting up MMTTY and N1MM Logger for 75 baud RTTY, see the section 
on Using MMTTY for 75 baud RTTY at the end of the Using MMTTY section in the 
Digital Modes chapter.  

8. CQ World Wide DX contest - RTTY 

 Window: Select Log type  
o Log Type: CQWWRTTY  
o Mode Category: RTTY  
o Sent Exchange:  

 North American/Canadian stations - Your zone plus the STATE or 
PROVINCE Example: 05 NY  

 NB For cabrillo log submission the order must be: Zone 
first, then state (or province) with no leading spaces, and 
ONLY ONE space between the zone and the state.  

 Other stations - Your zone Example: 14  

The default zone values for US (A,K,N,W) stations are  

 Zone 3 - If number in callsign is 6 or 7  
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 Zone 4 - If number in callsign is 5 or 8 or 9 or 0  
 Zone 5 - If number in callsign is 1 or 2 or 3 or 4  

The default zone values for Canadian (VE) stations are  

 Zone 1 - If callsign starts with: VE8, VY1  
 Zone 2 - If callsign starts with: VO2, VY0  
 Zone 3 - If callsign starts with: VE7  
 Zone 4 - If callsign starts with: VE3, VE4, VE5, VE6  
 Zone 5 - If callsign starts with: VE1, VE2, VE9, VO1, VY2  

 Press the Space bar when the cursor is in the Callsign field to have the Zone 
field filled with the default value.  

 The province code is pre-filled for Canadian stations based on the call sign 
prefix.  

 The state field for US stations is pre-filled if you have worked that station on 
another band, or if you are using a Call History file.  

 When typing the section and the entered section is new the call sign will be 
shown in RED. The Available window will also show if a section multiplier is 
needed on other bands  

 When pressing Space and the entered callsign is not US or VE, the cursor will 
skip the state/section field.  

 When submitting your log to the contest robot make sure you have in the Sent 
Exchange the correct order: Zone first, then state (or province).  

 
Cabrillo output  
The Cabrillo file must be in the order zone, state because that's how the official Cabrillo 
template for CQ WW RTTY is defined. However, this has *nothing* to do with how you 
operate during the contest, it only applies to the post-contest log submission. During the 
contest, you can send in either order; all the rules say is you must send both. 
 
A lot of people seem to send zone, state. However, the order state, zone is easier for 
people using N1MM Logger+ because that's the order in the entry window. It's also 
easier for people using software that calculates the zone from the state (like N1MM 
Logger+ does). 
 
So: put zone, state in the contest setup dialog to ensure your Cabrillo file is OK, but you 
can please yourself about the order in your exchange macros; state, zone (e.g. 599 ON 
ON 04-04) will make it easier for fellow N1MM Logger+ users, so it's the recommended 
order on this reflector!  

 Call History in CQWWRTTYIf you like to use Call History Lookup and you plan to use a 
generic call history file that contains state information for W stations, you should be 
aware of a potential problem with call signs from AK and HI. If you invoke a call history 
lookup for a call sign in AK or HI, the call sign is in the file, and there is an entry for the 
state for that call sign in the file, the state/province field in the Entry window will be pre-



filled, even though under the rules for this contest the state field should be blank. This in 
turn may lead to an error in logging the contact; you may have to edit that entry in the 
log to remove the unwanted state code. You can avoid this by removing the state codes 
from the call history file for call signs in AK and HI, or more simply by turning Call 
History Lookup off for this contest. 

 
 

9. CQ World Wide WPX contest - RTTY 

 Window: Select Log type  
o Log Type: CQWPXRTTY  
o Mode Category: RTTY  
o Sent Exchange: 001 (set Send Leading Zeroes in Configurer >Function 

Keys)  

 Sample Function Key file available: see CQWPXRTTY.MC  

 
 

10. CIS contest - RTTY 

The Commonwealth of Independent States Contest where everybody can work 
everybody for QSO and multiplier credit.  

 Window: Select Log type  
o Log Type: CISDXRTTY  
o Sent Exchange:  

 CIS stations: CIS area code Example for Moscow City: RU11  
 Non-CIS stations: 001  

 
 

11. DL DX RTTY contest 

 Window: Select Log type  
o Log Type: DLDXRTTY  
o Mode Category: RTTY  
o Sent Exchange: 001  

Note that PSK31 and/or PSK63 may also be used in this contest.  

12. DMC RTTY contest 

 Window: Select Log type  
o Log Type: DMCRTTY  
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o Mode Category: RTTY  
o Sent Exchange: 001  

 
 

13. DRCG Long Distance RTTY contest 

This contest has replaced the ANARTS RTTY contest.  

 Window: Select Log type  
o Log Type: DRCGWWRTTY  
o Mode Category: RTTY  
o Sent Exchange: Zone Example: 14  

o Sample Function Key file available: see DRCGWWRTTY.MC  

 
The actual sent exchange includes a signal report add your CQ zone  

 
See contest sponsor website for new contest times and bandchange restrictions.  

14. EA PSK31 contest 

 Window: Select Log type  
o Log Type: EAPSK  
o Mode Category: PSK  
o Sent Exchange:  

 For Spanish stations - Province Example: AL  
 For non-Spanish stations - Serialnumber Example: 0001  

The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a Spanish station or a non-Spanish station.  

15. EA RTTY contest 

 Window: Select Log type  
o Log Type: EARTTY  
o Mode Category: RTTY  
o Sent Exchange:  

 For Spanish stations - Province Example: AL  
 For non-Spanish stations - Serialnumber Example: 0001  

The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a Spanish station or a non-Spanish station.  

16. EPC PSK63 QSO party 

 Window: Select Log type  
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 Log Type: EPCPSK63QP  
 Sent Exchange:  

o EPC member stations: EPC membership number Example: EPC0001  
o Non-EPC member stations: 001  

 
 

17. EPC PSK World Wide DX contest 

 Window: Select Log type  
 Log Type: EPCWWDX  
 Sent Exchange:  

o EPC member stations: EPC membership number Example: EPC0001  
o Non-EPC member stations:  

 
 

18. EU PSK DX contest 

 Window: Select Log type  
o Log Type: EUPSKDX  
o Sent Exchange: 001  

 
 

19. JARTS WW RTTY contest 

 Window: Select Log type  
o Log Type: JARTSWWRTY  
o Sent Exchange:Your age Example: 34  

 XYL and YL stations may give 00  
 Multi-operator stations must send 99 as a operator age.  

 
 

20. JT RTTY DX Contest 

 Window: Select Log Type  
o Log Type: JTDXRTTY  
o Mode Category: RTTY  
o Sent Exchange: CQ Zone (e.g., 5, 14, 23, etc.)  

 
 



21. Makrothen RTTY Contest 

 Window: Select Log type  
o Log Type: MAKRORTTY  
o Mode Category: RTTY  
o Sent Exchange: 4 digit grid Example: JO33  

 
 

22. Logbook of the World Contest - RTTY/Digital 

 Window: Select Log type  
o Log Type:  

 LOTWRTTY  
o Sent Exchange:  

 For North American stations: State/Province abbreviation Example: 
CT  

 For non North American stations: Countryprefix  

 
 

23. NA Sprint RTTY 

 Window: Select Log type  
o Log Type: SPRINTRTTY  
o Mode Category: RTTY  
o Sent Exchange: 001 Tom CT  

 Serial number, your name and your location (state, province or 
country) Example: PA1M DE N1MM 123 TOM CT K  

The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a North American station or a non-North American station.  

24. North American QSO Parties RTTY - NAQP 

 Window: Select Log type  
o Log Type: NAQPRTTY  
o Operator Category: SINGLE-OP or MULTI-TWO  

 For Multi-Two see the extra info below!  
o Mode Category: RTTY  
o Sent Exchange:  

 For North American stations - Operator name and station location 
(state, province, or country) Example: Tom CT  

 For non-North American stations - Operator name only Example: 
Thomas  



The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a North American station or a non-North American station.  

XXXVerify thisXXX  

MULTI-TWO operating: When changing operator you have to use Ctrl+O to set the 
NAME (not Call) of the operator. This name set with Ctrl+O will be used in the Cabrillo 
file. So from the Sent Exchange only the state is being used but the name is needed. 
(Example: Tom CT). The macro {OPERATOR} can be used to automatically switch 
WAV files (in SSB), for more info see the Macro section.  

25. OK DX RTTY Contest 

 Window: Select Log type  
o Log Type: OKDXRTTY  
o Mode Category: RTTY  
o Sent Exchange: CQ zone  

26. Quick PSK63 Contest 

The contest uses the same rules as the SARTG WW RTTY contest so select that 
contest (SARTGRTTY).  
After the contest the Cabrillo output has to be updated (take SARTG WW out and 
replace with Quick PSK63)  

27. Russian PSK DX Contest 

 Window: Select Log type  
o Log Type: RUSDXPSK  
o Mode Category: PSK  
o Exchange:  

 Russian stations: Two-letter oblast code, e.g. MA  
 Others: 001  

 
 

28. Russian DX RTTY contest 

 Window: Select Log type  
o Log Type: RUSDXRTTY  
o Mode Category: RTTY  
o Sent Exchange:  

 Non-Russian stations: WAZ zone Example: 14 for Western Europe  
 Russian stations: Your oblast code (two letters)  

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a Russian station or a DX station.  



29. Russian Cup RTTY contest 

 Window: Select Log type  
o Log Type: RUCUPRTTY  
o Mode Category: RTTY  
o Sent Exchange: 001  

 
This contest is for Russians only.  

30. SARTG New Year RTTY Contest 

 Window: Select Log type  
o Log Type: SARTGNYRTY  
o Mode Category: RTTY  
o Sent Exchange: 001 Name  
o Soap Box Comments: "Happy New Year" in your native language  

o Add "Happy New Year" in your native language to the Function Key 
macro. Do not add it to the Sent Exchange. If you do, the Cabrillo output 
and General Log output may not be correct.  

 
Logging an exchange with spaces is not supported and logging of the Happy New Year 
greating is *not* required. If you want to record the Happy New Year greeting it can be 
added *without* spaces after the name preceeded by a "/". Example: 
Jim/HappyNewYear. If added, the Cabrillo output generator will remove the "/" and 
everything that follows when generating the output file.  

The sponsor informed the developers that as of December 21, 2013 they will accept 
Cabrillo 3.0 formated logs. It is necessary to follow the Sent Exchange & Soap Box 
instructions above to export a Cabrillo file. The Happy New Year message that you sent 
will appear in the Cabrillo Soap Box Comment.  

31. SARTG WW RTTY Contest 

 Window: Select Log type  
o Log Type: SARTGRTTY  
o Mode Category: RTTY  
o Sent Exchange: 001  

o Sample Function Key file available: see SARTGRTTY.MC  

 
 

32. SCC RTTY Championship 

in-edit  
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 Window: Select Log type  
o Log Type: SCCRTTY  
o Mode Category: RTTY  
o Sent Exchange: four-digit number of the year the amateur radio license 

was FIRST officially issued (e.g. 1983) to the operator.  

 
The score Summary window only shows your total score and the number of mults you 
have worked per band. There is no breakdown by points. In SCC there is one extra 
column of mults but that had to be there as the way things are setup to calculate the first 
multiplier (different years). Thus the name of the second mult is "N/A" . The only way to 
do a breakdown on points is to go through your log and manually do it.  

33. SP DX RTTY contest 

 Window: Select Log type  
o Log Type: SPDXRTTY  
o Mode Category: RTTY  
o Sent Exchange:  

 001 for non-SP stations  
 Your province Example: B for Lubuskie  

The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a Polish station or a DX station.  

34. TARA Grid Dip contest 

 Window: Select Log type  
o Log Type: TARAGRID  
o Mode Category: RTTY or PSK  
o Sent Exchange: name + 4 digit grid locator Example: Tom FN12  

 
 

35. TARA PSK Rumble 

 Window: Select Log type  
o Log Type: TARAPSK  
o Mode Category: PSK  
o Sent Exchange: Name and Call Area Example: Tom W1  

 
 

36. TARA RTTY Melee 

 Window: Select Log type  
o Log Type: TARARTTY  



o Mode Category: RTTY  
o Sent Exchange:  

 State for USA stations Example: CT  
 Province for Canadian stations Example: NB  
 001 for all other stations (serial number)  

 
 

37. TARA Skirmish 

 Window: Select Log type  
o Log Type: TARAPSK, or SKIRMRTTY (SKIRMRTTY requires that you 

download the SKIRMRTTY.udc user-defined contest file)  
o Mode Category: DIGITAL  
o Sent Exchange: Name and Prefix Example: Tom N1  

Note: Download the SKIRMRTTY.udc file into your UserDefinedContests folder and use 
SKIRMRTTY. If you do not want to use the udc file, the TARAPSK contest will also work 
for the Skirmish, but the scoring of multipliers will not be correct. Use the Tara on-line 
log submission page and enter the correct prefix multiplier count there. If you use more 
than one digital mode during the contest, submit a separate entry for each mode as per 
the contest rules.  

38. Ukrainian DX Classic RTTY contest 

The Ukrainian DX contest can be configured for Ukrainian stations and non-Ukrainian 
stations.  

 Window: Select Log type  
o Log Type: UKRAINDX  
o Mode Category: RTTY  
o Sent Exchange:  

 Oblast for Ukrainian stations Example: CH  
 001 for non-Ukrainian stations  

o Sample Function Key file available: see UKRAINDX.MC  

The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are an Ukrainian station or a non-Ukrainian station.  

39. Ukrainian Open RTTY Contest 

 Window: Select Log type  
o Log Type: UKRRTTYOPEN  
o Mode Category: RTTY  
o Exchange: 2-letter province code + 3-digit serial number  

http://n1mmplus.hamdocs.com/tiki-list_file_gallery.php?galleryId=26


 
 

40. Ukrainian RTTY contest 

The Ukrainian DX contest can be configured for Ukrainian stations and non-Ukrainian 
stations.  

 Window: Select Log type  
o Log Type: UKRAINRTTY  
o Mode Category: RTTY  
o Sent Exchange:  

 Oblast for Ukrainian stations Example: CH  
 001 for non-Ukrainian stations  

× Country CountCountries are counted per band for SSB, CW and RTTY. Because 
RTTY is in a separate contest module, they won't be counted correctly when a station 
makes SSB and CW QSOs as well as RTTY QSOs with a country. 

 
The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are an Ukrainian station or a non-Ukrainian station.  

41. Ukrainian DX DIGI Contest 

75 baud RTTY and PSK63 modes  

 Window: Select Log type  
o Log Type: UKRAINDIGI  
o Sent Exchange:  

 Oblast for Ukrainian stations Example: CH  
 001 for non-Ukrainian stations  

 
 

42. United Kingdom DX contest RTTY 

The UK DX contest can be configured for UK stations and non-UK stations.  

 Window: Select Log type  
o Log Type: UKDXRTTY  
o Sent Exchange:  

 Area code for UK stations Example: BS  
 001 for non-UK stations  

The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are an UK station or a non-UK station.  

43. VOLTA RTTY Contest 



 Window: Select Log type  
o Log Type: VOLTARTTY  
o Mode Category: RTTY  
o Sent Exchange: RST + QSO number + Your CQ Zone. Example: 599 001 

15  

The four Band Multiplier count for this contest is displayed on info window.  

44. WAEDC RTTY contest 

in-edit  

The WAEDC RTTY Contest can be configured for European stations and non-European 
stations.  

 Window: Select Log type  
o Log Type: WAERTTY  
o Sent Exchange: 001  

The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are an European station or a non-European station.  

Making QSOs in WAE RTTY:  

To start with, a QSO in WAE is just like a QSO in CQ WPX or SARTG, and I would 
suggest using a similar function-key set. The special feature of WAE is QTCs, which are 
reports of previous QSOs that can be exchanged for additional points.  

In CW and SSB WAE, QTCs can only be sent from non-EU to EU, but in RTTY there 
are many more possibilities. QTCs can be sent in either direction between any two 
continents (not with a station in the same continent).  

In N1MM Logger+, the user interface for QTCs in RTTY is very similar to that in 
CW/SSB. The Logger has features to automate the sending and receiving of QTCs. 
There is also information in the Entry and Bandmap windows to tell you whether the 
rules permit you to exchange QTCs with another station. In the bottom part of the Entry 
window, while you are in QSO with a station information about the number of QTCs you 
have available to exchange with him is displayed. In the following example, the three 
numbers in red after "QTCs" mean that you have not exchanged any QTCs with this 
station yet (0), you have 10 QTCs available to send to him, and you have 22 total 
unsent QTCs in your log.  



 

The Bandmap and Entry windows contain visual cues about the QTC status of stations 
spotted in the Bandmap or entered into the Entry window. A special color scheme for 
spotted call signs has been implemented, as follows:  
RED: the station is a new multiplier on this band (same as in other contests)  
GREEN: this is a new station on this band, and you can also exchange QTCs with him 
(you are on different continents and you have not yet exchanged 10 QTCs)  
BLUE: this is a new station on this band, but you have no more QTC room available 
(same continent, or you have already exchanged 10 QTCs)  
BLACK: this station is a dupe on this band, but you still could exchange QTCs with him 
for QTC points  
GREY: dupe, and there is no QTC room either - this station is non-workable for any kind 
of credit, so just pass him by  
Note that this special color scheme only applies to the Bandmap and Entry windows; 
the colors in the Digital Interface and Available Mults and Qs windows use the normal 
color scheme, the same as in other contests.  

OK, let's look at the process. First, let's suppose you are CQing. If you have a good run 
going and you are getting new multipliers calling in, you may decide you don't want to 
break your rhythm for QTCs. As long as there are people waiting to work you when you 
CQ, you may decide you will be best off adding to your QSO and multiplier counts 
rather than adding a quick 10 QTCs, which increases your net QSO+QTC point count 
but does nothing for your multiplier points.  

However, especially later in the contest, you might want to pick up your score with some 
QTCs, as you will probably be able to exchange a batch of 10 QTCs more quickly than 
you could work 10 more QSOs, and the odds of finding a new multiplier may be much 
lower than earlier in the contest. In fact, you can even call someone who is a dupe just 
so you can exchange QTCs; the extra QSO will not count for points, but the QTCs will.  



First, let's look at the case where you do not have many unsent QTCs to send (that's 
previous QSOs that you have not already sent as QTCs). In this case, if you work 
someone who has a good clear signal (you won't want to do this with someone you 
have trouble copying) and you have not yet exchanged QTCs with him, you may want to 
receive some.  

Start by asking him if he has any QTCs for you ("QSL TNX. ANY QTCS FOR ME?"). If 
he says yes, press Ctrl+Z once. That gets you to the RQTC window for receiving QTCs.  

 

After you tell him you are ready with the RX Ready button, he will send you a message 
whose first line is something like "QTC: 22/10 QTC: 22/10". The first number is the 
group number (the 22nd group he has sent), the second is the number of QTCs in the 
group (maximum 10, and especially in RTTY it is most efficient to send only large 
groups). If you click on this in the RX window, it should transfer to the RQTC window for 
recording in your log.  

The heart of his message will be a set of up to 10 QTCs. Each QTC contains three 
elements: the time, the call sign, and the serial number. Each time you receive a QTC, 
left-click on it and the entire QTC should transfer into the corresponding panes in the 
RQTC window. You can also enter or edit elements by hand, or you can right-click on a 
single element and then left-click in the box where you want it to go. After you have 
received all the QTCs in the group, it may help to click on the green bar at the left of the 
RX window so you can freeze the RX window, scroll back and complete or fix any 
missing or garbled elements. Remember to click on the yellow bar when you are done 
so you can receive again.  



After he has sent the batch of QTCs to you, you may need him to repeat some of the 
information. There are buttons in the RQTC window for asking for repeats for individual 
QTCs ("Agn #1", etc.) or for the whole series ("All Agn"). Once you have them all, press 
the "Save" button, which will send an acknowledgement message to him and log the 
QTCs, and then you can start CQing again.  

 

Suppose instead that you do have a bunch of unsent QTCs ready to go. Then what you 
may want to do at the end of a QSO with a station with a good clear signal (if you have 
trouble copying someone's signal, you probably will not want to try QTCs with him) is to 
ask if he wants to receive QTCs ("QSL TNX. DO YOU WANT QTCS?"). If he says yes, 
press Ctrl+Z twice to get to the SQTC window.  



 

This window starts out pre-filled with all the information you need to send - as you can 
see, sending QTCs is quite a bit easier than receiving them! The buttons in this window 
should be self-explanatory. The "Send Hdr" button is what you use to send the QTC 
batch number (e.g. QTC: 2/10), and once the other station has acknowledged that, the 
"Send All" button is what you use to send the batch. After the batch has been sent, if he 
asks for a repeat of #3, 7 and 9 you can resend them by pressing Snd #3, Snd #7 and 
Snd #9. Once he acknowledges them all, press Save and go back to CQing.  

If you get into the wrong QTC window by mistake, you can either press Cancel or press 
Ctrl+Z once or twice until the QTC window closes. Note also that if you aren't able to 
exchange QTCs with a station (you're on the same continent, or you have already filled 
your quota of 10), the QTC window will not open. If you are able to receive QTCs but 
don't have any QTCs to send, the RQTC window will open, but the SQTC window will 
not.  

S&Ping works much the same. The color coding in the Bandmap window can let you 
know whether you will be able to exchange QTCs even before you start a QSO, or once 
you are in QSO the detailed QTC status is visible in the Entry window. Often you will let 
the running station decide if he wants to do QTCs or not, depending on how well his run 
is going, but sometimes you may want to initiate the process yourself, as described 
above.  

If the other station wants to send QTCs to you, you can either reply "SRI QRU" (not 
quite correct, but he will get the message) or you can press Ctrl+Z once to get the 
RQTC window and press the RX Ready button to tell him you are ready, then receive 
QTCs the same as described above. If he asks you whether you have QTCs for him, 
you have three options: press Ctrl+Z twice and press the R U QRV button to give him 



the cue to get ready; send "SRI QRU"; or send a message telling him you don't have 
any but are willing to receive some ("SRI QRU. ANY QTCS FOR ME?").  

Most of the basic QTC messages are sent by buttons in the SQTC and RQTC windows. 
You can program the messages in these buttons from the Setup -> Settings menu in the 
digital interface window, under the third tab ("WAE RTTY Configuration").  

There are a few additional messages you may want to program into the buttons at the 
bottom of the Digital Interface window, such as:  
{TX} QSL TNX. GOT ANY QTCS FOR ME? {RX}  
{TX} QSL TNX. DO YOU WANT QTCS? {RX}  
{TX} SRI QRU {RX}  
{TX} SRI QRU. ANY QTCS FOR ME? {RX}  

You may think of more - that's OK, there are up to 24 clickable message buttons in the 
Digital Interface window. I often find myself changing them on the fly during a contest. 
You can get to the programming window by right-clicking on the button you want to 
change.  

XXXEverything below needs to be reviewed - some may not apply to NL+XXX  

 QTC Lines on the frame are broken up into separate boxes. This was done to 
allow error checking of any data that is input by hand and clicking on data in RX 
window.  

 If you click on data or enter data in the QTC windows if the routines detect bad 
data it will flag that data in red. So when you are receiving QTCs and you get one 
that is garbled, Click on it anyway and it will get placed into the QTC area. The 
boxes for that QTC will turn red.  

 Upon completion of the sending QTC's all you have to do is look at the QTC 
window and it will tell you by the red colors what QTC you need to RX again. You 
press the AGN # button and it sends your message out. At the same time your 
message is going out the QTC line is cleared. Now when the station sends the 
repeat of the QTC you requested and you click on it and it will then be placed into 
that blank line that was just cleared.  

 When saving QTC if any of the data still hasn't been corrected it will send the 
received ok message but if there is an error in the Time or the Callsign the 
program will let you save the QTC and not care about it. But if there is an error in 
the serial number (If it contains anything besides a number) it will not let you 
save it. The reason for this is in the program the serial number needs to be a 
certain type of variable(numeric) and if it is not a numeric variable it will not save 
it. So the flow of it if there is an error in the serial section and you press Save is:  

A. Sends the confirm string you have setup  
B. Tells you on the entry window there is a Format error  
C. Waits for you to fix it.  
D. So now you would have to scroll back to see what was sent of take out the extra 
letter your finger hit then hit save.  
By doing it this way you are not slowing down the other station  



 The program will not save info into the log until the bad data is fixed. Once fixed 
just click Save again and it will save the data without sending the received 
message. A warning message is given in the Entry window status bar.  

 Sometimes a call sign reported in a QTC will not pass the call sign recognition 
routines and the QTC will be displayed in red. If it was a special call sign, not a 
copying error, and you want to log it anyway, you can "force-log" the QTC by 
Ctrl+clicking on the Save button  

 To select whole lines of received QTC just place the cursor over the line and left 
click.  

 To select individual QTC sections place the cursor over the item you want to 
select and right click on it. After the data is selected place the cursor over the text 
box you want the data to go into and left click it will be placed into it.  

 When pressing Ctrl+Z to switch modes the program will display the total QTC 
sent and received from the station being worked.  

 When pressing Ctrl+Z to switch modes if you have reached the MAX amount of 
QTC the QTC window will close and give a warning message in Entry windows 
status bar.  

 When left clicking on a Received QTC line will split data on " ","/","-" separators if 
the routines can't split the data it will not copy the data over. You will have to click 
each item separate or hand type it in.  

 Selecting of individual QTC items can be done by right clicking on item. Left 
clicking on the box where the data to be placed places text.  

 Ctrl+Z cycles through QSO, receive QTC and send QTC modes. After you enter 
a callsign in the entry window pressing Ctrl+Z will cycle through the RQCT and 
SQTC modes. If you are receiving QTC press Ctrl+Z once and as the QTC 
appears in the digital window just click on it one time and it will transfer over to 
the QTC entry window. To send a QTC press Ctrl+Z one more time and it will 
show you all the QTCs you have available to send.  

 The status line in the Info window shows the total QTC Sent and Received from 
the station being worked.  

 Upon entering a callsign in the entry window and pressing the spacebar, the 
number of total QTC's exchanged with that callsign and the Total of all unsent 
QTC is displayed on the entry window so you should be able to keep track easier 
of what your QTC numbers are  

 If you work a station that is on your same continent and try to send them QTC or 
try to receive QTC from them the program will tell you you can not do that. Press 
Enter and move on......  

 On the WAE Tab located in the settings area will allow you to set the maximum 
number of QTC you want to send. Whatever this setting is set to is the number 
that will send unless you do not have that many QTC to send. This defaults to 10.  

 The total unsent QTC's is displayed along with # of QTC's exchanged with 
current callsign on the Entry window  

 Continent is checked when sending and receiving QTC's  
 Default number of QTC to send can be entered on the Tab WAE RTTY 

configuration under Settings in the menu from the DI interface.  



 The number of QTC sent and total QTC available ois shown in the Entry window 
upon Entering Callsign  

 Hover mode is disabled if the QTC window is open  
 The number of CR's between QTC's sent is configurable (Setup QTC)  
 Placing a QTC into the QTC window is possible by clicking in line of QTC boxes 

where you want QTC to be placed into.  
 When tuning in the bandmap the Entry Window will show the QTC status of the 

tuned callsign; starting with version 11.11.01, the color in the Bandmap window 
also shows the status  

 Warning: In this contest it is allowed to log a contact with a zero serial number 
(such as a non-contest DXpedition you work during the contest). Therefore the 
normal ESM flow is altered; F8 (Agn?) is not highlighted when the exchange box 
is empty during a QSO. In a normal QSO where you receive a serial number, you 
have to be careful not to hit Enter too soon and forget to log the received serial 
number; make sure to enter the serial number before you hit Enter to finish the 
QSO!  

 
For those who are familiar with WAE CW/SSB, note that although the QTC user 
interface in N1MM Logger+ is similar, there are fundamental differences in the contest 
rules between the RTTY and the SSB/CW version of the contest:  

1. Everyone can work everyone, so DX can work DX and EU can work EU  
2. Everyone can both send and receive QTCs, however they can only be exchanged 
between stations in a different continent  

How do I know how many QTCs I can receive from a station or how do I know the 
number to send to them?  

The program will do all this for you in a number of ways...  

 The first number that is displayed on the entry window by the QTCs title is the 
total number of QTC's you have exchanged with that station. If it says 8 then you 
can either receive or send 2 more  

 When you press Ctrl+Z to switch to RQTC mode the program already knows how 
many QTC you can receive and will only enable that many entry points on the 
QTC frame  

 When you press Ctrl+Z to switch to SQTC mode the program will either set the 
maximum number you want to send or however many QTC's you are still allowed 
to send to that station. (Whichever is smaller)  

 
 

45. XE RTTY Contest 

 Window: Select Log type  
o Log Type: XERTTY  



o Mode Category: RTTY  
o Sent Exchange:  

 Mexico: State. Example: AGS  
 Non-Mexico: 001  

The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a Mexican station or a non-Mexican station.  

 

2.1.5.6 Setup User Defined Contests 

in-edit  

 2.1.5.6 Setup User Defined Contests  

o Installation Instructions for a User Defined Contest (UDC)  
o 1. 50RS VHF  
o 2. ACHAMPCW  
o 3. ARKTIKA-SPRING  
o 4. AEGEAN RTTY Contest  
o 5. AGB  
o 6. AGB NYSB/NEMIGA/PARTY  
o 7. AGB Party  
o 8. Alaska QSO Party  
o 9. ARI RTTY 80/40m  
o 10. ARI SEZIONI Contest  
o 11. ARKTIKA Polar Radioman  
o 12. ARRL-EME  
o 13. ARR PSK63  
o 14. Belgian Data Modes WW Contest  
o 15. Brazil Independance Day Contest  
o 16. Bucuresti Contest  
o 17. CA HF  
o 18. Championship of Astrahan oblast  
o 19. CONCURSO NACIONAL FONIA  
o 20. CQ WE  
o 21. CSA-VHF  
o 22. CUCALAMBE Contest  
o 23. DEUTSCHLAND EASTER CONTEST  
o 24. DigiFest  
o 25. DIG_PA Contest  
o 26. DL DTC Contest  
o 27. DNIEPER CUP  
o 28. EPC French DX Contest  
o 29. EPC Ukrainian DX  
o 30. ES OPEN HF  



o 31. EUCW Frat Party  
o 32. EUCW ON5ME-160  
o 33. FGUP 2011  
o 34. Flight of the Bumblebees  
o 35. G3ZQS Memorial Contest  
o 36. GEDEBAGE  
o 37. GENERIC  
o 38. GENERIC2  
o 39. GENERIC RTTY  
o 40. HA National Championship OB  
o 41. HA3NS Memorial Contest  
o 42. International 2010  
o 43. International Lighthouse Week 2010  
o 44. IRTS80M  
o 45. IRTS CQIR  
o 46. HINA33  
o 47. JW-FD  
o 48. Kanagawa  
o 49. KCJ  
o 50. Keymens Club of Japan  
o 51. KT Serbia Cup  
o 52. Lighthouse Christmas Lights 2010  
o 53. Lighthouse Spring Lites 2010  
o 54. LY WAL Contest  
o 55. Marconi Memorial Contest  
o 56. Memory Lives Forever Contest  
o 57. MOON CONTEST  
o 58. Moscow-Championship  
o 59. MULAN WAP  
o 60. North American QRP CW Club Sprints.  
o 61. NRL Cup  
o 62. NRRL TELEFONITEST  
o 63. NZART WW11 Memorial and VHF and up Contests.  
o 64. OBLAST  
o 65. OH Domestic Events, Easter, Sainio, Summer, Autumn and Xmas.  
o 66. OH-PARKS  
o 67. OK-OM DX SSB  
o 68. Old New Year  
o 69. Original QRP  
o 70. OZ ACTIV Contest  
o 71. OZCHR-VHF  
o 72. PARLA  
o 73. PN QUICK CW Contest  
o 74. PODXS 070 Contests  
o 75. PODXS 070 St. Patrick's Day Contest  
o 76. PODXS Triple Play Low Band Sprint  



o 77. PODXS Valentine Sprint Contest  
o 78. Popov Memorial  
o 79. POPOV-VHF  
o 80. PSK 31 Flavors  
o 81. PW 144 and 70Mhz  
o 82. QRP HF RTTY  
o 83. R3A Cup Digi  
o 84. R3E-SC  
o 85. R4C Champ  
o 86. R4W (Udmurtia, Russia) Open Championship  
o 87. R6H Champ  
o 88. RCWC 4 Seasons  
o 89. REGION-NR  
o 90. RSGB UKAC (VHF)  
o 91. RSGB VHF Contests  
o 92. RUSSIAN160  
o 93. SALMON-RUN  
o 94. SARA Spring Sprint  
o 95. SARA Spring Sprint (OM)  
o 96. SARL Contests  
o 97. SCAG SPRINT  
o 98. Seanet Contest  
o 99. SKMEM  
o 100. SMIRK  
o 101. SP PGA Contest DX  
o 102. SP PGA Contest SP  
o 103. Suffixes XXIX National  
o 104. SP WW EPC BPSK63  
o 105. SPAR Winter FD  
o 106. SRR JR  
o 107. SV Triathlon  
o 108. TA VHF UHF  
o 109. TARA SKIRMISH  
o 110. TenTen QSO Parties  
o 111. Tesla HF Memorial Contest  
o 112. Texas Parks On The Air  
o 113. The Day of YLs  
o 114. UBA PSK63 Prefix Contest  
o 115. UFT HF Contest  
o 116. UK DXC BPSK63  
o 117. URAL CUP  
o 118. USi W/VE Islands Qso Party  
o 119. UT5EU-MEMORIAL-VHF  
o 120. VHF GRIDS  
o 121. VU Himalayan Contest  
o 122. VU International DX Contest  



o 123. VU Summer (Internal) Contest  
o 124. Vytautas Magnus trophy  
o 125. WAB Contests  
o 126. Worked All China Provinces BY  
o 127. Worked All China Provinces DX  
o 128. Worked all VK Shires  
o 129. World Lighthouse OTA  
o 130. WSEM minitest  
o 131. YACHAMP  
o 132. YL-OM  
o 133. YO PSK31  
o 134. Battle of Carabobo Contest.  
o 135. ZOMBIE  

The User Defined Contests listed below have been developed by users of N1MM 
Logger+, and should work as described although they are not officially supported by 
N1MM Logger+.  
There are probably additional details within the .UDC file regarding contest setup and 
exchange. Use a text editor to examine the file after downloading from the >Files >User 
Defined Contests gallery. Be advised that there are known scoring anomalies with some 
of the UDC contests.  

Installation Instructions for a User Defined Contest (UDC) 

User Defined Contests are not distributed with the program installer, either Full or Latest 
Update  

o A list of available User Defined Contests is located on the >Documentation 
>Digging Deeper >Supported User Defined Contests page  

o The UDC files themselves are found on the N1MM Logger+ website, 
located under >Files >User Defined Contests  

o To enable a UDC contest and select it in the contest configuration dialog 
window  

1. Locate the desired UDC file on the website in >Files >User Defined 
Contests page  

2. Download the .UDC file to your computer's hard drive in the 
UserDefinedContests directory in the N1MM Logger+ user files 
area, at My Documents/N1MM Logger+/UserDefinedContests  

3. Restart N1MM Logger+  
4. Within N1MM Logger+, select >File >New Log in Database.  
5. Find and choose the UDC contest name you downloaded (without 

the .UDC file suffix). It will be included in alphabetic order among 
the list of all other supported contest names. NOTE: if you do not 
see the contest in that list, use a text editor (Notepad) to open the 
UDC file. Find the "Name =" statement (around line 10 of the file) 
which defines the actual contest name. In some instances the 
Name= statement may not match the Windows .UDC file name.  

http://n1mmplus.hamdocs.com/tiki-index.php?page=Supported+User+Defined+Contests
http://n1mmplus.hamdocs.com/tiki-list_file_gallery.php?galleryId=18


 
 
 

1. 50RS VHF 

50MHz RASE DX Sprint.  
",  

 See the UDC file for more details  
 Filename: EARSVHF.udc  

 
 

2. ACHAMPCW 

Asiatic Russia (UA9) Championship CW  

 See the UDC file for more details  
 Filename: ACHAMPCW.UDC  

 
 

3. ARKTIKA-SPRING 

ARKTIKA-SPRING contest file  

 See the UDC file for more details  
 Filename: AC-SPRING.UDC  

 
 

4. AEGEAN RTTY Contest 

Generic - RST and Serial Nr. Runs OK with a fixed amount of points per qso.  
Select log type: AEGEANRTTY  

 See the UDC file for more details  
 Filename: AEGEANRTTY.udc  

 
 

5. AGB 

AGB-NEMIGA Contest. Third Friday of September (16 Sep 2011) 2100 - 2400 UT  

 See the UDC file for more details  
 Filename: AGB.udc  



 
 

6. AGB NYSB/NEMIGA/PARTY 

AGB NEMIGA, Allows RY and PSK modes. Select "MIXED+DIG" for "Mode Category"  
Exchange: RS(T) + Serial Nr and AGB Member Nr (if a member)  
Complete Contest name in log.  

 See the UDC file for more details  
 Filename: AGB_RTTY.UDC  

 
 

7. AGB Party 

AGB-PARTY (Activity Group of Belarus) Contest. Third Friday of December (16 Dec 
2011) 2100 - 2400 UT  

 See the UDC file for more details  
 Filename: AGBPARTY.UDC  

 
 

8. Alaska QSO Party 

If using SSB/CW plus Digital, Select MIXED+DIG in the Contest Setup Window. Enter 
QSO points on logging line.  
Select file name: AKQP_RTTY  
Exchange: Serial Nr, Name and Grid Square  

 See the UDC file for more details  
 Filename: AKQP_RTTY.UDC  

 
 

9. ARI RTTY 80/40m 

(Set up for Italian domestic) ARI 80/40m RTTY Contest  
Select file name: ARIRTTY  
Exchange: Your Area Code  

 See the UDC file for more details  
 Filename: ARIRTTY.UDC  

 
 



10. ARI SEZIONI Contest 

ARI SEZIONI Contest  

 See the Read_Me file  
 Filename:ARI_SEZIONI.zip  

 
 

11. ARKTIKA Polar Radioman 

Exchange: RST + Arktika Club Member Number e.g. 599 AC999. Non-members send 
RST + Serial Number. Club member numbers are mults, once only.  

 See ARKTIKA_read-me.txt  
 Filename: ARKTIKAPR.zip.  

 
 

12. ARRL-EME 

VHF/UHF only, signal report as exchange, dupes are not allowed on same band CW, 
SSB and FM modes  

 See the UDC file for more details  
 Filename: ARRL_EME.udc  

 
 

13. ARR PSK63 

ARR PSK63 contest.  
Select log type: ARR_RTTY. Exchange RST and Serial. Multipliers are DXCC and "CT" 
Callsigns.  

 See the UDC file for more details  
 Filename: ARR_RTTY.udc  

 
 

14. Belgian Data Modes WW Contest 

Belgian Data Modes WW Contest. If using AFSK, Select DIGITAL in the Contest Setup 
Window.  

 See the UDC file for more details  
 Filename: BDMWWRTTY.udc  



 
 

15. Brazil Independance Day Contest 

Brazilian Independance Day PSK31 Contest. Select DIGITAL in Setup Window. v1.0.1,  

 See the UDC file for more details  
 Filename: BRAZ_IRTTY.udc  

 
 

16. Bucuresti Contest 

Generic, Serial # and YO District or Country WEB Identifier (e.g. Belgium=BE, 
Sweden=SE) as exchange.  
If using Mixed modes, select MIXED+DIG in the Contest Setup Dialogue.  

 See Bucuresti_Read_Me.txt file for more details (In Bucuresti.zip)  
 Filename: BUCURRTTY.udc  

 
 

17. CA HF 

Central America contest. Contact Argentinean & Nearby countries. Exchange RST and 
Serial. Provinces are mulpliers,  

 See the UDC file for more details  
 Filename: CAHF.udc  

 
 

18. Championship of Astrahan oblast 

Russian internal contest (???????? ????????? ???????????? ???????)  

 See the UDC file for more details  
 Filename: R6U-Champ.udc  

 
 

19. CONCURSO NACIONAL FONIA 

Spanish National Phone Contest (RADIO CLUB SEVILLA)  

 See the UDC file for more details  
 Filename: EACNF.UDC  



 
 

20. CQ WE 

CQ Western Electric Contest. Contact Employees, Retired Employees or other 
Amateurs. Exchange Name, WE Locator and years of service. Non-employees give 
number of CQ WE Contests entered (1 if current is the first, can be 1-6) If using all 
modes, be sure to select 'MIXED+DIG' on contest set-up page.  

 See the rules for full details.  
 Filename: CQWE_RTTY.udc  

 
 

21. CSA-VHF 

South American VHF contest  

 See the UDC file for more details  
 Filename: CSA-VHF.udc  

 
 

22. CUCALAMBE Contest 

National Cuban contest \Cucalambe  
Select log type: CUCALAMBE  
Exchange: AREA Code  
Import Section file (CUCALAMBE.sec required in N1MM main folder)  

 See the UDC file for more details.  
 Filename: CUCALAMBE.udc  

 
 

23. DEUTSCHLAND EASTER CONTEST 

Deutschland Easter Contest.  
Exchange: RST + Serial Nr. (+DOK)  

 Filename: DC_EASTER.udc  

 
 

24. DigiFest 



Digifest Contest. Exchange: RSQ and Locator(4 digits) Locator is mult (once only). 
Work Station each band and mode. Note1 - In the 'Set up Contest Window' Set the 
Mode Category to 'DIGITAL'. Note2 - not all digital modes allowed in the contest are 
supported in MMVARI.  

 See the UDC file for more details  
 Filename: VHF_DFRTTY.UDC  

 
 

25. DIG_PA Contest 

DIG_PA Contest  
Select log type: DIG_PA  
Exchange: RS(T) and Member Number or just RS(T) if not a member.  

 See UDC file for more details.  
 Filename: DIG-PA.udc  

 
 

26. DL DTC Contest 

German Telegraphy Contest, held 3rd October.  
Select log type: DL_DTC  
Exchange: RST and LDK, non DL only RST  

 Filename: DL_DTC  

 
 

27. DNIEPER CUP 

DNIEPER CUP. Send and receive two-letter AREA + Serial Nr. Start new contest each 
Session (Set correct Mode in Contest Setup Window,  
Select file name: DNIEPERTTY.  
Exchange: Serial Nr (must be first) and a two letter Area or District or County Code.  

 See the UDC file for more details  
 Filename: DNIEPERTTY.UDC  

 
 

28. EPC French DX Contest 



EPC French DX Contest. Select log type: See Read-Me.txt in EPCFR.zip. Exchange 
Call, RST, Dpt. Nr. or Serial Nr.  
After the contest, edit CATEGORY-OPERATOR: SOAB-HP, SOAB-LP, MOAB-HP in 
log (see rules).  

 See the UDC file for more details. N1MM+ v4698 or later.  
 Filename: EPCFR.zip  

 
 

29. EPC Ukrainian DX 

Set of files for EPC Ukraine DX Contest (for participants outside of Ukraine). See the 
post on 11/29/2011 in N1MMLogger-Digital@yahoogroups.com for installation 
instructions  

 See the UDC file for more details  
 Filename: EPCUkrDX_FOR_DX.zip  

 
 

30. ES OPEN HF 

ES Open HF Championship  

 See the Read_me.txt file for more details  
 Filename: ES_OPEN_DX.udc or ES_OPEN_ES.udc  

 
 

31. EUCW Frat Party 

EUCW Fraternizing Party. Whatever is entered in Comment (Club Name) is a multiplier.  
Select log type: EUCWFP  
Exchange: Your name, (Club name), Member Nr. or NM  

 See the UDC file for more details  
 Filename: EUCWFP.udc  

 
 

32. EUCW ON5ME-160 

EUCW ON5ME-160 Party. Whatever is entered in Comment (Club Name) is a 
multiplier.  



Select log type: EUCW160  
Exchange: Your name, (Club name), Member Nr. or NM  

 See rules for more details.  
 Filename: EUCW160.udc  

 
 

33. FGUP 2011 

"Generic" contest, RS(T) and Serial Nr Exchange, All Callsigns are Multipliers.  

 See the UDC file for more details  
 Filename: FGUP-2011.UDC  

 
 

34. Flight of the Bumblebees 

Flight of the Bumblebees contest.  
Select file name: FLTOTBBS  
Exchange: State/Province/DXCC Entity and Power or Bumblebee Nr.  

 See the UDC file for more details  
 Filename: FLTOTBBS.udc  

 
 

35. G3ZQS Memorial Contest 

Fists G3ZQS Memorial Contest, can be used for Fists Sprints.  
Exchange: RST, State/Prov/DXCC, Name, and Fist# or Power  

 See the UDC file for more details.  
 Filename: G3ZQSMEM.udc  

 
 

36. GEDEBAGE 

Generic, RS(T) + Serial Nr. WPX Prefix Mult.  

 Filename: GEDEBAGE.udc  

 
 



37. GENERIC 

Template for Serial # and State(Prov) as exchange. One multiplier - Section  

 See the UDC file for more details  
 Filename: Generic.udc  

 
 

38. GENERIC2 

Template for Serial # and State(Prov) as exchange. 2 multipliers: Section and Country  

 See the UDC file for more details  
 Filename: Generic2.udc  

 
 

39. GENERIC RTTY 

Generic, Serial # and State(Prov) as exchange  

 See the UDC file for more details  
 Filename: GenericRTTY.udc  

 
 

40. HA National Championship OB 

Exchange: RS(T) + Last 2 characters of previous station worked, your own for the first 
contact  

 See the Read_Me file for more details  
 Filename: HA_NChamp zip  

 
 
 

41. HA3NS Memorial Contest 

Exchange RST and HACWG Member Nr or NM  

 See the UDC file for more details  
 Filename: HA3NS.udc  

 
 



42. International 2010 

SWL template, both Callsigns, RS(T) and Serial numbers are logged  

 See the UDC file for more details  
 Filename: SWL.udc  

 
 

43. International Lighthouse Week 2010 

International Lighthouse Week (Serial#, Name, Member# as applicable, Lighthouse# as 
applicable, State(Prov), as exchange)  

 See the UDC file for more details  
 Filename: ILLW-2010.udc  

 
 

44. IRTS80M 

IRTS 80 Metres Counties Contest. CW/SSB, 80m only, Serial # and County as 
exchange  

 See the UDC file for more details  
 Filename: IRTS80M.udc  

 
 

45. IRTS CQIR 

IRTS CQIR Contest  
Select File name: IRTSCQIR  
Exchange: Irish - Serial and County Code, Others - only Serial  

 See the UDC file for more details  
 Filename: IRTSCQIR.udc  

 
 

46. HINA33 

JLRS Hina 33 Contest. Multi Band, Multi Mode Contest. If using Data, Select 
MIXED+DIG on Contest Dialogue Setup window.  
Exchange: YLs send RS(T) and YL, OMs send RS(T) only.  

 Filename: HINA33RTTY.udc  



 
 

47. JW-FD 

JOCK WHITE MEMORIAL FIELD DAY (NZART). 80/40m, SSB/CW, Report/Serial 
#/Branch # as exchange, 1 hour sessions  

 See the UDC file for more details  
 Filename: JWFD.udc  

 
 

48. Kanagawa 

Internal JA contest  

 See the UDC file for more details  
 Filename: kanagawa.udc  

 
 

49. KCJ 

KCJ(Keymen's Club of Japan) contest. Version for the rest of the world (not JA), 
Prefecture as exchange  

 See the UDC file for more details  
 Filename: KCJ.udc  

 
 

50. Keymens Club of Japan 

KCJ (Keymen's Club of Japan Contest).  
Select file type: KCJ_JA or KCJ_DX as appropriate.  
Exchange: JA - Prefecture or District Code, Others, Continent Code e.g. EU  
See KCJ-DX.UDC for Non-JA entrants. v1.0.2; KCJ_JA.UDC for JA entrants  

 See the UDC file for more details  
 Filename: KCJ_DX.udc  

 
 

51. KT Serbia Cup 

KT Serbia Cup Contest  



 See KTKUP.txt in KTKUP.zip  
 Filename: KTKUP.udc or KTKUP_YU.udc  

 
 

52. Lighthouse Christmas Lights 2010 

Lighthouse Christmas Lights 2010  

 See the UDC file for more details  
 Filename: LCL-2010.udc  

 
 

53. Lighthouse Spring Lites 2010 

Lighthouse Spring Lites 2010,  

 See the UDC file for more details  
 Filename: LightHouseEvent.udc  

 
 

54. LY WAL Contest 

LY WAL Contest (Worked All Lithuania)  
Select file type: LYWAL  
Exchange: LY - WAL Area, Others, DX  

 See the UDC file for more details  
 Filename: LYWAL.udc  

 
 

55. Marconi Memorial Contest 

Marconi Memorial Contest. Generic, RST+Serial NR Exchange, CQWW-type Country 
Prefix as Multiplier  

 See the UDC file for more details  
 Filename: MARCONIMEM.udc  

 
 

56. Memory Lives Forever Contest 



Memory Lives Forever Contest. RS(T) and Op Age MAY Also Send and Rcv S.K. 
Callsign & Age. e.g. 559 79 G8FW 88 as exchange.  

 Filename: MEMORY.udc  

 
 

57. MOON CONTEST 

MOON CONTEST  
Select file type: MOONRTTY  
Exchange: Serial Nr + 6 Character Locator + Name of QTH  
Note =Use for all - restrict Band to suit. Generate correct claimed score after contest by 
editing qso points - do not rescore when prompted.  

 See the UDC file for more details  
 Filename: MOONRTTY.udc  

 
 

58. Moscow-Championship 

Moscow Championship. Oblast(Rus) and Serial # as exchange. Oblast and every 
Moscow (MA) callsign is multiplier  

 See the UDC file for more details  
 Filename: Moskwa_Champ.udc  

 
 

59. MULAN WAP 

MULAN DX Contest. 80,40,20,15,10m SSB/CW,Serial/Province  

 See the UDC file for more details  
 Filename: MulanDXC.udc  

 
 

60. North American QRP CW Club Sprints. 

Exchange: RST, State/Province/DXCC and Member Nr. or Power (include the 'W')  

 See the rules for more details.  
 Filename: NAQCC.udc  



 
 

61. NRL Cup 

(Russian internal contest).  

 See the UDC file for more details  
 Filename: NRLC.UDC  

 
 

62. NRRL TELEFONITEST 

NRRL (Norsk Radio RelÃƒÆ’Ã†â€™Ãƒâ€šÃ‚Â¦ Liga) TELEFONITEST  
(Internal Norwegian Contest)  

 See the UDC file for more details  
 Filename: NRRLTELE.udc  

 
 

63. NZART WW11 Memorial and VHF and up Contests. 

 See the Read_Me file  
 Filename: NZART.zip  

 
 

64. OBLAST 

Use as a template - serial # and Oblast(Rus) as exchange. Oblast is multiplier  

 See the UDC file for more details  
 Filename: Oblast.udc  

 
 

65. OH Domestic Events, Easter, Sainio, Summer, Autumn and Xmas. 

Exchange: RS(T) Serial Nr. and County Code.  

 See the ReadMe.txt file.  
 Filename: FINNdom.zip  

 
 



66. OH-PARKS 

OHIO State parks are multipliers. 1 point per every QSO  

 See the UDC file for more details  
 Filename: OH-Parks.udc  

 
 

67. OK-OM DX SSB 

OK-OM DX SSB Contest. OK-OM Stations send RS + County Code, Others send RS + 
Serial Nr. CQWW and County Codes are Mults.  

 See OKOM DX SSB.txt in OKOM DX SSB.zip  
 Filename: OKOMDXS.udc or OKOMDXS_DX.udc  

 
 

68. Old New Year 

RS(T) and NR (Age of OP. plus Years of Experience) as exchange  
Select file name: OLDNEWYEAR  
Exchange: Serial Nr and (Total of your Age + Number of Years YOU have held 
Licence).  

 See the UDC file for more details  
 Filename: OLDNEWYEAR.udc  

 
 

69. Original QRP 

O R I G I N A L - Q R P - C O N T E S T. Serial # and Category (VLP, QRP or MP) as 
exchange  

 See the UDC file for more details  
 Filename: OQRP.udc  

 
 

70. OZ ACTIV Contest 

(Danish Internal Contest?)  
OZ Activity Contest (Serial # and Post Code (first digit) as exchange)  

 See the UDC file for more details  



 Filename: OZACTIV.udc  

 
 

71. OZCHR-VHF 

OZCHR-VHF (Russian VHF contest). ?????? ?????? ??? ???????. VHF bands only, 6 
char. GriqSquare as exchange, dupes are not allowed on same band different modes  

 See the UDC file for more details  
 Filename: OZCHR_OCHN.udc  

 
 

72. PARLA 

PARLA(EA) CW CONTEST  

 See the UDC file for more details  
 Filename: PARL.UDC  

 
 

73. PN QUICK CW Contest 

Short Portuguese CW Contest. Members send PN Number, Others send Serial Nr.  

 See the Read-me file for more information.  
 Filename: PN_QUICKCW.udc or PNMQUICKCW.udc (in zip file)  

 
 

74. PODXS 070 Contests 

Use for several PODXS070 Club contests. Exchange Call, RST and State/Province or 
DXCC Entity. Use for PSK Festival, Jay Hudak Memorial, Pumpkin Sprint and 
Firecracker  

 See the UDC file for more details  
 Filename: PODXS1RTTY.udc  

 
 

75. PODXS 070 St. Patrick's Day Contest 

Use for PODXS070 Club St. Patrick's Day Contest. Exchange Call, Name, 
State/Province or DXCC Entity and Member Nr.  

http://n1mmplus.hamdocs.com/tiki-print_multi_pages.php??????%20??????%20???%20???????


 See the rules for more details  
 Filename: PODXS2RTTY.udc  

 
 

76. PODXS Triple Play Low Band Sprint 

PODXS070 Club Triple Play Low Band Sprint. Select log type: 070TPRTTY. Exchange 
Call, RST and State/Province/DXCC Entity.  

 See the PODXS Website for more details  
 Filename: 070TPRTTY.udc  

 
 

77. PODXS Valentine Sprint Contest 

PODXS070 Club Valentine Sprint. Select log type: 070VSRTTY. Exchange Call, Name, 
OM/YL and State/Province/DXCC Entity.  
After the contest, edit "YL"s to 2 points. Complete Contest name in log.  

 See the UDC file for more details  
 Filename: 070VSRTTY.udc  

 
 

78. Popov Memorial 

POPOV MEMORIAL CONTEST - RS(T) and NR (Years of Experience) as exchange  

 See the UDC file for more details  
 Filename: PopovMemorial.udc  

 
 

79. POPOV-VHF 

(Russian internal VHF contest). 2M only, serial # and GriqSquare as exchange, dupes 
are not allowed on same band CW, SSB and FM modes  

 See the UDC file for more details  
 Filename: Popov_Cup_VHF.udc  

 
 

80. PSK 31 Flavors 



31 FLAVORS CONTEST (PODXS). Former name - FLAVORSPSK.udc,  
Select file type: FLAVORRTTY  
Exchange: State/Province or DXCC Entity + 070 member number/Name, if not member  

 See the UDC file for more details  
 Filename: FLAVORRTTY.udc  

 
 

81. PW 144 and 70Mhz 

PW 144 and 70Mhz.  
Select file name: PW_144_70  
Exchange: Locator. 4 Character Square  

 See the UDC file for more details  
 Filename: PW_144_70.UDC  

 
 

82. QRP HF RTTY 

QRP HF RTTY Contest.  

Exchange: RST and CQ Zone  

 See the UDC file for more details  
 Filename: QRPHFRTTY.UDC  

 
 

83. R3A Cup Digi 

R3A Cup Digital Contest  
Exchange: RST and Oblast or Serial Nr  

 See the Read Me file in R3A_CDRTTY.zip  
 Filename: R3A_CDRTTY.udc  

 
 

84. R3E-SC 

Russian internal contest (\????? ?????????\"").""",  

 See the UDC file for more details  
 Filename: R3E-SC.UDC  



 
 

85. R4C Champ 

Russian internal contest (???????? ?????????? ??????????? ???????)  

 See the UDC file for more details  
 Filename: R4C-Champ.UDC  

 
 

86. R4W (Udmurtia, Russia) Open Championship 

Russian internal contest  

 See the UDC file for more details  
 Filename: r4w-champ.udc  

 
 

87. R6H Champ 

Russian internal contest (???????? ????????? ??????????????? ????)  

 See the UDC file for more details  
 Filename: R6H-Champ.UDC  

 
 

88. RCWC 4 Seasons 

Russian 4 Seasons Contests  

 See the Read_Me file for more details  
 Filename: RCWC4.zip  

 
 

89. REGION-NR 

Russian internal contest (????????? ?????????? ???????)  

 See the UDC file for more details  
 Filename: REGION-NR.udc  

 
 



90. RSGB UKAC (VHF) 

RSGB UKAC (VHF). VHF+ only,Points per Km and UK GriqSquare multiplier ",  

 See the UDC file for more details  
 Filename: VHF_Paul4.UDC  

 
 

91. RSGB VHF Contests 

This one Generic, Exchange RS(T), Serial Nr and Full Locator. 1 Point/Kilometer. No 
Multipliers.  

 See VHF_RSGB_ReadMe.txt in VHFRSGB.zip for other RSGB VHF Contests 
covered.  

 Filename: VHFRSGB.udc  

 
 

92. RUSSIAN160 

RUSSIAN 160 m contest (Contest Board will calculate points)  

 See the UDC file for more details  
 Filename: RUSSIAN160.UDC  

 
 

93. SALMON-RUN 

This contest is published for learning purposes only. WA QSO party (aka Salmon Run) 
is fully supported by the logger  

 See the UDC file for more details  
 Filename: Salmon_Run.udc  

 
 

94. SARA Spring Sprint 

SARA Spring Sprint. Exchange: RST, Locator and Class, Locator and WPXprefix are 
Mults  
Select file name: SARA  
Exchange: Your Locator and Class of entry.  

 See the UDC file for more details  



 Filename: SARA.UDC  

 
 

95. SARA Spring Sprint (OM) 

SARA Spring Sprint (for OM stations). Exchange: RST, Locator and Class, Locator and 
WPXprefix are Mults  
Select file name: SARAOM  
Exchange: Your Locator and Class of entry.  

 See the UDC file for more details  
 Filename: SARAOM.udc  

 
 

96. SARL Contests 

Several SARL Contests. See the Read_ME file in SARL.zip  

 Filename: SARL.zip  

 
 

97. SCAG SPRINT 

SCAG Sprint Cup  
Select file name: SCAG  
Exchange: Name + Member (SCAG Club) Nr or NM  

 See the UDC file for more details  
 Filename: SCAG.udc  

 
 

98. Seanet Contest 

Seanet Contest , RST + Serial as exchange, DXCC Countries as Multipliers.  
Seanet Countries use SEANETRTTY.UDC; Non Seanet countries use 
SEANETRTTY2.UDC (Rename to SEANETRTTY.udc after copying to N1MM\UDC 
folder)  

 See the UDC file for more details  
 Filename: SEANETRTTY.udc  



 
 

99. SKMEM 

Silent Key Memorial Contest. Exchange RST+ITU Zone or RST+a Silent Key Callsign.  

 Correct claimed score by deducting 1 point x Nr of Mults for each ITU Zone 
exchange received.  

 Filename: SKMEM.udc  

 
 

100. SMIRK 

Six Meter International Radio Klub contest. Exchange: SMIRK number, if the station 
worked has one, and grid  

 See the UDC file for more details  
 Filename: SMIRK.udc  

 
 

101. SP PGA Contest DX 

Polish PGA-Test, Non-SP Stations",  

 See the UDC file for more details  
 Filename: PGATEST-DX.udc  

 
 

102. SP PGA Contest SP 

Polish PGA-Test, for Polish Stations",  

 See the UDC file for more details  
 Filename: PGATEST-SP.udc  

 
 

103. Suffixes XXIX National 

Suffixes XXIX National (EA). RS and Province as exchange.  

 See the UDC file for more details  
 Filename: EASUFF29.zip  



 
 

104. SP WW EPC BPSK63 

SP WW EPC BPSK63 Contest.  
Exchange: RST+Serial or SP Province Code. Province and DXCC are Multipliers.  

 See SPEPC_RTTY.text in SPEPC_RTTY.zip  
 Filename: SPEPC_RTTY.udc or SPEPCORTTY.udc  

 
 

105. SPAR Winter FD 

SPAR (Society for the Preservation of Amateur Radio) Winter Field Day,  

 See the UDC file for more details  
 Filename: SPAR_FD.udc  

 
 

106. SRR JR 

SRR (Russia) youth hams contest  

 See the UDC file for more details  
 Filename: SRRJR.UDC  

 
 

107. SV Triathlon 

Exchange: RS(T) and Serial. Entrants using all three modes select MIXED + DIG in the 
Contest Setup Window. After the contest, edit Cabrillo file CONTEST: name to 
TRIATHLON-DX-CONTEST. Correct claimed score - multiply 'B3' number by 3, then by 
number of multipliers, add to previous claimed score.  

 FIlename: TRIATHRTTY.udc  

 
 

108. TA VHF UHF 

TA VHF UHF Contest. Exchange: RS(T) Serial Nr. (Start at 001 on each band) Full 
Locator. Select MIXED in the Contest Setup Dialogue Window.  

 Filename: VHF_UHF_TA.udc  



 
 

109. TARA SKIRMISH 

TARA SKIRMISH Contest. Exchange: Name and Prefix (Area locator),  

 See the UDC file for more details  
 Filename: SKIRMRTTY.udc  

 
 

110. TenTen QSO Parties 

Exchange: Name, TenTen #, & State(Prov. or Country). Use for all QSO parties - 
restrict mode to suit.  

 See the UDC file for more details  
 Filename: TENTENRTTY.udc  

 
 

111. Tesla HF Memorial Contest 

Exchange: RST, Serial Nr. and 4 Character Grid. After contest, edit own square 
contacts to 90 points.  

 Filename: TESLA_VHF.udc  

 
 

112. Texas Parks On The Air 

Exchange: Callsign and Park Designator, Texas, State, Province or DX  

 See the Read-Me file in the zip file.  
 Filename: TX-PARKS.udc  

 
 

113. The Day of YLs 

\Days of YLs\(YL/OM party) - Exchange: RS(T) + YL or OM. Work same station each 
band and mode.  
Select log type DOYLSRTTY  
Mode Select: If using all modes, select MIXED+DIG  
Exchange: OM or YL  



 See the UDC file for more details  
 Filename: DOYLSRTTY.udc  

 
{ANAME(){UBAPSK63{ANAME}  

114. UBA PSK63 Prefix Contest 

Exchange: RSQ and Serial Number Starting at 1001. Mults are WPX Prefix  

 See UBAPSK63_ReadMe.  
 Filename: UBA63RTTY.udc in UBAPSK63.zip  

 
 

115. UFT HF Contest 

Exchange RST, Member Number or NM  

 Filename: UFT-HF.udc (in UFT-HF.zip)  

 
 

116. UK DXC BPSK63 

Exchange Real RSQ, Serial Nr. and your DXDA Number.  

 See UKDX63.txt in UKDX63RTTY.zip  
 Filename: UKDX63RTTY.udc  

 
 

117. URAL CUP 

Ural Cup (Kubok Urala)  

 See the UDC file for more details  
 Filename: Ural_Cup.udc  

 
 

118. USi W/VE Islands Qso Party 

USi W/VE Qso Party  
If a station is going to use all three modes, in the contest set-up window select 
Mixed+Digi.  
Island stations should start a new log for each location (to re-start Serial Nr)  



Select file name: USI_QPRTTY  
Exchange: Island Designator(If Island station) and/or State/Province or DXCC Entity.  

 See the UDC file for more details  
 Filename: USI_QPRTTY.udc  

 
 

119. UT5EU-MEMORIAL-VHF 

VHF only, serial # and GriqSquare as exchange, dupes are not allowed on same band 
CW, SSB and FM modes  

 See the UDC file for more details  
 Filename: UT5EU_Memorial_VHF.u  

 
 

120. VHF GRIDS 

Worked All Provinces of The Netherlands: Exchange RS(T), Serial NR and Grid, Dutch 
Stations send RS(T), Serial NR and 2 figure Province Code. Unzip the file (there will be 
2 files - udc and txt), import CallHist_VHF_WAP.txt and turn Call History Lookup on.  

 See the UDC file for more details  
 Filename: VHF_WAP.zip  

 
 

121. VU Himalayan Contest 

Indian Stations send RS(T) and 2 figure State or Union Territory Code. Others RS(T) 
and Power  
Use the correct UDC file for your location.  

 See VU_Read-Me.txt in VU.zip for more details.  
 Filename: VU_HIMA_DX.udc or VU_HIMA_VU.udc (in VU.zip)  

 
 

122. VU International DX Contest 

Indian Stations send RS(T) and 2 figure State or Union Territory Code, others RS(T) 
and Serial Number.  
Use the correct UDC file for your location. Select log type: VU_DX_ VU=VU Stations, 
DX=Non-Asian Stations, ASIA=Non-VU Stations.  



 See VU_Intl_Read-Me.txt in VU.zip for full details.  
 Filename: VU_DX_VU.udc or VU_DX_ASIA.udc or VU_DX_DX.udc  

 
 

123. VU Summer (Internal) Contest 

Exchange: RS(T) and Serial Number  

 Select correct Mode Category in the Contest Set up Dialogue Window, e.g. 
MIXED+DIG if working all three modes.  

 Filename: VUSUMMRTTY.udc (in VU.zip)  

 
 

124. Vytautas Magnus trophy 

Vytautas Magnus Trophy (v1.0.2) Held the first Sunday AFTER the new year. 80m and 
2m. CW and Phone. Exchange RS(T), Serial Nr and full Locator(Multipliers)  

 See the UDC file for more details  
 Filename: VMTROPHY.udc  

 
 

125. WAB Contests 

Worked All Britain Contests  

 See WAB ReadMe in WAB.zip  
 Filename: WAB.udc  

 
 

126. Worked All China Provinces BY 

Worked All Provinces of China contest (for BY stations)  
Select log type: BY_WAPC_BY  
Contest Exchange: RS(T) and your Province i.d. DX send RS(T) and Serial Nr.  

 See the UDC file for more details  
 Filename: BY_WAPC_BY.udc  

 
 

127. Worked All China Provinces DX 



Worked All Provinces of China (for DX stations)  
Select log type: BY_WAPC_DX  
Contest Exchange: RS(T) and Serial NR, Chinese Stations send RS(T) and 2 figure 
Province Code.  

 See the UDC file for more details  
 Filename: BY_WAPC_DX.udc  

 
 

128. Worked all VK Shires 

Exchange RS(T) and VK Shire code, (DX send CQ Zone)  

 See VKshires_readme.txt in the zip file.  
 Filename: VKSHIRES.zip  

 
 

129. World Lighthouse OTA 

World Lighthouse OTA. Exchange: RS(T) Serial Nr, plus Lighthouse Expeditions send 
Reference Nr (Lxxxx)  

 See the UDC file for more details  
 Filename: WLOTARTTY.udc  

 
 

130. WSEM minitest 

This contest is already implemented as MINITESTCW in the logger. Use this udc file for 
learning only. RST, Serial Nr, 80 metres only. Note=Contest is every Wednesday, 1800-
1900 GMT, six periods, work each station each 10 minutes, each call is mult once ",  

 See the UDC file for more details  
 Filename: WESM.udc  

 
 

131. YACHAMP 

YAKUTIA CHAMPIONSHIP (???????? ????????? ??????)  

 See the UDC file for more details  
 Filename: YA CHAMP.UDC  



 
 

132. YL-OM 

The YL-OM Contest is scheduled (1400 UTC Feb-11-2011 thru 0200 UTC Feb-13-
2011)  
Exchange: Station Worked, QSO Number, RST, ARRL/RAC Section or DX Country",  

 See the UDC file for more details  
 Filename: YLOM.udc  

 
 

133. YO PSK31 

YO PSK31 contest. RST, Serial NR and Country ID (e.g. G) - YO send County Code as 
exchange  
Select file name: YORTTY  
Exchange: Serial Nr and Your Country Prefix - YO Stations: Serial Nr and County Code  

 See the UDC file for more details  
 Filename: YORTTY.udc  

 
 

134. Battle of Carabobo Contest. 

Exchange: RS, Serial Nr, YV Stations also send District code(Mults by band)  

 See the Read-Me file in YV_CARABOBO.zip  
 Select file name: YVBC_SSBYV.udc or YVBC_SSBDX.udc  

 
 

135. ZOMBIE 

Exchange: S/P/C + Zombie NR/Phone 3 digit area code + Name + Years held Licence. 
CW only.  
Select file name: ZOMBIE  
Exchange: State/Province/Country I.D. and your Zombie Member Nr or 3 Digit phone 
area code and your Name and Number of years you have held Licence.  
Work out your score. (See rules)  

 See the UDC file for more details  
 Filename: ZOMBIE.udc  
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1. Call History Lookup 

Call History Lookup is a feature that can be used to pre-fill the exchange during a 
contest to save typing, or to display user comments or notes for specific call-signs. The 
sources of Call History data can be files from other sources, previous contest logs, or 
hand-generated data files of your own.  Your club may generate Call history files for 
Sweepstakes, for example, or you may choose to generate your own from last year's 
log.  You might choose to harvest names and call-signs from your general log, so that 
you can recognize people by name on the air.  

1.1. Introduction 

Before using the Call History Lookup feature, Call History Lookup must be enabled on 
the Entry Window's Config menu, and  the user must import a text file or files containing 
comma-or semicolon-separated data into the Admin database.  

A fairly large number of contest-specific Call History text files may be found in the Call 
history Files section of the Files menu on this web site. For many of us, these will be the 
preferred source of data for the Call History Lookup function.  

You can also build a Call History text file from your previous year's log. Simply open the 
old log, click > Tools > Clear Call History to empty the Call History database table, then 
click Update with Current Log. To save the Call History text file, use the Export>Export 
Call History option on the Entry window's Files menu, and give the exported file an 
easy-to-find filename.  

And, of course, you can always load Call history text files into the database directly from 
the Call History Files user directory.  

If you want to draw on multiple logs for the same contest, or indeed combine multiple 
Call History files into a single database table, you can do so simply by going to 



File>Import>Import Call History and holding down the Ctrl key while you click multiple 
text files.  

There can be only one Call History table present in the Admin database at a time, 
and it remains in the database unless replaced with another. A Call History text 
file can be imported manually, or associated with a specific contest on the 
Associated Files tab of the Contest Setup dialog. As you can imagine, it is easy to 
forget that you have the wrong call history table in the database, left over from 
last weekend, so we recommend you use this feature.  

When a callsign is typed into the Entry window and the Space bar is pressed (or Enter, 
in the ESM case), the Call History database table is searched. If the callsign is found, 
the associated Call History data is displayed on the "beam heading" line in the Entry 
window. If the contest exchange fields are blank, the data retrieved from the database 
are also used to pre-fill any relevant  exchange field(s) in the Entry window.  

if "Show User Information" is checked on the Entry window's right-click menu, data from 
the Call History table is also displayed on the Bearing line. If Call history Lookup is not 
enabled, data from the User Text field of the table is still displayed on the User Data 
line, below the Bearing line.  

Here are some Entry window examples. The first shows the Entry window with both the 
exchange data and user data (his QTH, in this case) displayed.  

 
 
In VHF contests, the grid square from the Call History table is used to calculate the 
beam heading reported in the Bandmap.  



 

1.2. The Call History Text File 

This section describes the layout of the default Call history text file and the database 
table into which the Call history is imported.  

The Call History Text File can be created by any text editor - Notepad is fine. The file is 
comma- or semicolon-delimited, which means that the items of data are in specific 
locations. The default structure, also reflected in the database table, is:  

Call, Name, Loc1, Loc2, Sect, State, CK, BirthDate, Exch1, Misc, UserText, 
LastUpdateNote. This order is fixed, and if you use the default order, then you must 
include a comma in each record in the input text file for each field, even if the field is 
empty. Here's an example:  

N9RV,,,,06,,-1,1900-01-01,,,,Log update edit fields  

As you can see, the file has a number of empty fields before we come to "06", which is 
the ITU zone number, and is put in the Sect field, because this contest draws from the 
Sect field to prefill the station's zone.  

1.2.1. Import Directives 

You can move or exclude columns of data, map ARRL section to State, map State to 
ARRL section, or truncate a six character grid square to four characters. This is 
accomplished with the use of import directive commands, which are surrounded  with 
"!!" , to tell the program that they are instructions, not data. When an import directive 
command is read, the import routine follows that instruction until another import directive 
command is read or all data is imported. Import directive commands can be repeated if 
the data structure or field order changes in the data.  

Here is a list of the import directive commands that can be used in a Call History text 
file:  



  !!Order!! - defines the order of the comma separated input data that follow  
  !!MapStateToSect!! - populate empty Sect field from the State information  
  !!FourCharGridSq!! - truncates 6 character grid squares to 4 character grid squares  
  !!AppendUserText!! - append additional user text into the UserText field (default)  
  !!NoAppendUserText!! - do not append user text into the UserText field, new data 
replaces prior  
  !!Validate50State!! - ignore all state data that isn't one of the 50 states  
!!NoLoc2AltGrid!! - do not move the existing Loc1 grid into Loc2 for an alternate grid 
location  
!!MapOnSection!! - map GTE, ONN, ONE, ONS to ON section  
!!ValidateArrlSection!! - remove any section that is not an ARRL section (includes VI, 
PR) Can be used to remove ON  

Every exported Call History text file lists the import directives, the field names, and the 
maximum size. Here are the Call History field names along with the maximum size. The 
import routine will truncate any field that exceeds the maximum, discard any CK value 
that is not a number, and discard any Birthdate that is not a date.  

  Call(15), Name(20), Loc1(6), Loc2(6), Sect(8), State(8), CK(#), Birthdate(date), 
Exch1(12), Misc(15), UserText(60),  

If an  !!Order!! input directive is not read during file import, the routine expects the data 
to be in this comma separated order:  

 
Here's an example of Call History data that will import without an import directive:  

K3CT, JOHN , , , ,PA , , ,NHA, , N1MM Program Developer  

As you can see, each comma denotes a field.  Successive commas mean empty fields. 
Spaces can be added to make it easier to count the number of commas. If this single 
line file was imported into the Call History database and the Call History Look Up option 
is enabled, the Entry window for the PA QSO Party would appear like this when the 
callsign K3CT was entered and spacebar pressed (or Enter with ESM):  

 



 
As you can imagine, making sure you have the right number of commas between actual 
data in the text file can be a problem.  Fortunately, the !!Order!! command offers a 
simple solution. For example, you create a text file that looks like this:  
!!Order!!, Call, Name, CK, Sect  
N4ZR, Pete ,54 ,WV  
N3OC, Brian, 67, MDC  

When you load it into the Call History database, the data will be put in their proper 
places in the Call History table, and when you operate in Sweepstakes, for example, 
with Call History Lookup enabled, the program will pre-fill the check and section in the 
Exchange field, and will display the name and all the other data in the Bearing line of 
the Exchange Window.  This redundancy is deliberate, because if you set out to edit the 
Exchange and then realize that the pre-filled data were correct, they are there for ready 
reference.  

What this change has done is to make it much easier to generate Call History text files 
for importing into the Call History database. For example, you could generate a file that 
contains calls, names, checks and sections for everyone you worked last year in 
Sweepstakes, and by writing the correct !!Order!! line, like this:  
!!Order!!,Call,Name,CK,Sect  

The !!Order!! import directive can also be used to ignore columns of data. For instance, 
if the data file contains additional columns as shown below:  
DD3JN, 70 23, GERD, JO42AI,JO31OE  
PA1M, 144 70, Carel, JO33FE, JO33II  

The second column can be ignored with the import directive prior to the data.  
!!Order!!, Call,, Name, Loc1, Loc2  
DD3JN, 70 23, GERD, JO42AI,JO31OE  
PA1M, 144 70, Carel, JO33FE, JO33II  

Alternately, the second column of data can be placed in the UserText field with the 
following import directive:  
!!Order!!,Call,UserText,Name,Loc1,Loc2  
DD3JN, 70 23, GERD, JO42AI,JO31OE  
PA1M, 144 70, Carel, JO33FE, JO33II  

The Supported Contests section of this manual may include the Call History field(s) 
used for exchange information. If the field information is not listed in this section follow 
this procedure to determine which Call History field to populate.  

 Open a new contest log.  
 Log some dummy QSO's that contain the exchanges of interest.  
 Click Tools, Clear Call History then Update with Current Log.  
 Export the Call History (File, Export, Export Call History) and examine the 

exported QSO text.  
 Place the exchange data in the populated call history field. The coding of some 

contests is complex. It is not unusual to find that contests that store information in 



fields for points calculation, determining multipliers, or exporting Cabrillo. 
Therefore, it may not be necessary to populate all of the Call History fields.  

 
If your Call History file import doesn't function correctly, review the import directive(s) to 
make sure they match the field names. For example, you must use Sect, not sec or 
Sec, and Ck, not Check. Field name case is not important. All of these field names 
will import data into the Sect field: Sect, SECT, sect, sEcT, SeCt. If problems continue, 
post a message on the N1MM Logger email reflector asking the other users for help.  

1.2.2. Associating Call History Files with a Contest 

If you want to have a specific Call History Lookup file loaded and enabled whenever you 
start that contest, you can do this two ways. Either add the filename to the Associated 
Files tab for the contest log, or add the short contest name (the one in the Contest 
Setup dialog) to the Call History text file as a comment (preceded by a "#". You can 
even have it loaded and used for more than one contest, by putting in multiple contest 
names. Example (omit the quotation marks):  
"#NAQPCW"  
"#NAQPSSB"  
For QSO parties, the state abbreviation is required after the contest name. Example:  
"#QSOParty PA"  

1.3. Related Menu Options 

 >Config >Enable Call History Lookup  
o Check to enable Call History Lookup.  

 >File >Import  >Import Call History  
o Select the file to be imported.  All information in the Call History table in 

the Admin database is erased, and the imported information substituted.  
 >Tools >Update Call History with Current Log  

o Update the call history table in the current database with the QSOs from 
the current log. Contacts will be added when new or updated when 
already in the call history table. For the 2 grid fields the behavior is a bit 
different. When both grid fields are filled and a new third grid has been 
logged, the second grid (oldest) will be removed, and replaced by the 
contents of the first field. The new grid will be added to the first position. 
The same change in position will happen when only the first grid is filled 
and a new grid has to be added from the log. A 4 digit grid will be 
overwritten by a 6 digit grid when the first 4 characters are the same.  

 

 > Tools > Clear Call History then Update with Current Log  
o As above, except clears the call history table before adding contacts from 

the current log. Can be used to start a new Call History table.  

 >File >Export >Export Call History  



o Exports the information in the Call History table. It is very important, 
particularly if you have changed the Call History table, to re-export the 
data as a Call History text file.  Otherwise, any changes will be 
lost.  You are given the opportunity to rename the text file so that, for 
example, a 2008 SS file can be renamed 2009 SS, to indicate that it has 
been updated.  

You can import any Call History file that you formerly used without an !!Order!! 
directive.  When you export a Call History text file, the program fills in the commas that 
are necessary to fit the default order, as well as -1 for each empty CK and 1900-01-01 
for each empty Birthdate.  This is necessary to ensure compatibility with your old Call 
History files.  

2. Reverse Call History Lookup 

old-edit  

In addition to the regular Call History lookup, where you type a call sign into the Entry 
window and the program pre-fills the exchange based on the data in the Call History file, 
there is also a Reverse Call History lookup feature, where you can enter an exchange 
into the Entry window and the program will search the log and the Call History file for 
callsigns that correspond with that exchange. This does not work in all contests (for 
example, it makes no sense for serial numbers and it doesn't work for Sweepstakes 
because of the complicated exchange). If the Call History lookup option is selected, the 
Reverse lookup feature will search the Call History file as well as the log.  

The Reverse lookup feature is enabled using a pop-up (right-click) menu item in the 
Check window. If the Reverse lookup feature is not available for that contest, the menu 
item will be greyed out. Once the Reverse lookup feature has been enabled, you can 
type an exchange, or a partial exchange, in the exchange box in the Entry window, and 
if the number of characters typed in is equal to or greater than the threshold (which you 
can set with another pop-up menu item), the program will search in the log and the Call 
History table for callsigns whose exchange matches the typed-in exchange. Up to 100 
matching callsigns will be displayed in the Check window. Once you have determined 
which of the matching callsigns is the correct one, you can click on it in the Check 
window and the callsign and exchange will be transferred into the Entry window.  

If there was a full or partial call sign entered into the callsign box in the Entry window 
before entering the exchange, only call signs from the log or Call History file that match 
the partial call sign in the Entry window will be displayed in the Check window, and they 
will appear below the regular matching callsigns that were filled in from the log and the 
SCP file.  

You can also control whether the matches for the partial exchange can be found 
anywhere in the exchange field in the log and Call History file, or if the match must 
begin with the first character (that is, whether BC will match all of AABCD, ABC, BC, 
BCDE, etc. or whether it will only match BC, BCDE, etc.). Limiting the match to the first 
characters and/or increasing the threshold for the number of characters matched will 
result in faster lookups and smaller numbers of matching callsigns found.  

http://n1mmplus.hamdocs.com/tiki-index.php?page=Check+Window


× 

 Note 

Both for prefilling the exchange and for reverse lookup, the name of the field in which 
the data is stored in the Call History file must match the name of the field that is used in 
that particular contest. For example, if the state/province is part of the exchange, 
depending on the contest that part of the exchange might match the State, Sect or 
Exch1 field in the Call History file. You can use the !!Order!! directive to ensure that data 
in the Call History file is associated with the appropriate field name for the contest. For 
example, if you have a Call History file for the NAQP that looks like this:  
!!Order!!,Call,Name,State  
K3CT,John,PA  

then to use this same data file in a state QSO Party, you might have to change the first 
line of the file to!!Order!!,Call,Name,Exch1while leaving the rest of the data 
unchanged.You can determine which fields are used in a given contest type by creating 
a dummy instance of the contest, entering some typical fake contacts, using the Tools > 
Clear Call History then Update with Current Log menu item, exporting the Call History 
file to a temporary text file, and then examining that file with a text editor to see which 
field names are used for which exchange fields in that contest type. For some contest 
types, you may find the same exchange data in two fields in the Call History file. In such 
cases you may have to experiment to determine which of the fields is/are used for 
reverse lookup. 

 

2.2 Supported Radios 

old-edit xxx  

XXXMost of this is probably version-independent, but should be reviewedXXX  
XXXThere may have been some changes, old radios deleted and new radios added 
between Classic and PlusXXX  

 2.2 Supported Radios  

o 1. General Information  
o 2. Manual Mode - No Radio Selected  
o 3. Digital Mode Mapping  
o 4. Alinco  
o 5. Elecraft  

 5.1. K2  
 5.2. K3 and K3S  
 5.3. KX3  

o 6. FlexRadio  

 6.1. Flex-6000 Series  
 6.2. Flex-5000A with RX2  
 6.3. Flex-1500, Flex-3000, Flex-5000A without RX2  



 6.4. SDR-1000 and SDR-5000A (using Kenwood settings)  

o 7. Icom  

 7.1. General Icom Information (all Icom owners please read)  
 7.2. IC-271 / IC-471 / IC-1271  
 7.3. IC-275A/E/H using address 10 hex  
 7.4. IC-375 / IC-575 (all versions)  
 7.5. IC-475A/E/H using address 14 hex  
 7.6. IC-703 using address 68 hex  
 7.7. IC-706 using address 48 hex  
 7.8. IC-706MKII using address 4E hex  
 7.9. IC-706MKIIG using address 58 hex  
 7.10. IC-718 using address 5E hex  
 7.11. IC-725 using address 28 hex  
 7.12. IC-728 using address 38 hex  
 7.13. IC-729 using address 3A hex  
 7.14. IC-735 using address 04 hex  
 7.15. IC-736 using address 40 hex  
 7.16. IC-737/737A using address 3C hex  
 7.17. IC-738 using address 44 hex  
 7.18. IC-746 using address 56 hex  
 7.19. IC-746 PRO using address 66 hex  
 7.20. IC-751/751A using address 1C hex  
 7.21. IC-756 using address 50 hex  
 7.22. IC-756 PRO using address 5C hex  
 7.23. IC-756 PRO II using address 64 hex  
 7.24. IC-756 PRO III using address 6E hex  
 7.25. IC-761 using address 1E hex  
 7.26. IC-765 using address 2C hex  
 7.27. IC-775/775DSP using address 46 hex  
 7.28. IC-781 using address 26 hex  
 7.29. IC-821H using address 4C hex  
 7.30. IC-910H using address 60 hex  
 7.31. IC-1275A/E using address 18 hex  
 7.32. IC-7000 using address 70 hex  
 7.33. IC-7200 using address 76 hex  
 7.34. IC-7400 using address 66 hex  
 7.35. IC-7410 using address 80 hex  
 7.36. IC-7600 using address 7A hex  
 7.37. IC-7700 using address 74 hex  
 7.38. IC-7800 using address 6A hex  
 7.39. IC-9100 using address 56 hex  

o 8. Kenwood  

 8.1. General Kenwood information  
 8.2. TS-480  
 8.3. TS-570  
 8.4. TS-590  



 8.5. TS-850  
 8.6. TS-870  
 8.7. TS-950sdx  
 8.8. TS-50, TS-140, TS-440, TS-680,TS-711,TS-790,TS-811,TS-

940  
 8.9. TS-2000  
 8.10. N1MM logger loses communication with the radio (TS-850, 

TS-950 etc.)  

o 9. TenTec  

 9.1. General TenTec information  
 9.2. ARGONAUT V  
 9.3. ARGONAUT VI  
 9.4. JUPITER  
 9.5. OMNI-VI  
 9.6. OMNI-VII  
 9.7. Orion  
 9.8. Eagle  

o 10. Yaesu  

 10.1. General Yaesu information  
 10.2. FT-80C  
 10.3. FT-100(D)  
 10.4. FT-736  
 10.5. FT-450  
 10.6. FT-747GX  
 10.7. FT-757  
 10.8. FT-757GXII  
 10.9. FT-767 / FT-767GX  
 10.10. FT-817  
 10.11. FT-840  
 10.12. FT-847  
 10.13. FT-857, FT-857D  
 10.14. FT-890  
 10.15. FT-897  
 10.16. FT-897D  
 10.17. FT-900  
 10.18. FT-920  
 10.19. FT-950  
 10.20. FT-990  
 10.21. FT-991  
 10.22. FT-1000(D)  
 10.23. FT-1000MP (Mark-V)(Field) (Not for use with SteppIR 

antenna controller)  
 10.24. FT-1000MPSteppIR  
 10.25. FT-1000 series, FT-990 and FT-920 Setting filters  
 10.26. FT-2000  
 10.27. FTDX-1200  



 10.28. FTDX-3000  
 10.29. FTDX-5000  
 10.30. FTDX-9000  

o 11. Unsupported Radios  
o 12. Other Models  

Note: Known settings for specific transceivers, as well as program features that they do 
not support are mentioned below as far as we know them. Please advise us of any 
corrections or needed changes.  

1. General Information 

 When using a home-brew self-powered interface set the handshaking to:  
o DTR - Always On  
o RTS - Always On  
o Like when using ICOM clone cables  

 All radios: Band change is not allowed while transmitting  
 All radios: Timeout for all radios is default set to 10 seconds (user settable). 

Users generally increase this value to 13 - 15 seconds.  
o Some radios require initialization commands for configuration. These are 

sent to the radio when the program starts. Users should have the radio 
and interface powered prior to starting the program so this can occur. If 
the radio needs to be power cycled after the program has initialized, right 
click in the Bandmap and select Reset Radio to perform this initialization 
again.  

o A warning message will be displayed when no response received from the 
radio and the radio will be changed to a manual radio by the program.  

o To restart the radio radio interface polling select in the right-click menu 
from the bandmap "Reset radios"  

o When the radio control gives a warning 10 seconds after you start the 
logger, then you never had radio control at all, and you should check your 
hardware, and serial port settings. Consult the manual from your radio and 
also read below.Some radios require initialization commands for 
configuration. These are sent to the radio when the program starts. Users 
should have the radio and interface powered prior to starting the program 
so this can occur. If the radio needs to be power cycled after the program 
has initialized, right click in the Bandmap and select Reset Radio to 
perform this initialization again  

 Polling of radios while sending CW is supported for all radio except for FT-1000.  
 It may appear that the Up Arrow, Down Arrow, Page Up or Page Down are not 

working when incrementing or decrementing the current frequency with these 
keys.  

o The VFO frequency will not change if the incremented/decremented 
amount is smaller than the frequency deltas supported by your rig. This is 
not always well documented by the manufacturer. Icom 751 rigs for 



example do support 10 Hz steps but only show 100 Hz steps on the 
display.  

o The keys mentioned above have to be set higher than the minimum step 
size supported by the radio.  

o It's easy to test if it is the keys are working. Check the frequency while 
pressing the keys mentioned above. If the frequency moves nothing has to 
be changed.  

o The default increment/decrement for CW is 10 Hz. If this doesn't work, try 
changing it to 100 Hz, under the Configurer, Other tab.  

o This only applies to the keys that increment/decrement the current 
frequency.  

 Memory mode - most modern radios have a kind of memory mode. In this mode, 
the radio will not provide the correct polling data to the program. VFO mode is 
required.  

 When SO1V mode is selected, VFOB is not defined for receiving. The second 
Bandmap and Entry window are automatically closed.  

 Sending CW characters via radio command (CAT) is not supported due to the 
limitations and contesting requirements. A COM, LPT, WinKey, or similar 
interface built into the radio (Elecraft K3) is required to send CW.  

 USB and USB to COM interfaces:  
o Do not turn off radios while the program is running if the radio is 

connected via USB port. Exit the program first.  
o Do not unplug a USB to COM converter while the program is running. Exit 

the program first.  
o The device driver will remove the COM port from the hardware table and 

the program will hang then eventually timeout. Programs written in Visual 
Basic and use MSCOMM control can not detect a COM port that is 
removed from the hardware device table. This is a Microsoft bug.  

2. Manual Mode - No Radio Selected 

In manual mode no radio is selected and attached to the program. If possible always 
connect a radio using the CAT interface or serial port. Older radios (or very new not 
supported radios) can still be used with the program by selecting Manual but many 
functions in the program will not work as easy as they could or will not work at all. When 
a radio is not configured, it is the user's responsibility to make sure the mode and band 
are correct when logging contacts. When no radios are selected in Configurer, the 
program will attempt to set the initial operating mode and frequency in single mode 
contests when the program starts or a new contest is opened. The program uses 
information from the contest selection and the mode tab settings in Configurer.  

3. Digital Mode Mapping 

Below information by Rick, N2AMG and John, K3CT regarding supported Digital 
configurations by N1MM logger.  

 



Radio Modes Corresponding to N1MM Logger Digital Mode Designations 
Column Headings = Mode names used in N1MM Logger 

Radio RTTY RTTY-R AFSK 
AFSK-
R 

PSK PSK-R 

Flex 
  

DIGL DIGU 
  

FT990/1000/1000MP RTTY-L RTTY-U 
PKT-
LSB 

(4)  
  

FT100 
  

Dig(3) 
   

FT950/2000/3000/5000/9000 
FSK(RTTY-
LSB) 

FSK-
R(RTTY-
USB) 

PKT-
LSB 

PKT-
USB   

FT450 RTTY-L RTTY-U 
User-
L 

User-
U   

FT817/857/897 
  

Dig(3) 
   

FT920 
Data-
LSB(2) 

Data-
USB(2)     

IC7600/7700/7800 RTTY RTTY-R 
LSB-
D1 

USB-
D1 

PSK 
PSK-
R 

IC746Pro/756Pro/7200/7410/9100 RTTY RTTY-R 
LSB-
D 

USB-
D   

Other Icom RTTY RTTY-R 
    

Orion/OmniVI/OmniVII FSK 
     

K2 
  

RTTY 
RTTY-
R   

K3 FSK D FSK D-R 
AFSK 
A 

AFSK 
A-R 

DATA 
A 

DATA 
A-R 

TS2000 FSK (1) 
    

TS480/590/Other Kenwood FSK FSK-R 
    

 
(1) = radio menu selection 
 
(2) = FSK/AFSK selected by a rear panel switch 
 
(3) = Radio menu programmable for RTTY, RTTY-R, PKT-L, PKT-U 
 
(4) = FT990/1000/1000MP selection does not support PKT-USB  



If your radio does not have an entry under AFSK or PSK, use LSB or USB (e.g. 
Argonaut/Jupiter/FT840/847/890/900/757GXII). If there is an entry under AFSK-R but 
not under PSK, try using AFSK-R for PSK31 and other digital modes.  

4. Alinco 

 DX-77 - supported  

5. Elecraft 

 Elecraft USB-serial converter issues and N1MM logger  
o Situation: Setting up Elecraft K3 to work with N1MM logger and simply key 

CW with DTR line of CAT port.  
o Results: CAT works fine, but every time I try to send CW there appears an 

error window "CommPortDev_OnComm 4 - 2147417856"  
 N1MM is totally blocked and has to be killed using task manager.  

o Solution: Early Elecraft USB-serial converters used a Prolific chip, and the 
(Win2K) Prolific driver doesn't work correctly for CAT and DTR-CW-keying 
using the same port. Elecraft has since that time switched to an FTDI 
USB-serial converter, and newer Elecraft USB-to-serial adapters don't 
have this problem  

 A USB-serial converter using a FTDI-chip and the FTDI drive is 
working fine, CAT ok, fast CW keying, ESC immediatly interrupts 
message ...  

 All ufb now :- Tnx Thomas DK3DUA  

5.1. K2 

o Uses Kenwood-style commands but has its own radio selection. Only the 
KY command which is Elecraft specific is not supported.  

o Use default Kenwood parameters but sometimes one (1) stopbit only 
works (contrary to the K2 KPA100 manual saying that 2 stop bits should 
also work).  

o N1MM Logger does not support the K2 "virtual keying" feature using 
commands sent to the K2 serial port.  

o Setting the "Wide" and "Narrow" filter codes.  
 Remember to set the filter codes for both VFOs. Get the 

appropriate N1MM Logger screen menu prompt by left clicking 
when your cursor is over the active VFO window.  

 Substitute this code for the complete Kenwood "FL" code that 
comes up by default: K22;FW99991;K0; (no spaces, all caps, 
include the ";"'s) This will set the filter to "FL1" on the K2. If you put 
this code in the SSB "Wide" section for the filter code, it will give 
you FL1 for SSB - if you put this in the CW "Wide" section, it will 
give you FL1 for CW. Remember that the actual bandwidth of the 
filter will depend on how you have set FL1 on your K2. The same is 



true when you substitute this string for the "Narrow" settings. If you 
want a filter other than FL1 in either mode, just change the "1" after 
the 9999 to the number of the filter you want to invoke ie: 1,2,3 or 4. 
As an example, K22;FW99993;K0; placed in the code section for 
CW "Narrow" would invoke FL3 when the switch is set to "Narrow" 
and you are on CW.  

 Briefly, "K22" tells the K2 that this is an "extended command mode" 
- the ";" tells the K2 that this command is finished - the "FW" tells 
the K2 that this is a command to set the filter width - the 9999 
number is ignored in the string but is necessary to include (it can be 
any set of four numbers between 0 and 9999 - I just picked 9999) - 
the "1" is the number of the filter to invoke (1 - 4) - the "K0" (that is 
"K" zero) tells the K2 to go back to the "normal command mode."  

 Use the same technique to set the RTTY filters as well. Have fun es 
73, Don N4HH  

o Please check out the feature which works great with the K2 and TS850 etc 
that don't have RIT clear IF you are Running (doesn't work for S&P). Put 
the rig into split, and use VFO B as your "RIT". Then go into Config, and 
turn on "Reset RX Freq when Running Split". Using VFO B for RIT, tune in 
a caller off freq, work him, and at the end of the QSO VFO B will be set to 
VFO A freq. Neat feature, and specifically designed for this situation.  

5.2. K3 and K3S 

o The K3 contains a firmware bug that was reported several times and 
never been fixed which affects users who would like to use PTT via radio 
command. If the Esc key is pressed when a CW transmission begins and 
you are using PTT via radio command, the radio may not return to RX. 
The radio RX issue doesn't occur if the owner disconnects the CW jack 
from the rear of the K3 radio and doesn't change any N1MM Logger 
setting. Similar issues have been reported on other modes. Delay has 
been added to the N1MM Logger program when Esc is pressed but the 
problem still occurs intermittently. The problem seems to be worse with 
the very early K3 radios. Until this firmware issue is corrected, users may 
notice that the radio does not return to RX intermittently when using PTT 
via radio command. When this occurs, make another transmission and 
end it with the ESC key.  

o Radio control issues have been reported when running other K3 utility 
software (such as LP-Bridge) in conjunction with N1MM Logger. Please 
test with only N1MM Logger+ running without the other software before 
reporting a radio control issue, in order to eliminate the other software as a 
possible source of the problem.  

 Note also that when using LP-Bridge, changes of band, mode and 
VFO may take longer than without LP-Bridge. During the process, it 
is possible for the radio and the program to be temporarily out of 



sync, and you may see some apparent instability in the band panel 
in the entry window and/or brief flashing of the Split indicator in the 
entry window. This is normal and should clear within a fraction of a 
second.  

o A single receiver K3 can be used in SO1V or SO2R mode. A dual receiver 
K3 can be used in all program modes, including SO2V. In order to transmit 
from VFO B in SO2V or split mode, both VFOs must be on the same band 
(the K3 does not support cross-band split operation, although it is possible 
to receive on two separate bands simultaneously).  

o In a dual receiver K3, the radio's front panel Split indicator can be 
misleading. What it actually means is that the transmitter is using VFO B. 
In SO2V, if you use a function key while the keyboard/RX focus is in the 
VFO B entry window or if you click on a function key button in the VFO B 
entry window, the radio's Split indicator will be displayed even though you 
are not actually operating split. This is because you are transmitting from 
VFO B. To determine whether you are logging in split mode or not, look for 
the Split indicator in the Logger's entry window and not the indicator on the 
radio's front panel.  

o You can operate split from either entry window in SO2V, but in order to 
transmit from the correct VFO and have the transmit and receive 
frequencies logged correctly, you must enter Split mode from the program 
(using Ctrl+S or Ctrl+Alt+S) and not by pressing the K3's Split button. If 
you are using "reverse split" (i.e. logging the contact in the VFO B entry 
window, listening to the subreceiver on VFO B and transmitting from VFO 
A) the Split indicator in the entry window will be displayed, but the K3's 
front panel Split indicator will not be displayed because the transmitter is 
using VFO A.  

o When you change transmit focus between entry windows, the Logger may 
display a Split indication temporarily in the entry window(s) while the 
program and radio status are temporarily out of sync in the process of 
changing. This condition is most likely to be seen when using LP-Bridge. It 
should only last for a fraction of a second. If the condition persists, check 
to see whether you are trying to operate in a mode the radio does not 
support (e.g. transmitting from VFO B with the two VFOs on different 
bands is not supported by the radio).  

o The stereo (grave accent - ` key, at the left end of the number keys row on 
many keyboards) toggles Sub on and off. It is identical to pressing the 
SUB radio button. To leave SUB on all the time, select Config > Sub 
Receiver Always On  

 If you have selected Diversity mode on the radio, toggling Sub off 
and on via ` or Alt+F12 will turn Diversity mode off  

 Logger preserves diversity reception on the K3 unless RX Focus 
changes to vfoB at which time the subRX will switch to vfoB (note 



that in diversity reception mode, both receivers are using VFO A, so 
full SO2V functionality is not available without leaving diversity 
mode)  

o K3 SubRX ON/OFF control by Logger  
 Independent of the state of Sub Receiver Always On:  

 changing RX Focus to vfoB turns the subrx ON  
 Ctrl+Shift+Up/Dn does not change the state of the subrx  
 Alt+F12 or ` toggles subRX ON/OFF if RX Focus is on vfoA 

(action disabled if RX Focus on vfoB)  
 Sub Receiver Always On checked:  

 clicking any vfo bandmap/avail. window spot or Ctrl+Up/Dn 
turns the subRX ON  

 changing RX Focus turns the subRX ON  
 if Sub Receiver Always On was unchecked and the user 

checks it, subRX is turned ON  
 Sub Receiver Always On unchecked:  

 If the TX & RX Focus is on VFOB and the RX Focus 
changes to VFOA ( \ keystroke), the subRX stays ON  

 If the TX & RX Focus is initially on VFOB and then RX & TX 
Focus is on VFOA (PAUSE, CTRL+Left or vfoA 
Bandmap/Available window spot click ), the subRX is turned 
OFF  

 if Sub Receiver Always On was checked and the user 
unchecks it, subRX is turned OFF  

o Ctrl+Alt+D command action:  
 If "Sub Receiver Always On" is ON and the SubRX is ON, turn "Sub 

Receiver Always On" to OFF and leave the SubRX ON  
 If "Sub Receiver Always On" is ON and the SubRX is OFF, turn 

"Sub Receiver Always On" to OFF and leave the SubRX OFF  
 If "Sub Receiver Always On" is OFF and the SubRX is ON, turn 

"Sub Receiver Always On" to ON and leave the SubRX ON  
 If "Sub Receiver Always On" is OFF and the SubRX is OFF, turn 

both ON  
o Alt+F12 command action:  

 If the subRX is OFF - check "Sub Receiver Always On" and turn the 
subrx ON  

 If the subRX is ON - uncheck "Sub Receiver Always On" and turn 
the subrx OFF unless RX Focus is on vfoB  

o Digital radio modes FSK D, AFSK A and DATA A are supported  
 FSK D, AFSK A and DATA A are displayed in N1MM+ as RTTY, 

AFSK and PSK respectively  
 If the current contest allows digital modes, typing RTTY into the 

Entry window will put the radio into either RTTY (FSK D) or AFSK 
(AFSK A) mode depending on the selection in the Configurer's 
Digital Modes tab for the current digital engine  



 If the current contest allows digital modes, typing PSK into the 
Entry window will put the radio into PSK (DATA A) mode  

 PSK D is not supported by N1MM+; the digital engines in N1MM+ 
cannot transmit PSK using the PSK D sub-mode  

 The K3's data sub-mode is stored in the firmware on a per-band 
basis  

 If VFO B and VFO A are on the same band, the data sub-
mode will be the same in both VFOs  

 If VFO B and VFO A are on different bands, their data sub-
modes can be different, but the firmware does not provide a 
way to poll the K3 for the VFO B data sub-mode. N1MM 
Logger+ will assume that the VFO B sub-mode is the same 
as in VFO A when the two VFOs are on different bands  

 Adjust audio levels in AFSK A and DATA A to give 4-5 bars on the 
K3's ALC meter. This allows the K3's firmware ALC to control 
power without clipping peaks and causing IMD. In PSK31 and other 
digital modes requiring high linearity, keep the requested power 
setting below 60 watts (AFSK RTTY can be safely used at 100 
watts)  

o RIT control - When in RUN mode, the Up/Dn arrow keys change the RIT 
frequency (if the K3's RIT is turned on). When in S&P mode the radio 
frequency is changed  

o Using the program as a voice keyer with a K3 on SSB:  
 Option 1  

 Connect your microphone to the mic input of the sound card 
and the Line Out of the sound card to the Line In on the back 
of the K3  

 Set soundcard program to drive Line In  
 Select LINE IN with MENU:MIC SEL  
 Command Tx (or PTT or...) and adjust the MIC GAIN (which 

is now LINE IN gain) for proper audio level  
 Option 2  

 Connect microphone to desired microphone connection on 
the K3  

 Select MIC with MENU:MIC SEL  
 PTT and set Mic Gain  
 Connect sound card as described under Option 1  
 Now, if you set MIC+LINE ON then both audio sources will 

drive the K3. The MIC GAIN control will control the MIC 
GAIN only. LINE IN GAIN must be set when LINE IN is the 
selected source via MENU:MIC SEL  

o The K3 can accept PTT switching from several sources, including: a 
keying circuit from a serial or parallel port to the K3's PTT IN; PTT from a 



Winkeyer; RTS (pin 7) on the radio control RS232 port; or using "Radio 
PTT via command"  

 Do NOT use multiple methods of PTT control in parallel; in some 
cases doing so can leave the K3 stuck in transmit at the end of 
function-key messages. In particular, do NOT check "Radio PTT via 
command" if you are using RTS on the radio control port, or any 
other hardware PTT connection, to control PTT. Using "Radio PTT 
via command" together with hardware PTT control can cause the 
K3 to get hung up in transmit, so don't do it!  

 Procedure for configuring RTS on the radio control RS232 port: 
Start with the K3's CONFIG:PTT-KEY set to OFF-OFF; configure 
N1MM+ to control PTT from RTS on the radio control port (Port 
setup); set the K3's CONFIG:PTT-KEY to RTS-OFF  

 Warning: leaving RTS set to Always on with the K3's CONFIG:PTT-
KEY set to RTS-OFF or RTS-DTR will cause the K3 to be 
permanently in transmit  

o The K3 accepts CW keying on DTR (pin 4) of the same COM port you're 
using to control the K3. This method can be used when other methods 
(e.g. Winkeyer or a keying circuit on a separate COM or LPT port) are not 
available  

 CW and radio control on the same COM port do NOT work in 
SO2R mode  

 CW on DTR does NOT work with some USB-to-serial adapters 
(e.g. Prolific chipset)  

 CW on DTR may be missing some capabilities and may have other 
undesired side effects - use at your own risk  

 Procedure: Start with the K3's CONFIG:PTT-KEY set to OFF-OFF; 
check the CW/Other box beside the radio control port in the 
Configurer and configure N1MM+ to use DTR for CW on that port; 
set the K3's CONFIG:PTT-KEY to OFF-DTR  

 Warning: leaving DTR set to Always on with the K3's CONFIG:PTT-
KEY set to OFF-DTR or RTS-DTR will cause a permanent "key-
down" condition  

 Cat Macro strings used to play back Radio # 1 internal K3 CW/data messages or 
DVR voice keyer messages  

o M1 = {CAT1ASC SWT21;}  
o M2 = {CAT1ASC SWT31;}  
o M3 = {CAT1ASC SWT35;}  
o M4 = {CAT1ASC SWT39;}  

 It is not necessary to program a function key to send RX; to the radio for a DVK 
stop. The program code sends RX; to the radio when the Esc key is pressed.  

 It is not necessary to include the K31; command in any K3 Cat Macro. The radio 
is in K31 mode all the time and sending this command just adds delay.  



5.3. KX3 

 Radio control issues have been reported when running other K3 utility software 
(such as LP-Bridge) in conjunction with N1MM Logger. Please test with only 
N1MM Logger running before reporting a radio control issue, in order to eliminate 
other software as a possible source of the problem  

 The KX3 can be used in SO2V mode, within the limitations of the KX3's Dual 
Watch feature (e.g. VFO B must be within 15 kHz of VFO A). See the description 
of subreceiver control for the K3 above  

 The KX3 does not have an FSK keying input, so the digital engines (e.g. 
MMTTY) cannot transmit in FSK. To do RTTY, put the KX3 into AFSK A mode 
and configure the Logger and the digital engine for AFSK  

 The KX3's radio control port does not have DTR or RTS inputs, so unlike the K3 
these signals cannot be used on the radio control port to key CW or PTT  

 The digital engines (MMVARI and Fldigi) cannot transmit in PSK D. To do PSK, 
put the KX3 into DATA A mode and configure the Logger and the digital engine 
for PSK  

 Cat Macro strings used to playback Radio # 1 internal KX3 DVK voice keyer  
o M1 = {CAT1ASC SWT11;SWT19;}  
o M2 = {CAT1ASC SWT11;SWT27;}  

 Cat Macro strings for other functions are listed below as examples  
o To tune the ATU {CAT1ASC SWT44;}  
o To enable VOX {CAT1ASC SWH29;}  

6. FlexRadio 

o Portions of this may not be valid for the Flex-6000.  
o Flex VAC is required for digital or to send/record audio files to the radio 

without cables. The radio's VOX does not function when VAC is enabled. 
See the setup at: http://kc.flexradio.com/KnowledgebaseArticle50230.aspx  

o Radio control  
 Third party COM port mapping software is required to create a 

virtual COM port for radio control. See the Flex documentation for 
computer and radio configuration.  

 Software was tested with COM port settings: 38400, N, 8, 1, 
DTR=Always Off, RTS=Always Off  

o CW sending  
 Depending on your computer hardware and system DPC latency, 

users may find that CW generated by the N1MM Logger program or 



with external devices like WinKey may not be acceptable. Contact 
Flex Radio for CW sending issues.  

o Glitches or pops in audio  
 Users experiencing intermittent glitches or popping sounds in the 

receiver audio while radio polling is enabled should contact Flex 
Radio.  

o PowerSDR  
 The code was tested with public version PowerSDR 2.0.22.  
 There may be some interaction between the PowerSDR radio 

"model" and the requirements for SO2V operation. Generally, 
controlling split, RX2 On/Off, or MultiRx (Non-RX2 models) from the 
N1MM program is recommended.  

o Digital Modes  
 Both Flex digital modes are supported. They are mapped to the 

N1MM Logger program selections of AFSK and AFSK-R. Open 
Config, Mode Control tab, and set Mode Sent to Radio for RTTY 
and PSK. Most users will likely select RTTY to AFSK and PSK to 
AFSK-R.  

 VAC does not allow the RX2 to be used with multiple Digital 
Interfaces. This is not a program limitation.  

o The Flex5000 RX2 radio selection is intended for use with the Flex 5000 
with the optional RX2 receiver. The Flex radio selection is intended for use 
with the Flex 1500, 3000, and the 5000 without the RX2. The Flex5000 
RX2 option implements SO2V using the RX2 for VFOB and the Flex 
selection implements SO2V using the MultiRx feature. There are 
limitations to the tuning range of the MultiRx and how the radio reacts 
when it's instructed to change to a frequency outside of this operating 
range.  

6.1. Flex-6000 Series 

o This section is under construction. As of mid-May the Flex software and 
our program are being modified and debugged in parallel.  

o Program Feature Set  
 The radio selection supports all of the standard program features 

including Reverse CW, Mute Mic, Audio Muting Macros, Antenna 
Macros, and Advanced SO2V. The three program options SO1V, 
SO2V, and SO2R are supported.  

o SO2V  
 Users are able to have a repeating CQ running on VFOA and tune 

the band with VFOB. Start the repeating CQ then press the \ key to 
switch RX focus to the VFOB Entry window. If a station is called 
using the Function keys, the TX focus will switch, the message will 
be sent, and the repeating CQ will not restart. Shift-F# can be used 
to send a message on VFOA (example: Shift F1 to restart the CQ 



again). PAUSE or CTRL+Right/LeftArrow keys can be used to 
switch both RX and TX focus together.  

 Users can program VFOB with the next Bandmap spot without 
changing focus using Ctrl+Shift+Up/Dn. This allows users to 
program the VFOB frequency and toggle receiver 2 On/Off with 
various keyboard commands when the VFOA frequency is not 
busy.  

 Receiver 2 can be programmed to be On all the time. See the 
Config option Dual RX Always On.  

 Receiver 2 state can be toggled with the stereo key (`) and the VFO 
frequencies swapped with ALT+F10. See other features below.  

 If Diversity mode is enabled on the radio, toggling Sub off and on 
via ` or Alt+F12 will turn Diversity mode off.  

 Logger preserves diversity reception unless RX Focus changes to 
VFOB.  

 Receiver 2 ON/OFF control by N1MM Logger is independent of the 
state of Config>Dual RX Always On.  

 Changing RX Focus to VFOB turns receiver 2 ON.  
 Ctrl+Shift+Up/Dn does not change the state of receiver 2.  
 Alt+F12 or the stereo key (`) toggles receiver 2 ON/OFF if 

RX Focus is on VFOA (action disabled if RX Focus on 
VFOB).  

 Dual RX Always On checked:  
 Single clicking in any VFO Bandmap, on an Available 

window spot, or Ctrl+Up/Dn turns receiver 2 ON.  
 Changing the RX Focus turns the receiver 2 ON.  
 If Dual Receive Always On is unchecked and the user 

checks it, receiver 2 is turned ON.  
 Dual RX Always On unchecked:  

 If the TX & RX Focus is on VFOB and the RX focus 
changes to VFOA ( \ keystroke), receiver 2 stays ON.  

 If the TX & RX Focus is initially on VFOB and then RX 
& TX Focus is switched to VFOA (PAUSE, CTRL+Left 
or VFOA Bandmap/Available window spot click ), 
receiver 2 is turned OFF.  

 If Dual Receive Always On is checked and the user 
unchecks it, receiver 2 is turned OFF.  

 Ctrl+Alt+D command action:  
 If "Dual RX Always On" is ON and receiver 2 is ON, change 

"Dual RX Always On" to OFF and leave receiver 2 ON.  
 If "Dual RX Always On" is ON and receiver 2 is OFF, turn 

"Dual RX Always On" to OFF and leave the receiver 2 OFF.  
 If "Dual RX Always On" is OFF and receiver 2 is ON, turn 

"Dual RX Always On" to ON and leave the receiver 2 ON.  
 If "Dual RX Always On" is OFF and receiver 2 is OFF, turn 

both ON.  



 Alt+F12 action is similar to the stereo (`) key, but also affects "Dual 
RX Always On" state:  

 If receiver 2 is OFF - check "Dual RX Always On" and turn 
receiver 2 ON.  

 If receiver 2 is ON - uncheck "Dual RX Always On" and turn 
receiver 2 OFF unless RX focus is on VFOB.  

6.2. Flex-5000A with RX2 

o Program Feature Set  
 The Flex5000 RX2 radio selection supports all of the standard 

program features including Reverse CW, Mute Mic, Audio Muting 
Macros, Antenna Macros, and Advanced SO2V. The three program 
options SO1V, SO2V, and SO2R are supported.  

o SO2V  
 The RX2 option is required for SO2V operation.  
 Users are able to have a repeating CQ running on VFOA and tune 

the band with VFOB. Start the repeating CQ then press the \ key to 
switch RX focus to the VFOB Entry window. If a station is called 
using the Function keys, the TX focus will switch, the message will 
be sent, and the repeating CQ will not restart. Shift-F# can be used 
to send a message on VFOA (example: Shift F1 to restart the CQ 
again). PAUSE or CTRL+Right/LeftArrow keys can be used to 
switch both RX and TX focus together.  

 Users can program VFOB with the next Bandmap spot without 
changing focus using Ctrl+Shift+Up/Dn. The state of the RX2 is 
unchanged. This allows users to program the VFOB frequency and 
toggle the RX2 On/Off with various keyboard commands when the 
VFOA frequency is not busy.  

 The RX2 can be programmed to be On all the time. See the Config 
option Dual RX Always On.  

 The RX2 state can be toggled with the stereo key (`) and the VFO 
frequencies swapped with ALT+F10. See other features below.  

 If Diversity mode is enabled on the radio, toggling Sub off and on 
via ` or Alt+F12 will turn Diversity mode off.  

 Logger preserves diversity reception unless RX Focus changes to 
VFOB at which time the RX2 will switch to VFOB.  

 Subrx ON/OFF control by N1MM Logger is independent of the state 
of Config>Dual RX Always On.  

 Changing RX Focus to VFOB turns the RX2 ON.  
 Ctrl+Shift+Up/Dn does not change the state of the RX2.  
 Alt+F12 or the stereo key (`) toggles RX2 ON/OFF if RX 

Focus is on VFOA (action disabled if RX Focus on VFOB).  
 Dual RX Always On checked:  

 Single clicking in any VFO Bandmap, on an Available 
window spot, or Ctrl+Up/Dn turns the RX2 ON.  



 Changing the RX Focus turns the RX2 ON.  
 If Dual Receive Always On is unchecked and the user 

checks it, the RX2 is turned ON.  
 Dual RX Always On unchecked:  

 If the TX & RX Focus is on VFOB and the RX focus 
changes to VFOA ( \ keystroke), the RX2 stays ON.  

 If the TX & RX Focus is initially on VFOB and then RX 
& TX Focus is switched to VFOA (PAUSE, CTRL+Left 
or VFOA Bandmap/Available window spot click ), the 
RX2 is turned OFF.  

 If Dual Receive Always On is checked and the user 
unchecks it, the RX2 is turned OFF.  

 Ctrl+Alt+D command action:  
 If "Dual RX Always On" is ON and the RX2 is ON, change 

"Dual RX Always On" to OFF and leave the RX2 ON.  
 If "Dual RX Always On" is ON and the RX2 is OFF, turn 

"Dual RX Always On" to OFF and leave the RX2 OFF.  
 If "Dual RX Always On" is OFF and the RX2 is ON, turn 

"Dual RX Always On" to ON and leave the RX2 ON.  
 If "Dual RX Always On" is OFF and the Sub RX is OFF, turn 

both ON.  
 Alt+F12 action is similar to the stereo (`) key, but also affects "Dual 

RX Always On" state:  
 If the RX2 is OFF - check "Dual RX Always On" and turn the 

RX2 ON.  
 If the RX2 is ON - uncheck "Dual RX Always On" and turn 

the RX2 OFF unless RX focus is on VFOB.  

6.3. Flex-1500, Flex-3000, Flex-5000A without RX2 

o Program Feature Set  
 The Flex radio selection supports all of the standard program 

features including Reverse CW, Mute Mic, Audio Muting Macros, 
Antenna Macros, and SO2V. The three program options SO1V, 
SO2V, and SO2R are supported.  

o SO2V  
 The MultiRx is used for VFOB. Frequency and mode limitations of 

VFOB and how the radio responds to frequencies outside this 
range are controlled by the radio.  

 Given this, users are able to have a repeating CQ running on VFOA 
and tune the band with VFOB. Start the repeating CQ then press 
the \ key to switch RX focus to the VFOB Entry window. If a station 
is called using the Function keys, the TX focus will switch, the 
message will be sent, and the repeating CQ will not restart. Shift-F# 
can be used to send a message on VFOA (example: Shift F1 to 



reastart the CQ again). PAUSE or CTRL+Right/LeftArrow keys can 
be used to switch both RX and TX focus together.  

 Users can program VFOB with the next Bandmap spot without 
changing focus using Ctrl+Shift+Up/Dn. This allows users to 
program the VFOB frequency and toggle MultiRx On/Off with 
various keyboard commands when the VFOA frequency is not 
busy.  

 The MultiRx can be programmed to be On all the time. See the 
Config option Dual RX Always On.  

 The MultiRx state can be toggled with the stereo key (`) and the 
VFO frequencies swapped with ALT+F10. See other features 
below.  

 MultiRx ON/OFF control by N1MM Logger is independent of the 
state of Config>Dual RX Always On.  

 Changing RX Focus to VFOB turns the MultiRx ON.  
 Ctrl+Shift+Up/Dn does not change the state of the MultiRx.  
 The stereo key (`) or Alt+F12 toggles MultiRx ON/OFF if RX 

Focus is on VFOA (action disabled if RX Focus on VFOB).  
 Dual RX Always On checked:  

 Single clicking in any VFO Bandmap, on an Available 
window spot, or Ctrl+Up/Dn turns MultiRx ON.  

 Changing the RX Focus turns MultiRx ON.  
 If Dual Receive Always On is unchecked and the user 

checks it, MultiRx is turned ON.  
 Dual RX Always On unchecked:  

 If the TX & RX Focus is on VFOB and the RX focus 
changes to VFOA ( \ keystroke), MultiRx stays ON.  

 If the TX & RX Focus is initially on VFOB and then RX 
& TX Focus is switched to VFOA (PAUSE, CTRL+Left 
or VFOA Bandmap/Available window spot click ), 
MultiRx is turned OFF.  

 If Dual Receive Always On is checked and the user 
unchecks it, MultiRx is turned OFF.  

 Ctrl+Alt+D command action:  
 If "Dual RX Always On" is ON and MultiRx is ON, change 

"Dual RX Always On" to OFF and leave MultiRx ON.  
 If "Dual RX Always On" is ON and MultiRx is OFF, turn "Dual 

RX Always On" to OFF and leave MultiRx OFF.  
 If "Dual RX Always On" is OFF and MultiRx is ON, turn "Dual 

RX Always On" to ON and leave MultiRx ON.  
 If "Dual RX Always On" is OFF and MultiRx is OFF, turn both 

ON.  
 Alt+F12 action is similar to the stereo (`) key, but also affects "Dual 

RX Always On" state:  
 If MultiRx is OFF - check "Dual RX Always On" and turn 

MultiRx ON.  



 If MultiRx is ON - uncheck "Dual RX Always On" and turn 
MultiRx OFF unless RX focus is on VFOB.  

6.4. SDR-1000 and SDR-5000A (using Kenwood settings) 

o By: Rob AB7CF  
o Some setup details are not really needed but are included for 

completeness. One thing I notice different is in PowerSDR Cat setup I use 
ID as: "PowerSDR" though it shouldn't make a difference. Probably the 
most common Vcom mistake is a failure to click Update Driver and 
following the procedure after making a change in Vcom configuration..  

o Example: using VCom configurator using ports 4-5 defines and VAC  
o Check your VCom configurator to make sure you have a check box in the 

COM4 - COM5 pair and you have clicked Save Configuration. MAKE 
SURE you click the Update Driver and follow the instructions. Close VCom 
configurator. Click on Window's Start Button, Click on ControlPanel, Click 
System, Click on the Hardware Tab, Click on Device manager.  

o In Device manager make sure there ISN'T a yellow question mark on the 
entry labeled "Multi-port serial adapters." If there is no yellow question 
mark your Vcom virtual cable should be working properly. If there is an 
yellow question mark there is a problem with your Vcom installation which 
needs attention. Assuming no problem, Close ControlPanel.  

o Now check PowerSDR. Open PowerSDR Setup and click on the CAT 
Control tab. In CAT Control make sure Enable CAT is checked. Under 
PTT make sure Port 4 is selected and RTS and DTR are unchecked. 
Select ID as: PowerSDR. Click Apply. Close PowerSDR Setup.  

o Now check N1MM. Click Config. Select "Configure Ports, Telnet 
Address,Other" Under Com-5 select Kenwood. Make sure CW/PTT is 
unchecked. Now click Set. In the popup box the settings should be: Speed 
4800, Parity: N DataBits: 8, Stop Bits: 1 DTR (pin 4) = Handshake. RTS 
(pin 7) =Handshake, 1 selected in Radio/VFO. Leave the "Radio PTT via 
command" check box UNCHECKED. Check the "Allow external interrupts" 
check box. Click Okay (twice) to back out.  

o Now you should be communicating with your SDR. Check that clicking a 
new frequency in the Panadapter changes frequency in N1MM. With the 
focus in N1MM check that the keyboard up and down arrows change the 
PowerSDR frequency.  

7. Icom 

7.1. General Icom Information (all Icom owners please read) 

o Almost every Icom rig requires an ICOM CT-17 CI-V interface or 
compatible. If your Icom radio has a USB computer interface (IC-7200, IC-
7600, etc), install the latest driver for the virtual COM port and audio 
codec.  



o Icom rigs use software handshaking. That means they do not use DTR 
and RTS. However, interfaces that get their power from the RS232 port 
require you to set DTR and/or RTS to "Always On" to supply power to the 
interface. Check your interface manual to see how DTR and RTS must be 
set.  

o Set N1MM Logger and the rig to:  
 Address - see specific rig information below  
 Baud Rate - 9600 or 19200 (see specific rig maximum rates below). 

When a slower baud rate is selected, the program will disable CI-V 
acceleration features added for radio programming and keyboard 
tuning.  

 Data Bits - 8 bits  
 Parity - None  
 Stop Bits - 1 bit  

o On your rig, set:  
 "CI-V Transceive" to OFF - If CI-V is set to ON, the Bandmaps will 

not update as the VFO is turned.  
 "Some Icom rigs have a "4 or 5 Byte Data" or "Frequency Data 

Length" interface option. Set the radio to use 5 data bytes for the 
frequency.  

o Due to the limited Icom radio control, the user needs to control the radio 
from the keyboard. This means that the user can not press these buttons 
on the radio: SPLIT (most radios), DUALWATCH, CHANGE, VFO/MEMO, 
A=B, A<>B, or MAIN/SUB. Icom radios only report the VFO frequency of 
the active VFO. Because of this, the program will select each VFO to read 
the frequency during initialization. During 2011, Icom added a firmware 
command to poll the radio split to the latest firmware updatable and new 
radios. Those radios that are capable or reading the split have been 
updated in program versions 12.03.01 or newer. See the specific radio 
text for the firmware revision. When using these radios with the proper 
firmware and program version 12.03.01 or newer, users can change the 
radio split by pressing the radio button and the program will track.  

o To set and clear split under program control, use ALT+F7 or one of the 
other keyboard commands. Split is correctly set/cleared when clicking in 
the Bandmap or Available windows. To select VFOB (SO2V mode only), 
use the PAUSE, "\", or CTRL+Right/Left Arrow keys. In SO2V mode, the 
VFO is also selected with a Right or Left click on the band buttons in the 
Available window.  

o Frequencies > 2 GHz are ignored and not sent to the radio.  
o For CW sending, a seperate CW interface cable is needed between the 

radio and the computer. This interface maybe serial or parallel port or a 
WinKey. The CI-V cable or serial cable to the radio alone is not enough to 
do CW.  

o The ALT+F10 swap VFO frequency command is disabled during SO2R for 
Icom radios that lack a swap VFO CAT command. This is because the 
program is unaware of Icom VFO B frequency in SO2R mode.  



o The Icom command set (CW via CAT control) is not supported. A COM, 
LPT, or WinKey is required to send CW.  

 The models below are supported:  

7.2. IC-271 / IC-471 / IC-1271 

 Select IC-706 and set the radio address to hex 48 or program the 
default radio address in the program setup window. Please report 
on program functionality.  

 There are several limitations caused by the lack of several CI-V 
commands. VFO select and split commands are not supported. 
This will prevent the program from controlling the radio split and 
reading or programming VFOB frequency. SO2V mode should not 
be attempted and VFOB's Bandmap and Entry windows can be 
closed.  

7.3. IC-275A/E/H using address 10 hex 

 The CI-V command set lacks split ON/OFF commands. This 
prevents the program from controlling the radio split.  

7.4. IC-375 / IC-575 (all versions) 

 Select IC-706 and set the radio address to hex 48 or program the 
default radio address in the program setup window. Please report 
on program functionality.  

 The CI-V command set lacks split ON/OFF commands. This 
prevents the program from controlling the radio split.  

7.5. IC-475A/E/H using address 14 hex 

 The CI-V command set lacks split ON/OFF commands. This 
prevents the program from controlling the radio split.  

7.6. IC-703 using address 68 hex 

7.7. IC-706 using address 48 hex 

 This radio firmware does not include a CAT command to key the 
radio. This causes the radio command PTT options to be non-
functional.  

7.8. IC-706MKII using address 4E hex 



 This radio firmware does not include a CAT command to key the 
radio. This causes the radio command PTT options to be non-
functional.  

7.9. IC-706MKIIG using address 58 hex 

 This radio firmware does not include a CAT command to key the 
radio. This causes the radio command PTT options to be non-
functional.  

7.10. IC-718 using address 5E hex 

 Set N1MM Logger to 19200 bps and the radio to "AT" (AuTo).  

7.11. IC-725 using address 28 hex 

7.12. IC-728 using address 38 hex 

7.13. IC-729 using address 3A hex 

7.14. IC-735 using address 04 hex 

 The CI-V command set lacks split ON/OFF commands. This 
prevents the program from controlling the radio split.  

 When the IC-735 is used with factory settings (1200 baud, 
transceive ON), the bandmap response of N1MM is extremely slow. 
Jumpers J22 located on the PL-unit board (upper side under PA 
unit) allow baud-rate, address and CI-V transceive to be changed. 
But.. the jumpers are not labeled and not in the order as stated in 
the Service manual. In fact transceive ON/OFF is the last one (front 
panel toward you, tarting from left) this one should be removed to 
turn transceive OFF. The 2 first ones set the baud-rate (move the 
second one to the first position to switch from 1200 to 9600 baud) 
the 3 remaining ones are the CI-V address - default 04; is with last 
the last one of this group of 3 - ON.  

 
Jumper J22 settings for 9600 baud, transceive OFF and default address 04 - from left to 
right with front panel toward you...  

1 2 3 4 5 6 

ON OFF OFF OFF ON OFF 

Baud rate Baud Rate Address Address Address CI-V transceive 

These settings make the 735 operable with N1MM (trx IC735 / baud rate 9600 / 8 data 
bits / no parity / 1 stop bit). DTR and/or RTS are not used by the Icom CI-V (no 



handshake) so does not matter. However, they should be turned to "always ON" if using 
an interface powered though those pins. Alternatively, they can be used for CW and 
PTT, for example if you are limited by the number of COM-ports on your machine. 73' 
Patrick F6IRF  

7.15. IC-736 using address 40 hex 

7.16. IC-737/737A using address 3C hex 

 The CI-V command set lacks split ON/OFF commands. This 
prevents the program from controlling the radio split.  

7.17. IC-738 using address 44 hex 

7.18. IC-746 using address 56 hex 

 VFO-B is a virtual VFO as long it isn't activated. The scale is not 
controlled by the VFO-B of the transceiver. It becomes an active 
VFO when it is activated. The IC-746 is switched to VFO-B and set 
to the frequency shown in the VFO-B bandmap.  

7.19. IC-746 PRO using address 66 hex 

 USB-D / LSB-D digital modes supported.  

7.20. IC-751/751A using address 1C hex 

 There are several limitations caused by the lack of some CI-V 
commands. VFO select and split commands are not supported. 
This will prevent the program from controlling the radio split and 
reading or programming VFOB frequency. SO2V mode should not 
be attempted and VFOB's Bandmap and Entry windows can be 
closed.  

To communicate with the radio, the baud rate, CI-V Transceive, and number of bytes of 
frequency data must be set correctly. This is set via a DIP switch on the Icom UX-14 
interface board. Using the DIP switch S1 location in the beginning of the manual (page 
11 has the DIP switch positions reversed) set S1 to the following:  
1-------------6  
On - Off - Off - Off - Off - On  
This will set the baud rate to 9600, the length of the frequency information to 5 bytes, 
and turn CI-V Transceive OFF.  
If the radio contains the Piexx UX-14 CI-V board, set the DIP switches per the Piexx 
manual for the same configuration  

7.21. IC-756 using address 50 hex 



 Please see also Key Assignments (Alt+F12) and the setting 'Dual 
Rx always on' in the Config menu.  

7.22. IC-756 PRO using address 5C hex 

 Please see also Key Assignments (Alt+F12) and the setting 'Dual 
Rx always on' in the Config menu.  

7.23. IC-756 PRO II using address 64 hex 

 Please see also Key Assignments (Alt+F12) and the setting 'Dual 
Rx always on' in the Config menu.  

 USB-D / LSB-D digital modes supported.  

7.24. IC-756 PRO III using address 6E hex 

 Please see also Key Assignments (Alt+F12) and the setting 'Dual 
Rx always on' in the Config menu.  

 USB-D / LSB-D digital modes supported.  

7.25. IC-761 using address 1E hex 

 There are several limitations caused by the lack of some CI-V 
commands. VFO select and split commands are not supported. 
This will prevent the program from controlling the radio split and 
reading or programming VFOB frequency. SO2V mode should not 
be attempted and VFOB's Bandmap and Entry windows can be 
closed.  

To communicate with the radio, the baud rate, CI-V Transceive, and number of bytes of 
frequency data must be set correctly. This is set via a DIP switch inside the radio. Set 
the baud rate to 9600, the length of the frequency information to 5 bytes, and turn CI-V 
Transceive OFF.  
The manual lacks the details but it is suspected that DIP S1 should be set to the 
following:  
1-------------6  
On - Off - Off - Off - Off - On  
If the radio contains the Piexx UX-14 CI-V board, set the DIP switches per the Piexx 
manual for the same configuration.  

7.26. IC-765 using address 2C hex 

7.27. IC-775/775DSP using address 46 hex 

 The IC-775 firmware is limited and lacks commands to select Main 
or Sub. It is also not possible to read the frequency of the Sub VFO 



without moving it into the Main VFO and polling. This is done at 
program start, Configurer exit, and Reset Radios. Because of this 
radio limitation, the SO2V functionality is limited. This radio is better 
suited for SO1V or SO2R use.  

 The radio firmware lacks the ability to poll the VFOB frequency. 
Frequency changes to the SUB made by tuning the SUB VFO knob 
will not be sensed and tracked by the program in SO2V mode.  

 Please see also Key Assignments (Alt+F12) and the setting 'Dual 
Rx always on' in the Config menu.  

7.28. IC-781 using address 26 hex 

 Please see also Key Assignments (Alt+F12) and the setting 'Dual 
Rx always on' in the Config menu.  

7.29. IC-821H using address 4C hex 

 The ALT+F12 radio specific command swaps MAIN and SUB using 
the CAT radio command.  

 The ALT+F10 command swaps the VFOA/B frequency and mode 
only in SO1V and SO2V program modes.  

7.30. IC-910H using address 60 hex 

 The ALT+F12 radio specific command swaps MAIN and SUB using 
the CAT radio command.  

 The ALT+F10 command swaps the VFOA/B frequency and mode 
only in SO1V and SO2V program modes.  

7.31. IC-1275A/E using address 18 hex 

 The CI-V command set lacks split ON/OFF commands. This 
prevents the program from setting or clearing the radio split.  

7.32. IC-7000 using address 70 hex 

7.33. IC-7200 using address 76 hex 

 Radio control via USB with Icom driver or CI-V interface.  
 The IC-7200 USB codec is supported. IC-7200 users can use the 

USB cable with the Icom drivers for radio control, AFSK RTTY, 
PSK, voice message playback, and recording QSOs. IC-7200 users 
can not record messages on the fly. In CW, only the received 
portion of the QSO is recorded. This is a radio limitation.  

 Detailed instructions for setting up USB communications with this 
radio may be found under >Files >Supplementary Information.  
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7.34. IC-7400 using address 66 hex 

 Select the IC-746 PRO as radio.  
 USB-D / LSB-D digital modes supported.  

7.35. IC-7410 using address 80 hex 

 Program releases 12.03.01 and later support polling the radio for 
split status  

 Radio control via USB with Icom driver or CI-V interface.  
 USB-D / LSB-D digital modes supported.  
 The audio codec is supported. Users with the Icom drivers can use 

the USB cable for radio control, AFSK RTTY, PSK, recording voice 
messages on the fly, voice message playback, and recording 
QSOs. In CW, only the received portion of the QSO is recorded. 
This is a radio limitation.  

 Detailed instructions for setting up USB communications with these 
radios may be found under >Files >Supplementary Information.  

7.36. IC-7600 using address 7A hex 

 Program releases 12.03.00 or newer require radio firmware that 
contains the get split command (firmware 1.11 or newer).  

 Radio control via USB with Icom driver or CI-V interface.  
 USB-D / LSB-D digital modes supported.  
 The IC-7600 and IC-9100 audio codecs ares supported. Users with 

the Icom drivers can use the USB cable for radio control, AFSK 
RTTY, PSK, recording voice messages on the fly, voice message 
playback, and recording QSOs. In CW, only the received portion of 
the QSO is recorded. This is a radio limitation.  

 Detailed instructions for setting up USB communications with these 
radios may be found under >Files >Supplementary Information. 
The file is titled "IcomUSBCodecInstructions 2011-10-2.pdf"  

7.37. IC-7700 using address 74 hex 

 Program releases 12.03.00 or newer require radio firmware that 
contains the get split command (firmware 1.20 or newer).  

 USB-D / LSB-D digital modes supported.  

7.38. IC-7800 using address 6A hex 

 Program releases 12.03.00 or newer require radio firmware that 
contains the get split command (firmware 2.30 or newer).  

 Please see also Key Assignments (Alt+F12) and the setting 'Dual 
Rx always on' in the Config menu.  
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 USB-D / LSB-D digital modes supported.  

7.39. IC-9100 using address 56 hex 

 Program releases 12.03.01 or newer require radio firmware that 
contains the get split command (firmware E1 or newer).  

 USB radio control and audio CODECS are supported. Detailed 
instructions for setting up USB communications may be found 
under >Files >Supplementary Information. The file is titled 
"IcomUSBCodecInstructions 2011-10-2.pdf"  

8. Kenwood 

8.1. General Kenwood information 

o All models are supported  
 Newer models connect directly via a serial port cable or USB port. 

The use of the USB port requires a Kenwood driver be installed.  
 Older models need the Kenwood IF-10 and/or the IF-232C interface 

(or compatible). Please check the radio's manual.  
 Almost any of the earlier generation Kenwood radios need 

some sort of level conversion, and at least some also come 
without the necessary chip set. Radios like the TS-940S, TS-
440S, TS-811, TS-711 need both a chip and a level 
converter.  

 PIEXX (www.piexx.com) makes a combined level converter 
and chip set replacement for the TS-940, as well as a 
complete replacement microprocessor for the TS-930 to 
provide communications.  

o Hardware handshaking is mostly being used. This means that DTR= 
Always on or handshake and RTS = Always on or handshake.  

 Unless you make up a special loop back cable for it so you can use 
DTR and RTS for CW and PTT.  

o The stock Kenwood interfaces (IF-232 for the older -x40 and -x50 series 
transceivers) and a bare RS-232 cable for the more recent TS-
480/570/870/2000 require handshake. Except for the TS-570. the solution 
is to install a jumper between CTS/RTS pins at the RS-232 input of the 
Kenwood interface (in the case of the -40 and -50 transceivers) or 
transceiver (TS-480/870/2000). The TS-570 can lock-up if RTS is 
connected to CTS and requires RTS=always high to be reliable.  

o Using the jumper ("over-ride hardware handshaking") will free RTS for 
PTT in addition to DTR for CW. The alternative to over-riding the hardware 
flow control is to set RTS=Always On and use DTR for PTT or CW as 
necessary (DTR is not connected in the radio/interface).  

o RX/TX information from the radio is ignored while sending is in progress to 
avoid glitches in sending.  
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o Typical Kenwood radio defaults:  
 Speed: 9600 Baud; Parity: N ;Databits: 8; Stopbits: 2 and 

"hardware handshaking" (RTS and DTR set to "Handshake"). It is 
recommended by the developers to use a baud rate above 9600 
baud if possible. The radio menu and the program setup must be 
changed together.  

o When setting split both VFOs are forced in the same mode.  

o Assigning these basic example macros to Function Keys will allow you to 
play and stop the internal DVK (voice keyer) on radio #1. Other macro 
strings can be inserted to playback on radio #2 or both radios. See the 
Macros section of the manual.  

 Message1 = {CAT1ASC PB1;}  
 Message2 = {CAT1ASC PB2;}  
 Message3 = {CAT1ASC PB3;}  
 Stop Playback = {CAT1ASC PB0;}  
 The TS-590 DVK stop command is sent to the radio when the ESC 

key is pressed.  

o The Kenwood KY command set (CW via CAT control) is not support due 
to the limitations. A COM, LPT, or WinKey is required to send CW.  

8.2. TS-480 

 Select: Kenwood. Note that handshaking options may 
vary - check your manual  

 "AFSK" via the data jack with software PTT is 
supported. Check the "Digital Modes Acc Jack Radio 
Command PTT" and the "Software PTT Via Radio 
Command - Digital" in the radio COM port setup 
window.  

8.3. TS-570 

 Select: Kenwood  
 When using the ACC2 port on the back, you must 

send both the audio signal and the PTT signal to the 
ACC jack.  

 You can't use the normal PTT connection from the 
MIC jack if you are inputting audio into the ACC jack.  

 SO2V: 
9600,N,8,1,handshake,handshake,radio/VFO=1  

8.4. TS-590 

 Select: Kenwood  



 Follow the Owners Manual for port speed, parity, 
number of databits, and stopbits  

 Make sure the COM port speed set in N1MM Logger 
is the same as the speed in TS-590 menu item 62. 
57600 bps is recommended. After changing the 
speed in menu item 62, you must power off the TS-
590 AND the 12 volt supply powering the 590. Make 
sure the power supply has completely discharged 
before turning the power supply and 590 back on.  

 When using the TS-590S radio codec as a sound 
card for a DVK, the live microphone has priority over 
the codec. This means that if live audio is being sent 
from the microphone, a .wav file cannot be sent over 
the codec at the same time. Starting of the .wav file 
will be blocked, even if the microphone VOX drops 
shortly thereafter. So, if you're running, and using the 
microphone to say callsigns, but F2 to send the 
exchange, you have to wait until the VOX drops 
before pressing F2.  

 When using the ACC2 radio jack, there are three PTT 
options. PTT for digital modes (pin 9), PTT for non-
digital modes (pin 11), and software PTT (PTT via 
radio command by mode). The ACC2 pin 13 PTT is 
exactly the same as the Remote connector pin 3 PTT. 
If you use Remote connector pin 3 PTT while using 
the internal radio codec, there will be no RF output. 
To use the ACC2 for digital modes with software PTT, 
check "Digital Modes Acc Jack Radio Command PTT" 
and the "Software PTT Via Radio Command - Digital" 
in the setup window of the COM port used for radio 
control.  

 ARCP-590 or ARUA-10 are not needed when using 
N1MM Logger with the TS-590.  

 Detailed instructions for setting up USB 
communications with this radio may be found under 
>Files >Supplementary Information. The file is titled 
"KenwoodTS-590SCodec 2011-04-02.pdf".  

8.5. TS-850 

 Select: Kenwood  
 Turn off AI on init  
 Speed: 4800 Baud; Parity: N ;Databits: 8; Stopbits: 2 

(!)  
 Check out the possible communications issue below 

with this radio.  
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8.6. TS-870 

 Reportedly works well; further information on setup 
would be welcome  

8.7. TS-950sdx 

 Select: Kenwood  
 Some (older) TS-950sdx radios drop power when 

polled by a logging program. It's pretty obvious on 
either CW or SSB.  

 The problem is not the program but the ROM 
firmware chip. The big one one the digital 
board of the 950sdx.  

 Just replace the chip, the problem should go 
away. Costs about $27.00 - and very easy to 
install (about 10 minutes)  

 Order a battery if you haven't replaced it 
already - it's right next to the chip on the same 
board....  

 Speed: 4800 Baud; Parity: N ;Databits: 8; 
Stopbits: 2 (!)  

 Check out the possible communications issue 
below with this radio.  

8.8. TS-50, TS-140, TS-440, TS-680,TS-711,TS-790,TS-811,TS-940 

o The radio firmware revision of some of these radios may require the use of 
Kenwood-Slow rather than Kenwood.  

8.9. TS-2000 

o Use the radio selection TS-2000. It was added to allow control of RX 
antenna input.  

o Use the highest baud rate possible, something above 9600 baud. The 
window selections should be No Parity, 8 Databits, 2 Stopbits, DTR = 
Handshake, and RTS = Handshake. The radio default baud rate can be 
changed with radio menu 56. Since hardware hand shaking is used by the 
TS-2000, the serial cable needs to contain wires for the hardware flow 
control pins.  

o Do not use the radio function called "auto-mode". This function 
automatically changes the radio mode and changes the radio mode set by 
N1MM logger.  

o Radio NB: This may produce AFSK RTTY (LSB) problems when changing 
between the higher (USB) and lower (LSB) bands.  



o Do not use the radio in memory mode, use VFO mode. The program will 
not function when in memory mode with the program.  

o The radio control works for frequencies above 6 meters.  

8.10. N1MM logger loses communication with the radio (TS-850, TS-950 etc.) 

o This problem is based in the radio's firmware. Some Kenwood radios are 
not capable of communicating with N1MM Logger while the VFO knob is 
being turned. If you turn the VFO knob smoothly and continuously, no 
matter how slowly, the radio will not respond to radio polls and the link will 
time out. For these radios there are two choices, pause when tuning the 
VFO so the radio will answer the program polling requests or increase the 
'transceiver timeout time'. The transceiver timeout time is set by right-
clicking in the Bandmap window. This is a radio firmware limitation, not a 
software issue. Using Kenwood-Slow will *not* solve this firmware 
limitation.  

9. TenTec 

9.1. General TenTec information 

 The models below are supported, other models are not supported.  

9.2. ARGONAUT V 

 Use the Argonaunt radio selection.  

9.3. ARGONAUT VI 

 Use the Eagle radio selection. The Argonaut V and Argonaut VI 
radio commands are different.  

 This radio is NOT capable of SO2V operation. Select SO1V or 
SO2R program operation.  

 The radio firmware requires a 200ms delay after every Set-type 
command. Users may notice this delay when the program is setting 
the frequency, mode, or split.  

9.4. JUPITER 

 Uses 1 stopbit and DTR and RTS 'Always on'. Do NOT check the 
CW check box on the port setup screen for this com port.  

9.5. OMNI-VI 

o The Omni VI+ the "Cde" item under menu 2 should be set to "off". 
Otherwise there will be collisions between the data sent from the rig when 



N1MM polls for data and the data that is being continuously sent by the 
radio which will cause erratic behavior.  

o In the COM port setup window for the radio, the "Icom Code" box should 
be set to 4. This radio uses the Icom protocol for radio communications.  

9.6. OMNI-VII 

 The Omni-VII does not support antenna switching in "radio" mode. 
It is only possible in "remote" mode. So owners of the Omni-VII can 
not use the antenna switch macros.  

 Alt+F10 (exchange VFO) and CW-Reverse operation supported  
 The Omni-VII can not receive on VFOB.  

9.7. Orion 

 Uses default 56000 Baud and 1 stopbit and hardware handshaking; 
From Version 11.10.02 forward, handshaking requires that CTS is 
connected per the Orion manual.  

 Firmware version 1.363 or greater needed.  
 Note that the Orion does not support PTT on CW via computer 

command. This does work on SSB, but on CW, you need to set a 
parallel or serial port to assert PTT for that radio. Then use a cable 
from that adapter to pin three (PTT) of the aux port on the Orion. 
This is the black RCA Phono connector on the aux cable. By use of 
a Y connector, you can parallel your footswitch and this CW PTT 
cable.  

 When using PTT and CW lines off a serial or parallel port. Be sure 
to go into the Orion CW menu and set "PTT in CW as" to the value 
"Mox".  

 Default bandwidths: CW: 300/800; SSB: 2000/2800; RTTY 250/400  
 CW on main receiver is LCW.  
 Supports Digital Voice Keying (DVK) via the AUX port. Audio 

should be fed to the AUX port and NOT the microphone.  
 When no DVK is specified the front microphone gain will 

normally set to 0  
 Microkeyer users: check out the Supported Hardware 

chapter regarding muting of the ORION microphone 
audio input.  

 When a DVK is specified for that radio the microphone gain 
will not change (mostly fed to the front microphone).  

 When up/down pressed, turn on RIT if in S&P, turn off RIT if in 
running mode.  

 Clear RIT by setting to 1 Hz not 0. Avoids turning off RIT.  
 Narrow SSB bandwidth set to 1990 Hz to force the use of 2.4 kHz 

filter in auto mode.  



 RIT can be changed using the up/down keys if RIT on. Note that 
you must turn on RIT from within the program!  

 Swap VFOs using Alt+F10. This will replace the contents of 
memories 199 and 200  

 Example Setup FSK/CW/SSB  
 In FSK or SSB mode the program uses the PTT input to key 

the rig.  
 In CW mode the program uses the PTT as the CW key.  

 Digital setup and MMTTY.  
 N1MM Config / Config Ports / Hardware Tab.  

 Set the CW menu choice for the 
interface com port to DTR (Pin 4).  

 MMTTY Setup / Setup MMTTY / TX Tab / 
Radio command button.  

 Checked the PTT button under 
DTR/RTS.  

 Interface information  
 LINE OUT (74) is fixed level output (RCA connector)  

 Should be fed to LINE IN on the soundcard.  
 Yellow phono plug on Pin 4 of the AUX I/O cable 

assembly  
 NB this is a combined output for both receivers, use 

the AUX I/O port for separated outputs (pin 4 and 6)  
 AUX I/O port (80): AUX IN (pin 1) for transmit audio from the 

soundcard  
 Should be fed to LINE OUT on the Soundcard.  
 The AUX gain can be set under the SSB menu  
 Set the AUX gain to 65 and use the computer audio 

setting to drive the rig to 100 watts for RTTY.  
 AUX port: PTT (pin 3)  

 A transistor switch is needed from a serial or parallel 
port.  

 Works fine for digital modes but also for recording and the 
voice keyer.  

 Switch between MIKE and AUX via the menu.  

 
This is a summary of the SO2V features for the Orion.  

o The stereo (grave accent - `) key toggles Sub audio On and Off. To leave 
SUB audio selected all the time, select Configurer>Dual RX always on  

 If you are using Diversity mode on the radio, toggling Sub off and 
on via ` or Alt+F12 will turn Diversity mode off  

 Logger preserves diversity reception unless RX Focus changes to 
vfoB at which time the subrx will switch to vfoB  

o Subrx ON/OFF control by Logger  



 Independent of the state of Dual RX Always On:  
 changing RX Focus to vfoB turns the subrx ON  
 Ctrl+Shift+Up/Dn does not change the state of the subrx  
 Alt+F12 toggles subrx ON/OFF if RX Focus is on vfoA 

(action disabled if RX Focus on vfoB)  
 Dual RX Always On checked:  

 clicking any vfo bandmap/avail. window spot or Ctrl+Up/Dn 
turns the subrx ON  

 changing RX Focus turns the subrx ON  
 if dual rx always on was unchecked and the user checks it, 

subrx is turned ON  
 Dual RX Always On unchecked:  

 If the TX & RX Focus is on VFOB and the RX Focus 
changes to VFOA ( \ keystroke), the subrx stays ON  

 If the TX & RX Focus is initially on VFOB and then RX & TX 
Focus is on VFOA (PAUSE, CTRL+Left or vfoA 
Bandmap/Available window spot click ), the subrx is turned 
OFF  

 if dual rx always on was checked and the user unchecks it, 
subrx is turned OFF  

o Ctrl+Alt+D command action:  
 If "Dual RX always on" is ON and the Sub RX is ON, turn "Dual RX 

Always On" to OFF and leave the Sub RX ON  
 If "Dual RX always on" is ON and the Sub RX is OFF, turn "Dual 

RX Always On" to OFF and leave the Sub RX OFF  
 If "Dual RX always on" is OFF and the Sub RX is ON, turn "Dual 

RX Always On" to ON and leave the Sub RX ON  
 If "Dual RX always on" is OFF and the Sub RX is OFF, turn both 

ON  
o Alt+F12 command action:  

 If the subrx is OFF - check "Dual RX always on" and turn the subrx 
ON  

 If the subrx is ON - uncheck "Dual RX always on" and turn the 
subrx OFF unless RX Focus is on vfoB  

9.8. Eagle 

 This radio is NOT capable of SO2V operation. Select SO1V or 
SO2R program operation.  

 The radio firmware requires a 200ms delay after every Set-type 
command. Users may notice this delay when the program is setting 
the frequency, mode, or split.  

10. Yaesu 

10.1. General Yaesu information 



 The models below are supported, other models are not supported.  
 Required interfaces  

 Newer models connect directly via a serial port cable.  
 Older models need the Yaesu FIF-232C CAT interface (or 

compatible).  
 Software handshaking is being used for all models.  
 Yaesu uses by default:  

 Speed: 4800 Baud Parity: N Databits: 8 Stopbits: 2  

10.2. FT-80C 

 It has been reported that this radio will not transmit key CW or MIC 
audio while it is sending the radio polling data to the computer. The 
radio polling string is fixed by the radio firmware and it requires over 
800ms to send the data to the computer at 4800 baud. This radio 
should only be used without radio control. This operation just isn't 
practical for contesting.  

10.3. FT-100(D) 

 The FT-100D has an internal jumper for either CAT/TUNER or 
LINEAR. This should be set for CAT/TUNER.  

 Configure the radio as FT-100, 4800, N, 8, 2, Handshake, Tx=1, 
DTR=Always on or off, RTS=Always on or off.  

 Needs a standard FT-100 CAT cable (CT-62).  

10.4. FT-736 

 Not supported and probably never will be. It seems that once the 
radio is controlled by CAT it can't be controlled by hand anymore.  

10.5. FT-450 

 When using a 3 wire cable (TX, RX and ground) set CAT RTS=disable on radio 
(default is enable). This cable does not have DTR or RTS connected. The radio 
settings CAT TOT should be set to 1000 and CAT RATE must match the 
program configuration. A three wire cable should also work with USB serial 
adapters.  

 There are other forms of the CATMacros for SO2R use but a basic form to play 
the internal radio voice memory 1 & 2 and stop the message are:  

o {CAT1ASC PB1;}  
o {CAT1ASC PB2;}  
o {CAT1ASC PB0;}  

 The DVK stop command is sent to the radio when the ESC key is 
pressed.  



10.6. FT-747GX 

 It has been reported that this radio will not transmit key CW or MIC 
audio while it is sending the radio polling data to the computer. The 
radio polling string is fixed by the radio firmware and it requires over 
800ms to send the data to the computer at 4800 baud. This radio 
should only be used without radio control. This operation just isn't 
practical for contesting.  

10.7. FT-757 

 Select FT-757GXII as radio and disable the radio communications 
timeout via the bandmap menu option (set it to 0).  

 The FT-757GX does NOT send anything to the computer and the 
radio mode can not be set by the program so the radio control 
functionality will be limited.  

10.8. FT-757GXII 

 Supported  

10.9. FT-767 / FT-767GX 

 There are no plans to support this radio.  

10.10. FT-817 

 19200, N, 8, 1, Handshake, Handshake. FT-817 CI-V Baud "Hi". When using a 
USB/Serial adapter set DTR to 'Always on' and RTS 'Always off'.  

 There are some limitations in the radio control provided by Yaesu.  
o The best way to understand what is possible is to take few minutes and 

review the available CAT Commands on page 72 of your operating 
manual.  

o VFO A/B : It is only possible to switch from one VFO to the other but there 
is no way to know by the program if the radio is on VFO A or VFO B.  

o Narrow CW Filter : There is no CAT Command to set Filters on the radios.  

10.11. FT-840 

 Supported  

10.12. FT-847 

 Split operation via the program is not functional due to Yaesu radio control 
limitations. Split needs to be set/cleared manually by the operator.  



10.13. FT-857, FT-857D 

 There has been a confirmed change in the radio firmware in the newer model FT-
857 radios. This operational change removed the radio control VFOA/B selection 
indicator which has broken SO2V operation. This is a radio limitation, not a 
program limitation. The newer model FT-857 radios can only be used in SO1V or 
SO2R program modes. If you own an older model radio, SO2V operation will 
function when selecting the FT-897 radio in the program menu.  

10.14. FT-890 

 Supported  

10.15. FT-897 

 The radio control provided by Yaesu is limited. All operating modes (SO1V, 
SO2V, SO2R) are supported.  

 The PTT line in the DATA jack on the rear of the radio cannot be used for CW, 
because when it is asserted, the radio sends a continuous key-down tone. To 
actuate PTT from the program using RTS or DTR, the interface must be wired to 
the front-panel microphone jack's PTT pin.  

10.16. FT-897D 

 The radio control provided by Yaesu is limited.  
 If you are having problems with the SO2V radio control with a newer model FT-

897D radio, this is likely caused by a change made to the radio firmware. The 
solution is to select the FT-857 radio model and use the SO1V or SO2R program 
modes. See the comment in the FT-857 text about the confirmed operational 
change in the radio. This is a radio limitation not a program limitation.  

 The PTT line in the DATA jack on the rear of the radio cannot be used for CW, 
because when it is asserted, the radio sends a continuous key-down tone. To 
actuate PTT from the program using RTS or DTR, the interface must be wired to 
the front-panel microphone jack's PTT pin.  

10.17. FT-900 

 Supported  

10.18. FT-920 

 The radio control provided by Yaesu does not include an indicator in the polling 
data to indicate which VFO is selected or active. If the user changes the VFO by 
pressing the radio buttons, the program can not detect this change. This is a 
radio limitation, not a program limitation. It is recommended to use this radio in 
SO1V or SO2R mode.  



10.19. FT-950 

 The radio menu CAT TOT should be set to 1000 or higher.  
 The radio menu CAT RATE must match the program COM port baud rate. The 

suggested baud rate is 38400 (38400, N, 8, 2).  
 When using a COM port cable that contains data and signaling wires, verify that 

the radio menu CAT RTS = ENABLE (default) and the program radio COM port 
RTS to Handshake or Always ON.  

 When using a COM port cable with only three wires (TX, RX and ground) set 
CAT RTS = DISABLE on the radio menu and set the program radio COM port 
RTS to Always OFF.  

 There are other forms of the CATMacros for SO2R use but a basic form to play 
the internal radio voice memories are:  

o {CAT1ASC PB0#;} (where # is a number 1 - 5 for message 1 - 5)  
o {CAT1ASC PB00;} (stop)  

 The DVK stop command is sent to the radio when the ESC key is 
pressed.  

10.20. FT-990 

 FT-990 and early FT-1000 had a design problem in the CAT interface. It used an 
open emitter transistor on the serial out line. That worked fine for TTL HIGH (+5 
V) but some TTL to RS232 interfaces did not have enough load to cause the 
output to go low ... the interface would "float" in the undefined logic state between 
.3 and 3.5 volts. The solution is to add a 1.5K Ohm resistor from "serial out" to 
ground. When using the ARRL handbook design the 1.5k resistor needs to be 
added between pin 1 of the 7417 (which is pin 2 of the DIN) to ground.  

 The radio control provided by Yaesu does not include an indicator in the polling 
data to indicate which VFO is selected or active. If the user changes the VFO by 
pressing the radio buttons, the program can not detect this change. This is a 
radio limitation, not a program limitation. It is recommended to use this radio in 
SO1V or SO2R mode.  

10.21. FT-991 

 The radio firmware has been updated several times. Be sure to install the latest 
firmware.  

 Due to the design, this radio can only be used in SO1V or SO2R modes.  
 Setup information and notes:  

o Install the Silicon Laboratory drivers onto your computer per the Yaesu 
website instructions.  

o Install a Standard USB cable between the FT-991 and your computer. If 
the Silicon Labs drivers were successfully installed, you will have an 
enhanced port and a standard port showing in device manager.  

o Set the following menu items on the ft-991. Note: the menu #’s may 
change with future firmware updates.  



 012 keyer type off  
 031 CAT rate 38400  
 032 CAT Tot 1000  
 033 CAT rts disable  
 060 PC keying dtr  
 071 Data PTT sel rts  

o Select the hardware tab. Under Port, select your enhanced port. Under 
radio select FT-991. Click on SET and input 38400,N,8,2 always off, 
always off. Select Radio NR1. Place a check mark in Enable Both 
Hardware and Software.  

10.22. FT-1000(D) 

 Cat control will not work with FT-1000D internal software version 
lower than v6....most older ft1000d's have version v5.8... you need 
an update!  

 Older versions do have a CAT control problem. Check out the 
infromation with the FT-990 (above).  

 If the bandmap/frequency is not updating, the radio probably is in 
Mem/Tune mode. Deselect using the VFO/MEM switch.  

 The program forces the radio at startup from Mem/Tune 
mode in VFO mode to avoid this problem.  

 For filter settings see below  
o The stereo (grave accent - `) key toggles Sub on and off. It is identical to 

pressing the SUB radio button. To leave SUB on all the time, select 
Configurer>Dual RX always on  

o Subrx ON/OFF control by Logger (SO2V mode)  
 Independent of the state of Dual RX Always On:  

 Changing RX Focus to VFOB turns the subrx ON  
 ` or Alt+F12 toggles subrx ON/OFF if RX Focus is on VFOA 

(action disabled if RX Focus on VFOB)  
 Dual RX Always On Checked:  

 Clicking any vfo bandmap/avail. window spot or Ctrl+Up/Dn 
turns the subrx ON  

 Changing RX Focus turns the subrx ON  
 If dual rx always on was unchecked and the user checks it, 

subrx is turned ON  
 Dual RX Always On Unchecked:  

 If the TX & RX Focus is on VFOB and the RX Focus 
changes to VFOA ( \ keystroke), the subrx stays ON  

 If the TX & RX Focus is initially on VFOB and then RX & TX 
Focus is on VFOA (PAUSE, CTRL+Left or VFOA 
Bandmap/Available window spot click ), the subrx is turned 
OFF  

 If dual rx always on was checked and the user unchecks it, 
subrx is turned OFF  



o Ctrl+Alt+D command action:  
 If "Dual RX always on" is ON and the Sub RX is ON, turn "Dual RX 

Always On" to OFF and leave the Sub RX ON  
 If "Dual RX always on" is ON and the Sub RX is OFF, turn "Dual 

RX Always On" to OFF and leave the Sub RX OFF  
 If "Dual RX always on" is OFF and the Sub RX is ON, turn "Dual 

RX Always On" to ON and leave the Sub RX ON  
 If "Dual RX always on" is OFF and the Sub RX is OFF, turn both 

ON  
o Alt+F12 action is similar to the stereo (`) key, but also affects "Dual RX 

Always On" state:  
 If the subrx is OFF - check "Dual RX always on" and turn the subrx 

ON  
 If the subrx is ON - uncheck "Dual RX always on" and turn the 

subrx OFF unless RX Focus is on VFOB  

10.23. FT-1000MP (Mark-V)(Field) (Not for use with SteppIR antenna 

controller) 

 The program can't send CW via the MP's serial cable. See the help 
for how to build a CW interface  

 If the bandmap/frequency is not updating, the radio probably is in 
Mem/Tune mode. Deselect using the VFO/MEM switch.  

 The program forces the radio at startup from Mem/Tune 
mode in VFO mode to avoid this problem.  

 The indicator should show VFO.  
 Use a straight serial cable  
 4800,N,8,2 and DTR and RTS set to "Always Off"  
 A big issue with the FT-1000MP is that you cannot set the radio to 

split with VFO-B as the RX. Well, you can, but you cannot control 
whether you are listening dual, or just VFO-B from the computer. 
You can detect it, but not set it. The user will have to press the 
main RX button to turn off the main receiver when split from VFO-B. 
Note that Alt+F10 will swap VFO A & B frequencies. That is very 
useful in this case.  

 Optimum configuration for those who wish to operate AFSK and/or 
PSK. There will be an 85 Hz display offset between RTTY and PSK 
but that is minor.  

 PKT is LSB with the frequency display shifted by 2.125 KHz (or 
other user defined offset at menu 6-4). It also selects audio input 
from the PACKET jack on the rear of the radio, disables the 
processor and mutes the microphone. Finally, it offsets the filters so 
the narrow filters are properly placed (centered as specified in 
menu 6-5).  

 Using QMB memories  



 When doing a QMB RCLl press M>A until it transfers the 
QMB frequency to the VFO. After this it should work as 
normal, but you lose the original frequency that was in VFO-
A.  

 For filter settings see below  
o The stereo (grave accent - `) key toggles Sub on and off. It is identical to 

pressing the SUB radio button. To leave SUB on all the time, select 
Configurer>Dual RX always on  

o Subrx ON/OFF control by Logger (SO2V mode)  
 Independent of the state of Dual RX Always On:  

 Changing RX Focus to VFOB turns the subrx ON  
 The ` key or Alt+F12 toggles subrx ON/OFF if RX Focus is 

on VFOA (action disabled if RX Focus on VFOB)  
 Dual RX Always On Checked:  

 Clicking any vfo bandmap/avail. window spot or Ctrl+Up/Dn 
turns the subrx ON  

 Changing RX Focus turns the subrx ON  
 If dual rx always on was unchecked and the user checks it, 

subrx is turned ON  
 Dual RX Always On Unchecked:  

 If the TX & RX Focus is on VFOB and the RX Focus 
changes to VFOA ( \ keystroke), the subrx stays ON  

 If the TX & RX Focus is initially on VFOB and then RX & TX 
Focus is on VFOA (PAUSE, CTRL+Left or VFOA 
Bandmap/Available window spot click ), the subrx is turned 
OFF  

 If dual rx always on was checked and the user unchecks it, 
subrx is turned OFF  

o Ctrl+Alt+D command action:  
 If "Dual RX always on" is ON and the Sub RX is ON, turn "Dual RX 

Always On" to OFF and leave the Sub RX ON  
 If "Dual RX always on" is ON and the Sub RX is OFF, turn "Dual 

RX Always On" to OFF and leave the Sub RX OFF  
 If "Dual RX always on" is OFF and the Sub RX is ON, turn "Dual 

RX Always On" to ON and leave the Sub RX ON  
 If "Dual RX always on" is OFF and the Sub RX is OFF, turn both 

ON  
o Alt+F12 action is similar to the stereo (`) key, but also affects "Dual RX 

Always On" state:  
 If the subrx is OFF - check "Dual RX always on" and turn the subrx 

ON  
 If the subrx is ON - uncheck "Dual RX always on" and turn the 

subrx OFF unless RX Focus is on VFOB  

10.24. FT-1000MPSteppIR 



 Select this FT1000mp when using a SteppIR antenna.  
 This selection is optimized for the combination of an FT1000MP 

and the SteppIR antenna. It sends radio commands one at a time, 
paced with the command delay. Otherwise, it is identical to the FT-
1000MP  

10.25. FT-1000 series, FT-990 and FT-920 Setting filters 

Simply right-click on the bandmap and you will get a menu which includes "Set 
transceiver filter codes" ... there are six submenus: CW Wide, CW Narrow, SSB Wide, 
SSB Narrow, Digi Wide and Digi Narrow. In my case the commands for SO2V are:  

 The settings below will work for the FT-1000, FT-1000D, the FT-
1000MP, the FT-1000MP/MKV and the FT-1000MP/MKV Field (or 
any combination of two FT-1000 "family" of rigs in SO2R).  

BandWidth 
VFO-A 
(main) 

VFO-B 
(sub) 

Filter Remarks  

2.4 kHz 0 0 0 0 140 
0 0 0 128 
140 

SSB Wide or Digi Wide —  

2.0 KHz 0 0 0 1 140 
0 0 0 129 
140 

SSB Narrow or Digi 
Narrow 

will use 2.4 kHz on 
VFO-B  

500 Hz 0 0 0 2 140 
0 0 0 130 
140 

CW Wide or Digi Wide —  

250 Hz 0 0 0 3 140 
0 0 0 131 
140 

CW Narrow or Digi 
Narrow 

will use 500 Hz on 
VFO-B  

6.0 KHz 
(thru) 

0 0 0 4 140 
0 0 0 132 
140 

—  -- 

 The VFO-B (sub) only supports bandwidths of 6.0 KHz, 2.4 KHz 
and 500 Hz.  

 For SO2R (two rigs) configure the two bandmaps the same.  
 Some notes:  

 "Duplicates default filter settings" is appropriate to the FT-
1000 MK/V and Field only. The FT-1000/D/MP permit more 
flexible filter selection.  

 The FT-920 does not support 2.0 KHz and 250 Hz filters ... it 
might make more sense to revise CW and Digi settings for 
2.4/500 Hz (0 0 0 0 140 and 0 0 0 2 140) filters.  

 Even though the FT-920 lacks the second receiver, the FT-
920 permits selecting different bandwidths for each VFO. 
The CAT commands are the same as those for the second 
receiver in the "1000" series: 0 0 0 130 140 selects 500 Hz 
and 0 0 0 128 140 selects 2.4 KHz.  



 The FT-990 commands are the same as those for VFO A in 
the "1000" series of radios.  

10.26. FT-2000 

 A user has reported communications issues when using firmware version 11.54 
1.55. It's unclear if a CAT menu has been changed or added. The user reported 
no issues when using firmware 11.53 1.50.  

 The radio menu CAT TOT should be set to 1000 or higher.  
 The radio menu CAT RATE must match the program COM port baud rate. The 

suggested baud rate is 38400 (38400, N, 8, 2).  
 When using a COM port cable that contains data and signaling wires, verify that 

the radio menu CAT RTS = ENABLE (default) and the program radio COM port 
RTS to Handshake or Always ON.  

 When using a COM port cable with only three wires (TX, RX and ground) set 
CAT RTS = DISABLE and the program radio COM port RTS to Always OFF.  

 There are other forms of the CATMacros for SO2R use but a basic form to play 
the internal radio voice memories are:  

o {CAT1ASC PB0#;} (where # is a number 1 - 5 for message 1 - 5)  
o {CAT1ASC PB00;} (stop)  

 The DVK stop command is sent to the radio when the ESC key is 
pressed.  

 The stereo (grave accent - `) key toggles Sub RX On and Off. To leave SUB On 
all the time, select Configurer>Dual RX Always On  

 Subrx ON/OFF control  
o Independent of the state of Dual RX Always On:  

 Changing RX Focus to VFOB with \, PAUSE, or CTRL+RightArrow 
turns the subrx ON  

 Ctrl+Shift+Up/Dn used to store the next Bandmap spot in the Sub 
does not change the state of the subrx  

 The ` key or Alt+F12 toggles subrx ON/OFF when RX Focus is on 
VFOA. This action is disabled if RX Focus on VFOB.  

o Dual RX Always On checked:  
 Clicking any VFO, Bandmap, or Available window spot or 

Ctrl+Up/Dn turns the subrx ON  
 Changing RX Focus with \ turns the subrx ON  
 If Dual RX Always On was unchecked and the user checks it, subrx 

is turned ON  
o Dual RX Always On unchecked:  

 If the TX & RX Focus is on VFOB and the RX Focus changes to 
VFOA with the \ keystroke, the subrx stays ON  

 If the TX & RX Focus is initially on VFOB and then RX & TX Focus 
is on VFOA (PAUSE, CTRL+Left or VFOA Bandmap/Available 
window spot click ), the subrx is turned OFF  



 If Dual RX Always On was checked and the user unchecks it, subrx 
is turned OFF  

 Ctrl+Alt+D command action:  
o If "Dual RX always on" is ON and the Sub RX is ON, turn "Dual RX Always 

On" to OFF and leave the Sub RX ON  
o If "Dual RX always on" is ON and the Sub RX is OFF, turn "Dual RX 

Always On" to OFF and leave the Sub RX OFF  
o If "Dual RX always on" is OFF and the Sub RX is ON, turn "Dual RX 

Always On" to ON and leave the Sub RX ON  
o If "Dual RX always on" is OFF and the Sub RX is OFF, turn both ON  

 Alt+F12 action is similar to the stereo (`) key, but also affects "Dual RX Always 
On" state:  

o If the subrx is OFF - check "Dual RX always on" and turn the subrx ON  
o If the subrx is ON - uncheck "Dual RX always on" and turn the subrx OFF 

unless RX Focus is on VFOB  

 Also see the Advanced SO2V for Radios with Separate Sub-Receivers? section 
of this manual.  

10.27. FTDX-1200 

 The radio menu settings:  
o CAT TOT should be set to 1000 or higher.  
o CAT RATE must match the program COM port baud rate. The suggested 

baud rate is 38400 (38400, N, 8, 2).  

 

10.28. FTDX-3000 

 The radio menu settings:  
o CAT TOT should be set to 1000 or higher.  
o CAT SELECT must be set to USB if you wish to use the internal USB port 

for CAT control.  
o PC KEYING must be set to DTR to send CW with a COM port or with the 

USB port on the radio.  
o CAT RATE must match the program COM port baud rate. The suggested 

baud rate is 38400 (38400, N, 8, 2).  
 When using a COM port cable that contains data and signaling wires, verify that 

the radio menu CAT RTS = ENABLE (default) and the program radio COM port 
RTS to Handshake or Always ON. When using a COM port cable with only three 
wires (TX, RX and ground) set CAT RTS = DISABLE on the radio menu and set 
the program radio COM port RTS to Always OFF.  

 There are other forms of the CATMacros for SO2R use but a basic form to play 
the internal radio voice memories are:  

o {CAT1ASC PB0#;} (where # is a number 1 - 5 for message 1 - 5)  
o {CAT1ASC PB00;} (stop)  

http://n1mmplus.hamdocs.com/tiki-editpage.php?page=SO2V


 The DVK stop command is sent to the radio when the ESC key is 
pressed.  

 The USB driver for the FTDX-3000 will install two virtual serial ports. One, called 
the "enhanced COM port", can be used for CAT control, while the other, the 
"standard COM port", can be used for PTT, CW or FSK keying  

10.29. FTDX-5000 

 The radio menu CAT TOT should be set to 1000 or higher.  
 The radio menu CAT RATE must match the program COM port baud rate. The 

suggested baud rate is 38400 (38400, N, 8, 2).  
 When using a COM port cable that contains data and signaling wires, verify that 

the radio menu CAT RTS = ENABLE (default) and the program radio COM port 
RTS to Handshake or Always ON.  

 When using a COM port cable with only three wires (TX, RX and ground) set 
CAT RTS = DISABLE and the program radio COM port RTS to Always OFF.  

 There are other forms of the CATMacros for SO2R use but a basic form to play 
the internal radio voice memories are:  

o {CAT1ASC PB0#;} (where # is a number 1 - 5 for message 1 - 5)  
o {CAT1ASC PB00;} (stop)  

 The DVK stop command is sent to the radio when the ESC key is 
pressed.  

 The stereo (grave accent - `) key toggles Sub RX On and Off. To leave SUB On 
all the time, select Configurer>Dual RX Always On  

 Subrx ON/OFF control  
o Independent of the state of Dual RX Always On:  

 Changing RX Focus to VFOB with \, PAUSE, or CTRL+RightArrow 
turns the subrx ON  

 Ctrl+Shift+Up/Dn used to store the next Bandmap spot in the Sub 
does not change the state of the subrx  

 The ` key or Alt+F12 toggles subrx ON/OFF when RX Focus is on 
VFOA. This action is disabled if RX Focus on VFOB.  

o Dual RX Always On checked:  
 Clicking any VFO, Bandmap, or Available window spot or 

Ctrl+Up/Dn turns the subrx ON  
 Changing RX Focus with \ turns the subrx ON  
 If Dual RX Always On was unchecked and the user checks it, subrx 

is turned ON  
o Dual RX Always On unchecked:  

 If the TX & RX Focus is on VFOB and the RX Focus changes to 
VFOA with the \ keystroke, the subrx stays ON  

 If the TX & RX Focus is initially on VFOB and then RX & TX Focus 
is on VFOA (PAUSE, CTRL+Left or VFOA Bandmap/Available 
window spot click ), the subrx is turned OFF  



 If Dual RX Always On was checked and the user unchecks it, subrx 
is turned OFF  

 Ctrl+Alt+D command action:  
o If "Dual RX always on" is ON and the Sub RX is ON, turn "Dual RX Always 

On" to OFF and leave the Sub RX ON  
o If "Dual RX always on" is ON and the Sub RX is OFF, turn "Dual RX 

Always On" to OFF and leave the Sub RX OFF  
o If "Dual RX always on" is OFF and the Sub RX is ON, turn "Dual RX 

Always On" to ON and leave the Sub RX ON  
o If "Dual RX always on" is OFF and the Sub RX is OFF, turn both ON  

 Alt+F12 action is similar to the stereo (`) key, but also affects "Dual RX Always 
On" state:  

o If the subrx is OFF - check "Dual RX always on" and turn the subrx ON  
o If the subrx is ON - uncheck "Dual RX always on" and turn the subrx OFF 

unless RX Focus is on VFOB  

 Also see the Advanced SO2V for Radios with Separate Sub-Receivers? section 
of this manual.  

10.30. FTDX-9000 

 The radio menu CAT TOT should be set to 1000 or higher.  
 The radio menu CAT RATE must match the program COM port baud rate. The 

suggested baud rate is 38400 (38400, N, 8, 2).  
 When using a COM port cable that contains data and signaling wires, verify that 

the radio menu CAT RTS = ENABLE (default) and the program radio COM port 
RTS to Handshake or Always ON.  

 When using a COM port cable with only three wires (TX, RX and ground) set 
CAT RTS = DISABLE and the program radio COM port RTS to Always OFF.  

 There are other forms of the CATMacros for SO2R use but a basic form to play 
the internal radio voice memories are:  

o {CAT1ASC PB#;} (where # is a number 1 - 5 for message 1 - 5)  
o {CAT1ASC PB0;} (stop)  

 The DVK stop command is sent to the radio when the ESC key is 
pressed.  

 The stereo (grave accent - `) key toggles Sub RX On and Off. To leave SUB On 
all the time, select Configurer>Dual RX Always On  

 Subrx ON/OFF control  
o Independent of the state of Dual RX Always On:  

 Changing RX Focus to VFOB with \, PAUSE, or CTRL+RightArrow 
turns the subrx ON  

 Ctrl+Shift+Up/Dn used to store the next Bandmap spot in the Sub 
does not change the state of the subrx  

 The ` key or Alt+F12 toggles subrx ON/OFF when RX Focus is on 
VFOA. This action is disabled if RX Focus on VFOB.  
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o Dual RX Always On checked:  
 Clicking any VFO, Bandmap, or Available window spot or 

Ctrl+Up/Dn turns the subrx ON  
 Changing RX Focus with \ turns the subrx ON  
 If Dual RX Always On was unchecked and the user checks it, subrx 

is turned ON  
o Dual RX Always On unchecked:  

 If the TX & RX Focus is on VFOB and the RX Focus changes to 
VFOA with the \ keystroke, the subrx stays ON  

 If the TX & RX Focus is initially on VFOB and then RX & TX Focus 
is on VFOA (PAUSE, CTRL+Left or VFOA Bandmap/Available 
window spot click ), the subrx is turned OFF  

 If Dual RX Always On was checked and the user unchecks it, subrx 
is turned OFF  

 Ctrl+Alt+D command action:  
o If "Dual RX always on" is ON and the Sub RX is ON, turn "Dual RX Always 

On" to OFF and leave the Sub RX ON  
o If "Dual RX always on" is ON and the Sub RX is OFF, turn "Dual RX 

Always On" to OFF and leave the Sub RX OFF  
o If "Dual RX always on" is OFF and the Sub RX is ON, turn "Dual RX 

Always On" to ON and leave the Sub RX ON  
o If "Dual RX always on" is OFF and the Sub RX is OFF, turn both ON  

 Alt+F12 action is similar to the stereo (`) key, but also affects "Dual RX Always 
On" state:  

o If the subrx is OFF - check "Dual RX always on" and turn the subrx ON  
o If the subrx is ON - uncheck "Dual RX always on" and turn the subrx OFF 

unless RX Focus is on VFOB  

 Also see the Advanced SO2V for Radios with Separate Sub-Receivers? section 
of this manual.  

11. Unsupported Radios 

 JRC JST-145 & JST-245 - These radios are unsupported because they lack 
commands to determine if the radio is in split, no means to set or clear split, the 
VFO can not be selected, and they lack an indicator to determine which VFO is 
active.  

12. Other Models 

 Submit a Feature Request along with a URL for the developers information for 
the computer interface. Radios with limited radio control or very long data 
exchanges are not well suited for this software application.  
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2.3 Key Assignments - Keyboard Shortcuts 

in-edit  

XXXThis entire page needs to be reviewed for any changesXXX  
XXXThe only change made so far was to add some WAE QTC keystrokes in the last 
sub-sectionXXX  

 2.3 Key Assignments - Keyboard Shortcuts  

 1. Key Assignments Short List  
 2. General Key Assignments  
 3. Active Radio/Bandmap Control Key Assignments  

 3.1. Jump to Spots  
 3.2. Jump to CQ Frequencies  
 3.3. Tune the Radio  
 3.4. Change Keyboard & Radio Focus  
 3.5. Other Nifty Tricks  

 4. Non-Active Radio/Bandmap Control Key Assignments  

 4.1. Jump to Spots  
 4.2. Tune the Radio  

 5. Logging Key Assignments  
 6. Callsign/Exchange Editing Features  
 7. Message Key Assignments  
 8. CW Key Assignments  
 9. 'Enter Sends Message' mode (ESM)  
 10. Telnet Key Assignments  
 11. Available Window Key Assignments  
 12. SO2R Key Assignments  
 13. RTTY Key Assignments  
 14. Gridsquare Key Assignments (VHF and up)  
 15. Rotator Key Assignments  
 16. Window Key Assignments  
 17. Lookup Table Edit  
 18. QTC Keys (for WAE contests)  

1. Key Assignments Short List 

Key Assignments Short List 

Running keys S&P Keys 

F1 = CQ Shift+F1 = Call CQ and switch to run 

; or insert = Send call and report 
Alt+U= Toggle S&P/Run. Set CQ-
frequency for pass 



' = Send TU message and enter in log Alt+Q = Return to CQ-frequency 

Alt+R = Enable CQ repeat 
Ctrl+Up/Dn arrow = Grab next qso from 
bandmap 

Ctrl+R = Set repeat time 
Ctrl+Alt+Up/Dn arrow = Grab next mult 
from bandmap 

Esc = Stop sending, stop repeat - 

General keys Radio control 

Ctrl+O = Set operator call (or OPON in 
Callsign field) 

Alt+F10 = Swap VFOs 

Ctrl+N = Add note to log Alt+Q = Return to CQ frequency 

Ctrl+W or Alt+W = Wipe entry fields, or 
unwipe a previously wiped contact. Release 
a reserved serial number 

Alt+F8 = Return to last frequency 

SPACE or TAB = Move between logging 
fields 

Ctrl+PgUp/PgDn = Up/Down a band 

ENTER = Log it (see ESM mode) 
Type CW/USB/LSB/RTTY = Change 
mode Type frequency in KHz = Change 
frequency or band 

Ctrl+Q/A = Quick edit previous or next call 
Ctrl+S = Set radio into split Ctrl+Alt+S - 
Toggle split mode 

Ctrl+D = Delete last qso. Asks for 
confirmation 

Ctrl+Enter = Set split frequency 

Alt+H = Show help 
Alt+F7 = Set split frequency or offset to 
specified frequency 

Alt+K = Edit message buttons 
Alt+' = Toggle between the wide and 
narrow filters 

Ctrl+Alt+Enter = Log a not accepted qso 
(invalid exchange, usually) 

Alt+F12 - Copy frequency and mode to 
other radio/VFO. Some radio-specific 
differences. 

- 
Backslash ( \ ) = Change Receive (RX) 
focus (VFO/Radio) 

DX Spots and Band Map ESM Mode 

Mouse wheel = Zoom in/out bandmap Ctrl+M = Turn on/off 

Keypad +/- = Zoom in/out bandmap Insert or ; = Send call and exchange 

Alt+D = Remove spot Enter = Send TU and log it 

Alt+P = Send spot Enter = Start CQ again... 

Ctrl+P = Send spot with comment Alt+Enter = Log without sending anything 

Ctrl+Tab = Toggle to/from packet window Multi-User Mode 



Alt+O = Store contact in the Bandmap 
Alt+Z = Set pass frequency (broadcast to 
all computers) 

Alt+Q = Jumps to the CQ frequency on this 
band 

- 

SO2R Specific radios / Rotor control 

Backslash ( \ ) - Two radios = Change 
Receive (RX) focus 

FT-1000MP + FT1000D + some Icom 
Dual Watch radios Alt+F12= Dual 
Receive toggle 

Pause = Swap both Transmit and 
Receive/Keyboard focus  

Ctrl+Enter = Send next ESM state on 
alternate radio 

TenTec Orion Alt+F12 = Toggle Main/left 
Sub/Right and Active in both ears. 

Ctrl+F1 to F12 = Send message on 
alternate radio  

Ctrl+B = Dueling CQ's 
Rotor control for the callsign in the 

Entry window 

` (Back-quote) = Toggle Stereo/Mono ( LPT 
pin 5) 

Alt+J - Turn rotor to bearing 

Alt+L - Turn rotor to long path bearing 
 

- Ctrl+Alt+J - Stop turning the rotor 

CW SSB RTTY VHF 

Page Up = speed up 
Ctrl+Shift+F1 
=Record CQ 

Alt+G = Grab call from 
stack 

Alt+minus = 
Toggle grids 

Page Down = speed 
down 

Ctrl+Shift+F* 
=Record F-key 
message 

Alt+T = RX/TX toggle 
Ctrl+E = Send 
message to 
stations 

= = send last Fkey 
again 

NB. Same keys 
again to stop 
recording 

Ctrl+Arrows = Swaps 
DI 

- 

Shift +Fx = send 
opposite mode Fx 

Same Same Same 

Ctrl+K = toggle CW 
window 

- 
Ctrl+K = toggle 
manual window 

Alt+Z = Set pass 
frequency 

Esc = Stop sending 
immediately and close 
window 

--- 
Esc = Stop sending 
immediately and close 
window 

- 

 Note 



The keys below work from all main windows 

2. General Key Assignments 

 Space - The spacebar will jump from field to field filling in defaults like the 
callsign from the call-frame, 59/599, and information from previous contacts with 
this station. SPACE IS THE PREFERRED TAB CHARACTER.  

 Tab - Jump to the next entry field in the Entry Window.  
 Shift+Tab - Jump to the previous entry field in the Entry Window.  
 Alt+H - open Internet help. Most windows have contest-specific help accessible 

from their right-click menus.  
 Ctrl+Tab - Toggle between the Entry window and the Packet window.  
 Alt+F9 - toggle through all the antennas for that band. The selected antenna will 

show in the status pane.  
 Alt+F4 - Quit the program. If two Entry windows (SO2R) the program will not exit. 

You are being asked if you are sure.  

3. Active Radio/Bandmap Control Key Assignments 

3.1. Jump to Spots 

 Note 

If you are operating single mode, your mode won't change when jumping between 
spots. 

 Ctrl+Down Arrow - Get next spot higher in frequency.  
 Ctrl+Up Arrow - Get next spot lower in frequency.  
 Ctrl+Alt+Down Arrow - Get next spot higher in frequency that is a multiplier.  
 Ctrl+Alt+Up Arrow - Get next spot lower in frequency that is a multiplier.  
 Shift+Alt+Up Arrow - Get next spot lower in frequency that is self-spotted.  
 Shift+Alt+Down Arrow - Get next spot higher in frequency that is self-spotted.  

3.2. Jump to CQ Frequencies 

 Alt+Q - Jumps to the last CQ frequency on this band (active bandmap) and will 
clear all textboxes in the Entry Window.  

 Shift+Alt+Q - Jumps to the last CQ frequency on other band (non-active 
bandmap).  

 Ctrl+Alt+Q - Jumps to your last used CQ frequency on any band and tune active 
bandmap to that frequency.  

 Alt+F8 - Return to your previous frequency (you can use this to "undo" Alt+Q).  

3.3. Tune the Radio 

 Ctrl+Page Up - Go up one band. WARC bands are skipped while logging for a 
contest.  



 Ctrl+Page Down - Go down one band. WARC bands are skipped while logging 
for a contest.  

 Up Arrow - Tune radio down 100 Hz on SSB, 20 Hz on CW (adjustable in the 
configurer).  

o FT-1000MP, FT-890, FT-920, FT-990 and FT-1000 and all Kenwood 
radios  

 In S&P - pressing the up/down arrows will turn off RIT and tune 
your main VFO.  

 In Running mode - it will turn on your RIT and tune the RIT.  
 Down Arrow - Tune radio up 100 Hz on SSB, 20 Hz on CW (adjustable).  

o See Up Arrow information above  
  
 Alt+F7 - Set split frequency or offset from current frequency for the active radio. 

When hitting Enter or click OK with nothing on the line split will be cleared. Press 
ESC or click Cancel to exit. More information about working split can be found in 
the Single Operator Split Operation chapter.  

 Ctrl+Enter - Entering a frequency or offset in the callsign field and entered with 
Ctrl+Enter will set a split frequency.  

 Alt+S - When your rig is in the split mode, Alt+S will reset the RX frequency back 
to your transmit frequency, but the split mode is preserved. "Reset RX frequency 
when running split" is associated with Alt+S. When invoked, the program will 
automatically do an Alt+S as you log each QSO. Operates on VFO-A only!  

 Ctrl+S - Set radio to split operation, if not in split mode already.  
 Ctrl+Alt+S - Toggle Split mode on the radio. 'Split' will be shown in the Entry 

window.  
  
 Alt+F5 - Swap radio frequency, mode, and callsigns between VFOs (SO2V) or 

radios (SO2R). In SO2R, the receive focus changes to the non-active radio.  
 Alt+F6 - Identical to Alt+F5 except the receive focus does not change.  
 Alt+F8 - Jump to your last frequency.  
 Alt+' (Alt+singlequote) - toggle between the wide and narrow filter for the 

selected mode (SSB, CW and Digi modes).  
 Ctrl+Alt+D - Allows the SO2V user to enable CQ repeat, call CQ on VFOA, and 

tune the sub-receiver (VFOB) between CQ's. Currently, this feature is only 
enabled for the K3, IC756, IC756Pro, IC756Pro2, IC756Pro3, IC7800, and 
IC7600.  

o If "Dual RX always on" is ON and the Sub RX is ON, turn "Dual RX Always 
On" to OFF and leave the Sub RX ON  

o If "Dual RX always on" is ON and the Sub RX is OFF, turn "Dual RX 
Always On" to OFF and leave the Sub RX OFF  

o If "Dual RX always on" is OFF and the Sub RX is ON, turn "Dual RX 
Always On" to ON and leave the Sub RX ON  

o If "Dual RX always on" is OFF and the Sub RX is OFF, turn both ON  

3.4. Change Keyboard & Radio Focus 

http://n1mmplus.hamdocs.com/tiki-index.php?page=Single+Operator+Split+Operation


 Ctrl+Left arrow - Move both TX and RX/Keyboard focus to VFO A or in SO2R to 
left radio  

 Ctrl+Right arrow - Move both TX and RX/Keyboard focus to VFO B or in SO2R 
to right radio  

 Alt+F10 - Swap between VFOs when using one radio (VFO A-B). On Icom 756 
and 7800 toggle between Main and Sub frequencies.  

o Command is disabled during SO2R for Icom radios that lack a swap VFO 
CAT command. This is because the program is unaware of Icom VFO B 
frequency in SO2R mode.  

 Pause - Swap radios and match keyboard to radio.  
 Backslash ( \ ) - Move RX focus and launches a second Entry Window if only 

one Entry window is open (not supported for SO1V).  
o SO2V - One radio - 2 VFOs - Moves RX focus between the 2 VFOs on the 

radio.  
o SO2R - Two radios - Moves RX focus between the 2 radios.  

3.5. Other Nifty Tricks 

 Mouse wheel - Zoom in or out the bandmap which has KEYBOARD focus.  
 Numeric keypad + (plus) - Zoom in the bandmap which has KEYBOARD focus 

to show fewer stations (less bandwidth).  
 Numeric keypad - (minus) - Zoom out the bandmap which has KEYBOARD 

focus to show more stations (more bandwidth).  
 Ctrl+T - Turn on the radio and send continuous CW (tune). Ctrl+T again or the 

Escape key ends the transmission.  
 Alt+F12 - Most radios use this command to copy frequency and mode to other 

radio/VFO.  
o A few radios use Alt+F12 for specific features and then mostly swaps 

MAIN and SUB using the CAT radio command  
o FT-1000MP + FT1000D + Elecraft K3 + Icom IC-756 series, IC-781 ,IC-

775 and IC-7800 only  
 Dual Receive toggle. NB. Only turn Dual Receive on/off from the 

keyboard so it stays in sync with the program.  
o TenTec Orion  

 Toggle between Main/left Sub/Right and Active in both ears.  
 ` (backquote or grave accent)  

o SO2R mode,Toggle Stereo/Mono ( LPT pin 5). If MK2R or OTRSP is 
enabled send stereo commands to the external SO2R controller.  

o SO2V mode, some radios containing Dual Rx have specific functions 
assigned to this key. See the Supported Radios section for the specifics.  

o SO1V mode, disabled.  
o Backquote (grave accent) can be found on US keyboard as the unshifted 

tilde ~  
 = (equal key) - Will send the last message key (F1-F12) again.  
 Alt+F11 Staying in Run Mode. During DXpeditions it could be very useful to stay 

in Run mode all the time and not jump inadvertently to S&P mode when you 
QSY. This behavior can be toggled using the Alt+F11 key. The following 



message will be given in the statusbar when DXpedition mode is ensabled 
"Run/S&P auto-toggle disabled". Back to normal shows the message "S&P and 
Run Mode enabled"  

 
 

4. Non-Active Radio/Bandmap Control Key Assignments 

4.1. Jump to Spots 

 Ctrl+Shift+Down Arrow - Get next spot higher in frequency and will skip over 
CQ-Frequency when radios/VFOs are on the same band. Proper keystroke 
operation is radio dependent. Disabled for SO1V.  

 Ctrl+Shift+Up Arrow - Get next spot lower in frequency and will skip over CQ-
Frequency when radios/VFOs are on the same band. Proper keystroke operation 
is radio dependent. Disabled for SO1V.  

 Shift+Ctrl+Alt+Down Arrow - Get next spot higher in frequency that is a 
multiplier. If you are operating single mode, your mode won't change when 
jumping between spots. Disabled for SO1V.  

 Shift+Ctrl+Alt+Up Arrow - Get next spot lower in frequency that is a multiplier. If 
you are operating single mode, your mode won't change when jumping between 
spots. Disabled for SO1V.  

 Shift+Alt+Q - Jumps to your last CQ frequency on the inactive VFO/radio.  

4.2. Tune the Radio 

 Ctrl+Shift+Page Up - Go up one band.  
 Ctrl+Shift+Page Down - Go down one band.  
 Shift + Numeric keypad + (plus) - Zoom in the inactive bandmap  
 Shift + Numeric keypad - (minus) - Zoom out the inactive bandmap  

5. Logging Key Assignments 

 Enter  
o Log contact, when 'Enter sends message' is off in config menu.  
o Sends message when 'Enter sends message' is on in config menu. The 

send messages depend on the field values i.e. in which field the cursor is 
in the Entry Window. Check the highlighted keys.  

 Space - Preferred character to move sequentially through Entry Window fields .  
o Jumps from callsign to Exchange field or vice versa.  
o Other fields' default values will be filled in  
o If there is a call on the callsign frame and if the callsign field is empty, the 

call from the frame will be placed in the callsign textbox.  
 Alt+Enter - Send End of QSO message key and log the contact. In ESM it just 

logs the contact (nothing sent).  
 Insert or ; - Sends His Call key followed by the Exchange key.  



 ' - Send End of QSO message and enter in log .  
 Alt+W or Ctrl+W (Alt+W = Ctrl+W)  

o Wipe Out Entry Fields, clear information about the current contact in this 
window  

o If all of the entry fields are blank, this restores the last wiped contact 
("unwipe" function)  

o Serial number contests: Release a reserved serial number after it has 
been reserved  

 Ctrl+Shift+W - Wipe out other window's contact information.  
 Ctrl+Alt+Enter - Log a not accepted 'invalid' qso (invalid exchange etc.). It will 

prompt for a comment. Use 'View | Notes' to correct later.  
o When no comment is entered "Forced QSO" will be added to the comment 

field.  
 Ctrl+Y - Edit last contact.  
 Ctrl+D - Delete the last contact.  
 Alt+O - Store contact in the bandmap.  
 Alt+M - Mark this frequency in the bandmap as being in use.  
 Alt+D - Removes the spot from the bandmap which is on the callsign frame or in 

the callsign field in the Entry window when S&P or CQ-frequency when Running.  
 Ctrl+F - Find the callsign entered in the callsign field in the log. Pressing Ctrl+F 

again will find the next instance.  
 Ctrl+M - Enable/disable 'Enter sends message' mode.  
 Ctrl+N - Add a note/comment to your last or current contact.  
 Ctrl+Q - Quick Edit mode, go back one qso in the log. Enter logs and Escape 

discards the changes made. No content checking!  
 Ctrl+A - Quick Edit mode, go forward one qso in the log. Enter logs and Escape 

discards the changes made. No content checking!  
 Ctrl+U - Increase the number in the exchange field by 1.  
 Alt+U - Toggles "Running' box". When running is checked, the behavior of Enter 

Sends Messages mode changes appropriately. Additionally contacts are logged 
as being part of a run.  

 Alt+K - Change the contents of the Packet/CW/SSB/Digital message buttons.  
 Alt+Y - Will "yank" the first call from the Check window in the Entry window 

callsign field.  
 Ctl+G - Cut number mode toggle.  
 Ctrl+Alt+G - to stack additional callsigns in all modes. Same as the macro 

{STACKANOTHER}  
 Ctrl+Shift+M - Used to set the Autosend threshold. Autosend will start sending 

the callsign before you have finished copying a full callsign. i.e. starting after a 
certain number of characters has been typed AFTER the last number in the 
callsign. The minimum threshold is 1. Zero will turn off the feature. Only when in 
RUN mode. 

o The Autosend rules are: 
 Find the first letter in the call  
 Find the last number after the first letter  
 Find the Nth letter after step 2  



 For example: Threshold set to 2 
 W4WYP would start sending at Y  
 S57AD would start sending at D  
 KH6/WA4WYP would start sending at Y (using the "/" rule as 

well)  
 WA4WYP/4 would start at Y (/4 will not be looked at)  

 WYP, WWYP and WAWYP do not meet the criteria for autosend to 
begin.  

 Prefixes like KH6/ are ignored and do not themselves trigger the 
autosend threshold.  

Key  Send function key(s) Action(s) 

Insert 
His Call Key & Exchange 
Key 

Send his call followed by the Exchange. 

;  
His Call Key & Exchange 
Key 

Send His call followed by the Exchange. 

Alt+Enter 
 

Log the contact. 

' 
End of QSO Key & Log 
contact 

Send the End of QSO message and log the 
contact. 

6. Callsign/Exchange Editing Features 

 Space Bar - Moves cursor to the last position the cursor was in prior to leaving 
the Callsign or Exchange fields.  

 Tab - Move to the next field.  
 Shift+Tab - Move to the previous field.  
 Home - Moves cursor to beginning of the field it's in.  
 End - Moves cursor to end of the field it's in.  
 Question mark (?) - Sends a ?, and will cause the ? to be highlighted when you 

reenter the field . E.g. N?MM will send what is typed, but automatically highlight 
the ? so you can replace it. A double ?, as in DL?K?A will highlight all text in 
between and including the ? marks. The first keystroke entered will replace all 
three characters.  

 Left/Right Arrow - Moves cursor to left or right one position within the field it's in.  
 Backspace - Delete character to the left.  
 Delete - Delete character to the right.  
 Shift+Home - Will highlight from the cursor insertion point to the home 

(beginning) of the textbox.  
 Shift+End - Will highlight from the cursor insertion point to the end of the textbox.  
 Shift+arrow key - Will highlight as you press the keys. When you type the first 

character, it will delete the highlighted character.  

7. Message Key Assignments 



 
There are two sets of messages stored for F1 through F12, one for Running mode and 
one for Search and Pounce mode. However, you can send the message from the 
opposite mode by pressing Shift+Fx. The assignments below apply to both modes.  

Below is a table of the function keys with their associated default messages. Note that 
the CQ key always switches the program to Running mode regardless of which mode it 
was in at the time. All of the keys named in the table are used by ESM. The His Call 
key, Exchange key and End of QSO key are called up by logging key shortcuts (Insert 
or ; key and' key) regardless of whether the Enter Sends Messages (ESM) feature is 
used or not. The function keys can be remapped to others on the Function Keys tab in 
the Configurer, but be very careful in doing so, because if you do, you may disrupt 
the functioning of the Enter Sends Messages (ESM) feature.  

Default Function Keys 

F1 CQ key F2 Exchange key F3 End of QSO Key F4 My Call Key 

F5 His Call Key F6 QSO B4 Key F7 - F8 Again Key 

F9 - F10 - F11 - F12 - 

 Esc - Stop sending CW or wav. file.  
 Ctrl+R - Set CQ repeat time in seconds or milliseconds (Example: 1.8 or 1800)  
 Alt+R - Toggles repeat mode. Hit Esc or begin entering a callsign to stop repeat 

temporarily  
 Shift+Fx - Sends the contents of the function key definition for the opposite 

mode. If you are in Run mode and press Shift+Fx, the program sends S&P Fx. 
The reverse is also true.  

 Ctrl+Shift+Fx - Record SSB message for the selected function key. Pressing 
Ctrl+Shift+Fx again stops the recording. Fx can be F1 to F12 in either the Run or 
S&P lists of function key definitions. Make sure that the program is in the correct 
mode (either Run or S&P), and that you have filled in filenames in rows 
Filenames must be entered in at least the first 12 function key slots (right-click on 
the message buttons in the Entry window to edit); if names are only in the first 
12, then the program will play those messages when the corresponding function 
keys are pressed, regardless of whether you are in Run or S&P mode.  

 Ctrl+Alt+Fx - Record external DVK memories 1 to 4, only on the W9XT card or 
other DVKs that emulate it  

8. CW Key Assignments 

 PgUp/PgDn - Adjust CW speed Up/Down active radio using Primary CW Speed 
Step (Other tab in Configurer).  

 Shift+PgUp/PgDn - Adjust CW speed Up/Down active radio/VFO using 
Secondary CW Speed Step (Other tab in Configurer) in SO2R/SO2V mode.  



 Alt+PgUp/PgDn - Adjust CW speed Up/Down inactive radio/VFO using 
Secondary CW Speed Step (Other tab in Configurer) in SO2R/SO2V mode.  

 Ctrl+K - This will open the CW window to send manual CW. Pressing Ctrl+K 
again will close the window  

o Pressing Ctrl+K within the CW window closes the CW window and any 
remaining characters in the buffer will be sent  

o Pressing Escape (or Enter) closes the CW window and stops sending 
immediately. No remaining characters in the buffer will be sent  

 Ctrl+Shift+R - Toggle CW Reverse/No Reverse.  

 

9. 'Enter Sends Message' mode (ESM) 

 Ctrl+M - Toggle 'Enter Sends Message' mode  
 Alt+Enter - Log without sending anything  
 Ctrl+Alt+Enter - Log even if exchange is invalid or missing  

 
Note: ESM is affected by two options in the Configurer under the Function Keys tab:  

 the "ESM sends your call once in S&P, then ready to copy received exchange" 
check box (sometimes called the "Big Gun" option)  

 the "Work dupes when running" check box (recommended)  

ESM Mode Enter Key Actions 

Callsign field 
Exchange 
field 

In Run Enter 
sends 

In S&P Enter 
sends 

Empty Empty CQ (F1) My Call (F4) 

New Call (1st time) 
Empty or 
invalid 

His Call + Exch(F5 
+ F2) 

My Call (F4) 

New Call (repeat) 
Empty or 
invalid 

Again? (F8) My Call (F4) 

New Call (repeat) - ESM sends 
call once... checked 

Empty or 
invalid 

Again? (F8) Again? (F8) 

New Call (before sending 
exchange) 

Valid 
His Call + Exch(F5 
+ F2) 

Exchange + 
Log(F2 + Log It) 

New Call (after sending 
exchange) 

Valid 
End QSO + 
Log(F3 + Log It) 

Log(Log It) 

Duplicate Call 
Empty or 
invalid 

QSO B4 (F6) do nothing 



Callsign field 
Exchange 
field 

In Run Enter 
sends 

In S&P Enter 
sends 

Duplicate Call (before sending 
exchange) 

Valid 
His Call + Exch(F5 
+ F2) 

Exchange + 
Log(F2 + Log It) 

Duplicate Call (after sending 
exchange) 

Valid 
End QSO + 
Log(F3 + Log It) 

Log(Log It) 

Dupe (1st time) - Work Dupes 
checked 

Empty or 
invalid 

His Call + Exch(F5 
+ F2) 

do nothing 

Dupe (repeat) - Work Dupes 
checked 

Empty or 
invalid 

Again? (F8) do nothing 

Dupe (before sending exchange) 
- Work Dupes checked 

Valid 
His Call + Exch 
(F5 + F2) 

Exchange + 
Log(F2 + Log It) 

Dupe (after sending exchange) - 
Work Dupes checked 

Valid 
End QSO + Log 
(F3 + Log It) 

Log(Log It) 

10. Telnet Key Assignments 

 Alt+P - Spot the callsign of the last station logged or the one currently in the 
callsign textbox in the format DX CALL Frequency, without comment unless one 
has been specified on the Spot Comment tab of the Telnet window.  

 Ctrl+P - Spot the callsign of the last station logged or the one currently in the 
callsign textbox. You will be prompted for a comment. Hit ESC,click "Cancel" or 
click the red X to exit the comment window without spotting. If you do not enter a 
comment, and one has been specified on the Spot Comment tab, it will be sent 
when you click OK. If you specify a comment, it will be sent along with the one 
specified on the Spot Comment tab.  

 Left-click - Tune the active radio to the frequency of the spot.  
 Shift+Left-click - Tune the inactive radio to the frequency of the spot.  
 SH/DX - Entered in Entry window Callsign field will be passed through to active 

Packet window for processing.  

11. Available Window Key Assignments 

 Left-click - Mostly tunes the active radio to the frequency of the spot. Behavior 
depends on SO1V, SO2V or SO2R and on options in the right-click menu in the 
Available window.  

 Shift+Left-click - Mostly tunes the inactive radio to the frequency of the spot. 
Behavior depends on SO1V, SO2V or SO2R and on Available window right-click 
options.  

 Double click - Go to the frequency with the active VFO.  
 Alt+A - Starting with the top row of the window's lower pane, grabs the callsign 

there and transfers it to the call-frame of the entry window. Repeating steps 



down through the spots one at a time and transfers the next one to the call-
frame. Color of the transferred spot changes to black.  

 Shift+Alt+A - Same, except that it starts with the current row, and repeated 
keypresses step up through the spots.  

12. SO2R Key Assignments 

 Ctrl+Enter - Send next ESM state on alternate radio (assuming ESM turned on).  
 Ctrl+F1 to F12 - Send Fn message on alternate radio.  
 Ctrl+Left Arrow - In SO2R move both Transmit and Receive/Keyboard focus to 

left radio, or in SO2V move both TX and RX/Keyboard focus to VFO A.  
 Ctrl+Right Arrow - In SO2R move both Transmit and Receive/Keyboard focus 

to right radio, or in SO2V move both TX and RX/Keyboard focus to VFO B.  
 Pause - Move both TX and RX Keyboard focus to other radio (or other VFO in 

SO2V). If TX and RX focus are split when you hit pause, TX focus will move to 
where the RX focus is.  

 Ctrl+B - Dueling CQ's will send CQ (without delay) alternately on each radio. If 
Dueling CQ's is turned on, both radios become run radios. Dueling SSB and CW 
CQ's are supported too.  

 Grave accent, backquote, or unshifted tilde key (~) Toggle STEREO mode 
on/off, or toggle Auto/PTT modes with modified DXD . Notes: On US keyboards, 
the key we are talking about is the key just to the left of the number 1 key.  

 Ctrl+I - Toggle SO2R Mode (Soundcard). Toggle through the SO2R modes 
supported by the program. Only operative in '$5SO2R' when N1MM logger 
controls the audio, not when using an external SO2R controller.  

 Ctrl+PgUp/Down - When changing band using Ctrl+PgUp/Down will skip the 
other radio's band.  

o THIS IS NOT A SUBSTITUTE FOR HARDWARE LOCKOUT!!  
 Ctrl+Shift+I - Toggle 'Advanced SO2R'. An advanced method of automated 

focus control. See SO2R?.  
 Ctrl+Shift+N - Set advanced SO2R delay time  
 Ctrl+Shift+K - FocusOther, Another method of automated focus control. Forces 

entry focus to non-transmitting radio, with entry focus returning to the transmitting 
radio as soon as it reverts to receive. See SO2R?. Disabled in SO1V mode.  

 Ctrl+Shift+L - Toggle CTRLFx Macro. This macro allows the user to send on the 
other radio (RTTY and CW only).  

13. RTTY Key Assignments 

 Alt+T - Toggle TX - RX  
 Alt+G - Grab callsign  
 Ctrl+K - Toggle TX/RX, and displays the CW/Digital Keyboard window to send 

manual information using the keyboard  
 Ctrl+Arrows - Swaps from one active DI to the other DI. DI1 will follow entry 

window 1. DI2 will follow entry window 2  
 Esc - Stop sending  

http://n1mmplus.hamdocs.com/tiki-editpage.php?page=SO2R
http://n1mmplus.hamdocs.com/tiki-editpage.php?page=SO2R


 

14. Gridsquare Key Assignments (VHF and up) 

 Alt+equal (=) - Search entered info from both the Callsign field and the 
Gridsquare field in the call history table.  

o The results will be shown in the Check window.  
 Alt+minus (-) - Toggle through call history and entered grid squares (max 3) in 

the grid square entry field.  
o When no grids are found in the call history there is nothing to toggle..  

15. Rotator Key Assignments 

 Alt+J - Turn rotor to bearing for the callsign in the Entry window or to the callsign 
in the callframe (when callsign field is empty).  

 Alt+L - Turn rotator to long path bearing for the callsign in the Entry window.  
 Ctrl+Alt+J - Stop turning the rotator when turning and no bearing in callsign field 

in Entry window.  

16. Window Key Assignments 

 Ctrl+Tab - Toggles between the Entry window and Packet window.  
 Ctrl+K - Display the CW/Digital Keyboard window to send manual information 

using the keyboard.  
 Ctrl+L - Display the Log window (toggles between open and minimized).  

 

17. Lookup Table Edit 

 Ctrl+D - to delete a row in the table or use the right click menu  
 Scroll Lock - the Scroll Lock key selects the current row for editing  

18. QTC Keys (for WAE contests) 

in-edit  

 Ctrl+Z - in CW/SSB, enters or leaves QTC mode; in RTTY, cycles through Send, 
Receive and QTC Off  

o If Ctrl+Z is pressed before the QSO with the station has been logged, logs 
the QSO  

 Enter - logs the next QTC (receiving), or sends the next QTC in the batch 
(sending)  

 F3 (End of QSO Key) - sends the TU message and exits QTC mode  
 Alt+W - wipes the current row  
 Esc - terminates sending (CW or RTTY), or if the program is not currently 

sending, exists the QTC window (same as the Cancel button)  



 Alt+Enter (sending QTCs only) - re-sends the last sent string  
 Alt+Enter, Alt+Tab, Alt+Space (receiving QTCs only) - force-logs the current 

QTC; overrides error-checking  
 Ctrl+A (receiving QTCs only) - removes the last blank line of received QTCs and 

reduces the count in the QTC header  
o Used, for example, when the number in the header was copied incorrectly 

and fewer QTCs are received than expected  
 Alt+A (receiving QTCs only) - adds a new QTC line (if fewer than 10) and 

increases the count in the QTC header  
o As above, when more QTCs are received than expected  

 1, 2, 3 (sending QTCs only) - if pressed while the Agn button is highlighted, 
resends the time(1), call(2) or serial number(3) from the previous QTC  

 

 

2.4 Function Keys, Messages and Macros 

 1 Stored Messages and the Function Key Message Editor 

 2 Macros 

 3 ESM - Enter Sends Message 

 4 Function Key Examples 

 

 

2.4.1 Stored Messages and the Function Key Editor 

 2.4 Function Keys, Messages and Macros  
 2.4.1 Stored Messages and the Function Key Editor  

o 1. Fundamentals  

 1.1. Important Change for Those Transitioning from N1MM Classic  

o 2. The Function Key Message Editor  

 2.1. The Save and Cancel Buttons  
 2.2. The File Menu  
 2.3. The Edit or Right-click Menu  

o 3. Function Key Message File Contents  

 3.1. Comment Line - any line that begins with a pound sign "#"  
 3.2. Message Line - any line that does not begin with a pound sign 

"#"  
 3.3. Message Content Limitations  

o 4. Sample Function Key Files  

http://n1mmplus.hamdocs.com/tiki-index.php?page=Stored+Messages+and+the+Function+Key+Message+Editor&structure=N1MM+Logger+Documentation
http://n1mmplus.hamdocs.com/tiki-index.php?page=Macros&structure=N1MM+Logger+Documentation
http://n1mmplus.hamdocs.com/tiki-index.php?page=ESM+-+Enter+Sends+Message&structure=N1MM+Logger+Documentation
http://n1mmplus.hamdocs.com/tiki-index.php?page=Function+Key+Examples&structure=N1MM+Logger+Documentation


o 5. Special Measures for SSB Function Keys  

 5.1. The {Operator} Macro  
 5.2. Recording on the Fly  
 5.3. Voicing Call-signs, Serial Numbers and Frequencies  

 5.3.1. Simple Voicing  
 5.3.2. Advanced Voicing  

 5.4. Recording Letters and Numbers  
 5.5. Should I Use Voicing?  

1. Fundamentals 

One of the things that differentiates contest logging programs from general-purpose 
loggers is the ability to send stored messages, to save energy during long contests. 
N1MM Logger can send stored messages in CW, SSB and digital contests. These 
messages can incorporate macros, short-form statements which perform program tasks 
automatically.  

It will help you to follow the discussion below if you first understand, in general terms, 
how N1MM Logger's message-sending capabilities are organized. The architecture 
consists of three primary components: Function Key Files, Messages, and Macros  

 Function Key Files are text files with a .mc extension that can be edited with a 
text editor (Notepad) or the program's internal Function Key Editor  

o Each row of text in a Function Key file is either a Comment or a Message  
 Comments begin with a pound sign "#" and help to explain the 

purpose of surrounding Messages. Comments are black text in the 
Function Key Editor  

 Messages are lines of text in a Function Key file that do not begin with a pound 
sign "#"  

o Messages begin with a label (text that will appear on the keys in the Entry 
Window), followed by comma ",", followed by the message itself  

o Messages can contain ordinary text, macros, or - in Messages for phone 
contests - WAV filenames  

o The first 12 Message lines are called Run Messages. They are assigned, 
in sequence, to the keyboard Function Keys F1 - F12 when you are in Run 
mode. Run Messages are blue text in the Function Key Editor  

o The next 12 Message lines (13 - 24) are called Search and Pounce 
Messages. They are also assigned, in sequence, to the keyboard Function 
Keys F1 - F12, but only when you are in Search and Pounce mode. 
Search and Pounce Messages are green text in the Function Key Editor  

 Macros are special text expressions surrounded by curly braces "{...}"  
o Macros can either trigger a program action or expand to a string of text to 

be transmitted in CW or digital modes  

 
Three default Function Key message files are included with the program, one for each 
mode: SSB Default Messages.mc, CW Default Messages.mc, and Digi Default 



Messages.mc. These are assigned automatically when you open a new contest (>File 
>New Log in database), as indicated on the Associated Files tab of the Contest Setup 
Dialog. You can edit the messages in the default files, export the messages to a new 
.mc file, or load different messages from an existing .mc file (for example, a .mc file that 
you download from the website's >File >Sample Function Key Files gallery). We'll get 
further into this below.  

× 

 A Macro is Not a Message 

Early in the use of computers for amateur radio contesting, the term "macro" was used 
to denote any stored message. We follow a different convention - for us, the term Macro 
means a message component that either triggers a program action or expands to a 
string of text to be transmitted in CW or digital modes. The use of the .mc filename 
extension for our Function Key message files is a left-over from those days. Don't be 
misled.  

1.1. Important Change for Those Transitioning from N1MM Classic 

 
N1MM Logger Classic found its wav files assuming the starting directory was the N1MM 
Logger program directory. Typically users would place their wav files in a sub-directory 
of the N1MM Logger program directory called wav. To call up a wav file in this sub-
directory, you would specify the file name in the form wav\filename.wav (or 
wav\{OPERATOR}\filename.wav if you were using operator-specific files) in your 
function key messages.  

N1MM Logger Plus finds its wav files assuming the starting directory is the wav sub-
directory created by the installer inside the N1MM Logger+ user files directory (*not* the 
program files directory). To call up a wav file in this sub-directory, you specify the file 
name in your function key messages as filename.wav, i.e. without the leading wav\ (or if 
you are using the {OPERATOR} macro, as {OPERATOR}\filename.wav, again without 
the leading wav\). If you edit your message files by removing the leading wav\ on file 
names in messages, you will be able to access wav files you have placed in the wav 
sub-directory.  

Alternatively, if you want to continue to use the same message files you used with 
Classic without editing them to remove all those leading wav\'s, you can create a new 
wav sub-directory inside the wav sub-directory in the N1MM Logger+ user files directory 
(so that these wav files are located at My Documents\N1MM 
Logger+\wav\wav\filename.wav, or My Documents\N1MM 
Logger+\wav\wav\{OPERATOR}\filename.wav - note the two levels of wav\ in the path 
name), and once you have placed your wav files in that new sub-directory (or in 
operator-specific sub-directories under that wav\wav sub-directory if you are using the 
{OPERATOR} macro), you can call those wav files up using your old function key 
message files.  

2. The Function Key Message Editor 

http://n1mmplus.hamdocs.com/tiki-index.php?page=The+Contest+Setup+Dialog
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The Function Key Message Editor is the key tool for managing your Function Key 
messages. It provides the best way for assigning, managing and editing Function Key 
Message files using a Notepad-like editing window. You can import and export function 
key message files, edit them, and save them.  

The easiest way to open the Function Key Message Editor is by typing Alt+K in the 
Entry Window, or by simply right-clicking on the message buttons in the Entry Window. 
The editor will display the message file associated with the current program mode (CW, 
SSB or digital). If you want to open the message files associated with the other modes, 
select >Config >Change CW/SSB/Digital Function Key Definitions and select the 
desired mode.  

× 

 Unknown Operating Mode? 

If right-clicking on a message button or pressing Alt+K results in an error message to 
the effect that the function key editor cannot be opened because the operating mode is 
not set, or if the function key editor opens up but the messages you see are for the 
wrong mode, you must first set the operating mode (CW, SSB or digital) before opening 
the function key editor. You do this by typing the mode (CW, SSB, RTTY or PSK) into 
the call sign box and pressing Enter. Once you have done this, right-clicking on a 
message button or pressing Alt+K will open the function key editor with the messages 
for the mode you entered. 

 
The Function Key Editor dialog window:  



 

2.1. The Save and Cancel Buttons 

 Save assigns the messages to the current contest and saves them to the file 
indicated in the title bar of the Function Key Editor. If you want to save those 
changes to a different file, use Export. Note: It is easy to change a default 



function key file without meaning to, if you forget that it is the file in the 
title bar and Save a modified version. If you do this, use the Sample 
Function Keys function below to retrieve the defaults, and then save them 
to the original file name.  

 Cancel closes the editing window without saving. If you have made any changes, 
or imported a file, the program will ask you whether you want to save the 
changes. Answer Yes and the editor assigns the messages to the current contest 
and saves them to the file indicated in the title bar of the Function Key Editor. 
Answer No and the editor just closes, abandoning any changes you may have 
made.  

2.2. The File Menu 

 

 Copy these Messages to the Clipboard places the entire contents of the editor 
on the clipboard  

 Delete These Messages and insert Starter Message Text if you want to revert 
to the standard messages for the current mode, this option will copy them into 
the editor in place of the messages that were there, retaining the original 
filename. You will be asked if you wish to save your changes. OK makes the 
changes in the database and in the open .mc file; Cancel reverts to the previous 
message set.  

 Import and Assign a Different Function Key (.MC) file to this Contest 
assigns a file that you choose to this contest. It is entered on the Associated Files 
tab and will be automatically opened whenever you open this or another instance 
of this contest.  

 Save these Messages to a Different Function Key (.MC) filename opens a 
dialog where you can copy the current contents of the Function Key Message 
Editor to an .MC file of a different name.  

× 

 Starter Messages 

There has been a significant change in the way Default [mode]Message text is handled.  
A set of Default .mc files is loaded in the Documents folder at program installation. If 
you wish, you may modify these to your heart's content, changing them to fit each 
contest, or you may create and save contest-specific .mc files. Note, though, that if you 
start with a Default CW file, for example, make changes in the Function Key Editor, and 
Save them, they will be saved under that filename.  



If you wish to restore the original Default messages, you can do the following:  

 Click on "Import and Assign a Different Function Key File" on the File menu, and 
select the Default [mode] Messages.mc file you wish to revert.  

 Click on "Delete these Messages and Insert Starter Message Text" (also on the 
File Menu).  

 Click the Save button in the Function Key Editor, to save the Starter messages to 
the database and to the Default [mode] Messages.mc file, effectively recreating it 
in original form. If you exit without clicking Save, you will be prompted to decide 
whether you want to save the changes or not.  

2.3. The Edit or Right-click Menu 

 

If you select the drop-down menu item >Edit, or right-click in the Function Key Message 
Editor Window, you'll see a short menu. Three of the choices - cut, copy and paste - are 
the familiar Notepad editing commands and should need no explanation.  

 Insert wav filename selection does what its name implies. Click on it and you 
will be asked to select a wav filename from the N1MM Logger+\Wav directory. 
Select a Wav file, and its filename will be inserted at the location of your cursor. 
The intended use of this function is to make it easy to construct complex SSB 
messages, combining macros and filenames.  

× 

 Databases and Function Key Assignments 

Each database remembers your preferred Function Key file for a particular contest. For 
example, if you assign CQWWCW.MC to the CQ Worldwide CW contest in 2014, the 
database will remember your preference and also automatically assign the same file to 
the CQ Worldwide CW 2015 contest. However, if you open a new database for your 
logs, that memory is lost and you will begin with the default assignment of CW Default 
Messages.MC.  

 



3. Function Key Message File Contents 

Refer to the previous Fundamentals section and the Function Key Editor Dialog window 
screenshot for the following explanations  

N1MM Logger accommodates up to 24 messages for each mode (CW, SSB and 
Digital), each divided into two sets of 12, one for Run mode, the other for Search and 
Pounce (S&P). (For more information on Run vs. S&P and other features of function key 
usage, see the Entry Window chapter section on Function Keys). This means that your 
Function Key message files can have as many as 24 active lines, plus an unlimited 
number of Comment lines. Here's an example::  

3.1. Comment Line - any line that begins with a pound sign "#" 

o Comment Example: #This is a comment line  

3.2. Message Line - any line that does not begin with a pound sign "#" 

o Simple Message Example: F1 CQ, CQ  
Message lines have two elements - a Label and the Message itself. The 
Label is separated from the Message with a comma ",". In this example, 
the label is "F1 CQ" and the transmitted message is "CQ"  

o Simple Message Example with a Macro: F1 CQ, CQ de {MYCALL}  
In this example, the transmitted message is "CQ de" followed by my 
callsign, which the program will retrieve from the >Config >Change Your 
Station Data "Call" dialog  

o Message Example with multiple Macro: F2 Exch,! {SENTRST} {EXCH} 
de {MYCALL}  
In this example of a contest exchange, the transmitted message begins 
with the other station's callsign "!", followed by an RST report "SENTRST", 
followed by the contest exchange (which could be an incrementing contact 
number, a state, a CQ zone, or any number of parameters based on the 
contest), followed by "de", and finally my callsign  

3.3. Message Content Limitations 

o Label length is limited to 29 characters, though you would never want to 
use that many  

o Message total length is limited to 255 characters  
o Message line count is usually 24 - 12 for Run and 12 for Search & 

Pounce. However, if you do not assign S&P messages the program will 
automatically substitute the Run messages in their place. For example if 
your S&P messages for F9 - F12 are identical to those in Run, you can 
leave those lines blank. But be careful - because you cannot have any 
gaps in the sequential numbering of the S&P messages  

http://n1mmplus.hamdocs.com/tiki-index.php?page=Entry+Window


4. Sample Function Key Files 

In addition to the three default message files that install with the program, there are also 
a large number of Sample Function Key files available for download here on the 
website. The advantage of these sample files, over the default files, is that they have 
been customized for the major contests and can be used without further modification.  

5. Special Measures for SSB Function Keys 

CW and RTTY messages are quite straightforward. SSB messages, however, are a bit 
trickier. If you run two filenames, or a macro and a filename together - for example 
"Mycall.wavCQ.WAV" or "1Mycall.wav - Windows won't know where the firstelement 
ends and the second begins. The simple solution is to insert a comma between 
elements in an SSB message, so that example becomes "Mycall.wav,CQ.WAV".  

The SSB Default Message.mc file, as shown in the Function Key Editor  

http://n1mmplus.hamdocs.com/tiki-list_file_gallery.php?galleryId=23


 

This screenshot shows the default SSB function keys, as supplied with the program 
initially. You'll note that each of the function key messages includes only one Wav 
filename. F5-His Call, which can either be 1 space, or if you are using voicing of call 
signs, filled with "!". This is the macro that is used to tell the program to voice a callsign 
by putting together letter and number files, so it would not normally be used. The whole 
subject of voicing, which is both a little complicated and quite controversial, is discussed 
below. __Unless you are planning to voice call-signs or serial numbers (see below), you 



should never have the "!" macro in your SSB definitions. The same goes for the "#", "*", 
and "@" macros. Use an explicit filename like mycall.wav.  

The Wav files must be placed in the N1MM+ user directory, which would be 
C:\Users\login\Documents\N1MM Logger+\Wav (unless you changed the default user 
directory at time of installation). The "empty.wav" file is installed in that directory during 
program installation. In the case where a station has multiple operators, each operator's 
Wav files would be in an operator subdirectory C:\Users\login\Documents\N1MM 
Logger+\Wav\callsign. For example, K3CT's Wav files when operating at N1MM's 
station would be located in C:\Users\N1MM\Documents\N1MM Logger+\K3CT.  

5.1. The {Operator} Macro 

As you probably noticed above, there is an {Operator} macro in the path for each of the 
.wav message files. The purpose of this is to enable you to change the stored message 
files to match the operator currently on duty (in a multi-op or guest op situation). For 
example, if a set of messages (such as CQ.wav) are stored in My Documents\N1MM 
Logger+\Wav\N1MM, then if N1MM is the operator and the message refers to 
{OPERATOR}\CQ.wav, the program will send his CQ.wav when that key is pressed. 
The same is true for stored letters and numbers, used in voicing callsigns and serial 
numbers, except that those are stored in the path which is identified on the Other tab of 
the Configurer. If the path specified in the Configurer is {OPERATOR}\, N1MM's letter 
and number files will be found at My Documents\N1MM 
Logger+\wav\LettersFiles\N1MM\ .  

The current operator is displayed in the title bar of the Info window, and also in large 
blue letters inside that window, to the right. It is pre-filled with the callsign in the Station 
Data. To change the operator, just press Ctrl+O and enter the desired call-sign.  

Even if you operate alone, and never need to change operators, we recommend you 
leave the {Operator} macros in place and put the wav files in folders with your callsign 
as the title. That will make it easy to add a guest op, and in the meantime the 
substitution for {OPERATOR} will be provided from the Station Data page.  

5.2. Recording on the Fly 

If you need to record or re-record a function key file in a hurry, you can do so from 
inside the program, so long as the Function Key message calls only a single .wav file, 
and that .wav file is already assigned to that function key file in the database. Despite 
the limitations, this is still very useful, particularly for split operation in SSB contests 
where you want to specify a listening frequency that changes often.  

The key sequence to start and stop on-the-fly recording is Ctrl+Shift+Fkey, in either Run 
or S&P mode.  
When you start on-the-fly recording, a message will appear in the status line of the 
Entry window. If all is well, it will read "start recording:[file path and name]. Press 
Ctrl+Shift+Fkey after you have finished recording, and the status line will read 
"recording saved: [file path and name]. If you get an error message, and the Entry 
window is not large enough to read the whole thing, simply stretch it horizontally until 
you can.  

http://n1mmplus.hamdocs.com/login
http://n1mmplus.hamdocs.com/login
http://n1mmplus.hamdocs.com/callsign
http://n1mmplus.hamdocs.com/tiki-index.php?page=Configurer
http://n1mmplus.hamdocs.com/tiki-index.php?page=Configurer


If you invoke a .wav file that is not found (for example, by having the wrong .wav file or 
an incorrect path in the .mc file), you'll be warned in the same place. To trouble-shoot 
path problems, you may have to stretch the Entry window horizontally, because there is 
only limited space for the message in the status line.  

5.3. Voicing Call-signs, Serial Numbers and Frequencies 

This option appears to be growing in popularity among SSB contesters. One operator, 
to protect the sleep of his wife and young children, even created such a complete set of 
voicing files that he could operate an entire Sweepstakes without a microphone. Earlier 
releases of N1MM Logger contained a simplified form of voicing. In version 11.12.3 and 
thereafter, a more sophisticated way of voicing numbers was added. What follows 
explains the difference and how to implement either one.  

When voicing is used, the !, # and @ macros can be used in SSB messages, and the 
program will send the individual letter and number files that make up the call name or 
number that is to be sent. The individual letters, numbers and special characters used 
for voicing are stored in the location defined in the letters file path on the Files tab of the 
Configurer . Again, if you wish to have more than one operator, you will want to insert 
the {Operator} macro in the letters file path in the Configurer, and then record in a 
subdirectory named with the operator's call-sign, so that Ctrl+O can be used to tell the 
program which operator's letter files to use.  

Function key messages that use voicing may have more than one wav file or macro in 
them. Use commas to separate the individual wav file names and macros within a 
message.  

Note: If you do not want to use voicing, be sure that your Run F5 key is 
programmed to a single space, not "!".  

5.3.1. Simple Voicing 

This technique is used for voicing call-signs, as the simplest way of voicing serial 
numbers, and for giving your listening frequency when operating split. The operator 
records files for the letters A-Z, the numerals 0-9, and a few special characters - 
query.wav for the "?" character, stroke.wav for the portable indicator (which you 
denote in your log using the "/" or slash character), and point.wav to voice the decimal 
point (in a frequency, for example). When the ! macro is included in a function key 
definition, and the key is pressed, the program substitutes a sequence of .wav files for 
the number or callsign. N1MM is parsed into N.wav+1.wav+M.wav+M.wav. The # and 
@ macros work the same way for serial numbers and frequency, respectively.  

5.3.2. Advanced Voicing 

This technique is used to voice serial numbers in a way that is considered to be more 
intelligible than a simple string of numbers. The theory is that "One hundred twenty 
three" will likely be more easily understood than "one two three", because of the 
redundancy added by the "place markers."  

In order to implement advanced voicing, you will need to record the following wav files. 
These files must be stored in the user programmable Letters File path (Config, Files 
tab). The letters file path may contain the {Operator} macro, which is essential if you 
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have more than one operator. Example: If the path in the Configurer is {OPERATOR}\, 
the letter and number files will be in My Documents\N1MM 
Logger+\Wav\LettersFiles\{Operator}\  

0.wav through 19.wav (20 files)  
20.wav through 90.wav (only the even tens intervals) (8 files)  
hundred.wav and thousand.wav  

When you try to voice a number for the first time after program start, the program 
checks to see whether all the needed files for advanced voicing are present. If one or 
more are missing, serial numbers will be voiced using the simple voicing method. The 
same check is also made with changing operators (with Ctrl+O). A comment appears in 
the bottom pane of the Info window to report the outcome of the wav file check.  

A complete table showing the files voiced for each number can be found in the files 
section here . There is one further variation - if you have Logger set to use leading 
zeros,, then one or two leading 0.wav files are voiced before the number, as 
appropriate. We do not recommend using leading zeros with Advanced Voicing. As you 
can imagine, "zero eleven" is probably not an improvement in intelligibility over "eleven" 
or "zero one one."  

A good way to get natural-sounding numbers is to record full compound numbers, like 
"one hundred ten" or "two thousand four hundred and thirteen" with a program like 
Audacity (see below), and then use it to cut up the recording into the various 
components you need. This will help you get a natural intonation pattern, making your 
voiced numbers easier to understand. For example, numbers like "thirteen" are 
generally only at the end of compound numbers, and will typically be voiced naturally 
with a falling intonation.  

5.4. Recording Letters and Numbers 

This is the hardest part of voicing. A more natural-sounding output will be much easier 
for other stations to understand, a particularly important point with serial numbers. The 
question of how to reduce the robotic sound is a complicated one, as users of the phone 
companies' 411 service will appreciate.  

The program-induced lag between numbers is very brief, so the real tricks are:  

 trimming the individual voice files so that they have as little "dead air" as possible 
before and after the letter or number.  

 adjusting the speed, intonation and audio level of the individual number files so 
that they go together as naturally as possible.  

The best single tool we have found so far for this purpose is the freeware Audacity  
audio editor. It incorporates a variety of excellent tools for trimming, equalizing levels, 
and so on. A lot will always depend on how much time the individual op is willing to 
devote.  

http://n1mm.hamdocs.com/tiki-download_file.php?fileId=1428
http://audacity.sourceforge.net/


When recording with Audacity, be sure to "Export as .WAV" using the default file 
creation settings; these work fine with N1MM Logger, while some of its other .wav file 
options will not.  

Here's a tip some people have found to be helpful. This may or may not work for you.  

 Do not record individual letters and numbers. Instead, record callsign-like strings, 
such as A1BCD, E2FGH and so on. Try to speak at the same speed you would 
during a contest. Then use Audacity (or whatever editor you favor) to cut the 
recording apart, trim off any dead time, and equalize the levels. You can even 
use the Change Tempo tool (under Effects) to speed up your recorded letters 
and numbers to sound more natural while retaining your voice's pitch and other 
characteristics - amazing!  

5.5. Should I Use Voicing? 

This remains controversial. Is the saving in energy during a contest worth the potential 
loss in intelligibility? You can potentially operate an entire contest using "search and 
pounce", without ever having to say a word yourself. On one hand, when you are 
running, voicing the other station's call-sign is pretty safe, since he knows who he is, 
and needs only to be confident that you're calling him. On the other hand, some 
operators feel that the loss of the "human touch" may deter casual contesters from 
calling in.  

From an intelligibility standpoint, voicing serial numbers is less attractive. In poor 
conditions, the "robotic" quality may make copy harder, particularly for non-English-
speakers. The jury is still out on this one as well.  

 

2.4.2 Macros 

 2.4.2 Macros  

 1. General Macros  

 1.1. {END} Macro Examples  

 2. CATHEX and CATASC Radio Hex Macro Commands  
 3. CATAHEX, CATIHEX, CATAASC, and CATIASC Macro 

Commands  
 4. Antenna and Rotor Control Macro Commands  
 5. CW Macros  

 5.1. CW Macro Examples  

 6. SSB Macros  

 6.1. SSB Macro Examples  

 7. SO2V/SO2R Macros  
 8. Multi-User Macros  

 8.1. {MESSAGE} Macro Examples  



 9. Digital (RTTY and PSK) Macros  

 9.1. RTTY and PSK Macro Examples  

 10. Packet/Telnet Macros  

One of the great strengths of N1MM Logger+ is its ability to send stored messages 
during contest QSOs, and to embed macros in those messages. Macros are so called 
because they either expand to a given text string, for CW and digital modes, or execute 
some program function. An example of the first is the {EXCH} macro, which expands to 
the exchange which you entered in the Contest Setup Dialog's Sent Exchange field - for 
example, if you enter John CT, that is what will be sent whenever the {EXCH} macro is 
encountered.  
The second (program control) type of macro is much more complex and more powerful. 
These macros can switch the program from RUN mode to S&P mode, an essential 
attribute during NA Sprint; set or clear your transceiver's RIT function; or a myriad of 
other possibilities. In the sections that follow, you will find a comprehensive list of all the 
macros available in N1MM Logger+, as well as useful examples of how stored 
messages can be structured for efficient operating.  

1. General Macros 

 
General macros can be used in all the places mentioned above.  
Note that the table below is sortable alphabetically by the name of the macro, by 
clicking on the up/down arrow icon just to the left of the "Result" heading.  

Macro keyword  Result 

*  Call from the Station info dialog, same as {MYCALL} 

!  

Sends the callsign entered in the Callsign field of the Entry 
window, or if that field is empty the last call logged. Use this 
macro rather than {CALL} if you wish to have the Send 
Corrected Call function work correctly. 

@  

To voice the current receive frequency, if you have recorded 
files for individual letters and numbers. The frequency will be 
voiced to the nearest 100 Hz, dropping .0 if receiving on an 
even KHz frequency. This capability can be used to avoid 
having to rerecord CQ messages on 40m split. Here is an 
example: {operator}\CQ 
Listening.wav,@,{operator}\AndThisFreq.wav 

{CALL}  

Sends the call in the Callsign field of the Entry window as it 
was at the time the message started, or (if that field is empty) 
the last call logged. Note: This will send the call as it was when 
the message STARTED. Use the ! macro instead to use the 
Send Corrected Call function. Do not use the {CALL} macro in 
F5 (HisCall key) if you use ESM; instead, use the ! macro in 
F5. This is critically important if you ever hit [ENTER} in 
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Macro keyword  Result 

ESM before you have finished typing the call-sign, 
because if you do, the characters entered after you hit 
[ENTER} will not be sent unless you use !. 

{CHNAME}  

If a Call history file is loaded into the current database, and a 
callsign is entered for which a name is present in the file, then 
this macro will send that name. Call History lookup does not 
have to be enabled for this macro to function. 

{CLUSTER}  Cluster callsign from Station info dialog. See examples 

{COMMENT}  
Macro to add string following {COMMENT} to comment field of 
current or last QSO 

{END}  

This macro stores all macro text after the {END} macro string 
and executes it after CW, SSB or DIGI messages are sent. 
One use of the {END} macro is to send CAT commands to the 
radio(s) after a transmission ends. All QSO message text 
placed after the {END} macro command is not sent. 

#  
Send serial number for this QSO, or if there is no call sign in 
the Entry window, the serial number for the previous QSO 

{EXCH}  

Sent Exchange, based on the contents of the Sent Exchange 
box in the Contest Setup dialog. When the sent exchange 
includes a serial number (001 or # in the Sent Exchange box), 
the number sent will be for the current QSO if there is a call 
sign in the entry window, or for the previous QSO if there is no 
call sign in the entry window. 

{FORCELOG}  
Same effect as Ctrl+Alt+Enter, but does not ask for a note to 
be entered 

{FORCELOGNOTE}  As above but asks whether you want to enter a note. 

{FREQ}  Frequency from the contact in the Entry window 

{GRID}  Gridsquare from Station info dialog 

{GRIDSQUARE}  Gridsquare from grid textbox (contact in Entry window) 

{GRIDBEARING}  
Bearing between own gridsquare and grid textbox (contact in 
Entry window) 

{REVGRIDBEARING}  
Reverse bearing between own gridsquare and grid textbox 
(contact in Entry window) 

{KMGRIGDISTANCE}  
Distance in kilometer between own gridsquare and grid textbox 
(contact in Entry window) 

{LOG}  

CW:Logs the current contact. Same as ENTER in the Entry 
Window. Digital: Put the {LOG} macro after the {RX} macro... 
The receive frequency is being reset to the transmit frequency. 
Note: does not work in phone (SSB, FM etc) 



Macro keyword  Result 

{LASTCALL}  Call of last station logged 

{LASTEXCH}  
Exchange of last station logged. For ROPOCO and LZOPEN 
only. It does NOT work for other contests! 

{MYCALL}  My Call from Station info dialog, same as * 

{NAME}  
Sends the name as entered in the Entry window name field 
(Example: TARA) or when no Entry window name field, 
searches the name in the call history table 

{NAMEANDSPACE}  

Sends the name as entered in the Entry window name field 
(Example: TARA) or when no Entry window name field, 
searches the name in the call history table and adds a space 
behind it 

{OTHERFREQ}  
Is replaced by the frequency of the non-active radio. Used for 
passing stations to other bands. Substitutes "R" for decimal on 
CW 

{OTRSP XXXX}  
Used to send a command to an OTRSP (Open Two-Radio 
Switching Protocol) device. XXXX can be any command known 
to the OTRSP device 

{PGDN}  
Change frequency up equal to amount set under 'PgUp/PgDn 
Incr (kHz)' 'in the Configurer under the 'Other tab'. Can be used 
after the {END} macro, as in NA Sprint function-key messages 

{PGUP}  

Change frequency down equal to amount set under 
'PgUp/PgDn Incr (kHz)' 'in the Configurer under the 'Other tab'. 
Can be used after the {END} macro, as in NA Sprint function-
key messages 

{PREVNR}  Sends the QSO # of the last logged QSO 

{LRMHZ}  
Frequency Left Radio/VFO-A in MHz. Example: 28 when on 
28.1234 MHz 

{RRMHZ}  
Frequency Right Radio/VFO-B in MHz. Example: 14 when on 
14.1235 MHz 

{RUN}  Switches into Running mode 

{S&P}  Switches into S&P mode 

{STEREOOFF}  The stereo bit on the LPT port will be set to OFF 

{STEREOON}  The stereo bit on the LPT port will be set to ON 

{TIMESTAMP}  Date and Time from the contact in the Entry window 

{TX}  

CW/SSB: when sent in a function key will key ptt. Use Esc to 
turn off. This is a manual PTT from the keyboard. RTTY: Check 
out the Digital macros below. Note: This does not appear to 
work with some radio/interface combinations. 



Macro keyword  Result 

{CLEARRIT}  

Reset the RIT to zero. Could be used in the macro that 
confirms the contact, usually F3. Use the RIT when the station 
is calling and when logged the RIT clears (using F3). Note: Will 
only work for radios that support that function. Most ICOM 
radios do not. Your manual will tell you for sure 

{CTRL-A}...{CTRL-Z}  
Sends Ctrl+A character to TNC. All characters from the 
alphabet can be used (A to Z). Not valid in MMTTY and PSK. 
See examples 

{ENTER}  Sends ENTER to TNC 

{ENTERLF}  
Sends Return/Line Feed to the TNC. Try this if {ENTER} 
doesn't seem to work 

{ESC}  
Sends Escape character to TNC. Not valid in MMTTY and 
PSK. See examples 

{DATE}  Short date in Windows format as set in Regional settings 

{DATE1}  
Date in Nordlink-TF/WA8DED format (dd.mm.yy)- format: 
26.02.99 

{SENTRST}  Sends the RST sent as entered in Entry window Snt field 

{SENTRSTCUT}  
Sends the RST sent with the number 9 sent as the character 
N. Will send 57N or 5NN etc 

{TIME}  Time in Windows format as set in Regional settings 

{TIME1}  
Time in Nordlink-TF/WA8DED format (hh:mm:ss)- format: 
20:36:55 

{TIME2}  
Short GMT time (hhmm)- format: 2036 Information how this 
macro works in digital contests can be found at: Time2 - How it 
works 

{DAYTIME}  Date in TAPR DayTime format - format: 0107162036 

{DATEGMT}  Date and GMT time - format: 16-jul-01 18:36:55 

{TIMEGMT}  GMT time - format: 18:36:55 

{F1} - {F12}  Sends text assigned to function keys F1 through F12 

{SOCALLSTACK}  

This macro enables single operator callsign stacking. When in 
RUN mode, this macro gives the operator the ability to stack 
and retrieve a single callsign when multiple stations are calling. 
The stacked callsign does not need to be a full call and it can 
contain a "?". Single operator call stacking can be used in 
SO1V/2V or SO2R mode, in both entry windows, and 
with/without ESM. When in RUN mode, {SOCALLSTACK} will 
move a call or partial call and place it in the callsign frame and 
bandmap. If a stacked call exists on the call frame, the 

http://n1mmplus.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#Digital%20contests%20-%20RTTY/PSK31
http://n1mmplus.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#Digital%20contests%20-%20RTTY/PSK31


Macro keyword  Result 

callsigns will be exchanged. If the callsign contains a question 
mark ("?"), the cursor will highlight the question mark when the 
text is popped off the stack. If the callsign does not contain a 
question mark, the cursor is placed at the beginning of the 
callsign upon return to the entry window. Using the existing 
command ALT+D, it is possible to delete a stacked call from 
the bandmap and call frame without popping it off the stack 
with when the callsign entry window is blank. 
{SOCALLSTACK} will also pop the call off the stack if ESM 
replaced the stacked call with the string CQ-Frequency. When 
this occurs, the stacked call will be visible in the bandmap. 
{SOCALLSTACK} is not intended to be used with the MM call 
stacking function. See also the macro {STACKANOTHER}. 
Callsigns stacked by {SOCALLSTACK} can be popped off the 
stack by pressing the space bar when the CQ-Literal is on the 
call frame. More info and examples in the chapter: Single 
Operator Call Stacking 

{STACKANOTHER}  
Macro to stack additional callsigns in all modes. Also check the 
keycombination CTRL+ALT+G More info and examples in the 
chapter: Single Operator Call Stacking 

(CLRSTACK} Clears the call stack 

{LOGTHENPOP}  

RUN mode only. Intended for with the single operator call 
stacking feature. It logs the current station sending corrections 
if enabled, pops the next call off the stack, and updates ESM if 
enabled, to the correct step. The macro can be used with or 
without ESM. The suggested message is: {LOGTHENPOP} 
TU NW {F5}{F2} (Note: In contests with serial numbers, do 
NOT use # in the LOGTHENPOP macro). In CW, if 
{LOGTHENPOP} can not pop a call off the stack and the 
logged callsign was changed, send corrected call if enabled 
and the TU message. More info and examples in the chapter: 
Single Operator Call Stacking. Example function key setup can 
be found in the Chapter Function Key Examples (CW: example 
3) 

{ROVERQTH}  
Sends the Rover QTH. Check out the chapter Setup QSO 
Parties for more information on Rover support 

{VARYMSG1} 
{VARYMSG2}  

These macros allow the user to control how often an alternate 
form of a function key message is sent instead of the primary 
form. Each can be used once in a given Function Key set. The 
form of the macro is {VARYMSGn&Primary 
Message&Alternate Message&How Often to Send 
Alternate&}. Substitute the form of the message you want to 

http://n1mmplus.hamdocs.com/tiki-index.php?page=Single+Operator+Call+Stacking
http://n1mmplus.hamdocs.com/tiki-index.php?page=Single+Operator+Call+Stacking
http://n1mmplus.hamdocs.com/tiki-index.php?page=Single+Operator+Call+Stacking
http://n1mmplus.hamdocs.com/tiki-index.php?page=Single+Operator+Call+Stacking
http://n1mmplus.hamdocs.com/tiki-index.php?page=Function+Key+Examples
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+QSO+Parties+-+CW+and+SSB
http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+QSO+Parties+-+CW+and+SSB


Macro keyword  Result 

send most often for Primary Message. Substitute the message 
you want to send at intervals for Alternate Message. Finally, 
specify how often you want to send the Alternate message in 
"How Often to Send Alternate". A "0" in the "How Often to Send 
Alternate" field sends the Primary Message every time. A "1" in 
the "How Often to Send Alternate" field sends the Alternate 
Message every time. Placing a number, N, greater than 1, in 
the "How Often to Send Alternate" field sends the Alternate 
Message every Nth time. Examples: in the CQ Key definition 
(RUN F1), {VARYMSG1 &CQ * *&CQ CQ * *&3&} will send a 
slightly longer CQ every 3rd time. In the TU Key definition 
(RUN F3), {VARYMSG2 &TU&TU *&4&} will send TU alone 
after a completed QSO, and send TU followed by your call only 
every 4th time. Any function key text before or after the 
{VARYMSGn} macro string is preserved. So, RTTY users may 
place the {TX} {RX} macros before and after the 
{VARYMSGn} macro string. The primary and alternate 
{VARYMSGn} fields may contain other macros but the two 
{VARYMSGn} macros may not be nested. 

 
The TNC Interface accepts all of the macros above.  

1.1. {END} Macro Examples 

 
The {END} macro signals the program that the remaining {} commands are to be 
executed when the program returns from sending the CW, SSB or DIGI messages. 
Here is an example:  

 Message: F1 {STEREOOFF}CQ TEST *{END}{STEREOON}  

 
Whenever the F1 key is pressed, the stereo bit on the LPT port will be set to OFF. CQ 
will be sent via the current mode, and after the message is complete, the stereo bit on 
the LPT port will be turned back on. Thus, one can listen to just the second radio while 
the CQ is being sent, then listen to both radios after it is finished.  

× 

 More to send after the {END} Macro? 

Only Macros that do not involve sending messages are executed when they are placed 
after the {END} macro. For example, if you put {MYCALL} or "5NN" after the {END} 
macro, they will be ignored. Why? Well the message is over, there is nothing more to 
send. Conversely, all macros that only trigger program functions (don't send messages) 
are executed before any messages are sent, unless they appear after an {END} macro. 



2. CATHEX and CATASC Radio Hex Macro Commands 

Macro keyword  Substituted by 

{CAT1HEX 
radio_hex_command(s)} 
 
{CAT2HEX 
radio_hex_command(s)}  

These macros can be used to send commands to radio 
# 1 or radio # 2 requiring hex data input. The macro 
name must be followed by the radio hex data and 
closing terminator }. An example is shown below. There 
must be two hex characters per byte including zero 
(zero is entered as 00). Spaces are allowed anywhere in 
the hex command string to make entry and verification 
easier. 
You can not place more than one CAT1HEX or 
CAT2HEX macro in a message but the message can 
contain one of each macro. The exception to this rule is 
when the {END} macro is used. More than one radio 
command can be sent to the radio by placing a \ 
character between the radio commands. Spaces are 
allowed around the \ character. Multiple radio 
commands are broken into separate radio commands 
and sent to the radio using internal command pacing. 
Depending on the computer speed and the number of 
commands in the string, the use of these macros may 
delay the operation of the program during sending of 
CW or other program operation. There are no 
precautions which prevent the use of these macros 
while the radio is transmitting. If the user wants to switch 
an antenna port safely, use the {ANTRX#TOGGLE} 
macros which contain a TX inhibit. 
An example of an Icom command is: {CAT1HEX 
FEFE66E01C0102FD \ FE FE 66 E0 1C 01 02 FD } 

{CAT1ASC 
radio_ASCII_command(s)} 
 
{CAT2ASC 
radio_ASCII_command(s)}  

These macros can be used to send commands to radio 
# 1 or radio # 2 requiring ASCII data input. The macro 
name must be followed by the radio ASCII data and 
closing terminator }. An example is shown below. All 
leading spaces before the radio command portion 
begins are removed and not sent to the radio. All other 
spaces in the command are sent to the radio. 
You can not place more than one CAT1ASC or 
CAT2ASC macro in a message but the message can 
contain one of each macro. The exception to this rule is 
when the {END} macro is used. More than one radio 
command can be sent to the radio by either placing a \ 
character between the radio commands or by 
concatenating them together. Spaces before or after the 
\ character are sent to the radio. Multiple radio 



Macro keyword  Substituted by 

commands using the \ separator are broken into 
individual radio commands and sent to the radio using 
internal command pacing.  
Non-ASCII characters may be included in the radio 
command string by delimiting the two character hex 
value with < >. The leading < and trailing > characters 
are not sent to the radio. Spaces are not allowed inside 
the < > characters. If the ASCII radio command contains 
characters that are macros (*, !, #), these characters 
must be sent using this hex notation (replace * with 
<2A>, ! with <21> , and # with <23>). 
Depending on the computer speed and the number of 
commands in the string, the use of these macros may 
delay the operation of the program during sending of 
CW or other program operation. There are no 
precautions which prevent the use of these macros 
while the radio is transmitting. If the user wants to switch 
an antenna port safely, use the {ANTRX#TOGGLE} 
macros which contain a TX inhibit. 
Examples of several forms of this command are: 
{CAT1ASC PB1;\PB2;} {CAT1ASC PB1;PB2;} 
{CAT1ASC P<42>1;PB2;} . You may place a space 
between the macro name and the radio CAT command 
to improve readability. All leading spaces after the 
CAT1ASC macro command name are removed. As an 
example of the use of hex notation, this command 
contains a macro character {CAT1ASC *UM0} and will 
not work correctly; the correct form using hex notation 
would be {CAT1ASC <2A>UM0} . If the radio command 
needed to be terminated with a CR (Orion), the 
command would be {CAT1ASC <2A>UM0<0D>} 

3. CATAHEX, CATIHEX, CATAASC, and CATIASC Macro Commands 

Macro keyword  Substituted by 

Active radio 
{CATA1HEX 
radio_hex_command(s)} 
 
{CATA2HEX 
radio_hex_command(s)} 
 
{CATA1ASC 
radio_ASCII_command(s)} 

These eight macros's provide flexibility to send ASCII or 
HEX commands to either radio in SO2R mode (or VFO 
in SO2V) mode based on Active or Inactive radio/VFO. 
 
Radio specific commands were added for those SO2R 
users that do not have identical radios. The new 
macros follow the same syntax as the CAT1HEX and 
CAT1ASC macros. 
 



Macro keyword  Substituted by 

 
{CATA2ASC 
radio_ASCII_command(s)} 
 
Inactive radio 
{CATI1HEX 
radio_hex_command(s)} 
 
{CATI2HEX 
radio_hex_command(s)} 
 
{CATI1ASC 
radio_ASCII_command(s)} 
 
{CATI2ASC 
radio_ASCII_command(s)}  

The F-key macro text passes through a routine that 
removes CAT macros for radio(s) that do not qualify 
based on Active/Inactive radio(s). This allows one F-key 
string to be used for multiple purposes. 
 
An example of a Pro3 macro string that switches 
DualWatch and the Rx antenna based on the radio 
activity is shown below. {catA1hex fefe6ee0 12 00 
00fd}{catI1hex fefe6ee0 12 00 01fd}{catA2hex fefe6ee0 
07 c0 fd}{catI2hex fefe6ee0 07 c1 fd} 

{CATDELAY}  

This macro suspends the entire program operation to 
allow CAT commands to be received and executed by 
the radio possibly before a transmission begins. The 
need for this macro is dependent on the computer 
speed, radio interface rate, and radio type. The form of 
the CATDELAY macro is {CATDELAY N} where "N" is 
a user programmable delay in 50ms increments. The 
value of N is internally limited to 20 which would be a 
delay of 1 second 

4. Antenna and Rotor Control Macro Commands 

Macro keyword  Substituted by 

{ANTRX1TOGGLE} 
 
{ANTRX2TOGGLE} 
 
{ANTRX3TOGGLE} 
 
{ANTRX4TOGGLE} 

These macros can be used to switch between antenna ports and 
toggle the receive antenna input on some radios when the 
program is not transmitting. Some radio models have multiple 
inputs but lack the CI-V command to control the port so the 
functionality of these macros is radio dependent. When the 
{ANTRX#TOGGLE} macro is executed, the numbered antenna 
port is selected. If the same antenna port macro executed again 
and the radio is equipped, the receive antenna will be toggled on 
and off with each macro execution. If the antenna port is switched 
to another port, the current setting of the RX antenna is stored 
and used when this antenna is selected again. If only one radio 
antenna port is used it is only necessary to assign that 
{ANTRX#TOGGLE} macro to a F-key to toggle the RX antenna 
on/off quickly. 



Macro keyword  Substituted by 

 
Supported radios: Yaesu FT950, FTDX9000, FT2000 Icom: 
IC746, IC746Pro, IC756, IC756Pro, IC756Pro2, IC756Pro3, 
IC775, IC7700, IC7800 and Elecraft K3, TenTec Orion, Kenwood 
TS2000, Kenwood TS-590S 

{TURNROTOR}  Turn the rotor to the direction based on the calculated direction 

{LONGPATH}  Turn the rotor to the calculated longpath direction 

{STOPROTOR}  
Stop turning the rotor. Note that per the manual some functions 
are not supported for all rotor brands 

5. CW Macros 

 
CW macros are only substituted when used in substitutions for CW buttons.  

CW Program Control and Prosign Macros 

Macro 
keyword  

Substituted by 

:: < ::  Increment CW speed with 2 wpm. See examples 

:: > ::  Decrement CW speed with 2 wpm. See examples 

:: ~::  Send half space character. See examples 

::[::  SK prosign      . . . _ . _  

:: ]  AS prosign      . _ . . .  

+  AR prosign      . _ . _ .  

= ::  BT prosign      _ . . . _  

* the ! Macro: To send the CW code for an exclamation point, substitute a caret ^ in the 
macro  

Special Character Macros 

Macro 
keyword  

Substituted by  
Macro 
keyword  

Substituted by 

^  . . _ _ .  É . . _ . .  

"  . _ . . _ .  Ü . . _ _  

'  . _ _ _ _ .  Ä . _ . _  

?  . . _ _ . .  Á . _ _ . _  



Macro 
keyword  

Substituted by  
Macro 
keyword  

Substituted by 

/  _ . . _ .  Ñ _ _ . _ _  

:  _ _ _ . . .  Ö _ _ _ .  

;  _ . _ . _ .  _ . _ _ . _  

(  _ . _ _ .  $ . . . _ . . _  

)  _ . _ _ . _  @ . _ _ . _ .  

,  _ _ . . _ _  . . _ . _ . _  

-  _ . . . . _  ! 
 

× 

 Improving CW Readability 

Some calls have letter combinations where it's hard for to copy correctly. E.g. 6Y2A is 
often copied as BY2A. To help make your call easier to copy, Go to Config > Change 
Packet/CW/SSB/Digital Message Buttons> Change CW Buttons, and try changing the 
default F1 and/or F4 message where * is used for your call. In this example, 6Y2A 
changes F4 from * to>6<~Y2A. 
Result: the 6 is sent 2 WPM slower compared to the rest of the call, and an additional 
half space is added between the 6 and Y. Try other combinations of <, >, or ~ to make 
your call easier to copy. 

5.1. CW Macro Examples 

 Sent the call entered in the callsign field  
o Macro: !  

 Send his call. The callsign entered in the callsign entry field will be 
sent by the program via the serial or parallel port  

 Sent CQ with your call sent as a macro substitution  
o Macro: cq~test~de~*  

 The time between the words is a half space (~).  
 The * will be replaced with the callsign from the Station dialog 

{MYCALL}  

 Send part of exchange faster (report sent 6 wpm faster)  
o Macro: <<<5nn>>>{EXCH}  

 The report 5nn is sent 6 wpm faster than the exchange (<<< >>>).  

6. SSB Macros 

 
SSB macros are only substituted when used in substitutions for SSB messages. SSB 
wav file names can be concatenated using a comma.  



SSB Macros 

Macro 
keyword 

Substituted by 

{OPERATOR}  

Used to specify different wav files for each operator, to prevent 
confusion caused by having recorded wav files in a different voice than 
the operator's voice using the microphone. 
See examples 

6.1. SSB Macro Examples 

 Send the call entered in the callsign field  
o Macro: !  

 Send his call. The callsign entered in the callsign entry field will be 
sent by the soundcard. The location of the letter and number files 
used to make up his call sign is set up in the Configurer under the 
Files tab. All of the WAV files for the letters/numbers etc. must be 
present in that folder. See here  

 Let each operator have his own WAV files  
o Wave file name, e.g.: {OPERATOR}\cq.wav  

 If you specify WAV files like: {OPERATOR}\cq.wav , then as you 
change operators in a multi-operator contest station, the WAV files 
will change as well. You will have to create a full set of wav files for 
each operator. Note that the WAV directory syntax indicates a 
subdirectory under the Wav sub-directory in the N1MM Logger+ 
user files directory. You can also fully qualify the file name, as in: 
"C:\Users\[yourWindowslogonusername]\Documents\N1MM 
Logger+\wav\{OPERATOR}\cq.wav"  

 The {OPERATOR} macro can be concatenated with other 
characters; for example, if you really wanted to, you could use: 
{OPERATOR}CQ.wav and keep separately-named files in the 
same directory:  

 N1MMCQ.wav  
 PA1MCQ.wav  

 Play exchange with operators voice: {OPERATOR}\5905.wav  
 {OPERATOR} is a string substitution that is only implemented for 

SSB messages  

 

7. SO2V/SO2R Macros 

 
SO2V/SO2R macros are only substituted when SO2V or SO2R is selected. The 
{CTRLFx} macros work only in SO2R mode, because their functionality is not useful in 
SO2V.  

http://n1mmplus.hamdocs.com/tiki-index.php?page=Before+the+Contest#How%20to%20Record%20WAV%20Files%20for%20the%20Function%20Keys%20Used%20in%20SSB%20Contests


Single Op 2 VFO and Single Op 2 Radio Macros 

Macro keyword Substituted by 

{ACTIVEAUDIOTOGGLE}  
Toggles the muting and unmuting of the AF gain on the 
active radio. This works only on radios that support this 
capability via the radio control port 

{INACTIVEAUDIOTOGGLE}  
Toggles the muting and unmuting of the AF gain on the 
inactive radio. This works only on radios that support 
this capability via the radio control port. 

{ACTIVEAUDIOON}  
Unmutes audio on the active radio; same limitation as 
above 

{ACTIVEAUDIOOFF} Mutes audio on the active radio 

{INACTIVEAUDIOON}  Unmutes audio on the inactive radio 

{INACTIVEAUDIOOFF} Mutes audio on the inactive radio 

{OTHERBAND}  
Sends the band of the other (inactive) VFO/radio (e.g. 
80) 

{OTHERMHZ}  
Sends the frequency of the other (inactive) VFO/radio in 
MHz (e.g. 3.5 and 3R5 in CW) 

{OTHERFREQCUT}  
CW only. Sends last digits of the frequency of the other 
(inactive) VFO/radio as cut numbers. Uses the cut 
number style selected in Configurer 

{JUMPRX}  
Change the RX focus to the other input window. If only 
one input window is shown the second window will be 
opened 

{WIPE}  
Wipe the focus window. If the entry boxes are all empty, 
restores the last wiped contact ("unwipe") 

{ADVSO2RON}  Turn 'Advanced SO2R' on. See Chapter 'SO2R' 

{ADVSO2ROFF}  Turn 'Advanced SO2R' off. See Chapter 'SO2R' 

{CTRLFX}  

SO2R only. Works with RTTY and CW. Sends on the 
other radio. Thus a CW Button might look like: "tu 
EXCH{CTRLF9}" where F9 on the other radio is set to 
send a CQ. It is important to note that via hotkey 
Ctrl+Shift+L will turn this feature on or off. When off the 
CTRLFn macro is ignored. Entry focus moves to the 
other radio only when the callsign field on the current 
radio is empty. 

{CONDJUMP}  

When RX and TX focus are split between two radios, 
and the user hits the Enter key, TX focus is first moved 
to the radio with RX focus. The CW message is sent. 
After the CW message has been completed, TX and RX 



Macro keyword Substituted by 

focus are both moved to the other radio. When RX and 
TX focus are not split between radios, and the user hits 
the Enter key, the CW message is sent. When the CW 
message has been completed, TX and RX focus remain 
unchanged. 
Typical usage in Sprint is: Run F3: TU {END} 
{CONDJUMP} 

{QSYCQ}  
Allows QSYing to the last CQ frequency on the focus 
radio 

{STOPTX)  
In specialized SO2R scenarios, forces PTT to be 
released. Rarely needed, and not for SO1R use. 

8. Multi-User Macros 

 
Multi-User macros are only substituted when in Multi-User mode.  

Macro 
keyword 

Substituted by 

{MESSAGE} 
Send a message (via function key) to other connected stations over the 
network. See examples 

{PASS 0} 
... 

{PASS 15} 

Pass frequency from station 0 (Master station) through station 15. The 
Pass frequency is rounded to the nearest kHz 

{PASS 1800} 
... 

{PASS 
28000} 

Insert pass frequency for first connected station found on that band. 
Valid values are PASS 1800, 3500, 7000, 14000, 21000 and 28000 

{PASSMSG 
0} 
... 

{PASSMSG 
15} 

Pass last QSO information from station 0 (Master station) through 
station 15 

8.1. {MESSAGE} Macro Examples 

 
The {MESSAGE} macro sends a message (via a function key) to other connected 
stations over the network. The info will be shown in big red letters in the Info window 
from the receiving station(s). Place a number directly after the {MESSAGE} macro if you 
want to send the message to one specific station. If you don't want to send to a specific 



station, but want to start your message with a number put "- " in front of the message. 
Because "*" is used by macro substitution to indicate a callsign, you cannot put a * a the 
beginning of a message to indicate that the message should be sent to all stations. 
Since sending to all stations is the default behavior, this is not a problem. Just don't start 
the message with a number if you want to send the message to all stations.  

{MESSAGE} Macro Examples 

Button 
text 

Macro 

F8 Pass 
station 

{MESSAGE}2 {TIMEGMT} {PASS 1} {CALL} {GRIDSQUARE} 
{GRIDBEARING}deg. {KMGRIDDISTANCE} km. 
Message sent to station 2 with info about the station in the callsign field. 
This is a macro which could be used in VHFREG1 where a station is sent 
from one band to another 

F8 Pass 
station 

{MESSAGE} {TIMEGMT} {PASS 1} {CALL} {GRIDSQUARE} 
{GRIDBEARING}deg. {KMGRIDDISTANCE} km. 
Message sent to all connected stations with info about the station in the 
callsign field 

F8 OK {MESSAGE}2 OK. Send OK to station 2 

9. Digital (RTTY and PSK) Macros 

 
The following substitutions will be made when sending function key.  
In the Digital interface the macros below can be used but also all other macros shown 
under general macros.  

Macro keyword Substituted by 

{TX} 
Start transmission in the digital interfaces (needed to transmit!) 
Needed at thebeginning of every Digital macro! 

{RX} 
Switch to receive in the digital interfaces (needed to get back to 
receive). Needed at the end of every Digital macro! 

{CLRRX} 
Clear the RX window. This macro can be used either alone or after 
an {END} macro. 

{CLRTX} Clear the TX window. 

{SCQ} Placed at end of TU macro, resume CQ 

{GRAB} Grab first callsign from grab callsign window 

{DELALL} Delete all entries from grab callsign window 

{DELTOP} Delete Top Entry from grab callsign window 

{DELSEL} Delete highlighted entry from grab callsign window 



Macro keyword Substituted by 

_ (Underscore) MMTTY only. Send an idle tone 

^ 
Send the ! character (! sends the other station's call; use ^ to put a 
! character in a message) 

{FILE:xxxx} 

Send a textfile. xxxxx is replaced by the name of the text file and 
the text file needs to be in the N1MM Logger+ user files directory. 
The macro works any place in a macro string. If the text file only 
contains one line it does not add CR to end of line. When the text 
file contains multiple lines the CR from the last line will be removed 
so the following text will be on the same line. Multiple {FILE:xxxx} 
macros are allowed in one macro string 

{LDIGFQ} Left Digital Interface Frequency 

{RDIGFQ} Right Digital Interface Frequency 

{PREVTIME} 
Send previously sent time (for ANARTS and BARTG and similar 
contests) 

{ALIGN} 
Move signal into bandpass range. Does the same as Align Buttons 
on Digital Interfaces and the PSK Engine 

{PROFILE0} 
MMTTY only. Reset to HAM default definitions for RTTY mark, 
space, width 

{PROFILE1} 
... 

{PROFILE8} 

MMTTY only. {PROFILE1} through {PROFILE8} in the function 
keys at the start of a CQ or S&P macro will change MMTTY's 
profile. This way it is possible to have one profile for CQing and 
another one for S&P or however you want to set them up 

{HXXXX} 

HAL DXP38 only. The DXP-38 commands are in the form of Hex 
that look like $80 $EA. This macro substitution takes the text string 
in the form of {HXXXX} or {H80EA} and converts this to the 
appropriate command that should be sent to the TU. See the 
RTTY chapter for more HAL DXP38 info 

{DI1}...{DI24} 
Send text assigned to the digital macro keys DI-1 to DI-24 on the 
Digital Interface 

{LOGTHENGRAB} 

Run Mode only. Log the current contact and grab the top callsign 
from the Grab window of the DI. If the grab window is empty, logs 
the current contact and then switches to the TU key message 
instead of continuing with the rest of the message containing 
{LOGTHENGRAB} 

{DIGQTCR} WAE contest only. Open Digital QTC Receive window 

{DIGQTCS} WAE contest only. Open Digital QTC Send window 

{ALT-T} Same as keyboard ALT+T - Toggle TX/RX state 

{ALT-Q} Same as keyboard ALT+Q - Return to CQ frequency 



Macro keyword Substituted by 

{ENABLEAFC} Turn AFC on 

{DISABLEAFC} Turn AFC off 

{ENABLENET} Turn NET on (not applicable in FSK) 

{DISABLENET} Turn NET off 

× 

 Always use {TX} and {RX} together 

Use {TX} and {RX} together in your macros. Otherwise, {TX} alone in a macro will cause 
the radio to remain in transmit until you press an RX button or the ESC key 

× 

 TNC - Clear Buffer After Abort 

It is best to add the command that your TNC uses to clear the transmit buffer to the end 
of your Abort Macro. If not, the transmit buffer still holds the remaining characters that 
were left in the sent string and will get sent the next time the TNC sends. 

9.1. RTTY and PSK Macro Examples 

Example Function Key Macros 

Function Macro 

Log the contact, grab a call from the Grab box and give 
an exchange to the next station. 
If the Grab box is empty, this macro will log the contact 
and just send the TU message instead.  

{TX}{ENTER} ! 
{LOGTHENGRAB} TU NW 
{F5}{F2}{RX} 

Log the contact, pull the next callsign from the call stack 
and send the exchange to him (see Single Operator Call 
Stacking). 
If you want to stack another station that has called you, 
just Alt-Click on the call in the RX window and it will be 
placed on the call stack where you can get it with this 
macro.  

{TX}{ENTER} ! 
{LOGTHENPOP} TU NW 
{F5}{F2}{RX} 

Example Macros for the PK-232 (Digital Interface window)  

Button text Macro 

Abort {CTRL-C}R{ENTER}TC{ENTER} 

TX X{ENTER} 

http://n1mmplus.hamdocs.com/tiki-index.php?page=Single+Operator+Call+Stacking
http://n1mmplus.hamdocs.com/tiki-index.php?page=Single+Operator+Call+Stacking


Button text Macro 

RX {CTRL-D} 

Band Up RB U{ENTER} 

RxReverse RXREV T{ENTER} 

Example Function Key Macros for the PK-232 (Entry window) 

Mode Button text Macro 

Running  F1 CQ 
X{ENTER}CQ CQ CQ TEST DE {MYCALL} {MYCALL} K 
CQ{CTRL-D} 

Running  F2 Exch X{ENTER} ! UR 599 {EXCH} 599 {EXCH} BK{CTRL-D} 

Running  F3 Tnx/Qrz X{ENTER} ! TU GL DE {MYCALL} QRZ{CTRL-D} 

S&P  
F1 

{MYCALL} 
X{ENTER}! DE {MYCALL} {MYCALL}{CTRL-D} 

S&P  F2 Exch 
X{ENTER}! UR 599 {EXCH} 599 {EXCH} GL DE 
{MYCALL}{CTRL-D} 

Example Macros for the KAM  

Button text Macro 

Abort {CTRL-C}R RTTY {ENTER} 

TX {CTRL-C}T 

RX {CTRL-C}E 

Example Macros for the SCS PTC (Digital Interface window)  

Button text Macro 

Abort {ESC}CLR{ENTER}{CTRL-D}{ENTER} 

TX/RX {CTRL-Y} 

RX-Reverse {ESC}TR 1{ENTER} 

RX-Norm {ESC}TR 0{ENTER} 

45 Baud {ESC}BAU 45{ENTER} 

75 Baud {ESC}BAU 75{ENTER} 

Command mode {ESC}Q{ENTER} 

- - - - - - 



Button text Macro 

RTTY {ESC}Q{ENTER}BAU{ENTER} 

PSK31 {ESC}Q{ENTER}PSKT{ENTER} 

CW {ESC}Q{ENTER}CWT{ENTER} 

AMTOR {ESC}Q{ENTER}AMTOR{ENTER} 

PACTOR {ESC}Q{ENTER}PT{ENTER} 

PACKET {ESC}Q{ENTER}PACKET{ENTER} 

Example Function Key Macros for the SCS PTC (Entry window)  

Mode Button text Macro 

Running  F1 CQ {CTRL-Y}CQ TEST DE * * * k{ENTER}{CTRL-Y} 

Running  F2 Exch {CTRL-Y}! HI 599 {EXCH} {EXCH} K{CTRL-Y} 

Running  F3 CFM {CTRL-Y}! QSL TU DE * QRZ? K{CTRL-Y} 

S&P  F1 {MYCALL} {CTRL-Y}! DE * * K{CTRL-Y} 

S&P  F2 Exch {CTRL-Y}DE * TU 599 {EXCH} {EXCH} GL DE *{CTRL-Y} 

Example Function Key Macros for MMTTY (Entry window) 

Mode Button text Macro 

Running  F1 CQ 
{TX} CQ CQ CQ TEST DE {MYCALL} {MYCALL} K CQ 
{RX} 

Running  F2 Exch {TX} ! UR 599 {EXCH} 599 {EXCH} BK{RX} 

Running  F3 Tnx/Qrz {TX} ! TU GL DE {MYCALL} QRZ {RX} 

S&P  
F1 

{MYCALL} 
{TX} ! DE {MYCALL} {MYCALL}{RX} 

S&P  F2 Exch {TX} ! UR 599 {EXCH} 599 {EXCH} GL DE {MYCALL}{RX} 

Send CQ 
on new 
line  

F1 CQ {TX}{ENTERLF} CQ DE {MYCALL}{RX} 

10. Packet/Telnet Macros 

 
Packet/Telnet macros are only substituted when used in the packet/telnet buttons.  

Macros for use in packet/telnet buttons 



Macro keyword Substituted by 

{WAIT} Wait 5 seconds (fixed value) 

 
Macros for use in 'Comment For All Spots' (in Telnet/Packet window).  

Macros for use in 'Comment For All Spots' (in Telnet/Packet window) 

Macro keyword Substituted by 

{GRIDSQUARE} Gridsquare from grid textbox in Entry window 

{MODE} Mode used during contact in Entry window 

{QTH} QTH from section/qth textbox in Entry window 

{ZONE} Zone for state/province/section/oblast/other textbix in Entry window 

 

 

2.4.3 ESM - Enter Sends Message 

 

 2.4.3 ESM - Enter Sends Message  

o 1. ESM Overview  
o 2. ESM on Phone - One Special Feature  

1. ESM Overview 

 
This section provides a step-by-step introduction to ESM. Try it, and we can almost 
guarantee you'll like it.  

The first step is to turn it on. Open the Config menu in the Entry Window, and select 
ESM  



 
 
 
 
Now close the menu and enter any call in the entry window. We're assuming that you 
are doing S&P.  

 
 
 
 
What's different? Take a look at the F4 button. The highlight means that if you press 
<Enter> at this point, the F4 message will be sent (which is what you want - your call). 
Press <Enter>, your call is sent, but the cursor remains in the callsign field, and F4 is 



still highlighted. If he doesn't answer the first time, just press <Enter> again. If he 
answers you, hit <Space>, and the cursor will move to the Exchange box. You are not 
ready to send your exchange to him yet, because you have not yet copied his 
exchange, so now F8 (Agn?) is highlighted. Type in the exchange you receive from him, 
and look!  

 
 
 
 
Now F2 is highlighted. That means that the next time you hit <Enter>, the program 
sends F2 and logs the QSO.  

So instead of an 8 step process to work an S&P QSO, you have either 3 or 4:  

1. Enter the callsign  
2. Press <Enter>  
3. (optional) If he doesn't answer, press <Enter> when it's time to call him again; if 

he does, press <Space> and copy his exchange  
4. Press <Enter> again to send your exchange to him and log the QSO.  

× 

 What is this "Big Gun" switch? 

What's described above is the default behavior in S&P ESM, which assumes you won't 
get answers every time (or even most times) you call somebody. If you're louder than 
that, you may want to change the behavior. Go to the Configurer (the first option on the 
Config menu), click it, choose the Function Key tab, and look for the option "ESM sends 
your call once, then ready to copy S&P exchange." Check that, and the behavior 
changes. Enter now sends your call once, and the cursor then moves to the Exchange 
textbox. At the same time, the Function Key highlight moves to F8 Agn. Type in his 
exchange, and the highlight moves to F2 Exchange. Press Enter, and your exchange is 
sent to him. If you already have a valid exchange in the Exchange textbox, whether you 
type it or it is pre-filled, the highlight will move directly to F2 instead of going to F8. Once 
F2 is sent, the QSO is logged, and the highlight moves back to F4, ready to call the next 
station. 



× 

 Big Gun Tip 

One little trick to use with the Big Gun switch on is to program your call in F8 instead of 
"again". This way, when you don't get the guy on the first call, hit Enter again to 
repeatedly send your call until he answers (and the cursor is always in the right place 
when he does answer). 73 de Ted W4NZ 

 
But suppose you're Running (Calling CQ)? The first thing to do is tell the program. You 
do that by checking the box next to the word "Run", either with your mouse or by hitting 
<Alt>+U. Now your Entry Window looks a bit different:  

 
 
 
 
Note the highlight is now on F1, because the first thing in most Run QSOs is a CQ. 
Press <Enter> and the program will send F1.  

Now someone answers. Type in his callsign and the window changes.  

 
 
 
 
You're starting to get the hang of this - the highlights mean that when you hit <Enter> 



the program will send F5 followed by F2 (on CW - on phone you would speak the 
callsign and then press <Enter> to send your exchange).  

Once you have done that, the window changes again.  

 
 
 
 
Now the highlights tell you that you have copied a legitimate exchange (in this case the 
program has supplied it from the callsign), and that the next <Enter> will send your F3 
message and log the QSO.  

So, type a callsign, hit <Enter> 3 times, and you've logged a QSO. Pretty slick!  

Now suppose you're like me and you fat-finger copying the exchange, so that you have 
nonsense in the Exchange box, like this. In that case, the program reminds you:  

 
 
 
 
If you hit <Enter> with an incorrect exchange, the program will send the F8 message 
and request a repeat. Alternatively, if you see your mistake and correct it, the screen 
changes again to show the "F3 and Log It" highlights. Just press <Enter>, the program 
sends the F3 message, logs the QSO, and you're done.  

Once you've used ESM, I predict you'll never go back to the old way again.  



× 

 F1 Call CQ - A special Function Key that switches to Run Mode automatically 

The developers have reserved F1 as the "Call CQ" key. Pressing it while in Search and 
Pounce mode will switch you to Run mode. Although we do not recommend changing it, 
there are at least two ways to redefine F1: modify the ESM function key assignment 
table (see below) or use the {S&P} macro at the end of your F1 definition to force the 
program back to S&P mode. 

 
 
 
Two further refinements, and then this chapter is done. Open the Config menu again, 
and then open the "Configure Ports, Telnet Address, Other" sub-menu. Click on the 
Function Keys tab:  

In the left-hand column, note that I have checked "Send Corrected Call." This neat 
feature, in Run mode, keeps track of whether you have changed the callsign in the 
callsign box. For example, say you only copied "DL6A" at first, and filled in the rest later. 
Eventually, you copy DL6ABC, and when you press <Enter> to send the F3 (TU 
message), on CW the program sends "DL6ABC TU ..." On phone, you'll need to supply 
the correction.  



In the right-hand column, the third checkbox is cumbersomely titled "ESM only sends 
your call once in S&P, then ready to copy received exchange." In shorthand, we call this 
the "Big Gun switch." If you nearly always get stations you call the first time, you can 
save a keystroke by having the cursor advance automatically to the exchange box after 
the first time you call. If you often need to call again, don't check it. If you have checked 
it, and need to call a station more than once, you just press F4, regardless of where the 
cursor is.  

× 

 ESM cursor behavior and the Digital Interface window 

Because of the ability to transfer data from the DI window to the Entry window with a 
mouse-click, the behavior of the cursor moving between the boxes in the Entry window 
is slightly different when the DI window is open than when it is closed. If you are using 
ESM in CW or SSB with the DI window open and the cursor does not move between the 
call sign and exchange boxes when you expect it to, try closing the DI window. 

× 

 Caution 

Don't change the "key mappings" (below the red type on the Function Key tab of the 
Configurer) unless you absolutely know what you're doing - it can make a horrible hash 
out of ESM. 

 
The chart below outlines the possible combinations of information in the Entry window, 
and what will be sent in each situation.  
Note: ESM is affected by two options in the Configurer under the Function Keys tab:  

 the "ESM sends your call once in S&P, then ready to copy received exchange" 
check box (sometimes called the "Big Gun" option)  

 the "Work dupes when running" check box (recommended)  

ESM Mode Enter Key Actions 

Callsign field 
Exchange 
field 

In Run Enter 
sends 

In S&P Enter 
sends 

Empty Empty CQ (F1) My Call (F4) 

New Call (1st time) 
Empty or 
invalid 

His Call + Exch(F5 
+ F2) 

My Call (F4) 

New Call (repeat) 
Empty or 
invalid 

Again? (F8) My Call (F4) 

New Call (repeat) - ESM sends 
call once... checked 

Empty or 
invalid 

Again? (F8) Again? (F8) 

http://n1mmplus.hamdocs.com/F4


Callsign field 
Exchange 
field 

In Run Enter 
sends 

In S&P Enter 
sends 

New Call (before sending 
exchange) 

Valid 
His Call + Exch(F5 
+ F2) 

Exchange + 
Log(F2 + Log It) 

New Call (after sending 
exchange) 

Valid 
End QSO + 
Log(F3 + Log It) 

Log(Log It) 

Duplicate Call 
Empty or 
invalid 

QSO B4 (F6) do nothing 

Duplicate Call (before sending 
exchange) 

Valid 
His Call + Exch(F5 
+ F2) 

Exchange + 
Log(F2 + Log It) 

Duplicate Call (after sending 
exchange) 

Valid 
End QSO + 
Log(F3 + Log It) 

Log(Log It) 

Dupe (1st time) - Work Dupes 
checked 

Empty or 
invalid 

His Call + Exch(F5 
+ F2) 

do nothing 

Dupe (repeat) - Work Dupes 
checked 

Empty or 
invalid 

Again? (F8) do nothing 

Dupe (before sending exchange) 
- Work Dupes checked 

Valid 
His Call + Exch 
(F5 + F2) 

Exchange + 
Log(F2 + Log It) 

Dupe (after sending exchange) - 
Work Dupes checked 

Valid 
End QSO + Log 
(F3 + Log It) 

Log(Log It) 

2. ESM on Phone - One Special Feature 

old-edit  

There's every reason, when running CW or RTTY, to use stored messages for almost 
every transmission. Phone is different - you may not want to have the computer talk for 
you all the time.  

 Most operators choose to say callsigns and serial numbers themselves, rather 
than having the computer assemble them from individual letters and numbers. 
See the next section for more discussion of these issues, and for information on 
how to set up your Function Key definitions, whether you choose to let the 
computer do it all or not.  

 In some contests like CQWW, the exchange is so short that it may be more 
hassle than it is worth to have the computer voice your CQ zone.  

 
Or... you may forget, particularly when you are running tired, and say the other station's 
call and your exchange before you realize you've done so.  

To deal with this, N1MM Logger incorporates some additional flexibility. Here's how it 
works, courtesy of the inventor, N2IC:  



You are in Run mode. A station answers. You type in the callsign, and you use your live 
voice to send the callsign and exchange. Now, the station you are  
working is about to send his/her exchange. If, at this point, you hit the Enter key, your 
exchange wav file would be sent. That is bad - you already used your live voice to send 
the exchange. Instead of hitting the Enter key, hit the Space bar. Now, type in the other 
station's exchange. Hit the Enter key, and the "Thanks" message will be sent, and the 
QSO will be logged.  

In summary, the decision of whether to use the Enter key or the Space bar at that step 
in the logging process depends on whether you use your live voice to send your 
exchange, or a wav file.  

Here's an illustrated version of how it works:  

You're running, and W8QZR calls you. You type his call into the callsign field.  

 
Then, for whatever reason, you say his call and the exchange instead of having the 
computer do it. If you then hit Enter, the program will, as it says, transmit his call and the 
stored exchange message. Not what you want.  

Instead, you hit the Space bar.  

 

Perfect! Now the cursor is in the Exchange field. There is nothing in the exchange field 
yet, so F8 (Agn?) is highlighted. Type in his exchange.  



 

The highlight moves to the TU and "Log It" buttons, just where they should be. Hit Enter, 
and the computer will log the QSO, send your "TU QRZ" message and be all ready for 
the next QSO.  

 

2.4.4 Function Key Examples 

old-edit  

XXX Needs new screen shots displaying function key message sets in the message 
editing window XXX  

 2.4.4 Function Key Examples  

 1. SSB  

 1.1. WPX SSB example  

 2. CW  

 2.1. CW program default  
 2.2. Sprint CW examples  

 2.2.1. Example 1  
 2.2.2. Example 2  
 2.2.3. Example 3  
 2.2.4. Example 4  

 3. RTTY  

 3.1. General RTTY example  
 3.2. Example RTTY where the time is part of the exchange 

(like ANARTS).  

× 

 Note 1 

There may not be any 'holes' in the function keys lines with skipped function keys. ALL 
preceding Function keys must at least have a line in the table. Example: You'd like to 



have a different S&P F3 key than the Run F3 key. First you have to add the 12 Run 
lines in the table, after that the S&P lines for F1 + F2 +F3 which you liked to change for 
S&P. So at least 15 lines in total have to be in the function key table (12 run + 3 S&P). 

× 

 Note 2 

The text F1 (etc.) in the left column is only text and has no intelligence/meaning for the 
program. You could remove it and change it to any text you like, which will show on the 
Function key in the Entry window. The order of lines determines what the key will do. 
Examples: line 5 is Run F5 , line 11 is Run F11, line 17 is S&P F5 (17-12=5) etc. 

× 

 Note 3 

When you load a function key definition file into the current database, that table of 
definitions, including any changes that you make during the current session, is saved in 
the database. That means that if you restart the program and, for instance, start a new 
contest log, you will discover that the program still uses the function key definitions set 
for the previous contest. Each N1MM Logger database has single, separate tables for 
CW, SSB and RTTY function key definitions. Once these have been created or loaded 
from a file (File > Import > Import function keys from file), they remain until replaced. 
The correct way to manage this is to specify a file for each relevant mode (on the 
Associated Files tab of the Contest Setup dialog) when you set up a new contest, so 
that the right function key definitions will be loaded. If you don't specify a file, or clear 
the Associated Files notation, the most recent set of definitions stored in the database 
will come up each time you open or reopen the log.  

1. SSB 

old-edit  

This is the default SSB Function Key Definition Table, as it appears in the database 
when the program is first installed.  

XXX Obsolete screen shot from earlier versions of N1MM Logger Classic XXX  



 

If an external DVK is configured, place the dummy filename empty.wav in each of the 
first n slots in the function key definition table, where n is the number of message 
memories supported by the DVK. This will cause the MK2R or LPT controlled DVK to be 
triggered when F1-Fn are pressed. Note that the program PTT will not be toggled when 
the external DVK message starts.  

1.1. WPX SSB example 

old-edit  

Here is an excerpt from my macro list that I used in WPX SSB with ESM. Note again 
that the first 12 lines are for Run mode, and the last 12 for S&P. I was voicing both 
serial numbers and the other station's callsign. Note also that I used a brief pause.wav 
file (finite length but no sound) to get a pause between his call and the serial number.  

This is tricky because it requires mixing macros and WAV filenames. Pay close 
attention to the details - there are no doubt other syntaxes that work, but I know this 
does, with no spaces, commas or other punctuation in the right column. When playing 
more than one wav file, separate the files with a comma as shown in the F3 message 
below.  

Button Caption WAV File  

F1 CQ {OPERATOR}\cq.wav  

F2 Exch {OPERATOR}\exchange.wav  

F3 TU {OPERATOR}\tnx.wav,{OPERATOR}\mycall.wav  



F4 {MYCALL} {OPERATOR}\mycall.wav  

F5 His Call {OPERATOR}\pause.wav  

F6 Rpt Exch {OPERATOR}\number.wav  

F7 
 

F8 
 

F9 
 

F10 
 

F11 
 

F12 
 

F1 
 

F2 Exch {OPERATOR}\exchangeSP.wav  

F3 TU 
 

F4{MYCALL} 
 

F5 His Call 
 

F6 Rpt Exch 
 

F7 
 

F8 
 

F9 
 

F10 
 

F11 
 

F12 
 

2. CW 

old-edit  

2.1. CW program default 

old-edit  

Below are the default function keys as set up in the program. The F3 to F12 keys under 
S&P are not filled in. If you press these keys in S&P mode, the Run mode S&P 
messages will be sent.  

Button caption CW message  

F1 CQ cq~test~de~*  

F2 {Exch} <<<5nn >>>{EXCH}  

F3 TU TU de *  

F4 {MYCALL} *  

F5 His Call !  



F6 QSO B4 QSO B4 de *  

F7 ? ?  

F8 Agn Agn  

F9 
 

F10 
 

F11 
 

F12 
 

F1 {MYCALL} *  

F2 5NN {EXCH} <<<<5nn>>>>{EXCH}  

F3 
 

F4 
 

F5 
 

F6 
 

F7 
 

F8 
 

F9 
 

F10 
 

F11 
 

F12 
 

 
 
 
 
 
 

2.2. Sprint CW examples 

old-edit  

Whether you operate the NA Sprint or not, these examples will illustrate the use of 
various macros in combination with text in function key definitions.  

2.2.1. Example 1  
old-edit  

This Function key set is based on a set posted by Kenny, K2KW  

Button caption CW message  

F1 CQ * * <<<NA>>>  

F2 Exch * {EXCH}  



F3 TU EE{S&P}  

F4 {MYCALL} *  

F5 His Call !  

F6 QSO B4 B4 E E  

F7 ? ?  

F8 Agn AGN  

F9 
 

F10 
 

F11 
 

F12 
 

F1 CQ **<<<NA>>>  

F2 Exch ! {EXCH} *  

F3 TU EE{RUN}  

F4{MYCALL} *  

F5 His Call !  

F6 QSO B4 B4 E E  

F7 ? ?  

F8 Agn AGN  

F9 
 

F10 
 

F11 
 

F12 
 

 
Running Message Notes  

 For F2, there is a space before the *; E.G. "<space> * {EXCH}"  
 For F3, "EE" is there to confirm the QSO. You could easily use "TU".  
 After the "EE" is sent on the F3 message, the {S&P} macro puts you into the S&P 

mode. Then just hit your UP/DOWN arrow to QSY.  
 Personally I have F6 programmed as {EXCH} to send a repeat on the exchange  

 
S&P Message Notes  

 Note the difference in the sequence for the F2 message compared to the 
Running F2 message  

 For the F3 message, the {RUN} macro puts you in the running mode, ready to 
work a tail ender and send him the correct QSO sequence  

 Personally I have F6 programmed as {EXCH} to send a repeat on the exchange  



2.2.2. Example 2  
old-edit  

This function key set is based on one posted by Pete, N4ZR and modified by Rich, 
VE3KI.  

Button caption CW message  

F1CQ * * NA{CLEARRIT}  

F2 Exch * {EXCH} 
 

F3 TU E~E {CLEARRIT}  

F4 {MYCALL} *  

F5 His Call !  

F6 QSO B4 B4 *  

F7 Rpt Exch {EXCH}  

F8 ? ?  

F9 
 

F10 
 

F11 
 

F12 
 

F1 CQ * * NA{CLEARRIT}  

F2 Exch ! {EXCH} * {RUN}  

F3 NR #  

F4 {MYCALL} *  

F5 His Call !  

F6 Name PETE  

F7 State WV  

F8 ? ?  

F9 
 

F10 
 

F11 
 

F12 
 

 
Note two things about this set:  

1. The {RUN} macro is in S&P F2, not F3. This worked great for me - when I pressed 
Enter to send the S&P exchange, the exchange was sent, the QSO was logged, and the 
mode changed to {RUN} with the cursor in the call sign box. Therefore I did not have to 
press F3 to get from S&P to Run. The main problem with this is that if anyone asks for a 
repeat of the serial number, the Run keys are already active, so you have to either 



remember how to get the serial number from the S&P set (Shift+F3), or else just use the 
paddle, which is what I did.  

2. There is no {S&P} macro in this set. At the end of a Run QSO, you switch to S&P 
mode by just QSYing. This also worked OK for me; since you are going to have to QSY 
anyway, there seems to be no real need to force a change to S&P mode. I also had the 
"QSYing wipes the call & spots QSO in bandmap" option selected, which may have 
helped ensure that the cursor was in the right place after QSYing by wiping the entry 
window. Of course I did not actually have the band map open, and I just ignored any call 
signs that showed up in the frame in the entry window.  

It would be a nice touch if the final Enter in Run mode would not only log the QSO, send 
the acknowledgment (E E or R) and switch to S&P, but also QSY the radio by 1.5 kHz; 
but as far as I am aware there is no {QSY:+1.5} macro to do this. I think you have to 
either turn the radio dial or press the up/down arrow or PgUp/PgDn key (depending on 
what increments you have these keys set for). I just turned the dial. Next time, if I 
remember, I will set PgUp and PgDn to 1.5 kHz and try to use them more.  

73, Rich VE3KI  

2.2.3. Example 3  
old-edit  

This function key set is an example how to use the Single Operator Call Stacking 
macros in CW. Posted by John, K3CT.  

Button Caption CW Message (sic)  

F9 Stack {SOCALLSTACK}  

F10 Log Pop {LOGTHENPOP} TU NW {F5}{F2}  

F11 
 

F12 Wipe {WIPE} 

 
DX4Win uses F12 for Wipe so I use the same key for casual operating and contesting.  
Colored stickers with a message on the key tops helps me find the important keys.  

2.2.4. Example 4  
old-edit  

Customizing N1MM Logger for the North American CW Sprint by Steve, N2IC  

I'm not going to try to explain how to operate the Sprint - for this, there is an excellent 
writeup at: http://www.kkn.net/~n2ic/sprint.html  
What I will do is describe how to get the most out of N1MM Logger in the Sprint. My 
operation is SO2R, and my configuration is optimized for that mode. However,I'm sure 
you SO1R guys will pick up a few tricks from what I have done for SO2R.The most 
important thing is to get your options, windows and function keys setup correctly before 
the Sprint starts.  

The Options...  



Start up N1MM Logger using version 12.1.0 or later, and create a new SPRINTCW 
contest.  

In the Config menu, select the following options:  

 Enter sends message (ESM)  
 QSYing wipes the call & spots QSO in bandmap  
 Do not automatically switch to run on CQ frequency  
 Show non-workable spots  
 SO2R->Toggle CTRLFx Macro  

 
Note: SO2R->Focus on Other Radio is NOT turned on  

The Windows...these are the only windows I have on my screen and all fit nicely on my 
small monitor  

 Entry Window (one for each radio)  
 Visible Dupesheet (one for each radio)  
 Info  
 Log  
 Score Summary  

 
XXX Screen shot using N1MM Logger Classic - a similar setup would work in Plus XXX  



 

 
 

 
The Visible Dupesheet is really nice once you get used to it. To see if a station is a 
dupe, you just scan the dupesheet with your eyes, rather than frantically type a call into 
the Entry Window. You can change the font size in the Visible Dupesheet by dragging it 
wider, so that there is white space past right-most column. Then right-click in the white 
space for a choice of a small font or a large font.  

Notice that I do NOT have the "Available Mults & Q's" nor the Bandmap windows open.  

Now, I'm about to temporarily contradict myself. Open a Bandmap window. Right click 
and select "Packet Spot Timeout". Change the packet spot timeout to 1 minute. That's 
right....1 minute. Hit OK. Now close the Bandmap window. Don't reopen it. It is of no 
value in Sprint, but it is important to change the packet spot timeout value to 1 minute. 
(Side note: This option should really be called "Bandmap Timeout" not "Packet Spot 
Timeout". It controls how long calls stay on the bandmap and the appearance of calls in 



the "on deck" frame of the Entry Window. We're obviously not using packet in the 
Sprint.)  

Function Keys ....  

Here are my function key definitions. I'll explain a few that aren't obvious.  

Button caption CW Message  

F1 CQ {JUMPRX}cq na cq na * na  

F2 Exch * # steve nm  

F3 TU {CLEARRIT}T{END}{CONDJUMP}{STOPTX}  

F4 (MYCALL} *  

F5 His Call !  

F6 QSO B4 ! QSO B4 * NA  

F7 Other Short {CTRLF10}  

F8 Other Long {CTRLF11}  

F9 Go S&&P {S&P}  

F10 CQ CQ NA * * NA {RUN}  

F11 Long CQ CQ NA CQ NA * * NA {RUN}  

F12  -  

F1 S&&P CQ {JUMPRX}CQ NA CQ NA * NA  

F2 S&&P Exch ! # STEVE NM *{RUN}  

F3 S&&P TU TU  

F4 S&&P{MYCALL} *  

F5 S&&P His Call !  

F6 S&&P Name -  

F7 S&&P Other Short {CTRLF10}  

F8 S&&P Other Long {CTRLF11}  

F9 Go Run {RUN}  

F10 CQ CQ NA * * NA {RUN}  

F11 Long CQ CQ NA CQ NA * * NA {RUN}  

F12 - 

 
 
With the CQ F3 key, my "thank you" message is sent. When you QSY, you will 
automatically be changed to the S&P mode. Do not include the {S&P} macro here -it will 
cause the last station worked to get "stuck" in the on-call fame of the Entry Window.  



With the S&P F2 key, as soon as I send my exchange, it immediate switches to Run 
mode.  
I can also force myself into Run and S&P modes with the F9 key.  

The F7 and F8 keys send CQ's on the "other" radio. This is very useful when the other 
station is sending his exchange, and you are going to lose the frequency (i.e. it will 
become "his" frequency). You can send a CQ on the other radio, while he is sending his 
exchange. Then, when he finishes sending his exchange and you need to send your 
"thank you" message to finish the QSO, all you have to do is hit Enter, which will stop 
the CQ on the other radio, and send your CQ F3 message on the active radio. However, 
you had better be ready to copy a new caller on the "other" radio. You also need to be 
sharp with the Pause key to jump between the two radios when this happens. The 
{CONDJUMP} macro in the Run F3 message will move your entry focus to the "other" 
radio, so that you will be ready to copy a new caller.  

When I'm CQing on the active radio, but simultaneously doing S&P on the other radio, 
and hear a new station, I can just hit the Enter key. This will stop the CQ, and send my 
call on the other radio.  

One thing you need to do is keep an eye on where your transmit and receive focus is 
(the red and green dots on the Entry Window). When you're doing SO2R in the Sprint, 
there will be times where your focus is not where you might expect it, or want it. Always 
be ready with the \ and Pause keys to jump between radios. Yes, this takes lots of 
practice, and you will make mistakes. The Thursday night NCCC Sprints are good 
practice for this.  

73 and see you in the Sprint !  
Steve, N2IC  

3. RTTY 

old-edit  

3.1. General RTTY example 

old-edit  

The way the keys below are designed, they will work in many RTTY contests without 
any changes. Whether these particular ones suit your situation will depend on your 
antennas, your power, QTH, etc.; but maybe these will give you some ideas to work 
with.  

Button Caption Message sent  

F1 CQ {TX} CQ TEST DE * * CQ {RX}  

F2 EXCH 599{EXCH} ! BK {RX}  

F3 TU {TX}{ENTERLF} ! TU DE * QRZ? {RX}  

F4 {MYCALL} {TX} DE * K {RX}  

F5 His Call{TX}{ENTERLF}  

F6 QSO B4 {TX} B4 DE * CQ {RX}  



F7 Rpt Exch {TX} {EXCH} {EXCH} {EXCH} {EXCH} K {RX}  

F8 {TX} AGN AGN DE * K {RX}  

F9 
 

F10 
 

F11 
 

F12 
 

F1 CQ {TX} CQ TEST DE * * CQ {RX}  

F2 EXCH {TX}{ENTERLF} DE * TU 599 {EXCH} {EXCH} BK {RX}  

F3 TU {TX} ! TU {RX}  

F4 Call Him {TX} DE * * * K {RX}  

F5 1x1 {TX} ! DE * K {RX}  

F6 0x1 {TX} DE * K {RX}  

F4 Call Him {TX} DE * * * K {RX}  

F5 1x1 {TX} ! DE * K {RX}  

F6 0x1 {TX} DE * K {RX}  

F7 Rpt Exch {TX} {EXCH} {EXCH} {EXCH} {EXCH} {EXCH} BK {RX}  

F8 Agn {TX} AGN AGN de * K {RX}  

F9 
 

F10 
 

F11 
 

F12 

 
 
When using the above keys it is assumed that ESM is on. The Run mode keys F5, F6 
and F7 are not very useful when you are S&Ping, this is why I put those keys to better 
use by programming them differently from the Run mode keys.  
Note also that you can use up to 24 additional buttons (mouse only, no keyboard 
access) on the digital interface window. For example, you can set up 0x1, 0x2, 0x3 and 
0x4 calls, single, double and triple exchanges, separate requests for his zone and state 
and repeats for your zone only and for your state only, and so on.  

73, Rich VE3KI  

3.2. Example RTTY where the time is part of the exchange (like ANARTS). 

old-edit  

In the following table only the keys that are different from the general example above 
are shown  

Button Caption Text sent  



RUN and S&P 
 

F2 Exch {TX}599 {TIME2} {TIME2} {EXCH} ! KN {RX}  

F7 Rpt Exch {TX} 599 {TIME2} {TIME2} {TIME2} {EXCH} {EXCH} K{RX} 

 
73, Rich VE3KI  
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 9.1. Exposing and Deleting Phantom Serial Ports  

o 10. Hooking up a Footswitch  

 10.1. Parallel port  
 10.2. Serial port footswitch information (using the 9 pin connector 

numbers)  

o 11. Avoiding RFI and Other Common Interfacing Maladies  

1. Ports Used for Interfacing 

The program can interface with your radio using several ports from the computer. These 
ports are:  

 Serial port - A serial port can send CW, control PTT or communicate with your 
radio; with some radios you may be able to do all three on one port. Hardware 
serial ports are rapidly disappearing from most computers, but if the computer 
has open PCI bus slots. inexpensive serial and serial/parallel port cards are 
available. Alternatively, USB-to-serial adapters may be used.  

 Parallel port - Parallel (LPT) port interfacing is quite flexible. In addition to 
controlling CW and PTT, N1MM Logger uses the LPT port to control popular 
SO2R control boxes, and to send band information to a band decoder for 
automatic antenna or bandpass filter switching. With one exception, USB-to-
parallel adapters will not work here. Note also that you will still need a separate 
virtual or hardware serial port for radio control, because radio control cannot be 
done from a parallel port.  

 USB port - Most computers now have multiple USB ports. USB-to-serial adapters 
can be used to provide full serial port capabilities, but be aware that not all such 
adapters (or their drivers) work well with N1MM Logger+. See USB Interface 
Devices for specifics. There are also many different interface devices available 
that use USB port control for a full gamut of capabilities. See the chapter 
Supported Hardware for more information.  

 Sound card - N1MM Logger+ can use your computer's sound card to record your 
contest QSOs, and also to send stored audio messages to your transmitter in 
response to function key presses. The sound card may be on the computer's 
motherboard, or a separate card internal to the computer, or an external sound 
card interfaced to the computer with a USB cable. For these purposes, it is best 
to find a computer or sound card that has separate microphone and line input 
jacks, as well as a line out jack. Some sound cards (particularly in laptops) now 
come with only two jacks, or even with only one "combo" jack, and the input jack 
may not be switchable between microphone and line levels. If this is the case, 
you will not be able to run your microphone through your sound card and record 
QSOs at the same time.  

2. Radio interfacing 

Radio manufacturers have supplied various means for interfacing radios with computers 
for radio control functions. All of these interfaces appear to the computer software like a 
standard RS-232 serial port, but the hardware actually used varies considerably. At a 

http://n1mmplus.hamdocs.com/tiki-index.php?page=USB+Interface+Devices
http://n1mmplus.hamdocs.com/tiki-index.php?page=USB+Interface+Devices
http://n1mmplus.hamdocs.com/tiki-index.php?page=Supported+Hardware


minimum, the features supported by radio control interfaces include reading and setting 
operating frequencies and modes. Most but not all radios that support radio control from 
a computer also supply commands for the computer to control TX/RX switching (PTT). 
Newer radios support control of a wide variety of other features, such as RIT/XIT 
control, switching of filters, and other functions.  

The earliest radio control interfaces generally used TTL voltage levels on the radio 
connector which were not compatible with RS-232 signal levels, and therefore required 
external radio control interface boxes to perform the level switching between TTL (0 and 
+5V) and RS-232 (-12V and +12V) logic levels. These interfaces use the RS-232 TxD 
and RxD signal lines for data communication, and some of them also require RTS/CTS 
handshaking, which can often be simulated by simply setting the RTS line always on. 
These external radio control interfaces require DC power, which can either be supplied 
separately, or in some cases from one of the RS-232 control lines (usually DTR or 
RTS), in which case the control line supplying the DC power must be configured to be 
always on. At the computer end or the hardware connection, if the computer does not 
have serial ports a USB-to-serial adapter can usually be substituted.  

Some newer radios have true RS-232 serial ports, in which case an external level 
switching interface is not needed, but otherwise these are configured similarly to the 
earlier TTL-level radio control ports. For the most part, these serial ports still only 
support radio control data over the RxD and TxD lines, possibly supplemented by 
RTS/CTS handshaking, but in at least one case (the Elecraft K3), the radio's RS-232 
port also supports direct keying of CW and PTT inputs using the DTR and RTS control 
lines. Again, either a true serial port or a USB-to-serial adapter can be used at the 
computer end of the connection.  

More recently, as serial ports on computers have become increasingly rare, some 
newer radios have incorporated a USB-to-serial adapter internally, so that the hardware 
connection to the radio is a simple USB cable. Nevertheless, the drivers for these USB 
ports still appear to the software to be standard RS-232 serial ports. In many cases, the 
same USB connection is also used to drive a CODEC ("sound card") internal to the 
radio, which eliminates the need for audio connections between the computer and the 
radio, but from the point of view of the software, that single USB connection appears to 
be two separate devices: an RS-232 serial port, and a standard computer sound card. 
These two devices must be configured separately, regardless of the fact that they share 
a single cable.  

3. Interfacing for PTT and CW Keying 

3.1. Choosing Your PTT Method 

N1MM Logger+ offers multiple methods for controlling PTT on your radio. Unless you 
use VOX, or QSK on CW, you will need to select one of these methods, and your 
choice may vary depending on the mode you want to operate, your radio's capabilities 
and how you choose to use them, any existing interfaces or other PTT wiring done for 
use with other programs, and so on.  

The available methods are:  



 Hardware PTT - uses serial (COM) or parallel (LPT) ports. Software controls the 
state of individual lines on the port for PTT and CW (and in the case of the LPT 
port, additional SO2R-related functions). This requires a driver (INPOUT32) - see 
Installing the Software for specifics. Works with USB-to-serial adapters, but will 
not work with USB-to-LPT adapters except for the Piexx SO2RXLAT .  

 Software PTT - uses PTT (TX/RX) commands sent to the radio through the radio 
control port. For certain radios that incorporate a radio CODEC (effectively, a 
sound card inside the radio), if you wish to use it either for AFSK (digital modes) 
or as a voice keyer for SSB, you will need to use Software PTT. Check the 
Supported Radios section for your radio setup instructions. Software PTT is great 
with some radios, such as the TS-590, but with others, which require a longer 
delay between CAT commands, it will be slower than hardware or Winkey PTT. 
In the case of Icom radios, when a data collision is detected, the PTT may fail to 
actuate or hang in transmit, requiring an ESC to return to receiving. Also, please 
note that N1MM Logger+ cannot control PTT for a built-in DVK, as compared to a 
CODEC, because if the recorded message is not sent from the computer, the 
program cannot know when the recorded message has finished. Such DVKs 
must use VOX, for this reason.  

 Winkeyer PTT - uses PTT provided by the Winkeyer USB series of CW keyers, 
but also works for SSB and digital modes. If a port is set up to control a 
Winkeyer, and PTT is set as the Pin 5 function on the Winkeyer tab in the 
Configurer, PTT is automatically active on the real-panel jacks of the Winkeyer, 
and it needs only to be cabled to the appropriate jack on your radio. Winkeyer 
PTT is the most flexible of the PTT options, particularly on CW, because you can 
set the inter-character "Hang Time" separately from the end-of-message Tail 
Time. The settings are on on the Winkeyer tab in the Configurer. If you chose to 
use one of the other methods for PTT control, simply omit this cable.  

 Digital Modes PTT - If using FSK, configure MMTTY to a COM port or 
EXTFSK/EXTFSK64 for FSK keying, and also configure it for PTT on the same 
port. To use a radio CODEC for AFSK in digital modes, PTT must be handled by 
N1MM Logger+ using Software PTT (see above). For AFSK not using a built-in 
radio CODEC, use the Logger's PTT options for other modes, or configure PTT 
in MMTTY. If you want to use the same COM port for PTT in digital and non-
digital modes, then you must check "Digital" on that port in the Hardware tab of 
the Configurer, and configure MMTTY for PTT. This tells the Logger to close the 
port and hand it over to MMTTY when you switch to a digital mode.  

 
For SSB or digital modes, use any of the options above. Remember, if you are using 
your radio's audio CODEC, you will need to use Software PTT and omit COM or LPT 
hardware PTT control.  

For CW, if you have a Winkeyer, Winkeyer PTT is recommended, because it gives you 
the most flexibility in setting hang and tail time. If you do not have one, but have a serial 
or USB port, Hardware PTT is probably the simplest. You can do this with a simple 
transistor switch off the appropriate line of a serial port or a USB-to-serial adapter. CW 
and PTT can be handled on a single port, and with some radios it may even be possible 

http://n1mmplus.hamdocs.com/tiki-index.php?page=Installing+the+Software
http://www.piexx.com/
http://n1mmplus.hamdocs.com/tiki-index.php?page=Supported+Radios
http://n1mmplus.hamdocs.com/tiki-index.php?page=Configurer#Configurer_gt_Winkeyer_Tab


to do radio control on that port as well if the radio does not need the RTS and DTR lines 
to be set in a particular way (since these lines are used for CW and PTT).  

3.2. Choosing Your CW Method 

N1MM Logger+ offers multiple methods for keying CW on your radio.  

The available methods are:  

 Hardware CW - uses serial (COM) or parallel (LPT) ports (usually separate from 
the radio control port). Software controls the state of individual lines on the port 
for PTT and CW (and in the case of the LPT port, additional SO2R-related 
functions). This requires a driver (INPOUT32) which is installed by the Full 
Installer. Works with USB-to-serial adapters, but will not work with USB-to-LPT 
adapters except for the Piexx SO2RXLAT .  

 Winkeyer CW - uses a K1EL Winkeyer or equivalent. This is the most-
recommended method, because it is virtually immune to timing problems that 
might be caused by unexpected events in the computer (such as a Windows 
Update, virus checker update, or other resource-intensive activity that might be 
taking place behind the scenes). CW timing with a Winkeyer is controlled 
externally to the computer. The Winkeyer can also be used with a paddle as a 
regular CW keyer, with the advantage (over a separate keyer or the built-in keyer 
in some radios) that paddle and computer keying are integrated, e.g. touching 
the paddle interrupts computer keying without any doubling up or garble, and 
paddle and computer speeds are the same).  

 
There are a few radios (Kenwood, Elecraft, recent Yaesu, Flex) that support sending 
CW via "KY" radio command messages. This method is not supported directly by the 
Logger, but you can program such radio command messages into function key 
messages using {CAT1ASC} macros. Apart from the fact that it only works with certain 
radios, there are several other limitations to this method:  

 You can only put one of these CAT1ASC macro commands in each function key 
message.  

 The number of characters that can be sent in such a message is limited (e.g. no 
more than 24 characters with Elecraft radios - other radios may have a different 
numerical limit). Note that this is the number of Morse code characters, including 
spaces, that the message is converted to, not a count of the number of 
characters in the N1MM Logger+ command. Therefore you need to design your 
messages so that they will take no more than 24 characters with the longest call 
sign and exchange you are likely to need during the contest.  

 Once the function key containing one of these messages has been pressed, you 
cannot rely on the Esc key to interrupt the message from N1MM Logger+. You 
can interrupt a message in progress either from the radio's front panel controls or 
by sending another function key message that has a CAT1ASC command to 
switch to RX immediately programmed into it.  

http://www.piexx.com/


 The CW speed using this method is controlled from the radio's CW Speed 
control, not from N1MM Logger+. The Logger's CW speed control macros and 
the PgUp/PgDn keys will not work with this method.  

 If you like to use auto CQ repeat in N1MM Logger+, the repeat interval is 
measured from the start of one message to the start of the next one, i.e. it 
includes the message as well as the time between messages. Therefore it has to 
be longer than the duration of your CQ message at the slowest CW speed you 
use. If you change CW speeds, a repeat interval that is appropriate for the 
slowest CW speed will likely be longer than you would like at higher speeds.  

 The "send corrected call sign" feature does not work with this method.  
 You cannot send ad lib Morse code this way, i.e. the Ctrl+K command to send 

keyboard CW does not work with this method.  

× 

 N1MM Logger+ Does Not Support CW Keying by Audio Tone 

Almost daily, we get queries about why the Logger's CW won't work with software or 
interface units that feed audio tones to a transceiver. Typically, this involves the 
Signalink USB interface or the software program FLDIGI.  
N1MM Logger+ does not and will not support this way of generating CW. There are a 
couple of reasons. First, on many transceivers, when they are in USB or LSB mode, you 
are precluded from using CW filters and other CW receiving aids. Second, sound-card 
CW is fraught with problems, including audio noise in your CW, RF interference to the 
CW tones, and the possibility of generating two or three separate CW signals due to 
audio harmonics. It's just a bad idea!  

The simple interfaces described below are easily constructed at minimal cost with 
readily available components. 

3.3. Parallel (LPT) Port for CW and PTT 

This is a typical simple interface that can be used for parallel port CW and PTT keying. 
Separate circuits (transistors) are used for CW and PTT.  

 
 

 
 
 



LPT 
pin  

Function 

1 Strobe 

16 PTT output 

17 CW output 

18 Ground 

× 

 Note 

For hints on diagnosing problems with a parallel port, see the note under Addtional 
Parallel Port Interfacing just a bit further on. 

3.4. Serial (COM) Port 

When a serial port is used for CW and/or PTT keying, it is the RTS and DTR lines that 
are used.  

DB9 
pin  

DB25 
pin  

Function 

7 4 PTT output (RTS) 

4 20 CW output (DTR) 

5 7 Ground 

× 

 Note 

The CW and PTT lines for a radio must be on the same serial/parallel port. Example: 
When COM4 is the CW Port and Radio 1 or Both is selected, PTT control for Radio 1 
must also be on COM4. USB-to-serial converters are supported, but USB-to-LPT 
(parallel) converters are not. 

3.5. Using a transistor 

The keying circuit for serial port CW or PTT keying is similar to the circuit used with a 
parallel port.  

 
 

 



 
 

 Equivalents for the 2N2222 are 2N3904, BC547 or BC548.  
 NB. It isn't a bad idea to add a 1 kOhm resistor from base to ground, also adding 

a shunt capacitor of 10 nF is highly recommended at the collector output to 
ground in order to prevent RF feedback to base and subsequent blocking.  

3.6. Using an opto-Isolator (opto-coupler) 

Some users prefer to use an opto-isolator rather than a transistor, in order to provide 
more protection for the serial port in the event of something going wrong downstream. 
In that case, however, two special considerations may apply:  

 You may need to place a diode in series with the input of the opto-isolator, to 
protect it from negative voltage swings on a standard serial port. Check the 
specifications of the opto-isolator you use to determine whether this is necessary.  

 Some opto-isolators may not pull their output "low" enough (close enough to zero 
volts) to switch PTT or CW on a given transceiver. In that case, appropriate "pull-
down" measures must be applied.  

4. Via USB port 

Not all computers have serial ports any more, or even if they do, there are not enough 
to control transceivers, packet, serial CW keying etc. In this case consider a USB-to-
serial port adapter. Most of them do nicely for basic radio control functions and/or for 
CW and PTT keying. These devices require drivers within the computer; make sure that 
drivers for your operating system are available before trying to use one of these 
adapters.  

The timing of serial port or parallel port keying can be subject to "stuttering" caused by 
the CPU being unavailable to control the port while it is busy with other tasks. For 
perfect CW not dependent on Windows processes the usual answer is to use a 
Winkeyer by K1EL. The computer communicates with the Winkeyer using normal ASCII 
characters via the serial port, which are buffered inside the Winkeyer and converted to 
CW there. The CW timing is thus independent of computer processing delays. A 
USB/serial adapter will work fine with a Winkeyer; in fact, most Winkeyers delivered 
today are WKUSB keyers with a USB-to-serial adapter built in to the keyer. Check the 
Winkeyer manual for more information.  

In some cases PTT and CW keying may unexpectedly stop working when using a USB-
to-serial converter, because Windows has shut down the USB port to save power. 
Check this Windows setting:  

 Control Panel; System Icon,  
 Hardware Device Manager Tab or button.  
 Expand USB Serial Bus Controllers  



 Highlight each USB Root Hub or Generic USB Hub in turn  
 Double click for Properties settings, Power Management tab  
 Remove the check mark from 'Allow the computer to turn off this device to save 

power'  
o The box is checked by default in most cases  

 Repeat for every USB Root Hub and Generic USB Hub  
 Reboot the computer  

 
A table giving evaluations by N1MM users of various USB-to-serial converters is in this 
section of the manual. Another overview of serial- to-USB converters can be found at 
the RTTY contesting page by AA5AU at: http://www.rttycontesting.com .  

5. Additional Parallel Port Interfacing 

If the type of CW port chosen is LPT1, LPT2 or LPT3, and a hardware LPT port is used, 
additional information will be present on the chosen parallel port. In the Configurer, 
select the radio that corresponds with the selected port (Radio 1 or Radio 2). The BCD 
data on the LPT is that of the current active radio/VFO. The band data is available on 
multiple LPT ports — Radio 1 on LPT1, Radio 2 on LPT2 and so on. USB-to-LPT 
converters are not supported.  

Parallel port pin layout  

LPT 
pin  

Description 

1  
Return for PTT and CW output. This pin has limited sink capability, so you may 
need to buffer it 

2  
Band output (Least Significant Bit) set by Antenna tab in Configurer. This pin is 
also used to stop the message sent on the hardware DVK. 

3  

NA-compatible TX focus. - Radio 1/2 Pin 3 will go to a logic LOW level (0V) when 
Radio 1 has TX focus and to a logic HIGH level (5V) when Radio 2 has TX focus. 
(NB. LPT pin 3 is the complement of Pin 14). Set ONLY if no hardware DVK 
output is selected (msg# 1). 

4  
NA-compatible RX focus. LPT Pin 4 will go to a logic LOW level when Radio 1 has 
RX focus and to a logic HIGH level when Radio 2 has RX focus. Set ONLY if no 
hardware DVK output is selected (msg# 2). 

5  
(Shift+singlequote) to toggle for Stereo mono. LPT Pin 5 will go to a logic LOW 
level for mono audio and to a logic HIGH level for stereo audio. Set ONLY if no 
hardware DVK output is selected (msg# 3). 

6  Set ONLY if no hardware DVK output is selected (msg# 4). 

7  Band output set by Antenna tab in Configurer 

8  Band output set by Antenna tab in Configurer 

http://n1mmplus.hamdocs.com/tiki-index.php?page=USB+Interface+Devices
http://n1mmplus.hamdocs.com/tiki-index.php?page=USB+Interface+Devices


LPT 
pin  

Description 

9  Band output (Most Significant Bit) set by Antenna tab in Configurer 

14  
Radio select A/B (transmit focus) for DX Doubler compatibility. LPT Pin 14 will go 
to a HIGH level when Radio 1 has TX focus and to a LOW level when Radio 2 has 
TX focus. (NB. LPT pin 14 is the complement of Pin 3) 

15  Footswitch input port 

16  PTT output, high = transmit mode 

17  CW output 

18-
25  

Return for Band output 

5.1. Diagnosing Parallel Port Problems 

× 

 Will all PCI-e Parallel Port Cards Work? 

As fast as technology moves, it is difficult to be categorical about this, and there has 
been some traffic on the reflector suggesting that some families of LPT port chips are 
not compatible with the software components used by N1MM Logger+ to control 
individual lines on an LPT port. Experimental results show, however, that two families of 
chips do work, as of February 2013: These chips are used both in single-port cards and 
in combination cards (2 serial and one parallel, for example), but have only been 
systematically tested in the one LPT port variant.  

 MOSChip Semiconductors series MCS9900. This company is now owned by 
Asix Electronics Corporation,. and the very latest driver can be downloaded here

. Specify PCIe Bridge for the product family. These chips are used in the SYBA 
SD-PEX10005 1 Port Parallel Card, available from the usual online sources.  

 Oxford Semiconductor OX16PC952-954. This company's chips are used in 
several 1-port LPT cards, including the StarTech.com PEX1P, which also is 
widely available. Originally, they were thought to be incompatible with parallel 
port switching, but this does not appear to be the case (contact N4ZR for details). 

× 

 Diagnosing LPT Port Issues 

Recently, a number of users have encountered difficulty using PCI-e LPT ports to 
control band decoders, SO2R controllers, and other devices. After a great deal of 
experimentation, here are a few things to try if you have trouble.  
 
1. Make sure you have the correct address specified in N1MM's Configurer. Typically, 
PCI-e add-in cards seem to have I/O addresses that are not the standard ones for a 

http://www.asix.com.tw/download.php?sub=downloadsearch&PSNoID=110
http://www.asix.com.tw/download.php?sub=downloadsearch&PSNoID=110


given port number. For example, built-in LPT1 ports typically have an address of 0378 
for our purposes, which is the lower of the two I/O addresses given for the port in 
Device Manager. On the other hand, 3 different PCI-e cards tested all have fixed I/O 
addresses at D000 and D010, regardless of the LPT port number, and the correct 
address is the higher one - D010. When in doubt, try them both.  

2. The first time you run N1MM Logger+ after a new installation, don't run it from a 
shortcut. Instead, go into the N1MM Logger+ program directory, right-click on the 
executable (.exe) file, and select "Run as Administrator". It has been suggested that this 
step may be necessary in some cases, in order for the component that drives the 
parallel port to be registered properly, and it can't hurt. This is a one-time only step.  

K8UT discovered a nifty parallel port test utility at here . The crucial thing it does is 
totell you-- if it cannot find a port at a given address. It's freeware, and can be used with 
a voltmeter or something controlled by the LPT port (like a band decoder), with N1MM 
Logger+ settings put aside for the moment it will quickly establish whether the port is 
working properly.  

5.2. External DVK Interfacing 

When you select DVK on a parallel port, antenna selection via that port is disabled, 
because the DVK pins and the antenna pins on the LPT port overlap. Following is the 
table of pin-outs for external DVK control:  
F1 pin 3  
F2 pin 4  
F3 pin 5  
F4 pin 6  
F5 pins 4 and 6  
F6 pins 4 and 5  
F7 pins 4, 5, and 6.  

When F1-F7 are pressed, a 100 ms. pulse is sent to the relevant pins for external DVK 
control.  

In order to record messages on an external DVK, you will need to connect your 
microphone to it directly, and follow the procedure outlined in the DVK manual; N1MM 
Logger+ support is limited to triggering the first 7 memories when the corresponding 
Function Key (F1-7) is pressed, and stopping stored message playback when the ESC 
key is pressed. Some external DVKs have as few as 4 memories, in which case only 
F1-F4 will trigger playback.  

6. Band decoder output 

Pins 9, 8, 7 and 2 can be set using the Antenna tab in the Configurer. The output on the 
pins will follow the selected code which is being set up by the selected antenna.  

 
 

http://www.xlentelectronics.nl/


 
 
 

6.1. Sample configs 

 
 

 
 
 
To replicate the default Top-Ten Devices behavior, you would need to set up the 
Antenna tab in Configurer as shown above to the left|  
It is possible to use more than one antenna per band with N1MM Logger+. With Alt+F9 
it is possible to toggle between these antennas. List the bands for each antenna with a 
comma separating them - e.g. 3.5,7  

6.2. Sample Config > Antenna for two stacked antennas 

 
 



 
 
 
You will need to make appropriate provision with a diode matrix on the output of your 
band decoder to select the appropriate antenna or antennas when a given code is sent 
from the program to the decoder. For example, if your band decoder outputs positive 
voltage and you use a tri-band beam with a single coax feedline, you will need diodes to 
sum the three signals from your band decoder into the one feedline.  

7. Bearing data 

Bearing data for rotator control is currently not available on the LPT port.  

8. Sound card interfacing 

Of course, you can always use one of the many commercial audio interfaces designed 
primarily for digital modes. However, if you have a sound card that permits feeding 
microphone input through it to the line output (most do), and has a mixer that will allow 



you to independently set the level of the microphone, .wav playback and internally-
generated audio (such as for AFSK), you really don't need an interface at all. On SSB, 
simply plug your microphone into the sound card mike input. Cable the sound card's 
Line Out to the Line In or Phone Patch input of your transceiver, and you're done.  

You may encounter hum, resulting from difference in AC potential between the chassis 
of your computer and that of your transceiver. In that case, a 600-ohm isolation 
transformer in the cable between sound card and transceiver is the cure. Another 
approach is to bond the transceiver and computer chassis together with a heavy wire. 
Many people do both.  

If you absolutely must feed the audio output of your sound card into the microphone 
jack of your transceiver, the level will be far too high. In that case, a simple 10:1 
resistive voltage divider is the solution, placed in the audio cable before the microphone 
jack.  

9. Serial and Parallel port interfacing under Windows 2000/XP/Vista/Windows 

7/Windows 8 

Windows 2000, XP, Vista and Windows 7 and 8 require a special dll which will be 
installed automatically by N1MM Logger+ to use the parallel ports.  

9.1. Exposing and Deleting Phantom Serial Ports 

Unlike N1MM Logger Classic, N1MM Logger+ can support serial ports numbers up to 
99. The following procedure is not likely to be necessary, but you may still wish to use it 
to eliminate "phantom" (not used, but unavailable) serial ports from your system,  

Here is how to have Device Manager expose and remove invisible serial port 
assignments:  

1. Click on the Start button and select All Programs > Accessories.  
2. In Windows XP, Click on Command Prompt; in Windows Vista, 7 or 8, Right-

click on Command Prompt and select the Run as administrator menu item.  
3. Type set devmgr_show_nonpresent_devices=1 and hit the Enter key.  
4. Start Device Manager. There are many different ways to do this; one is to right-

click on Computer (or My Computer), select Properties, and then click on 
Device Manager. Another is to find Device Manager in the Control Panel.  

5. In the Device Manager window, select the View > Show Hidden Devices menu 
item.  

6. Click on the + sign next to Ports to see the full list of COM ports that have been 
assigned in your computer.  

7. Highlight an unused port number you wish to remove from the list and then press 
the Delete key. Accept when asked to confirm and continue with any more port 
numbers that you wish to delete.  

 
Thanks to KK1L and N7WY for this tip.  

10. Hooking up a Footswitch 



 
A footswitch can be hooked up to a serial port or a parallel port. The footswitch program 
action is the same for both LPT and COM ports, i.e. footswitch closure causes the 
action selected in the Configurer for that port.  

10.1. Parallel port 

If pin 14 is not used to switch radios using an external SO2R box (for example, by using 
the Pause key), then hooking up a footswitch to LPT1 can be done by connecting a 10k 
resistor from pin 14 to pin 15. Pin 14 is normally +5V and provides pull-up voltage for 
pin 15.. Then connect a normally open footswitch between pin 15 and pin 18 of LPT1. 
Closing the footswitch pulls pin 15 low and performs the function selected in the 
configurer.  

If pin 14 is being used for Radio A/Radio B control of an external SO2R box, a 5V 
supply with a 10k series resistor can be used to provide the pull-up voltage for pin 15.  

10.2. Serial port footswitch information (using the 9 pin connector numbers) 

Connect a 10k resistor between pin 6 and pin 7. Set DTR, pin 4 to "Always On" and 
RTS, pin 7 to "Always Off". Connect the footswitch between pins 4 and pin 6.  
The program action will be on footswitch closure. The footswitch wires can not be 
referenced or connected to ground.  

11. Avoiding RFI and Other Common Interfacing Maladies 

More often than not, reports of quirky, intermittent issues with radio control, CW and 
PTT interfacing, as well as hum and distortion in sound card audio, wind up being 
traced back to RFI - your own signal turning up where it doesn't belong, or to improper 
grounding.  

While we can't afford the space to deal exhaustively with this topic, there are several 
good resources - the RFI reflector (RFI@contesting.com), this paper  by Chuck 
Counselman, W1HIS, and these papers  by Jim Brown, K9YC  

 

2.5.2 USB Interface Devices 

 2.5.2 USB Interface Devices  

 1. General Comments on USB to Serial I/O Interface Devices  
 2. Sound Interfacing and USB External Sound Cards  
 3. CW issues with USB Adapters  

With the disappearance of serial and parallel ports on most new PCs, most N1MM 
Logger+ users are now forced to use USB interface devices to accomplish functions 
formerly performed using serial and parallel ports. These include consumer-grade USB-
to-serial adapters as well as devices designed and manufactured specifically for 
amateur radio use. For the most part, with the help of software drivers installed when 
the device is first connected to the PC, these devices are configured in N1MM Logger+ 

http://www.yccc.org/Articles/W1HIS/CommonModeChokesW1HIS2006Apr06.pdf
http://audiosystemsgroup.com/RFI-Ham.pdf


as if they were true serial ports, with some important caveats and exceptions noted in 
the following sections.  

A separate category of USB devices is the "USB Sound Card", which are similar in 
function to on-board and bus-based sound cards except that its interface with the PC is 
through a USB port. Some devices aimed at the amateur community combine USB 
sound cards and USB-to-serial adapters in a single box. Some transceivers are now 
delivered with such USB devices incorporated internally. Generally speaking, once the 
appropriate drivers have been installed, these devices are configured in similar ways, 
regardless of whether they are in a transceiver or in a separate box or boxes.  

× 

 USB-to-parallel adapters generally will not work 

USB-to-parallel adapters will not work for keying CW or controlling PTT through the 
standard parallel port interface, because these adapters do not permit controlling 
individual lines.  
The only exception we are aware of is the SO2RXLAT by Piexx , which is designed 
specifically for this purpose. 

1. General Comments on USB to Serial I/O Interface Devices 

There are two different problems that are often encountered by N1MM Logger+ users 
trying to use USB-to-Serial adapters.  

The first of these problems relates to the specific chipsets and drivers used in these 
adapters. The market for these adapters is dominated by two chipsets, called Prolific 
and FTDI. There is a potential problem with adapters using the Prolific chipset for serial 
communications (in particular, for rig control) from N1MM Logger+. This problem only 
applies to actual serial communications; simple on-off keying of DTR and RTS for CW 
and PTT keying is not affected. There are several versions of the Prolific chipset 
(including counterfeit knock-offs), and also several versions of the drivers, and at least 
some of these drivers are incompatible with the Microsoft library routines used by 
N1MM Logger, DXLab Suite, Logger32 and some other amateur radio programs. The 
symptom is an error message with the error number 8020. The result is that with some 
combinations of Prolific chipset and/or driver software, adapters using the Prolific 
chipset may not work properly for rig control and similar purposes with N1MM Logger+. 
Rather than attempting to list all of the possible combinations of chipset version, driver 
version and operating system in order to determine which ones work and which ones do 
not, our simplest advice is to avoid using USB-to-serial adapters using the Prolific 
chipset for rig control, rotor control or similar serial communications purposes.  

The second problem relates to FSK RTTY keying from MMTTY. MMTTY can use a true 
serial port for FSK keying, by programming the port to send 5-bit characters at 45.45 
baud. Unfortunately, most single-port USB-to-serial adapters, or at least those that are 
new enough to work with Windows 7, cannot go slowly enough to do 45.45 baud 
Baudot. Some multi-port adapters (two or four serial ports from a single USB port, e.g. 
Edgeport) are capable of going slowly enough, but if there are currently-sold single-port 
adapters that can do direct FSK keying, they are few and far between.  

http://www.piexx.com/


The standard solution to this is to use EXTFSK (or EXTFSK64, on systems whose CPU 
is capable of supporting it). EXTFSK does all the timing internally instead of using the 
serial port hardware. EXTFSK is capable of keying FSK on any of the TxD, RTS or DTR 
lines on any serial port or any USB-to-serial adapter, and even on a true parallel port 
(but *not* on USB-to-parallel printer adapters, which are incapable of bit-twiddling). 
There is a downside to using EXTFSK - the timing is less accurate than the hardware 
timing from a true serial port. This may result in a slightly less readable signal under 
difficult conditions.  

We are not aware of any USB-to-serial adapters that will not do FSK with the help of 
EXTFSK or EXTFSK64, nor are we aware of any USB-to-serial adapters that will not 
key CW or PTT on their DTR/RTS lines other than adapters that don't have any physical 
connections for these control lines (such as the Elecraft KXUSB which does not 
implement the DTR and RTS control lines and therefore cannot use DTR or RTS).  

Drivers: One key thing to never do is to allow Windows to tell you that it already has the 
driver for a particular device - you should always install the driver that comes with your 
interface. Windows can misidentify these devices when you plug them in and Windows 
will let you fail by using the driver it thinks is correct - and often Windows is dead wrong.  

Generally speaking, with XP you can use most any USB to serial device (Prolific or 
FTDI chipsets) as long as you do not have a conflict. When it comes to Vista or 
Windows 7, FTDI seems to be the only game in town for close to sure results (Editor's 
note - not all users agree with this characterization.)  

Even with all of this, depending on what you have done with your computer previously, 
you may have problems. And again, the point of all of this is that the problems may 
have nothing to do with what hardware you are trying to use. It could be something left 
over by some earlier activity on your computer. That said, most installations of these 
devices goes well right from the start. When they do not, it can be very frustrating.  

A further technical note, posted on the N1MM Logger reflector by Joe, W4TV, concerns 
an easy way to tell whether a given adapter can handle 45.5 baud RTTY:  

Windows serial drivers set the data rate (baud rate divisor) with 14 bits of a "double 
word." That limits the max/min range of the driver/UART to 214:1 ... and any maximum 
rate higher than 512K will preclude operation at 45.45 bps.  

The lower rates are not a 100% guarantee of compatibility but the higher rate is a 
certain sign that EXTFSK or AFSK will be required for RTTY.  

2. Sound Interfacing and USB External Sound Cards 

If you want to record your contest QSOs, or use stored messages in phone contests, 
you will need to interface your computer to the audio system of your transceiver.  

This requires a little thinking ahead. If you wish both to record QSOs and to use stored 
messages, then you will need a sound device (be it internal or external) that has both 
Line and Microphone inputs, and that is capable of duplex operation - that is, it can both 
record and play back at the same time. This is not a rare capability, or something found 
only on expensive sound cards, but something to check in choosing which card to buy.  



A more common problem, these days, seems to be sound cards - particularly those 
integrated into laptop computers - that have only a single input that can be used for 
either Line or Microphone, but not both at the same time. In those cases your best bet 
may be to get an external USB sound card. Again, it is not necessary to go high-end for 
this application, so long as both criteria above are met.  

Two external USB cards that have been tested with N1MM Logger are the Encore, sold 
by NewEgg here  .for under US$20, and the GWC, also sold by NewEgg at this URL

 for about the same price.. The ByteRunner UA-580 also works fine. (Thanks, Joe 
W4TV for this info)  

3. CW issues with USB Adapters 

N1MM Logger+'s serial and parallel port CW options are a simple and easy way to 
generate CW, but if your computer is slow, you may find the CW is not always smooth, 
particularly when receiving spots from a Telnet cluster in a busy contest. If this happens 
with serial keying, try using a parallel port if you have one. If you don't, or if you want to 
put an end to CW issues once and for all, the answer is K1EL's Winkeyer USB, which 
handles CW and all-mode PTT by offloading these functions from the computer 
entirely. It is also an excellent stand-alone keyer with 4 built-in memories.  

Another issue can be poor weighting when using serial port keying. Some adapters 
have a lot of latency and will mangle your CW. Usually this can be corrected by finding 
a better driver for the adapter. Make sure you are running the latest vendor-provided 
driver for your operating system, not the one the OS picks. Some adapters allow you to 
set the latency in control panel. See this article .  

 

2.5.3 Supported Hardware 

in-edit  

 2.5.3 Supported Hardware  

 1. Windows and External USB Peripherals  
 2. Green Heron Engineering Inc. - GH Everyware (rotator control)  
 3. Ham Radio Solutions - EZmaster  
 4. K1EL - Winkeyer  
 5. microHAM - microKEYER  

 5.1. Tentec ORION + "Mute mic on supported radios"  
 5.2. ICOM CI-V Interfaces + Transceive on/off Features  
 5.3. N1MM Logger+ can't read the RX frequency (shows as 

0) - frequency shown fine in microHam router without the 
Logger  

 5.4. Truncation of Messages (When Using Winkeyer Keyer)  

 6. microHAM - MK2R/MK2R+  

 6.1. USB-only SO2R Support  
 6.2. Suggested Port Setup by Joe, W4TV  

http://www.newegg.com/Product/Product.aspx?Item=N82E16829180006
http://www.newegg.com/Product/Product.aspx?Item=N82E16829126101%20%28GWC%29
http://www.newegg.com/Product/Product.aspx?Item=N82E16829126101%20%28GWC%29
http://www.digi.com/support/kbase/kbaseresultdetl?id=3418


 6.3. On-the-Fly Recording from within N1MM Logger  

 7. RigExpert  
 8. Top Ten Devices - Automatic Band Decoder and DX Doubler  

 8.1. Hardware Update: 'Both Ears on the Inactive Radio' 
versus 'Both Ears on the Active (or Run) Radio' from the 
Keyboard  

 9. West Mountain Radio - RIGblaster  

 9.1. CW and Digital Setup RIGblaster Plus  
 9.2. SSB Setup RIGblaster Plus  
 9.3. RIGblaster Advantage  

 9.3.1. Setting Up N1MM Logger with the RIGblaster 
Advantage  

 10. Transverters  
 11. Unsupported Hardware  

 11.1. W5XD MultiKeyer  

 12. Other Hardware Information  

 12.1. USB Soundcards  
 12.2. Other Soundcards  
 12.3. External versus Internal Soundcards  

1. Windows and External USB Peripherals 

One word of caution about external (USB) sound cards ... and other USB peripherals.  

Windows can only address the "USB root hub" ... they are directly connected to the 
internal PCI bus. Windows will process data from all "Root Hubs" in a machine in 
parallel. However, all of the "child" devices are like leaves on a tree, each leaf which 
"grows" from the same "root" receives a time slot (generally 16 msec) in turn. If you 
have too many "leaves" on one root hub, the delay can become excessive and result in 
communications failures (time outs) with the controlling software (Logger).  

This can be particularly problematical with some software that polls every 50 to 100 
msec and will timeout if a response has not been received before the next poll interval. 
USB can easily handle the aggregate throughput (it will do something like 240 mb/sec) 
but the delays can be a problem if the software writer does not account for them.  

Be particularly aware of this issue if you use external hubs and add many devices - 
particularly devices like memory sticks and "thumb drives."  

73, Joe Subich, W4TV  

For much more information about specific USB to serial adapters and similar 
hardware, see USB Interface Devices.  

2. Green Heron Engineering Inc. - GH Everyware (rotator control) 

old-edit  

N1MM Logger can send bearing information direct to the Green Heron GH Everyware 
software. N1MM Logger must be configured to send rotor information over the network 

http://n1mmplus.hamdocs.com/tiki-index.php?page=USB+Interface+Devices


(using UDP packets). This can be done by editing the N1MM Logger.ini file. Information 
regarding this is given in the supplied documentation with the Green Heron software, 
which is bundled with Everyware Remote and Base hardware and not sold separately.  

Please refer to the Everyware documentation for further details.  

3. Ham Radio Solutions - EZmaster 

old-edit  

EZ Master is an LPT port and USB Device that interfaces your PC with several devices 
in your shack like radios, antennas, filters switching, microphone, headphones etc. 
Including PHONE, CW, RTTY, DIGITAL Mode interface and internal DVK, CW Keyer 
and SO2R switching.  

More information can be found on the Ham Radio Solutions website .  

4. K1EL - Winkeyer 

Winkeyer is an external keyer chip designed by K1EL and G3WGV, which combines full 
electronic keyer features with a serial interface to a computer. Winkeyer is intended to 
interface with compatible Windows software and produce CW from ASCII characters 
sent to it, avoiding CW timing problems caused by multitasking.  

N1MM Logger was one of the first Windows logging program to support Winkeyer, and 
it has become a favorite CW solution for N1MM Logger+ users. Serial or parallel port 
keying may work fine, particularly with faster computers, but using Winkeyer can enable 
you to get by with a slower machine or run other programs in conjunction with N1MM 
Logger+, while keeping your CW perfect. Stand-alone keyers are available, and the 
Winkeyer keyer chip is also used in multi-function interfaces such as Ham Radio 
Solutions EZMaster, RigExpert, and several microHAM interfaces.  

More information can be found on K1EL's website .  

A full explanation of setting up N1MM Logger+ to work with Winkeyer is found in the 
Configurer section of the N1MM Logger+ Manual.  

5. microHAM - microKEYER 

The authoritative source for information on configuring N1MM Logger to work with 
various microHAM products is the microHAM web site  which offers a variety of 
"Example Configurations". These configurations are also accessible through the Help 
menu of the microHAM Router software, under "Document Download."  

5.1. Tentec ORION + "Mute mic on supported radios" 

In the Configurer dialog, Other tab, make sure that "Mute mic on supported radios" is 
*NOT* checked. If that is checked, the Logger mutes the microphone and turns on the 
AUX input during DVK operation. By design the microKEYER routes DVK audio to the 
microphone input.  

5.2. ICOM CI-V Interfaces + Transceive on/off Features 

http://www.hamradiosolutions.com/
http://www.k1el.com/
http://n1mmplus.hamdocs.com/tiki-index.php?page=Configurer&structure=N1MM+Logger+Manual#Configurer_REAL_GT_Winkeyer_Tab
http://n1mmplus.hamdocs.com/tiki-index.php?page=Configurer&structure=N1MM+Logger+Manual#Configurer_REAL_GT_Winkeyer_Tab
http://www.microham-usa.com/support.html


How to connect microHAM devices to N1MM Logger+ together with, for example, a 
SteppIR antenna which needs Transceive ON to know the radio frequency while N1MM 
Logger+ likes to see Transceive OFF.  

 connect all of the CI-V devices in parallel (tip to tip, ground to ground)  
 turn off Transceive in the Icom rig  
 turn ON "polling" in microHAM Router  
 turn OFF "polling" in microHAM Band Decoder  

 
The microKEYER (Router) will poll only when the logging software is not polling (for 
example, Router will poll even though N1MM Logger+ does not). The Router polls will 
keep data flowing on the CI-V bus to allow the SteppIR and other similar hardware to 
stay "in sync."  

The microHAM Band Decoder will provide antenna switching (including support for 
multiple antennas per band with the appropriate external switch) according to your 
normal programming , provide drive for bandpass filters (several brands) and can do 
"format conversion" which will allow a Yaesu (Quadra, FL-7000) or Icom (IC-2KL, IC-
4KL, IC-PW1) solid state amplifier to work with any other (supported Yaesu, Kenwood, 
Icom, or TenTec) radio.  

The same capability exists with non-Icom radios.  

5.3. N1MM Logger+ can't read the RX frequency (shows as 0) - frequency shown fine in microHam router without the 

Logger 

N1MM Logger+ polls for slightly different data than Router (VFO A and VFO B vs. 
"Current operating frequency") so Router "times out." Solution:  

Open Router | Control | Set and uncheck "Disable router queries" .  

5.4. Truncation of Messages (When Using Winkeyer Keyer) 

Symptom: Sends all the macro CW messages except the last letter and then goes back 
to receive. The solution is to add a space or the | character (the shifted \ character) at 
the end of the macro message. The | character is about 1/3 of a space.  

6. microHAM - MK2R/MK2R+ 
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 To set up MK2R+ with N1MM using LPT control see: 
http://www.microham.com/Downloads/MK2R_N1MM_Setup.pdf  

 For a set-up using only USB see "USB-only SO2R.pdf" by N4ZR in the N1MM 
Logger area on Yahoo (http://groups.yahoo.com/group/N1MMLogger).  

 
Q. When I load N1MM logger the message shows: "Winkeyer v2 detected, Only 
Winkeyer v4 and higher are supported in N1MM."  



A. That's a Winkeyer initialization error of some kind which shows when the MK2R+ is 
not switched on when N1MM logger is started.  

Q. How many serial ports are needed by MK2R to fully work  
A. In any case, one only needs five ports for a fully functioning system with N1MM 
(Radio 1, Radio 2, PTT 1, PTT2, and Winkeyer). Any other functions (Packet, rotor 
control, etc.) do not need  
to be in the "first eight." MMTTY/Digital Interface will share a port with PTT (and CW if 
you are not using Winkeyer) ... and MMVARI or MMTTY in AFSK mode does not 
require a port at all. Even if/when the SO2R control signals get mapped to serial 
handshake lines or the software adds support for the microHAM control protocol (on a 
virtual port) one additional port will not push most systems "over the line" - although the 
ability to start the block of eight other than at COM1 would provide a bit of insurance. 
 
73, Joe, W4TV  

An example setup  

microHAM Router  

 VOICE Audio Switching for both radios: CmCmCm  

FT1000MP, Proset Plus plugged to front mic jack.  

N1MM Logger (6.10.9 or higher)  

 Configurer >Audio tab  
o 2 - Single Card - Two Radio, No sound card SO2R  
o Select Device = USB Voice CODEC  
o Select Input Line = Microphone  
o Select Line to Mute = Microhone  
o Recording bits = 16  
o Sampling rate = 22050  

 
Ctrl+Shift+Fx to record, Fx to playback.  

6.1. USB-only SO2R Support 
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With USB-only SO2R support using the the MicroHam SO2R protocol, an LPT port to 
command various SO2R functions with the MK2R/MK2R+ is no longer needed.  

Designate a virtual COM port as your MK2R control port in N1MM logger. To do this, 
check the CW/Other box for the port, click on 'Set', and check the MK2R box on the port 
details dialog. Then go to the SO2R tab on the MicroHam Router, select Microham 
SO2R protocol with the "radio button", and identify the COM port in the drop-down list 
just below. Finally, if you want to use program-derived band data, on the ACC tab 
change the Radio 1 and Radio 2 options to "SO2R protocol controlled". If you want to 



control band decoders for two radios, you may need to wire up a new cable to get Radio 
1 data from pins 6-9 on the ACC connector, and Radio 2 data from pins 10-13.  

Record-on-the fly within the program is supported using USB-only.  

6.2. Suggested Port Setup by Joe, W4TV 
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"The MK2R/MK2R+ operates very well with six total ports (I will use A - F to avoid 
particular numbers):  

MK2R/MK2R+ with 6 Total Ports  

Port  Connected Device 

COM 
A  

Winkeyer (it is best to assign Winkeyer to the "lowest" port to avoid loss of CW 
if another port is activated for CW) 

COM 
B  

Radio #1 (PTT and Footswitch is optional on this port) 

COM 
C  

Radio #2 (PTT and Footswitch is optional on this port) 

COM 
D  

Digital #1 FSK and PTT for Radio #1 (assign Radio 1) 

COM 
E  

Digital #2 FSK and PTT for Radio #2 (assign Radio 2) 

COM 
F  

MK2R (protocol port) 

 
A user who does not choose to do FSK (uses AFSK only) can survive with FOUR virtual 
ports as PTT can be enabled on each of the radio ports - even with radios that normally 
expect "handshake" - as the MK2R does the handshaking and frees both RTS/DTR 
lines for control functions."  

The COM D and COM E PTT settings (or the optional radio port PTTs) are necessary if 
you wish to use the built-in N1MM Logger "DVK" with PTT (rather than VOX). This does 
not mean that you have to designate COM 5 and 6 on the Ports tab as PTT - instead 
you can just make sure the PTT box is checked on your two FSK ports in Router. If you 
wish to use the MK2R's built-in DVK instead, you will need to check the "DVK" box on 
the port you are using for the MK2R.  

6.3. On-the-Fly Recording from within N1MM Logger 
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In order to make on-the-fly recording with Ctrl+Shift+Fx work with N1MM and the 
MK2R+, there are a couple of unusual requirements:  



 if using the MK2R SO2R protocol (USB-only), you need to use MM 7.10.9 or later  
 If your computer uses the Realtek or Soundmax chips for its on-board sound, 

then you will need temporarily to set the USB Voice CODEC to be the default 
sound device in Windows and be sure to turn off all Windows sounds for the 
duration, also in the Control Panel. There's a glitch in the Realtek/Soundmax 
drivers that doesn't let mic audio get through to the MK2R+'s USB Voice CODEC 
(which it uses to record and play Function Key messages) unless you do this.  

7. RigExpert 
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When installing drivers for RigExpert Std or Plus, it creates 4 virtual COM Ports on your 
computer along with USB Audio Codec (for its internal sound card). Some users of the 
RigExpert TI-5 interface have reported that the 4th virtual port, for FSK keying, does not 
work with MMTTY. It is still possible to key FSK RTTY, using the 2nd virtual port 
(PTT/CW/SoftFSK) using the version of EXTFSK supplied with the RigExpert, and 
configuring MMTTY to use EXTFSK.  
Click on "Show Serial Ports" (ListRE program which comes with RigExpert software) 
and write down COM port numbers for CAT and PTT/CW for future reference.  
Then run your N1MM. (Make sure you are not running other logging programs at the 
same time to avoid port conflict).  
Go to Configure and click on Configure Ports, Telnet Address, Other. Click on 
Hardware. You will see a selection of COM port from COM 1 to COM 8. Select the 
proper COM port number for CAT (the one you memorized before), select your radio 
model and in Details select the proper parameters for your radio (baud rate, etc.). Then 
select proper COM port number for CW/PTT (check CW/PTT) and in the details set 
DTR to CW and RTS to PTT. If you are using RigExpert Plus, then you may also set a 
separate COM port for Winkeyer.  
If you want to use RigExpert as your Sound card (for SSB messages or RTTY) you may 
go to Audio (under the same Configurer menu) and select USB Audio Codec as you 
Sound Device.  
Please keep in mind that N1MM only accepts COM port number from 1 to 8. So if upon 
RigExpert installation you were given higher COM port number, then you should go to 
Windows Device Manager and change it.  
Also, don't forget that you can not run two programs that using USB Interface, at the 
same time.  
If you have older RigExpert - SD or 2.2, you still may use it with N1MM, just need to 
install additional driver (REAUDIO).  

When RigExpert SD is used with N1MM for Voice Keying, in the Configurer's Audio 
select "RigExpert" as a Device. Then configure the Recorded wav file path in the "Files".  
The older RigExpert models,need to have REAUDIO installed. For newer RigExpert 
models REAUDIO is not needed "USB Audio Codec" in the "Select Device" menu 
should be seleceted.  

8. Top Ten Devices - Automatic Band Decoder and DX Doubler 
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To replicate the default Top Ten Devices behavior, you would need to set up Configurer 
>Antenna tab as shown in the Interfacing section.  

8.1. Hardware Update: 'Both Ears on the Inactive Radio' versus 'Both Ears on the Active (or Run) Radio' from the 

Keyboard 
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I wanted to go one better and mimic the "PTT" operation of the DXD, which puts both 
ears on the INactive radio for aggressive S&P, but still be able to put both ears on the 
Active (or Run) radio from the keyboard, to help pick up weak answers to my CQs while 
HC8N is blasting on the S&P radio at S9 +40. You can do this manually by switching the 
DXD audio mode switch from PTT to Auto, but I'd rather keep my hands on the 
keyboard.  

After corresponding with George, W2VJN and Dave, N3RD, of Top Ten, and entirely 
thanks to them, I have it working. I also owe a vote of thanks to Terry, N4TZ/9, whose 
article in September/October NCJ describes modifying the DXD to do the same trick, 
but with a footswitch, and got us all thinking.  

First, put the DXD jumpers (2) in their CT/Writelog/TR/MM position. This has the effect 
of isolating pin 5 of the LPT port. Then put a 2N2222 open collector switch between pin 
5 and the Auto terminal of S3 on the DXD (that's the audio mode switch). Specifically, 
pin 5 drives the base of the transistor through a 1K resistor connected to the high side 
of R22, just like the basic CW keying interface. The emitter is grounded to the ground 
side of R22, and the collector is wired to the switch side of R29. I mounted the transistor 
next to R22 with double-sided tape. Ugly but effective. That's all there is to it.  

× 

 DX Doubler on port other than LPT1 

When using the DX Doubler on a port other than LPT1 check out the proper addresses. 

 
73, Pete N4ZR  

9. West Mountain Radio - RIGblaster 

old-edit  

9.1. CW and Digital Setup RIGblaster Plus 

old-edit  

Inside the RIGblaster Plus set the following jumpers on the P5 jumper block: D9 and 
D12, corresponding to RTS on PTT and DTR on KEY. Switch the port on which the 
RIGblaster is set from DIGITAL to OTHER. In N1MM's configuration use DTR (pin 4) set 
to CW and RTS (Pin 7) set to PTT. Using this configuration, everything works properly 
generating CW from N1MM and furthermore, this combination will allow the other 
soundcard related things to work (MMTTY, SSTV, PSK, Voice Key Express, etc). (by 
David, K1TTT)  

× 



 CW key down problem and RIGblaster Pro 

When your radio in CW stays in key down position try setting DTR to CW 

9.2. SSB Setup RIGblaster Plus 

old-edit  

 Serial port setup (configurer)  
o Com2 (any com port will do)  
o DTR: Always OFF  
o RTS: PTT  

 On the RIGblaster itself  
o Set the Tx/Auto switch to Auto.  

 Sound Volume Level  
o Use your soundcards volume control 

With it set up this way, it correctly mutes the microphone while transmitting a wav file 
and the VOX works when not transmitting a wav file.  

9.3. RIGblaster Advantage 
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A number of our users have experienced difficulty setting up the RIGblaster Advantage 
to do various modes. The following is based on information from West Mountain Radio's 
support department, but any errors are ours alone.  

When you load the RIGblaster driver onto your computer (we won't document that 
process here, because it is well covered in the Advantage manual), you will see a new 
virtual COM port and a new USB Audio Device reflected in your computer's Device 
Manager. Make note of the COM port's number. If it is not in the range 1-8, you'll need 
to move it there for use with N1MM Logger. That procedure, too, is in the Advantage 
manual  

The virtual COM port can be used for PTT using RTS), CW or FSK (using DTR) keying, 
and control of your radio. The USB Audio device (called "RIGblaster Advantage Audio" 
in Device Manager) has both playback and record channels, and can be specified 
anywhere you are asked to specify a sound card.  

Control of your radio is available from the Advantage in one of two forms - an RS-232C 
level DB-9 connector, and a TTL level 3.5mm stereo jack. The TTL jack (labeled CTL 
IN/OUT) is suitable for controlling radios that use TTL-level control - such as Icom's CI-
V remote jack and the 8-pin mini-din CAT jack found on some Yaesu models. It is not 
suitable for driving older Kenwood radios which employed a "negative TTL" scheme 
(such as the TS-440S and TS-850). Your best bet in this case is to buy or build an 
adapter to convert the Kenwood control setup to basic RS-232.  

The Advantage's RS-232 port can drive many RS-232C equipped radios with one 
proviso - the transceiver must not require hardware flow control. Otherwise what 
happens is that the radio holds RTS high and the Advantage will be stuck in transmit.  



Many Yaesu radios have a menu option "CAT RTS" which can be disabled - this will get 
CAT working on those radios with just a straight serial cable between the Advantage 
and transceiver.  

The FT-847 actually requires a null-modem cable but this is the only radio WMR knows 
of which does. Because the FT-847 does not require flow control this works fine with the 
Advantage.  

Kenwood radios without the ability to disable flow control require a modified serial cable 
which shorts RTS/CTS at the radio end, to fool the radio into believing flow control is 
active. This works in practice on most radios we have tried it with, but has not been 
tested with N1MM Logger. A more elegant solution is just to use a separate USB to RS-
232C adapter cable, giving you a second virtual COM port in Windows which is 
dedicated just to radio control. In this configuration, the Advantage COM port is used 
only for PTT and CW keying.  

The Advantage has a 3-position toggle switch on the front panel to determine how PTT 
is handled. In the "COM" position, PTT is under the control of the RTS line of the 
Advantage's virtual COM port. The center position, "OFF", disables PTT and CW 
through the Advantage. The third option is "VOX", which is derived from the audio signal 
itself in phone and data modes using AFSK.  

Remember that if N1MM is configured for PTT by radio command, the Advantage has 
no way of knowing this and will not go into transmit even though the radio does. Always 
make sure that PTT is done by RTS if under serial port control, or use the VOX position 
if using PTT via radio control.  

In summary, most radios can be set up for PTT (using RTS) and CW/FSK keying (using 
DTR). As long as the radio has either an 8 pin round mic jack or an RJ-45 mic jack it will 
work, because this is how audio and PTT get to the radio. For many radios, CAT can be 
achieved with a simple cable. For radios equipped with RS-232C jacks and which insist 
on flow control it is probably just simpler to use a separate USB to RS-232C cable.  

9.3.1. Setting Up N1MM Logger with the RIGblaster Advantage  
old-edit  

XXX Screen shots are from N1MM Logger Classic XXX  

Now we get to the easy part. Go to Config > Configure Ports, Mode Control, Audio, 
Other. Open the hardware tab.  



 

Select the virtual COM port number you will be using for radio control. Select your radio 
from the drop-down list. Click "Set". Do not select PTT via Radio Command. Make sure 
the communication parameters match between the program and your radio (found in its 
manual). If you are using just a single COM port for all functions, set DTR to CW and 
RTS to PTT, check the CW/Other box and you're done.  

 



If your radio wants hand-shaking, then by all means, use a second USB-to-serial 
adapter dedicated to radio control. Be sure to configure RTS and DTR on this COM port 
to the handshake settings your radio wants. Then go to the Advantage's COM port, 
check its CW/Other box, and click "Set". Set DTR on that port to CW, and RTS to PTT, 
check the "CW/Other" box, and you should be ready to go.  

 

10. Transverters 

N1MM Logger+ has transverter support in the form that per bandmap an offset 
frequency can be set. Right click menu bandmap and select Set transceiver offset 
frequency. Enter the transceiver offset frequency in kHz (minus is allowed). Example: 
116000 when using a transverter from 28 MHz to 144 MHz (144000 - 28000 = 116000). 
The same for other bands (up or down). This can be set per bandmap so when using 
two transceivers with transverters they can each be on a different band. The offset is 
saved by the program so after a restart the offset is still there.  

11. Unsupported Hardware 

11.1. W5XD MultiKeyer 
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The W5XD MultiKeyer is not supported and there are no plans to do so. SO2R support 
is provided by sound cards and Winkeyer or by other external hardware using serial and 
parallel ports.  

12. Other Hardware Information 
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All by Joe Subich, W4TV  

12.1. USB Soundcards 



old-edit  

The manuals for the soundcards below (in alphabetic order) indicate they have 
independent microphone and stereo line inputs.  

 Audigy 2NX External  
 Creative SoundBlaster MP3+  
 Turtle Beach "Audio Advantage Roadie"  

 
The "low price option" below does not have an on-line manual but the specs on the web 
site show separate mic and line jacks.  

 Byterunner UA-580  
o appears to be the recommendation for those who need an external sound 

card (laptop, etc.).  

12.2. Other Soundcards 
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 SoundBlaster Live 24 External  
o The one issue with the Live 24 External is that you cannot use the mic and 

line inputs at the same time (connecting the mic will disconnect the line). It 
will work fine for internal DVK in N1MM but you cannot "record QSOs" and 
use DVK at the same time if you loop the microphone through the Live! 24 
External.  

12.3. External versus Internal Soundcards 
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There are claims that External USB soundcards work substantially better (and should 
be used) than internal soundcards (on digital signals).  

Joe, W4TV: The claimed "advantage" comes from flawed tests which fail to properly set 
the input level to each sound device to take maximum advantage of its dynamic range. 
 
Except for the very worst sound cards or exceptionally noisy systems, internal sound 
cards have at least 60 dB of usable dynamic range (the better 16 bit cards have 80 dB 
of dynamic range and 24 bit cards with high level inputs can have dynamic ranges that 
approach 100 dB). If the audio from the transceiver is such that the receiver noise floor 
(no antenna) is six to ten dB above the noise floor of the sound card, the software DSP 
(MMTTY, etc.) will be able to operate at its full capacity. Receiver AGC, etc. will limit the 
receiver output to a level well below the input capacity of the soundcard. Most receivers 
will not vary more than 30 to 40 dB from quiet band to S9 +40 dB receive signals. 
Soundcard performance is not a matter of internal vs. external. It is a matter of careful 
attention to setting the proper level to allow the soundcard to function properly.  



 

2.5.4 N1MM Rotator Control 
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XXX N1MM Rotor description and screen shots are from Classic - need to be updated 
for Plus XXX  

 2.5.4 N1MM Rotator Control  

 1. Rotator Control Basics  

 1.1. File Menu Selections  
 1.2. Button and Mouse Assignments  
 1.3. Sending Rotor Position Information to N1MM Logger  
 1.4. Using N1MM Rotor Stand-Alone  
 1.5. Using N1MM Rotor with the Main N1MM Logger 

Program  
 1.6. One Rotator Per Radio - how to do it  
 1.7. N1MM Rotor running on another computer  
 1.8. Turning a Stack  
 1.9. Run time error: 126  

 2. Using external hardware and software  

Rotator control by N1MM Logger is supported using  

 External software  
o N1MM Rotor (comes with N1MM logger)  
o LP Rotor (freeware by Larry Phipps - N8LP)  
o PSTRotatorAZ (15 Euros/US$22 by Codrut Buda - YO3DMU)  

 External hardware  
o ARSWIN by EA4TX  
o ERC and ERC-M by Rene Schmidt DF9GR - PSTRotatorAZ required for 

ERC-M to control two rotators  

 
 
Rotators can be controlled in several different ways:  

 Entry window:  
o by entering a beam heading in the callsign field and press Alt+J. The rotor 

will turn to the entered beam heading  
 Example:234 Alt+J will turn the rotor to 234 degrees  
 The number must be numeric, >= 0 and <= 360  

o using the menu items in the Tools menu  
 Turn Rotor Alt+J - Turn rotor to bearing for the callsign in the Entry 

window  



 Stop Rotor Ctrl+Alt+J - Stop turning the rotor when turning and no 
bearing in callsign field in Entry window  

o using the short cut keys below:  
 Alt+J - Turn rotor to bearing for the callsign in the Entry window or 

to the callsign in the callframe (when callsign field is empty)  
 Alt+L - Turn rotor to long path bearing for the callsign in the Entry 

window  
 Ctrl+Alt+J - Stop turning the rotor when turning and no bearing in 

callsign field in Entry window  
 Bandmap window: by right clicking on a spot and select: 'Turn Rotor'  
 Available Mult's and Q's window: by right clicking on a spot and select: 'Turn 

Rotor'  

 N1MM Rotor stand-alone program  

 
Some remarks  

 If there is a call of less than three characters in the callsign field in the Entry 
window nothing will happen.  

 The status bar will show the bearing it will turn to. Example: Turning Rotor to 123 
degrees  

 Normally the rotor will turn to the country bearing after a callsign is entered. This 
info comes from the country file and mostly is the center of the country. In grid 
square contests however that is mostly not practical so when a grid is entered 
the rotor will turn to the calculated bearing between the own grid and entered grid 
square.  

1. Rotator Control Basics 
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N1MM Rotor has the ability to control up to 16 rotors per station, and to control rotors 
connected to other computers on your LAN. Each rotator requires its own COM port, 
unless external interfacing software is used. N1MM Rotor leverages the Antenna tab to 
define what rotators are controlled when you are on a band. N1MM Rotor can even 
rotate a stack with one command. N1MM Rotor is an external program which can be 
used from within N1MM Logger or as a stand-alone program.  

 
 

Supported Rotator Types 

 DCU1 - No Stop button supported. 
 M2 Orion - Speed shown to bottom 

right of status bar. 
 Prosistel 
 AlfaSpid 
 Yaesu 
 RC2800P-A 



  Rotor-EZ 
 AlfaSpid ROT2 
 Prosistel C 
 Green Heron RT-21 (use DCU-1 

option or Rotor-EZ setting) 

 
All rotators except the DCU1 support 
position reporting. It would be worth trying 
the Rotor-EZ setting with other rotators that 
use the DCU-1 protocol or a superset of it, 
because the antenna position may be 
reported in the Rotor window. 

Upper pane: The upper pane shows the selected rotator (as entered in the Setup under 
Tools) and behind the @ the current rotator position. 
 
Menu bar: Shows the File, Tools and Help menus.  

The big digits indicate the current rotator position. When an antenna offset has been 
entered this will be shown in small digits to the right of the current rotator position.  
More to the right a visual indication where the rotator is pointing. The line in the circle 
can be dragged to turn the rotator, for rotators that support position reporting.  
The textbox is an entry field where you enter the bearing the rotator is to be turned to.  
Clicking the Turn button will turn the rotator to that position, and the Stop button will stop 
turning the rotator at the current position.  
A reverse offset will be shown as (R) .  

Status bar: Shows the speed when reported by the rotator.  

The program will be brought to top when turning (unless minimized)  

1.1. File Menu Selections 
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 File  
o Always on Top - Select to have the program always on top  
o Exit - Exit the program  

 Tools  
o Setup Rotors - a dialog named 'Rotor Setup' will be displayed as shown 

below  



 

 

o Set Current Antenna Offset  
 The offset is entered on the antennas tab of the Configurer, or can 

be entered for the selected rotor. This offset is added to the rotor 
position to determine the antenna position, so it should be entered 
with a "-" sign when the offset antenna is rotated clockwise relative 
to the rotator direction. This is useful for antennas that are mounted 
at 90 degrees for pattern interference reasons, or for antennas that 
have simply turned some in the wind over the winter  

o Set Current Antenna Bidirectionality  
 Bidirectional is for dipoles, or SteppIr's where the user wants to 

reverse the antenna rather than turn it more than 180 degrees  
o Calibrate Rotor - Calbrate the rotator. Only when supported by the rotator 

like the M2 Orion. The ERC/ERC-M hardware does calibration in firmware.  
o Prosistel C Config  

 A dialog will open where you can set the rotator stop to North or 
South and the delay of the characters  

o Set rotation limits  



 This feature is for owners of rotators with brakes that jam. You may 
enter a number which will restrict how close the rotator will be 
turned to 0 or 360 degrees. If you enter 10, the limits will be 10 to 
350 degrees. Note that this can only be set for all rotators handled 
by an instance of the program. It didn't seem worth adding it to the 
antenna tab  

o A new line will be shown for every rotator that has been set up  
 Each line represents a rotator as entered in the setup under Tools  

 Help  
o Help - Shows the help file for this window  
o About - Gives the version of the N1MM Rotor program  

1.2. Button and Mouse Assignments 
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 Manual entry field - Type a heading and press Enter or the Turn button to turn 
the rotator. The entered number is in degrees.  

o Maximum: 450 and minimum 0. An error message will appear when 
entered otherwise when pressing the Turn button.  

 Turn - Click to turn rotator to heading in textbox. Pressing Enter will also turn the 
rotator, if the entry focus is on N1MM Rotor.  

 Stop Alt+S - Press to stop rotator turning. Pressing Alt+S or Escape will also 
stop turning the rotator.  

o This button is only shown when the rotator supports this feature.  
 F1 - F10 - Pressing the F-keys mapped to the bearing buttons will turn the rotator 

to the position as shown on the button. Right click to set the heading value.  

 Bearing buttons (F1 - F10)  
o Left mouse button click  

 Pressing one of the bearing buttons will turn the rotator to the 
position as shown on the button.  

 The F-keys F1 through F10 are mapped to the 10 bearing buttons.  
o Right mouse button click  

 Set Button to Current Position  
 The heading as entered in the manual entry field will be used 

to set the position.  
 Set Button to a Specific Heading  

 A dialog will appear and a frequency can be entered which 
will used to set the position.  

 
Only rotators that report position will be able to show the current position (also when 
rotating).  

1.3. Sending Rotor Position Information to N1MM Logger 
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By default, N1MM Rotor sends position information only to the N1MM Logger main 
program that is running on the same computer as N1MM Rotor. If you are using only 
one computer, with both N1MM Rotor and N1MM Logger running on that computer, you 
can skip the rest of this section, but if N1MM Rotor is running on a different computer 
from N1MM Logger, you need to read on.  

If you want to send position information to copies of N1MM Logger running on other 
computers, you must use a text editor to manually edit the N1MMRotor.ini file in order to 
tell N1MM Rotor which computers to send the information to. Look for the line 
"RotorReportingIP" in the [Rotors] section; if it doesn't exist, you will have to add it.  

If all of the computers in the network are in the same subnet, i.e. they all have IP 
addresses that start with the same three numbers, such as 192.168.1.xxx, then you can 
send position information from N1MM Rotor to all of the computers in the network 
simply by setting RotorReportingIP to the broadcast IP address (last number = 255), as 
in:  

[Rotors]  
RotorReportingIP=192.168.1.255  

If you only want to send position information to certain selected computers on the 
network, you can specify one or more individual IP addresses, separated by spaces. 
For example:  

[Rotors]  
RotorReportingIP=127.0.0.1 192.168.1.10 192.168.1.12  

This will send rotor position information from N1MM Rotor to N1MM Logger running on 
three computers: the same computer that N1MM Rotor is running on, which is always 
denoted by 127.0.0.1 regardless of which subnet it is in, and two additional computers 
whose IP addresses in this example are 192.168.1.10 and 192.168.1.12. Other 
computers in the network whose addresses are not specified in the N1MMRotor.ini file 
will not receive the rotor position information. The IP addresses do not all have to be in 
the same subnet, but of course they must all be reachable from the computer that 
N1MM Rotor is running in.  

 

1.4. Using N1MM Rotor Stand-Alone 

old-edit  

Go into the N1MM program directory with Windows Explorer and find 'N1MMRotor.exe'. 
This is the N1MM Rotor program. A shortcut on the desktop would be an easy way to 
start the program. All features mentioned above can be used.  

1.5. Using N1MM Rotor with the Main N1MM Logger Program 

old-edit  

Configure your rotors using the N1MM Rotor standalone program, as shown in the 
previous section. Verify that the rotors work correctly.  



The N1MM Logger main program has the capability to turn rotors from the Entry 
Window, as described earlier. To configure this capability in the N1MM Logger main 
program:  

 Setup the antenna selections in the Configurer; Tab: Antennas  

 
N1MM logger setup dialog in >Config >Configure Ports, Antennas tab  

 
 
 
 
The alphanumeric name in entered in the Rotor Description in the Configurer Antennas 
tab, must be exactly the same alphanumeric name entered in the N1MM Rotor Setup 
form.  

The N1MM Logger main program also has the capability to display the current direction 
of any rotor used by the controlling station, or any rotor in the network. To configure this 
capability, use the checkboxes "Display Rotors Used By This Station" and "Display 



Rotors Responding From Network" in the Configurer Antennas tab. A new display form 
will appear for each responding rotor:  

 

When "Display Rotors Used By This Station" is enabled, only the rotors used by the 
currently active bands in the Entry Window(s) will be displayed. When you change 
bands, the displayed rotors will be automatically updated.  

When "Display Rotors Responding From Network" is enabled, all rotors that report their 
position to the computer, from any N1MM Rotor running on the network, will be 
displayed.  

To start N1MM Rotor automatically from within the N1MM Logger main program, use 
the checkbox 'Start N1MM Rotor Program' in the Configurer Antennas tab.  

1.6. One Rotator Per Radio - how to do it 

old-edit  

Occasionally, we get questions about how to relate a rotator to a specific radio or VFO, 
in SO2R - so that when you enter a callsign in that radio's Entry Window, the rotator for 
that radio's antennas receives the command.  

The answer is simple - On the Antennas tab of the Configurer, define the antennas for 
the second radio as if they were alternative antennas for a given band, and specify the 
desired rotator's COM port . Then, while the second radio's Entry Window is active, hit 
Alt+F9. You only need to do this once, each time you change bands on the second 
radio. See this page for more on configuring more than one antenna for a given band.  

1.7. N1MM Rotor running on another computer 

old-edit  

Let's assume that N1MM Rotor is on a separate computer which has IP address 
192.168.1.14, and your computer, running N1MM logger, is 192.168.1.10.  

 Make sure N1MM Rotor is running on the computer that has the rotor connected 
to it.  

 Network the computers together.  
 Put this in your N1MM Logger.ini file:  

o [ExternalBroadcast]  
o BroadcastRotorAddr=127.0.0.1:12040 192.168.1.14:12040  

 ExternalBroadcast should already be there. If not, add it.  
 Enable "Display Rotors Responding From Network"  
 Put this in your N1MMRotor.ini file on the computer running N1MM Rotor:  

o [Rotors]  
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o RotorReportingIP=127.0.0.1 192.168.1.10  
 Control the rotator by menus in the Tools menu. You put the direction or a 

callsign in the call textbox and press Alt+J  
 The requesting station will see a Rotor Form window open, showing the current 

direction of the rotator. Note that some rotators cannot report progress.  

1.8. Turning a Stack 

old-edit  

In the example picture above at the right the stack is on Com3 and Com4 and are 
turned at the same time when turning antenna 4 (stack).  
Enter 3,4 and the heading selected will be sent to the rotor program and it will tell the 
rotators (of whatever type) on COM3 and COM4 to turn to that azimuth. If you want to 
control a single antenna, you will have to switch to that single antenna using the 
antenna toggle (Alt+F9) in the main program, press ALT+J and then toggle to the set of 
antennas that you want.  

1.9. Run time error: 126 

old-edit  

Run time error 126 could be caused by a firewall that doesn't like a UDP message sent 
to 127.0.0.1 to notify the rotor program of what window is active. If you want to use the 
rotor program without getting this error, you will need to figure out what program is 
causing this interference. First check your firewall. If that is not it, one user found that a 
program called "Port Explorer" was the cause. When "Port Explorer" was closed, the 
problem went away.  

2. Using external hardware and software 

 
Rotator control is supported directly by software and/or hardware from:  

 ARS-USB by EA4TX  
 LP rotor (freeware by Larry Phipps - N8LP)  
 PSTRotatorAZ (15 Euros/US$22 from Codrut Buda, YO3DMU) See the links 

section for urls.  

 
Start your ARS-USB, LP Rotor or PSTRotatorAZ software before attempting to control 
rotators.  

The ERC-M rotator controller by DF9GR offers control of an AZ-EL rotator system or 
two azimuth rotators using a single COM port. However, this mode of operation is not 
supported by N1MMRotor at this time. You will need to use two linked instances of 
PSTRotatorAz as intermediary between N1MM Logger+ and the ERC-M. Setup is a little 
tricky but is fully documented and works fine.  

 



2.6 Windows 

 1 Entry Window 

 2 Log Window 

 3 Bandmap Window 

 4 Telnet Window 

 5 Check Window 

 6 Available Mults and Qs Window 

 7 Info Window 

 8 Score Window 

 9 Multipliers Window 

 10 Statistics Window 

 11 Skins Colors and Fonts Window 

 12 Visible Dupesheet Window 

 13 Grayline Window 

 14 CW Reader Window 

 15 Realtime Score Reporting 

 16 Network Status Window 

 

2.6.1 The Entry Window 

 2.6 Windows  
 2.6.1 The Entry Window  

o 1. Key Features  

 1.1. Customizable Skins, Colors and Fonts  
 1.2. Which Entry window textbox has the entry focus?  
 1.3. Right-click Menu  
 1.4. Display of Check status  
 1.5. Band Panel  
 1.6. Action Button Row  
 1.7. Function Key Panel  
 1.8. Run/S+P (radio buttons)(Alt+U)  
 1.9. CW speed(PgUp/PgDn)  
 1.10. Entry and Transmit Focus - The Red and Green dots ("LED"s)  
 1.11. Call-sign/Exchange Editing Features  
 1.12. Entry Window Text Commands  
 1.13. Multi-op  
 1.14. Mobile/Rover/VHF Commands  
 1.15. Additional VHF Commands  
 1.16. Repeat CQ  
 1.17. Bearing, Call History and Status Bar Information  
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 1.18. The Status Bar  

o 2. Dual Entry Windows  
o 3. Call-sign Colors  
o 4. Other Features  
o 5. Function Keys  

 5.1. General  
 5.2. Run mode and S+P mode  

o 6. File Menu Selections  

 6.1. Import  
 6.2. Export  

 6.2.1. ADIF Export Sub-menu  

 6.3. Contest List  

o 7. Edit Menu Selections  
o 8. View Menu Selections  
o 9. Tools Menu Selections  
o 10. Config Menu Selections  

 10.1. Configure Ports, Mode Control, Audio, Other - Also called 
Configurer.  

 10.2. Change Your Station Data  
 10.3. Logger+ Audio Setup  

 10.3.1. The Monitor tab  
 10.3.2. The Playback tab  
 10.3.3. The Message Recording Tab  

 10.4. Use Logger+ Audio  
 10.5. Enter Sends Message (ESM mode)  
 10.6. Spot all S&amp;P QSOs  
 10.7. QSYing wipes the call & spots QSO in bandmap  
 10.8. Grab Focus From Other Apps When Radio Is Tuned  
 10.9. Do not automatically switch to Run on CQ-frequency  
 10.10. Show Non-workable Spots and Dupes in Bandmap  
 10.11. Reset Rx freq to TX when QSO is logged (RUN and split)  
 10.12. Sub Receiver Always On  
 CQ Repeat - Alt+R  
 10.13. Set CQ repeat time - Ctrl+R  
 10.14. CW AutoSend Threshold - Ctrl+Shift+M  
 10.15. Enable Call History Lookup  
 10.16. Change CW/SSB/Digital Message Buttons - Alt+K  
 10.17. Change Band Plan  
 10.18. Manage Skins, Colors and Fonts  
 10.19. Change Operator Call-sign Stored in Log (Ctrl+O)  
 10.20. Change Exchange Abbreviations  
 10.21. SO2R  
 10.22. WAE - Special commands for the WAE DX contest only  
 10.23. Clear INI file settings  

o 11. Window Menu Selections  
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o 12. Help Menu Selections  

1. Key Features 

Your entry window will be similar to this one.  

 

1.1. Customizable Skins, Colors and Fonts 

Note that while the colors and font sizes displayed here and in other screenshots mimic 
the original N1MM Logger Classic, Logger Plus provides for extensive customization of 
colors and fonts in every window, part of an effort to improve accessibility.  

1.2. Which Entry window textbox has the entry focus? 

in edit - provisional text based on e-mail from N1MM  

Versions 1.0.5108 and after include a change to how Entry Window textboxes are 
highlighted to show you which has the entry focus. This is active in SO1V, SO2V and 
SO2R.  

What inspired this change is that Win 10 is particularly bad at visual cues to show you 
which window is active. In Win 10, if the title bar is grayed, then the window is inactive. 
Problem is, some windows don't have titles. Sigh. It's probably possible to change this 
with the OS, but I doubt many will do it, thus the change.  

Beginning with the version to be released Tuesday August 25, the Skins, Colors and 
Fonts Window will allow you to choose the old method of indicating focus, and two 
choices for background highlighting  
corresponding to the two colors you have chosen for the Log window grid. It is important 
that your mult and dupe foreground colors are easily visible on the background that you 
choose. The default color scheme is pretty reasonable in this regard.  

What is different in the new scheme is that only the textbox with focus, in the window 
with focus, will have a white background. The white textbox will always tell you where 
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the next character you type will go. If neither Entry window has focus, then all the 
textboxes in both will show with a colored background. If you are working in another 
application, then you will need to use your mouse to bring focus back to N1MM+.  

There is a bonus to this change. We spent a lot of time trying to get focus back to the 
Entry Windows in a sensible way when you use the other windows in N1MM+. With the 
EW textboxes flashing white/color, this focus behavior is made much more obvious. I 
would ask that you not complain about the focus movement behavior for a week or two 
because it has not changed with the "colorization". Once you have acclimated to the 
new version, then it would be a good time to point out whatever inconsistencies there 
may be in the focus behavior.  

Finally, in working on this improvement, I ran across this feature of Windows: 
http://www.howtogeek.com/194095/how-to-change-the-blinking-windows-keyboard-
cursor-thickness/  

It allows you to change the thickness of the cursor. I changed mine to 2. It's much more 
visible without being obstructive.  

1.3. Right-click Menu 

In addition, this right-click menu is provided.  

 

The first 5 choices affect the size of the entry window. Uncheck them to remove things 
in the window that you do not need.  
"Show User Information", if selected, will display Call History User Text.  

The 6th option, Band Button Left Click Enabled, is on by default, but may be turned off. 
In a multi-op station, it may be helpful to turn off the left-click band change to prevent 
accidentally changing bands.  

If you click on the last option, "Change Band Panel Display", this dialog will appear.  



 

Click the Default button to display the traditional contest bands (HF or V/UHF depending 
on contest), or all HF bands except 60M when using the DX general logging "contest." 
Check individual bands to display only those bands. Note that if you select a single 
band contest on either HF or VHF, the Band Panel will continue to display either full list 
until you check the bands you want to have displayed.  

1.4. Display of Check status 

 
If the Check window is open and an exact match to the entered call-sign is found, a 
check will appear in the right end of the call-sign text box. The check is colored to match 
the call-sign color and reflect multiplier status - by default, the colors are green for 
double, red for single, blue for no multiplier but a workable station for QSO credit. A "?" 
appears if no match is found, unless you opt to turn that option off in the View Menu of 
the Entry window.  

1.5. Band Panel 

 There is one column of band buttons in the Band Panel for each permitted mode 
in the current contest, just to the left of the Call-sign textbox. The color codes 
shown, when a callsign has been entered, are for the currently-entered call-sign 
in the call-sign textbox. Green="double mult" red="single mult" blue="not worked 
yet" grey="dupe). These are default color choices - see the Skins, Colors and 
Fonts window, reached from the Config menu, to change these color codes 
throughout the program.  

 The Band Panel modes are determined by the Mode Category set in the Contest 
Setup Dialog (File > New Log or Open Log), not by the mode of the radio or one 
entered in the call-sign textbox (\"CW\", \"USB\", etc.).  
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 Left click on a mode/band button to move the program to that mode and band; an 
attached radio will follow, to the last frequency you used on that band. The 
rounded rectangular box around "15 CW" in the illustration above is an indicator 
of that radio's current band and mode, which may be useful during rapid band 
changes.  

 When not in Networked Computer mode, if you right click on a mode/band 
button, your radio will QSY to that band and mode, to the last frequency you 
used on that band, and the callsign of the last station you logged will be locally 
spotted (not sent out to the Internet). This feature is primarily intended for VHF 
contests where you may want to move a station to many band/mode 
combinations in quick succession.  

 When in Networked Computer mode with a callsign in the Callsign textbox, if you 
right-click on a band/mode button, the callsign and frequency of the station you 
are working will be passed to the networked computer on that band. An Info 
window message will be sent to the recipient station, and the passed callsign will 
be placed on the recipient station's Bandmap on its specified Pass frequency.  

1.6. Action Button Row 

 Esc:Stop - Immediately ends transmission of a stored message (all modes)  
 Wipe (Alt+W, Ctrl+W)- Clears information about the current contact. You can 

also program this into a Function Key, for one-keystroke operation.  
 Log It (Enter) - Writes this contact to the log. Disabled when in Quick Edit mode. 

If you have not filled in all needed exchange information, you will be prompted 
before logging will occur. You can use Ctrl+Alt+Enter to circumvent this \"editing\" 
function and log whatever you have entered, for correction later.  

 Edit - Pops up the full Edit window to edit the last contact. Use Ctrl+Q (Quick 
Edit) as a convenient alternative. Greyed out when in Quick Edit mode.  

 Mark (Alt+M) - Marks the current frequency in the Bandmap as being in use. 
Used when you don't want to take time to enter the call of the station using the 
frequency.  

 Store (Alt+O) - Spots on the Bandmap the call-sign you have entered in the Call-
sign textbox. It will be shown in bold because it is self spotted. The Telnet Filter 
tab option \"QSYing wipes the call and spots QSO in Bandmap\" is an easier way 
to do this, whether you have worked the station or not.  

 Spot It (Alt+P) - Spots either the callsign in the callsign textbox or the last QSO 
logged, if Telnet is active. See this section for more information.  

 QRZ - Performs a lookup on QRZ.com of the call-sign in the Call-sign textbox, if 
your computer is connected to the Internet.  

1.7. Function Key Panel 

 F1 through F12 - Sends the associated CW/Digital text or .wav file, and 
executes any macros stored in the message. Right click on the buttons to open 
the Function Key Editor. Running and S&P modes each have 12 stored 
messages. Press Shift+F1 through F12 to send the Run message when in S&P 
mode, or vice versa.  
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1.8. Run/S+P (radio buttons)(Alt+U) 

Switch between Run and S&P mode. This also switches between the Run (first 12) and 
S&P (second 12) messages in the .mc file (unless the second 12 messages are not 
present in the .mc file).  

1.9. CW speed(PgUp/PgDn) 

 The textbox shows the current CW speed. Either PgUp/PgDn or clicking the 
up/down arrows alongside the speed will change the speed. Only visible when 
CW mode is selected. The interval in WPM is set on the Other tab in the 
Configurer. Additional keystroke combinations for changing speed by a larger 
(secondary) interval may be seen under Key Assignments.  

× 

 The Ignore Winkey Speed Pot setting 

When using a Winkeyer, if you do not check "Ignore Winkey Speed Pot" on the Winkey 
tab in the Configurer, the program's starting CW speed will be set by the Winkeyer 
speed knob. If you check that box, the program will start at the last CW speed used. 

1.10. Entry and Transmit Focus - The Red and Green dots ("LED"s) 

On the Entry Window below the left end of the Call-sign textbox you will see either a 
green or a red dot (LED), or both. The LEDs are visual aids that help you keep track of 
what is happening on each VFO/radio, particularly when operating SO2V or SO2R. This 
is part of N1MM's continuing philosophy of letting the operator easily know what's 
happening at any given time.  

Green dot/LED - This VFO/radio has Entry focus - also known elsewhere in this manual 
as RX (Receive) focus or Keyboard focus. This means that any information entered by 
keyboard goes in that window, including function keys. Depending on your SO2R 
switching setup, it may also denote which radio you are hearing in your headphones.  

Red dot/LED - This VFO/radio has the Transmit focus. When actively transmitting, the 
red LED turns to orange (default) or another color defined in the Manage Skins, Colors 
and Fonts window, reached from the Config menu. Note that the Transmit focus does 
not necessarily tell you which radio will transmit next. For example, if the red LED is in 
Entry window A, but the green LED is in Entry window B, pressing F1 will send CQ on 
radio/vfo B, because it has the Entry focus. The red LED will move to that window, and 
remain in the active transmit color for the duration of the CQ.  

The following table explains how certain keystrokes and mouse-clicks move the LEDs 
from one entry window to the other  

Action 
Starting Condition First Keystroke 

Subsequent 
Keystrokes 

Back-slash Both in one Entry 
window 

RX focus to other 
Entry window 

Toggle RX focus 
between Entry 
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windows 

 One in each Entry 
window 

RX focus to other 
Entry Window 

Toggle 

Pause Both in one Entry 
window 

Both to other Entry 
window 

Toggle both 

 One in each Entry 
window 

Both to Entry window 
with Transmit focus 

Toggle both 

Mouse click 
(anywhere but 
buttons) 

N/A  RX to clicked window N/A 

Ctrl+left arrow Both in one Entry 
window 

Both to VFO/Radio A Nil 

 One in each Entry 
window 

Both to Radio A Nil 

Ctrl+right arrow Both in one Entry 
window 

Both to VFO/Radio B Nil 

 One in each Entry 
window 

Both to VFO/Radio B Nil 

 Important note 

When using function keys to transmit either CW or stored voice messages, the 
message will be sent on the radio or VFO that has the Entry focus, not the one that has 
the Transmit focus. When you press the function key, the red LED denoting Transmit 
focus first switches to the Entry window that has the Entry (Keyboard) focus, and then 
the message is transmitted. On the other hand, when using either manual CW or phone, 
messages will be sent on the radio or VFO that has the red LED, so if you grab the 
microphone or paddle, that's what you'll get. After a while, it becomes second nature - 
we promise! 

1.11. Call-sign/Exchange Editing Features 

 Space Bar - moves cursor between the Call-sign and Exchange textboxes. The 
cursor will always return to the position it was in when last in that textbox.  

 Tab - Moves to the next textbox.  
 Shift+Tab - moves to the previous textbox.  
 Home - moves cursor to beginning of the current textbox.  
 End - moves cursor to end of the current textbox.  
 Question mark (?) - In the Call-sign textbox, sends "?". The "?" will be 

highlighted (selected) when the cursor returns to the textbox. For example, 
entering N?MM in the Call-sign textbox will send what is typed, and automatically 
highlight the "?" when you space back to it, so you can easily replace it. A double 
"?", as in DL?K?A will highlights all text in between and including the "?" marks, 
and the first keystroke entered will replace all three characters.  

 Left/Right Arrow - moves cursor to left or right one position within a textbox.  



 Backspace - deletes character to the left of the cursor position.  
 Delete - deletes character to the right of the cursor position.  
 Shift+Home - highlights from the cursor position to the beginning of the current 

textbox, so that you can easily replace all the highlighted text.  
 Shift+End - highlights from the cursor position to the end of the textbox.  
 Shift+arrow key - highlights as you press the arrow keys in either direction. 

When you type the first new character, it replaces all the highlighted characters.  

× 

 Note 

Check out the Key Assignments page in Digging Deeper for a listing of all available 
"hot-key" assignments in the program. 

1.12. Entry Window Text Commands 

While N1MM Logger+ does not make extensive use of text commands (as CT did and 
Win-Test still does), there are a few that may prove useful.  

In each case, the command is typed into the Call-sign textbox of the Entry 
window, and executed when Enter or Ctrl+Enter is pressed.  

 Mode Changes - Enter CW, SSB, RTTY or PSK, and the program (together with 
your radio, if one is connected) switches to the requested mode. This is 
particularly useful when you have not connected a radio, but wish to change the 
mode recorded in your log. For SSB, the switch will be to the conventional 
sideband (e.g., USB on the higher bands, or LSB on 40M and down). If you need 
to be on the opposite sideband for some reason, enter USB or LSB as needed.  

 Frequency Changes- Enter a full frequency in kHz (e.g., 14025.1 , or 14025,1 if 
your computer uses comma as the decimal separator) and the program moves to 
that frequency. Type a partial frequency relative to the current lower band edge 
(e.g., 025.1) and the program goes to that frequency relative to the band edge. 
Type a frequency with a + or - sign (e.g. +2, -3) to QSY by the selected amount 
(i.e. up 2 kHz or down 3 kHz). If your radio is interfaced for radio control, its 
frequency will follow the program. 
Type a frequency, but execute with Ctrl+Enter, and the program (and radio, if 
connected) goes into split mode and uses the frequency you entered as the 
transmit frequency. For full information on split operation, see this chapter.  

 Wipe the Log- WIPELOG -This command is used to delete any "practice" QSOs 
from a log before you begin actual operation. In single-computer stations it may 
be as easy simply to create another instance of the contest from the Contest 
Setup dialog. In networked computer stations such as multi-ops, use of 
WIPELOG is helpful for ensuring that the logs maintained on each computer will 
be consistent with one another. It is important that every computer on the 
network performs the WIPELOG command before any contacts are made. Any 

http://n1mmplus.hamdocs.com/tiki-index.php?page=Single+Operator+Split+Operation


spare computers should be set up for the contest, and the WIPELOG command 
executed, before they are connected to the network.  

 TOUR command - A very few contests allow for multiple sessions in which you 
can work the same station in every session for QSO credit. You can enter TOUR 
into the Entry window in place of a call sign to reset dupe checking at any time 
before or during the contest. This command has 2 required parameters that are 
entered into the Sent RST field, separated by a forward slash "/". The first 
parameter is the time when the current session begins (GMT) and the second 
parameter is the duration of the session. The format for both parameters is 
hhmm. For example, 1200/30 means the session starts at 1200Z and has a 
duration of 30 minutes. The minimum value for the duration parameter is 10 (10 
minutes). If the TOUR command is entered without any parameters, the current 
values of the start time and duration will be displayed. The default values are 
0000/00.  

o At the beginning of each session the start time and duration will be 
displayed in the status field at the bottom of the Entry Window. After the 
first QSO has been logged during the new session you should see the 
Multiplier window reset and dupes will be reset for this new session as 
well.  

o Most of the contests supported by the Logger do not need this command 
but some (mostly Russian and Ukrainian) have it built into the contest 
module and do not require it entered manually.  

o If you are planning on using TOUR command with other contests, keep in 
mind that settings for it will be lost when the Logger is restarted. If the Snt 
(sent RST) field is not displayed in the Entry window, you will not be able 
to use this command.  

1.13. Multi-op 

OPON - This command is the equivalent of Ctrl+O, and opens a sub-window for a new 
operator to "sign on." The operator is saved in the log with each contact for later display 
and analysis (for example, using the View > Statistics menu item and selecting Operator 
as the row or column to be displayed). The operator currently "ON" is displayed in large 
blue letters in the Info window.  

QSO-specific operator information is not included in the Cabrillo file, but the "Update 
Ops from Log" button in the Contest Setup Dialog can be used to create a list of 
operators to be included in the Cabrillo header.  

OPON also determines what will be returned by the {OPERATOR} macro, which can be 
used in SSB function key message files to invoke individual wav files in each operator's 
voice.  

In addition, after you have entered your call, you can execute Save Window Positions 
on the Entry window's Tools menu and thereafter when you sign on again, your 
personal saved window positions will be retrieved.  

1.14. Mobile/Rover/VHF Commands 



 ROVERQTH - for use in QSO parties, opens a pop-up window into which you 
enter your current or planned county abbreviation, in the form specified by the 
contest organizer. See the section on Mobile/Rover Support.  

 COUNTYLINE - for use when operating from a county line in QSO parties. 
Opens a pop-up window into which you enter the county abbreviations, 
separated by a comma. After you exit this window, check the title bar of the Entry 
window to ensure the correct counties are listed.  

1.15. Additional VHF Commands 

 BEACONS - This command will load a user-prepared file called Beacons.txt from 
the N1MM Logger+ document directory (which sub-folder?) unto the database. 
The file format is:  

# Hours to stay in bandmap (mostly > 24 or > 48) 

60 

# call beacon;frequency;locator;comment 

OZ7IGY/B;144471,1;JO55WM; 

PI7CIS/B;144416,2;JO22DC;Should always be heard 

DL0PR/B;144486,3;JO44JH;Switches power! 

GB3VHF/B;144430.4;JO01DH;QRG with a . 

ON0VHF/B;144418,5;JO20;4 digit grid 

The purpose of this function is to permit users to display beacons on their Bandmaps for 
much longer than the normal packet timeout, as a reminder to listen for those stations 
periodically. In the sample above, the beacons will continue to be displayed for 60 hours 
after the command is invoked. Note that unlike the other Entry window text commands, 
this one pops up a file selection dialog as soon as the last letter is typed; no Enter is 
required, other than to exit the dialog and load the file once it has been selected.  

1.16. Repeat CQ 

Alt+R - Toggles between Repeat CQ and normal CQ modes. The message "CQ 
Repeat is on/off" appears in the Status Bar with each Alt+R entered.  
Ctrl+R - opens a dialog for setting the repeat interval (in seconds).  

When you first press F1 after selecting repeat CQs, an icon will appear in the Entry 
window, like this.  
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As long as the icon is visible, the CQ will repeat at the repeat interval. If you interrupt 
with a call-sign or the ESC key, it will disappear.  

1.17. Bearing, Call History and Status Bar Information 

If the Entry window is tall enough, the two lines below the buttons will display useful 
information.  
The Bearing line displays short and long path beam headings and short=path distance 
to the station whose call-sign is entered in the Call-sign textbox. Call history information 
for the entered call-sign appears in the next line, when Call History Lookup has been 
enabled on the Config menu.  

1.18. The Status Bar 

The Status Bar is the bottom line of the Entry window is always displayed. It is divided 
into three panes  

 Left pane - Information  
o After entering a call-sign - Country, Zone, Continent  
o Otherwise - Program messages (error messages, results from commands 

such as CW speed changes, or recording of .wav messages. You may 
need to widen the Entry Window temporarily to display full file paths and 
other long messages.  

 Middle pane - QSOs /multipliers (/zone) depending on the selected contest.  
 Right pane - Current score  

2. Dual Entry Windows 

The program can have two Entry windows, one for each VFO (SO2V) or for each radio 
(SO2R). Select these, and SO1R, in the Configurer.  

The master Entry window, which is always open, is linked to VFO-A or radio 1.  
The second Entry window is linked to VFO-B (SO2V) or radio 2(SO2R). The second 
Entry window is automatically opened when SO2V or SO2R is selected. If it is closed for 
any reason, it can be reopened by typing "\" (backslash) anywhere in any of the 
Logger+'s active windows, except for the Telnet window.  

If two Entry windows take up too much screen space, you can right-click on either 
window and reduce its size by omitting lines of content, such as the row of Action 
buttons. you'll note that in the VFO-B example below, some lines have been omitted. 
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You can also position the second Entry window over the first Entry window. Typing "\" 
(as above) will bring the one that has been hidden to the front, with Entry focus.  

The Entry Window examples below reflect a typical setup: VFO-A is now assigned to 
running, and VFO(B) is assigned to S&P.  

 

All of the Entry window features that are available to the single radio operator also work 
in SO2R/SO2V. For example, when tuning the band with the S&P VFO, spots that are in 
the bandmap are automatically inserted into the relevant call-frame (above the Call-sign 
textbox) when you tune across the frequency of the spot. Hitting the space bar (or 
Enter, in ESM) will pull the call-sign from the call-frame into the Call-sign textbox. Then 
if a station calls you on the run radio, toggling back and forth between Entry Windows 
with the \ key will keep the information in each Entry Window until the respective 
stations are logged.  



The second Entry window will be opened when a call is clicked in the second bandmap, 
if it is not already open.  

More SO2R info can be found in the SO2R chapter.  

× 

 Tip 

In SO2V (one radio - two VFOs = 'normal' operation) QSOs made on VFO-A have to be 
entered in the standard (first) Entry window. Making a QSO on VFO-B (transmitting and 
receiving on VFO-B) has to be done by using the second (VFO) Entry window. So when 
using both bandmaps, both Entry windows are needed to make QSOs on both VFOs. 
However, when operating split, the program transmits on VFO-A, and only the master 
Entry window needs to be open. If both are open in SO2V the second entry window 
displays the receive frequency  

3. Call-sign Colors 

There are two places where a call-sign can be shown in the Entry window , in the Call-
sign field and in the Call-frame. The default colors for the call-sign text are consistent 
with other places throughout (such as the Band Panel and Available Mults and Qs 
windows), and are described below:  

Red 
Single Multiplier Example: CQWW - qso is either zone or country multiplier 
(one multipliers)  

Green 
Double or better Multiplier Example: CQWW - qso is a zone and a country 
multiplier (two multipliers)  

Blue New contact  

Gray 
Dupe contact or an unworkable station in a non-workable country. This 
means that you don't need this station because he is a dupe or you are not even 
'allowed' to work him in this contest according the contest rules. 

Alternative colors may be used by specifying them in the Manage Skins, Colors and 
Fonts window, reached from the Config menu.  

4. Other Features 

 Clicking on the Exchange textbox will have the same effect as pressing Space 
when the cursor is in the call-sign textbox.  

 The frequency, emission mode (e.g. CW, USB) and radio name are shown on 
the Entry window title bar.  

 When tuning the band, if a station on the Bandmap is within the tuning tolerance, 
its call will be placed in the Entry window's call-frame. When the call-sign textbox 
is empty, pressing the space bar will copy the call-sign from the call-frame to the 
call-sign textbox.  

 Ctrl+P - Spot the station entered in the call-sign field to the active Telnet cluster, 
if any. You will be prompted for a comment. If no station is entered in the call-
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sign field, the last logged station this session will be spotted. Macros are 
accepted in the comment sen  

 Alt+R - Toggles Repeat CQ. You can stop repeat CQing by beginning to enter a 
call-sign, or by hitting Escape. After you complete manual input, if you press F1, 
Repeat CQ will resume. Press Alt+R again to exit this mode.  

o Ctrl+R sets the period of repeat in seconds or milliseconds.  
 A 'R' will be shown in the red TX status LED when repeat mode is 

on.  
o The repeat timer for CW and SSB is for the interval from when you stop 

sending CQ until CQ resumes.  
 Repeat CQ is not available when using an external DVK, because 

there is no indication of when a message has ended.  
o When using a radio with internal voice message memories, the repeat 

timer can be used together with a CAT macro in the relevant• function 
key. Note: The repeat timer in this case starts when the radio command is 
sent to the radio. Users that use this function to trigger radio voice keyers 
must assign the radio command to abort the message to a separate 
function key, as Escape will not stop it.  

 Ctrl+Shift+Fx - Record SSB message for the assigned function key. Pressing 
Ctrl+Shift+Fx again stops the recording. Fx can be F1 to F12, either Run or S&P 
mode.  

 Ctrl+Alt+Fx - Record external DVK memory 1 to 4. Fx can be F1 to F4. An 
external DVK has to be connected and configured on an LPT port.  

 Enter sends messages - An entire normal contact can be completed with the 
Enter key. More information is given in the Using Stored Messages chapter 
under ESM (Enter Sends Messages)  

Ctrl+Q - enters Quick Edit mode. When you are in QuickEdit mode, the background of 
the Entry window textboxes are colored light blue. "QuickEdit" is also shown in the 
callframe.  

o There is no check of the exchange against the contest rules, as is done 
when the QSO is entered normally. So check thoroughly what you 
change.  

 If you have multiple filters or a crystal filter and DSP, Alt+' (Alt+single quote) 
toggles between a wide and narrow filter for the selected mode (SSB, CW or 
Digital). This hot-key will work whether you have changed your filter codes or not. 
Filter codes can be set in the the bandmap right click menu.  

 A warning message will be shown if user tunes away before logging a qso in the 
Entry window.  

 Force logging - The program tries to help you by validating what you copy as 
the Exchange, but if it is balking and you don;'t want to stop to figure it out, you 
can force logging with Ctrl+Alt+Enter. A small Note window will pop up, pre-filled 
with the words "Forced QSO". You can type over to remind yourself later what 
you copied, or simply hit Enter to log the default note.  
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5. Function Keys 

5.1. General 

Function keys F1-F12 are used for sending stored messages. The use of stored 
messages is covered in detail in another section. This section deals with the generic 
behavior of the Function keys.  

The Function keys can be stacked. This means you can press several Function keys in 
close succession, and the contents will be sent in full in the selected order, with a space 
between. For example, you could press F4 to re-send your call (if you think the other 
station did not get it right) and immediately press F2 to send the exchange. The 
program will send the two messages seamlessly.  

When hovering with the mouse over a Function key button the text to be sent is shown.  

5.2. Run mode and S+P mode 

If the Run radio button is selected, you will see the Run messages, and vice versa. 
Pressing Shift and a Function key sends the message stored in that key in the 
opposite mode (Run if S&P, and vice versa)  

When you press Shift alone, the labels will change to those from the other mode (if 
different). This will help you decide if you want to send one of those messages by 
holding the Shift and pressing a Function key.  

When you call CQ on a frequency, the marker CQ-Frequency is placed at that 
frequency on the Bandmap. Thereafter, if you are in S&P mode and you tune within the 
tuning tolerance of the marker, the program will switch automatically to Run mode. 
Clicking on the 'CQ-frequency' in the Bandmap also will place the program in Run mode 
again.  

Note that when in Search and Pounce mode, you can switch to Run mode by pressing 
F1 to send what is called the S&P CQ message. That will send the S&P F1 message 
(for example, "QRL?") and switch the program to Run mode.  

× 

  

Alt + F11 - Normally when you are on your CQ-frequency you will be in Run mode and 
QSYing will switch to S&P mode. Press Alt+F11 to disable this automatic mode change, 
and again to re-enable it. A message in the Entry window status bar will indicate what 
the current state is. When on a DXpedition this behavior can be very useful. 

6. File Menu Selections 
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 New log in database - Create a new contest log in the current database. More 
info here.  

 Open log in database - Open an existing log in the current database. More info 
here.  

 New Database - Create a new log database. Change the proposed name 
(ham.s3db) into a meaningful name for the use or contents of this new database. 
Until you change to another database (see Open Database below), this database 
will be opened by default at startup of the program.  

 Open Database - Open an existing log database. Select from databases already 
created.  

 Convert N1MM Database to N1MM+ - This option is intended for use after you 
install N1MM+ but before you delete NLClassic from your computer. Because 
N1MM+ uses SQLite, in order to access an old database (.mdb file) you need to 
do two things. First, open it in NLClassic (any version 14.0.0 or after). Then 
close it, select Convert...(this option)in NL+, and navigate to your N1MMClassic 
program directory. Select the database you want to convert, and hit Open. You 
will be asked for the name you want to give it under N1MM+, and when you hit 
Enter the database will be converted and placed in the [user]\My 
Documents\N1MM Logger+\Databases subfolder.  
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 Copy This Contest to Another Database - Copy the current contest log to 
another database. If the target database does not exist, you should create it first, 
using the New Database command. The original database is not changed, nor 
does the program start using the new database unless Open Database is 
subsequently used to open it.  

× 

 Why Copy A Contest to Another Database? 

There are many reasons why you might want to copy contests from one database to 
another. Many users have created databases organized by year, by contest type, and 
so on. This option makes that easy.  
Some users, particularly those whose CPU or PC memory capacity is limited, have 
found that they get improved program performance by using a database that has only 
one contest (or relatively few QSOs) in it. If you start off using a database with many 
contests already in it, you can always create a new database and then copy the QSOs 
you have already made to it.  

 Generate Cabrillo File - Invites you to name your Cabrillo file for the current 
contest, double-checks your sent exchange, creates the file, and opens it in 
Notepad for you to check before you send it in.  

 
Once created, the Cabrillo file can be edited using Notepad or any text editor. Make 
sure that the Station information (Config > Change Your Station Data) and Contest 
Setup (File > Open Log in Database) are correct before creating this file. Be sure to 
enter the correct Sent Exchange in the Contest Setup dialog, or else your Cabrillo file 
will be wrong.  

Double-check your entry class before generating the Cabrillo file. The defaults may well 
not be appropriate for your entry in this particular contest. The program defaults to 
Single Op Assisted as your class, and you may not want that. For Multi-op stations 
select the correct Operator Category in the Contest Setup window. This generates the 
correct numbers for each station; in Multi-single, the station number field (the last digit in 
each line) identifies the Mult and Run station.  

It is a good idea to rescore the contest (Tools>Rescore Current Contest) before 
submitting and check to be sure that the header of the Cabrillo file is correct before 
submitting the log. Some contest organizers use non-standard operator categories (i.e. 
not in the official Cabrillo specification); in these contests you will have to edit the 
category by hand to make it agree with the organizer's requirements.  

× 

 Digital Mode Designators 

Note: The Cabrillo standard only supports one mode designator for digital modes: RY. 
In some digital or mixed-mode contests, PSK and RTTY may be considered separate 
modes, and the contest organizers may specify additional non-standard designators 



such as PK. The Logger's Cabrillo mode export string for PSK is "PK" unless the 
contest considers RTTY and PSK to be a single digital mode. When this occurs the 
mode export string is "RY". Because the use of these mode designators is non-
standard, you should always check with the organizer's file specification and if 
necessary, edit the Cabrillo file to meet the organizer's requirements. 

6.1. Import 

 

=**Import ADIF from file... - Load the data from an ADIF file into the current database. 
The Contest Name in the ADIF file must match the contest name in the current 
database.  

A single N1MM Logger+ log database can not contain QSO's with identical time 
stamps (time and date). If the contacts contained in the ADIF already exist in the 
current database, YOU MUSTopen a new database and contest before importing 
the ADIF file.  

If the ADIF file contains tags that are not used by the N1MM Logger+ program, they are 
ignored. This is often the case when the ADIF file is generated by a different program. 
To view the N1MM Logger+ ADIF tags open a contest of the same type, log one or 
more dummy QSO(s), then export the ADIF file. Compare the Contest Name and QSO 
tags for the important QSO elements. See the FAQ on ADIF files for more information.  

o Import Call History... - Call history files (typically with the extension .ch or 
.txt) are used to suggest exchange elements based on past experience 
with the current station. See this full explanation  

o Import State and Province Abbreviations... - Import the state and 
province abbreviations used in many contest modules. This is done 
automatically when changing databases, but may be worth trying if you 
have trouble in a contest (particularly a QSO Party) with the program not 
recognizing certain county, state or province abbreviations. Do a rescore 
after executing this menu item, when QSOs have already been logged.  

o Recover QSOs from a Transaction Log... - Import the created 
transaction log (also known as a transaction file). This file is created 
automatically and stored in the Databases\TransactionLogFiles sub-
directory within the N1MM Logger+ User files area and have the filename 
suffix TRN. These files are used as follows: During normal operation 
N1MM Logger+ saves the information about each QSO in a simple text 
file. These files are stored in a sub-folder in the Databases folder in the 
user files area and can be used to recover in the event the database file is 
corrupted. Here's an explanation of how you can use those files to recover 
your data quickly, during a contest, or at your leisure later:  
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 The transaction log is created for each contest you log to  
 The file is closed after each transaction and reopened to force the 

data to be written to disk  
 To keep things simple and foolproof, you are not allowed to change 

the name of the transaction log  
 The name is used to make sure you are loading it properly, and to 

prevent mixing logs of two contests. Example name: 'CQWWCW - 
2005-09-19 - 14.TRN' i.e.: Contest name - date log created - an 
internal index number  

 To Recover your log, you MUST import the transaction log into 
a NEW (empty) database and a NEW contest log. See this link.  

 The new contest log must be the same contest type as the contest 
from the transaction file (Example: if restoring CQWPXCW, the new 
contest must also be CQWPXCW)  

 As you load the transaction log, a new transaction log is 
automatically made with the transactions in the first log. Thus you 
should never have to merge logs. You always use the last one  

6.2. Export 

 

× 

 Filename Tip 

Whenever the "Save File" window prompts for a filename, the default is your call-sign.txt 
(the cal-lsign comes from the Station Information dialog). "/" and some other common 
characters are not accepted by Windows, so if your contest call sign was N1MM/P, use 
something like "N1MM_P.txt" instead. 

6.2.1. ADIF Export Sub-menu 

 

 Export ADIF to file... - Create an ADIF file. This file can be used to 
export the current contest, for import into a logging program or 
another contest program (horrors!). Deleted QSOs are not 
exported; select the 'DELETEDQS' contest to export these.  
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 Export ADIF to file by date... - Create an ADIF file from the 
currently-selected contest, starting from the date set. The first time 
you use this function the default date will be 1900-01-01 (yyyy-mm-
dd). The second time the suggested date and time will be the last 
time you exported with this option. You can always over-write the 
date/time if you want. This function is especially useful when you 
want to export into a (general) logging program to do award 
tracking etc.  

 
Deleted QSOs are not exported; select the 'DELETEDQS' contest to export these.  

 

 Export ADIF to file by date from ALL contests... - Create an 
ADIF file from all QSOs in all contests starting from the date set. 
The first time you use this function the default date will be 1900-01-
01 (yyyy-mm-dd). The second time the suggested date and time 
will be the last time you exported with this option. You can always 
over-write the date/time if you want. This function is especially 
useful when you want to export into a (general) logging program to 
do award tracking etc.  

 
Deleted QSOs are not exported; select the 'DELETEDQS' contest to export these.  

 Export ADIF to file by Multi-User Station Name - Create an ADIF 
file from all QSOs from one station in a Multi User environment 
when you are currently logging DX. Otherwise, it exports only from 
the contest you are logging in. A station name has to be supplied 
from the Network Status window, after which you will be asked for a 
filename.  

 
Note: When using ADIF export and the contest name contains "RTTY" or "JARTS" the 
export mode is set to "RTTY" even when the log file shows otherwise (i.e. LSB).  

o Export to File (Generic)  
 Export to File (Generic), order by QSO Time (normal)... - 

Creates a generic file named call-sign.txt from the contest log 

http://n1mmplus.hamdocs.com/tiki-index.php?page=Network+Status+Window


ordered by time (and not by band). In some cases this will be the 
file requested by the contest manager. This file can also be used to 
import into a spreadsheet or database program, or your logging 
program if it can't import ADIF format. The exported file can be 
edited with a text editor like Notepad.  

 Export to File (Generic), order by Band... - Creates a generic file 
named call-sign.txt from the contest log ordered by band, per band 
ordered by time. In some cases this is the file requested by the 
contest manager, for example in VHF and up contests.  

o Export EDI to file by band... - Create an EDI (REG1TEST) file. This is a 
regular file format used for VHF contests in Europe. A separate file will be 
created for each band with QSOs made on it.  

o Print Score Summary to File... - Print the contents of the Score 
Summary window to a text file with the default name call-sign.SUM 
Example: N1MM.SUM. This can also be done by right-clicking the Score 
Summary window.  

o Export Call History... - Exports the information in the Call History 
database table. This table can only be filled or revised by using Import Call 
History. Do your editing on the Call History text file before import.  

o Export Function Keys to file - Export the contents of the function keys to 
file (*.mc). Exported function key definitions can be imported using the 
Function Key Editor  

 SSB Function Keys... - Export the SSB function keys.  
 CW Function Keys... - Export the CW function keys.  
 Digital Function Keys... - Export the Digital function keys (the 

Entry window keys, not the extra keys from the Digital Interface).  

6.3. Contest List 

At the bottom of the File Menu is a list of the last 9 contests you have had open, along 
with the databases they are contained in. This provides a very convenient way to switch 
between contests when you want to participate in more than one simultaneously. You 
can open the File menu and use your mouse to select the contest you want to work 
next, or you can hit Alt+F, which opens the File menu, and then hit the number (1-9) 
corresponding with the contest you want.  

The contest you currently have open will always be numbered "1", and the next 
previous will be numbered "2", so if you want to toggle between just two contests, all 
you need to do is set them up and then Hit Alt+F, then 2, to jump back and forth.  

7. Edit Menu Selections 
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 Wipe Out Entry Fields Ctrl+W - Clear information from the current contact 
(equal to Alt+W).  

 Edit Last Contact Ctrl+Y - Open a dialog to allow all fields for the last contact in 
the log to be modified.  

 Add a Note to Last/Current Contact Ctrl+N - Add a note to the current contact 
in the Entry window, or the last QSO logged when no call-sign is shown in the 
Entry window.  

 Edit Current Contact - Open a dialog to allow all fields for the current contact 
(still in the Entry window) to be modified. Double clicking in the Log window on a 
field with user-supplied data will open in-line editing of that particular item. See 
the Log Window below for more details on this.  

 Quick Edit - Quickly edit QSOs already in the log. If the text boxes in the Entry 
window are colored blue, you are in Quick Edit mode. Quick Edit (Ctrl+Q) 
always starts with the last QSO in the log. The call-sign and any exchange 
elements are displayed in the Entry window, with the legend "QuickEdit" in the 
call-frame. Correct any errors and hit Enter, or hit Esc to exit quick Edit mode. 
Once you are in Quick Edit mode, hitting Ctrl+A moves forward one QSO, while 
hitting Ctrl+Q moves backward (in time) one QSO.  

 Quick Edit Previous Contacts (Forward) Ctrl+A- Quickly edit the QSOs 
worked before in the log. Ctrl+Q moves back one QSO, Ctrl+A moves forward 
one QSO.  

 Increase Received NR by 1 Ctrl+U - Increase the number in the exchange field 
by 1. You will find this useful during serial number contests when you are in a 
pileup and you need to keep incrementing the DX station's serial number 
because you can't get him in the log...  

 Find/Find Again Ctrl+F - Find the call-sign entered in the call-sign field in the 
log. Pressing Ctrl+F again will find the next instance.  

8. View Menu Selections 



 

in-edit some obsolete or cluster-specific commands in lower section  

 Max Rates - Shows the best 1-minute, 10-minute and 60-minute rates achieved 
in the current contest. File > Copy these messages to the Clipboard is self-
explanatory, and appears for all of the View functions below..  

 Off Times - Shows off times. Lists each off period that complies with the contest 
rules, or each off-time of 30 minutes or more if the contest rules do not specify. 
Each off period shows when it began and ended, and the duration. Total on and 
off time is also given. Time between the start of the contest and the first logged 
QSO is counted as off time, as is time between the last QSO and the end of the 
contest.  

 Runs - Shows all runs. The program counts consecutive QSOs in run mode until 
an S&P QSO or band change. Off times do not break a run if you resume in Run 
mode on the same band.  

 Notes - displays all contacts with notes.  
 Statistics - Show statistics for the selected contest. Many choices available. See 

the Statistics Window section.  

× 

 Note 

All greyed-out 'Show' items below become active when valid call-sign information is 
entered in the call-sign textbox or the call-frame. Some formats may not be compatible 
with all current cluster command sets 

http://n1mmplus.hamdocs.com/tiki-index.php?page=Statistics+Window


 Show Last 10 Spots - Show the last 10 DX cluster spots for the call in the call-
sign field or call-frame. Telnet cluster connection required. Format may not be 
compatible with some cluster nodes.  

 Show Station - Show the station information for the call in the call-sign field or 
call-frame. Telnet cluster connection required  

 Show QSL/Telnet - Show the QSL information for the call in the call-sign field or 
call-frame. Telnet cluster connection required.  

 Show Sunrise/Sunset - Show the Sunrise/Sunset information for the call in the 
call-sign field or call-frame. Telnet cluster connection required.  

 SH/DX Current Call or Spot - Shows DX information from the current call in the 
call-sign field or spot. Telnet cluster connection required.  

 Show QRZ (Internet) - Show the information that QRZ.com has for this call 
using your browser. An Internet connection is required. present.  

 Show Google (Internet) - Show the information that Google.com has for this call 
using your browser. An Internet connection is required.  

 Show ? on Unmatched Calls - When the Check window is open and a call-sign 
is entered in the call-sign textbox, a "?" will appear following the call-sign if no 
matching call-sign was found in the Check window's sources. Uncheck the option 
if you do not wish this to happen.  

9. Tools Menu Selections 



 

 Rescore Current Contest - Rescores the current contest. This is required 
before submitting a log if anything has changed, such as a cty.dat or .sec file, or 
if you have edited any QSOs. It rechecks QSO points and multipliers and makes 
any corrections needed  

 Rescore last N Hours - Rescores the last N hours for the current contest. It may 
be run at any time but is rather slow.  

 Download and Install Latest Check Partial file (Master.scp)(Internet) - Opens 
your web browser to download the latest version of the check partial file. Select 
the file to download and save it in the Support Files subfolder of the N1MM 
Logger+ folder, under [user]\My Documents.  

 Toggle Tune (CW mode) Ctrl+T - Switches the radio into CW mode and using 
the CW keying interface, keys the transmitter. PTT is asserted. To stop tuning, 
press the Esc key or Ctrl+T again. After tuning ends and PTT is released, the 
radio returns to the original mode.  

 __Download latest N1MM Logger+ pdf manual (Internet)  
 Download and install latest country file (wl_cty.dat)(Internet) - Downloads 

and installs the latest wl_cty.dat file in the correct location (Internet connection 
required).  

 Import country list from downloaded file (Internet) - This option is retained for 
contests that use a non-standard cty.dat file that is not on the standard country 
file website.  



 Add call to country - Specify a country for the call-sign in the call-sign textbox in 
the Entry window. If no call-sign is entered this menu item will be grayed out. 
This is a quick way during the heat of a contest to add a country temporarily, until 
the next time you import wl_cty.dat. Making changes permanent requires editing 
the country file (wl_cty.dat) to be imported.  

 Tune to beacon for this band (20-10M) - This will change the radio's mode to 
CW and tune to the NCDXF beacon on the current band, if that band is 20, 15 or 
10 meters. The station currently transmitting and the power steps are displayed 
in the status bar of the Entry window that has the Entry focus (green LED). Short 
Path and Long Path bearings to the beacon are shown. See this website for 
current information on the beacon program .  

 Update Call History with Current Log - Update the current call history table in 
the Admin database with the QSOs from the current log file. Information 
associated with a call-sign will be added, or updated if already in the call history 
table. For VHF contest, in particular, where two Maidenhead grid fields are 
provided, the behavior is a bit different. When both grid fields are filled and a 
new, third grid has been logged, the oldest grid will be removed, and replaced by 
the grid from the first field. The new grid will be added in the first position. The 
same change in position will happen when only the first grid field is filled and a 
new grid is added from the log. A 4-digit grid will be overwritten by a 6-digit grid 
when the first 4 characters are the same, adding precision to the entry.  

 Clear Call History then Update with Current Log - As above, except clears the 
call history table before adding contacts from the current log. Can be used to 
start a new call history file.  

× 

 Saving an Updated Call History file 

After you have done this, the modified Call History table is only in the Admin database. 
To get it into a Call History text file, you must export the table to a file. Do this on the 
File menu, under Export>Export Call history.  
 
If you want to have a specific Call History Lookup file loaded and enabled whenever you 
start that contest, you need to add the short contest name (the one in the Contest Setup 
dialog) to the Call History text file as a comment (preceded by a "#". You can even have 
it loaded and used for more than one contest, by putting in multiple contest names. 
Example (omit the quotation marks):  

"#NAQPCW"  
"#NAQPSSB"  

For QSO parties, the state abbreviation is required after the contest name. Example:  

"#QSOParty PA" 

 Turn Rotor Alt+J - Turn rotor to bearing for the call-sign in the Entry window or 
to the call-sign in the callframe (when call-sign field is empty).  

o Alt+L will turn the beam to the proper bearing for long path  

http://www.ncdxf.org/Beacon/BeaconSchedule.html
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 Stop Rotor Ctrl+Alt+J - Stop turning the rotator.  
 Telnet Window Tools - Opens the Filters tab of the Packet Window.  
 Program Execution Logging (Diagnostics folder) - There are several different 

logging options, all of which export to the Diagnostics folder, and may prove 
useful to the developers in tracking down performance and other problems. We 
recommend that you click Disable All on the sub-menu unless you are 
encountering serious delays or other execution anomalies.  

 Save Window Positions - Save the current window positions to the .ini file.  
o Window positions are automatically saved when the program is closed.  
o Window positions are saved per operator. Use Ctrl+O to enter the call of 

the operator, and click ''Save Window Positions'. The next time that 
operator signs on (using Ctrl+O), the window setup will be adjusted to the 
saved layout.  

 Restore Window Positions - Restore from the .ini file the most recent saved 
window positions. The screen will update immediately  

o Window positions are restored per operator (when saved first by the 
operator). Use Ctrl+O to select Operator and press 'Restore Window 
Positions'. The windows will change to their new positions immediately. 
This enables easy reconfiguration of the screen when changing operators 
at a multi-op.  

 Check for New Program Version and Install - Useful if you have elected not to 
install a new version when the chance was automatically offered, and now want 
to remedy your "grievous error."  

× 

 Note 

More info about rotator control can be found in the Supported Hardware chapter under 
Rotator control 

10. Config Menu Selections 

http://n1mmplus.hamdocs.com/tiki-index.php?page=Rotator+Control&structure=N1MM+Logger+Documentation


 

Many of the selections after the Configurer can also be invoked in other ways, such as 
hot-keys or from other windows.  

10.1. Configure Ports, Mode Control, Audio, Other - Also called Configurer. 

This a very important dialog which determines many aspects of the program's external 
interfaces and operation. Go here for detailed documentation of this dialog.  

10.2. Change Your Station Data 

Modify overall Station information - name, call, address, state, latitude, longitude, etc. 
The call-sign and location information entered here is very important for most contests, 
It determines what country, state or province you are in, which may in turn affect the 
required exchange, scoring, which stations may be worked for contest credit, etc. See 
this section for more discussion.  

http://n1mmplus.hamdocs.com/tiki-index.php?page=Configurer
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10.3. Logger+ Audio Setup 

This menu item only appears when the following menu item has been checked. For 
users with Windows Vista or later operating systems, this is where you set up your 
audio options for the new Logger+ Audio functions, including playback and on-the-fly 
recording of stored voice messages. If you are running Windows XP, you will not see 
this option. If you check the next option below, Use Logger+ Audio, then the Audio tab 
will not be present the next time you open the Configurer.  

10.3.1. The Monitor tab 

This tab opens whenever you open the Logger+ Audio Setup  

 

The left-hand slider ("Set") sets the output level going to your radio. You will want to set 
this so that your radio indicates the correct microphone level and amount of 
compression. When playing a .wav file, the narrow "Wav" bar-graph displays the relative 
level of the peaks of the recording being played. The wide "Output" bargraph displays 
the peaks of the output going to your radio. The two are independent; if the Wav file 
bargraph shows relatively low peaks, you may want to re-record it to improve the signal-
to-noise ratio.  

 
The right-hand slider sets the record level for "on-the-fly" recording, and the narrow 
bargraph just to its right displays the relative sound level that is being recorded.  

When you close N1MM+, the soundcard(s) output level(s) and microphone 
input(s) levels are returned to the previous settings.  

The "Test" button will play a pre-recorded message, so that you can test your playback 
setup without having to record something first.  

The lower pane of this tab reports each stored message that is sent, which can be 
helpful for debugging.  

10.3.2. The Playback tab 



 
In the first options box, the first choice uses a single soundcard for SO1V/SO2V. The 
other 3 are all for SO2R - Single Soundcard Mono (where an external controller is used 
to route the audio between radios), SO2R Single Soundcard L/R (using one channel for 
each radio), and SO2R Two Soundcards Mono, where each soundcard is connected to 
one radio.  

In the second options box, select the Playback device that will feed audio to your radio. 
The set of possibilities displayed is dependent on your specific computer configuration.  

A growing number of radios have internal "sound cards", called CODECS. If you have 
one of these and wish to use it as the sound card for that radio, check the box. Of 
course, you cannot use a single radio CODEC for more than its own radios, so the first 
option needs to be set to match.  

The lower pane of this tab shows interactions between N1MM+ and windows audio 
functions.  

10.3.3. The Message Recording Tab 



 

This tab will vary with your choices on the Playback tab. If you choose two-soundcard 
SO2R you will need to choose inputs for each card to enable on-the-fly re-recording of 
stored messages  

The Sample Rate options are 8000 and 12000, and are set here for on-the-fly recording 
only.  

The lower pane will report the beginning and end of each on-the-fly recording event.  

Your microphone will be muted during playback if you check that option.  

10.4. Use Logger+ Audio 

Activates the audio setup in the selection just above, and deactivates the audio tab in 
the Configurer, if your PC is running Windows 7 or later. If you are running Windows 
XP, neither this option nor the configuration menu above will appear on your screen.  

10.5. Enter Sends Message (ESM mode) 

Ctrl+M toggles this mode on and off - first introduced by N6TR in TRLog, and much 
improved in N1MM Logger. The program anticipates the needed sequence of messages 
to complete a QSO in either Run or Search & Pounce mode, and sends each one in 
turn by simply hitting Enter. See ESM for further details.  

10.6. Spot all S&P QSOs 

Spot the contact when you log it. This option is turned off by default when starting the 
program, to avoid spotting everything you work unless you want to.  

If this option is checked, a contact is automatically spotted when:  

 You complete the QSO in S&P mode and  
 the spot is not already on your Bandmap at the same frequency (+/- the tuning 

tolerance)  

http://n1mmplus.hamdocs.com/tiki-index.php?page=ESM+-+Enter+Sends+Message


The Spot Comment tab on the Telnet window allows the user to specify a comment for 
spots, including elements of the log entry for the spotted call, such as Zone or 
Exchange.  

10.7. QSYing wipes the call & spots QSO in bandmap 

Very useful for S&P. If you enter a station's call in the Entry window, and then tune off 
for any reason (he doesn't answer your call, or...) the call is shown bold in the bandmap. 
These 'spots' are not sent out on Telnet. The setting of this feature remains as it was 
across program restarts.  

All bandmap features work on these 'spotted' stations so they are easy accessible if 
needed. Self-spotted stations are easily recognized because they are shown in bold.  

This option is also available on the Filters tab of the Telnet window.  

10.8. Grab Focus From Other Apps When Radio Is Tuned 

Brings N1MM+ to the front over any other app when you tune a radio that is interfaced 
with the program.  

10.9. Do not automatically switch to Run on CQ-frequency 

When selected and you QSY back to an old Run frequency, the mode stays in S&P. F1 
and Alt+Q continue to switch to Run mode. This is most useful in Sprint-like contests, 
where you QSY frequently and want to avoid unexpected switches to Run mode  

10.10. Show Non-workable Spots and Dupes in Bandmap 

This option is also found on the Filters tab of the Telnet window. When checked, this 
option displays all previously worked (dupe) call-signs, as well as stations that don't 
count in the current contest, in grey on the bandmap. When navigation the bandmap 
with hot-keys (Ctrl+Up/Dn, for example), grey calls are ignored. Its use is highly 
recommended to avoid wasting time on non-workable stations when S&P, even if 
operating unassisted.  

10.11. Reset Rx freq to TX when QSO is logged (RUN and split) 

When using the main VFO to transmit and the other to receive (split mode) after each 
logged QSO the RX frequency will be made equal to the TX (main VFO) frequency. It 
resets after every RUNNING QSO. Using a radio with VFOs A and B, this feature is 
there to let you use the main frequency control as an RIT. With Main/Sub radios like the 
Icom 756/7800 series you can not RX on SUB without receiving on both VFOs. In this 
case put RX on Main and TX on SUB for Alt+S to work.  

10.12. Sub Receiver Always On 

Yaesu FT-1000 series, Icom IC-756 series, IC-781, IC-775, IC-7800, Elecraft K3 with 
subRX only: Selects the mode for Dual Receive toggle (Alt+F12).  

 When selected -  
o Yaesu FT-1000 series: The sub receiver will be left on (blinking green RX 

led)  



o Icom IC-756 series, IC-781, IC-775 and IC-7800 only: Dual watch is not 
turned off when you switch from SUB to Main with Ctrl+Left Arrow or 
PAUSE  

o Elecraft K3: The sub receiver will be left on  
 Not selected - The sub receiver will switched off (RX led off)  

CQ Repeat - Alt+R 

Toggle for repeat CQing. With Winkeyer, beginning to enter a call-sign in the Entry 
Window terminates the CQ, but the program remains in CQ repeat mode. The function 
is automatically turned off when no longer on the CQ-frequency and the mode changed 
to S&P.  

10.13. Set CQ repeat time - Ctrl+R 

Specify the repeat interval (CW or SSB with sound card) in seconds. The default value 
is 1.8 seconds.  

10.14. CW AutoSend Threshold - Ctrl+Shift+M 

Start sending the call-sign after a certain number of characters typed AFTER the last 
number in the call-sign. The minimum threshold is 1. 0 will turn off the feature. Only 
works when in RUN mode, not in S&P. More info in the Logging Key Assignments 
section.  

10.15. Enable Call History Lookup 

When enabled, Call History Lookup can be used to pre-fill the exchange during a 
contest to save typing, or to display user comments or notes for specific call-signs. 
Reverse Call History Lookup uses the same Call History file to find stations whose 
exchanges fit what you have entered in the Exchange field. It is enabled by the same 
Config menu entry. Follow the links above for the full story.  

10.16. Change CW/SSB/Digital Message Buttons - Alt+K 

Change the contents of the CW/SSB/Digital Function Key messages). The maximum 
length of text in each CW, SSB and RTTY button is 255 characters. Alt+K will access 
the relevant list of definitions, depending on the mode you are in, or you can right-click 
in the button area to get there. See the discussion of the Function Key Editor here.  

 Change CW Function Key Definitions - Change the contents of the CW 
messages.  

 Change SSB Function Key Definitions - Change the contents of the SSB 
messages (.wav files).  

 Change Digital Function Key Definitions - Change the contents of the Digital 
messages.  

10.17. Change Band Plan 

 
The sub-menu offers the choice of CW or digital bandplan tables which can be edited 
and saved. You can only designate one CW and one digital band segment per band.  
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By definition, digital segments override cw segments, and both override SSB segments. 
That means that unless a band segment is designated for CW or digital modes, it will be 
shown as SSB.  

For example, on 40 meters, you can enter a CW segment of 700-7100 KHz, and a 
digital segment of 7040-7050. The resulting bandmap markings will look like this:  

 

× 

 Changes in Band Plan Management 

N1MM Logger+ has adopted a new approach to designating and displaying CW, digital 
and SSB band plans. You can now adjust the sub-bands that are displayed for any 
individual band through right-clicking on frequency labels (e.g. "7045") in the relevant 
Bandmap. See this link for details.  

10.18. Manage Skins, Colors and Fonts 

See the Skins, Colors and Fonts Window.  

10.19. Change Operator Call-sign Stored in Log (Ctrl+O) 

This function is used mostly in multi-operator situations, to change the operator callsign 
stored in the log and to call up a preferred window configuration when a new operator 
takes over.  

10.20. Change Exchange Abbreviations 

http://n1mmplus.hamdocs.com/tiki-index.php?page=Bandmap+Window#Display_and_Adjustment_of_Band_Plans_in_Background_of_Bandmap_Frequency_Scale
http://n1mmplus.hamdocs.com/tiki-index.php?page=Skins+Colors+and+Fonts+Window


The idea here is to hedge against having people send you abbreviations during contest 
that are not the same as those recognized by the contest organizers. We've all had 
people send us "ALA" when they meant "AL" or ALTA when they meant "AB". The 
problem is particularly bad in QSO parties. Put the non-standard abbreviation in the 
"Abbreviation" column, with the correct one in the Section Column. Click on the Section 
heading to sort by the standard abbreviation, so you can see various alternatives that 
you have entered.  

10.21. SO2R 

Much more info about Single Operator Two Radio operation of the program can be 
found in the SO2R chapter.  

 Dueling CQ's - Ctrl+B - SO2R feature that alternates sending CQ on each radio 
in turn, listening on one while transmitting on the other. Supported for both CW 
and SSB.  

o Changing either radio in frequency more than 200 Hz will terminate 
Dueling CQ.  

 Set Dueling CQ Repeat Time - Adjusts time after CQ ends on one radio before 
it starts on the other. In seconds.  

 Focus on Other Radio - Ctrl+Shift+K - FocusOther, See FocusOther  
 FocusOther Always Swap - Focus always switches to the other radio when one 

radio is transmitting, and always switches back to the original radio when 
transmission is completed.  

 Toggle CTRLFx Macro - Ctrl+Shift+L - When enabled and present in one of the 
function key definitions, the {CTRLFx} macro executes Fx (Function key 
definition x) on the opposite radio. An example is TU{CTRLF1} in Radio 2's F3 
slot, which sends TU and then sends the other radio's F1, used to get quickly 
back to the Run radio and call CQ after finishing an S&P QSO on Radio 2.  

 TX Lockout (Digital) - Select a lockout option. Also MIXED mode category is 
supported i.e. blocks second TRX on the same band and mode. This doesn't 
prevent RX overload. For digital modes only  

× 

 There's No Substitute for A Hardware Lockout 

Software lockouts are inherently less reliable than hardware systems, because of the 
vagaries of networking, RFI, etc. We urge you not to rely solely on software lockouts to 
prevent rule violations or hardware damage. 

o Multi-TX - This is the default setting. Start CQ on radio A, next a CQ on 
radio B, both are active. (no lockout)  

o First one wins - Start CQ on radio A, pause, Start CQ on radio B. The 
radio B CQ is ignored since radio A is already active, so if you press a F-
key for the second radio while radio1 is transmitting, the radio B F-key is 
ignored.  

o Last one wins - Start CQ on radio A (CQ starts), pause, Start CQ on 
radio B. The CQ on radio A will aborted and the CQ on radio B will start so 
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if you press a F-key for the second radio while radio A is transmitting, the 
radio A transmission is interrupted and radio B transmits.  

10.22. WAE - Special commands for the WAE DX contest only 

 Toggle WAE QTC mode - Ctrl+Z - Toggle the WAE QTC mode between QSO 
and sending/receiving QTCs. See WAE contest setup instructions.  

 WAE Received QTC Confirmation - Enter the WAE confirmation string or .WAV 
file (CW/SSB only - RTTY messages are configured in the Digital Setup window)  

 Max QTC Number for call-sign colors in Band Map - opens a dialog box to 
allow you to set the number of QTCs to be used for displaying the special colors 
in the bandmap for stations with QTCs remaining  

 Ctrl-Z sends QTC? automatically (EU stations, Run mode only) - When this 
option is checked, pressing Ctrl+Z while in Run mode automatically sends QTC? 
and puts the program into QTC mode (CW only, EU stations only).  

10.23. Clear INI file settings 

Option to clear out the 'N1MM logger.ini' file. Generally, it will be preferable to rename 
the existing .ini file to something like N1MM Logger.old, so that you can retrieve your 
settings if you need them to re-configure.  

11. Window Menu Selections 
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 Available Mult's and Q's - Display the Available Mult's and Q's window. More 
info in the Available Mults and Qs Window chapter  

 Bandmap - Display the Bandmap window. In SO2R/SO2V each Entry window 
has its own Bandmap window. More info in the Bandmap Window chapter  

 Check - Display the Check window. More info in the Check Partial Window 
chapter  

 CW Key Ctrl+K - Display the CW Key window. Pressing Ctrl+K again or Enter 
will close the window but will continue sending the message. Pressing Escape 
will stop sending the message. The windows is multiline (for pasting in text) and 
can be resized. The font type and size is the same as used in the Entry Window  

 

 

 CW Reader - Display the CW Reader window.  
 Digital Interface - Display the Digital Interface window - see the Digital Modes 

chapter  
 Entry Window - Displays the Entry window  
 Gray Line - Opens the Grayline window. More info in the Grayline Window 

chapter.  
 Info - Display the Info window. More info in the Info Window chapter  
 Log Ctrl+L - Display the Log window (toggles between open and minimized). 

More info in the Log Window chapter  
 Multipliers - Click to display the Multipliers sub-menu  

o Countries - Country multipliers are displayed  
o Grid Squares - Grid square multipliers are displayed  
o Sections/states - Section or state multipliers are displayed  
o Zones - Zone multipliers are displayed  
o County/Other - County multipliers (or other multipliers in some contests) 

are displayed  
 Network Status - Display the network status window - see the Network Status 

Window chapter  
 Score Summary - Display the score summary window. More info in the Score 

Summary Window chapter  
 Telnet - Display the Telnet window. More info in the Telnet Window chapter  
 Visible Dupesheet - Display the Visible Dupesheet window. More info in the 

Visual Dupesheet Window chapter  

 
Ctrl+Tab can be used to rotate focus among open windows in a round-robin fashion.  

12. Help Menu Selections 
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 EntryWindow Specific Help - Shows the Entry Window sub-section of the 
Windows chapter of the Digging Deeper section of the on-line manual. Requires 
an active Internet connection  

 Manual Index - Shows the full index of the on-line manual. Requires an active 
Internet connection  

 Supported Contests & Setup - Shows the Supported Contests chapter of the 
on-line manual. Requires an active Internet connection  

 Key Assignments - Shows the Key Assignments list from the Digging Deeper 
section of the on-line manual. Requires an active Internet connection  

 Revision History & Latest Update Download - Shows the Latest Update 
section of the Files Menu on the web site. Requires an active Internet connection  

 N1MM Logger Manual (User installed *pdf required) - Read the manual off-
line. There is a link on the Tools menu that will download this file - be sure you 
download it into the Support Files folder in the N1MM Logger+ user files area. 
Requires Adobe Reader or another .pdf reader  

 Contest rules for this contest- Go to the web site from the contest sponsor on 
the Internet where the rules can be found. Requires an active Internet connection  

 WA7BNM Contest Calendar - Go to WA7BNM's contest calendar site on the 
Internet. Requires an active Internet connection  

 User Questions & Discussion Group - Go to the Yahoo Discussion Group 
page on the Internet. Requires an active Internet connection  

 Bug Report Form - Go to the form on the N1MM Logger web site. Please note, 
this is not the place to report difficulties such as installation or setup 
problems - far better to use the Yahoo group for that. Requires an active 
Internet connection  



 Feature Request Form - Go to the form on the N1MM Logger web site. 
Requires an active Internet connection  

 View Error Log - View the latest 'Errorlog.txt' file generated by the program. The 
program creates and updates the contents of this file when the program 
generates an error. This could be used to help pinpointing a problem in the 
program  

 Report Score to 3830- Go to the 3830 score reporting site on the Internet. 
Requires an active Internet connection  

 About Vx.yy.zzzz - Show the About Dialog  

 

2.6.2 The Log Window 

 2.6.2 The Log Window  

o 1. Editing the Log  
o 2. Marking Multipliers  
o 3. Serial Numbers  
o 4. Warning of Possible Errors  
o 5. Keyboard Shortcuts  
o 6. Right-click Menu  

Your Log window will be similar to this one.  

 

 The top pane is the log.  

 The bottom pane shows the contacts in your log that match the partial or full call 
entered in the Entry window. It is sorted by band, call, date & time.  



 The separator bar is set at a percentage of window size. When shrinking the 
window vertically, both sections get smaller. After resizing the window, decide 
how much space to allocate to dupes by setting the separator bar.  

 The title bar gives date and time (in UTC), the selected contest and the name of 
the current database.  

 To resize the text in the log, click on the resizer arrows at the upper right corner 
of the window.  

 There are options for modifying the width of individual columns, to be found on 
the Right-Click Menu (see below). You can also resize them by click-and-drag of 
the invisible dividers between the header items. This will not work in the log itself.  

 Click on the heading of any column to sort the log by that column. Click the 
header of the datestamp column ("MM-DD HH:MM") to return to normal log 
order.  

 When a Multi operator mode (Multi-One, Multi-Two, Multi-Multi) is selected, the 
"Op" and R# columns appear in the log, and the radio number and operator call-
sign are shown for each QSO.  

1. Editing the Log 

Double-click any user-entered field in a QSO record to edit it; type the correction and hit 
Enter to save it. This can be done in either the upper or lower panes of the Log 
window, to facilitate correcting earlier QSOs with a station when you need to.  

o Program generated fields, such as QSO points, cannot be edited.  
o If you want to edit the sent serial number in a QSO, you will note that 

up/down arrows are displayed, on the assumption that you probably are 
just off by one. Click the appropriate arrow and hit Enter, or type the 
correction if you need to.  

o If you want to edit the timestamp (date and time) of a QSO, first make sure 
that the date/time column is no wider than it needs to be. You can 
accomplish this, if there is white space to the right of the time, by right-
clicking in the Log window and selecting "Auto Set Column Widths." Now 
double-click on the time, and you'll see the time in hours:minutes:seconds 
format, with the hours selected and a calendar icon with down arrow at the 
right end. If you need to enter a new hour, do so, and then hit Tab or Enter 
to exit. If you need to change the minutes, click on them with your mouse 
to select them, enter the new value, and hit Tab or Enter to finish editing. If 
you need to change the date, click on the down arrow next to the calendar 
icon, click on the date to change to, and hit Tab or Enter to exit.  

2. Marking Multipliers 



The check-marks denote whether a given QSO accounted for one or more multipliers. 
They are provided by the program based on the received exchange, callsign, and built-
in data resources, such as the wl_ct.dat file. They cannot be edited.  

3. Serial Numbers 

In a serial number contest the serial numbers in the log window will be displayed without 
any leading zeros even when zeros are entered before the number (001 becomes 1, 
and so on).  

4. Warning of Possible Errors 

When a station is worked on multiple bands or modes with varying exchanges (zones 
14 and 15, for example), this will be highlighted in red in the lower pane. The red 
highlight color indicates that there is a strong likelihood of an error.  

Calls with no match in the master.scp file and zones that don't match the country file will 
also be highlighted. The highlighting for no match in SCP file is the same color as the 
highlighted buttons in ESM, yellow/orange by default. This color can be changed in 
Config > Manage Skins, Colors and Fonts - it is the background color for highlighting 
text (the first entry in that dialog). This is usually not an error; the highlight is just a 
reminder to take a second look to make sure you typed the call sign in correctly.  

These highlights only last for the duration of the contest. After the contest is over, the 
highlighting will disappear in order not to facilitate log washing after the contest.  

5. Keyboard Shortcuts 

 Delete (Ctrl+D) - Delete the last contact in the log.  
 QuickEdit (Ctrl+Q) - Moves the last QSO in the log into the Entry window, and 

signals the mode with "QuickEdit" in the call-frame. You can tab or space through 
the window, make the changes you need, and then hit Enter to save them. Hit 
Esc to exit QuickEdit without making changes, or Ctrl+Q again while in this mode 
to switch to the next previous QSO.  

6. Right-click Menu 

Right-click in one of the rows in the upper pane - not in the title bar - and the following 
menu will appear.  



 

 Edit Contact - Opens a dialog to edit the selected contact - the one on which 
you click to open the right-click menu. Items which cannot be edited are greyed-
out. This is mainly retained for those who have become accustomed to editing 
their log this way in N1MM Logger Classic.  



 

You can move up and down the log with the large black arrows.  

 Delete Contact - Asks whether you want to delete the selected contact.  
 Play Contact - Used to play back the selected QSO if recorded using the 

qsorder.exe program by K3IT (see References, Third Party Software). This 
selection will be greyed out if there is no recording. Contact audio will play on 
your default sound player. Make sure you don't have the sound player connected 
to your radio's audio input.  

 Jump to This Frequency - Moves a connected radio to the frequency of the 
selected QSO. This can be useful in S&P mode if you look at the log after a 
couple of QSOs and discover a discrepancy that you need to ask the running 
station about.  

 www.qrz.com - Opens QRZ.COM's record for the call-sign in the selected QSO.  
 Change timestamps of the entire log by a fixed amount - Useful when you 

discover your clock has been off since yesterday.  



 

 Change Operator - Changes the operator credited with the selected QSO.  
 Change mode - Changes the mode of the selected QSO.  
 Change RX and TX Frequency - Allows you to enter a replacement frequency 

for that entered in the log for the selected QSO. Can be useful with a non-
interfaced radio, if you discover that you forgot to log a band change.  

 Change Station Name - can be used to change the station name of the PC that 
made the QSO.  

× 

 Changing more than one QSO at a time 

You can also make the five types of changes above in more than one QSO at a time. 
Click the first log entry you want to change. Then either Shift+Click on the last QSO in a 
consecutive group, or Ctrl+Click on multiple non-consecutive QSOs. The highlighting 
for which lines are selected is very subtle in the default color scheme, so be 
careful.  
When you have selected all the QSOs you want, right-click one of them to bring up the 
right-click menu, select the action you want, and fill in the replacement value. Hit Enter, 
and you'll see a pop-up, asking you whether you really want to make this change in X 
QSOs. You can cancel at this point if you are not absolutely sure. 

 Show rates to this QSO in Info window - If the Info window is open, displays 
QSO rate up to the selected QSO.  

 Set Start Interpolation Time and Row - An example how to use can be found in 
the After the contest chapter.  

 Set Stop Interpolation Time and Row - An example how to use can be found in 
the After the contest chapter.  

 Rescore from this point on - Rescore from the selected QSO forward  
 Auto-set Column Widths - A quick way to make sure column widths will suffice 

for the entire log, while minimizing the size of the log window. This option sets 
column widths based on contents, not the width of the headings, so some 
headings may be truncated in contests with short exchanges, for example.  

 Delete custom column widths - Restores the default values, as defined by the 
length of the headings.  

 Show Mode - Option whether to show a Mode column in the log - may be useful 
to help minimize the size of the Log window on a crowded screen in a single-
mode contest.  

http://n1mmplus.hamdocs.com/tiki-index.php?page=After+the+Contest
http://n1mmplus.hamdocs.com/tiki-index.php?page=After+the+Contest


 Select All - Select all the QSOs in the log for Copy to the Clipboard.  
 Copy - Copies the selected QSO(s) to the Clipboard as either an ADIF string or a 

Generic string (used in European VHF contests).  
 Help - Opens the manual page on the Log window (Internet connection required)  

 

2.6.3 The Bandmap Window 

 2.6.3 The Bandmap Window  

o 1. Key Features  
o 2. Colors of the incoming spots  
o 3. Display and Adjustment of Band Plans in Background of Bandmap 

Frequency Scale  
o 4. Keyboard shortcuts  
o 5. Clickable Text Messages  
o 6. Mouse Actions  
o 7. Right-click Menu Options  
o 8. Example bandmap usage  

Your Bandmap window will be similar to this one.  



 

1. Key Features 

The Bandmap window represents a VFO or a radio. There are three scenarios: one 
radio with 1 VFO displayed (SO1V); one radio with 2 VFOs displayed (SO2V); or two 
radios with one VFO shown for each radio (SO2R). Bandmaps can be zoomed down to 
just a few KHz or up to the entire band.  

With one radio in SO1V mode, only one bandmap can be displayed. With one radio in 
SO2V mode, two bandmaps may be displayed, one for each Entry window. Each 
bandmap represents one VFO. With two radios the operation is exactly the same, 
except that each bandmap represents one of the radios.  



To switch the Entry or RX Focus from one bandmap to the other, Press "\". To switch 
both the Transmit and Entry/RX Focuses, press "Pause".  

The Bandmap window includes the following basic features:  

 Current receiving frequency is denoted by a blue arrow. If split, the current 
transmit frequency is denoted by a red arrow. At the point of each arrow is a 
graphic depiction of whether the radio is currently in a wide or narrow filter setting 
for its current mode.  

 
In this example, the radio is in the CW band. The dark blue and red bands are a 
notional (not actual) representation of the CW filter bandwidth, while the light blue 
represents the tuning tolerance set in the Configurer. If you tune the VFO outside that 
range, any call-sign captured into the Entry window's call-frame or brought into the Entry 
window's call-sign textbox will be erased. If you have elected to set the Config menu 
option "QSYing wipes the call and spots QSO in bandmap," the station you did not work 
is spotted in boldface as a reminder to come back to it.  

 The up/down arrows in the upper right control the size of text in the window, 
independent of the global setting for the rest of the program.  

 In the title bar, the first line of smaller type shows the name of the connected 
radio, and the VFO or radio denoted by the Bandmap. Immediately below in 
larger type is the receiving frequency and below that, in smaller type, is the 
transmit frequency if different (when Split). To the right are three clickable 
buttons. The first sends SH/DX to the Telnet cluster to which you're connected. 
The second toggles between wide and narrow filter settings, always displaying 
the one that will be selected next if it is clicked. Clicking on the third (labeled 
"CQ") will jump your radio's VFO to the last frequency on which you called CQ on 
the current band. The text CQ-Frequency is shown on the Bandmap on the 
frequency where you last went into Run mode, and used as the target for this 
function.  

 Below the three buttons are text prompts to remind you that RIT or XIT are on (by 
turning red), report the amount of the RIT or XIT offset, and remind you what 
mode the radio is in. Each of these is clickable to turn the function off or on, or to 
step through the available modes - see Clickable Text Messages below.  

 In the bottom line of the header are four programmable radio control buttons. 
Right-click on any of them, and an editing dialog will appear:  

http://n1mmplus.hamdocs.com/tiki-index.php?page=Configurer#Other
http://n1mmplus.hamdocs.com/tiki-index.php?page=Bandmap+Window#Clickable_Text_Messages


 

 

The string to send is in the format of a radio control macro (e.g. CAT1ASC or CAT1HEX 
macro). Enter a label into the button label column and a radio control macro in the same 
format you would use in a function key message, including the curly braces. into the 
"String to send" column. Now clicking on this button will send the selected command to 
the radio.  

 You can mouse over any call-sign on the Bandmap and a tool-tip will appear 
briefly, telling you when the station was spotted, by whom, and anything else 
about the spot. In addition, when a spot is less than three minutes old NEW will 
be placed behind the call and bearing on the Bandmap. When the spot includes 
split frequency information, the station's receiving (QSX) frequency will be shown 
behind the bearing. Splits are shown as 3 digits on HF. The bearing to a station 
is shown only for stations outside your own country, with exceptions for USA and 
Canada.  

 Spots of stations close to their sunrise/sunset time are marked with a 
sunrise/sunset indicator "¤".  

 CW Skimmer spots are marked with "#" in spotter's call-sign as skimmer spot in 
the bandmaps (see picture at right above). If you are the spotter, then the spots 
are marked with a "!".  

2. Colors of the incoming spots 

 Blue: Will be a good QSO, not a multiplier  
 Red: Single Multiplier Example: CQWW - QSO is either zone or country multiplier 

(one multiplier)  



 Green: Double or better Multiplier Example: CQWW - QSO is a zone and a 
country multiplier (two multipliers)  

 Gray: Dupe  
 Bold - This is a self-spotted call.  

Note- A different set of color codes is provided for the WAE contests, to assist with 
QTCs. Read about it here  

3. Display and Adjustment of Band Plans in Background of Bandmap Frequency 

Scale 

 

The illustration above depicts the new feature in N1MM Logger+ for displaying and 
modifying band plans. This is an alternative to the procedure provided on the Config 
menu of the Entry window. Note: This is not real - there is no digital sub-band 
inside the SSB portion of the band. It only illustrates all of the options.  

http://n1mmplus.hamdocs.com/tiki-index.php?page=Setup+HF+Contests+-+CW+and+SSB#WAEDC_contest_CW_SSB


There are some considerations to be aware of before you begin.  

 You can only designate CW and digital band plan segments. It is assumed that 
anything not designated for one of those modes is SSB territory.  

 You can only designate one band segment per mode, but by understanding the 
rules of precedence used by the program you should be able to handle this. For 
example, SSB is defined as not CW and not digital, so there is no need to set 
SSB limits.  

 
To set the band plans from the Bandmap window, right-click on a frequency number in 
the Bandmap. That will bring up the following menu:  

 

Note that you click on the frequency you want to set, and then click in the sub-menu to 
set it. For example, if you want to set the digital sub-band minimum frequency on 40 
meters for a major RTTY contest, you might click on "7020" and then click "Set as Digi 
sub band min freq".  

 The "Set" options are self-explanatory. Options that are not available on a given 
band or frequency are greyed out.  

 The "Remove" option is for CW contests, when many CW operators migrate into 
what are normally digital sub-bands. To prevent these being logged as RTTY, 
you can remove the digital sub-bands and re-establish them after the contest.  

4. Keyboard shortcuts 

 Numeric keypad + key - Zoom In on the Bandmap associated with the Entry 
window that has entry focus.  

 Numeric keypad - key - Zoom out on the Bandmap associated with the Entry 
window that has entry focus.  

 Shift - Numeric keypad + key - In SO2V or SO2R, zoom in on the Bandmap 
associated with the Entry window that does not have entry focus.  

 Shift - Numeric keypad - key - Zoom out on the Bandmap associated with the 
Entry window that does not have entry focus.  

 
Jumping to Spots on the active radio or VFO (the one with the Entry focus)  

 Ctrl+Down Arrow - Jump to next spot higher in frequency.  
 Ctrl+Up Arrow - Jump to next spot lower in frequency.  



 Ctrl+Alt+Down Arrow - Jump to next spot higher in frequency that is a 
multiplier.  

 Ctrl+Alt+Up Arrow - Jump to next spot lower in frequency that is a multiplier.  

 
Jumping to Spots on non active radio/VFO  

 Ctrl+Shift+Down Arrow - Jump to next spot higher in frequency on the inactive 
radio/VFO. This will skip over CQ-Frequency when radios or VFOs are on the 
same band. Proper keystroke operation is radio dependent. Disabled for SO1V.  

 Ctrl+Shift+Up Arrow - Jump to next spot lower in frequency on the inactive 
radio/VFO. This will skip over CQ-Frequency when radios/VFOs are on the same 
band. Proper keystroke operation is radio dependent. Disabled for SO1V.  

 Shift+Ctrl+Alt+Down Arrow - Jump to next spot higher in frequency on the 
inactive radio/VFO that is a multiplier. If you are operating single mode, your 
mode won't change when jumping between spots. Disabled for SO1V.  

 Shift+Ctrl+Alt+Up Arrow - Jump to next spot lower in frequency on the inactive 
radio/VFO that is a multiplier. If you are operating single mode, your mode won't 
change when jumping between spots. Disabled for SO1V.  

 Shift+Alt+Q - Jumps to your last CQ frequency on the inactive VFO/radio. 
Disabled for SO1V.  

5. Clickable Text Messages 

These are found below the radio frequency at the top of the Bandmap.  

 

 RIT Offset (already 0.00 in the illustration) - Click this label to clear the RIT 
offset.  

 RIT - Click this label to toggle the RIT on and off.  
 XIT - Click this label to toggle the XIT on and off.  
 CW/USB/LSB/RTTY/PSK/AFSK/AM/FM - Click this label to toggle from 

USB/LSB (band-specific) through RTTY to CW/PSK/AFSK/AM/FM (radio 
dependent).  

6. Mouse Actions 

 Click on frequency - Moves the active VFO/radio to that frequency.  
 Shift+Click on frequency (SO2R only) in inactive Bandmap - Tune the non-active 

radio without changing window focus. Allows you to be active and sending on 
one radio and change the frequency on the non-active radio without changing 
Entry window focus.  



 Shift+Click on bandmap callsign (SO2R only) in inactive Bandmap - Same as 
Shift+Click on Frequency with the addition that the callsign is placed in the non-
active radio's Entry window call-frame.  

 Click on call - Jump to that frequency and place the call in the Entry window call-
frame. When the call-sign field is empty, hit Space to copy the call-sign from the 
Entry window call-frame to the call-sign textbox.  

 Double-Click on call - Jump to that frequency, place call in the Entry window call-
frame and the call-sign textbox, replacing anything that was previously there.  

 Click on or to the left of the vertical frequency scale - Jump to that frequency.  
 Click frequency label - Jump to that frequency.  
 Right Click call - Display the right-click menu for the selected call (see Right-Click 

menu below).  
o The selected call will be shown in italic font and underlined when the right-

click menu is open  
 Right Click anywhere else - Display the right-click menu with some options 

grayed out which are call related.  

7. Right-click Menu Options 

If you right click in the Bandmap window the right-click menu will appear. If you do not 
click on a particular spot, certain options will be grayed out.  



 

 Remove Selected Spot - equivalent to Alt+D with the spot callsign in the call-
frame; removes the selected spot. Grayed-out when not right-clicking on a 
particular spot  

 Blacklist callsign - if you click on this option and the Filter Blacklisted Spot 
Calls option in the Filters tab of the Telnet window's right-click menu is enabled, 
subsequent spots of that station will not be displayed on the Bandmap or in the 
Available window. Used to get rid of busted spots that recur often, such as 
LW3LPL. To edit the list of blacklisted spots, or to remove a call from the list, use 
the Edit option on the filter tab.  



 Blacklist Spotter - designed in particular for use when an RBN station is feeding 
spots that are badly off-frequency (due to I/Q image problems) or otherwise 
defective. Could also be used for the occasional harasser on traditional DX 
clusters. Again, this feature is enabled/disabled in the Filters tab of the Telnet 
window's right-click menu; the blacklist can also be edited from that tab.  

 Zoom In (Numeric Pad + or Ctrl+Scroll wheel after clicking in the lower right of 
the Bandmap) - Show a wider frequency range on the Bandmap that has 
entry/RX focus.  

 Zoom Out (Numeric Pad - or Ctrl+Scroll wheel) - Show a narrower frequency 
range on the Bandmap that has entry/RX focus.  

 Go to Bottom of Band - Go to the bottom of this SSB/CW subband.  
 Go to Top of Band - Go to the top of this SSB/CW subband.  
 Remove Spots, This Band Only, Leave Self Spots  
 Remove Spots, This Band Only  
 Remove Spots, ALL BANDS, Leave Self Spots  
 Remove Spots, ALL BANDS  
 Show Last 10 Spots - click this option (which is gray unless a callsign has been 

clicked on) and the cluster will be asked for the last 10 spots of that station. 
These are displayed in the Telnet window.  

 Show QRZ - requests address information from the DX cluster  
 Show Station - sends the SH/STA [callsign] command to the DX cluster  
 Show QSL/Packet - sends the SH/QSL [callsign] command to the DX cluster  
 Show Sunrise/Sunset - sends the SH/SUN [callsign] command to the DX 

cluster  
 Set transceiver offset frequency - This is for transverter support. The offset is 

saved when the program closes and read again when opened. Remember to 
enter the frequency of the transceiver and not that of the transverter when going 
into split mode (Alt+F7). Information how to fill in this table (which frequencies to 
enter and how to calculate the IF frequency) can be found in the VHF and Up 
Contesting chapter.  

http://n1mmplus.hamdocs.com/tiki-index.php?page=VHF+and+Up+contesting
http://n1mmplus.hamdocs.com/tiki-index.php?page=VHF+and+Up+contesting


 

 Set transceiver timeout time - Sets the time interval after which, if no 
communication with a radio is occurring, the program will alert you. The value is 
set for each radio (default is 15 seconds). Entering a value of zero will disable the 
timeout function. Entering a negative number will set the time out value to 15 
seconds. Entering a number that is too large for the program variable will set the 
timeout to the program maximum. The positive minimum is 5 seconds.  

 Set transceiver filter codes - This setting controls what is sent to your radio 
when you click the "Wide/Narrow" button at the top of the Bandmap to toggle 
between wide and narrow filters. If no value is set, then the program uses the 
default values set for your radio.  

 
You will be prompted for the wide or narrow string to set the filters. For Kenwood, it's 
pretty easy. You just look up in your manual the string you want and enter it. For other 
radios, like FT-1000MP, it's harder. You must enter a series of space-delimited codes in 
DECIMAL. Therefore, when an FT-1000MP filter code of 0 0 0 0 8C is required, you 
must enter 0 0 0 0 140 (8C hex).  
To reset to the default values in the program enter a space and press the OK button. It 
is possible to use {CR} in the filter codes which will be replaced with the return 
character. These selection are disabled when manual radio is selected (i.e. no radio 
selected).  

o CW Wide  
o CW Narrow  
o SSB Wide  
o SSB Narrow  



o Digi Wide  
o Digi Narrow  

 Find a Callsign (use Alt-F8 to return) - This option allows you to search for a 
particular callsign in the bandmap. Searches from current frequency up to find 
each instance.  

 Bring to foreground when made active - This brings the active bandmap to the 
foreground. If you don't have enough monitor space, you can place Bandmaps 
on top of one another, and when you move the entry focus between Entry 
windows, the When not having enough real estate on the monitor screen it is 
possible to place both bandmaps on top of each other. The active bandmap will 
be shown hiding the non-active bandmap.  

 Reset Radios - Allow manual reset all attached radios. When contact with a 
radio is lost the dialog below will appear. Select 'Retry' to restore the connection 
with all attached radios or Right-Click on the bandmap and choose "Reset 
Radios" to restart the connection.  

 

 

 Telnet Bands/Modes - opens the Bands/Modes tab of the Telnet window so you 
can adjust which bands and modes will be displayed on Bandmaps and in the 
Available Mults & Qs window.  

 Telnet Filters - opens the Filters tab of the Telnet window so you can adjust 
which spots will be displayed on Bandmaps and in the Available Mults & Qs 
window.  

 Show Telnet History - Shows the Telnet history of any station on the bandmap. 
Select the station by right-clicking on it and then clicking on this option.  



 

 

 Show My Call Spot History - Shows the recent Telnet history for spots of your 
station.  

 Help - Show the help file for this window.  

 
When the cluster to which you are connected is a DXSpider cluster, select 'Format for 
DX Spider cluster' on the Other tab in the Configurer.  

Hovering with the mouse over a spot  

Hovering with the mouse over a spot in the Bandmap gives the following info about the 
spotted station:  

 Exact frequency sent by spotter.  
 Call-sign of spotter.  
 The time in minutes since the station was placed on the DX cluster network.  
 Comments sent with the spot.  
  

 
Hovering with the mouse over the blue arrow marking your receiving frequency - 
shows the exact frequency and tuning tolerance.  

8. Example bandmap usage 

by Tom, N1MM  

In Search & Pounce (S&P) the call-frame will show you each spotted station as you 
come within "tuning tolerance" (user settable) of that station. I'm terrible at remembering 
whether I worked a station and on what frequency. With worked stations in the 



bandmap, the program will tell you that they are not workable again. You can tune by 
them more quickly. The same feature is useful in contests with unworkable stations.  

In a contest like CQ WPX, with (basically) no value multipliers, here is how I use the 
Bandmap. Whenever I can't get a run going I start S&P on a band with a lot of unworked 
stations (use the available window). I use Ctrl+Up and Ctrl+Down arrow to go to the 
next station. If that station is at the beginning of a QSO, I move to the next one. If the 
QSO is near the end, I wait and work the station. Then I move on. If I reach the top of 
the band, I start coming back down the band, working the ones I missed on the way up. 
If there is no station at a frequency, that's my new running frequency!  

In contests with valuable multipliers, you should use Ctrl+Alt up/down to get the 
multipliers first, then go back and get the QSOs.  

If the rate drops fairly low, sweep the band using your VFO. That is where the old calls 
in the bandmap come in useful. If you copy a call, but it seems like it is going to take a 
long time to work him, tune to the next guy. If you have "QSYing wipes the call & spots 
QSO in bandmap" turned on, the call will be spotted in bold, so you can 
Ctrl+Up/Ctrl+Down to him later.  
Remember: if a call is in the callframe, space will load it into the call textbox.  

If all this seems very unfamiliar, you haven't read the Key Assignments help (and/or the 
Key Assignments Shortlist).  
Reading that single item is your single best time investment in using this program.  

Spots and the time shown  

When you hover with the mouse over a spot in the bandmap, it will show the relative 
age of a spot in minutes. The time shown here depends on the spot format. There are 
two formats for spots. One is for current spots, one is for SH/DX spots. Some clusters 
allow to show old spots in the current spot format. The program handles the two types 
of spots differently.  

 Current spots go into the bandmap with the computer's local (converted to UTC) 
time. This is to remove variations in cluster times and order the spots into the 
time they were received.  

 Old spots are logged with the originating cluster's time with the provision that it 
cannot be later than the current local (UTC) time.  

 
With AR-Cluster you can display old spots with SH/DX or SH/FDX. It is recommended 
to use SH/DX, as it will be recognized as an old spot. Other cluster software may have 
similar capabilities.  

Red lines indicating US license frequencies  

On the bandmap there are red lines to indicate extra, advanced and general portions of 
each band. Since US hams can operate only in their section and the sections of lower 
class licenses, it is in your interest to operate some in the higher portions of each band. 
Otherwise there are some US hams you will not ever be able to work.  



The lines can be found on:  

 SSB: 3775, 3850, 7225, 14175, 14225, 21225 and 21300.  
 CW: 3525, 7025, 14025 and 21025.  
 No lines on 160 and 10 meters.  

 

2.6.4 Telnet Window 

 2.6.4 Telnet Window  

o 1. Tabs  

 1.1. Clusters  
 1.2. Bands/Modes  
 1.3. Filters  

 1.3.1. Save Spots  
 1.3.2. "Show non-workable spots" and "QSYing wipes call 

and puts it in the bandmap"  
 1.3.3. "Randomize incoming spot frequencies"  
 1.3.4. Spot origin filtering  

 1.4. Spot Comment  
 1.5. Band Plans  

o 2. Sending Stored commands to the cluster  
o 3. Mouse Clicks  
o 4. Multi-User Setup  
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Your Telnet window will be similar to this one, with six tabs.  



 

 The textbox labeled "Type:" is where you can input any text commands to send 
to the cluster. For example, typing "bye" without the quotes and hitting Enter will 
disconnect you from most clusters.  

 The "Reconnect" button will re-establish your connection to the cluster shown on 
the label of the first tab (see below).  

 A font sizer is at the upper right, just below the "X" to close the window. Click the 
up or down arrows to change the size of the text in the text pane below.  

 The text pane is where all messages from the Telnet cluster will appear. Click in 
the text pane to temporarily halt scrolling; move the mouse cursor out of the text 
pane to restart it.  

 All incoming information from the connected DX cluster is displayed in the text 
area of the Telnet window. They are color-coded by mode - defaults are blue for 
CW, magenta for digital, and black for SSB. Spots forwarded to the Bandmaps 
and Available Mults & Qs window are filtered as provided on the Filters tab. 
Spots that are filtered out (not forwarded) are greyed out in the text area.  

 
Split information given in the spot comment will be recognized and forwarded to the 
Bandmaps and Available window. When such a spot is selected the transceiver will go 
into split mode (if applicable). The program recognizes: UP, U, DOWN, DN, D and the 
word QSX. Examples: QSX 3.838, QSX 4, UP 5, DOWN 2, U 5, D4, U4, DN4, UP4, 
DOWN4, QSX7144 etc.  



1. Tabs 

There are six tabs above the text pane, which is displayed by default and also tied to 
the left-most tab, which always displays the call-sign of the currently-selected cluster.  

The first tab displays the callsign of the Telnet cluster node to which you are connected, 
and opens the lower pane so that you can see the flow of spots from the node. Except 
as noted, any changes made on the other tabs take effect when you switch back to this 
tab.  

1.1. Clusters 

The Clusters tab is used to select the cluster to which you want to connect, from a list 
that you can also edit from the tab. The Edit List button in the window under the 
Clusters tab opens a new edit window where you can make changes to the list. You can 
import or export the list of clusters from/to a file using the File menu in the edit window. 
By default, these files are stored in the ExportFiles folder in the N1MM Logger+ user 
files area.  

 

Also on the tab:  

 A checkbox to tell the program to automatically log on to the selected cluster 
whenever the Telnet window is open.  

 A checkbox to format some commands properly when you are connecting to a 
DXSpider cluster.  

 A "Logon with" field, where you fill in the callsign the cluster is expecting to see at 
logon.  

 A "Show Telnet Buttons" checkbox. Uncheck it to reduce the size of the Telnet 
window as much as possible, saving screen space.  

 A "Connect" button that will send the logon sequence to the selected cluster and 
switch your view of the window back to the selected cluster.  



× 

 Connecting to Telnet from a multi-computer network 

If you are using N1MM Logger+'s networking to connect multiple computers together in 
a network, only one of the computers in the network (the one designated as "Master") 
connects to a Telnet cluster. The other, non-Master computers need to have their Telnet 
windows open to receive spots from the Master computer, but they do not connect 
directly to a Telnet cluster.  

1.2. Bands/Modes 

The Bands/Modes tab allows you to select which bands and modes will be passed 
through to the Bandmap(s) and Available Mults & Qs window. Select bands individually 
or select groups of bands with the large buttons across the top ("HF", "VHF", etc.). 
Select mode(s) individually, by clicking the "All" button, or by checking "Contest" to pass 
only the mode(s) valid in the current contest. The "Reset All Defaults" button will check 
every band and mode.  

 

1.3. Filters 

The Filters tab provides another set of filters, as well as checkboxes for a few related 
options.  



 

 Set the desired Bandmap timeout for DX spots by entering time in minutes.  

1.3.1. Save Spots 

The "Save Spots" checkbox is a new feature, added to solve an issue with packet spot 
processing that caused the spots database (Spots.s3db in the Databases folder) to 
grow too large and impact program performance. If you are experiencing symptoms of 
this, check the size of your Spots database. If it is more than a few MB, that may be 
why.  

The "Save Spots" box is unchecked by default, and if left that way, the Spots database 
is not used at all. The advantage is very low performance impact from Telnet use. The 
drawbacks are that when you restart N1MM Logger+, the Bandmap will be empty. The 
check for Telnet spots in the Check window will not be active, and the "Spotted" option 
in the Multiplier window will not work.  



If the box is checked, N1MM+ now honors the Bandmap timeout value set on this tab. 
For example, if you set the timeout value at 20 minutes, the Spots database will only 
retain spots for the last 20 minutes. When you restart NL+, the Bandmap will only 
display spots for the last 20 minutes, and the Check and Multiplier windows will only use 
spots from the last 20 minutes. The developers are aware that the latter is a slight 
drawback, and may look at other options after the high contest season is over.  

1.3.2. "Show non-workable spots" and "QSYing wipes call and puts it in the bandmap" 

These options have moved here from the Config menu.  

1.3.3. "Randomize incoming spot frequencies" 

Automatically adds or subtracts a small amount from the received spot frequency, so as 
to improve your chances of breaking a "packet pileup" when you click on a spot.  

1.3.4. Spot origin filtering 

There are two levels of spot origin filtering. You can either choose to pass spots only 
from your country or continent (determined from the Station Data page) or only from 
specified prefixes. Generally, we recommend that you use spot filtering at your Telnet 
cluster instead.  

1.4. Spot Comment 

This tab lets you specify a comment for each spot you make (such as "WPX") and add 
log data fields to the fixed comment.  

 

1.5. Band Plans 



The Band Plans tab formerly permitted setting limits for mode segments within band 
plans. This function has now been moved to the Bandmap window, and is accessed by 
right-clicking on a frequency label (e.g. "7045"). The tab will be removed before long.  

2. Sending Stored commands to the cluster 

Across the bottom of the Telnet window are twelve buttons which can be individually 
programmed with stored messages to be sent to the Telnet node. Right-click in the 
button area to bring up the editor.  

 

Different button sets can be saved and recalled for use with the File menu at the upper 
left. By default the text files containing sets of button messages are stored in the 
FunctionKeyMessages folder in the N1MM Logger+ user files area.  

3. Mouse Clicks 

 When the you left- or right-click in the text area, scrolling is stopped. A right-click 
on a callsign brings up a small menu  

 

Click on "Jump to this spot" to send the active radio to the spot frequency. This option is 
mainly retained for nostalgia. It makes far better sense to click in the Bandmap or the 
Available window while maintaining the Telnet window minimized, once you have the 
filters, bands and modes set up as you want them.  



4. Multi-User Setup 

When running in networked computer mode, only the Master station has to be 
connected to the DX-cluster. The master station will relay all information to and from the 
connected computers to the cluster node.  

5. CW Skimmer and the Reverse Beacon Network (RBN) 

CW Skimmer version 1.1 and up has a built in Telnet server which allows N1MM Logger 
to receive spots from it. Add an entry to your Telnet list with the address: 127.0.0.1:7300 
if you are running Skimmer on the same machine as N1MM Logger. If running on a 
different PC on the same network, use that machine's internal IP address in the same 
format.  

The Reverse Beacon Network's Telnet relay servers make all of the RBN's Telnet spots 
available to users worldwide. Because of the huge volume of spots on a major contest 
weekend - at least fifty times as many as the conventional cluster network - we highly 
recommend that you connect to a "retail" server and use the node's filtering capabilities 
to manage the quantity actually sent to you. It will be helpful to use a short Packet Spot 
Timeout (set on the right-click menu of either the Bandmap or on the Filters tab of the 
Telnet window) - 15 minutes should be more than adequate, because CW Skimmer re-
spots stations that remain on the same frequency every 10-12 minutes.  

Because of the high volume of spots, the RBN uses specially-designed relay servers on 
its Telnet nodes, which are internally streamlined. A side-effect is that these nodes 
do not respond to user commands. This is another good reason to connect to a 
"retail" cluster that handles both RBN and traditional spots. You can find a list at 
this site  .  

Local Skimmer spots can be merged with spots from conventional DX clusters using 
software such as WintelnetX or CC User, freeware by K1TTT and VE7CC respectively. 
Skimmer spots are distinguished from regular spots by the addition of unique markers. 
In the Bandmaps, Skimmer or RBN spots are identified with "#" after the callsign and 
bearing; spots from your own Skimmer, identified by the callsign set in your Station 
Data), are marked with "!"  

6. Spot Filtering 

There are three levels of spot filtering available. The first and most powerful of these 
using whatever filtering capabilities are built into the node. The second is established by 
the Band/Modes and filters tabs of the Telnet window. A third is set by the Available 
Mults & Qs window's Bands and Modes button. The latter only affects what is seen in 
that window.  

6.1. AR Cluster V6's Skimmer Spot Quality Filtering 

Because of the large volume of spots generated by the RBN, even at very high 
accuracy rates (over 99 percent), a large number of busted spots have been noticed. 
Toward the end of major contests, these may be a significant problem for serious 
competitors. In addition, calibration and image errors are occasionally encountered due 
to hardware and software issues.  

http://www.dxcluster.info/


CT1BOH has developed and AB5K has implemented DX cluster-based evaluation of 
spot quality, in an effort to reduce the number of bad spots seen on the RBN. This nice 
piece of work was implemented in Version 6 of AR Cluster. AB5K.net was the first node 
offering this feature, and many more now have it too. You can find an exhaustive list at 
this web site .  

The evaluation is subdivided into 3 categories:  

 Validation – When a callsign is first spotted on a given frequency, it is tagged 
with a “?” in the last column of the Comment field of the spot. When two or more 
other RBN nodes agree on the spot, the tag on each subsequent spot becomes 
“V”  

 Frequency – After a station has been spotted on a given frequency, if it is then 
spotted on another frequency the spot is tagged as above, but with a “Q”, for 
QSY? Again, once the move is confirmed, subsequent spots are tagged with V. 
The idea here is to catch I/Q image spots, spots sent by badly-calibrated 
Skimmers or spots inadvertently sent on the wrong band.  

 Busted Spots – This is the real high point of the Quality Tags. The algorithm uses 
some sophisticated measures of the “resemblance” between the busted spot and 
the real one, and will tell you both what spots are busted and what the real call is, 
based on other spots at or very near the same frequency.  

 
Here is a brief snapshot of one minute of RBN plus traditional spot flow.  

 

http://www.dxcluster.info/telnet/index.php?software=AR-Cluster


You can see that the node software picked up two busted spots, and also was skeptical 
about others until they were repeated. There are no QSY spots in this sampling, but if 
there had been, you would have seen the “Q” tag.  

When you first connect to an AR Cluster, make sure it is sending RBN spots as well as 
traditional ones by commanding it to “set dx filter”. Once RBN spots are flowing, you can 
set any other filters you want to, such as limiting spots to stations in your geographic 
area. Then all you have to do is send “set DX extension skimmerquality”, and the 
Quality Tags will start to appear at the right end of the Comment field.  

Some operators will prefer to filter out certain of these spots. Most likely candidate for 
this treatment are spots tagged with “B”., but you can filter out “?” or “Q” spots too, and 
the node will not send spots of those stations to you until they are confirmed (and 
tagged V). Here’s a partial list:  

Set DX filter Skimbusted – only send me those spots that are marked as busted, 
together with the node's identification of the correct spot)  

Set Dx Filter NOT Skimbusted – don’t send me any spots that are tagged as B  

Set DX filter NOT SKimQSY – don’t send me any Q spots until they are verified  

Set DX filter Skimvalid – only send me spots that have been tagged with a V  

These and other Skimmer-related filtering commands are found on AB5K’s website.   

One of the neat things about AR Cluster V6 is that you can create complex filters to 
show you exactly what you want. For example:  

SET DX FILTER {MYCALL} OR (spotterstate=MD OR spotterstate=PA OR 
spotterstate=VA OR spotterstate=WV)  

This filter will tell me whenever I am spotted anywhere in the world, and otherwise will 
show me all spots, both traditional and RBN, made by stations in the states around my 
QTH.  

× 

 Abbreviating ARC V6 filter commands  

While N1MM Logger+'s Telnet buttons will accommodate fairly long commands, 
stringing together a lot of "state=" or "cty=", or "state<>" or "cty <>" commands could be 
too much. Fortunately, there is an abbreviated syntax. The "[entity]=/<>" filters can be 
abbreviated as follows: state=[MD,VA,WV,PA] or CTY=[K,VE,KP4]  

 
You could add some Quality Tag-specific filters – for example:  

SET DX FILTER call={MYCALL} OR NOT skimbusted and (spotterstate=md OR 
spotterstate=pa OR spotterstate=va OR spotterstate=WV)  

This filter will work the same as that above, but also will not show me any spots that the 
cluster evaluates as busted.  

http://64.128.19.154/Home.aspx


Here’s another filter that lays on some more complexity, written by CT1BOH and 
recently published on CQ-Contest:  

Set DX Filter (skimValid OR not skimmer or ((SkimQsy OR SkimUnknown) AND 
(cty <> K AND cont <> EU )))  

This filter shows human spots, Skimmer spots appraised as V(alid), and Q and ? spots 
from outside Europe and the USA. It filters out Q(new frequency?) and ? (not yet valid) 
spots from the US and Europe, on the theory that it’s less important to jump on those 
first.  

So that’s the story – whether you choose to filter at the cluster node, or see everything 
coming in and make your own decisions, Quality Tags can be a very useful tool. 
Congratulations to CT1BOH and AB5K for their achievement.  

6.2. Using Filters 

Many operators will prefer to make their own judgments, rather than using filters. There 
are some advantages to this, probably. For example, a rare multiplier spotted initially by 
only one RBN node would carry a “?” tag until two more confirm the spot. Waiting for it 
to come through a Skimvalid filter could result in your being twentieth in the pileup 
instead of first or second. Late in a big contest, a large multi-op will have worked many 
of the stations on each band. A lot of busts will seem to be valid, but operators may 
want to make that judgment quickly for themselves rather than relying on the node. The 
next section shows how you can use N1MM features to make this approach easier.  

N1MM Logger has two main ways of initiating S&P QSOs, by using either the Available 
Mults and Qs window or the Bandmap(s). Of the two, the Bandmaps are the easiest 
way to work with Quality Tags, simply because the Available window scrolls so quickly 
when receiving spots from the RBN. Just mouse over the callsign on the Bandmap that 
you wonder about, and the full spot, including the Quality Tag, will appear in a tooltip. 
This makes it really quick and easy to skim over the bandmap and dismiss the busted 
ones with Alt+D Here’s an example  

 

In this example, if you had worked EA1FAI a couple of minutes before, when you saw 
EA1FAE pop up, you moused over him, and he was revealed as a busted spot. 
Alternatively, you can click on a call to select him for a possible QSO, and if the tooltip 
reveals he’s a bust, you just hit Alt+D and move on.  

6.3. Spot Flow in N1MM Logger+ 

The following diagram may help you visualize how Telnet spots flow through N1MM 
Logger+  



 

× 

 Spot Filter Tips 

The Available window band/mode settings only affect what is displayed in the Available 
window's spot list. Spots flow to them through the band/mode and filter tabs of the 
Telnet window, and so must be the same as, or more restrictive than, those settings. If 
you discover that certain band or mode choices are greyed out, take a look at your 
Telnet window settings.  
In networked-computer mode, spots flowing to the Networked Computers are not 
affected by any filter settings in the Master Station. Networked Stations' spots arrive 
unfiltered, in order to let the operators at those stations set their own filters in N1MM 
Logger+. 
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 2.6.5 The Check Window  

o 1. Key Features  

 1.1. Special Telnet Features  
 1.2. Reverse Call History Lookup  

o 2. Right-Click Menu  

1. Key Features 

The N1MM Logger+ Check window is the latest evolution of the Super Check Partial 
idea originated by K1EA in the CT logging program. It combines up to four separate 
sources for checking the validity of an entered or spotted call-sign. Its system of color-
coding helps the operator determine if the call-sign as copied is correct, and, if not, 
where the error probably lies.  

When first opened, before a partial or complete callsign is visible in either the callframe 
or the call-sign textbox of the Entry window, the default Check window looks like this:  

 

The four upper panes, left to right, will contain results derived from comparison with 
your current log; with a Master.scp data file downloaded on the Tools menu of the Entry 
window; with Telnet spots received by the program, and with a Call History file, if one 
has been loaded. The numbers immediately below the grey pane titles reflect the size of 
the files under comparison, at the moment the check window was opened. The log and 
Telnet totals will continue to grow for as long as the underlying database tables continue 
to grow, but will not be seen again until you re-start the program.  

The bottom pane is for Reverse Call History Lookup, discussed below.  



You do not have to display results from all these sources, or from the reverse lookup 
window. A right-click menu lets you uncheck any panes you do not wish to see:  

 

The other choices on this menu will be discussed below.  

 When you enter a call-sign in the Entry window's call-sign textbox, beginning with 
the third character, or a call-sign is transferred into the call-frame from the 
Bandmap, the Check window will begin trying to check it against the selected 
sources of information. The check results are displayed as below, using "YT1" as 
an example:  



 

 

Note the green highlights - given the first 3 characters, the Check window is telling you 
that there are matches with those characters, and that any of the callsigns with one or 
two green-highlighted characters could be correct, based on what has been found in the 
various call-sign files.  

Now enter another character, making the possible call-sign YT1E. The Check window 
changes:  

 

In the first row, the bold and italicized callsign reflects a perfect match in the master file. 
"YT1A" with the "A" highlighted in red means that an imperfect match was found in the 
current log - you may actually have heard YT1A rather than YT1E, since the station has 
already been logged once in the contest.  



There is another list of suggested call-signs in the master file pane. The first, with the 
green highlight, means that "YT1E" matched a call in the master file, but only in part. 
The full call found in that file is YT1ET, so the "T" is highlighted in green. But there are 
other possibilities, if you miscopied one of the characters. Each of the characters that 
would have to be changed is highlighted in red.  

1.1. Special Telnet Features 

Because of uncertainty about the quality of Telnet spots, a spot will only appear in the 
Telnet section if:  

 It has been spotted at least 3 times or  
 It has been spotted with a Q or V spot-quality tag on AR Cluster version 6.  
 If the Save Spots checkbox on the Filters tab of the Telnet window is checked, 

this check of Telnet spots will be retrospective to the beginning of the current 
contest. If it is not checked, the retrospective check is limited to the Packet Spot 
Timeout interval set either on the Filters tab or on the Bandmap's right-click 
menu.  

1.2. Reverse Call History Lookup 

In contests where this feature is supported you may enter a sought-for multiplier (for 
example, a rare county in a QSO party) in the Exchange textbox of the Entry window. 
The call-signs of any stations with that multiplier in either the current log or the Call 
History file will then be displayed in the bottom pane of the Check window. A full 
description of the Reverse Call History Lookup feature may be found here.  

2. Right-Click Menu 

 

http://n1mmplus.hamdocs.com/tiki-index.php?page=Call+History+and+Reverse+Call+History+Lookup


The right-click menu contains user-selected options for the Check window, along with 
some actions that can be taken "on the fly." It is opened by clicking in the text area of 
the Check window (not in the header).  

 Hide this pane - used to get rid of a pane in the Check window quickly. Right-
click in the target pane and click this option to hide it.  

 Proportional width this pane - This feature can be used to make one section of 
the Check window larger than others. Right-click in the pane you want to enlarge, 
select this option, and enter a number in the pop-up dialog that appears. Panes 
are all the same width by default, so entering "2" will make the target pane twice 
as wide as the others, "3" will make it three times as wide, and so on. This choice 
remains in effect until the Check window is closed and reopened.  

 The next five checkable options determine which panes appear in the Check 
window. If you are not running Assisted, for example, there is no reason to 
display the Telnet pane; if you have not loaded a Call History file, you can hide 
that pane, and so on.  

 Sorting - Favor end-character differences - Used to determine how much 
weight to give the last character in an entered call sign. This will help determine 
how high up the listing of possible calls a call sign with a /P, for example, might 
appear.  

 Yank: configuration - The hot-key Alt+Y can be used to "yank" a call sign from 
the Check window into the call sign textbox of the Entry window, replacing what 
is currently there. Clicking this option on the right-click menu opens a sub-menu:  

 

 

This sub-menu determines the panes in which call signs will be selected for yanking and 
the order in which those panes are selected with consecutive yanks. In this example, 
with LMT entered as the Yank order, the Log, Master and Telnet panes will supply the 
call signs to be yanked. The first Alt+Y will yank the first call in the top row in the Log 
pane. Subsequent Alt+Ys will step through the calls in the top row in that pane, and then 
do the same in the Master file pane, and then in the Telnet pane. After the first row in all 
the panes has been exhausted, the next Alt+Y will yank the first call in the second row 
in the Log pane and proceed through the second row in the three panes in the order 
specified, and so on.  



 Yank: allow dupes- As the name suggests, checking this option will allow you to 
yank call signs which are in your log and reported as dupes.  

 Reverse Lookup Search without leading wildcard (*) - This limits the search 
to the first characters in call signs, whereas with this option turned off, the search 
will also find the search text beginning later in the field. When this option is not 
checked, BC will match AABC, ABCD, BC, BCDE, and so on; when the option is 
checked, only BC, BCDE, etc. will be matched. Limiting the search to the first 
characters results in faster searches with fewer matches.  

 Set Reverse Lookup Threshold - opens a sub-menu where you can select how 
many characters must be entered in the Exchange field before the Reverse 
Lookup occurs. When using a very large Call History file or operating in a QSO 
party such as 7QP where the first two letters of each multiplier only denote the 
state, increasing the threshold above the default "2" may help to speed up 
delivery of meaningful results.  
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 2.6.6 The Available Mults and Qs Window  

o 1. Key Features  
o 2. Spot Listbox  
o 3. Right-Click Menu  

The Available Mults and Qs window is most useful when spots are being received from 
a Telnet DX cluster (e.g. in a multi-operator setup, in Assisted or Unlimited class, or in 
contests that allow spots to be used in the single-operator class).  

The Available Mults and Qs window looks like this.  



 

× 

 Band Buttons Have Moved 

Before you ask - the Band Buttons in N1MM Logger Classic's Available Mults & Qs 
window have moved to the Entry window in N1MM Logger+. 

1. Key Features 

 The Header - The header shows the number of Available Multipliers and QSO's. 
(Example 4 Mults 12 Qs)  

 The Summary Panel - the table in the center of the window header indicates 
how many new QSOs and new multipliers are currently available on each of the 
contest bands. The bands with the most multipliers and QSOs available is 
highlighted in red.  



 The Mults/Mults&Qs Button - clicking this button toggles between showing both 
Qs and Mults and only Mults in the lower pane of the Window (also known as the 
Spots listbox). It is color-coded with standard N1MM coding for Mults and Qs to 
remind you of which is which at 3 AM on Sunday. Its color and caption always 
reflect your current choice, not the one that will be invoked when you click it.  

 The Bands & Modes Button - Clicking this button opens a Bands/Modes menu 
which looks in general like the Bands/Modes tab of the Telnet window, but which 
only affects the contents of the lower pane of the Available window. Options 
which are not available in the current contest are greyed out.  

 

 

 If you check the Focus Radio box, the spots listbox will only display spots that 
are on the band to which the focus radio or VFO is set. If you change the focus to 
another radio or VFO, the spots listbox will switch to displaying only those spots. 
The non-focus radio or VFO selection is disabled when SO1V is selected  

 If you check Contest under Modes, only those spots that fit the contest modes 
will be displayed in the Available window's spots listbox.  

2. Spot Listbox 

The list box (the lower section of the window) shows spots received via Telnet. There 
are 7 columns, nominally in this order: Call, Frequency, Dir (bearing), Mode, SNR 
(Signal-to-noise ratio) for Skimmer spots, Time (hhmmZ) and Spotter.  



 You can click and drag the column headings to any order you want, and narrow 
the window to reduce its size anf hide columns you don't care about.  

 Clicking on a column title will sort the column, and clicking again will reverse the 
sort order.  

 An indicator of split spots appears next to frequency.  
 Spots coming from a local Skimmer are shown with a (!) to the right of the 

bearing, and those from a non-local Skimmer or the RBN (other than your spots, 
if you are a contributor) are tagged with with (#). A sunrise/sunset indicator is 
shown to the right of the bearing where applicable, as an aid to determining 
which spots may either be "perishable" or particularly suited to a gray-line QSO.  

 Spots are colored by default as follows:  
o Green - double multiplier  
o Red - single multiplier  
o Blue - valid QSO  

 
The colors may be changed in Manage Skins, Colors and Fonts, on the Entry window's 
Config menu.  

3. Right-Click Menu 

 

 Delete Spot - If you right-click on a spot in the spot listbox, the right-click menu 
will come up, and the "Delete spot" option will not be greyed out. Click it to delete 
the selected spot.  

http://n1mmplus.hamdocs.com/tiki-index.php?page=Entry+Window#Manage_Skins_Colors_and_Fonts


 Blacklist callsign/Blacklist spotter__ - Right-click on a spot, and click either 
option to get rid of either a persistent busted spot (e.g., EK3LR) or a problem 
spotter.  

 Set Band & Mode Filter Options - Opens the same dialog as the Bands & 
Modes button on the window header.  

 Show Qs & Mults - Replicates the toggling function of the Mults & Qs button on 
the window header.  

 SO2R Focus Follows Spot  
 Advanced SO2V VFO Selection (Radio Dependent) - ((Single Operator Two 

VFO Operation (SO2V)|#Advanced_SO2V_for_Radios_with_Separate_Sub-
Receivers|the chapter on SO2V operation)) for details. Works on radios with 
separate sub-receivers.  

 Enable Right-click QSY on Spot - In SO2V and SO2R operation, QSYs the 
second VFO or radio to a spot when it is right-clicked, without changing the entry 
focus.  

 Turn Rotor - turns the rotator for the Entry window that has the entry focus to the 
bearing for the station in the call-frame or call-sign textbox  

 Summary Panel Band Selection - Allows you to customize the Summary Panel 
for any desired mix of HF, VHF and microwave bands.  

 Show Summary Panel - uncheck this option to reduce the size of the Available 
window by hiding the Summary Panel  

 Help - Internet connection required - displays this section of the manual  

 

 

2.6.7 The Info Window 

 2.6.7 The Info Window  

o 1. Key Features  

 1.1. Multi-Operator Features  

o 2. Contest Goals  

 2.1. Editing and Exporting Goals  
 2.2. Goal Files  
 2.3. Importing Goals  

The illustration below is a typical Info window with all options enabled in the right-click 
menu, also shown.  



 

To open the Info window, select "Info" on the Window menu of the Entry window  

1. Key Features 

 The title bar shows the call-sign of the station owner (from the Station Data table) 
and the default Sent Exchange for the current contest. The operator's call-sign is 
shown in blue on the right side of the window. If another operator signs on using 
Ctrl+O or the OPON text command, that callsign will replace the other.  

 The sent exchange is shown in the title bar. The next QSO number will be shown 
on the title bar if it is a serial number contest. Example: Exch: 59 002  

 The content of the window, other than the long-term and short-term rate displays, 
is selectable from the right-click menu.  

o The first line is the spot that is in the call-frame of the Entry window, 
including any comment.  



o The second line provides country information, including long and short-
path headings, as well as short path distance to the country of the call-
frame spot.  

o The third line provides sunrise and sunset times in UTC at the DX 
location, plus his local time  

o The fourth line displays the last WWV message received from the 
connected Telnet node. There were none when this screenshot was 
taken.  

 Below the information lines are two graphs. The left-hand one shows near-term 
rates. Left to right, these are the rate for the last 10 QSOs, the last 100 QSOs, 
the last hour, and the interval since the start of the current clock hour. The right-
hand graph displays hourly rates for five intervals, selected from the right-click 
menu to be either 20, 30 or 60-minute moving averages. Each vertical line 
represents one such interval - the rightmost edge is the current interval, which 
may not have been completed at any given moment  

 The last information line, below the graphs, reports the start date and time of the 
contest, as set in the Contest Setup Dialog (File>Open Log). This value can be 
changed by right-clicking on the start date and time for the contest in the Contest 
Setup Dialog. It is important that it be set correctly, to synchronize the current 
running of the contest with any goals you have set.  

o During the running of the contest, other important information items will; 
appear in this line. They include, for example, confirmation that your score 
was successfully reported to the on-lihne scoreboard  

 The open area below the Contest Start Time is for messages from the program. 
The most important use now is for notification when you are spotted on the DX 
Cluster network, and by whom. It is also the place, in a multi-op, where the 
program reports any difference in entry category between computers on the 
network (multi-single versus multi-two, for example).  

1.1. Multi-Operator Features 

In multi-operator contests, the Info window also displays, under the current operator's 
callsign, a number of useful indicators. These include:  

A display to help you comply with contest rules for band changes in multi-operator 
contesting  

 A band change counter or band timer (depending on the contest and entry 
category)  

o 10 minute band timer - counts down after band change. The band change 
timer does not start until the first band change of the contest.  

o The band change counter has a "stop light" (red/yellow/green) colored 
background, to warn the operator when nearing or exceeding the allowed 
number of band changes in the current clock hour.  

 Mult-Run indicator - Displays MULT or RUN when Multi-One or "1" or "2" when 
Multi-Two selected  

o Multiplier or Run station can be toggled with key combination Ctrl+Alt+M  

http://n1mmplus.hamdocs.com/tiki-index.php?page=Info+Window


 
With the advent of the RBN, the sheer number of spots received and listed in the 
Available Window and on the Bandmaps within the spot timeout period may exceed the 
computer's capacity to process them. The program monitors CPU utilization, and when 
it approaches a dangerous level, automatically trims a small number of the oldest spots. 
When this takes place, you will see an advisory message in this section of the window, 
so that you can decide if you wish to make any changes in your DX cluster filtering or 
other variables.  

2. Contest Goals 

× 

 How Active Goals are Stored 

In N1MM Logger+, goals are stored in a table in the Admin database. Only one set of 
goals can be active at any time, and regardless of the contest you open, they 
remain active until replaced. However, if you have defined a goal file on the 
Associated Files tab for a given contest, that goal file will be loaded whenever you start 
a new instance of that contest. For example if you define CQWW goals.txt as an 
Associated File in one instance of CQWWCW, that goal file will be loaded any time you 
open any instance of that contest. 

 
Here are some other key things to remember about N1MM Logger+ goals:  

  

2.1. Editing and Exporting Goals 

 
Right-click in the Info window, and click on Edit and Export Goals. That opens the 
following dialog:  



 

You'll note that the hour is stored in the form "dhh" where "d" is __the day of the contest 
and "hh" is the beginning of the hour, in clock time, not in terms of the hour in the 
contest. Hence, for example, "222" denotes the second day of the contest and the hour 
beginning at 2200Z. In the example, the goals were derived from an ARRL November 
Sweepstakes, which runs until 0300Z on the third day.  

You can edit this table just as you would any other table in an N1MM Logger+ database. 
Be careful with the "hour" column until you are comfortable with the convention. When 
you have made your changes, you can either export to a goals file in text format, which 
will be placed in Documents\N1MMLogger+\GoalFiles, or simply OK out of the dialog, 
in which case the changes are saved to the Admin database's Goals table.  

2.2. Goal Files 

This is the Goal file format:  



 

You can create a Goal file with a text editor and import it into the database using the 
Import Goals function (see below). Be sure that you use a straight text editor for this, 
such as Notepad. Word processing programs can insert special codes that N1MM+ 
does not understand.  

Note that you do not need to enter anything for those hours when you do not plan to 
operate, but you do need the header just as it appears here.  

× 

 Set Your Start Time 

Be sure to set the contest start time (in the Contest Setup dialog) to the correct value for 
any contest in which you intend to use goals. As you can imagine, this is important to 
ensure that the appropriate goal is displayed for the appropriate hour of the contest. 

2.3. Importing Goals 

Click on Import Goals, and this submenu will appear. You can import goals from a log or 
a .txt file in the GoalFiles Document directory  



 

o Typically, you will want to import goals from all bands, but if you plan to 
enter a contest single-band, you can set goals for that band only by 
clicking the appropriate radio button.  

o Click on the "Text File" button, and a dialog opens showing you all the 
goal files in the GoalFiles document folder. Select one, open it, and the 
contents are transferred to the database.  

o Click on "Log" and something new happens. This window opens:  



 

Select the database you want to get your goals from, and click "Open".  

Now this dialog opens:  



 

Select the contest from which you want to derive your new goals, and OK out. They are 
transferred to the Admin database. There you can edit them as outlined above, and 
optionally export them to a Goals file.  

 

2.6.8 The Score Window 

 2.6.8 The Score Window  

The Score window is automatically formatted to display the components of the score 
(such as QSOs, zones, and country multipliers) in the current contest.  

 

The Score window has an independent font resizer - the up/down arrows in the upper 
right corner - and is now resizeable. If you reduce its size so that not all the contents 



can be seen on-screen at once, scroll bars will appear to allow you tosee parts of 
interest without re-sizing.  

With a right mouse click, a menu will appear  

 Copy all - Copy all info to the Windows Clipboard.  
 Print to file - Print the score summary to a file.  
 Help - Show the user manual section for this window (Internet required).  

 

 

2.6.9 The Multipliers Window 

 2.6.9 The Multipliers Window  

o 1. Key Common Features  

 1.1. Color-Coding  
 1.2. Tailoring Mult Lists for Particular Contests  
 1.3. Mouse-over  
 1.4. Resizing  
 1.5. Clicking on Multipliers  

 1.5.1. Right-Click Menu - multiplier-specific options  
 1.5.2. Other Right-Click Options  

The Multipliers window is opened from the Entry window's Window menu. Right-clicking 
on the "Multipliers" selection opens a sub-menu from which you can choose one of five 
multiplier displays, depending on the contest.  



 

Choosing Countries, in a CQWW log, displays a chart like this:  



 

× 

 My Multipliers Window Looks Funny 

If your Multipliers window is empty or incomplete, right-click and look on the right-click 
menu for the option "Show Only Worked & Expected to be Worked Mults." If it is 
checked, then The multiplier window will only show mults that have been worked, ones 
that you have included in an expected mult list, and mults that have been spotted. 
Uncheck it, and the Multipliers window will return to normal.  

1. Key Common Features 

The drop-down menu gives 5 choices, each of which is tailored to meet needs in certain 
contests. Whichever you pick, there are some key common features.  

1.1. Color-Coding 

The color blocks displayed are, by default, blue for a band where the mult has already 
been worked (but a valid QSO is available), red meaning that a station is available for a 
single multiplier on that band, and green meaning a double multiplier QSO is available 



on that band, in those contests that have them. These colors may be changed to meet 
special needs through the Manage Skins, Colors, and Fonts editor on the Config menu 
of the entry window.  

Decisions by the program about whether a multiplier is available on a given band are 
based on callsigns, and for those contests in which multipliers are determined by the 
content of the exchange, the color-coding may not be accurate. A multiplier block 
remains on the chart until the underlying spot has expired under the current bandmap 
spot timeout setting. Open a Bandmap along with the Multipliers window, set a short 
timeout, and you will be able to see this happen.  

1.2. Tailoring Mult Lists for Particular Contests 

Users will often want to tailor one of the five available multiplier lists to a particular 
contest or QSO Party; for example, in WAE, non-European competitors will only want to 
keep track of European country multipliers.  

As a first step in this direction, the seven check boxes across the top right of the window 
permit you to limit the display to a single continent. Only one can be displayed at a time, 
but once you leave the "All" display, you will discover that you have some flexibility in 
the way that the columns of multipliers are arranged, to help you make best use of your 
screen space. This varies from one type of multiplier to another - for example, the 
States/Sections window must be displayed as a wide rectangle to group 10 US call 
areas and the Canadian sections in logical order.  

 
 
Gerald, VE1DT has done considerable work on defining the other tailoring possibilities, 
and much of what follows is based on his efforts.  

Options for doing this are found in the right-click menu reached from any of the five 
multiplier lists.  

 

Show Only Worked & Expected to Be Worked Mults - Checking this option limits the 
mults displayed to those specified by one of the methods below.  
Edit Expected Multiplier List - Clicking this option opens the following dialog  



 

You can use this dialog to edit the list of expected multipliers, one at a time. For 
example, if you are editing the countries to be displayed, you'll need to enter the country 
prefixes one line at a time, in upper case exactly as they are shown in the 
Multipliers window. For example, you need to enter "CE0X" not "CE0/X". If you enter 
specific bands, note that they are specified by frequency in MHz, not by wavelength in 
meters. Here's a simple example:  

 



Click OK to save the list, and if you check the "Show Only" option described above, the 
Multiplier window will look like this:  

 

Similarly-limited multiplier displays can be generated by the same process in the Zones 
display. Before the "Show Only" option is checked, this display will look like this:  

 



The reason for the 91 zone lines is to cover both CQ and IARU zones. Needless to say, 
there's no reason to have 91 zones in CQWW, so let's use this example to explore your 
options for creating and storing tailored multiplier tables for specific contests.  

 Hand editing - you can use the Edit Expected Multiplier List dialog  

1.3. Mouse-over 

Mousing over any prefix will display information about it - the name of the country, its 
continent and zone, long and short-path bearings, and the distance  

1.4. Resizing 

The Multipliers window may be reduced in size, in case your screen real-estate is too 
limited to show the whole thing. If you shrink it right-to-left or left-to-right, a horizontal 
scroll bar will appear to remind you that there is more information to be seen. Vertically, 
down-sizing causes the chart to be rearranged, so that a vertical scroll-bar is not 
necessary.  

1.5. Clicking on Multipliers 

in-edit  
Left-clicking on a block that is colored to denote either a single or double multiplier will 
QSY VFOA or Radio A to the frequency of the station that you can work for that 
multiplier. Blocks denoting stations that would be valid QSOs but not multipliers are 
not clickable.  

Right-clicking on a multiplier block or elsewhere in the open Multipliers window (other 
than the title bar)opens the right-click menu.  

1.5.1. Right-Click Menu - multiplier-specific options 

 Some of the options are keyed to the particular multiplier block clicked, and will 
be greyed out if you click elsewhere. To Show Calls Worked and Spots Available, 
you will need to right-click one of the band blocks, not the prefix.  

o Show Calls Worked and Spots Available will display a list of all stations 
already worked for the multiplier, regardless of band, whether the box you 
clicked is green, blue, red or empty. It will also display a list of spots 
currently available for the multiplier on a new band or mode.  

o If you are showing a chart of zones worked (in CQWW, for example), this 
option can be clicked to show the country prefixes that count for the zone 
on which you right-clicked.  

o Turn Antenna - if rotator control is enabled, clicking on this option will turn 
the antenna to the short-path direction of the multiplier from your QTH.  

1.5.2. Other Right-Click Options 

o Set Bands and Modes to be Displayed - opens a dialog that looks very 
much like the Telnet and Available windows' Bands and Modes dialogs. 



Again, we recommend that for most purposes you just click "Contest" and 
let the program take care of it for you.  

o Help - will take you via the Internet to this section of the manual.  

 

 

2.6.10 The Statistics Window 

 2.6.10 The Statistics Window  

o 1. General  
o 2. File Menu  
o 3. Example Statistics  

The Statistics window can be found under View > Statistics in the Entry Window. New in 
N1MM Logger+ is provision of graphical as well as tabular presentation of data. Select 
either by clicking the tabs at the top of the screen.  



 

Or you can present the same data in graphical form. Be forewarned, this is not a PJ2T 
log - that call is just an example.  



 

The graphical representation really comes into its own when the data are more 
complex. For example, if you want to know at a glance which bands were most 
productive when, graph hours versus bands.  



 

× 

 Tip 

During a contest, if you are checking Statistics and a station comes back, just start 
typing. The statistics window will go to the background and every typed characters will 
go to the Entry window. 

1. General 

The Statistics window allows you to select almost all database fields from a contest for 
display in tabular form by row and column, or in graphical form. The following table 
explores the options and their usefulness in various contexts.  

Fields Row Column Remarks  



Band Y Y 
 

Operator Y Y 
compare operators, only useful when running Multi-
operator  

Hour Y N 
 

RadioNr Y Y only useful when using more than one radio  

Mode Y Y useful in mixed contests  

CountryPrefix Y N worked number of stations per country or mode  

Zone Y Y 
 

Section Y Y 
used in many domestic or local contests - may equate to 
province, oblast, ARRL section, etc., depending on the 
contest  

CK Y N 
2 digit number used in Sweepstakes, formally denoting the 
year first licensed  

Prec Y Y 
"Precedence" used in Sweepstakes to denote class of 
entry  

Points Y Y 
 

Mult1 Y Y multiplier, or first multiplier in contests with more than one  

Mult2 Y Y Second multiplier in contests with more than one  

Mult3 Y Y Third multiplier where applicable  

WPXPrefix Y N prefix as determined by WPX rules  

GridSquare Y Y 4-character of grid square  

Run1Run2 Y Y useful when doing SO2R  

MiscText Y N Contest specific information  

ContactType Y Y 
Blank = qso, "D" = dupe, "N" = non-workable or zero-point 
station (same country in CQWW, for example)  

Day Y Y first or second day of the contest  

Mult & Band Y Y 
 

Exchange1 Y Y Use in some contests (like WAE to show QTCs) 

× 

 Note 

Old contests may not have valid values in fields that have been added since the contact 
was logged. The number of contacts shown on screen and printed on the summary 
sheet are without dupe contacts. 

 

2. File Menu 



 Copy All - Copy the contents of the window to the Clipboard, either as text or as 
a graphic  

 Print - Print the statistics table to a printer. Font can be set by user. Also prints 
graph displays if supported by your printer  

 Print to File - Print the statistics table to a file. This function is greyed out when a 
graph is being displayed.  

3. Example Statistics 

Try these examples with an old log:  

Row Column Usage Description  

CountryPrefix Band Always QSOs per country per band  

Hour Operator Multi User QSOs per hour per operator  

Band Operator Multi User QSOs per band per operator  

GridSquare Band Grid contests QSOs per gridsquare per band  

Band Exchange1 WAE and some other Show RQTC & SQTC info 

 

 

2.6.11 Manage Skins, Colors and Fonts 

 2.6.11 Manage Skins, Colors and Fonts  

o 1. Colors Tab  
o 2. Fonts Tab  
o 3. The Skins Menu  

 1. Load Existing Skin  

 1.1. Load Skin from File  
 1.2. Load Default Skin  

 2. Save Current Selections as Skin File  

o 4. Other Settings  

 1. Show Form Font Sizers  
 2. Snap Windows to Edges  
 3. Tooltips  

The configuration settings for N1MM Logger Plus allow customization of most of the 
fonts and colors used in the program. To access the Manage Skins, colors and Fonts 
dialog window, select Manage Skins, Colors and Fonts on the Entry window's Config 
menu.  



 

1. Colors Tab 

The Colors tab displays the current setting for 24 program colors. Clicking the 
<Change> button in the left column allows you to select a different color. If you select a 
color different than the default skin color (read about the default color below), a <Reset> 
button will appear in the right hand. Clicking <Reset> will revert that color to the 
program's default value, regardless of the skin you are currently using.  

Color settings can be grouped in three categories: Global, Shared, and Dedicated.  



 Global color settings affect every window in the program. Examples of Global 
colors are:  

o Background color for all program windows  
o Background color for program buttons  
o Background color for text areas of most windows  

 Shared color settings affect several windows in the program. Examples of 
Shared colors are:  

o Callsign colors (dupes, normal Qs, mults, double mults): Affect the colors 
of callsigns in the Bandmap, the Digital Interface Receive window, and the 
Entry Window callsign field  

 In an example of extended sharing, in the Function Key Editor, 
Comment lines are identified by using the callsign Dupe color, Run 
Message lines are the normal QSO color, and S&P Message lines 
are the Double Mult color.  

o Callsign background colors (dupes, normal Qs, mults, double mults): 
control background colors in the Check window and the Entry window 
Band Panel buttons.  

 Dedicated colors affect only one window. Examples of Dedicated colors are:  
o Frequency and line colors only affect the Bandmap(s)  
o Background color, color of normal text, and Color of My Callsign all apply 

only to the DI Receive window  
o Color of transmit indicator dot in the Entry Window - the color the normally 

red dot turns to when transmitting  

2. Fonts Tab 

The Fonts tab displays the current setting for five program fonts. Clicking on the font 
description allows you to select the font family and default font size. If the selected font 
family and size are different than the default program font (read about the default font 
below), a <Reset> button will appear to the right of the font description. Pressing 
<Reset> will revert that font to the program's default value, regardless of the skin you 
are currently using.  

When making large changes to font sizes, some windows may not automatically adjust 
to the new sizes. It might be necessary to close and re-open the windows for the new 
size to display properly.  



 

 Entry Window Callsign  
Controls the font family and size for the Entry Window fields - callsign, signal 
report and contest exchange  

 Medium - Screen Text and Tables  
Controls the font family and size of warnings and special messages in the Entry, 
Info, and Multipliers windows  



 Small - most labels, Log and Network Status Window data  
Controls the font family and size for notes in the lower portion of the Info Window 
and the grids of the Log and Network Status Windows  

 Smaller - Buttons, Small Labels, Bandmap Window Callsigns  
Controls the font family and size for all program buttons and tabs, notes in the 
upper portion of the Info Window, summary table in the Available Mults and Qs 
Window, frequency and callsigns in the Bandmap, text in the Multiplier Window. 
This font is used in every window of the program.  

 Fixed - Digital Interface, Telnet and Score Windows  
Controls the font family and size for the Check Window, Telnet Window, Digital 
Interface Receive Window and the Score Summary Window.  

3. The Skins Menu 

Click the link at upper left.  

1. Load Existing Skin 

 

Skins are collections of settings that include the font family, font size, and colors. N1MM 
Plus includes a variety of built-in skins (see screenshot) from which you can choose. 
You cannot change these built-in skins, but you can use them as a foundation in 
creating customized skins.  

1.1. Load Skin from File  
Loads font and color settings from a .SKIN file. The files must be located in your 
Documents\N1MM Logger+\SkinsAndLayouts directory.  

1.2. Load Default Skin  



Self-explanatory. Gets you back to the default set of colors and fonts.  

2. Save Current Selections as Skin File 

After adjusting colors and fonts, you can save the settings in a .SKIN file, which will be 
stored in your My Documents\N1MM Logger+\SkinsAndLayouts directory.  

 
 

4. Other Settings 

 

These are found in the lower frame of the dialog, and displayed along with any of the 
tabs  

1. Show Form Font Sizers 

 
Enabling this setting allows individual font sizes in specific windows, regardless of the 
default font size setting. When enabled, Font Sizer controls will appear in the upper 
right-hand corner of the following windows: Telnet, Log, Available Mults & Qs, Multiplier, 
Digital Interface, Info, Check, Score Summary, and Bandmap.  

2. Snap Windows to Edges 

Enabling this setting simplifies the task of aligning program windows adjacent to each 
other.  

3. Tooltips 



 
Tooltips display helpful hints that appear when you pause your mouse over certain 
locations in program windows. The option at the bottom of the Skins, Colors and Fonts 
window allows you to choose between no tooltips (once you feel comfortable with the 
program), "standard" tooltips (usually one line of text) and "balloon" tooltips that may be 
several lines. You'll find tooltips particularly useful in the Bandmap and Available Mults 
and Qs windows, where mousing over a call-sign displays the age of the spot, who 
spotted it, how long ago, and anything that was in the Comment field of the spot.  

 

2.6.12 Visible Dupesheet Window 

 2.6.12 Visible Dupesheet Window  

o 1. Example Visible Dupesheet  
o 2. What is the usefulness of the Visible Dupesheet?  

1. Example Visible Dupesheet 



 

 

The Visible Dupesheet is a quick way to determine if a station is a dupe without having 
to enter the callsign in the program. The calls already worked will be indexed much like 
a paper dupesheet that is organized by call area and suffix. The Visible Dupesheet is 
especially useful for short, high speed contests like the NA Sprint. It is closely patterned 
on the Visible Dupesheet used by TR Log.  

 Each VFO/Radio/Bandmap has its own Visible Dupesheet. The VFO/Radio A 
sheet displays all of the contacts for the band VFO/Radio A is on. VFO/Radio B 
does the same for whatever your VFO B/Radio is set to even if you don't (or 
cannot) use VFO B  

 The columns signify call areas. If a call area exceeds the number of calls that will 
fit it will overlap into an adjacent column with some dash lines to differentiate  

 Each call area is sorted by suffix  
 To see the dupe sheet for any band, set your radio to that band  
 To check for a dupe, first look for the call area column, then look up the suffix, 

then the prefix  
 If you don't want both windows open, close one, position the other where you 

want it and then use Tools > Save Window Positions. The next time you start the 
program only one window will open  

 Unless you can copy RTTY in your head, you do not need the Visible Dupesheet 
for RTTY contests. Obviously RTTY calls will tell you they are dupes or not as 
soon as they print  

 The Visible Dupesheet can hold a maximum of 800 stations per band. Going 
above this limit will give a warning . Depending on computer speed and 
configuration, users may experience noticeable delays when using the Visible 



Dupe Sheet with logs containing more than 300 calls. Performance with 600 
callsigns is acceptable with a 2.6 GHz computer running only Logger  

 Font size is set here. The Visible Dupesheet uses the last (Fixed) font.  
 There are no menus in this dialog  

2. What is the usefulness of the Visible Dupesheet? 

By Steve, N2IC  

First, let me say what this feature is not: It is NOT intended to be a step towards paper 
(or electronic) dupe sheet submission. A paper dupe sheet is an obsolete artifact of the 
pre-computer logging era.  

Now, I'll be perfectly honest about the utility of the Visible Dupesheet. I have been a 
user of TRLog for many years, as well as a fan of the NA Sprint contest. To do very well 
in an extremely fast-paced contest, like the NA Sprint, you have to minimize the amount 
of non-productive time. Any time you are not actually making a QSO is non-productive 
time. As you tune around a band, looking for new stations to work, you need a really 
fast way to determine if a station that you hear is a dupe. The fastest way to do this is to 
use only your brain. Some contesters have an amazing ability to keep their dupesheet 
completely "in their head". For the rest of us, we typically reach for the keyboard and 
type the call into the entry window. As soon as you do this, N1MM Logger+ instantly 
tells you whether it's a dupe. Excellent. However, some of the NA Sprint operators who 
use TRLog have found an even faster way to check for a dupe - using TRLog's Visible 
Dupesheet feature. As you tune the band, you keep your eyes focused on the Visible 
Dupesheet. It becomes second nature to scan the Visible Dupesheet. When you hear a 
non-dupe that you want to call, you don't even have to enter the call in the Entry 
Window, yet. Just hit the Enter key. If he/she comes back to you, you now have time to 
enter his/her call and exchange.  

Obviously, in a contest where you work many, many stations on each band, this feature 
won't work - it takes too long to scan the Visible Dupesheet when it is crowded with 
calls. However, this is not the case with the NA Sprint. The winners work no more than 
150 stations per band, making the Visible Dupesheet an ideal way to dupe check.  

 

2.6.13 Grayline Window 

 2.6.13 Grayline Window  

o 1. Setup Menu Selections  

http://n1mmplus.hamdocs.com/tiki-index.php?page=Skins+Colors+and+Fonts+Window#Fonts_Tab


 

1. Setup Menu Selections 

 

 Show Sun - Select or de-select showing the current position of the sun on the 
Grayline map  

 Show Equator - Show or hide the Equator on the map  
 Show Meridian - Show or hide the Greenwich Meridian  



 Show Home Location - Will show a red dot on your location as set in N1MM+ and 
explained in Installing the Software.  

 Number of Spots to Display - Select 0, 50, 100, 150 or 200 most recent spots to 
be displayed on the map.  

 Clear All Spots - self-explanatory  

 

2.6.14 CW Reader Window 

in-edit  

 2.6.14 CW Reader Window  

o 1. CW Reader Setup  
o 2. CW Reader Operation  

The Logger's CW Reader is receive-only. The CW reader engine cannot be used to 
transmit CW; to transmit CW, you must configure some other method in the Logger 
(serial or parallel port keying, or a Winkeyer, for example).  

1. CW Reader Setup 

The first time you open the CW Reader window, or any time the window is opened with 
no CW reader engine selected in the setup, the following dialog will be displayed:  

 

After clicking on OK in the above window, or at any time thereafter by selecting the 
Setup menu in the main CW Reader window, the following setup window will be 
displayed:  

http://n1mmplus.hamdocs.com/tiki-index.php?page=Installing+the+Software#Edit_Station_Information


 

N1MM Logger+ supports three different CW reader programs, or "engines".  

The first, Fldigi by W1HKJ, is also one of the digital engines that is supported by the 
Logger for digital modes. Fldigi is not automatically installed with N1MM Logger+; if you 
want to use it, you must download and install it. Once Fldigi has been downloaded (and 
optionally configured for digital mode operation - see the Digital - Fldigi for Sound Card 
Modes chapter), it can also be used as a receive-only CW reader (N1MM Logger+ does 
not support transmitting CW from Fldigi). Click on the Enable check box for Fldigi. You 
may wish to use a separate copy of Fldigi for CW from the digital modes copy; that way, 
the configuration setups for Fldigi for CW and for digital modes can be saved 
separately. If you do this, both of these copies of Fldigi should be outside the Program 
Files or Program Files(x86) paths in Windows Vista or later, in order to enable the 
configuration files to be saved. You can run Fldigi stand-alone from a location in the 
Program Files path, but any copy of Fldigi that is run from N1MM Logger+ in Windows 
Vista or newer must not be located in a protected Program Files path. You do not need 

http://n1mmplus.hamdocs.com/Digital%20-%20Fldigi%20for%20Sound%20Card%20Modes
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to do the original installation of Fldigi outside the Program Files path. Simply install in 
the default location, create a new location outside the Program Files path, and copy the 
fldigi.exe file from the original installed location into the new location. The first time it is 
run from the Logger, fldigi will create the other files it needs in the new location.  

 

The second supported CW reader program is CwGet by UA9OV. This is a shareware 
program that can be downloaded from the www.dxsoft.com web site. It may be used 
either unregistered (free), or registered (requires a fee to be paid to the author). The 
unregistered version does not save configuration information between runs, which 
means that you will have to perform the setup (primarily selection of the sound card to 
be used) each time the CwGet engine is started. In either case, after downloading and 
installing CwGet you can select it in the CW Reader setup window by checking the 
Enable check box for CW Get and entering the path to the program. It is also possible to 
select command line settings for CwGet in the setup window. Unlike Fldigi, CwGet may 
be run from the default installation location even if that location is in C:\Program Files or 
C:\Program Files(x86). You do not need to make a separate copy of CwGet outside the 
Program Files path.  



 

The third supported CW reader type is an external TNC that is capable of decoding 
Morse code. You set up the COM port communications parameters for the TNC in the 
bottom part of the window.  

Once the CW reader engine has been selected, click on Save to save the selection and 
exit the Setup window. This will open one or two new windows: the CW reader engine 
window (if you are using Fldigi or CwGet) and the CW Reader text window (see next 
section). There will be further configuration required in the CW reader engine window 
the first time it is used (or every time if you are using an unregistered copy of CwGet), in 
order to select the sound card that is used for decoding. The Fldigi configuration window 
may open the first time you use it; if it does, the only configuration information that is 
needed for the CW Reader engine is the sound card setup, and you can skip over the 
other parts of the configuration. The first time Fldigi is used as a CW reader engine, it 
may start up in a digital mode and you may need to change its operating mode to CW.  

Since N1MM Logger+ supports two Entry windows (for two VFOs in SO2V, or for two 
radios in SO2R), it also supports two CW Reader windows. The CW Reader window 
corresponding to each Entry window is opened from the Window > CW Reader menu 
item in that Entry window. In order to save separate configurations for the engines in the 
two CW Reader windows, you will need to use two separate copies of the engine, one 
for each CW Reader window.  

Both CW Reader software engines (Fldigi and CwGet) use a sound card for decoding. 
This requires an audio cable connection between the radio and a sound card input. The 
radio output can from a speaker or headphone output, or a line output if a separate 
output (possibly labelled for digital modes) is available. The sound card can be a 
motherboard sound card or a separate sound card, either internal or external. If 



possible, the input used should be a line-level input. If the only input available is a 
microphone input, you may need to supply an attenuator (resistive voltage divider) 
between the high-level output from the radio and the low-level microphone input on the 
sound card. If you are using a TNC as the CW Reader engine, the audio connections 
will be between the radio and the TNC, and there will be a serial port connection 
between the TNC and the computer.  

Note that older versions of Fldigi only use the left channel on input; for that reason, in 
most SO2V installations these older versions of Fldigi can only be used from Entry 
Window 1. Starting with Fldigi version 3.22.06, Fldigi is now capable of using either 
sound card channel for input. In any copy of Fldigi that you want to use with the right 
channel of the sound card, use the Configure > Sound Card menu item in the Fldigi 
window to open the Fldigi configuration window. Select the Right channel tab, and near 
the bottom under Receive Usage, check the Reverse Left/Right channels check box to 
switch Fldigi to use the right channel on receive. Click on Save to save the configuration 
change, and then close the configuration window.  

Recent versions of fldigi may default to requiring confirmation from the user before you 
shut them down. If that shutdown is initiated by shutting down N1MM Logger+, instead 
of by shutting down the CW Reader window and engine first, this can result in fldigi 
continuing to run after the Logger has shut down. This can cause problems the next 
time you start up the Logger. To prevent this from happening, you need to make a 
change in the fldigi configuration file. In each folder that fldigi is run from, find the file 
called fldigi_def.xml. (Note: this file is created the first time fldigi is run from this location, 
i.e. it will not exist until after you have run that copy of fldigi at least once). Right-click on 
the file name, select Open with... and then select Notepad or Wordpad as the program 
to open the file with. Look for a line that reads <CONFIRMEXIT>0</CONFIRMEXIT> or 
<CONFIRMEXIT>1</CONFIRMEXIT>. If you see a 1 between the two keywords, 
change it to a 0 and save the file. Repeat this for every copy of fldigi you use from within 
N1MM Logger+ (DI1, DI2, CW Reader 1 and/or CW Reader 2).  

If you choose to use CwGet as the engine, note that if you use an unregistered copy of 
CwGet with input from the right channel of the sound card, that unregistered copy will 
not transfer decoded text to the corresponding CW Reader window. In most SO2V 
installations CwGet will have to be registered if you want to use it from Entry Window 2. 
Also, unregistered copies of CwGet will not save their configuration data, meaning you 
will have to set up the sound card parameters every time you start CwGet; registered 
copies will save their configuration data and remember it between sessions. The 
configuration data is stored in an ini file in the N1MM Logger+ user files area (the same 
location as the N1MM Logger.ini file). It will be called CWGET1.INI (Entry Window 1) or 
CWGET2.INI (Entry Window 2 in SO2R or SO2V).  

2. CW Reader Operation 



 

 

The CW Reader window is where decoded received text appears. If the scrolling 
method selected in the Digital Interface Setup window is "scrolling", then as new 
incoming text is decoded, older text is scrolled off the top of the screen. If the scrolling 
method selected for the Digital Interface is "non-scrolling", then text does not move, but 
incoming text overwrites previous text on the current line; the current line where 
incoming text is displayed is indicated by underlining, and moves down the window one 
line at a time, jumping back to the top of the window once the bottom line is filled. You 
can stop scrolling temporarily by clicking on the green bar at the left of the window; the 
green bar will turn yellow and the text will stop scrolling so you can copy it without 
having to follow it up the screen or catch it before new incoming text overwrites it. When 
you click on the yellow bar to resume normal scrolling, the bar will turn green, text that 
was decoded while scrolling was stopped will be sent to the window, and then normal 
operation will resume.  

You can click on call signs and exchanges in the text window; depending on where the 
focus is in the Entry window, this will automatically transfer the text that was clicked on 
into the call sign or exchange box in the Entry window. This operation is similar to the 
way the Digital Interface window is used in RTTY and PSK31.  

There are two menu items in the CW Reader window. The first one, Setup, opens the 
setup window to enable you to change the CW reader engine. The second one, Clear 
RX, simply clears the received text window.  

In order for the CW reader engine to work, the signal you wish to copy must be tuned in 
correctly. The CW reader engine has tuning aids (either a waterfall or a spectrum 
display in Fldigi, and a spectrum display in CwGet) to help you tune signals accurately. 
You can fine tune by clicking in the spectrum display, but be aware that fine tuning in 
the CW reader engine will have no effect on your transmitted signal's frequency. If you 
wish to transmit on the same frequency as you are receiving on, your best bet is to set 
the CW reader engine's audio frequency to be the same as your transmitter's sidetone 
frequency, and then tune signals using the transceiver's tuning knob (not by clicking in 
the spectrum display or waterfall).  

Software decoding of CW (Morse code) has its limitations. The signal to be copied must 
be fairly strong (at normal CW speeds, the human ear can decode CW at lower signal-
to-noise ratios than software can) and clear of QRM and QRN (heavy QRM or QRN can 



render the CW undecodeable). The sent CW timing must also be accurate (e.g. 
machine-sent CW). On a good machine-sent signal such as ARRL CW bulletins, 
software copy can be nearly perfect. On the other hand, sloppy hand-keyed CW can 
result in errors ranging from poor spacing (v e 3 k i instead of ve3ki) to a complete 
failure to copy (nothing but Es and Ts displayed, as the reader software triggers on 
individual dits and dahs).  

 

 

2.6.15 Real-time Score Reporting Application 

 2.6.15 Real-time Score Reporting Application  

The separate Contest Reporting Application (real-time score reporting) no longer exists. 
The same functions have been incorporated in N1MM Logger+. See this section.  

 

2.6.16 The Network Status Window 

 2.6.16 The Network Status Window  

o 1. Tabs  

 1.1. The Stations Tab  

 1.1.1. Right-Click Menu  
 1.1.2. What, Another Right-Click Menu?  

 1.1.2.1. Adjusting the Stations Tab's Format  

 1.2. The Resynchronize tab  
 1.3. The Rescore tab  
 1.4. The Options tab  
 1.5. The Actions Tab  
 1.6. The Messages Tab  
 1.7. Recovering from a Broken Logging Computer  
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The Network Status Window is brand new in N1MM Logger+. All network-related 
options and actions have been moved to this new Window, with some minor 
exceptions for backward compatibility reasons. Those remain in the Info window. 
The new network scheme also simplifies and automates the network setup. So long as 
each computer on the network is running the same version of N1MM Logger, and the 
same contest and multi-operator class in the Contest Setup, the network will be set up 
automatically.  

× 

 Turning on Networked Computer Mode 

If you open the Network Status window without enabling networking, you will see a 
framed warning: "Networked Computer Mode is off - Click here to turn on." This function 
replaces the Networked Computer Mode option that used to be on the entry window's 
Config menu.  
Do as it says and the other computer(s) in the network will appear. 

1. Tabs 

Whenever you open the Network Status window, it comes up in the Stations tab.  

1.1. The Stations Tab 

As you can see above, this tab contains all the basic information about each station in 
the network:  

 Computer - This is the name assigned by Windows  
 IP Address - on the local area network  
 Pass - The pass frequency (to which other stations on the network can pass new 

mults). Each station can set or change this frequency for itself manually (on the 
Actions tab) and all stations can then see the new frequency.  



 Run - Whether each station is in Run or S&P mode  
 10/100 - What its current QSO rate is (last 10 and last 100 QSOs)  
 Freq - What frequency it is currently on.  
 Op - Who is operating (as set by OPON or Ctrl+O)  
 Msg - What, if anything, that station has just done, such as pressing a function 

key  
 Send/Receive - normally reads "OK" unless there is a problem with the network.  
 Master - Permits checking to select one station on the network as the master. 

Check one to determine which connects to the Internet for cluster spots and time 
synchronization.  

 
A (((*))) in the title bar of the Network Status window means that your computerjust 
broadcasted its IP address, usually in the process of establishing a connection to the 
network. When connection is established, the title bar will reflect the number of stations 
in the network.  

The red highlight on the Messages tab means that there is a network message waiting 
there that has not yet been read. In most cases, it is normal administrative traffic, such 
as a connect request from another station on the network. The red highlight may also be 
seen on the computer name during the connection process, usually accompanied by a 
red highlight in the Send or Receive column. These will disappear when a good 
connection is established.  

× 

 Keeping Computer Clocks in Sync 

In order to keep all of the clocks on a network in sync, all "slaves" - computers other 
than the one designated as "master" - must be run as Administrator (by right-clicking on 
the desktop icon and selecting "Run as administrator" from the pop-up menu), and the 
master must be set up to sync with Internet time (at Date/Time in Control Panel). 

1.1.1. Right-Click Menu 

The right-click menu on the Stations tab opens a menu of powerful functions that most 
multi-op operators will find important in real time. The rationale for placing it here is that 
most operators will keep this tab on-screen, since it contains so much important 
operational information. Each of these functions requires right-clicking on the line 
entry of a computer other than the current one, to identify the affected computer 
and open the right-click menu.  



 

 Pass current/last QSO - If you right-click on a computer to which you wish to 
pass your current or last QSO (assuming that the station just worked has agreed 
to QSY), and then click this option, a Talk message will be sent to the Info 
window of the target computer, telling the other operator who to expect and on 
what frequency. If that computer's Pass Frequency is set to zero, then the 
Message will show the receiving computer's frequency at that time.  

 Talk - A right-click on any computer in the network, followed by a click on this 
option, will open the Talk sub-window with that computer's name already 
entered.Talk messages appear in the Info window of the receiving 
computer.  

 Show connection log - Right-click on a computer and then on this option, and a 
log of communications events between your computer and the one selected will 
be displayed as an aid to trouble-shooting.  

 Target for call stacking - The intended use of this feature is for large multi-ops 
that have more than one radio on a given band, to permit the "helper" operator to 
identify and queue stations for the run operator to work. If the two computers are 
on the same frequency (+/- a small tolerance), a right-click on the target 
computer turns on call stacking. Thereafter, any callsign that the "helper" op 
enters in his Entry window will appear in the call-frame of the target computer's 
Entry window. The run operator only needs to hit [Space] to pull the call down 
into the call-sign textbox, ready to work. There is a checkbox on the Options 
tab which, if selected, will clear the sending computer's Entry window if the 
target computer works the station that has been stacked.  

 Close and Open connection - These options are used to open and close 
connections between the current computer and the one you right-clicked on.  

 Prevent automatic reconnect attempts - used when trouble-shooting the 
network to stop the selected computer from sending reconnect requests every 
thirty seconds.  



 Set station as master for telnet and time sync - Another way to set any given 
computer on the network as the Master for receiving DX cluster spots and 
performing time synchronization. Note that time synchronization requires that 
N1MM Logger+ be run as Administrator on the receiving computer(s).  

 Auto-set column widths - used to adjust the format of the Stations display to 
the minimum required to display the information currently present on-screen  

 Call for Help - Sends an audio request for assistance to the computer you 
clicked on, together with a text message in the receiving computer's Info window.  

 Stop Networking (not recommended during contest) - self-explanatory.  
 Help - when Internet access is available, displays the appropriate section in the 

User Manual.  

1.1.2. What, Another Right-Click Menu? 

There is a second right-click menu associated with this tab. It is made visible when you 
right-clink on the column headings row of the tab ("Computer", "IP Address", etc.) . It 
allows you to select which columns on the Stations tab you want to display, in the event 
that you want to minimize required screen space while still monitoring network activity.  

 

1.1.2.1. Adjusting the Stations Tab's Format  
If you put your cursor between column headings in that row and move it rightward 
almost to the next column to the right, you'll see that it changes to a standard Windows 
"change width" character (a vertical line with horizontal arrows facing away from it). You 
can drag that marker right to increase the width of the column to its left, or left to 
decrease the width of that column.  

It is possible using this control to make the heading of a column disappear altogether. If 
you do that and want to recover, right-click in the body of the tab, and select "Auto-Set 
Column Widths" to get back to the full set of minimum-width headings.  

You can also reorder the columns, by clicking on a column heading itself and dragging it 
where you want it. Be a little cautious in doing this, though, because there is no 



command for automatically restoring column order to the original - you'll have to do that 
manually.  

1.2. The Resynchronize tab 

 

Normally every computer has a copy of every QSO in the log. If all computers stay 
connected at all times, new QSOs entered on one computer are broadcast to the other 
computers in the network so that every computer always has a complete copy of the 
log.  

If it is necessary to edit or delete a QSO, the computer that the QSO was initially logged 
from must be used to perform the change. Other computers do not have permission to 
change the QSO. Any such change made at the originating computer will be reflected 
on all computers that are connected to the network at the time the change is made.  

If a computer becomes disconnected from the network, you can continue to log contacts 
on it. When the computer rejoins the network, all QSOs made on that computer will 
automatically be sent to the other computers, and all new QSOs made on the other 
computers will be copied to the rejoining computer. This process is called 
resynchronization (resync for short).  

Resynchronization of newly added QSOs is automatic. However, if changes (edits or 
deletions) are made to previously existing QSOs while a computer is disconnected from 
the network, those changes will not be applied during the automatic resync process. In 
other words, the automatic resync when a computer reconnects to the network only 
updates new QSOs; it does not update QSOs that were already in the log. Because of 
this, it is a good idea to perform an additional manual resync at the end of the contest in 
order to ensure that all the logs are identical, and that is the purpose of this tab.  



A manual resync operation initiated from this tab requests each other computer in the 
network to update the requesting station's copies of all QSOs that were originally logged 
at the other computer in order to take into account the effects of any changes (edits or 
deletions) that were made during network outages.  

 The "Contest" button will resynchronize from the start of the contest.  
 The "Last" button and the textbox next to it are used to resync for a shorter 

period when you know when the problem occurred.  
 The "Since" button works the same way but by resync start date and time rather 

than duration.  
 The "Resync All Stations" checkbox syncs each log with all others 

simultaneously. Use this after the contest is over to ensure that all logs are 
identical. This can be a resource-intensive process; in order to avoid disrupting 
operations at other computers, do not use it during the contest while any 
computers are still being used to log new contacts.  

 The "Rescore When Done" checkbox rescores the contest after the resync is 
complete on this computer, or all computers if Resync All is selected  

1.3. The Rescore tab 

 

This tab controls rescoring the log on the local computer, recalculating QSO points and 
multipliers, in order to take into account the effects of any changes (edits or deletions) 
on the final score. This is recommended practice at the end of a contest, before a 
Cabrillo file is generated for sending to the contest sponsor. The buttons are the same 
as those on the left-hand side of the Resynchronize tab, and are used similarly .  

1.4. The Options tab 



 

Left to right and top to bottom, following is a description of the radio buttons and 
checkboxes on this tab.  

 Run1/Run2 radio buttons - these buttons are greyed out except in the case of 
the Multi-2 class, in which case you can click the radio button to designate the 
current computer as Run 1 or 2.  

 Don't work non-mults - check this box if you are entered in the multi-single 
class in contests where the current computer must not work non-multipliers. 
When checked, will block the station from working non-mults. Function key 
messages will not be sent to a non-mult.  

 Don't automatically change to S&P mode - When checked, prevents the 
current computer from switching from Run to S&P mode when QSYing by more 
than the tuning tolerance for its mode. See this page for more details on per-
mode tuning tolerance.  

 Wipe callsign when logged by stack target - Use in conjunction with call 
stacking. If you stack a callsign for your partner to work, and he works it, your 
call-sign textbox will automatically be cleared so you can stack another.  

 Trace Networked Computer messages - a trouble-shooting tool that logs 
messages between computers on the network to a file titled 
MultiUserMessages.txt  

 Force ALL other stations to stop transmitting when I transmit - self-
explanatory  

 Block my Tx only if other station transmitting on the same band and mode 
(multi-one) - self-explanatory  

1.5. The Actions Tab 
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 Talk (Ctl+E) - opens a sub-window, in which you can send or receive talk 
messages to/from the other station(s) on the network.  

 



 

The first of these two illustrations is an empty Talk window. By default, Talk messages 
are sent to all stations, denoted by the asterisk. If you enter a computer name in place 
of the asterisk, followed by a space and the text of a message, the message will be sent 
only to that station. That computer name then becomes the default address for Talk 
messages from you until replaced. Note: you must enter the computer name exactly as 
shown in the left-most column of the Stations tab, except that whatever case you enter 
will be changed to all upper-case to conform with the Microsoft standard.  

The upper pane is now where talk messages are received, as in the second illustration. 
Messages in red have been received, and are also displayed in the bottom pane of the 
Info window, Ctrl+E can now be used to toggle the Talk window between full size and 
minimized to the lower left corner of your screen.  

The first time you receive a Talk message while the Talk window is open but minimized, 
you will notice a new icon in the right-hand end of the Windows taskbar, with a message 
balloon above it. The icon will remain there until the Talk window is closed. This is in 
addition to the N1MM+ logo you will see over to the left, which is present any time the 
program is open. Thereafter, each time a new talk message comes in while the Talk 
window is minimized, a message balloon will appear above the new icon, as illustrated 
below. The message balloon is displayed for 5 seconds and then disappears.  

 

If you want to send a message only to a particular station, right-clicking on that station's 
line on the Stations tab and then selecting "Talk" will relieve you of having to fill in the 
computer name. Other operation is as above.  

 Set Your Pass Frequency - enter the frequency you want other stations on the 
network to pass stations to. It will appear on all stations' Stations tab.  



 Stop Networking - Self explanatory - strongly discouraged during a contest.  
 Force Time Sync - Self-explanatory  
 Edit Computer Addresses - N1MM Logger+ networking is automatic within a 

single subnet, which is usually the case in local area networks. However, if you 
want to network across a Wide Area Network, or in rare instances where your 
network involves more than one subnet, auto-configuration will not work. In that 
case you will need to fill in computer addresses in this table exactly as assigned 
by the network(s). For WAN networking you must enter the external IP 
addresses of each LAN and also port numbers for all the computers you wish to 
connect to, in the format XX.XXX.XX.XX:port number}. The port number is 
needed to permit operators to set up forwarding through their router firewalls to 
the right computer. If going subnet-to-subnet, you do not need to enter port 
numbers and the IP addresses would be the internal IP address. Here's an 
example in the WAN case, such as would be needed for a distributed IARU HQ 
"station":  

 

 

o You'll note that the first computer listed has no port number - this is 
because 12070 is the N1MM+ networking port for all computers on any 
LAN. The port numbers on the others are ones you assign, for use only in 
port forwarding.  

o Please refer to your router help file for instructions on setting up port 
forwarding.  



 Reset Serial Numbers at All Stations - only for use when you have screwed 
up. Sets the serial numbers on all computers to the highest value in any of the 
logs, plus 1, so you can start a new serial number sequence without duplicate 
numbers. This does not change the serial numbers of QSOs that are already 
logged.  

1.6. The Messages Tab 

Displays networking messages  

1.7. Recovering from a Broken Logging Computer 

 
What do you do if one of your computers no longer works?  

DO NOT ADD ANOTHER COMPUTER WITH THE SAME NAME!  

If you do not replace it on the network  

1. Each computer will have a copy of the QSOs logged by the broken computer. If 
they all agree on the number of QSOs, then you should be fine. If not, you will 
need to compare the lists from each one and determine which QSOs are 
missing.  

 
If you replace it on the network  

1. Locate a running network computer whose log includes the QSOs from the 
broken logging computer. SHUT THE PROGRAM DOWN on this computer.  

2. Copy that computer’s <log>.S3DB. <log>.s3db-wal and <log>.s3db-shm 
database files (The last two are temporary files that usually do not exist) to a 
network drive, diskette or flash drive.  

3. Copy the <log>.S3DB* database files from the temporary medium to the 
replacement computer’s \database directory  

4. Configure the replacement computer and N1MM Logger and begin logging. Any 
new QSOs will be identified by the replacement computer's name, which MUST 
not be the same as the broken machine.  

5. Restart the source computer and resume logging  

 
Notes:  
Each computer is the "book of record" for the QSOs logged on that computer, 
even though all QSOs are normally logged on every computer, for redundancy. Resync 
simply compares what your log shows for QSOs by a particular computer to what that 
computer has. If there is a difference, the computer that logged the QSO sends the 
updated QSOs to the requesting computer.  



 
The best way to avoid all this is to keep a spare computer up and running N1MM+ 
on the network. You can then just swap it in for the broken one.  

 

2.7 Digital Modes 

 1 General RTTY and PSK Information 
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 4 Digital - MMTTY for RTTY Support 
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2.7.1 General RTTY and PSK Information 

 2.7 Digital Modes  
 2.7.1 General RTTY and PSK Information  

o 1. RTTY Information  

 1.1. Common RTTY Frequencies  
 1.2. General RTTY Information  

o 2. PSK Information  

 2.1. General PSK Information  
 2.2. Common PSK and Digital Frequencies  

Digital mode contesting is growing rapidly. N1MM Logger+ supports digital mode 
contesting, not only RTTY but also other digital modes, with a flexible interface. If you 
are new to digital modes, you might want to read over this section. If you are familiar 
with digital modes and eager to get N1MM Logger+ working for them, you might want to 
proceed directly to the Digital Setup section.  

1. RTTY Information 

This section contains some general information about operating in RTTY that is not 
directly related to N1MM Logger+. For RTTY newbies, it is recommended that you read 
AA5AU's tutorial on getting started on RTTY . If you are new to digital mode contesting 
in general and RTTY in particular, the following information may also be helpful. If you 
are an old-timer on RTTY, you can probably skip this section.  

Before the spread of personal computers, RTTY was the most prevalent digital mode 
(other than CW, that is), and was done using surplus teletype equipment - mechanical 
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teleprinters. This equipment posed severe constraints on the RTTY mode that are still 
evident today. Despite these constraints, RTTY has proven to be quite well-adapted to 
contesting, and it is still by far the most common digital contesting mode.  

More recently, these mechanical teleprinters have been replaced by other devices. At 
first these were mostly separate boxes containing embedded microprocessors (called 
"terminal units". "TUs" or "TNCs"), but now the most common device for decoding and 
encoding RTTY is simply a sound card in a personal computer. N1MM Logger+ is 
capable of using either a hardware terminal unit or one of several software "engines", 
including MMTTY, MMVARI, Fldigi and 2Tone. Because there is no one method, 
whether it be a software program or a hardware modem, that performs better than the 
others under all conditions, N1MM Logger+ also supports the capability to run two or 
more such methods in parallel, thus gaining the advantages of both. For example, a 
user might choose to use a terminal unit such as the HAL DXP-38 in parallel with one or 
more copies of MMTTY using different decoding algorithms and parameters, in the hope 
that when conditions are marginal, one or another of the parallel decoders will succeed 
even when the others are failing to decode accurately.  

The most commonly used digital engine for RTTY is MMTTY. MMTTY performs very 
well, and offers a wide range of adjustments and options that are not available with the 
other available choices. However, MMTTY does not support other digital modes like 
PSK31. Amateurs who wish to use other digital modes will have to use either MMVARI 
or Fldigi as the digital engine for those modes, and users who are accustomed to using 
one of these engines for other modes may prefer to use the same engine for RTTY 
instead of switching to MMTTY. MMVARI comes pre-loaded with N1MM Logger+, 
whereas MMTTY, Fldigi and 2Tone must be downloaded and installed separately.  

An RTTY signal is a single carrier (like CW), but instead of being modulated on and off 
like CW, the transmitted power is kept constant, and modulation is imposed by changing 
the frequency by a preset amount; in amateur usage, the historical practice is to use a 
"shift" of 170 Hz. That is, RTTY is modulated using frequency-shift keying (FSK). The 
frequency shifting can be done either within the radio in radios which support this 
method, or external to the radio at audio frequencies (for example, in a computer sound 
card).  

The first method (usually called FSK) requires an on-off keying signal to be applied to a 
keying input to the radio. This keying is very similar to CW keying, except that instead of 
turning the carrier on and off as in CW, closing the key input shifts the transmitter's 
frequency. FSK therefore requires an on-off keying interface between the computer and 
the radio, and the radio must have the internal circuitry required to perform the 
frequency shifting. Radios that support this FSK mode usually have other features that 
assist RTTY operators, such as specialized filtering.  

The second method, using audio tones fed into an SSB transmitter which converts the 
tones to RF in exactly the same way that SSB converts audio voice frequencies to RF, 
is called Audio Frequency Shift Keying (AFSK). AFSK can be used with any SSB 
transmitter. Because the optimum filtering and other settings for RTTY operation are 
different from those for voice communication, some transceivers offer special AFSK or 



digital-mode modes, but fundamentally these specialized audio digital modes operate in 
the same way as SSB.  

There are never-ending arguments among amateurs as to which method is better, FSK 
or AFSK. If a station has been successfully set up for other sound-card digital modes, 
such as PSK31, that same setup can be used for AFSK RTTY, whereas the hardware 
configuration needed for FSK is unique to RTTY and cannot be used for other digital 
modes. However, some radios do not support the use of narrow receiving filters in SSB 
mode, which makes FSK better for RTTY contesting with those radios from an 
operational point of view. From a signal quality point of view, the very best AFSK setups 
can produce signals that are somewhat cleaner (occupy less spectrum) than most FSK 
transmitters are capable of, but on the other hand, a poorly set up AFSK station can 
transmit spurious signals, splatter or hum and noise. Badly configured AFSK setups are 
unfortunately more common than they should be, and give AFSK a bad name. When 
using AFSK, care must be taken to ensure that audio levels are set correctly; FSK does 
not require the same level of care.  

Whether using FSK or AFSK, digital modes are harder on transmitting equipment than 
CW and SSB because of the higher duty cycle (sustained periods of full-power 
transmitting). As a result, it is important not to overstress the transmitter. It is also 
important to take steps to avoid transmitting extraneous noises or spurious signals, and 
to ensure that neither audio harmonics nor intermodulation distortion (IMD) products are 
generated anywhere in the signal chain.  

Here are some tips for RTTY setup and operation:  

Hardware interfacing:  

 Unless your radio has a USB Codec built in (e.g. IC7200 and 7600), in order to 
receive RTTY you will need to connect the audio output from your radio to the 
input of the sound card being used with your computer, or if you are using a TNC 
or TU, to its audio input (see the manual for your TNC/TU for details)  

 To transmit:  
o For AFSK, you need to connect the audio output from your sound card or 

TNC/TU to an audio input on your radio (exception: radios with a built-in 
USB Codec), either directly or via a sound card interface  

o For FSK, you need a keying circuit from a serial port to your radio's FSK 
keying input. If you are using a USB-to-serial adapter, you will probably 
need to use the EXTFSK or EXTFSK64 plug-in in MMTTY  

o For either AFSK or FSK, you need some way to control PTT (TX/RX 
switching). In AFSK, VOX operation is the simplest method with many 
radios, although some radios do not support the use of VOX with the line-
level audio inputs used for AFSK. Also, VOX is not possible in FSK. If you 
use PTT control from N1MM Logger in other modes, the same method 
can be used in digital modes. Alternatively, you can control PTT from the 
digital engine using a serial port with a keying circuit. In FSK, the same 
port can be used for both PTT and FSK  



o When using AFSK, make sure that all forms of audio processing, 
compression, speech processing, hi boost, etc. are turned off  

o If you are using SSB for AFSK, MMTTY expects the radio to be in LSB on 
all bands, whereas Fldigi expects the radio to be in USB on all bands. 
Both of these engines have means to operate on the "other" sideband, 
using a "Reverse" ("Rev" or "Rv") button  

o See the Interfacing chapter for url's and tips on interfacing  
o Note that the character set used in RTTY does not have all ASCII 

characters, so some special characters can not be printed/transmitted  

1.1. Common RTTY Frequencies 

Contests USA (kHz) USA (kHz) 
Europe/Africa 
(kHz) 

Japan 
(kHz)  

Common Common 
DX 
frequency 

Common Common  

1800 - 1810/1835 - 
1845 

1800 - 1810 1838 - 1843 1838 - 1843 
 

3570 - 3600 3580 - 3600 3590 3580 - 3620 
3520 - 
3530  

7025 - 7100 
7025-7050/7080 - 
7100 

7040 7035 - 7045 
7025 - 
7040  

 
10120 - 10150 

 
10140 - 10150 

 
14060 - 14120 14080 - 14100 

 
14080 - 14100 

 

 
18100 - 18110 

 
18100 - 18110 

 
21060 - 21150 21080 - 21100 

 
21080 - 21120 

 

 
24910 - 24930 

 
24920 - 24930 

 
28060 - 28150 28080 - 28100 

 
28050 - 28150 

 
 

1.2. General RTTY Information 

There are two aspects of RTTY which are often confusing to newcomers to the mode.  

The first of these is the "polarity" of the signal. In FSK, there are two frequencies, 
conventionally called "mark" and "space". In amateur RTTY, these two frequencies are 
almost always separated by 170 Hz, and the mark frequency is the higher of the two RF 
frequencies. Someone who is transmitting with the opposite polarity is said to be 
transmitting "upside down". His signal will be gibberish at the receiving station, unless 
the operator there inverts his receive polarity. When first setting up for RTTY, if you 
appear to be unable to decode any signals you receive, try inverting your receive 
polarity (in MMTTY, use the "Rev" button; in 2Tone, use the "<Swap>" button; in 
MMVARI, switch between RTTY-L and RTTY-U settings; in Fldigi, use the "Rv" button).  

http://n1mmplus.hamdocs.com/tiki-index.php?page=Interfacing&structure=N1MM+Logger+Documentation


In FSK, getting the polarity right involves arranging things so that the switching 
conventions (does closing the keying input result in mark or space?) match between the 
radio and the computer. Unfortunately, the switching conventions are not universal. 
Fortunately, almost all radios affected by this have a menu item in the radio to reverse 
the keying polarity. Once this option is set correctly, the radio's transmit RTTY polarity 
will be correct from then on. On receive, most if not all radios in FSK mode receive 
RTTY on the lower sideband. If software is used to demodulate the received signal, it 
must be set so that the lower of the two audio tones is converted to mark and the upper 
tone to space. This is the default configuration in most software that supports FSK 
keying. Note that in FSK, the transmit and receive polarities are determined 
independently, i.e. it is possible to receive correctly and yet to transmit upside down.  

In AFSK, getting the polarity right involves coordination between the choice of audio 
frequencies generated in the sound card and the choice of sideband on the radio. The 
default combination in MMTTY and 2Tone is to use lower sideband on the radio, 
combined with an audio tone pair in which the mark tone is the lower of the two audio 
frequencies (e.g. the most common pair is mark = 2125 Hz, space = 2295 Hz). The use 
of the lower sideband inverts these tones at RF to match the standard amateur 
convention. Software like Fldigi that uses the opposite convention (mark tone higher 
than space) is used with the radio in upper sideband. Fortunately, once the receive 
polarity is correct in AFSK, the transmit polarity will also be automatically correct.  

The second sometimes puzzling aspect is related to the RTTY character set. The digital 
code used in RTTY predates the ASCII code used by modern computers. Instead of 8 
bits, which allows for 256 different characters, the Baudot or Murray code used in RTTY 
has only 5 bits. This 5-bit code only has enough different characters for 26 letters plus 6 
control codes, so to get numbers and punctuation the text has to be preceded with a 
special "FIGS" character (one of the 6 control codes) to get a second set of 26 
characters (10 numbers plus 16 punctuation marks). FIGS is "sticky", so there is 
another special "LTRS" character to switch back to the letters case.  

Just like any other character, these FIGS and LTRS characters can be damaged by 
noise, QRM, QSB, etc., and if they are, the received info is displayed wrongly until the 
next LTRS or FIGS character (or in some situations, the next space character) comes 
along and sets things right. Sometimes the opposite happens - a text character is 
converted by noise into a FIGS or LTRS code, with similar results.  

The most common problem that results is numbers being printed as letters, so with a bit 
of experience, many RTTY operators will get used to interpreting TOO as 599 and UE 
as 73. Serial numbers are slightly more difficult; PQW in the input data is most likely 
012, and so on. You can see which letter corresponds to which number by comparing 
the top (QWERTY) row of letters on the keyboard with the numbers immediately above 
and to the left. Letters can also be printed as numbers and punctuation; for example, 
CQ TEST when converted to FIGS case becomes :1 53'5 .  

Various software has different ways of helping out with this. When you run MMTTY 
stand-alone, if you right click on a "word" (delimited by spaces), the entire word changes 
to the opposite case. So, for example, VE4AEO is changed to ;3R-39 and vice versa. 
N1MM's digital window has a box titled Letters/Figs for opposite-case display, that 



shows text that the mouse "hovers" over (no click necessary) in the opposite case. This 
requires you to move the mouse over the text that you want to convert; the unconverted 
text is displayed in the MouseOver box.  

There is a common feature called Unshift on Space (UOS or USOS) whose purpose is 
to deal with the lost {FIGS}/{LTRS} problem. It was designed for normal text, where the 
majority of information is alphabetic.  

MMTTY has two UOS options. One of these is a button on the MMTTY main window 
that affects what you see in the receive window; the other is a setup option (under the 
Tx tab in the MMTTY setup) that affects what you transmit.  

The receive option in the main window simply changes the receive window's case back 
to {LTRS} at the beginning of every new "word", i.e. after a space, unless of course the 
new "word" starts with {FIGS}. This takes no extra time, but improves reliability of 
receipt of alphabetic text.  

The transmit option, on the other hand, actually transmits extra {FIGS} characters at the 
beginning of every numeric "word" to try to ensure greater reliability. It does not transmit 
an extra "LTRS" at the beginning of every alphabetic word, because using UOS on 
receive is a more efficient way to achieve the same end result.  

When you are ragchewing, you should always use UOS on both receive and transmit. 
UOS assumes that the majority of "words" are alphabetic, which is true of normal text.  

During contests, the receive UOS option is still helpful, especially when the exchange 
includes letters, and it does not cost anything. The N1MM Logger DI window's 
"Letters/Figs" line can be used to deal with those cases where receive UOS converts an 
intended numeric field to letters.  

The transmit UOS option achieves greater reliability of numeric exchanges at the cost of 
some extra {FIGS} characters. If you are concerned about the slight speed penalty it 
imposes, you can leave transmit UOS on and use dashes ("-") instead of spaces 
between all-numeric fields, e.g. 599-123-123 . Do not make the mistake of using dashes 
between alphabetic fields though; dashes between alphabetic fields are both slower and 
less reliable than spaces. The downside of using dashes in this way between numeric 
fields is that if the initial {FIGS} character is lost, the entire exchange will be in the wrong 
case, e.g. TOOAQWEAQWE. Sending spaces with transmit UOS on costs two extra 
{FIGS} characters but is more reliable (our example with an initial lost {FIGS} character 
becomes TOO 123 123). On the other hand, turning transmit UOS off results in 599 
QWE QWE in any receiver using UOS, even with no errors at all. A compromise among 
all of these possibilities is to always turn transmit UOS on, but use a hybrid exchange: 
599-123 123 (a dash instead of a space after the signal report, but spaces after that). A 
single {FIGS}/{LTRS} error will not prevent at least one copy of the exchange from being 
decoded correctly regardless of whether the receiving station is using UOS or not.  

2. PSK Information 

2.1. General PSK Information 



PSK31 (and its higher-speed versions, PSK63 and PSK125) is an example of a "sound-
card digital mode", i.e. a digital mode that was made possible by the use of sound cards 
in PCs. The advent of sound cards in PCs made these sound-card modes available for 
anyone to use with a minimum of expense. All that is needed is an SSB transceiver, an 
audio interface (which can be as simple as patch cables, or can include isolation and 
attenuation controls) and a means of controlling PTT, unless VOX is used.  

N1MM Logger+ supports PSK31 and other sound-card digital modes using either of two 
digital engines: MMVARI and Fldigi. MMVARI comes pre-loaded with the program, 
whereas Fldigi has to be downloaded separately. Fldigi supports a wider variety of 
digital modes than MMVARI, although the majority of these modes are not used for 
contesting.  

Conventionally, sound-card digital modes are communicated using USB, regardless of 
the band. Many PSK31 users set their radio's dial to a standard frequency (14070.0 kHz 
is the most common) and then look for signals anywhere within their SSB filter 
bandwidth (e.g. from 250 Hz to 2750 Hz or so, which would correspond to transmitted 
frequencies from 14070.25 kHz to 14072.75 kHz). PSK31 signals are narrow-band, so 
there can be many different PSK31 signals simultaneously copyable within the available 
frequency range without changing the radio's dial setting. Tuning is often done simply by 
clicking on the desired signal in the waterfall display.  

PSK31 is short for "Phase Shift Keying, 31.25 baud". There are also higher-speed 
versions, PSK63 (62.5 baud - seen fairly often) and PSK125 (125 baud - not quite so 
common). Actually, in addition to using phase shift keying for modulation, PSK31 also 
uses amplitude modulation ("waveform shaping") to minimize the bandwidth occupied 
by a signal. As a result of this combination of phase and amplitude modulation, PSK31 
places great requirements on the linearity of the equipment used, from the sound card 
generating the signal to the transmitter, and also the receiver. The peak power of a 
PSK31 signal can be approximately twice as high as the average power. If a transmitter 
is operated near its power handling capacity, it can clip these peaks, resulting in 
"splatter", which shows up on the waterfall as extra "tracks" in addition to the two main 
modulation tracks that are normally visible. To avoid having this happen, the audio 
levels in the sound card and in the transmitter's input audio stages must be controlled to 
avoid reaching power levels that would result in clipping. In most transmitters, this is 
equivalent to keeping the power below the level that would result in ALC action, and 
usually this also means powers below approximately half the transmitter's maximum 
power rating.  

Standard PSK31 (sometimes also called binary phase shift keying, or BPSK31) is 
sideband-independent. There is a rarely-used variation called QPSK31 (or QPSK63 for 
the 62.5 baud speed) that uses four phases instead of two (quadrature phase shift 
keying). This allows for some error correction while still delivering the same text speed. 
QPSK31 is sideband-dependent, i.e. the transmitting and receiving station must both be 
using the same sideband in their radios (by convention, upper sideband).  

PSK31 works well even at low powers. In fact, once the transmitted power is sufficiently 
high to give an acceptable level of copy, there is no advantage to be gained by 
increasing power further. Unlike analog modes, where increasing power may make your 



signal louder relative to QRM and therefore easier to copy, increasing the power in 
PSK31 does not necessarily improve your signal's readability. It can even degrade copy 
by overloading the other station's receiver and creating splatter within the receiver. More 
importantly, a very strong signal will affect the AGC in every receiver that picks it up, 
causing the receiver gain to decrease and making copy of signals on other frequencies 
more difficult. For this reason, high-power operation is unpopular in PSK31.  

When you plan to run PSK:  

 Keep your macros short.  
o PSK is about 1/3 slower than RTTY; you can really impact your rates with 

wordy macros  
 Use lower case letters wherever possible  

o PSK is a varicode mode. That means that characters contain a variable 
number of bits, unlike ASCII characters that have a fixed number of bits. 
Most lower-case PSK characters have fewer bits in them than their upper-
case equivalents, so lower-case (in general) transmits faster  

 Make sure all forms of speech processing and audio processing in the radio are 
turned off. Also, make sure any special effects in the sound card are turned off as 
well  

 Transmitter linearity is extremely important in PSK  
o Keep power below 1/2 the transmitter rating to avoid clipping peaks  
o Avoid any visible ALC action (except in radios with ALC designed for PSK, 

e.g. Elecraft K3/KX3)  

 

2.2. Common PSK and Digital Frequencies 

PSK31 activity generally starts from the bottom edge of the IARU RTTY bandplan, 
expanding upwards as activity increases.  

Band Digital Frequencies (kHz) PSK Frequency (kHz) Remarks  

160 meter 1800 - 1810 / 1838 - 1843 1807 / 1838  1807 in Region 2  

80 meter 3575 - 3585 3580  

40 meter 7030 - 7040 / 7060 - 7085 7035 / 7080 7080 in Region 2  

30 meter 10130 - 10145 10142 WARC, no contesting  

20 meter 14065 - 14090 14070  

17 meter 18100 - 18110 18100 WARC, no contesting  

15 meter 21060 - 21090 21080  

12 meter 24920 - 24930 24920 WARC, no contesting  

10 meter 28110 - 28125 28120  

 



2.7.2 Digital Overview and Features 

 2.7.2 Digital Overview and Features  

o 1. Digital Overview  
o 2. Making QSOs  

 2.1. Make a Digital Mode Transmission  
 2.2. Digital Need to Know  

o 3. Tips for Making QSOs  

 3.1. Using Hover Mode  
 3.2. The Rate Improver - Right Click = Return NOT Menu  

o 4. Do You Have... (what to check when it does not work)  

 4.1. Insert Key Assignments  
 4.2. Configuring the Entry Window Function Keys  
 4.3. Message Buttons  

o 5. Name Lookup  
o 6. Output RX Data to a Text File  
o 7. Single Operator 2 Radios (SO2R)  
o 8. Additional Receive-Only Windows for RTTY  

The digital part of the N1MM logger program is designed, coded and maintained by Rick 
Ellison, N2AMG.  

After the first overview part, which should be of interest to anyone getting started using 
digital modes with the Logger, the remainder of this section of the manual is a potpourri 
of miscellaneous ideas and suggestions on how to use the Logger in digital modes. If 
your main interest is in getting N1MM Logger+ up and running in digital modes, after 
checking out the overview you might prefer to proceed directly to the Digital Setup 
section.  

1. Digital Overview 

N1MM Logger+ supports a variety of methods to decode and transmit digital modes, 
including an external TNC/TU; the MMTTY engine for RTTY (sound card on receive, 
either sound card AFSK or FSK keying on transmit); G3YYD's 2Tone drop-in 
replacement for MMTTY, for AFSK RTTY; the MMVARI engine for RTTY (AFSK or 
FSK), PSK31, PSK63, PSK125 (both BPSK and QPSK), and MFSK16; or the Fldigi 
engine for a broad range of sound-card digital modes including AFSK RTTY, PSK and 
many more. Regardless of which of these engines is used, the digital data streams pass 
to and from the engine via the Digital Interface (DI) window. At least one DI window 
must be open to operate the Logger in digital modes. Depending on your hardware 
configuration and operating mode, you may have either one (SO1V, SO2V) or two 
(SO2V, SO2R) DI windows open. Both DI windows have full receive and transmit 
capabilities. It is also possible to supplement the two DI windows with up to four 
additional receive-only windows each. The user can interact with the DI windows using 
either the keyboard or the mouse as the primary control interface. There is a wide 
variety of options available to customize the operation of the digital interface.  

http://n1mmplus.hamdocs.com/tiki-index.php?page=Digital+Setup


For RTTY, the most popular interface engine is MMTTY. MMTTY performs very well, 
supports both FSK and AFSK, and has a wide variety of options and parameters that 
can be adjusted to tweak its performance. Many new users of N1MM Logger+ will 
already be familiar with MMTTY, either from using it stand-alone as an RTTY program, 
or from using it from within another contesting or general logging program. MMTTY 
does not come pre-installed with N1MM Logger+; it must be downloaded and installed 
separately, and then the Logger can be configured to use it.  

An alternative to MMTTY, using different decoding and encoding algorithms that 
perform better than MMTTY under some (but not all) conditions, is 2Tone. 2Tone was 
written by G3YYD to be a replacement for MMTTY without requiring any changes to the 
interface programming. That is, anywhere the MMTTY program is called up in N1MM 
Logger+, 2Tone can be used instead simply by changing the path to the program in the 
configuration. Probably the most common use for 2Tone is in parallel with MMTTY. One 
of the programs is used in the main Digital Interface window, and the other one is used 
in an additional RX-Only window. You may choose to use MMTTY in the main window 
and 2Tone in the additional window (this arrangement is popular with people using 
FSK), or vice versa.  

MMTTY and 2Tone do not support other sound card digital modes, of which the best-
known is probably PSK31. Users of those other digital modes can choose either 
MMVARI or Fldigi as the digital engine for those modes. MMVARI comes pre-loaded 
with N1MM Logger+, whereas Fldigi has to be downloaded and installed separately. 
Fldigi supports a wider variety of modes, although most of those modes are not used for 
contesting. For most users, it is probably the user interface that determines which of 
these two engines they prefer. Users who are accustomed to operating digital modes 
using one of these engines may be more comfortable using the same engine for RTTY 
as well, instead of switching to MMTTY.  

While MMTTY typically performs as well as or better than most of the hardware 
interfaces that were formerly common for RTTY (e.g. multi-mode TNCs), there are 
some terminal units that can rival or exceed it in performance under some conditions. 
Users who already have one of these devices may wish to consider using it with N1MM 
Logger+, either on its own or in parallel with MMTTY. For most such terminal units, the 
user will have to program the software commands needed to control the unit into the 
digital interface. An exception is the HAL DXP-38, which is supported directly without 
requiring user programming.  

The remainder of this section describes the operation of the DI windows, including basic 
operation as well as advanced features that can help make operation easier and more 
efficient. A separate section describes how to set up N1MM Logger and the DI Window 
for digital modes regardless of which type of digital engine is used. Engine-specific 
details are described in separate sections for each of the supported engines (MMTTY, 
MMVARI, Fldigi and external TNCs; 2Tone is included under MMTTY).  

 Problems? 

Check out the Digital Modes part of the Frequently Asked Questions (FAQ) of this Wiki. 
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2. Making QSOs 

This section explains:  

 How to make a Digital mode transmission  
 Keyboard, Insert key and Mouse Assignments  
 Function keys  
 Macros  

2.1. Make a Digital Mode Transmission 

 Select 'Window | Digital Interface' and the Digital Interface will open. The Digital 
Interface window can be positioned and resized on your monitor as desired  

 In the Entry window's call sign box, type "RTTY" (without the quotation marks) if 
you want to use RTTY, or "PSK" (without the quotation marks) if you want to use 
PSK or another sound-card digital mode  

 If an external TNC is used only the Digital Interface window is opened. When one 
of the sound card interfaces is chosen an extra window will appear: MMTTY (or 
2Tone), MMVARI or FLDIGI depending on which interface is selected in the DI 
window's Interface menu  

 Left clicking on a call will grab the callsign. Right clicking on the RX and TX 
windows will show a menu (this can be changed via a menu setting)  

 Pressing Insert will Grab the highlighted call and sends Hiscall followed by the 
Exchange button  

 Double clicking on a call sign in the call sign box from the Digital Interface sends 
that call to the Entry window  

 A call sign is automatically highlighted if recognized by the program. Call signs 
are always recognized when they are both preceded and followed by a space. 
There is also an option to recognize call signs buried in garbage (without a 
leading or trailing space), provided that call sign is in the master.scp file  

2.2. Digital Need to Know 

 If the call sign in the call sign field in the Entry window is equal to the call sign in 
the received text, the call in the Entry window does not get placed into the Grab 
list.  

 Staying Focus'ed 

Focus is automatically returned back to the Entry window when clicking a call sign in the 
Receive window 

 Pressing Ctrl while single clicking on a call will force the call into the Entry 
window  

 Click in the Entry window input field you want data to go to and then hold down 
the Ctrl key while clicking on the corresponding data in the RX window. It will 
paste to the field you clicked into  

 "-" separators between exchange elements are removed automatically  



 CQ Repeat time starts  
o when using a sound card engine, from when the sending stops  
o when using an external TNC, from when the message begins, as there is 

no way to tell when the TNC finishes sending  
 During transmit, call signs are not grabbed from the receive window  
 Linefeed characters (LF) in incoming text are replaced with Carriage Return (CR) 

characters  

 Auto-CQ with a TNC 

To get auto-CQ to work correctly with a TNC set your repeat time to at least 9 or 10 
seconds. It may need to be longer if you have a longer CQ macro. This will stop the 
TNC buffer from receiving the next string before it finishes sending the last one. 

 Clear the TNC Transmit Buffer 

It is best to add the command that your TNC uses to clear the transmit buffer to the end 
of your Abort Macro. If not, the transmit buffer still holds the remaining characters that 
were left in the sent string and will get sent the next time the TNC sends. 

 Stop Sending CQ 

When using a TNC turn off Config >Function Keys >Stop Sending CQ when Callsign 
changed. If not every time you stop an auto-CQ and you type a callsign in the box it will 
send the abort string to the TNC. 

3. Tips for Making QSOs 

Callsigns and exchanges are displayed in the Digital Interface (DI) window. This 
information can be transferred to the Entry window's Callsign field and exchange fields 
with the mouse, or it can be typed in manually the same as you would do in CW and 
SSB. Call signs recognized in the input stream are also placed in the Grab window, and 
can be transferred from there to the Entry window using the Grab button, the {GRAB} 
macro or Alt+G on the keyboard.  

3.1. Using Hover Mode 

 Hover Mode places the callsign in the callsign field in the Entry Window when 
you hold the mouse over a valid callsign. If you use this in combination with the 
'Right click = Return NOT menu' option, you hover over the call then right click to 
plant the call and send your call; when the station comes back to you you click on 
the exchange to place it in the Entry Window. Right clicking again sends TU and 
logs the Q. Right click, left click,right click and you're done...  

o Note: Your own call is excluded from being picked up.  
o Hover mode is used in conjunction with the menu selection 'Rt Click = 

Return NOT menu' which will will send a Return when right clicking in the 
DI RX window instead of displaying a pop up menu  

3.2. The Rate Improver - Right Click = Return NOT Menu 



Select from the settings menu in the Digital window "Right Click = Return NOT menu". 
This setting could improve your rate greatly as your hand never leaves the mouse 
except for the occasional difficult exchange. Making a qso:  

 While in Run mode with ESM on  
o Right click in the DI's RX window to send CQ  
o When a station replies left click on the call  
o Right click sends your exchange  
o As he sends his exchange, left click on it  
o Right click again to send TU and log the QSO  
o Right click again sends CQ (and you're back at the first bullet)  

 In S&P it does the same thing as hitting Enter to advance thru the ESM mode  

 
Right click takes the place of hitting Enter for ESM. Most of the time while in the contest 
I have one hand on the mouse and the other hand I have one finger resting on the 
space between the Esc and F1 keys. With that finger I can hit Esc if I have started a CQ 
and someone has started coming back to me. 73 Rick N2AMG  

4. Do You Have... (what to check when it does not work) 

Below are the most common mistakes made setting up or using N1MM logger in RTTY 
mode.  

 Forgetting to add {TX} and {RX} to each of the F Keys  
 Setting up Mode Control in the Configurer incorrectly  
 Incorrect settings in the Configurer under the Digital Modes tab  
 Forgetting to set up the Dig Wnd Nr in the Configurer under Hardware for ports 

that have the Digital check box checked  

4.1. Insert Key Assignments 

Mode 
Enter Sends Message 
(ESM mode) 

Ins key or ; does the following:  

RUN and 
S&P 

OFF 
1. Grab Callsign from call list if callsign field empty 
otherwise use call in callsign field  

  
2. Prefills Exchange Boxes  

  
3. NO DUPE: Sends F5 (Hiscall) + F2 (Exchange) or 
DUPE: Sends Nothing  

  
4. Places cursor in next exchange field (Example: 
Sect)  

RUN ON 
1. Grab Callsign from call list if callsign field empty 
otherwise use call in callsign field  

  
2. Prefills Exchange Boxes  

  
3. NO DUPE: Sends F5 (Hiscall) + F2 (Exchange) or  



  
3. DUPE  

  
— WorkDupes checked: Sends F5 (Hiscall) + F2 
(Exchange)  

  
— WorkDupes not checked:Sends F6(Dupe)  

  
4. Places cursor in next exchange field (Example: 
Sect)  

  
5. Highlights F8 button  

S&P ON 
1. Grab Callsign from call list if callsign field empty 
otherwise use call in callsign field.  

  
2. Prefills Exchange Boxes  

  
3. NO DUPE: Sends F4 (Mycall) or  

  
3. DUPE  

  
— WorkDupes checked: Sends F5 (Hiscall) + F2 
(Exchange)  

  
— WorkDupes not checked:Sends F6(Dupe)  

  
4. Once exchange entered INSERT sends F5-F2  

  
** Pressing INSERT again will continue to send F5-
F2  

  
5. Places cursor in next exchange field (Example: 
Sect) 

 

4.2. Configuring the Entry Window Function Keys 

 There are separate Entry window function keys for 'Running' mode and 'Search & 
Pounce' mode  

 The function keys use the same macros for both PSK and RTTY  
 The function keys can be changed using the Config | Change CW/SSB/Digital 

Function Key Definitions | Change Digital Function Key Definitions menu item, or 
more simply by right-clicking on one of the buttons  

 The function key editor is the same as for CW and SSB message buttons  

 
Some tips for function key and button messages:  

 Text to be transmitted in digital modes must be preceded and followed by {TX} 
and {RX} macros  

 Always begin and end the actual text of your messages with a space character to 
separate the content of your message from garbage characters generated by 
noise. If your call sign is the last thing in a message and there is no following 
space, the person at the other end will not be able to tell where your call sign 
ends and the garbage begins  



 With the sole exception of consecutive all-numeric elements, where a hyphen ("-
") can optionally be used instead of a space, always separate call signs and 
exchange elements from each other with single spaces  

 To set your messages off from previous text, you can start with a single {ENTER} 
instead of a space. Do not waste time by sending more than one {ENTER}. 
Never end a message with {ENTER}; that causes your information to scroll 
upwards on the received screen just as the other operator is trying to click on it  

 Don't put in long sequences of spaces, periods or other punctuation; that just 
wastes time without making it any easier to copy  

 Do not place any kind of punctuation immediately before or after a call sign; 
always set call signs apart from the rest of the text with single spaces  

 Ending messages with K, KN or BK is unnecessary in RTTY; the receiving 
station knows that you are finished when your carrier drops  

 In contests where the US state is part of the exchange, do not use DE before 
your call sign; that can be confused with the exchange for Delaware. Also, do not 
use IN as a preposition to indicate that what follows is your QTH; that may be 
interpreted as Indiana  

 Do not repeat unnecessarily. If signals are strong, you only need to send your 
exchange once; if conditions are poor, sending your exchange twice or even 
three times can pay off by reducing the number of requests for repeats, but when 
conditions are very good, this is unnecessary. Adjust your exchanges to suit 
conditions (the extra buttons in the DI window are useful for this)  

 If a signal report is part of the required contest exchange, send it once and once 
only. Everyone knows what it is going to be, so there is no need to repeat it. 
Always send the report as 599 (all-numeric), never 5NN (5NN takes more time in 
RTTY than 599; 5NN is for CW only)  

 If you are CQing and more than one station is responding to you, it may help to 
put the other station's call sign at the end of the exchange as well as at the 
beginning, to take care of situations where other stations who are still calling 
cover up the call sign at the beginning  

 In general, though, don't send the other station's call sign more often than is 
necessary to ensure he knows you are talking to him and he has copied the call 
sign correctly  

 Don't send your own call sign more often than necessary to ensure that the other 
station knows your call sign. There is no need to send both call signs in every 
message; once the call signs have been exchanged correctly, subsequent 
repeats don't add anything  

 Don't send the other station's exchange back to him. If you are not sure you got it 
right the first time, ask for a repeat, but once you feel you have copied it 
correctly, move on. Sending his exchange back puts doubt in the other station's 
mind unnecessarily, and in poor conditions he can confuse it with your own sent 
exchange  

 When responding to a CQ call, never send your exchange until after the CQing 
station has sent you his exchange and you have copied it correctly. Do not 
include any part of your exchange in your F4 message  

4.3. Message Buttons 



 There are 0, 8, 16 or 24 extra message buttons possible on the digital interface 
(DI window)  

 A right click on one of the message buttons brings up the Digital Setup dialog 
where the messages can be configured  

 These extra message buttons support regular macros but don't support 'Running' 
mode and 'Search & Pounce' mode  

 If using a TNC, include in your messages the control commands needed to turn 
on the TNC and switch to RX  

 Macro key substitution is supported by the buttons in the RTTY window as well 
as the function keys on the Entry window  

The macros which can be used and some examples can be found in the macros 
reference section  

There are several additional buttons for an External TNC. Please check the Digital - 
External TNC support chapter. Also please check the rules for messages and macros 
when using MMTTY and MMVARI.  

5. Name Lookup 

The program has the possibility to lookup the name from a station entered in the 
Callsign field. For this to happen the following has to be done.  

 Import a callsign versus name text file  
o The famous 'Friend.ini' file used in the WF1B program can be directly 

imported  
o Also a text file using the format for Call History import can be used  

 Callsign <comma> Name. For example: N1MM,Tom  
 Select >Config >Call History Lookup  
 Use the {NAME} macro to have the name sent  

o Note: The name is looked up in the Call History table with the cursor in the 
callsign field and pressing the Spacebar!  

 
Example how to import the Friend.ini file from the WF1B program.  

 Select >File >Import >Import Call History  
 Select your 'Friend.ini' file by changing 'Files of type:' to 'All Files (*.*)'. Otherwise 

only text files will be shown!  
 Select the 'Open' button. The callsigns with names from the text file will be 

imported  
 NB. Importing info in this table will delete all previous content. There is no merge 

option! So if there is information in it and you only want to add info, first export 
this info (Select >File > Export >Export Call History) and merge the data outside 
the program with a Text editor like Notepad. After this import the new merged file 
'Friend.ini' file  

 The program will show in the bottom pane of the Entry Window status information 
during importing and afterwards the number of imported callsigns  

http://n1mmplus.hamdocs.com/tiki-index.php?page=Macros#N1MM_Logger_Manual
http://n1mmplus.hamdocs.com/tiki-index.php?page=Digital+-+External+TNC+support#N1MM_Logger_Manual
http://n1mmplus.hamdocs.com/tiki-index.php?page=Digital+-+External+TNC+support#N1MM_Logger_Manual
http://n1mmplus.hamdocs.com/tiki-index.php?page=Digital+-+MMTTY+for+RTTY+support#N1MM_Logger_Manual
http://n1mmplus.hamdocs.com/tiki-index.php?page=Digital+-+MMVARI+for+PSK+and+other+modes#N1MM_Logger_Manual


6. Output RX Data to a Text File 

Sending your RX data to a text file can be done in N1MM Logger+ or in MMTTY. These 
files are a safety feature, as you can go back through them for any info you missed or 
lost during a crash.  

 N1MM Logger+: Right click in the RX window and select >Output to Text File 
(this choice is not available if you have selected the 'Right Click = Return NOT 
menu' option; to turn the RX text file option on or off, you will have to temporarily 
disable the Right Click = Return option)  

 MMTTY: Doing this in MMTTY is a bit tricky. Go to the directory where the copy 
of MMTTY that you use with the Logger has been installed and run that copy of 
MMTTY in stand-alone mode. Click on File/Log RX and close the program. From 
now on every time you start that copy of MMTTY either via the Logger or in 
stand-alone mode an output text file will be created and all your info will be 
stored in this text file. In the directory where MMTTY is located files will be 
created that have names like 131127.txt (yymmdd.txt). MMTTY creates a new file 
for each day. This MMTTY file also contains lines indicating the times when 
MMTTY started and stopped, and the times when transmissions from MMTTY 
started and stopped, which can be quite helpful  

7. Single Operator 2 Radios (SO2R) 

N1MM Logger+ also supports SO2R for RTTY. You can use any combination of either 2 
MMTTY windows, 2 TNC windows or a combination of MMTTY and a TNC for SO2R 
operation. Info about MMTTY soundcard setup and SO2R can be found in the N1MM 
Logger+ Help file in the SO2R chapter.  

8. Additional Receive-Only Windows for RTTY 

N1MM Logger+ supports up to four additional RTTY receive-only windows for each DI 
window. The purpose of these windows is to allow simultaneous use of more than one 
decoding algorithm on the same audio input. While it is possible, by using wide 
bandwidth filters, to use the additional windows to decode different signals from the one 
in the main DI windows, the normal use of the additional windows is to decode the same 
signal as the one in the main window, using a different decoding method to improve the 
overall ability to decode signals in difficult situations.  

These receive-only windows may use additional copies of MMTTY or 2Tone, configured 
with different "profiles" (e.g. multipath, fluttered, different detection algorithms), or they 
can be used with additional TNCs or TUs. You can use any of the possible digital 
interface engines in the main DI window (MMTTY, 2Tone, MMVARI, Fldigi or a 
TNC/TU), but regardless of which engine is used in the main window, the additional 
receive-only windows can only use MMTTY, 2Tone or a hardware decoder (MMVARI 
and Fldigi are not supported in these additional windows).  

There are setup instructions for the additional receive-only windows on the Digital Setup 
page.  

http://n1mmplus.hamdocs.com/tiki-index.php?page=Single+Operator+Two+Radio+Operation+%28SO2R%29&structure=N1MM+Logger+Documentation
http://n1mmplus.hamdocs.com/tiki-index.php?page=Digital+Setup
http://n1mmplus.hamdocs.com/tiki-index.php?page=Digital+Setup


 

2.7.3 Digital Setup 

 2.7.3 Digital Setup  

o 1. Quick Start RTTY Setup  
o 2. Setup Overview  

 2.1. Downloading and Installing MMTTY  
 2.2. Downloading and Installing 2Tone  
 2.3. Downloading and Installing Fldigi  
 2.4. Downloading and Installing GRITTY  
 2.5. Setting Up the Configurer  
 2.6. Additional RX Windows for RTTY  

o 3. The Digital Interface - Window  

 3.1. Receive Window Callsign Colors  
 3.2. Mouse Assignments  
 3.3. Keyboard Assignments  

o 4. The Digital Interface - Menu Selections  

 4.1. Configurer Selection: Soundcard  
 4.2. Configurer Selection: OTHER  
 4.3. Configurer Selection: DXP38  

o 5. The Digital Interface - Setup  

 5.1. Tab: General/MMTTY Setup  
 5.2. Tab: MMVARI Setup  
 5.3. Tab: Message Setup  
 5.4. Tab: WAE RTTY Configuration  
 5.5. Tab: DXP-38 Setup  

1. Quick Start RTTY Setup 

First, make sure you are familiar with basic operation of N1MM Logger+ in CW and 
SSB. It's not a good idea to try to use the program in digital modes if you aren't familiar 
with at least the basic operation (see the Getting Started section of the manual for an 
introduction).  

Next, have a quick look at the Overview section below - if you are new to digital modes, 
this may give you a better idea of how things fit together, and even if you are an old 
hand at digital modes, it's worth taking a few minutes to ensure you know how to adjust 
sound card levels and sampling rates.  

Once you are ready to begin, decide which digital engine(s) you want to use - an 
external TU/TNC, MMTTY, 2Tone, MMVARI or Fldigi. One of these (MMVARI) is built in 
to the Logger, but the others all will need to be downloaded. Each digital engine used by 
the Logger stores its configuration information in the directory the engine is run from. 
For that reason, you should create a separate directory for each copy, separate from 
the directory you use when you run it stand-alone or from some other logging program. 



If you use more than one copy of a digital engine (for example, for SO2V or SO2R, or 
for additional RX-only windows), you need a separate directory for each copy. For more 
detailed information, check out the following sections on Downloading and Installing 
MMTTY/2Tone/Fldigi/GRITTY (GRITTY is receive-only and cannot be used from the 
main Digital Interface window).  

After these preliminaries, start N1MM Logger+ and open the Configurer (Config > 
Configure Ports, Audio, Mode Control, Other). Make sure the Hardware tab is selected 
(this is the tab the Configurer starts up in by default).  

In what follows, it is assumed that you already have radio control, CW keying and PTT 
control configured and working, and what you are trying to do is add in the capability for 
digital modes.  

In many cases, especially if you are planning to use AFSK, you will already have PTT 
control configured from the Logger. If the same method you use in other modes is 
acceptable for digital modes, you don't need to do anything special about PTT for digital 
modes. If you are planning to use FSK for RTTY, you will be setting up a serial port for 
FSK keying from within the digital engine, and you can use that same serial port for PTT 
control in RTTY. If you are using VOX (or an external VOX such as a SignaLink), you do 
not need to configure PTT control in the Configurer.  

All that being said, there are two cases where you need to do something about PTT 
control for digital modes in the Configurer. The first is if you plan to use MMVARI as 
your digital engine, and you want to use a control line from a serial port for PTT control. 
In that case, you must designate that serial port in the Configurer, check the Digital 
check box for that port, set the appropriate control line (DTR or RTS) for PTT, and set 
the DigWndNr to 1 for most cases, or 2 for DI-2 in SO2R/SO2V. The second case 
occurs if you are using a single serial port interface for both CW/PTT keying in 
CW/SSB, and also for FSK keying in RTTY. In that case you must check both the Digital 
and CW/Other check boxes for that port, configure DTR and RTS for CW/SSB, and set 
the DigWndNr (1 for SO1V or for DI-1 in SO2R/SO2V, 2 for DI-2 in SO2R/SO2V).  

Next, you need to select the Digital Modes tab in the Configurer. First, set the TU Type 
to Soundcard (unless you happen to be using a hardware TU/TNC). If your main digital 
engine is MMTTY or 2Tone, then under DI-1 MMTTY Setup, select AFSK or FSK as 
appropriate for your setup and set the MMTTY Path to point to the copy of MMTTY.exe 
or 2Tone.exe you will be using with the Logger. If you will be doing SO2V or SO2R, 
repeat for a separate copy of the digital engine under DI-2 MMTTY Setup. If you will be 
using Fldigi, there are separate places to enter the paths to Fldigi.exe. For all of these, it 
is recommended that you do not try typing in the path directly. Instead, click on the 
Select button, which opens a standard Windows file Open dialog window, and then 
navigate till you find the desired .exe file and select it.  

Once the paths to the digital engines are set up, select the Mode Control tab in the 
Configurer. On the right side, beside RTTY, set the Mode sent to radio - this should be 
RTTY if you are using FSK, but if you are using AFSK, it should be either AFSK (if your 
radio offers a separate mode for AFSK RTTY), LSB (for most radios with MMTTY or 
2Tone), or USB (for Fldigi).  



This completes the basic steps in the N1MM Logger+ Configurer. For more detailed 
explanation of the various options available, see the section below titled Setting Up the 
Configurer.  

Back in the main Entry window, if you have not already done so, choose a contest type 
that allows digital modes (i.e. not a CW- or SSB-only contest), and set the Mode 
Category to one that includes RTTY or Digital (don't choose MIXED - that's for 
CW+SSB only; choose MIXED+DIG instead). Type RTTY into the call sign box and 
press Enter. This should open the Digital Interface window. If it does not, use the 
Window > Digital Interface menu item to open the Digital Interface window (in 
SO2R/SO2V, each Entry window has its own Digital Interface window that opens from 
that Entry window's menu). If your preferred digital engine does not open (e.g. if you see 
the MMVARI window when you wanted MMTTY), then in the Digital Interface window 
use the Interface menu item to switch to the digital engine you want to use (use the 
MMTTY menu setting for both MMTTY and 2Tone).  

Select the Setup > Settings menu item in the Digital Interface window. Under Preferred 
RTTY Interface, select your preferred digital engine. Under Alignment Frequency, enter 
your preferred Mark audio frequency (e.g. 2125 Hz). If you are using MMTTY, then 
under MMTTY Window Settings, select either Normal or Control Menus, in order to 
have easy access to the MMTTY setup window. When you have completed the setup in 
the Digital Setup window, click on Save Configuration.  

There are a host of other options in the Digital Interface and Digital Setup windows. A 
complete reference manual for the menu options in the DI window is in the section 
below titled The Digital Interface - Menu Selections, and a reference manual for the 
Digital Setup window is in the section titled The Digital Interface - Setup. For a 
description of how to use the DI window, see the section titled The Digital Interface - 
Window.  

You're not done yet. Now you have to complete the configuration inside the digital 
engine itself. This is especially important for FSK, since the configuration of the FSK 
port is carried out inside the digital engine, not in the N1MM Logger+ program. There 
are separate chapters in the manual for MMTTY, MMVARI, Fldigi, and TNCs/TUs. 
There are too many possibilities to cover here, so consult the chapter(s) appropriate to 
your situation and complete the setup as described there.  

2. Setup Overview 

Setting up an interface requires configuring the Logger for the selected interface. 
Configuring has to be done within N1MM Logger+ in a few places, including the 
Configurer as well as the Digital Interface window. You will also have to perform some 
configuration from within your chosen digital engine.  

You do not need to download or install any additional files or programs to use MMVARI 
or a TU/TNC. However, before you can use MMTTY, you will have to download and 
install it. The same applies to 2Tone and Fldigi. This process is described in the next 
two sub-sections.  

http://n1mmplus.hamdocs.com/tiki-index.php?page=Digital+-+MMTTY+for+RTTY+Support
http://n1mmplus.hamdocs.com/tiki-index.php?page=Digital+-+MMVARI+for+PSK+and+Other+Modes
http://n1mmplus.hamdocs.com/tiki-index.php?page=Digital+-+Fldigi+for+Sound+Card+Modes
http://n1mmplus.hamdocs.com/tiki-index.php?page=Digital+-+External+TNC+Support


A brief note about hardware connections. If you are using a TNC or TU, the hardware 
connections will be explained in the documentation for the TNC. If you are doing sound 
card digital modes (including RTTY) using MMTTY, 2Tone, MMVARI or Fldigi, your 
hardware connections will depend on the radio, the sound card and the interface (if any) 
in use. It is impossible to cover all of the permutations and combinations in detail, but 
the following general comments apply.  

First, unless the sound card (or "codec") is built in to your radio, you must have some 
means of connecting the radio's audio output to the sound card's input. The ideal 
connection would be from a fixed-level ("line out") output on the radio to a "line in" input 
on the sound card. If your radio has one receiver, this will probably use the left channel 
of the sound card; with dual receivers, the second receiver may use the right channel 
(of course, this requires a stereo sound card; some external sound cards, such as the 
SignaLink, are mono and will not support dual-channel receive). If your sound card does 
not have a line level input, you may need to use a microphone input, and in this case 
you may need an attenuator to reduce the line level output from the radio to the lower 
level needed for the microphone level input on the sound card.  

To transmit, there must be some means to convey modulation from the computer to the 
radio. For FSK RTTY, this is an on-off keying signal, which is normally generated by a 
serial port connected to the radio's FSK keying input through a simple keying circuit. 
This serial port cannot be the same port that is used for radio control or for a Winkeyer 
or other serial device. If it is a USB-to-serial adapter, you will probably need to use 
MMTTY's EXTFSK or EXTFSK64 plugin. If you are using MMVARI for RTTY using FSK 
keying, select the appropriate plugin (FSK8250 for true serial ports, EXTFSK or 
EXTFSK64 for USB-to-serial adapters) in the Configurer under the Digital Modes tab.  

For AFSK RTTY and for all other sound card digital modes (e.g. PSK31), with the 
exception of radios with an internal codec, there must be a connection from the sound 
card's output ("line out", or speaker or headphone output) to the radio's audio input. If 
the only audio input on the radio is a microphone input, you may need attenuation to 
reduce the level to avoid overdriving the transmitter.  

You also need some means to control TX/RX switching (PTT). The most common 
method is to use hardware PTT control from a serial or parallel port via a simple keying 
circuit. Hardware PTT can be controlled either from the digital "engine" (MMTTY, 
MMVARI, 2Tone or Fldigi), or from N1MM Logger+ itself. N1MM Logger+ can use the 
same port for PTT control that it uses for radio control, but if you want to use serial port 
PTT from the digital engine instead, you must use a different port from the one that is 
used by the Logger for radio control. If you have a serial port set up for FSK keying, you 
can use a control line (RTS or DTR) on this same port for PTT control from the digital 
engine. If PTT is controlled from a digital engine rather than from the Logger, and you 
use that same serial port from the Logger in other modes (e.g. for CW keying), then you 
must check the Digital box for that serial port in the Configurer and make sure to 
indicate the appropriate Dig Wnd Nr (1 for DI1, 2 for DI2).  

If you do not have a separate serial or parallel port available for PTT in digital modes, 
you can control PTT directly from the Logger. For example, if your radio control 
interface supports PTT using RTS or DTR on the radio control serial port, you can 



configure the Logger to use this method. If no method of hardware PTT control is 
available and if your radio supports PTT via radio command, you can use software PTT 
control from the Logger. Warning: Using both software and hardware PTT control at the 
same time can cause problems; do not use both methods in parallel.  

As an alternative to hardware and software PTT control, you may be able to use VOX. 
This does not work with all radios, it cannot be used for FSK RTTY, and setting of audio 
levels and VOX triggering levels can be tricky, but some users have found this to be the 
simplest method of PTT control, since it does not require any additional hardware 
connections. Some external interfaces (e.g. SignaLink) perform a VOX function external 
to the radio, i.e. they generate a hardware PTT signal based on the presence of an 
audio signal without any connection to a serial port on the computer. If you are using 
such an interface, or VOX within the radio, you do not configure any PTT in the Logger 
or in the digital engine, as PTT control in these cases is external to the software.  

Sound Card Level Settings  

On receive, to make best use of the sound card's available dynamic range you would 
adjust the sound card's recording level control (and/or any other level controls or 
attenuators there might be in the receive audio path) so as to just barely avoid 
overdriving or saturation on the loudest signals. In MMTTY, an input signal that is too 
strong will cause the word "Overflow" to be displayed in the MMTTY spectrum window. 
The recording sound level should be adjusted to be just below the point where this word 
is displayed on the strongest signals.  

On transmit (AFSK RTTY and other digital modes), it is important to avoid setting levels 
high enough to cause either appreciable audio harmonics or intermodulation distortion 
(IMD). The goal is to come up with a combination of settings in the sound card playback 
mixer and the radio's mic gain or line in gain setting that results in audio signals just 
below the point where fast-acting ALC is triggered. On many radios, this is the point 
where the ALC meter just starts to move (special case: this is not true of the Elecraft 
K3/K3S and KX3, where the proper audio settings are those that result in 4-5 bars 
displaying on the radio's ALC meter). With many sound cards, you should try to avoid 
setting the playback gain in the sound card all the way to the maximum; the sound 
card's output may not be very linear at the maximum setting. A setting somewhere in 
the upper middle part of the range is ideal, provided it produces enough signal for the 
radio. Gain distribution is also important. A very low level out of the sound card followed 
by large amounts of amplification in the radio's audio circuits will risk picking up hum 
and noise and adding them to your transmitted signal.  

Sound card level adjustment should always be done using an audio frequency in the 
middle of the radio's filter bandpass. This is where both received and transmitted signals 
will be strongest. If level adjustment is performed using an audio frequency near the 
edge of the bandpass, the resulting level settings will be too high. During operation, if a 
desired signal is found near the edge of the bandpass, the Logger's Align button can be 
used to retune the radio so the desired signal is placed at the optimal point in the 
bandpass.  



If you are using the Windows default sound card for generating transmitted signals in 
digital modes, make sure to disable all Windows sounds. Most amateurs who spend 
significant time in digital modes prefer to use a separate sound card. It does not need to 
be a high-end audiophile sound card; digital modes like RTTY do not require anything 
extraordinary in the way of a sound card. The parameter of most interest is the noise 
floor; the noise level in a second sound card may be lower than that in the sound card 
on the computer's motherboard, and this may help improve reception of digital signals.  

Sound Card Sampling Rate  

If you are using a sound card or codec, you may also need to pay some attention to the 
sound card sampling rate. This will be the case either if you are using Windows Vista, 7, 
8 or 10, or with any version of Windows when you are using 2Tone, regardless of 
whether that is as your main digital engine or as an auxiliary decoder in one of the 
additional RX windows.  

In Windows XP, application software programs (such as the digital engines in the 
Logger) are able to set the sound card sampling rate directly. If you use two or more 
engines in parallel with the same card, you need to ensure that all of the engines are 
using the same sampling rate. The 2Tone engine does not offer a choice of sampling 
rates; it always uses 12000 Hz. Since the sampling rate for all digital engines connected 
to the same sound card should be the same, this means that if you are using 2Tone and 
MMTTY in parallel, you should set MMTTY's sampling rate to 12000 Hz as well.  

In Windows Vista, 7, 8 and 10, application software cannot set the sampling rate 
directly. The hardware sampling rate is set in the Windows Control Panel. Many sound 
card drivers will offer a choice between DVD (48000 Hz) and CD (44100 Hz) sampling 
rates. Software that uses the sound card should have its sampling rate adjusted to an 
exact integer sub-multiple of the hardware rate. If you are using 2Tone, since the 
software sampling rate is fixed at 12000 Hz, you would set the sound card to an exact 
multiple of 12000 Hz (such as 48000 Hz, the standard DVD sampling rate). If you are 
not using 2Tone, you can choose either hardware sampling rate, but whichever one you 
choose in the Control Panel, you should choose corresponding rates in the sound card 
applications (12000 Hz corresponding with 48000 Hz, or 11025 Hz corresponding with 
44100 Hz).  

If the hardware and software sampling rates are incompatible (e.g. software set to 
11025 Hz using a sound card set to 48000 Hz, or two different software engines, one 
set to 12000 Hz and the other set to 11025 Hz), you may find that the software 
calculates audio frequencies incorrectly. For example, tones that the software generates 
using 2125/2295 Hz settings may actually be at lower pitches with a smaller shift, and if 
you are using narrow filters in the radio, the filter bandpass may appear at the wrong 
place in the waterfall. In AFSK, logged and spotted frequencies may also be incorrect.  

In Windows Vista, 7, 8 and 10, to set the sampling rate in the sound card, open the 
Control Panel and find the area for Sound settings. You can also find this by right-
clicking on the little speaker icon at the right end of the Task Bar and selecting 
"Recording devices". Under the Recording tab in the Sound settings window, select the 
sound card device and input that you are using for receive audio in digital modes and 



click on the Properties button. Select the Advanced tab, and set the sample rate and bit 
depth (16 bits is good) to the desired values (e.g. 16 bit, 48000 Hz). If you are using 
AFSK, do the same under the Playback tab for the sound card device and output that 
you are using for transmit audio.  

To set the sampling rate in MMTTY, open the MMTTY Setup window, select the Misc 
tab, and in the lower left part of the window set the Clock to the desired setting (e.g. 
12000 Hz). To set the sampling rate in MMVARI, open the Digital Setup Window, select 
the MMVARI Setup tab and the Soundcard Setup tab under that, and set the Clock 
Adjustment RX Freq to the desired setting (e.g. 12000 Hz). In Fldigi, the sample rate is 
found in the Fldigi configuration under the Audio/Settings tab - there are separate 
sample rate settings for Capture (receive) and Playback (transmit). Remember to save 
the configuration in Fldigi after you make any changes.  

2.1. Downloading and Installing MMTTY 

MMTTY is not installed as part of the installation of N1MM Logger+. It must be 
downloaded and installed separately. It is possible to use N1MM Logger+ in RTTY 
without using MMTTY (e.g. by only using an external TNC, or AFSK RTTY from 
MMVARI). If you intend never to use MMTTY, you can skip the rest of this section. 
However, most RTTY users will probably want to have the ability to use MMTTY, at 
least as an option. In particular, if you would like to make use of the additional RX 
windows for "diversity decode", you will most likely need to install MMTTY (unless you 
have several TUs/TNCs you can use for the purpose).  

If you do not have a copy of MMTTY, then before continuing with the digital setup it is 
recommended that you download a copy of the MMTTY installer from the MM HamSoft 
website . You can find a copy of the full installer for the current version of MMTTY at 
that website. This file is a self-extracting executable, similar to the N1MM Logger+ 
installer. Download the file to a temporary folder and then execute it. It is recommended 
that you install MMTTY in its own program folder and not in the N1MM Logger program 
folder. By default, the installer will install MMTTY to C:\Program Files\MMTTY\, but in 
Windows Vista, 7 or 8 you should not install MMTTY in the Program Files or Program 
Files(x86) path, because that will prevent MMTTY from saving its settings.  

Note for users of Windows Vista and Windows 7, 8 and 10: User Account Control (UAC) 
in these versions of Windows prevents user programs from writing configuration 
information into the Program Files path. Even if programs are run with Administrator 
privileges, UAC may interfere with the ability to use separate configuration files for 
separate copies of the same program. Therefore, it is suggested that the folder for 
MMTTY, as well as any folders for extra copies used in the second DI window and the 
four additional RX windows, should not be in the Program Files path. It is suggested 
that you create a new folder outside the Program Files path, such as C:\Ham 
Radio\MMTTY, and then place any individual sub-folders for separate copies of MMTTY 
within that folder. Another option would be to create a DigitalEngines subfolder inside 
the N1MM Logger+ user files folder (the one inside your My Documents folder), and 
then create various subfolders within DigitalEngines for copies of MMTTY, 2Tone and 
Fldigi that you want to use with various DI windows and RX-only windows, as illustrated 
lower down in this section.  

http://hamsoft.ca/pages/mmtty.php
http://hamsoft.ca/pages/mmtty.php


If you wish to use FSK keying from MMTTY through a USB-to-serial adapter or via an 
LPT port, you will also need to download a copy of EXTFSK (from the MM HamSoft 
website ) or EXTFSK64 (from http://www.qsl.net/ja7ude/extfsk/indexe.html ) and 
install the appropriate files in each folder or sub-folder from which you intend to use 
MMTTY to transmit FSK using a USB adapter or LPT port.  

If you already have a copy of MMTTY installed on your computer, you can use that copy 
from N1MM Logger+. However, if you also use MMTTY stand-alone, it is possible that 
you may want (or need) to have a different setup for stand-alone use than with N1MM 
Logger+ (e.g. if you use the radio control port from within MMTTY stand-alone; this is 
not possible when MMTTY is used with the Logger). If you need a different setup with 
the Logger than the one you use stand-alone, then you should create a separate folder 
for each copy (for example, you can create a sub-folder inside either the N1MM 
Logger+ user files folder or the MMTTY program folder for the second copy of MMTTY). 
You need to copy only the MMTTY.exe and UserProfile.ini files from the main MMTTY 
folder into the additional folder (plus the extfsk.dll and/or extfsk64.fsk file(s) if you are 
using EXTFSK and/or EXTFSK64 for FSK keying). You can also copy MMTTY.ini, but if 
you don't, MMTTY will create a new copy of MMTTY.ini when it is run.  

If you plan to use two copies of MMTTY in SO2V or SO2R mode, one for each received 
audio stream, you will need to create two copies in separate folders with different 
configurations. In SO2V, one of these copies can be configured to use the left channel 
and the other copy to use the right channel of a single stereo sound card. In SO2R, you 
can either use a stereo sound card as in SO2V, or you can use two separate sound 
cards, one for each radio.  

If you want to use MMTTY for diversity decoding in additional RX windows, you will 
need to create another separate sub-folder for each additional RX window. For 
example, you can create sub-folders called DI1, DI2, DI1RX1, DI1RX2, DI2RX1, 
DI2RX2, etc. so that you can run several copies of MMTTY simultaneously; one for 
each main DI window, plus up to 4 additional RX windows for each DI window. Into 
each of these windows, you need only copy the MMTTY.exe, MMTTY.ini and 
UserPara.ini files from the main MMTTY program folder created when you first installed 
it. Each copy of MMTTY must then be configured to use the appropriate sound card and 
channel. The "Additional RX" copies usually use the same sound card and channel as 
the parent copy in the main DI window, but they can be configured to use different 
decoding algorithms or profiles to give you "diversity decoding", i.e. several different 
decoding methods used on the same receive audio.  

A sample folder structure might be as follows (each of the bottom-level folders contains 
a copy of the .exe file and .ini or other configuration files for that particular instance of 
the program).  

http://hamsoft.ca/pages/mmtty.php
http://hamsoft.ca/pages/mmtty.php
http://www.qsl.net/ja7ude/extfsk/indexe.html


 

Once MMTTY has been downloaded and installed, you can proceed to use the 
Configurer to set up N1MM Logger+ to use it - see section 2.5 below. For instructions 
on setting up additional RX windows, see section 2.6 below.  

2.2. Downloading and Installing 2Tone 

2Tone is not installed as part of the installation of N1MM Logger+. It must be 
downloaded and installed separately. You cannot run 2Tone stand-alone. Most people 
who use 2Tone have already downloaded and configured MMTTY, and simply use 
2Tone as a drop-in replacement for the MMTTY engine. If you are using 2Tone in the 
main DI1 or DI2 window, change the MMTTY path in the Configurer under the Digital 
Modes tab to point to a copy of 2Tone.exe . If you are using 2Tone in an additional RX 
window, configure that window for MMTTY but change the path in the setup to point to 
that window's copy of 2Tone.exe . Note that if you are using 2Tone in more than one DI 
or RX window, every window you use it in must point to a different copy of 2Tone.exe, 
i.e. a copy that has been unzipped into a different folder.  

You can find the latest version of 2Tone in the G3YYD folder in the Files area of the 
N1MMLogger-Digital user group at Yahoo. Download the zip file containing the latest 
version and unzip its contents into the folder(s) or sub-folder(s) you wish to run it from (a 
separate folder for each window you wish to use it in). The first time you install 2Tone in 
a folder, copy the entire contents of the zip file into the folder; when installing updated 



versions, you do not need to extract the ini files from the zip file if you wish to keep 
using the configuration information from the previous version.  

The configuration steps in N1MM Logger+ are the same for 2Tone as for MMTTY. To 
configure N1MM Logger to use 2Tone as the decoder for one of the main Digital 
Interface windows (DI1 or DI2), follow the instructions in section 2.5 below, taking care 
to ensure that the DI Path points to 2Tone.exe instead of MMTTY.exe . If you wish to 
configure N1MM Logger to use 2Tone as the decoder in one of the additional RX 
windows, use the Setup > Add. RX Windows > Open Add. RX Window (4 Avail.) 
menu item to open the additional RX window. The first time that window opens, it will 
display a setup window - see section 2.6 below. Set the Window Type to MMTTY, but 
then in the Path box change the path to point to the appropriate copy of 2Tone.exe 
instead of MMTTY.exe . Click on Save.  

Initially the additional RX window will be in a separate window from the main DI window. 
If you wish to embed the additional RX window into the DI window so that text decoded 
in the main and additional RX windows will appear one above the other within the DI 
window, select the Setup > Add. RX Windows > Enable Attached RX Windows 
menu item from the DI window's menu bar. The separate window will be minimized to 
the task bar; if you want to close the additional RX window, or if you need to change 
settings in its Setup window, you can open it from the task bar.  

For detailed instructions on configuration settings within 2Tone itself, see the 2Tone.pdf 
file in the downloaded 2Tone zip file.  

2.3. Downloading and Installing Fldigi 

FLdigi is not installed as part of the installation of N1MM Logger+. It must be 
downloaded and installed separately. It is possible to use N1MM Logger+ in RTTY and 
PSK contests without using fldigi. Fldigi supports a wide range of other digital modes, 
but most of these are rarely used for contesting. Fldigi can also be used as a receive-
only CW decoder. If you want to use fldigi as a CW decoder, you need to download and 
install it. If you intend never to use fldigi, you can skip the rest of this section.  

If you do not have a copy of fldigi and you wish to be able to use it, then before 
continuing with the digital setup you should download a copy of the Fldigi installer from 
the W1HKJ website at http://www.w1hkj.com/  . You can find a copy of the full 
installer for the current version of fldigi at that website. This file is a self-extracting 
executable, similar to the N1MM Logger+ installer. Download the file to a temporary 
folder and then execute it. It is recommended that you install fldigi in its own program 
folder and not in the N1MM Logger program folder. By default, the installer will install 
fldigi to C:\Program Files\Fldigi-x.xx.xx\, where x.xx.xx is the Fldigi version number. This 
is OK for fldigi when it is run stand-alone, but in Windows Vista, 7, 8 and 10, a copy of 
fldigi that is used from within N1MM Logger+ cannot be placed in the Program Files or 
Program Files(x86) path. Therefore it is recommended that you create a separate folder 
for fldigi somewhere outside the Program Files paths (for example, in a special folder 
within the N1MM Logger+ user files folder in your My Documents area), make a copy of 
fldigi.exe from the original fldigi program folder and place the copy in the new folder. 

http://www.w1hkj.com/


You do not need to copy any of the other files; that copy of fldigi will create new 
configuration files the first time it is run from the Logger.  

Note that older versions of fldigi only use the left channel on input; for that reason, in 
most SO2V installations these older versions of fldigi can only be used from Entry 
Window 1. Starting with Fldigi version 3.22.06, fldigi is now capable of using either 
sound card channel for input. In any copy of fldigi that you want to use with the right 
channel of the sound card, use the Configure > Sound Card menu item in the fldigi 
window to open the fldigi configuration window. Select the Right channel tab, and near 
the bottom under Receive Usage, check the Reverse Left/Right channels check box to 
switch fldigi to use the right channel on RX. Click on Save to save the configuration 
change, and then close the configuration window.  

Newer versions of fldigi may default to requiring confirmation from the user before you 
shut them down. If that shutdown is initiated by shutting down N1MM Logger+, instead 
of by shutting down the DI windows and engines first, this can result in fldigi continuing 
to run after the Logger has shut down. This will cause problems the next time you start 
up the Logger. To prevent this from happening, you need to make a change in the fldigi 
configuration file. In each folder that fldigi is run from, find the file called fldigi_def.xml 
(Note: this file is created the first time fldigi is run from this location, i.e. it will not exist 
until after you have run that copy of fldigi at least once). Right-click on the file name, 
select Open with... and then select Notepad or Wordpad as the program to open the file 
with. Look for a line that reads <CONFIRMEXIT>0</CONFIRMEXIT> or 
<CONFIRMEXIT>1</CONFIRMEXIT>. If you see a 1 between the two keywords, 
change it to a 0 and save the file. Repeat this for every copy of fldigi you use from within 
N1MM Logger+ (DI1, DI2, CW Reader 1 and/or CW Reader 2).  

2.4. Downloading and Installing GRITTY 

GRITTY is an innovative receive-only RTTY decoder by Alex VE3NEA (the author of DX 
Atlas, CW Skimmer and several other amateur radio programs). Its decoding algorithm 
is quite different from the algorithms used by other RTTY decoders. It can be used as 
one of the additional RX windows in N1MM Logger+ (see section 1.6 below) to provide 
additional information about received call signs and exchanges which can sometimes 
enable you to copy a signal even when the decoder in the main Digital Interface window 
is unable to decode the information successfully.  

GRITTY is not installed as part of the installation of N1MM Logger+. It must be 
downloaded and installed separately. A zip file containing the GRITTY installer can be 
downloaded from http://www.dxatlas.com/Download.asp  . The installer is a self-
extracting executable, similar to the N1MM Logger+ installer. Download the zip file to a 
temporary folder and then unzip it and execute the setup program. It is recommended 
that you install GRITTY in its own program folder. By default this will be in the Program 
Files path. Unlike MMTTY, 2Tone and Fldigi, when GRITTY is used from N1MM 
Logger+ it can be run from the program files path. GRITTY's configuration information is 
stored outside the program files path, and the interface with N1MM Logger+ creates a 
specially-named ini file to allow different configuration files to be used from the Logger 
as compared with GRITTY run stand-alone. The name of this ini file indicates which DI 
window (1 for SO1V, 1 or 2 for SO2R or SO2V) and which additional RX window 

http://www.dxatlas.com/Download.asp


number (1 through 4) the configuration applies to (for example, Config13.ini contains the 
GRITTY setup for additional RX window no. 3 from the DI-1 window). You can find the 
location of these configuration files from the GRITTY Help > Data Folder menu item.  

GRITTY's decoding method is based on Bayesian statistics. It performs an analysis on 
the received characters bit-by-bit and develops a probabilistic model, comparing 
incoming text to known-good call signs, common keywords and previously-decoded text 
in order to predict the most likely correct interpretation even in the presence of errors. In 
some situations, it can pick out call signs from error-filled text that would appear to be 
garble to other decoders. Of course, it must be used with care; while it can predict the 
most probable interpretation of a received string of bits and noise, this interpretation is 
not guaranteed to be correct. For example, it can sometimes be tricked into decoding 
apparent call signs from pure band noise.  

GRITTY performs best when the incoming audio is not passed through a narrow filter, 
e.g. by using a wide SSB filter instead of narrow CW-style filters. When used with 
narrow filters, GRITTY can sometimes refuse to decode anything even when other 
decoders are succeeding. When this happens, one tactic that may work is to temporarily 
widen the IF filter in your rig to pass a broader range of audio frequencies. In the 
presence of heavy QRM such as strong nearby signals, it may be necessary to use 
narrow filtering in order to prevent AGC pumping from adversely affecting the other 
decoders using more traditional methods. Fortunately, once GRITTY has started to 
decode using a wider filter, the IF filter can often be narrowed back down and GRITTY 
will continue to decode now that it has some previously-decoded text to work with.  

The interface between GRITTY and N1MM Logger+ is somewhat different from the 
interface with other decoding programs. The other decoders pass all of their decoded 
text to the Logger, which can then display it in the Digital Interface window or in one of 
the additional RX-only windows. GRITTY does not do this, but instead, when a call sign 
or exchange element appears in GRITTY's text window, clicking on it with the mouse 
will transfer it directly to the Entry window. In other words, the text window in the bottom 
half of the GRITTY window can be used as if it were one of the Logger's RX windows.  

You can find more information on setting up and using GRITTY, and on how it works, in 
the GRITTY Help file.  

2.5. Setting Up the Configurer 

There are three tabs in the Configurer that need to be set up when configuring N1MM 
Logger for digital modes. The first is the Hardware tab, where serial ports used for 
digital modes are set up. If you are using VOX or an interface that performs the VOX 
function externally (e.g. SignaLink), you do not need to configure a port for digital 
modes under this tab.  



 

 The Digital box in the main Configurer window indicates to the Logger that this 
port is used for digital mode control in certain special cases, as follows:  

o Use this to indicate a port that is used for an external TNC - only the 
Digital check box is checked for the port  

o Use it to indicate a port that is used for PTT control from MMVARI  
o It is possible to share a port (sequentially, not simultaneously) for both 

serial port CW keying (e.g. on DTR) and for PTT and FSK using MMTTY 
or 2Tone for RTTY (e.g. on RTS and TxD). If you are time-sharing a port 
like this, check both Digital and CW/Other for that port. When the DI 
window is closed, the settings in the DTR and RTS boxes will determine 
how the port is used; whenever the DI window is open, it will be the 



settings in the digital engine (e.g. MMTTY or 2Tone) that determine how 
the port is used. The figure above shows COM2 being used by the Logger 
for CW keying and by MMTTY for FSK keying  

o If you use a serial port with MMTTY or 2Tone for FSK and/or PTT keying 
and you do not use that serial port in other modes or in MMVARI, there is 
no need to configure that port in the Configurer; in this case, all of the 
setup is done within MMTTY  

 

 

If you have checked the Digital check box, click on the Set button for the same port and 
select the radio number and DI window number to be associated with the port. The 
figure above demonstrates an example where COM2 is being used by the Logger for 
CW keying from DTR, and by MMTTY for FSK keying from VFO B (SO2V).  

 The Radio Nr box indicates which radio this digital interface is for in SO2R 
mode; in SO2V and SO1V, Radio Nr is always = 1  

 The Dig Wnd Nr indicates whether this port is used for DI1 or DI2. This applies 
to SO2V and SO2R; in SO1V, Dig Wnd Nr is always = 1  

o You must choose a Dig Wnd Nr for each port that has the Digital box 
checked; otherwise the program will not assign the port to a DI window!  

 
The next tab to be set up is the Digital Modes tab.  



 

 Digital Interface 1/2 (left part of window)  
o TU Type:  

 None - if you do not plan to use the DI1 or DI2 digital interface  
 Soundcard - for any of the sound card digital engines (MMVARI, 

MMTTY, 2Tone or Fldigi)  
 Other - use this setting for most terminal units or TNCs (e.g. for a 

PK-232 or KAM TNC)  
 Dxp38 - use this setting for the HAL DXP-38 terminal unit  

o Speed, Parity, Data Bits, Stop Bits, Flow:  
 These are only used when the TU Type is Other or Dxp38  



 Set these parameters appropriately for the TNC or TU (Example 
settings: 9600, 8, N, 1, Xon-Xoff)  

 DI-1/2 MMTTY Setup (upper right part of window - this area is also used for 
2Tone setup)  

o MMTTY Mode: Select AFSK or FSK  
o MMTTY Path: Select path to MMTTY.EXE or 2Tone.exe, including the 

name of the executable file (i.e. not just the path to the folder). Using the 
Select button for this purpose will open a File Open dialog that will allow 
you to navigate through the file system to find the MMTTY.exe or 
2Tone.exe file, which avoids the possibility of a typing error when entering 
the path  

 The paths for the two DI windows are not the same, since each DI 
window runs its own copy of MMTTY or 2Tone  

 SO2V/SO2R in MMTTY 

You can use MMTTY with both receivers in a two-receiver setup with a single stereo 
sound card. You will need to install two copies of MMTTY in two separate program 
folders in order to allow one copy to be configured to use the left channel of the sound 
card and the other copy to be configured to use the right channel of the sound card. 

 SO2V/SO2R Shut Down Issue 

When two copies of MMTTY are used in DI1 and DI2 with a different COM port for each 
copy for PSK/PTT keying, you may need to close the two DI windows separately before 
shutting down N1MM Logger. If both DI windows are open at the time N1MM Logger is 
shut down, the COM port assignments in the two copies may get confused due to a 
glitch in MMTTY, which means the port assignments may be wrong the next time the 
Logger is started up. 

 DI-1/2 Fldigi Setup (midle right part of window)  
o Fldigi Path: Select path to fldigi.exe (complete path, including the name 

of the executable file). Use the Select button to simplify the task of finding 
the path and typing it in correctly  

 The paths for the two DI windows will normally be different in order 
to allow for different configurations (e.g. different audio sources) in 
the two copies  

 SO2V/SO2R in Fldigi 

Starting with FLdigi version 3.22.06, you can use Fldigi with both receivers in a two-
receiver setup with a single stereo sound card. You will need to install two copies of 
Fldigi in two separate program folders in order to allow one copy to be configured to use 
the left channel of the sound card and the other copy to be configured to use the right 
channel of the sound card on receive. 

 DI-1/2 MMVARI Setup (bottom part of window)  



o MMVARI RTTY Mode: Select AFSK or FSK  
o FSKPort: (FSK only)  

 Choose FSK8250 if you are using a true serial port or a device that 
can simulate a serial port and handle 5-bit codes at low speeds 
(this does not include most USB-to-serial adapters, but it does 
include some commercial interfaces designed to support FSK 
RTTY as well as some multi-port USB-to-serial adapters)  

 When MMVARI is opened for FSK RTTY, a small window 
labelled MMVARIFSK1 1.04 will open, or appear on the 
Windows Task bar. In this window you select the COM port 
number and the signal line to be used for PTT (RTS or 
DTR). FSK keying will be done on the TxD line. If this is a 
USB device that simulates a serial port, check Limiting 
speed. You can use the _ box at the top right to minimize 
this window after completing the setup  

 FSK8250 supports all of the RTTY speeds supported by 
MMVARI and the selected COM port or device  

 Choose EXTFSK if you are using a regular USB-to-serial adapter  
 When MMVARI is opened for FSK RTTY, a small window 

labelled EXTFSK 1.06 will open, or appear on the Windows 
Task bar. In this window you select the COM port number 
and the signal lines to be used for FSK keying (normally 
TxD) and PTT (RTS or DTR). You can use the _ box at the 
top right to minimize this window after completing the setup  

 The only RTTY speed supported by EXTFSK is 45.45 baud  
 On high-performance multi-core systems only, you may choose 

EXTFSK64 instead of EXTFSK. EXTFSK64 uses a more accurate 
timing mechanism than EXTFSK, but this mechanism uses 
significant CPU resources. EXTFSK64 is not appropriate for use on 
XP based systems or hardware running older dual-core Intel/AMD 
CPUs or Atom based CPUs. On systems that are capable of 
supporting it, EXTFSK64 can key FSK from LPT ports as well as 
USB-to-serial adapters. See 
http://www.qsl.net/ja7ude/extfsk/indexe.html  for more detailed 
information on EXTFSK64  

 When MMVARI is opened for FSK RTTY, a small window 
labelled EXTFSK 2.0 will open, or appear on the Windows 
Task bar. In this window you select the COM or LPT port 
number and the signal lines to be used for FSK keying 
(normally TxD) and PTT (RTS or DTR). You can use the _ 
box at the top right to minimize this window after completing 
the setup  

 EXTFSK64 can key FSK at speeds other than 45.45 baud 
(e.g. 75 baud)  

 SO2V/SO2R in MMVARI 

http://www.qsl.net/ja7ude/extfsk/indexe.html


You can use MMVARI with both receivers in a two-receiver setup with a single stereo 
sound card. In the DI Window's Digital Setup dialog box under the MMVARI Setup tab, 
simply configure the DI1 SoundCard to use the left channel and the DI2 SoundCard to 
use the right channel. 

 
The third tab to be set up is the Mode Control tab, which determines what mode the 
radio will be set to use in RTTY and PSK.  

 

This example is for a radio or radios with separate modes for FSK, AFSK and PSK (e.g. 
Elecraft K3 using FSK D, AFSK A and DATA A respectively). This particular setup uses 
AFSK from DI-1 (radio 1) and FSK from DI-2 (radio 2). The appropriate choices in the 



list boxes under Mode sent to radio will depend on the particular radio type (see 
Supported radios). For FSK RTTY, the correct choice will normally be RTTY. For 
AFSK RTTY, depending on the radio the appropriate choice might be AFSK or 
LSB/USB. For PSK and other sound card modes, the radio mode would be PSK (if 
available), AFSK-R (on some radios) or USB on most radios. For more information, see 
the Configurer page under the Config >Mode Control tab.  

2.6. Additional RX Windows for RTTY 

N1MM Logger+ supports up to four additional RTTY receive-only windows for each DI 
window. The purpose of these windows is to allow simultaneous use of more than one 
decoding algorithm on the same audio input. While it is possible, by using wide 
bandwidth filters, to use the additional windows to decode different signals from the one 
in the main DI windows, the normal use of the additional windows is to decode the same 
signal as the one in the main window, using a different decoding method to improve the 
overall ability to decode signals in difficult situations.  

These receive-only windows may use additional copies of MMTTY or 2Tone, configured 
with different "profiles" (e.g. multipath, fluttered, different detection algorithms). 
Alternatively, they can be used with a copy of Fldigi or GRITTY, or with additional TNCs 
or TUs. You can use any of the transmit-capable digital interface engines in the main DI 
window (MMTTY, 2Tone, MMVARI, Fldigi or a TNC/TU). The additional RX windows 
may be configured to use either the same sound-card interface engine as the main DI 
window with a different profile, or a different interface engine, including GRITTY (read-
only), but not including MMVARI (MMVARI can only be used in the main DI window).  

The receive-only windows are invoked from the DI window's Setup > Add. RX 
Windows > Open Add. Rx Window (4 Avail.) menu item - the number in the menu 
item indicates how many of these windows are unused and still available. The first time 
one of these windows is opened, its Setup window will be displayed.  

http://n1mmplus.hamdocs.com/tiki-index.php?page=Supported+Radios#Digital_Mode_Mapping
http://n1mmplus.hamdocs.com/tiki-index.php?page=Configurer#N1MM_Logger_Manual


 

The setup information that must be entered includes the engine type (MMTTY, TNC, 
Dxp38, GRITTY or Fldigi - the MMTTY setting is also used for 2Tone), the path to the 
copy of MMTTY/2Tone, Fldigi or GRITTY for that window (if used), and/or the COM port 
information for a TNC (if used). If the engine type is MMTTY, Fldigi or GRITTY, a 
separate spectrum display window is opened for the software digital engine.  



After the setup information has been entered, the window should be closed and re-
opened, and then it will be available for use. Once the additional RX window is active, 
you can click on call signs and exchanges in it to pass them to the Entry window, the 
same as you can in the main DI window.  

If the engine used in the additional RX window is GRITTY, the RX window will be very 
small and will contain the message "Minimize this window and use GRITTY window to 
click in."  

 

When GRITTY is the RX engine, it does not pass text to the RX window, but you can 
click on call signs in the bottom part of the GRITTY window and they will be passed to 
the Entry window, just the same as if you were clicking on the call sign in one of the RX 
windows.This only works correctly for call signs; clicking on exchanges may sometimes 
transfer extraneous information into the exchange box that will need to be deleted 
before the contact can be logged. Note that the color-coding of information in the 
GRITTY text window is not the same as the color-coding of call signs in the main DI 
window and the additional RX windows. See the GRITTY help file for more information 
on this and other features of GRITTY.  



 

It is possible to embed or attach a copy of the additional RX windows directly into the 
RX window area in the main Digital Interface DI window, using the DI window's Setup > 
Add. RX Windows > Enable Attached RX Windows menu item. Each such attached 
window is denoted with its number (1, 2, 3 or 4), which is normally on a green 
background. If the number is clicked on with the mouse, the background color changes 
to yellow and the text in that window is frozen temporarily, similarly to the green/yellow 
bar on the left of the main receive window and the regular additional RX windows. If the 
digital engine for one of the additional RX windows is GRITTY, a message appears in 
the attached window indicating that text decoded by GRITTY does not appear in that 
window; instead, the text is in the GRITTY text window, where you can click on it to 
pass it to the Entry window.  



 

The separate additional RX window(s) is/are minimized to the task bar when the 
attached windows are enabled, but they may be restored from the task bar in order to 
be able to change setup parameters or to close the additional RX window. The icon(s) 
for the additional RX window(s) are grouped together with the icons for N1MM Logger+ 
on the task bar. If any of the additional RX windows use sound card software for 
decoding, the spectrum display windows for those digital engines may also be 
mimimized to icons on the task bar, but these will be separate from the Logger icons; 
note that the icon for the digital engine (MMTTY - black crossed ellipses on a white 



background; 2Tone - 2T; GRITTY - green crossed ellipses; or Fldigi - miniature 
waterfall) controls the display for the digital engine only, not the RX window. In the 
screen shot below, as a result of hovering the mouse over the the N1MM Logger+ icons 
they have been expanded to thumbnail images above the task bar. The title of each 
thumbnail indicates which window will be restored if you click on that thumbnail.  

 

If Fldigi is used in parallel with other decoder engines, you need to be aware of the fact 
that fldigi assumes by default that the radio is in USB, whereas the other decoders 
assume LSB. If your radio is in LSB (this includes the FSK RTTY mode in amateur 
transceivers), you will need to tell fldigi to reverse its tones using the Rev button in the 
corresponding DI or additional RX window. This Rev button is not accessible from the 
attached RX-only windows; if you have enabled attached windows, you will need to 
restore the non-attached window to gain access to the Rev button for that copy of fldigi. 
Alternatively, if the radio is in USB (or FSK-R, etc.), fldigi will be on the correct sideband 
but you will need to reverse the tones in the other decoders using their respective 
reverse settings in the digital engine windows.  

3. The Digital Interface - Window 

The Digital Interface window, or DI window, is nearly the same regardless of which type 
of interface (MMTTY, MMVARI, FLDIGI or TNC) is being used. Its appearance (font 
sizes and foreground and background font colors) can be customized using the Skins, 
Colors and Fonts dialog window (main Entry window, Config > Manage Skins, Colors 
and Fonts).  



 

The Digital Interface is opened from the Entry window's Window > Digital Interface 
menu item. If you are using two entry windows (SO2V/SO2R), each entry window has a 
separate DI window associated with it - DI1 with the VFO A/Radio 1 Entry window, and 
DI2 with the VFO B/Radio 2 Entry window. Each DI window is opened from its 
corresponding Entry window's menu bar. If the digital "engine" chosen in a Digital 
Interface window is sound card software (MMTTY, MMVARI, Fldigi or 2Tone), a 
separate window including a tuning display and various other digital engine-specific 
information will also be opened when the Digital Interface window is opened - see the 
section of the manual relevant to the specific digital engine that has been selected.  

The DI window may be configured either in scrolling mode or in non-scrolling mode. 
Scrolling mode is the same as N1MM Logger Classic - new text is always added below 
previous text (i.e. usually on the bottom line of the RX window), and previously received 
lines scroll off the top of the window. Non-scrolling mode is new in N1MM Logger+ - 
previously received text does not move, but stays where it was first displayed until it is 
overwritten with new text. The line on which incoming text is being displayed is indicated 
with an underline, and this line moves steadily down the screen until it reaches the 
bottom, after which the top line in the window becomes the new incoming text line. The 
advantage of this mode is that received call signs and exchanges do not move, making 
them easier to click on.  

The Digital Interface caption displays either the offset frequency (radio's dial frequency 
+/- audio frequency) or the radio's dial frequency, depending on what you have chosen 
in the Digital Setup.  

 TX - Indicator to show which window has transmit focus (useful when using two 
sessions like SO2R)  



 Letters/Figs - Shows the text under the mouse in reverse case (letters/figures 
switched)  

 MouseOver - Shows the text under the mouse; this is the text that would be 
selected by a mouse click  

 
Top RX window - This is the receive window. Depending on the scrolling option you 
choose in the Digital Interface's Setup window, you can make this window either a 
scrolling window (old text scrolls off the top of the window as new lines are inserted at 
the bottom), or non-scrolling (new text appears on the active line, which is underlined; 
each time a new line starts, the text that was previously in the next line down is cleared 
and that line becomes the new current line; if the current line is at the bottom of the RX 
window, the line at the top of the window is cleared and becomes the current line where 
new text is entered). Some users find it easier to use a non-scrolling window where text 
does not move after it is entered (so incoming newlines do not cause text to scroll up 
just as you want to click on it). Other users find it easier to use a scrolling window so 
that new incoming text is always near the bottom of the window where they don't have 
to move the mouse very far to click on it. The Logger gives you the choice.  

There are 2 ways of moving a callsign from the RX window into the callsign box in the 
Entry window. You can single click on a callsign and it will transfer over to the main 
logging window, or, whenever a callsign is detected in the RX window it will be sent to 
the callsign grab window for easy movement to the logging window by clicking the Grab 
button or using a function key with a {GRAB} macro in it. By clicking on the colored bar 
on the left you can pause input to the receive window to scroll back through the (last 
2000 lines of) text using the scroll bars. When the window is paused the color of the bar 
will turn yellow. To turn input to the window back on click in the bar again and 
everything that was to be printed to the window will now enter the window. When the 
receive window is paused it is possible to select and copy text in the window.  

Bottom TX window - This is the transmit window, a free form typing window. If you 
click on the TX button the cursor will be placed into this window and whatever is typed 
will be sent. The size is static and doesn't change size (2 lines). For TNC users: when 
not transmitting, anything typed in the TX Window will be sent to the TNC. Used to send 
TNC commands to change settings etc.  

Callsign Textbox and Grab - When a callsign is encountered in one of the receive 
windows it will be placed in the Grab list in this textbox and when you press the Grab 
button it will transfer the callsign over to the main Entry window. The grab callsign 
window holds the last 10 callsigns seen in the RX window. The most current one is at 
the top and is highlighted. Dupe callsigns will not be shown in the grab window. The 
Sort Order in the grab window can be selected by right-clicking; you can choose either 
Last In First Out or First In First Out as the sort order  

 Callsign not added to grab List 

If the callsign in the callsign field in the Entry window is the same as the callsign in the 
received text, the call in the Entry window does not get placed into the grab call list. 



Clicking on a callsign in the RX window to move it into the Entry window will remove that 
callsign from the Grab list. 

 
Message buttons - The Digital Interface window can display 0, 8, 16 or 24 extra 
message buttons for preprogrammed messages. Configuring these message buttons is 
done in the Digital Interface window under 'Setup | Settings' or by right clicking on them, 
which brings up the Digital setup dialog. The width of these message buttons 
dynamically adjusts in relation to the width of the interface window  

 Clr RX - Clear the receive window (also possible using the right click menu, 
unless the Rt Click = Enter option has been selected)  

 Align (MMTTY and Fldigi only) - This is used to move the signal that you are 
copying into the passband of your filters. Set the frequency in the setup area. For 
example, if your filters are centered on 2210 Hz, RTTY signals close to the 
2125/2295 Hz pair will be copied well, but signals at higher or lower frequencies 
may not make it through the filters. If you click on a signal at a frequency in the 
waterfall that is not close to the nominal 2125/2295 pair, it may not decode very 
well. After clicking on the signal, if you click on the Align button your transceiver 
will be retuned to line the signal up on the configured frequency. This is essential 
in FSK where the transmit frequencies are fixed in the radio, and useful also in 
AFSK if you want to use narrow filters  

o Note that when you are using the MMVARI interface engine, the Align 
button appears on the MMVARI window instead of on the Digital Interface 
window  

 TX - Start the RTTY transmission, the transceiver is keyed. Will be colored Red 
when transmitting  

 RX - Stop the RTTY transmission - the transceiver changes back to receive. Will 
be colored Green when in receive  

 HAM (MMTTY only) - Restore the MMTTY frequency and shift settings to the 
HAM default  

 AFC (MMTTY only) - Can be used to turn MMTTY's AFC on or off (colored 
background means AFC is on)  

 Lock (Fldigi only) - Locks the transmit frequency at the current location. If you 
move the receive frequency, e.g. by clicking elsewhere in the waterfall, the 
transmit frequency does not change. Used for operating split  

 Rev (MMTTY and Fldigi only) - In sideband-sensitive modes like RTTY, reverses 
the tones (e.g. opposite sideband)  

 Grab - Transfer the selected callsign in the Callsign textbox to the callsign field 
on the main Logger Entry window. Once the callsign is filled, whatever you click 
on next will fill the next exchange box. When the Digital Interface is in transmit, 
calls are not added to the Grab window  

 CLR - Clear the Grab list  

3.1. Receive Window Callsign Colors 



 
When a callsign is recognized in the receive input stream the callsign will be colored 
according to the same color scheme that is used in the Bandmap Window and brought 
to the Grab window. Valid callsigns that are separated by spaces are always 
recognized, and optionally the Search routine can be used to search for known call 
signs from the Master.scp file in garbage text strings. When the search in garbage text 
is enabled and two calls are found in the same string, only the last one gets highlighted. 
Also, if the call sign being copied contains a shorter call sign that is in the Master.scp 
file, using the search in garbage feature may result in the shorter call sign being 
recognized instead of the longer one. The highlighted calls in text strings are clickable.  

If the "Use Generic Routines" option is chosen under Callsign Validity and Highlight in 
the Digital Setup, anything that looks like a callsign will be highlighted with a color that 
indicates its multiplier status using the same colors as in the Bandmap and Entry 
window. If the "Use Master.scp File" option is chosen, callsigns that are not in the 
Master.scp file will be highlighted in yellow in addition, either by changing the 
background to yellow (if the multiplier color is in the foreground), or by changing the text 
color to yellow (if the multiplier color is in the background). Regardless of which option is 
chosen, anything that passes the check routines and looks like a callsign will be placed 
in the Grab window.  

3.2. Mouse Assignments 

 Left mouse key clicking  
o Single clicking on a callsign grabs it and places it in the Callsign field on 

the Entry Window dialog  
o Single clicking on Exchange info etc. grabs it and places it in the 

Exchange field on the Entry Window dialog  
 Note: The callsign field must be filled first!  

o Double clicking on a callsign grabs it and overrides the current 
information in the Callsign field on the Entry Window dialog  

o Ctrl+Single clicking - will force what ever you are clicking to be sent to 
the box containing the typing cursor in the Entry window. (You may need 
to click first in the Entry window to select the box where you want to place 
the new data)  

o Shift+Single clicking - will cause the moused over text to be Letter/Figs 
converted on the fly while sending to Entry Window (only in RTTY Mode)  

o Alt+Single clicking - if Digital Call Stacking is enabled, will transfer the 
call sign being clicked on to the Bandmap call stack (see Single Operator 
Call Stacking? for more information)  

 Right mouse key clicking on RX window  
o Will give a menu only when the menu item 'RT Click = Return NOT 

menu' is NOT selected!  
 Clear RX - Clear the receive window. This receive buffer can 

contain a maximum of 10,000 characters  
 Output to Text File - Output the received text to a text file named 

RTTY1.txt  

http://n1mmplus.hamdocs.com/tiki-index.php?page=Bandmap+Window&structure=N1MM+Logger+Documentation#Colors_of_the_incoming_spots:
http://n1mmplus.hamdocs.com/tiki-editpage.php?page=Advanced+Functions


 Help - Show the help file for this window  
 Right mouse key clicking on TX window  

o Will give a menu only when the menu item 'RT Click = Return NOT 
menu' is NOT selected!  

 Clear TX - Clear the transmit window  
 Paste - Place the TX text in the Paste buffer  

 Right mouse key clicking in GRAB window  
o Gives a menu:  

 Clear List - Clear the entire grab window  
 Clear Selected Call - Clear the selected call in the grab window  
 Sort Order - Choose the order in which call signs are pulled from 

the grab window:  
 Last In, First Out  
 First In, First Out  

3.3. Keyboard Assignments 

 Alt+T - Toggle TX/RX, when in TX the cursor will be set to the TX window of the 
active interface  

 Ctrl+K - Toggle TX/RX and move the cursor into the DI's TX window to send 
manual information using the keyboard; press Esc or click on the RX button to 
terminate manual sending  

 Alt+G - Grab most recent callsign from callsign textbox. Upon grabbing that 
callsign gets deleted from the grab list  

 Ctrl+Left/Right arrows - When two radios are configured in SO2R or a dual-
receiver radio is used in SO2V, and two digital windows are open, pressing 
Ctrl+Left arrow or Ctrl+Right arrow will swap from one active Digital Interface to 
the other. Digital Interface 1 will follow VFO A/Radio 1, Digital Interface 2 will 
follow VFO B/Radio 2  

4. The Digital Interface - Menu Selections 

The digital interface has a menu at the top which varies depending on which type of 
interface is selected under the Digital Modes tab in the Configurer.  

4.1. Configurer Selection: Soundcard 

 Setup  
o Settings - Opens the Digital Setup window; see the section on 'The Digital 

Interface - Setup' below  
o Turn AutoTRXUPdate On/Off  

 If your radio's dial displays the actual transmitted frequency (i.e. the 
Mark frequency in FSK RTTY), you would turn this option off  

 If your radio's dial displays the suppressed carrier frequency (e.g. 
SSB mode), you would turn this option on. This causes the program 
to add (USB) or subtract (LSB) the audio frequency from the digital 
engine to/from the radio's dial frequency so that the frequency that 



appears in the Entry window, the Bandmap, the log and spotted to 
the DX cluster is the actual transmitted frequency, not the 
suppressed carrier frequency  

 AutoTRXUpdate can affect other modes 

If the AutoTRXUpdate option is turned on, it takes effect whenever the DI window is 
open. If you leave the DI window open and switch to CW or SSB, the offset will continue 
to be applied, and the frequencies in the Entry window, Bandmap and your log will be 
incorrect. You should always close the DI window when switching from digital modes to 
other modes. Also, if you are likely to want to use a non-digital mode the next time you 
start the program, you should close the DI window before shutting down N1MM Logger 
in order to ensure that the DI window does not cause this option to be applied the next 
time you start the Logger. 

o Bring to Foreground when made Active - Bring the Digital Interface and 
Engine to the foreground when its Entry window has focus  

 This adds ability to stack Digital Interfaces and Engines and have 
the correct one on top when the associated Entry window has focus  

o SoundCard  
 RX Mixer - Shows the Record control mixer dialog from the 

Windows operating system. Only for Windows versions XP and 
earlier  

 TX Mixer - Shows the Play control mixer dialog from the Windows 
operating system. Only for Windows versions XP and earlier  

 These menu items are not available when using the Fldigi 
engine. They are also not available in Windows 7, 8 and 
Vista  

o Setup MMTTY - The MMTTY setup is shown. This menu item is only 
visible when MMTTY is selected  

o AFC On/Off with CQ - If set then the AFC will turn on with CQ message 
or TU messages. Turning AFC on when soliciting new callers with a CQ or 
QRZ message can help tune in off-frequency callers  

o NET On/Off with Run Change - Option to turn Net function on in S&P 
and off in Running mode. In S&P mode, you normally want to transmit on 
the same frequency you are receiving on; in AFSK, turning NET on 
ensures this. In Run mode, you normally leave NET off in order to allow 
the receiver to track off-frequency callers without moving your TX 
frequency  

o Turn Hover Mode On/Off - With this option selected, when the mouse is 
hovered over a valid callsign the callsign is automatically transferred to the 
Entry window's callsign box without having to click on it. This option is 
most effective when used in combination with the RT Click = Return NOT 
menu option  

 Note: Your own call is excluded from being picked up  
o RT Click = Return NOT menu - When this option is selected, a right-click 

in the RX window will perform the same functions as pressing the Enter 



key. This is designed to work with ESM; in ESM, pressing the Enter key 
automatically sends the next message in the normal QSO sequence. For 
example, when CQing, once a callsign has been placed in the callsign box 
(either by left-clicking on it or using the Hover mode option), right-clicking 
will send the exchange and move the cursor to the exchange box, left-
clicking on the received exchange will transfer the exchange to the entry 
window and right-clicking will send the TU message and log the contact. A 
complete QSO can be performed with simply a couple of left-clicks and a 
couple of right-clicks  

o Send Text File - Send a text file. A file open dialog will appear from which 
the file to be sent can be selected  

o Output Main RX Window to Text File - When this is checked, text that is 
displayed in the main RX window will be saved to a text file in the N1MM 
Logger program folder. The file name will be date stamped (mmddyyyy), 
as in 05312012DigitalInterface1Output.txt (for DI1)  

o Digital Call Stacking - Used together with the {LOGTHENPOP} macro. 
See Single Operator Call Stacking? for more information  

 Enable using First In First Out - Enables the Digital Call Stacking 
feature. Calls are popped off the stack in the order they were 
placed there  

 Enable using Last In First Out - Enables the Digital Call Stacking 
feature. Calls are popped off the stack in reverse order, i.e. most 
recent first  

 Enable using FIFO Mults First - Enables the Digital Call Stacking 
feature. Calls are popped off the stack in order of their multiplier 
value. In those contests where one QSO can yield 2 or 3 mults, the 
higher-mult calls will be taken first. Among calls with the same 
multiplier value, calls are popped in FIFO order, i.e. in the order 
they were placed there  

 Disabled - Disables the Digital Call Stacking feature  
o Use RX Window Callsign Pause Routines - When this option is 

selected, moving the mouse in the RX window over a valid callsign while 
the callsign box in the Entry window is empty will cause incoming text to 
stop appearing and the RX window to pause scrolling. At this point you 
can either click on the callsign to transfer it into the Entry window, display 
any incoming text that was held back during the pause and resume 
scrolling, or simply move the mouse off the callsign to display any held 
incoming text and resume normal scrolling. Also with this option selected, 
when the left mouse button is clicked in the RX window to select text the 
RX window will pause until the mouse button is released after the text has 
been selected, at which point the selected text will be copied to the 
clipboard, any held incoming text will be displayed and normal scrolling 
will resume. If there is a scrollbar present in the RX window, moving the 
scroll bar will cause incoming text to be paused until either text has been 
selected and the mouse has been released, the pause strip at the left side 

http://n1mmplus.hamdocs.com/tiki-editpage.php?page=Advanced+Functions


of the window is clicked, or the right mouse button is clicked in the RX 
window  

o Add. RX Windows  
 Enable Attached RX Windows - After one or more additional RX 

window(s) has/have been set up using the last submenu item 
below, this option can be selected in order to attach or embed small 
RX text displays from the additional RX window(s) into the main DI 
window. When the additional RX windows are attached to the main 
RX window using this option, the attached windows appear above 
the main RX window. The non-attached RX windows are minimized 
to the task bar when the attached windows are enabled, but they 
may be restored from the task bar in order to see more text than is 
visible in the attached window, to access the setup options, or to 
close the additional RX window without closing the main DI window. 
The task bar icon for the additional RX window is grouped with the 
main N1MM Logger icons. If the additional RX window is using a 
software decoder, there will also be a separate task bar icon for the 
digital engine; do not confuse the two task bar icons  

 Open Add. RX Window (4 Avail.) - This allows you to open an 
auxiliary RX window for diversity decoding of the same RTTY 
signal, e.g. by using a TNC in the main DI window and MMTTY or 
2Tone in the auxiliary window, or by using a different copy of 
MMTTY or 2Tone with a different decoding algorithm to decode the 
same audio input. There are up to 4 such windows available (the 
remaining number available appears in the menu). Each additional 
window is associated with either DI1 or DI2, depending on which DI 
window menu was used to open it. There is a separate Setup 
dialog for each additional RX window, which is accessible from the 
menu bar at the top of the additional window. The first time an 
additional RX window is opened, its setup dialog will automatically 
be displayed. The decoder type (MMTTY, TNC or DXP38 - use 
MMTTY for 2Tone), and the path to the program or the COM port 
information for a TNC must be filled in before the additional RX 
window can be used. Once all of the additional RX windows you 
intend to open from either DI window have been set up and tested, 
you can use the Enable Attached RX Windows option to attach 
the additional windows to the main DI window  

 Interface  
o MMVARI - Select MMVARI as the interface  

 No other installation required - the MMVARI engine is installed 
during the N1MM Logger install  

o MMTTY - Select MMTTY (or 2Tone) as the interface  
 Requires MMTTY (or 2Tone) to be installed and the DI-1/2 path(s) 

to MMTTY to be set up in the Configurer  
o Fldigi - Select Fldigi as the interface  



 Requires Fldigi to be installed and the DI-1/2 path(s) to Fldigi to be 
set up in the Configurer  

 Help - Shows help file  

4.2. Configurer Selection: OTHER 

 Setup  
o Settings - Opens the Digital Setup window; see the section on 'The Digital 

Interface - Setup' below  
o Turn AutoTRXUPdate On/Off  

 If your radio's dial displays the actual transmitted frequency (i.e. the 
Mark frequency in FSK RTTY), you would turn this option off  

 If your radio's dial displays the suppressed carrier frequency (e.g. 
SSB mode), you would turn this option on. This causes the program 
to add (USB) or subtract (LSB) the audio frequency from the digital 
engine to/from the radio's dial frequency so that the frequency that 
appears in the Entry window, the Bandmap, the log and spotted to 
the DX cluster is the actual transmitted frequency, not the 
suppressed carrier frequency  

 AutoTRXUpdate can affect other modes 

If the AutoTRXUpdate option is turned on, it takes effect whenever the DI window is 
open. If you leave the DI window open and switch to CW or SSB, the offset will continue 
to be applied, and the frequencies in the Entry window, Bandmap and your log will be 
incorrect. You should always close the DI window when switching from digital modes to 
other modes. Also, if you are likely to want to use a non-digital mode the next time you 
start the program, you should close the DI window before shutting down N1MM Logger 
in order to ensure that the DI window does not cause this option to be applied the next 
time you start the Logger. 

o Bring to Foreground when made Active - Bring the Digital Interface and 
Engine to the foreground when its Entry window has focus  

 This adds ability to stack Digital Interfaces and Engines and have 
the correct one on top when the associated Entry window has focus  

o Turn Hover Mode On/Off - With this option selected, when the mouse is 
hovered over a valid callsign the callsign is automatically transferred to the 
Entry window's callsign box without having to click on it. This option is 
most effective when used in combination with the RT Click = Return NOT 
menu option  

 Note: Your own call is excluded from being picked up  
o RT Click = Return NOT menu - When this option is selected, a right-click 

in the RX window will perform the same functions as pressing the Enter 
key. This is designed to work with ESM; in ESM, pressing the Enter key 
automatically sends the next message in the normal QSO sequence. For 
example, when CQing, once a callsign has been placed in the callsign box 
(either by left-clicking on it or using the Hover mode option), right-clicking 



will send the exchange and move the cursor to the exchange box, left-
clicking on the received exchange will transfer the exchange to the entry 
window and right-clicking will send the TU message and log the contact. A 
complete QSO can be performed with simply a couple of left-clicks and a 
couple of right-clicks  

o Send Text File - Send a text file. A file open dialog will appear from which 
the file to be sent can be selected  

o Output Main RX Window to Text File - When this is checked, text that is 
displayed in the main RX window will be saved to a text file in the N1MM 
Logger program folder. The file name will be date stamped (mmddyyyy), 
as in 05312012DigitalInterface1Output.txt (for DI1)  

o Digital Call Stacking - Used together with the {LOGTHENPOP} macro. 
See Single Operator Call Stacking? for more information  

 Enable using First In First Out - Enables the Digital Call Stacking 
feature. Calls are popped off the stack in the order they were 
placed there  

 Enable using Last In First Out - Enables the Digital Call Stacking 
feature. Calls are popped off the stack in reverse order, i.e. most 
recent first  

 Enable using FIFO Mults First - Enables the Digital Call Stacking 
feature. Calls are popped off the stack in order of their multiplier 
value. In those contests where one QSO can yield 2 or 3 mults, the 
higher-mult calls will be taken first. Among calls with the same 
multiplier value, calls are popped in FIFO order, i.e. in the order 
they were placed there  

 Disabled - Disables the Digital Call Stacking feature  
o Use RX Window Callsign Pause Routines - When this option is 

selected, moving the mouse in the RX window over a valid callsign while 
the callsign box in the Entry window is empty will cause incoming text to 
stop appearing and the RX window to pause scrolling. At this point you 
can either click on the callsign to transfer it into the Entry window, display 
any incoming text that was held back during the pause and resume 
scrolling, or simply move the mouse off the callsign to display any held 
incoming text and resume normal scrolling. Also with this option selected, 
when the left mouse button is clicked in the RX window to select text the 
RX window will pause until the mouse button is released after the text has 
been selected, at which point the selected text will be copied to the 
clipboard, any held incoming text will be displayed and normal scrolling 
will resume. If there is a scrollbar present in the RX window, moving the 
scroll bar will cause incoming text to be paused until either text has been 
selected and the mouse has been released, the pause strip at the left side 
of the window is clicked, or the right mouse button is clicked in the RX 
window  

o Add. RX Windows  
 Enable Attached RX Windows - After one or more additional RX 

window(s) has/have been set up using the last submenu item 
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below, this option can be selected in order to attach or embed small 
RX text displays from the additional RX window(s) into the main DI 
window. When the additional RX windows are attached to the main 
RX window using this option, the attached windows appear above 
the main RX window. The non-attached RX windows are minimized 
to the task bar when the attached windows are enabled, but they 
may be restored from the task bar in order to see more text than is 
visible in the attached window, to access the setup options, or to 
close the additional RX window without closing the main DI window  

 Open Add. RX Window (4 Avail.) - This allows you to open an 
auxiliary RX window for diversity decoding of the same RTTY 
signal, e.g. by using a TNC in the main DI window and MMTTY or 
2Tone in the auxiliary window, or by using a different copy of 
MMTTY or 2Tone with a different decoding algorithm to decode the 
same audio input. There are up to 4 such windows available (the 
remaining number available appears in the menu). Each additional 
window is associated with either DI1 or DI2, depending on which DI 
window menu was used to open it. There is a separate Setup 
dialog for each additional RX window, which is accessible from the 
menu bar at the top of the additional window. The first time an 
additional RX window is opened, its setup dialog will automatically 
be displayed. The decoder type (MMTTY, TNC or DXP38 - use 
MMTTY for 2Tone), and the path to the program or the COM port 
information for a TNC must be filled in before the additional RX 
window can be used. Once all of the additional RX windows you 
intend to open from either DI window have been set up and tested, 
you can use the Enable Attached RX Windows option to attach 
the additional windows to the main DI window  

 Interface  
o MMVARI - Select MMVARI as the interface (e.g. for PSK or other sound 

card digital modes)  
 No other installation required - the MMVARI engine is installed 

during the N1MM Logger install  
o OTHER(Tnc) - Select the TNC or TU as the interface  

 Help - Shows help file  

4.3. Configurer Selection: DXP38 

 Setup  
o Settings - Opens the Digital Setup window; see the section on 'The Digital 

Interface - Setup' below  
o Turn AutoTRXUPdate On/Off  

 If your radio's dial displays the actual transmitted frequency (i.e. the 
Mark frequency in FSK RTTY), you would turn this option off  

 If your radio's dial displays the suppressed carrier frequency (e.g. 
SSB mode), you would turn this option on. This causes the program 
to add (USB) or subtract (LSB) the audio frequency from the digital 



engine to/from the radio's dial frequency so that the frequency that 
appears in the Entry window, the Bandmap, the log and spotted to 
the DX cluster is the actual transmitted frequency, not the 
suppressed carrier frequency  

 AutoTRXUpdate can affect other modes 

If the AutoTRXUpdate option is turned on, it takes effect whenever the DI window is 
open. If you leave the DI window open and switch to CW or SSB, the offset will continue 
to be applied, and the frequencies in the Entry window, Bandmap and your log will be 
incorrect. You should always close the DI window when switching from digital modes to 
other modes. Also, if you are likely to want to use a non-digital mode the next time you 
start the program, you should close the DI window before shutting down N1MM Logger 
in order to ensure that the DI window does not cause this option to be applied the next 
time you start the Logger. 

o Bring to Foreground when made Active - Bring the Digital Interface and 
Engine to the foreground when its Entry window has focus  

 This adds ability to stack Digital Interfaces and Engines and have 
the correct one on top when the associated Entry window has focus  

o Turn Hover Mode On/Off - With this option selected, when the mouse is 
hovered over a valid callsign the callsign is automatically transferred to the 
Entry window's callsign box without having to click on it. This option is 
most effective when used in combination with the RT Click = Return NOT 
menu option  

 Note: Your own call is excluded from being picked up  
o RT Click = Return NOT menu - When this option is selected, a right-click 

in the RX window will perform the same functions as pressing the Enter 
key. This is designed to work with ESM; in ESM, pressing the Enter key 
automatically sends the next message in the normal QSO sequence. For 
example, when CQing, once a callsign has been placed in the callsign box 
(either by left-clicking on it or using the Hover mode option), right-clicking 
will send the exchange and move the cursor to the exchange box, left-
clicking on the received exchange will transfer the exchange to the entry 
window and right-clicking will send the TU message and log the contact. A 
complete QSO can be performed with simply a couple of left-clicks and a 
couple of right-clicks  

o Send Text File - Send a text file. A file open dialog will appear from which 
the file to be sent can be selected  

o Output Main RX Window to Text File - When this is checked, text that is 
displayed in the main RX window will be saved to a text file in the N1MM 
Logger program folder. The file name will be date stamped (mmddyyyy), 
as in 05312012DigitalInterface1Output.txt (for DI1)  

o Digital Call Stacking - Used together with the {LOGTHENPOP} macro. 
See Single Operator Call Stacking? for more information  
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 Enable using First In First Out - Enables the Digital Call Stacking 
feature. Calls are popped off the stack in the order they were 
placed there  

 Enable using Last In First Out - Enables the Digital Call Stacking 
feature. Calls are popped off the stack in reverse order, i.e. most 
recent first  

 Enable using FIFO Mults First - Enables the Digital Call Stacking 
feature. Calls are popped off the stack in order of their multiplier 
value. In those contests where one QSO can yield 2 or 3 mults, the 
higher-mult calls will be taken first. Among calls with the same 
multiplier value, calls are popped in FIFO order, i.e. in the order 
they were placed there  

 Disabled - Disables the Digital Call Stacking feature  
o Use RX Window Callsign Pause Routines - When this option is 

selected, moving the mouse in the RX window over a valid callsign while 
the callsign box in the Entry window is empty will cause incoming text to 
stop appearing and the RX window to pause scrolling. At this point you 
can either click on the callsign to transfer it into the Entry window, display 
any incoming text that was held back during the pause and resume 
scrolling, or simply move the mouse off the callsign to display any held 
incoming text and resume normal scrolling. Also with this option selected, 
when the left mouse button is clicked in the RX window to select text the 
RX window will pause until the mouse button is released after the text has 
been selected, at which point the selected text will be copied to the 
clipboard, any held incoming text will be displayed and normal scrolling 
will resume. If there is a scrollbar present in the RX window, moving the 
scroll bar will cause incoming text to be paused until either text has been 
selected and the mouse has been released, the pause strip at the left side 
of the window is clicked, or the right mouse button is clicked in the RX 
window  

o Add. RX Windows  
 Enable Attached RX Windows - After one or more additional RX 

window(s) has/have been set up using the last submenu item 
below, this option can be selected in order to attach or embed small 
RX text displays from the additional RX window(s) into the main DI 
window. When the additional RX windows are attached to the main 
RX window using this option, the attached windows appear above 
the main RX window. The non-attached RX windows are minimized 
to the task bar when the attached windows are enabled, but they 
may be restored from the task bar in order to see more text than is 
visible in the attached window, to access the setup options, or to 
close the additional RX window without closing the main DI window  

 Open Add. RX Window (4 Avail.) - This allows you to open an 
auxiliary RX window for diversity decoding of the same RTTY 
signal, e.g. by using a TNC in the main DI window and MMTTY or 
2Tone in the auxiliary window, or by using a different copy of 



MMTTY or 2Tone with a different decoding algorithm to decode the 
same audio input. There are up to 4 such windows available (the 
remaining number available appears in the menu). Each additional 
window is associated with either DI1 or DI2, depending on which DI 
window menu was used to open it. There is a separate Setup 
dialog for each additional RX window, which is accessible from the 
menu bar at the top of the additional window. The first time an 
additional RX window is opened, its setup dialog will automatically 
be displayed. The decoder type (MMTTY, TNC or DXP38 - use 
MMTTY for 2Tone), and the path to the program or the COM port 
information for a TNC must be filled in before the additional RX 
window can be used. Once all of the additional RX windows you 
intend to open from either DI window have been set up and tested, 
you can use the Enable Attached RX Windows option to attach 
the additional windows to the main DI window  

 Interface  
o MMVARI - Select MMVARI as the interface (e.g. for PSK or other sound 

card digital modes)  
 No other installation required - the MMVARI engine is installed 

during the N1MM Logger install  
o Dxp38 - Select the DXP38 as the interface  

 TNC  
o TX - Switches the DXP38 into Transmit mode  
o RX - Switches the DXP38 back to Receive at the end of the current 

message  
o Abort - Switches the DXP38 back to Receive immediately  
o Tuning Indicator - DXP38 Tuning Indicator on/off  

 On - tuning indicator on  
 Off - tuning indicator off  

o Echo - DXP38 Echo on/off  
 On - echo on  
 Off - echo off  

o Tones - DXP38 Tones setup  
 Normal - normal mark/space tones  
 Reverse - reverse mark/space tones  

o RF Gain - DXP38 RF Gain setup  
 0 - no amplification  
 +6 db - 6 db amplification selected  
 +12 db - 12 db amplification selected  

o Filter - DXP38 Filter setup  
 Narrow 55 hz - Selects narrow (55 Hz) filter  
 Mid 75 hz - Selects mid (75 Hz) filter  
 Wide 100 hz - Selects wide (100 Hz) filter  

o Setup TNC - Opens the DXP38 tab in the Digital Setup window for making 
adjustments to other DXP38 parameters  

o Hard Reset TNC - As it says - does a hard reset on the DXP38  



 Help - Shows help file  

5. The Digital Interface - Setup 

This setup dialog is for all interface types, but some settings are only for MMTTY or 
MMVARI. When selecting 'Setup | Settings' in the Digital Interface window a dialog like 
the one below will shown. Any changes made in the setup form must be saved by 
clicking the Save Settings button located on the bottom of the form. Any changes made 
and saved will be changed as soon as the setup area closes.  

5.1. Tab: General/MMTTY Setup 

This interface has general setup information for ANY type of interface (Soundcard or 
external TNC) and some specific settings for MMTTY, MMVARI and Fldigi.  

 

 RX Windows add to Grab window - If this option is checked, callsigns detected 
in the Additional RX windows will be sent to the Grab window  



 Display Radio Freq and not Exact Freq in DI Caption  
o Check this option if you are using a radio mode that displays the actual 

transmitted frequency rather than the suppressed carrier frequency (e.g. 
FSK RTTY)  

o Note that this setup option only affects the frequency that is displayed in 
the DI window and that is returned by the {RDIGFQ} or {LDIGFQ} macro. 
To change the frequency that is sent to the Entry window and recorded in 
the log, see the DI window's Setup > Turn AutoTRXOffset On/Off menu 
item  

 Add Callsign to Bandmap on Alt+G - (MMTTY and PSK) Option to send 
callsign from station in callsign field (Alt+O) when doing a grab (Alt+G)  

 Send Space on Callsign Mouse Click - Sends a space to advance the entry 
window cursor after clicking on a call sign  

 (MMTTY) Send HamDefault on Run to S&P change - (MMTTY only) Ability to 
have Ham Default(MMTTY) sent when going from Run to S&P to reset Mark 
Frequency. Select to enable  

 (MMTTY-MMVARI) Turn AFC Off when switching to S&P - (MMTTY and PSK) 
Ability to Turn AFC Off when going from Run to S&P. Select to enable. Many 
people when in Running mode will leave the Net Off and turn on AFC to find 
people coming back to them a little off frequency. So to turn the AFC back off 
when you go to S&P (without forgetting) this setting comes in handy  

 Do Not add Dupes to Grab Window - Setting for adding dupes to Grab window 
or Not  

 Send Space on Using Grab - when doing a grab from the grab window it will 
also send a space press command to Entry window to advance the cursor  

 If QSY Wipes call is checked Clear Grab Window on QSY - If QSY Wipes and 
Spot call is checked then Clear the Grab window on wipe of callsign.  

 QSY will clear Grab Window - Changing frequency will clear the Grab window  
 Clear Grab Window On CQ - sending CQ will clear the Grab window  
 Only Grab Master.scp Calls and - Will only send calls that are found in 

Master.scp to the Grab window; if this is left unchecked, anything that passes the 
callsign validity check routines will be sent to the Grab window  

 On Top Settings  
o MMTTY always on Top - MMTTY is always in front of all other N1MM 

logger windows. A restart of N1MM logger is needed to activate this 
function. Minimizing the N1MM logger program will not minimize the 
MMTTY engine  

o MMVARI always on Top - MMVARI is always in front of all other N1MM 
logger windows. A restart of N1MM logger is needed to activate this 
function. Minimizing the N1MM logger program will not minimize the 
MMVARI engine  

o Fldigi always on Top - Fldigi is always in front of all other N1MM logger 
windows. A restart of N1MM logger is needed to activate this function. 
Minimizing the N1MM logger program will not minimize the Fldigi engine  



 Shift Frequency Compensation - for radios which use/need Shift Frequency 
Compensation  

o Enabled - Select to enable Shift Frequency Compensation  
o Offset Frequency - the frequency offset  

 Window Scroll  
o Window Scroll Type - You can choose between two scrolling behaviors 

in the RX window:  
 Scrolling - New text is always added at the bottom of the RX 

window. Each time a new line starts, previous text scrolls up one 
line to make room for the new line at the bottom of the window. The 
most recent text will always be near the bottom of the window, so 
you don't often need to move the mouse away from the bottom two 
lines or so, but if a newline character is received just as you want to 
click on something, the text you wish to click on will scroll upward  

 Non Scrolling - Previous text does not move when new text is 
added. The line where text is currently being entered is underlined, 
and each time a new line starts, the line immediately below the old 
current line is cleared and it becomes the new current line. If the 
previous current line was the bottom line of the display, the new 
current line will be the top line in the display, overwriting whatever 
was there before. Text does not move after it is entered, which can 
make it easier to click on than text in a scrolling window, but the 
most recent text can be anywhere in the window  

 

 Callsign Validity and Highlight Routines  
o Use Generic Routines - the generic routines will highlight anything that 

passes the check routines (and probably will look like a callsign), using the 
standard colors for multipliers, QSOs and dupes  

o Use these resources: - when selected, only call signs that are found in at 
least one of the selected resources will be highlighted  

 You can select any combination of the Master.scp file, the Call 
History file, calls that have been spotted on the cluster and appear 
in the Telnet window, and/or calls that have been logged in this 
contest  

o Use Combination of both - when selected there will be additional 
highlighting for callsigns that are not found in the selected resources. If the 
normal highlight is foreground, the background will be changed to yellow; 
if the normal highlight is background, the text color will be changed to 
yellow. The yellow color is not configurable  

o Use Search routine to find Master.scp in Garbage Text - turn checking 
for callsigns in garbage text in digital modes on or off. When this is turned 
on, callsigns that appear in the Master.scp file will be highlighted even if 
there are garbage characters before and after the call. Note that if a longer 



callsign is found that contains a callsign in Master.scp, only the callsign 
from Master.scp will be highlighted; you will have to enter the longer call 
sign by hand  

o Highlight Foreground Text - call sign text will be in the highlight color on 
the normal background  

o Highlight Background of Text - background color surrounding call sign 
will be changed to the highlight color  

 Alignment Frequency - frequency used by the Align button = preferred audio 
frequency. If you are using FSK RTTY, be sure to set the RTTY alignment 
frequency corresponding to your radio's transmit frequency (i.e. set Align 
frequency to your radio's Mark frequency in MMTTY, Mark frequency + 85 in 
MMVARI and Fldigi)  

o MMTTY - RTTY alignment frequency. This is the Mark frequency  
o MMVARI - Alignment frequencies for MMVARI  

 RTTY - RTTY alignment frequency in MMVARI  
 NB Add 85 to place MMVARI's Mark Frequency on desired 

frequency. Example: For 2125 Mark, enter 2210  
 Other - alignment frequency for other modes than RTTY (e.g. PSK)  

o FLdigi - Alignment frequencies for Fldigi  
 RTTY - RTTY alignment frequency in Fldigi  
 Other - alignment frequency for other modes than RTTY (e.g. PSK)  

 Default RTTY Interface - Select the preferred RTTY interface. Choices are: 
MMTTY, MMVARI, FLDIGI, TNC or DXP-38  

 Default PSK Interface - Select the preferred interface for PSK (and other sound 
card modes). Choices are MMVARI or FLDIGI  

 MMTTY Window Layout  
o Normal - The normal size MMTTY window is shown, including 

waterfall/spectrum, menu bar and control buttons  
o Small - The small size MMTTY window is shown, i.e. waterfall/spectrum 

display only  
o Control Menus - Shows waterfall/spectrum plus menu bar  
o Control Buttons - Shows waterfall/spectrum plus control buttons  

 Save Settings - Save the configuration changes you just made. If you want to 
back out without saving the changes, click on the X in the upper right corner to 
close the window; the program will ask you whether you are sure you don't want 
to save the changes  

5.2. Tab: MMVARI Setup 



 

 Waterfall/Spectrum Setup  
o Waterfall/Spectrum/Misc Color palette - The colors that make up the 

color palette can be changed to represent whatever colors you would like. 
The colors go from the weakest signal on the left to the strongest signal on 
the right. There is a color palette setting for the Waterfall, Spectrum and 
for Miscellaneous colors. The Default button changes the colors back to 
the default colors  

o AFC Search Range - This is how far in Hz the interface will track a drifting 
signal i.e the frequency sweeping width (+/-Hz) for the AFC  

 Sense Level - specifies the S/N level (dB) for the wide AFC. When 
the search range is less than or equal to 50 Hz, the wide AFC does 
not function. The sense level is applied to all the RX channels  

o Digital Output Level - specifies the digital output level in the range of 0 to 
32767. The default value is 16384  



o Use TNC Software for control - When selected N1MM logger will release 
the serial port for the TNC so the soundboard in the TNC can have 
control. When using an external TNC the internal soundboard can be used  

o # of MMVARI channels - Number of MMVARI channels to use. Choices 
are 1, 2, 3 or 4  

 Note that if this is set to 1, you have the option to select the Multi-
Channel Rx menu item in the MMVARI menu bar, but when it is set 
to 2, 3 or 4 this option is not available  

o MFSK (MFSK only)  
 Handling Center Frequency - When selected the center frequency 

is used for the carrier frequency. When not selected the base tone 
frequency is used for the carrier frequency  

 Use Metric Level Squelch - Select to use the metric level for the 
squelch. When not selected the S/N level is used for the squelch  

o Squelch Level - This level represents the noise level where you would 
like the interface to start copying signals. 0 indicates an open squelch and 
everything will be decoded  

o High Pass Filter - Select 'Use High Pass Filter' to use the internal high 
pass filter for RX. Although this is unnecessary with most soundcards, it 
sometimes is effective for eliminating hum in the input audio  

o Spectrum Lower Freq - the lower frequency to display when the 
Spectrum view or Waterfall is active  

o Spectrum Upper Freq - the upper frequency to display when the 
Spectrum view or Waterfall is active  

o CW ID  
 Enable - If this check box is checked (Enabled) the interface will 

send the string entered in the field (Enter CWID String) in CW after 
every transmission. A * will be substituted by SK, + by AR and = by 
BT  

o Save Settings - Save the configuration changes you just made. If you 
want to back out without saving the changes, click on the X in the upper 
right corner to close the window  



 

 

 Soundcard Setup  
o DI1/DI2 MMVARI Soundcard  

 Input Soundcard # - Select the input soundcard to be used  
 Input Channel - Select the input channel. Mono, Left channel or 

Right channel  
 Output Soundcard # - Select the output soundcard to be used)  

o FIFO  
 RX - specifies the depth of the RX FIFO buffer. Valid values are 4 

to 32  
 TX - specifies the depth of the TX FIFO buffer. Valid values are 4 to 

32  
o Clock - Soundcard Clock adjustment  

 RX Freq - specifies the sampling rate  



 TX Offset - the offset of the TX frequency compared to the RX 
frequency (some sound cards have an offset between record and 
playback)  

o Save Settings - Save the configuration changes you just made. If you 
want to back out without saving the changes, click on the X in the upper 
right corner to close the window  

5.3. Tab: Message Setup 

This tab is where you can edit the message buttons that are displayed in the lower part 
of the DI window. In addition to selecting this tab from the DI Setup window, you can 
also open this window by right-clicking on one of the buttons.  

There are four separate sets of message buttons stored in the database, one for each 
type of digital interface (MMVARI, MMTTY/2Tone/Fldigi, TNC and DXP38). Before 
importing, exporting or editing buttons you need to select the particular message set 
you will be working on.  

 

 Import - Once a message set has been selected under Digital Message Set, 
you can import buttons for that set from a .mc file using the Import button  

 Save - You can save the current message buttons in a .mc file in the N1MM 
Logger+ user files area by using the Save button  



 # of Messages - Select the number of message buttons to be displayed in the DI 
window. You can select 0, 8, 16 or 24  

 Digital Message Set -  
o Select an interface type from the drop down menu. Choices are:  

 MMVARI - messages for the MMVARI interface  
 MMTTY,Fldigi - messages for the MMTTY, 2Tone and Fldigi 

interfaces  
 Other - messages for a TNC (such as a PK-232 or KAM)  
 Dxp38 - messages for a DXP38  

o Click on the message button which is to be updated to transfer that button 
to the Message Setup area  

o The Macro buttons at the right are for TNC interfaces only. Enter the 
control codes that are needed to switch your TNC between RX and TX  

 Only visible when Other is selected  
 RX - Receive macro, i.e. the command(s) your TNC needs to put it 

into transmit. This will become the contents of the {RX} macro  
 TX - Transmit macro, i.e. the command(s) your TNC needs to put it 

back into receive at the end of a message. This will become the 
contents of the {TX} macro  

 ESC - Abort macro, i.e. the command(s) your TNC needs to abort 
an ongoing message immediately. This will be executed when you 
press the Escape key  

 Message Setup  
o Message Text - This is where the text of the message sent by the 

selected button is displayed and can be edited  
o Message Caption - This is where the caption that will appear on that 

button is displayed and can be edited  
o Available Macros - Shows the available macros that can be used in 

messages. Clicking on a macro will transfer it to the message text area  
o Save Message - Save the contents of the Message Text and Message 

Caption into the selected button  

 Save Settings - Save the configuration changes you just made, i.e. the entire set 
of 24 buttons. If you want to back out without saving the changes, click on the X 
in the upper right corner to close the window  

5.4. Tab: WAE RTTY Configuration 

This tab will only show when the WAE RTTY contest has been selected and the 
information in this tab is only valid for the WAE RTTY contest.  



 

 RQTC Messages - Under RQTC are the standard messages to be sent when 
receiving QTCs  

o RX Ready - the message to be sent to indicate you are ready to receive a 
batch of QTCs  

o All Agn - message to be sent if copy was poor and you want the entire 
batch sent again  

o Agn - message to send to request a repeat of a single QTC  
o Save QTC - message to send once the entire batch has been received 

and logged  

 SQTC Messages - Under SQTC are the standard messages to be sent when 
sending QTCs  

o RU QRV - the message to be sent to ensure the other station is ready 
before sending a batch of QTCs  

o Send All Heading - the message that sends the QTC batch number and 
number of QTCs ({QTC} - 1/10, for example)  

o Send All Ending - message sent after the entire batch has been sent  
o Save QTC - message to send once the other station has confirmed the 

QTCs have been received  



o QTC Spacing - character to send between individual QTCs (either 
{ENTER} or {ENTERLF}_)  

 When sending request for single QTC do what?  
o Clear all data for that QTC  
o Clear only Bad Data  
o Do nothing just send request  

 Default Number of QTC to Send - maximum of 10 QTC's  

 Save Settings - Save the configuration changes you just made. If you want to 
back out without saving the changes, click on the X in the upper right corner to 
close the window  

5.5. Tab: DXP-38 Setup 

This tab will only show when the DXP-38 TU has been selected under the Digital Modes 
tab in the Configurer.  

 

 
The various settings in this window are for setting up DXP-38 parameters. Consult the 
DXP-38 manual for detailed instructions on setting them up.  



 Save Settings - Save the configuration changes you just made. If you want to 
back out without saving the changes, click on the X in the upper right corner to 
close the window  

 

2.7.4 Digital - MMTTY for RTTY support 

 2.7.4 Digital - MMTTY for RTTY support  

o 1. MMTTY Windows  
o 2. Download, Configure and Test MMTTY  

 2.1. Download MMTTY  
 2.2. Configure MMTTY  

 2.2.1. FSK KEYING  

 2.2.1.1. Using the RIGblaster Interface for FSK with 
N1MM/MMTTY  

 2.2.2. AFSK KEYING  

o 3. Testing MMTTY  
o 4. Dual Receiver/Dual Radio Setup  
o 5. Using MMTTY  

 5.1. How to Tune RTTY  
 5.2. When Should I Use AFC?  
 5.3. When Should I Use the NET Option: NET On/Off with Run 

Change  
 5.4. Why to Use "Auto Update TRX Offset w/Mark Freq."  
 5.5. Using MMTTY for 75 baud RTTY  

The MMTTY soundcard interface, which uses the MMTTY engine by Makoto Mori, 
JE3HHT, is the most popular method for RTTY. Amateurs who use RTTY are indebted 
to Mori-san for the positive impact MMTTY has had on amateur radio RTTY. 

The 2Tone soundcard interface was written by David Wicks, G3YYD, as a replacement 
for the MMTTY interface in programs like N1MM Logger. It can be substituted for 
MMTTY as the digital engine used in any of the Logger's DI windows or Additional RX-
only windows. The 2Tone windows are different in appearance from the MMTTY 
windows, but perform similar functions. These windows are described and documented 
in pdf files that you download with 2Tone.  

1. MMTTY Windows 

When using MMTTY two windows will open.  

 the Digital Interface window  
o is similar for MMTTY, MMVARI, Fldigi and external Interfaces (TNCs or 

TUs). See the Digital Interface section  
 the MMTTY engine window -  

http://n1mmplus.hamdocs.com/tiki-index.php?page=Digital+Setup&structure=N1MM+Logger+Documentation#The_Digital_Interface_-_Window


o there are four versions which can be selected in the Digital Interface menu 
under Settings.  

 Small version MMTTY engine window  

 

 Normal, or Large version MMTTY engine window  

 

 Control Menus - small window plus the menu bar (View, Option, 
Profiles)  

 Control Buttons - large window minus the menu bar  

2. Download, Configure and Test MMTTY 

2.1. Download MMTTY 

 Download the current release of MMTTY here   
o At least version 1.64 is needed; version 1.68A is recommended  

 Run the setup program and install MMTTY to your computer in its own directory  
o In Windows 7, 8 and Vista, you must install MMTTY to somewhere other 

than the Program Files or Program Files(x86) directories (for example, you 

http://hamsoft.ca/pages/mmtty.php


can create an installation folder such as C:\MMTTY or 
C:\HamRadio\MMTTY)  

o If you are using a standard USB-to-serial adapter for FSK keying, you will 
probably need to use the EXTFSK plug-in. You can find a link to EXTFSK 
on the MMTTY download page (near the bottom of the page). Go to the 
EXTFSK page, then download the ExtFSK106.zip file from the link at the 
bottom of that page and unzip it into the MMTTY program folder  

 Users with high-performance multi-core CPUs (typically a 2.4 GHz 
i5 or faster Intel based system or 2.4 GHz quad core or faster AMD 
based system running Windows 7 or Windows 8) may be able to 
use EXTFSK64 instead of EXTFSK. EXTFSK64 has improved 
timing relative to EXTFSK, it supports speeds other than 45.45 
baud, and it can be used with LPT ports on 64-bit systems, but its 
CPU requirements are much greater than those of EXTFSK. See 
http://www.qsl.net/ja7ude/extfsk/indexe.html  for more information 
and downloads  

o When you run MMTTY from inside N1MM Logger+, you will likely want the 
MMTTY configuration to be different from the configuration used when 
MMTTY is run stand-alone. MMTTY always saves its configuration data to 
files within its program folder. Therefore, any copy of MMTTY that is used 
from within the Logger should be stored in a different folder from the main 
MMTTY folder. This can be a separate sub-folder in the MMTTY program 
folder, or it can be a folder in the N1MM Logger+ user files area, which is 
normally in your My Documents folder (e.g., you can create a 
DigitalEngines sub-folder in the Logger+ user files area and then create 
separate subfolders in that folder for each copy of MMTTY you wish to run 
from within the Logger). Then copy only the following files from the main 
MMTTY program folder into the new folder: MMTTY.exe, MMTTY.ini, 
UserPara.ini, and if you need it for FSK transmitting, Extfsk.dll or 
Extfsk64.fsk. If you use more than one copy of MMTTY (e.g. for 
SO2R/SO2V, or for additional RX-only windows), each copy must be 
installed in its own folder  

 The 2Tone engine, which can be used as a drop-in replacement for MMTTY, can 
be downloaded from the G3YYD folder in the Files area of the N1MMLogger-
Digital Yahoo user group, in the form of a zip file containing the 2Tone engine 
together with documentation for installing and using it. Each copy of 2Tone you 
plan to run (from DI windows or additional RX-only windows) must be placed in 
its own folder  

2.2. Configure MMTTY 

2.2.1. FSK KEYING 

1. In the N1MM Logger Entry window, select >Config >Ports, Telnet Address, Other 
>Digital Modes tab  

o Select Soundcard as your Interface type  

http://www.qsl.net/ja7ude/extfsk/indexe.html


o Select for the selected Digital Interface as MMTTY, Mode FSK  
o Select the path to your MMTTY directory (for DI-2 if you are configuring for 

the second DI window)  
 Select the 'Hardware' tab  

o Beside the port that you are using for FSK keying, if you are also using 
this same port for PTT or CW keying from the main N1MM Logger 
program and the CW/Other box for that port is checked, place a check 
mark under the Digital column beside this port as well; note that this is not 
applicable if you are using EXTFSK or EXTFSK64. If you are only using 
the port for RTTY and not in other modes (i.e. the CW/Other check box is 
not checked), you do not need to check the Digital check box  

o If you have checked the Digital check box, click on the Set button and set 
the Dig Wnd Nr to 1 (or 2 if you are configuring for DI-2)  

 
2. Save and exit the Configurer  

 If MMTTY is already loaded you may get an error message about not being able 
to open port xxxx. This is not a problem at this point; note that you can always re-
initialize MMTTY by closing and re-opening the Digital Interface window  

 
3. Open the Digital Interface window (under the Window menu)  

 Select the Interface > MMTTY menu item in the DI window  
 Select: Option > Setup in the MMTTY window, or use the DI window's Setup > 

Setup MMTTY menu item  
o Select the TX tab and under PTT, set the serial port that you will be using 

for FSK keying; if you also use this port in other modes for CW or PTT 
keying, the Digital and CW/Other check boxes in the Configurer should 
also be checked for this port, and the DigWndNr in the setup dialog box 
for that port must indicate which DI window the port will be used with (1 or 
2)  

 If you are using a control line other than TxD for FSK keying, you 
must select EXTFSK or EXTFSK64 as the serial port and configure 
the port and signal line information in the EXTFSK window. If you 
are using a USB-to-serial adapter, you will most likely also have to 
select EXTFSK or EXTFSK64 as the serial port and configure the 
port and signal line information in the EXTFSK window, as most 
USB-to-serial adapters are not capable of keying FSK RTTY 
without EXTFSK  

 Note that MMTTY's Radio Command port must be set to NONE; if 
you use MMTTY's Radio Command port when running MMTTY 
stand-alone, you must reconfigure MMTTY not to use this port 
when it is run from N1MM Logger+  



o Select the Misc tab in the MMTTY Setup window and check COM-
TxD(FSK) for the Tx Port  

 If you are using a USB device to do FSK keying, click on the USB 
Port button and set the option to C. Limiting Speed  

o Select the Sound Card tab (in MMTTY version 1.66G or later) and choose 
the correct sound card for Reception (the Transmission sound card is not 
used in FSK) (Note: Users of newer versions of Windows should consult 
the text box on sound card selection in Windows 7 in the section below on 
AFSK, as the same issues may apply to sound card selection for reception 
in FSK.)  

o If you are using two copies of MMTTY to decode signals using the two 
channels of a stereo sound card for different receivers (SO2V) or different 
radios (SO2R), select the Misc tab again and in the Source pane, select 
either "Left" or "Right", depending on which channel you want this copy of 
MMTTY to decode  

o Close the MMTTY Setup dialog  
o Close the Digital Interface window to have the Logger and MMTTY save 

the settings  

2.2.1.1. Using the RIGblaster Interface for FSK with N1MM/MMTTY  
 
The default for FSK via MMTTY is TXD. You'll need to change the jumpers when using 
a RIGblaster. Also, make sure you get MMTTY working as a standalone first. Then you 
should just be able to specify MMTTY (select Soundcard) in the Digital Interface config 
in N1MM and it should take off.  

2.2.2. AFSK KEYING 

 
1. Open the Configurer (Configure Ports, Telnet Address, Other in the Config menu).  

 Select the Digital Modes tab  
o Select Soundcard as your Interface type.  
o Select for the selected Digital Interface as MMTTY, Mode AFSK  
o Select the path to your MMTTY directory (for DI-2 if you are configuring for 

the second DI window)  
 Select the 'Hardware' tab  

o You can let N1MM Logger+ control PTT, or if you don't use PTT in other 
modes and want to have MMTTY control PTT, you can configure MMTTY 
to control PTT from a serial port. You can time-share a serial port between 
CW/PTT keying in N1MM Logger+ and PTT from MMTTY; to do this, you 
must place a check mark under the Digital column beside the port that you 
are using for the digital port  

o If you are using VOX or an external VOX unit like the SignaLink interface 
to control PTT, you don't need to configure anything for it in the Logger  

o If you have checked the Digital box, click on the Set button and set the Dig 
Wnd Nr to 1 (or 2 if you are configuring for DI-2)  



o If you are using 2Tone in place of MMTTY, do not check the Digital check 
box for your PTT port  

 
2. Save and exit the Configurer.  

3. Open the Digital Interface window (under the Window menu)  

 Select the Interface > MMTTY menu item in the DI window  
 Select: Option > Setup in the MMTTY window, or use the DI window's Setup > 

Setup MMTTY menu item  
o If you are using 2Tone rather than MMTTY, you will make the 

configuration settings below in the 2Tone Setup window, which is opened 
from the 2Tone window  

o If you have chosen to have MMTTY control PTT (not applicable with 
2Tone), select the TX tab and under PTT, set the serial port that you will 
be using for PTT. If the port is being time-shared with other modes, this 
should be the same port that you checked the Digital box for in the 
Configurer  

 Note that MMTTY's Radio Command port must be set to NONE; if 
you use MMTTY's Radio Command port when running MMTTY 
stand-alone, you must reconfigure MMTTY not to use this port 
when it is run from N1MM Logger  

o Select the Misc tab and check Sound for the Tx Port  
o Select the SoundCard tab (in MMTTY version 1.66G) and choose the 

correct sound card for both Reception and Transmission (users of 
WIndows 7, Vista and newer versions should read the note below)  

o If you are using two copies of MMTTY to decode signals using the two 
channels of a stereo sound card for different receivers (SO2V) or different 
radios (SO2R), select the Misc tab again and in the Source pane, select 
either "Left" or "Right", depending on which channel you want this copy of 
MMTTY to decode  

o Close the Setup dialog  

o Close the Digital Interface window to have the Logger and MMTTY save 
the settings  

 
Sound Card Selection in Windows 7, 8 and Vista  

In earlier versions of Windows, selecting the sound card was relatively straightforward. 
Windows assigned a number (or two numbers, one for recording=receiving and one for 
playback=transmitting) to each sound card device when it was installed, and that 
number could usually be relied upon not to change. Once you had selected the desired 
sound card in MMTTY, you were finished with the sound card configuration. 

Starting with Vista and continuing in Windows 7 and 8, Windows has made life for 
sound card users more complicated. The list now enumerates each active input or 



output as a separate device. The list of active inputs or outputs can change dynamically. 
Plugging or unplugging a cable into one of the jacks on a sound card can create or 
delete a new entry on the list. Windows power management can turn a USB port off if it 
has not detected any keyboard activity for some time, causing any inputs or outputs on 
a USB sound card on that port to be removed from the list. When the computer is 
restarted or reawakened after hibernating or sleeping, the list may be reconstructed and 
if there have been changes since the last restart, the order of devices on the list may 
change. If you are using a radio with a built-in USB codec, turning the radio on or off will 
add or remove that codec to/from the list. If any of these changes in the list results in a 
different number being assigned to a device you are using in MMTTY, that device will 
appear to stop working and you will have to readjust the sound card configuration in 
MMTTY. 

If this happens to you, the way to avoid it is as follows: Immediately before the contest, 
make sure that every sound card or codec that you plan to use during the period of the 
contest is turned on and stays on for the duration. Verify your sound card configuration 
immediately before the contest and then avoid doing anything during the contest that 
might result in a change to the list. Disable power management features that might 
result in a USB port you are using being shut off by Windows. If you are using the USB 
codec inside a radio, always turn on the radio before opening the DI window, and close 
the DI window before turning off the radio; preferably, don't turn the radio off during the 
contest. Fortunately not all of these precautions will be necessary in every case, but you 
should be aware of the possibility just in case. 

One other wrinkle introduced in newer versions of Windows is that with some sound 
cards, the default for the sound card input in the Windows Control Panel may have been 
set to single channel (mono) instead of two channels (stereo). If you are planning to use 
both channels of a stereo sound card to decode signals from two receivers (SO2V) or 
two radios (SO2R), you may need to verify that the default recording format for that 
sound card input is set to two channels. This is done via the Windows Control Panel 
(Sound > Recording > select the input you are using and click on Properties > 
Advanced)  

While you are checking the default recording format for number of channels, you will 
likely also have the choice of setting the sample rate and bit depth. Bit depth is not a 
problem (16 bits is fine), but the sample rate has become an issue in Windows 7, 8 and 
Vista. The sampling speeds in all applications that are using the same sound card in 
parallel should be the same, and they should be integer sub-multiples of the hardware 
sampling rate. The default sampling speed in MMTTY is 11025 Hz, which is suitable for 
a sound card that is set for CD quality (44100 Hz). However, the sampling speed in 
2Tone is 12000 Hz, which is suitable for a sound card that is set for DVD quality (48000 
Hz), and it is not user-adjustable. Your best bet is probably to set the sound card's 
sampling rate to 48000 Hz (DVD quality), and to change the sampling speed in MMTTY 
to 12000 Hz (MMTTY Setup window, Misc tab, lower left corner - it's called "Clock").  

3. Testing MMTTY 

MMTTY is also a stand-alone application, so testing can be done outside N1MM 
Logger+. You can use the originally-installed copy of MMTTY for stand-alone testing. 



Configuration changes you make in the stand-alone copy will not be applied to the 
copies that you run from inside the Logger; once you have settled on a setup item in 
one copy, if you want that same item to apply in other copies you will have to use the 
Setup window from within each separate copy to change that item.  

4. Dual Receiver/Dual Radio Setup 

In a dual-receiver setup (SO2R or SO2V), you may wish to be able to copy two 
separate RTTY signals (e.g. on two separate bands or two separate frequencies) 
simultaneously. To do this, you would open two Entry windows (VFO A/Radio 1 and 
VFO B/Radio 2) and open the Digital Interface window from each Entry window. You 
can then run MMTTY (or other digital interface engine, such as 2Tone) from each of 
these DI windows.  

The two audio streams from the two receivers can either be decoded by two separate 
sound cards, or in a single stereo (two-channel) sound card using the left and right 
channels for the two receivers. In either of these situations, the two copies of MMTTY 
must have different configurations; in particular, each one must be configured to use a 
different channel of the sound card, or a different sound card. In the case of a dual radio 
setup, if you are using FSK on both radios and/or if MMTTY is used to control PTT on 
both radios, each copy of MMTTY would also have to have access to its own serial port 
for PTT & FSK. This is also true in SO2V setups in order to enable transmitting from 
either VFO; even though there is only one FSK keying input to the radio in SO2V, the 
two DI windows need two separate serial ports for FSK keying, both connected to the 
same keying input on the radio.  

These serial ports are configured in MMTTY. You must set up each copy of MMTTY to 
use its respective serial port by choosing the relevant serial port in the PTT & FSK Port 
box under the TX tab in the MMTTY Setup window. If one or both of these ports is time-
shared with N1MM Logger+ for CW/PTT keying, then in the Configurer you must 
indicate this with check marks in the Digital column (Note: in order to check two Digital 
mode ports in the Configurer, you must be in SO2V or SO2R mode). You must also 
click on the Set button for each port in the Configurer and set the Dig Wnd Nr to 1 or 2, 
to indicate which of the two DI windows that serial port will be associated with.  

If the two copies of MMTTY are to use different channels of the same sound card, each 
copy must be configured to use its respective channel on the sound card under the Misc 
tab in the MMTTY Setup window; or, if they are using different sound cards, each copy 
must be configured to use its own sound card under the SoundCard tab.  

In order to support separate configurations for the two copies of MMTTY, each copy 
must be located in a separate folder. You can either use the main MMTTY program 
folder for one copy and a separate subfolder for the other copy, or you can create two 
subfolders for use by the Logger, leaving the copy in the main MMTTY program folder 
for stand-alone use. These subfolders must each contain, at a minimum, a copy of the 
MMTTY.exe file and the UserPara.ini file from the main MMTTY program folder. A copy 
of MMTTY.ini will be created the first time MMTTY is run from the folder if it was not 
previously present. If you are using the EXTFSK plugin, you will need a copy of the 



extfsk.dll file in the folder as well (or the extfsk64.fsk file if you are using EXTFSK64). 
Other files from the main MMTTY program folder are not used.  

The Logger's DI windows have an additional RX window feature as well. Up to four 
additional RX-only windows can be invoked from the Setup menus in the two DI 
windows. They can use either hardware decoders, MMTTY or 2Tone, but the most 
common use is for separate copies of MMTTY or 2Tone using different decoding 
algorithms or profiles on the same data stream. Because they are receive-only, these 
windows do not need access to serial ports and are not configured in the Configurer. 
However, to be fully useful, although they most likely will share the same sound card 
and channel with their parent DI window, they do need to have separate setups from the 
main copy of MMTTY (e.g. to use a different decoding algorithm or profile). Therefore, if 
you wish to use these additional RX-only windows with MMTTY, you will need to create 
additional folders, one for each additional window, containing copies of the MMTTY.exe, 
MMTTY.ini and UserPara.ini files (or if your are using 2Tone in stead of MMTTY, the 
2Tone.exe, MMTTY.ini and 2Tone.ini files). These additional folders do not have to be 
created at the time you first install MMTTY, i.e. you don't need to do this until you are 
ready to use the additional RX windows. In Windows 7, 8 and Vista, all of these folder 
must be outside the Program Files and Program Files(x86) paths.  

5. Using MMTTY 

 Messages must begin and end with {TX} and {RX}; these macros tell MMTTY to 
perform PTT switching  

 There is no special abort macro needed for use with MMTTY; just using the ESC 
key will stop transmitting  

 The TX and RX buttons in the DI window can be used for free form typing in the 
TX window pane of the DI window  

5.1. How to Tune RTTY 

 Use the VFO on your radio and dial in the peaks to match the 2 yellow lines on 
the spectrum  

 Click view and the X-Y scope to see a crossed-ellipses tuning display  
o If the X-Y display seems to rotate in the wrong direction, open the MMTTY 

Option > Setup window (or the DI's Setup > Setup MMTTY menu item), 
select the Font/Window tab and check (or uncheck) the Reverse rotation 
button  

 Make sure you click the "HAM" button to set MMTTY to the correct mark and shift 
settings  

o The default values for the HAM setting can be changed under the 
Demodulator tab in the MMTTY Option > Setup window  

 It's better to turn AFC off when you are in a crowded section of the band and 
manually tune the signals; if you leave AFC on, nearby strong signals may pull 
the tuning away from the signal you want to copy  

 Also in crowded sections it can be helpful to use the built-in notch and bandpass 
filters  



 If you are using AFSK, unless your radio has a specialized mode for AFSK 
RTTY, the conventional choice with MMTTY is to use LSB on all bands  

o If you use USB, make sure you click the "Rev" button in MMTTY  
 If you are using FSK, you need to be aware that NET does not work, and that 

tuning in a received signal by clicking in the waterfall or by allowing AFC to tune 
in the signal will result in your receive frequency being different from the transmit 
frequency. The "HAM" button will restore the correct audio frequency in your 
receive decoder but without retuning the radio. The "Align" button in the DI 
window can be used to retune your radio so that the received signal is lined up 
with your radio's transmit frequency  

5.2. When Should I Use AFC? 

 Use AFC (automatic frequency control) when MMTTY should automatically track 
the incoming RTTY signal. The best example of this is when you are CQing and 
want to tune in off-frequency callers  

 With AFC and NET both turned on, MMTTY will track the incoming signal and 
also keep your transmitter frequency locked to the received signal when using 
AFSK (NET does not work in FSK)  

 
When MMTTY is set to transmit FSK, AFC will work on receive only. When in "Running" 
mode, you want to keep your TX frequency stable, but with RX AFC set on you can pick 
up stations who reply a bit off your frequency and copy the exchange without losing 
your TX spot. Just don't let the AFC spread get too far from where you're transmitting.  

 A nice option to use is: AFC On/Off with CQ - If set then the AFC will turn on with 
CQ message or TU messages. This way when Running the AFC is on and during 
S&P the AFC is off  

5.3. When Should I Use the NET Option: NET On/Off with Run Change 

 
NET only operates in AFSK. If you are using FSK, your transmit frequency is fixed by 
your transmitter, and the NET software feature does not work.  

 When in 'Search and Pounce' mode the program will check the NET option so 
that once you tune a signal in, you will transmit on the same frequency you are 
receving him on (Warning: this doesn't work in FSK)  

 When in 'Running' mode the program will uncheck the NET option, which allows 
your receive decoder to follow an off-frequency caller while still leaving your 
transmit frequency unchanged  

5.4. Why to Use "Auto Update TRX Offset w/Mark Freq." 

 
If you are using FSK RTTY, most radios display the actual mark frequency on the tuning 
dial. A few even do this in AFSK RTTY. If your radio is like this, you don't need to use 



this option. The DI window title bar may display an offset frequency (radio dial (+/-) 
audio), but if this option is turned off the offset frequency will not be logged and you can 
ignore it.  

If you are using AFSK RTTY, especially with the radio in LSB or USB mode, as well as 
when you are doing a sound card digital mode like PSK (using MMVARI or Fldigi), the 
radio probably displays the suppressed carrier frequency on its dial. This is different 
from the mark frequency. If you are using the default mark frequency of 2125 Hz, the 
radio's dial display will be 2125 Hz too high (LSB) or too low (USB) as compared with 
the actual mark frequency. By checking this option, N1MM Logger will perform the 
correction automatically and display the actual mark frequency in the Entry window and 
the Bandmap window, as well as in the DI window title bar.  

5.5. Using MMTTY for 75 baud RTTY 

There are some RTTY contests that specify 75 baud (100 wpm) RTTY instead of the 
usual 45.45 baud (60 wpm) speed. MMTTY can be used for 75 baud RTTY, but there 
are a few quirks:  

 If you use EXTFSK for FSK keying (e.g. via a standard USB-to-serial adapter), 
you will not be able to use this combination for 75 baud. EXTFSK does not 
support 75 baud. Instead, you must reconfigure for AFSK  

 If your CPU is capable of running EXTFSK64, it can be used in place of 
EXTFSK. EXTFSK64 supports 75 baud; see 
http://www.qsl.net/ja7ude/extfsk/indexe.html  for information on EXTFSK64  

 In the MMTTY Setup window, select the Decode tab, and at the top of the 
window, for BaudRate select 75  

 If you are using MMTTY version 1.68 or newer, in the MMTTY Setup window 
under the Demodulator tab, in the section labelled HAM Default, UNcheck the 
"Fixes 45.45 baud" check box  

 If you are using an older version of MMTTY, you will need to be aware of the 
following:  

o The pre-version 1.68 MMTTY HAM Default button cannot be used in 75 
baud RTTY; if you press HAM, the speed will be reset to 45.45 baud. 
Besides not pressing the HAM button in the MMTTY window, there are a 
couple of other setup items you need to take care of:  

 In the DI Setup window, under the General/MMTTY Setup tab, 
make sure the following item is NOT checked:  

 (MMTTY)Send HamDefault on Run to S&P Change (if you 
forget to uncheck this item, you will be switched back to 
45.45 baud every time you switch from Run to S&P)  

 If you are using FSK with a true serial port or with an interface that 
supports FSK without using EXTFSK (e.g. a microHAM 
microKeyer), turn AFC off in the MMTTY window, and make sure 
the following item in the DI Setup window is NOT checked:  

 (MMTTY - MMVARI)Turn AFC On/Off on Run Change (if 
you forget to uncheck this item, AFC will pull your receive 

http://www.qsl.net/ja7ude/extfsk/indexe.html


frequency off your transmit frequency and you will be unable 
to use the HAM button to correct the situation)  

 In the DI Window's Setup menu, UNcheck AFC On/Off with 
CQ (same reason)  

 If you are using AFSK and like to use AFC, you may continue to do 
so, provided you are careful to ensure that your transmit and 
receive frequencies stay together. The HAM button is not available 
to re-align your transmit and receive frequencies. Therefore if you 
are using AFC, you should have NET on as well, to keep your 
transmit and receive frequencies together. (Note: NET does not 
work in FSK)  

 After the 75 baud contest is over, be sure to restore the 45.45 baud speed and 
any of the other configuration options you changed for 75 baud, in order to 
restore normal functioning  

 

2.7.5 MMVARI for PSK and Other Modes 

 2.7.5 MMVARI for PSK and Other Modes  

o 1. The MMVARI Interface  

 1.1. The MMVARI Interface Window  
 1.2. The Waterfall or Spectrum Window  

o 2. Setting Up the Digital Interface  
o 3. MMVARI Example  

1. The MMVARI Interface 

The MMVARI soundcard interface is based on the MMVARI engine by Makoto Mori, 
JE3HHT.  

All modes from the MMVARI engine are supported including bpsk (e.g. PSK31 and 
PSK63), qpsk-L (LSB), qpsk-U (USB - e.g. QPSK63), also RTTY-L (LSB), RTTY-U 
(USB), MFSK-L (LSB) and MFSK-U (USB) as well as non-standard modes GMSK (HF), 
FSK (V/UHF), FSK-W (V/UHF, satellite). The -L and -U variants of some of these 
modes are there to allow you to choose which sideband you use on the radio. In other 
words, you are not restricted to using LSB for RTTY and USB for other digital modes; 
you can choose to use either USB or LSB on the radio, and if you have chosen the 
correct mode variant in MMVARI, it will adjust the audio tones it uses to correspond to 
the sideband you have chosen.  

 RTTY 

MMVARI is capable of using FSK keying for RTTY (selected from the Configurer under 
the Digital Modes tab, using a specialized version of EXTFSK). Note that the "FSK" 
mode in the MMVARI mode box is an entirely different mode - it is NOT FSK RTTY. 



 
The MMVARI engine does not have to be installed separately, it is included in the 
N1MM Logger+ program program/update files and is the default digital engine when 
loading the digital window for the first time.  

1.1. The MMVARI Interface Window 

 

 

The Digital Interface window when using the MMVARI engine is sub-divided into several 
areas which will be covered from the top down.  

 TX - Indicator to show which DI window the transmit is going to take place from 
(useful when using two DI windows for SO2R/SO2V)  

 Letters/Figs - Shows the text under the mouse in the other case (FIGS/LTRS - 
RTTY only)  

 MouseOver - Shows the text which would be selected where the mouse is 
positioned over  

 Receive Windows - The MMVARI engine supports from 1 to 4 receive windows. 
The number of receive windows is selected from the DI window's Setup > 
Settings menu item in the Digital Settings window under the MMVARI Setup tab 



(# of MMVARI Channels). All of these windows operate in the same manner and 
you are able to grab callsigns from any of them and place them into the Entry 
window. Note that when the # of MMVARI Channels is set to 1, a different 
method of multiple RX channels becomes available (see The Waterfall or 
Spectrum Window below)  

 
There is a narrow green pane on the left side of each receive window. By clicking on the 
green pane you can pause input to the receive window to scroll back through the (last 
2000 lines of) text using the scroll bars. When the window is paused the color of the 
pane will turn yellow. To turn input to the window back on click in the pane again and 
everything that was to be printed to the window will now enter the window. When the 
receive window is paused it is possible to copy text in the window.  

If you click on a callsign using your mouse it will be put into the callsign field in the Entry 
window.  
Also, whenever a callsign is printed to any of the receive windows followed by a space it 
will be sent to the callsign grab window for easy movement to the logging window by 
clicking the Grab button.  

You can select any exchange info by single clicking on the sent info. This info will be 
transfered over to the logger Entry window item by item after the callsign is filled in.  

The top receive pane is the window used for making QSOs. Selecting another 
frequency for this window is done by left clicking in the Waterfall or Spectrum window. 
Changing the frequency of the other three receive windows is done by moving the 
numbered marker above the waterfall to the desired location. You can also use the 
Swap buttons in the lower part of the Waterfall window to exchange the selected 
window with the top receive window.  

 Transmit window - This is a free form typing window. If you click on the TX 
button the cursor will be placed into this window and whatever is typed will be 
sent. The size of this window is fixed at 2 lines  

 Callsign Textbox and Grab - When a callsign is encountered in one of the 
receive windows (followed by a space) it will be placed in this textbox and when 
you press the Grab button it will transfer the callsign over to the main logger 
window. The grab callsign window holds the last 10 callsigns seen in the RX 
window. The most current one is at the top and is highlighted. A right click in this 
box brings up a menu to clear list or selected callsign. Dupe callsigns will not be 
shown in the grab window  

 
Note: If the callsign in the callsign field in the Entry window is the same as the callsign in 
the received text, the call in the Entry window does not get placed into the call list.  

 Clr RX - Clear all receive windows  



 TX - Places the interface into transmit, the transceiver is keyed, and places the 
cursor into the TX window for input. See the Radio Interfacing section for Parallel 
and Serial port info on configuring for hardware PTT  

 RX - This will place the interface back into receive mode after all the characters 
in the transmit buffer have been sent. To abort transmit immediately without 
waiting for remaining characters to be sent, press the Esc key  

 Message buttons - These buttons on the Digital Interface are up to 24 extra 
preprogrammed messages. Configuring these macros is done in the Digital 
Interface window under 'Setup, Settings' (Message Setup tab), or by right clicking 
on one of the buttons, which brings up the Digital Setup window. The button 
widths dynamically adjust in relation to the width of the DI window. If the caption 
for a button is too long to fit on the button, the button will appear blank; you can 
cause the caption to appear by making the window wider, or you can edit the 
caption to make it shorter so it will fit  

 Grab - Transfer the selected callsign in the callsign text box to the callsign field 
on the main logger window. The cursor advances to the exchange box ready to 
accept the exchange when you click on it  

 CLR - Clears the grab window  

1.2. The Waterfall or Spectrum Window 

 

The MMVARI digital engine window - This window uses the MMVARI control from 
Makoto Mori, JE3HHT. Across the top the title bar shows either the offset frequency 
(radio (+/-) audio) or the radio's dial frequency, depending on a setup option. As you 
tune your radio this will update and the numbers will change.  

The screen shot here shows the window with four receive channels selected in the 
Digital Setup. There are cursors corresponding to each of the receive windows. The 
inverted triangle cursor, filled in in light blue, is for the main receive window. If NET is 
on, this is also your transmit frequency. If NET is off, there will be another inverted 
triangle filled in in dark blue indicating your transmit frequency. If you have more than 



one receive window enabled, a cursor with a number in it (1, 2, ...) corresponds to each 
additional receive window. To change frequency for the main receive window you can 
place your mouse pointer over a signal trace and click with your left mouse button. To 
change frequency for one of the other receive windows, you can click on the numbered 
cursor and drag it to the desired location in the waterfall.  

 TX Frequency and NET in FSK RTTY 

Note that if you are using FSK keying in RTTY, MMVARI has no control over your 
transmit frequency. Your transmit frequency in FSK RTTY is fixed by the radio. 
Therefore, moving the dark blue transmit indicator does not change your actual transmit 
frequency in FSK RTTY. Likewise, the NET function is inoperative in FSK RTTY. 

 Buttons above the waterfall  
o TX - Start the transmission, the transceiver is keyed and places the cursor 

into the TX window for input. See the Radio Interfacing section for Parallel 
and Serial port info for TX/RX switching (PTT)  

o RX - Stops the transmission, the transceiver changes back to receive after 
all the characters in the transmit buffer have been sent. To abort 
immediately, press the Esc key  

o AFC - Turns AFC on or off. Selected (white) means AFC on (Note: This 
button is greyed out and disabled when the Multi-Channel RX browser 
feature is enabled)  

o NET - Turns NET on or off. Selected (white) means NET on. When NET is 
on the TX frequency follows the RX frequency (this function is inoperative 
in FSK RTTY)  

o Align - This is used to move the signal under the receive indicator to the 
Alignment Frequency set up in the Digital Setup window. This can be used 
in most sound card modes to center the received signal in your filter 
bandpass, and in FSK RTTY it is used to align the received signal with 
your transmitter's signal  

 
Example: Suppose the center of the filter pass band is 2200 Hz. When clicking on a 
signal at about 1400 Hz the signal may be difficult to copy unless you are using wide 
filters. To move the signal to the center of your filter bandpass, click Align and the rig 
shifts and the spectrum frequency shifts and places the station on the frequency that 
was initialized in the Digital Setup window in the Alignment Frequency area. This allows 
you to narrow your filter bandwidth around the selected signal. If you are using FSK 
keying for RTTY and if your receive frequency is not exactly on the center frequency of 
your radio's mark/space tone pair (e.g. 2210 Hz for the standard 2125/2295 "high" tone 
pair), then you can use the Align button to retune your radio so your receive and 
transmit frequencies will be aligned correctly.  

o Mode selection - Select the mode to use by clicking on this button. The 
Speed selections are mode dependent. Selections are:  

 GMSK - MBCS experiment (HF) - Possible speed selections: 
31.25, 62.5, 125, 250  



 not used for contests  
 FSK - MBCS experiment (V/UHF) - Possible speed selections: 

31.25, 62.5, 125, 250  
 not used for contests  
 Do not confuse this mode with FSK RTTY - MMVARI's 

"FSK" mode is not FSK RTTY. MMVARI in N1MM Logger+ 
does support FSK RTTY, but this can only be selected from 
the Configurer, not from the MMVARI window  

 FSK-W - MBCS experiment (V/UHF, satellite) - Possible speed 
selections: 31.25, 62.5, 125, 250  

 not used for contests  
 BPSK - MBCS experiment (HF) - Possible speed selections: 31.25, 

62.5, 125, 250  
 for contesting purposes, BPSK and bpsk are equivalent  

 bpsk - Standard BPSK (e.g. PSK31) - Possible speed selections: 
31.25, 62.5, 125, 250  

 rtty-L - BAUDOT RTTY (LSB) - Possible speed selections: 45.45, 
50, 56, 75, 100, 110, 150, 200  

 rtty-U - BAUDOT RTTY (USB) - Possible speed selections: 45.45, 
50, 56, 75, 100, 110, 150, 200  

 You may choose either AFSK or FSK keying method for 
RTTY in the Configurer under the Digital Modes tab  

 mfsk-L - MFSK (LSB) - Possible speed selections: 15.625, 31.25  
 mfsk-U - MFSK (USB) - Possible speed selections: 15.625, 31.25  
 qpsk-L - QPSK (LSB) - Possible speed selections: 31.25, 62.5, 

125, 250  
 qpsk-U - QPSK (USB) (e.g. QPSK63)- Possible speed selections: 

31.25, 62.5, 125, 250  
o Speed selection - Select the speed to use in bps by clicking on this 

button. The speed to select is mode dependent as described above  
o Main Channel receive frequency - audio frequency  

 In RTTY, MMVARI displays the center frequency, not the mark 
frequency as displayed in MMTTY  

o Main Channel transmit frequency - audio frequency  
o Main Channel S/N reading  

 The Waterfall or Spectrum Display  
o At the top of the waterfall offset frequency (radio (+/-) audio) labels and 

tick marks are displayed  
o Receive channel markers  

 Top markers (tag cursors)  
 1,2,... - frequency receive channel 1,2,...  
 N - indicates a notch filter  

 The light blue colored marker (inverted triangle on the waterfall) 
indicates the main RX frequency  



 The dark blue colored marker (waterfall) indicates the TX frequency 
if it is different from the main RX frequency (only possible if NET is 
off)  

 Mouse key clicking  
o Left mouse key clicking - single clicking in the waterfall will change the 

main RX frequency  
o Right mouse key clicking - the audio frequency at the point clicked on 

will be shown. Also a menu will show:  
 Set notch on here - adds a new notch filter on the selected 

frequency indicated by a N in a yellow area. Multiple notches can 
be set; you can clear an individual notch by right-clicking on the N  

 Delete all notches - all set notches will be removed  
 Set TX Carrier on here - can be used to set the TX frequency (with 

NET off)  
 Turn Off Bandpass Filter - Turns the BPF off  
 RX 1 (2,3) Freq Here - can be used to set the RX 1, 2, or 3 

frequency here (only if the # of MMVARI Channels is greater than 
1)  

 
The left vertical indicator shows the signal level meter (green) and the squelch level 
(yellow line). Biy clicking on it the squelch level can be changed.  

 Receive channels below the waterfall  
o If you have chosen to use more than one MMVARI channel, below the 

waterfall the additional receive channels will be shown. The number of 
additional channels below the main waterfall is one less than the total 
number of MMVARI Channels set, i.e. there can be up to three additional 
channels (up to four MMVARI channels in total - to display more than four 
channels, see the Multi-Channel RX feature below)  

o Mode - Select the mode to use for this receive channel  
o Speed - Select the speed to use for this receive channel  
o Receive channel frequency  
o Receive channel S/N value  
o AFC - Turns AFC on or off for the selected channel. Selected (white) 

means AFC on  
o Squelch indicator - The squelch can be adjusted by dragging the line 

indicator to where you want it and turning off the squelch by dragging it all 
the way left  

o Miniature waterfall display - shows within 500 hz of the signal that that 
channel is on. You can click anyplace in this miniature waterfall or drag 
the indicator to where you want it  

o Swap - Exchanges this receive window with the main receive window. 
While working one station, you can dial the second station in via a second 
receive window and after you finish the first contact just hit swap button 



and then call the other station. See below for an alternative method of 
multi-channel receive  

 Menu at the Top  
o BPF - Used to enable/disable an internal audio Band Pass Filter. The BPF 

filter has steep skirts and 80db of rejection outside the bandpass. 
However, because it is in the sound card and not in the radio, it has no 
effect on unwanted signals inside the radio, i.e. a strong unwanted signal 
inside the radio's IF filter bandpass can still trigger the radio's AGC and 
cause gain blocking, even though the signal has been rejected in the 
sound card by the BPF. You can only prevent this by selecting narrow 
filters in your radio  

 Enable/Disable BPF - turns BPF on or off  
 Wide 1000 Hz, Middle 500 Hz, Narrow 250 Hz, Ultra Narrow 100 

Hz, Custom - filter bandwidth settings (grayed out when the BPF is 
disabled)  

 To set Custom width after enabling the BPF, left click in the 
waterfall where you want the BPF bandpass to start. Drag 
your mouse with the left button held down and release it 
where you want the BPF bandpass to end. The waterfall 
display will immediately relect the chosen Bandpass. This 
makes it simple to eliminate an offending station on the fly  

 The minimum width of the BPF that can be set is 100 Hz  
 The BPF can be turned off by selecting Disable BPF on the BPF 

menu or by right-clicking in the waterfall and selecting Turn off 
bandpass filter  

 The BPF settings are retained when you close and reopen the 
digital engine window  

o ATC - Used to turn Automatic Timing Control (ATC) on or off. It is 
recommended to keep ATC on all the time for better signal decoding  

 when RTTY is selected ATC is always off  
 in MFSK mode ATC is always on  

o FFT - FFT is Fast Fourier Transform, which is a method of extracting the 
spectrum out of a waveform. That is the basic tool that gives the waterfall 
and spectrum scope displays  

 FFT Type - Select the FFT display method. Selections are: 
Spectrum, Waterfall, Sync or Wave Input  

 FFT Width - Select the display width (frequency range). Selections 
are: 250 Hz, 500 Hz, 1000 Hz, 2000 Hz, 3000 Hz or User Defined. 
User Defined width is set in the Digital Setup window  

 FFT Scale - Select the vertical scale to use. Selections are: 100 
dB, 60 dB, Square Amplitude  

 Waterfall AGC - Turn the waterfall AGC on or off  
 Align after Left Click - Automates the Align process. Any time a 

signal is clicked on in the waterfall, an automatic Align operation is 



performed to re-center the audio frequency on the Alignment 
Frequency you have selected in the Digital Setup window  

o SHIFT - Shift selections. The choices are 170 Hz, 200 Hz, 23 Hz or User 
Defined  

 Only in RTTY-L, RTTY-U and GMSK  
o RTTY Demodulator - select either IIR or FFT decoder. Depending on 

conditions, one may decode better than the other  
 Only in RTTY-L and RTTY-U  

 

 

o Multi-Channel Rx - This feature is only available when the # of 
MMVARI Channels in the Digital Setup window under the MMVARI 
Setup tab is set to 1. It is an alternative method of receiving multiple 
signals simultaneously with MMVARI  

 Enable Multi Channel Browser - turns this feature on  
 When the Multi-Channel RX feature is turned on, there will 

be several numbered tag cursors at the top of the waterfall, 
and a separate browser window will open (see below). The 
number of channels is user-selectable (from 2 to 24)  

 Each line in the browser window shows text decoded under 
the corresponding numbered cursor  

 There is only one RX pane in the Digital Interface window, 
which displays text from the main RX signal under the light 
blue inverted triangle cursor  

 You can move the main RX cursor to the position of any of 
the numbered tag cursors simply by clicking in the 
corresponding small text window  

 You can use this feature to keep track of several separate 
signals being received. You can work each one in turn by 



clicking in the corresponding numbered text window to move 
the main RX/TX frequency (with NET on) to each numbered 
cursor position in turn (if NET is off, or you are using FSK 
RTTY, clicking in the text window only moves the RX 
frequency but not the TX frequency)  

 Open/Close Multi Channel Brower - turns the feature on or off 
(only visible after it has been enabled)  

 Set Number of RX Channels - you can select from 2 to 24 
channels to display in the browser window  

 Set AFC Search Level - Used to set the signal level (S/N ratio) 
used to determine whether a signal is strong enough to activate the 
AFC and cause the RX frequency to move to it (can be set from 1 
to 20 dB)  

 Set AFC Search Range - Each extra RX channel has AFC 
(automatic frequency control) which moves the cursor to keep it 
centered on a signal if the frequency changes slightly. This menu 
item is used to set the frequency range over which this feature 
operates (can be set from 100 to 500 Hz)  

 Set Spectrum Search Frequencies - Allows you to set the lower 
and upper limits for the browser channels. The lower limit can be 
250 Hz or higher, and the upper limit can be 2700 Hz or lower  

 Turn Channel Markers On - If unchecked, channel markers will 
not be displayed  

 Show Audio Frequency Only - if checked, audio frequencies will 
be displayed instead of RF frequencies  

 
The Multi-Channel RX method allows you to keep track of more channels (max 24) than 
the older # of MMVARI Channels method (max 4) that you set up from the Digital Setup 
window. The memory for each channel is limited to 80 characters. You can click on 
callsigns in the callsign column of the browser window in order to transfer them to the 
Entry window, or in Dxpedition mode (see below), you can click on a callsign in the 
browser window in either the decoded stream or the callsign column to: move the RX 
cursor (and if NET is on, the TX cursor) to that channel, transfer the callsign to the Entry 
window, and transfer the last 80 characters decoded in that channel into the main RX 
window. All channels in the browser in this method will be in the same mode. In RTTY, 
clicking on the channel marker for a channel switches between normal and reverse 
decoding in that channel. (For another way to do multiple receive in PSK only, you can 
also try the PSK Browser in Fldigi). 
 
 
 



 
 
Browser window in multi-channel RX  

 Setup menu  
o Set On Top - check this if you want to ensure that the browser window is 

always on top of other windows  
o Set AFC Width - set the frequency range for AFC in each browser 

channel  
o Set AFC Level - set the signal level that activates AFC  
o Set Squelch Level - set the squelch level in the browser  
o Set Channel Background Color - set the background color for the text in 

the browser window  
o Set Channel Text Color - set the color for text in the browser window  
o Set Channel Highlight Color - set the color for the highlighted channel  
o Dxpedition mode - turns Dxpedition mode on or off  

 With Dxpedition mode off, clicking on a channel in the browser 
moves the main RX cursor to the frequency of that channel. If NET 
is on, the TX cursor also moves to the same frequency  

 With Dxpedition mode on and NET off, clicking on a callsign in 
either the text stream or the callsign box in a browser channel:  



 Moves the main RX cursor to the frequency of that channel, 
leaving the TX cursor where it was  

 Transfers the last 80 characters from that channel into the 
main RX window  

 Transfers the callsign into the Entry window  
 Can be used in a Dxpedition situation where your TX 

frequency is fixed and you want to work stations anywhere in 
your receive range  

 With Dxpedition mode on and NET on (this is not possible in FSK 
RTTY), clicking on a callsign in either the text stream or the callsign 
box in a browser channel:  

 Moves the main RX and TX cursors to the frequency of that 
channel  

 Transfers the last 80 characters from that channel into the 
main RX window  

 Transfers the callsign into the Entry window  
 Can be used for normal S&P operating. After switching to 

the frequency of the selected channel, you can click on the 
Align button to center that channel in your receiver's filter 
bandpass  

 Clear menu - clears the browser window  

2. Setting Up the Digital Interface 

The setup dialog is for both MMTTY and MMVARI, this means that some settings are 
only for MMVARI, MMTTY or both. When selecting 'Setup | Settings' in the Digital 
Interface window a dialog wil be shown which is both for MMTTY and MMVARI. Please 
check the setup information in the Digital Setupchapter.  

3. MMVARI Example 

 Select 'Window > Digital Interface' in the Entry window to open the Digital 
Interface and the Waterfall/Spectrum window. The Digital Interface dialog can be 
positioned and resized on your monitor as desired  

 Left clicking on a call will grab the callsign. Right clicking on the RX and TX 
window will pop a menu (S&P mode) or send the Exchange function key in 
Running mode, depending on your choice for te Rt. Click option in the DI 
Window's menu  

 Pressing Insert will Grab the highlighted call and sends His call followed by the 
Exchange button  

 Double clicking on a callsign in the callsign box from the Digital Interface sends 
that call to the Entry window  

 A callsign is automatically highlighted if recognized by the program. For that to 
happen it needs to have a space before and a space after the callsign  

 

http://n1mmplus.hamdocs.com/tiki-index.php?page=Digital+Setup#N1MM_Logger_Manual


 

2.7.6 Digital - Fldigi for Sound Card Modes 

 2.7.6 Digital - Fldigi for Sound Card Modes  

o 1. The Fldigi interface  
o 2. Download and Configure Fldigi  

 2.1. Download Fldigi  
 2.2. Fldigi Initial Configuration  

o 3. The Fldigi Interface Window  

1. The Fldigi interface 

The Fldigi sound card interface is based on the fldigi code by Dave Freese, W1HKJ.  

Fldigi supports a wide variety of digital modes, including not only AFSK RTTY and PSK, 
but also other less common modes such as MFSK, MT63, Olivia, Throb, etc.  

Fldigi is a stand alone application, so you can also use it separately from N1MM Logger. 
Note that the configurations for Fldigi stand-alone and within the Logger are separate, 
i.e. changes made to the stand-alone configuration will not be applied to the 
configuration within the Logger, and vice versa.  

Fldigi does not support keying outputs on serial or parallel ports, as used by N1MM 
Logger for CW and FSK keying. Fldigi can be used from the Logger for AFSK RTTY or 
for PSK31 or other digital modes, but not for transmitting RTTY using FSK unless you 
use an external hardware circuit to convert audio output from Fldigi to an on-off keying 
signal for FSK. It can also be used as a CW receive-only decoder, but not for 
transmitting CW. For transmitting CW, use one of the CW interfacing methods detailed 
in the "Basic Interfacing - Radio, CW, PTT" chapter. You must not check the Digital 
check box on a port that will be used for CW keying while the DI window or the CW 
Reader window is open.  

2. Download and Configure Fldigi 

2.1. Download Fldigi 

 Download the current release of fldigi from the W1HKJ website at 
http://www.w1hkj.com/  . You can find a copy of the full installer for the current 
version of fldigi at that website. This file is a self-extracting executable, similar to 
the N1MM Logger installer. Download the installer file to a temporary folder and 
then execute it. It is recommended that you install fldigi in its own program folder 
and not in the N1MM Logger+ program folder. By default, the installer will install 
fldigi to C:\Program Files\Fldigi-x.xx.xx\, where x.xx.xx is the fldigi version 
number. If you are using Windows Vista, 7 or 8, and you want to run fldigi from 
inside N1MM Logger+, you must use a copy of fldigi.exe that is installed in its 
own folder outside the Program Files (or Program Files(x86)) folder. You can, for 
example, create a folder for fldigi inside your N1MM Logger+ user files area, then 

http://www.w1hkj.com/


make a copy of fldigi.exe from the original installation location and copy it into the 
new folder.  

2.2. Fldigi Initial Configuration 

After fldigi has been downloaded and installed, open the Configurer and set up the path 
to fldigi.exe under the Digital Modes tab. After closing the Configurer, choose a contest 
in N1MM Logger that supports digital modes, select the Logger's Window > Digital 
Interface menu item, and then in the Digital Interface window, select the Interface > 
Fldigi menu item.  

When you first open the fldigi interface from the Logger, and also any time you install 
fldigi into a different location, such as separate locations for the two digital interface 
windows or for the DI window and the CW Reader window, you will be prompted to fill in 
some configuration information by the fldigi configuration wizard, as follows:  

 Operator information - You do not need to fill in any of this information; N1MM 
Logger+ handles logging and all related information  

 Audio devices - Under the Devices tab, check the PortAudio box and select 
the sound card input and output you are using for Capture and Playback. Click 
Next  

 Transceiver control - Select the XML-RPC tab, check the Use XML-RPC 
Program box, and click the Initialize button. Do NOT select RigCAT, Hamlib, or 
MemMap for rig control; none of those will work with N1MM Logger+  

 You can let N1MM Logger handle PTT, in which case you do not need to 
configure PTT in fldigi. However, if you do not use PTT in other modes and you 
want to use hardware PTT controlled by the digital interface (e.g. fldigi), you can 
select the Hardware PTT tab, check the Use separate serial port PTT 
checkbox, select the appropriate COM port in the Device: window, and check 
either Use RTS or Use DTR, depending on which one your hardware setup uses. 
If the label on the Initialize button is red, click on the button. Note that a COM 
port that is used by fldigi cannot be used simultaneously by the Logger for other 
purposes. If you are time-sharing a serial port between fldigi in digital modes (not 
including CW) and the Logger in CW or SSB, check the Digital check box beside 
the COM port in the Configurer to ensure that the Logger will not try to use this 
port while the Digital Interface is open  

o If you intend to use fldigi as a receive-only CW decoder, be aware that you 
cannot use fldigi to transmit CW. Also, you cannot control PTT from fldigi 
on the same port that N1MM Logger+ uses for CW keying; do not check 
the Digital check box beside this port, and do not configure it within fldigi 
as a PTT port  

 Click Finish  

 
The fldigi configuration wizard does not automatically save its settings. After you have 
exited the configuration wizard and the main fldigi interface window has opened, you 
must save the configuration settings using the fldigi Configure > Save Config menu 



item. If you don't do this, then every time you open the fldigi window you will have to go 
through the configuration wizard steps again. Similarly, any time you make a 
subsequent change to the fldigi configuration you must explicitly save the new 
configuration if you want the change to be remembered.  

Newer versions of fldigi may default to requiring confirmation from the user before you 
shut them down. If that shutdown is initiated by shutting down N1MM Logger+, instead 
of by shutting down the DI windows and engines first, this can result in fldigi continuing 
to run after the Logger has shut down. This will cause problems the next time you start 
up the Logger. To prevent this from happening, you need to make a change in the fldigi 
configuration file. In each folder that fldigi is run from, find the file called fldigi_def.xml. 
(Note: this file is created the first time fldigi is run from this location, i.e. it will not exist 
until after you have run that copy of fldigi at least once). Right-click on the file name, 
select Open with... and then select Notepad or Wordpad as the program to open the file 
with. Look for a line that reads <CONFIRMEXIT>0</CONFIRMEXIT> or 
<CONFIRMEXIT>1</CONFIRMEXIT>. If you see a 1 between the two keywords, 
change it to a 0 and save the file. Repeat this for every copy of fldigi you use from within 
N1MM Logger+ (DI1, DI2, CW Reader 1 and/or CW Reader 2).  

3. The Fldigi Interface Window 

 

 Menu  
o File  

 Exit - closes the Fldigi window  
o Op Mode  

 CW - This configures Fldigi to decode CW (receive-only)  
 PSK - select BPSK-31 for normal PSK31, BPSK-63 for PSK63, etc.  
 RTTY - select RTTY-45 for normal 45 baud AFSK RTTY  
 Other selections can be used for other modes - see the fldigi help 

for details  
o Configure  

 Waterfall - under the Display tab, you can select whether to show 
audio or RF frequencies in the scale at the top of the waterfall, and 
whether to display transmitted as well as received signals  



 Rig control - XML-RPC should have been selected during the 
initial configuration. You can use the Hardware PTT tab to change 
the PTT settings for a separate hardware PTT port  

 Sound card - you can select the sound card to be used by Fldigi 
under the Devices tab  

 Modems - this is where you make configuration changes that apply 
to specific modes only (e.g. PSK-specific changes, or RTTY-
specific changes)  

 Save Config - use this to save the new configuration any time you 
make changes  

o View  
 PSK Browser - opens a browser window that can display up to 30 

signals within the waterfall simultaneously (PSK only). To configure 
this browser window, use Fldigi's Configure > Modems > PSK > 
Viewer configuration window to set the number of channels, the 
starting (lowest) audio frequency (channel separation is 100 Hz), 
and various other parameters  

 
Most Fldigi menu items not mentioned above are either not used by N1MM Logger, or 
perform advanced functions that are not needed for basic operation. See the fldigi help 
at the W1HKJ web site for more details (there is a link to the Fldigi-Help page from the 
download page at  
http://www.w1hkj.com/download.html ).  

Note also that when the Fldigi engine is selected, additional buttons appear in the 
Logger's Digital Interface window:  

 Align - for retuning the radio so that the desired signal is aligned on a pre-
configured frequency  

 Lock - to lock the transmit frequency at the present position in the waterfall while 
allowing the receive frequency to vary (for operating split)  

 Rev - in sideband-sensitive modes like RTTY, reverses the tones  
o Unlike the other digital engines used in the Logger, Fldigi assumes the rig 

will be in USB for RTTY. If you are using LSB, you will need to use the 
Rev button to tell Fldigi to reverse the tones. If you have tuned in a signal 
but all you see in the receive text window is garble, try clicking the Rev 
button once or in some cases, twice (sometimes you may find it necessary 
to toggle the Rev state off and back on to get it to "take")  

 
Note that older versions of Fldigi only use the left channel on input; for that reason, in 
most SO2V installations these older versions of Fldigi can only be used from Entry 
Window 1. Starting with Fldigi version 3.22.06, Fldigi is now capable of using either 
sound card channel for input. In any copy of Fldigi that you want to use with the right 
channel of the sound card, use the Configure > Sound Card menu item in the Fldigi 
window to open the Fldigi configuration window. Select the Right channel tab, and near 

http://www.w1hkj.com/download.html


the bottom under Receive Usage, check the Reverse Left/Right channels check box to 
switch Fldigi to use the right channel on RX. Click on Save to save the configuration 
change, and then close the configuration window.  

 

 

2.7.7 Digital - External TNC Support 

 2.7.7 Digital - External TNC Support  

o 1. The Digital Interface  
o 2. Setting Up the TNC in the Configurer  
o 3. Test Your External TNC  
o 4. Additional Macros for the External TNC Interface  
o 5. HAL DXP38 Setup  

 5.1. Hardware Setup  
 5.2. Software Setup in N1MM Logger  
 5.3. Configuring a DXP-38 in one of the additional RX windows  

o 6. HAL ST-8000 Setup (not supported)  
o 7. KAM Setup  
o 8. PK-232 Setup  

 8.1. Setting up the PK-232  

o 9. SCS PTC Setup  

The Digital Interface will not only work with MMTTY, MMVARI and external TNC's like 
the PK232, HAL DXP38 but with ANY TNC.  
This is because (with the special-case exception of the HL DXP-38) the commands for 
the TNC are not hard coded into the program. This has to be done by the user of the 

program  

Information about the following external TNCs can be found below but as already stated 
ANY TNC that uses serial communication can be used with N1MM Logger.  

1. The Digital Interface 

The Digital Interface can be used with any external TNC.  



 

Using a TNC will show an interface like the one above.  

2. Setting Up the TNC in the Configurer 

1. Start the N1MM Logger application  
2. On the Logger Main Window select >Config >Configure Ports, Telnet Address, 

Other >Digital Modes tab  
3. In Digital Setup  

1. Choose Other for Interface (for any TNC except for the HAL DXP-38; for 
the DXP-38, see separate instructions below)  

2. Set other parameters accordingly (Example settings: Com 4 ,9600 ,8 ,N 
,1, RST-Xon)  

3. Save the configuration < OK >  
4. Load the Digital Interface from the Window menu  
5. Program the RX, TX and Abort macros by opening the Digital Setup window 

(Setup > Settings menu item in the DI window), selecting the Macro Setup tab, 
selecting the "Other" digital macro set, and then right-clicking on each of the TX, 
RX and Esc buttons at the right side of the window and programming them with 
the appropriate codes to put your TNC into transmit, to put it into receive at the 
end of a message, and to abort a message, respectively. Once you have done 
this, the {TX} and {RX} macros will work in function-key messages and the other 
DI button messages, and the Esc key can be used at any time to abort a 
transmission.  

 
Make sure your interface is set to copy RTTY at 45 baud and 170 Hz shift. If necessary, 
you can type the TNC command(s) for this in the transmit window so it will be sent to 
the TNC, or (better) you can program it into one of the DI message buttons.  



 

3. Test Your External TNC 

 Test stand-alone  
 See the separate sections for the PK-232, KAM, HAL etc. If your TNC is not 

mentioned please set it up like the other mentioned TNC's  

 
Make sure your radio and TNC work on your computer's serial port by testing them with 
an existing terminal program. Connect your TNC/Radio into your computers serial port. 
The Hyperterm terminal program is included with Windows and works well. Make sure 
you note all COM port parameters. You should be able to tune in a RTTY signal and 
print it using the Hyperterm program. The Windows Hyperterm is geared toward modem 
communications and is not especially intuitive for direct COM port use. As stated 
previously, you can use any number of terminal emulator programs. For example, the 
Tera Term Pro 3.1.3 by Ayera Technologies is a small, open source, free terminal 
emulator that is available for download.  

The interface has been tested with the three mentioned TNC's below and works fine 
with them. Any other TNC should also work as long as you place the right commands 
for that TNC in the macros.  

4. Additional Macros for the External TNC Interface 

The Digital Interface will accept all of the Macro keywords that can be used in the 
Packet window and other places in the Logger and will also accept the following:  

Ctrl+A Ctrl+B Ctrl+C Ctrl+D Ctrl+E Ctrl+F Ctrl+G  

Ctrl+H Ctrl+I Ctrl+J Ctrl+K Ctrl+L Ctrl+M Ctrl+N  

Ctrl+O Ctrl+P Ctrl+Q Ctrl+R Ctrl+S Ctrl+T Ctrl+U  

Ctrl+V Ctrl+W Ctrl+X Ctrl+Y Ctrl+Z Esc  Enter 

 
These macro keywords can be used in any of the DI message buttons or the Logger 
function keys in the Entry window.  

The TX window will accept all control key commands except for the Esc key, which 
must be sent as a Shift+Escape combination.  

Remember that when setting up a message key that is not a TNC command you will 
need to include the {TX} macro (or the equivalent TNC command) to key the TNC 
before it sends. If a message does not start with the {TX} macro, your TNC will think it is 
a command being sent to it instead of message text, and it will not know how to process 
it. Before using the {TX} and {RX} macros in messages, you need to initialize them with 
the correct commands for your TNC, by opening the Digital Setup window, selecting the 
Macro Setup tab, selecting the "Other" Digital Macro Set, and then programming the 
TX, RX and Esc buttons with the correct command sequences for your TNC.  



To use free form typing in the TX window you need to first key your TNC (e.g. using the 
TX button after it has been programmed correctly for your TNC). Click the TX button to 
start transmitting and then click in the TX window. Whatever you type in the TX window 
now will be sent out. After you have finished typing, click on the RX button to return to 
receive mode.  

5. HAL DXP38 Setup 

 
The HAL DXP-38 is supported as one of the possible interfaces. Setup for the DXP-38 
is different from setup for other TNCs.  

There is a selection for the DXP-38 interface type in the Configurer under the Digital 
Modes tab, TU type.  

5.1. Hardware Setup 

It is a good idea to get the DXP38 running with WF1B, HAL or another known software 
package before trying to set it up for the first time in N1MM Logger. Doing this 
eliminates the need to troubleshoot both hardware and software simultaneously when 
configuring N1MM Logger. Hardware setup:  

1. Connect the PTT and FSK lines to the rig  
2. Connect the COM port (1 for HAL software) to the TNC  
3. Connect audio input to the DXP-38  
4. Connect the power  
5. Connect AFSK output to the rig (AFSK only)  
6. Consult the DXP-38 manuals for the details. The rig must be setto FSK RTTY 

(LSB) or LSB for AFSK  

5.2. Software Setup in N1MM Logger 

Port configuration - The COM port used for the DXP38 port should have a check mark 
in the Digital check box in the Configurer.  



 

Under the port settings (Set button), DTR/RTS should be set to Always On. Set the 
DigWNdNr to the digital window number that the DXP38 will be used with (1 or 2, for DI 
window #1 or #2).  



 

Digital configuration - In the Configurer under the Digital Modes tab, in the left side for 
the digital interface window that the DXP38 will be used with (Digital Interface 1 or 2), 
the port settings should be 9600 baud, N,8,1 and no handshaking:  



 

Command macros to control the DXP38  

Most of the useful DXP38 features can be controlled from the DI Setup window under 
the Dxp-38 Setup tab. However, you may also use DXP38 macros in the DI window 
buttons (but NOT in the Entry window function keys). To program one or more of these 
buttons, you can right-click on one of the buttons to open the editing screen. The HAL 
command set is documented in the DSP4100 technical documentation at the HAL 
website. The HAL macros are in the form of two hexadecimal bytes, the first of which is 
a hex 80. To program a command whose second byte is xy (where x and y are 
hexadecimal digits), include a macro in the form {H80xy} in the message button. You 
miust follow this exact template: the macro is surrounded by curly braces and starts with 
an H, followed by four hexadecimal digits (8, 0 and the two digits corresponding to the 
desired HAL command). Once you have edited one of more of the message buttons, 
you can save the entire file in the Dxp38 macro button set using the Save Macros 
button in the edit window.  



RTTY messages  

Your contesting and other RTTY messages can be either in the Entry window function 
keys (F1-F12, e.g. for use from the keyboard or with ESM) or in some of the DI window 
buttons (for auxiliary messages that are only used occasionally, by clicking on them with 
the mouse). These messages work the same way with the DXP38 as for other digital 
interfaces. Start each message with {TX} and end it with {RX}. Note that message 
buttons that are programmed in the DI window set with Dxp38 selected as the interface 
type will be stored in the Dxp38 macro set, i.e. they will be saved separately from 
message buttons that you set up for MMTTY or for MMVARI.  

First time startup  

 Start up N1MM logger first  
o After the program loads, make sure focus is on the TNC received text 

screen. Then turn on the DXP38. If the data link is OK , an @ will be 
printed on the screen. It takes about 20-30 seconds for the DXP to 
initialize after the @ appears in the RX window.  

 Subsequent startups  
o Turn on the DXP38. Start N1MM logger. After the DXP38 initializes, you 

should see a text rendition of the initialization process on the screen. The 
following screen shot is from the classic (pre-Logger+) version of the 
Logger, so yours may look slightly different, but you should see the same 
initialization messages in the RX window (the DXP-38 tuning indicator has 
been enabled in this screen shot, but none of the 24 message buttons in 
the DI window has been programmed yet):  



 

 

5.3. Configuring a DXP-38 in one of the additional RX windows 

 
The DXP-38 can be configured to be used in one of the additional RX-only windows. To 
do so, use the Setup > Open Add. RX Window menu item in the Digital Interface 
window. If this is the first time this window has been opened, the Setup window will 
open, otherwise you may have to use the Setup menu item in the RX window:  



 

Select Dxp38 as the window type. The MMTTY Setup section is not used for the DXP-
38. Under TNC Setup, select the COM port used for the DXP-38 and set the other 
parameters to 9600, N, 8, 1, no flow control, DTR and RTS both Always On. Once you 
click the Save button to save the configuration, close and reopen the RX window. The 
following screen shot is from an older version of the Logger, so yours may not look 
exactly like this, but you should see the same initialization messages on startup:  



 

6. HAL ST-8000 Setup (not supported) 

The HAL ST-8000 TNC is not supported and will not work with N1MM Logger as the 
baud rate used by the HAL is 45 baud and the serial port control in N1MM will only go 
as low as 110 baud...  

7. KAM Setup 

 Launch Hyperterm and set its parameters to 9600 bps, 8 databits, no-parity, 1 
stopbit and no flow control  

 Connect the KAM to the port configured in Hyperterm  
 Turn on the KAM  
 When you see the message 'Press (*) to set Baud Rate, press the "*" button'  
 Then set your callsign as prompted  
 To place the unit into RTTY mode type "RTTY"  
 Also make sure the unit is set up for software handshaking XFLOW = ON  
 Once you are communicating with the KAM and have it in the RTTY mode, you 

can also tune in a RTTY signal and it will decode and print on the Hyperterm 
window  

 Now try to transmit by typing a Ctrl+C and a "T" on the keyboard followed by 
several characters that you wish to transmit. To get back to receive, type a 
Ctrl+C and a "R"  

 If you have problems, consult your KAM manual  
 Now exit the Hyperterm program and start Logger  

 
Below are sample RTTY settings for the KAM TNC  



AUTOCR 0 AUTOLF ON AUTOSTRT OFF  

BKONDEL ON CD SOFTWARE CRADD OFF  

DIDDLE ON ECHO ON FILTER OFF  

FSKINV OFF INVERT OFF LFSUP OFF  

LOWTONES OFF MARK 2125HZ RBAUD 45  

SHIFT 170 SPACE 2295HZ USOS ON  

XFLOW ON XMITECHO ON 
  

 
There are three parts in setting up N1MM logger to work with the KAM.  

1. Port configuration  

o The KAM should have a checkmark in digital  

2. Digital configuration  

o On the digital configuration dialog  
o Choose a free port and configure it for 9600 baud, N,8,1 and none  

3. Macro Creation required to control the KAM  

o Set the TX macro to: {Ctrl-C}T  
 will go into transmit  

o Set the RX macro to: {Ctrl-C}E  
 return to receive after the message is completed  

o Set the ESC macro to: {Ctrl-C}R  
 this will immediately return the system to receive before sending 

any text  
o You can now program your messages with the {TX} and {RX} macros, for 

example  
 CQ macro: {TX} CQ CQ CQ DE W3PP W3PP W3PP KKK {RX}  

8. PK-232 Setup 

 Make sure the PK-232 autobaud is set and the unit is set to RTTY mode  
 Launch Hyperterm and set its parameters to 1200 baud, 8-data, no-parity, 2 stop 

bits, and no flow control  
 Connect the PK-232 to the port configured in Hyperterm  
 Turn on the PK-232  
 Type a few "*" characters so your PK-232 will autobaud to the 1200 baud rate  
 Now place the PK-232 in the RTTY mode by typing the command "BAUDOT". It 

should respond OPMODE now BAUDOT  
 Turn the threshold pot full clockwise and make sure the LED is on  
 Also make sure the unit is set up for software handshaking XFLOW = ON  



 Once you are communicating with the PK-232 and have it in the BAUDOT mode, 
you can also tune in a RTTY signal and it will decode and print on the Hyperterm 
window  

 Now try a transmit by typing a "X" on the keyboard followed by several 
characters that you wish to transmit. To get back to receive, type a Ctrl+C and a 
"R"  

 If you have problems, consult your PK-232 manual  
 Now exit the Hyperterm program and start Logger. In the DI Setup window under 

the Macro Setup tab, select the "Other" Digital Macro Set, and program the TX, 
RX and Esc buttons as follows:  

o TX: X{ENTER}  
o RX: {CTRL-D}  
o Esc: {CTRL-C}R{ENTER}TC{ENTER}  

 If this has been done correctly, the {TX} and {RX} macros in your messages 
should now work correctly, and the Esc key should be able to interrupt (abort) an 
outgoing message immediately when it is pressed  

8.1. Setting up the PK-232 

By John VK4WPX / VK4CEJ  

Setting up the PK-232 for RTTY is very simple and straightforward.  

 First, open the 'Configurer' (On the main logging window click Config, Configure 
Ports, Telnet addresses, Other)  

 Click the Hardware tab  
o Click in the box adjacent to the COM port that you have your PK-232 

connected to in the column labeled 'Digital'  
o See picture below, the example here shows the PK-232 on COM-2  



 

 

 Next, click on the Digital Modes tab and set up the Digital Interface 1 parameters  
o The example in the picture below shows that the PK-232 is set for 9600 

baud, no parity and 8 data bits  



 

 

Setting up macros and the main logging window "F" keys for the PK-232 is also really 
very simple.  

 Modify any existing macros that came pre-configured by replacing every instance 
of ' {TX} ' with ' {Ctrl-C}Xmit{ENTER} '  

o I found that the command did not work every time unless it was followed 
by the {ENTER}  

o or, if the macro does not have {TX} or {RX} in it and you want it to start 
transmitting or go to receive, add those commands and, replace every 
instance of {RX} with {Ctrl-D}  



 Example: F1 "CQ" macro would therefore be " {Ctrl-C}Xmit{ENTER}CQ CQ CQ 
DE * * * K{Ctrl-D} "  

 Example: F5 macro "Hiscall" would be " {Ctrl-C}Xmit{ENTER}! "  
o Which would leave the rig in transmit mode so that you could type more 

info in the transmit window  
o To return to receive, press Ctrl+D (hold down the Ctrl key and press D)  

9. SCS PTC Setup 

 Take the PTC as you use it for other digimode programs e.g. ALPHA (by 
DH7RG), XPWIN (By KF7XP), LOGGER (by K4CY)  

 Set the PTC to SERBAUD 19200 (not AUTO ! ) > switch the PTC OFF  
 Start N1MMLogger and go to 'Config | Configure Ports, Telnet Address, Other', 

Select the tab 'Digital Modes'. Set 'Digital Interface 1 TU Type' to 'CW/Other', set 
the used serial port to 19200 Baud, N-8-1-none. Set the 'Digital Interface 2 TU 
Type' to 'None'. Save with 'OK'  

 Click on Windows and select Digital Interface  
 Be sure that the PTC is connected to the right serial port and switch it ON and 

the start info will appear in the upper window finished by the prompt cmd: If you 
can't see anything check serial port and settings  

 Click in the lower window, enter with the keyboard 'Escape+Shift bau 45 ENTER' 
the PTC will switch to RTTY (look at the PTC mode display). Add 'Escape+Shift 
term 1 ENTER' to switch the PTC to echo the transmitted signs in the upper 
window. Note : Escape without Shift will switch the cursor to the main window  

 In the open Digital Interface select 'File | Settings' and select Tab: 'Macro Setup'. 
Select behind 'Digital Macro Set' 'Other 1'. Now three buttons appear with TX, RX 
and ESC on it. These buttons have to filled with the sequence to put the PTC in 
TX and RX and to get a correct function for canceling the AUTO-CQ function or 
make a break with the ESC-key on the keyboard  

o Digital Macro Set: Other 1  
o TX button: {Ctrl-Y} NB. in capital letters  

 Now the macro {TX} can be used to switch the TX ON  
o RX button: {Ctrl-Y} NB. in capital letters  

 Now the macro {RX} can be used to switch the TX OFF  
o ESC button: {ESC}CLR{ENTER}{Ctrl-D}{ENTER}  

 The macro will reset the PTC-2 to PACTOR, clear the TX buffer 
and switch the PTC-2 back to RTTY  

 There are a maximum of 24 extra functionkeys. One of them may be configured 
to switch the PTC-2 from the default state PACTOR to RTTY  

o Name button: RTTY  
o Contents button: {ESC}clear{ENTER}{ESC}bau 45{ENTER}{ESC}term 

1{ENTER}  
 Every time you start the PTC-2 you may click on this key to start 

the RTTY-mode. You need 'term 1' to get a delayed echo on the 
RX-window when your text is transmitted  



 You may generate more macros with simple QSO texts using the installed 
N1MMLogger macros as !, *, DATE, TIME etc  

 Don't forget to start a functionkey with {TX} and at the end place {RX} to switch 
back to receive  

 See for some macro examples at macros page  

 

2.8 Single Operator Contesting 

 1 Single Operator Two VFO Operation (SO2V) 

 2 SO2V and SO2R Operation 

 3 SO2R - Single Operator Two Radio Operation 

 4 Single Operator Split Operation 

 5 Single Operator Call Stacking 

 

2.8.1 Single Operator Two VFO Operation (SO2V) 

in-edit  

XXX This page was copied as-is from the N1MM Logger Classic manual - most of the 
material has not yet been reviewed for Plus, but changes, if any, will be small XXX  

 2.8 Single Operator Contesting  
 2.8.1 Single Operator Two VFO Operation (SO2V)  

o 1. Advanced SO2V for Radios with Separate Sub-Receivers  
o 2. Approximating the Capability with Radios that do not have a Sub-

Receiver  
o 3. More advice on using SO2V - from VE3KI  
o 4. SO2V RTTY with MMTTY  

A number of N1MM users are interested in using the advanced VFO and/or subreceiver 
capabilities of modern transceivers to improve their scores by approximating SO2R 
techniques, but with a single radio. This has led to the definition of an operating mode 
called SO2V (Single Operator Two VFOs). This section will deal with the features of 
N1MM Logger that are designed for use in this mode.  

1. Advanced SO2V for Radios with Separate Sub-Receivers 

old-edit  

Additional SO2V features are available for radios that have dual receivers or Main/Sub 
receive. As of the last manual update the complete radio list is: IC-
756/Pro/Pro2/Pro3,IC-7600, IC7800, IC-781, Orion/2, K3, KX3, TS-990, FTdx9000, 
FTdx5000, FT2000, FT1000/D/MP/MKV/MPSteppIr, and the Flex Radios.  

http://n1mmplus.hamdocs.com/tiki-index.php?page=Single+Operator+Two+VFO+Operation+%28SO2V%29&structure=N1MM+Logger+Documentation
http://n1mmplus.hamdocs.com/tiki-index.php?page=SO2V+and+SO2R+Operation&structure=N1MM+Logger+Documentation
http://n1mmplus.hamdocs.com/tiki-index.php?page=SO2R+-+Single+Operator+Two+Radio+Operation&structure=N1MM+Logger+Documentation
http://n1mmplus.hamdocs.com/tiki-index.php?page=Single+Operator+Split+Operation&structure=N1MM+Logger+Documentation
http://n1mmplus.hamdocs.com/tiki-index.php?page=Single+Operator+Call+Stacking&structure=N1MM+Logger+Documentation


In SO2V mode, the \ key changes the RX focus to the Sub receiver and enables the 
Sub audio if necessary (Orion). To use this feature  
set the CQ repeat time a longer than normal and start a repeating CQ using VFOA 
(Main). If nobody answers, press the \ key to enable the Sub receiver and tune the 
band. Pressing \ again will change the RX focus back to VFOA and turn off the Sub if 
Config > Dual Rx Always On is not checked. With Icom radios that only have one VFO 
knob, pressing the \ key also changes the knob association to the Sub VFO.  

If you do not find someone to call before the CQ timer expires, the program will call CQ 
again on VFOA. With RX focus on VFOB (Sub) Entry window, typing a letter will cancel 
the repeating CQ running on VFOA.  

Pressing a function key to call someone or send an exchange will automatically switch 
the TX focus to the proper VFO prior to transmitting. Some radios switch faster because 
they require fewer configuration commands. If the RX focus is on then VFOB (Sub) 
Entry window and the CQ repeat needs to start again on VFOA, simply press the 
CTRL+CQ-Key. The program default for the CQ-key is F1 and this is set in Configurer > 
Function Keys tab.  

If someone answers your CQ while the RX focus is on VFOB (Sub), press the \ key to 
change the RX focus prior to entering the callsign. If you want to change the TX and RX 
focus together press the PAUSE key.  

There is special functionality associated with the Ctrl+Alt+D and Grave accent 
keystrokes for the SO2V radios. See the appropriate radio model in the Supported 
Radios section.  

2. Approximating the Capability with Radios that do not have a Sub-Receiver 

old-edit  

Some basic SO2V functionality has been implemented for all VFOA/B radios (those 
without a sub-receiver).  

You may find the CTRL+Shift+Up/Dn command useful. It programs VFOB with the next 
spot Up or Dn in the Bandmap. When you have time to listen or call the station, press 
the PAUSE (or Ctrl+RightArrow) key. To return to your Run frequency, press the 
PAUSE (or LeftArrow) key, it won't change your RUN frequency. Instead, the program 
will let you know that split is necessary with a status message at the bottom of the Entry 
window.  

See the Supported Radio section of the manual for radio specific information regarding 
general and SO2V operation.  

3. More advice on using SO2V - from VE3KI 

old-edit  

SO2V is a kind of halfway point between SO2R (single-op two radios) and SO1V 
(standard single-receiver operation). The most efficient of the three is SO2R. The main 
advantage of SO2R over traditional one-radio one-VFO operation (SO1V) is that you 
can be listening in one QSO while you are transmitting in a different QSO. Ideally, you 

http://n1mmplus.hamdocs.com/tiki-index.php?page=Supported+Radios
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could be doing two QSOs at once on different bands even though you never have more 
than one transmitted signal at a time, interleaving between the two and doubling your 
overall speed (at least when things are going very well). This is simply not possible with 
only one radio, even if it has two receivers, but SO2V is an attempt to make use of the 
second receiver to gain at least some of the advantages of SO2R.  

In SO2V, you are deaf whenever you are transmitting, so the key advantage of SO2V 
over SO1V is to be able to receive two signals in parallel. You don't conduct two QSOs 
at once, but you can at least determine whether there is someone worth working on 
either of two frequencies at once. That would seem to require two receivers, one 
receiver in each ear, not just two VFOs. You need to be able to tell which signal is 
coming from which receiver (e.g. stereo headphones).  

I am by no means all that proficient, but the main way I use SO2V is CQing on one 
frequency while S&Ping elsewhere in the same band. Again, more to get this out of the 
way than to describe SO2V, note that if it's a good run, people are coming back to you 
right away and you don't have time for SO2V techniques. In fact, what you may need is 
LOGTHENPOP to cope with multiple callers, and when you are doing this in CW or SSB 
you don't need the distraction of a second receiver. Instead, you would leave the 
second receiver turned off while things are going this well.  

However, if things slow down, as they often do late at night or late in the contest, then 
while you are CQing on VFO A and find you have to send CQ several times before 
anyone shows up calling you back, you can turn your second receiver on and start 
using it to S&P up and down the band while you keep on CQing.  

After your transmitter stops at the end of the CQ message, in SO2V you have two 
receivers both active. One is on your transmit frequency, listening for someone calling 
you back. The other one is somewhere else on the band, looking for a station CQing 
that you can call.  

Suppose: (1) no-one answers your CQ (IMHO your first duty is always to answer 
someone who answers your CQ); and (2) you find someone on VFO B that you haven't 
worked yet, and they are calling CQ or just about at the end of a QSO. In that case, 
what you can do is switch to the VFO B entry window (with the mouse if you are 
mousing, e.g. in RTTY, or with the \ key if you are keyboarding) and have (or try to 
have) a QSO on the VFO B frequency. Once that QSO is completed (or as soon as the 
other guy comes back to someone else instead of you), you switch back to VFO A, 
hope that someone hasn't taken over your run frequency while you were away, and 
send a CQ again to repeat the whole process.  

In SO2R, you can keep listening to the other station on the S&P VFO even while you 
are transmitting on your CQ frequency in between transmissions on the S&P radio, but 
in SO2V you have to stay on the S&P frequency for the entire duration of the S&P QSO, 
which means you run a significant risk of losing your run frequency. You have to weigh 
the risk of this happening against the benefit of picking up the S&P QSO during a dead 
period on your run frequency.  

You will probably want to turn autoCQ off while you are doing this. If I leave autoCQ on, 
inevitably I find that the transmitter fires up at exactly the wrong time, just before the 



other station sends his call sign, or when his QSO is ending and it's time to drop in my 
call sign on the VFO B frequency.  

You can also use SO2V to S&P with two receivers at once. Tune one up the band and 
the other down the band at the same time, and simply decide which one to use based 
on where you hear a new station to work first. You can use the \ key to jump back and 
forth between the two entry windows.  

SO2V is more productive if you are in the Assisted class. You can use spots from the 
cluster or RBN to guide where you tune with VFO B, instead of just tuning up and down 
the band. Instead of turning the VFO B tuning knob to find the next station to work, you 
can jump VFO B to the next workable spotted station using Ctrl+Shift+Up/Down arrows. 
This greatly increases the odds of quickly finding someone to work on VFO B versus 
just randomly tuning and screening out the ones you have previously worked.  

You can also use the cluster this way in SO1V with only one receiver, but with a 
significant disadvantage. Once you tune away from your run frequency after listening for 
someone calling you back, you then often have to wait some more listening on the 
second frequency until the caller is at the right point for you to call him. With two 
receivers, you can time your CQs on VFO A so that you don't have to waste time 
listening first on VFO A and then on VFO B; you can listen to both at the same time and 
line up the times so you either respond to a caller on VFO A if one is there, or else send 
your call to a CQer on VFO B, in this way minimizing the time you are away from your 
run frequency.  

To set up for SO2V with a dual-receiver radio, you select the SO2V button in the 
Configurer, and in the Config menu you check the "Dual Rx always on" menu item. In 
RTTY, you can set up the two DI windows with two separate interfaces listening on 
different channels of the sound card and just leave both receivers on all the time. In 
CW/SSB, you will probably want to learn how to use the ` and Ctrl+Alt+D keys (see the 
documentation on Supported Radios) to turn the second receiver on and off.  

I am probably missing some important things, but this is how I use SO2V with my dual-
receiver K3.  

4. SO2V RTTY with MMTTY 

in-edit  

Instructions for setting up two copies of MMTTY for use in SO2V (Note: there are more 
detailed instructions on setting up for digital modes in the Digital Modes section - this 
section focuses on the SO2V aspects):  

 Create two separate folders for the two copies of MMTTY. This allows each copy 
to have its own configuration. These folders must be outside the C:\Program 
Files and C:\Program Files(x86) paths  

 Copy the MMTTY.exe, MMTTY.ini and UserPara.ini files (plus extfsk.dll if you 
use EXTFSK, or extfsk64.fsk if you use EXTFSK64) from the main MMTTY 
program folder into each of the two folders you will use for SO2V  



 Start N1MM Logger and open the Configurer (Config > Configure Ports, Audio, 
Mode Control, Other)  

 Select the Hardware tab  
o Select the SO2V option  
o This next step is optional for most users, but mandatory for some. If you 

are using serial ports for PTT and/or FSK from MMTTY, and you also use 
the same serial port(s) for CW or PTT keying from N1MM Logger+ in CW 
or SSB modes, then you may need to check the Digital check box beside 
the ports that are shared the two copies of MMTTY (for RTTY) and the 
Logger (for CW and SSB). If the only place you use a port is from MMTTY, 
you should skip this step, don't mention the port at all in the Configurer, 
and perform all of the setup for this port within MMTTY  

 Note that you must use either two serial ports, one for each copy of 
MMTTY, or no serial ports (AFSK; PTT controlled either by the 
main N1MM Logger program or in hardware, e.g. PTT via radio 
command or by VOX). If you are using two serial ports, their FSK 
keying outputs must both be connected to the radio's FSK input 
(e.g. by wire-ORing the keying outputs)  

 Click on the Set button for the port you will use with VFO A and set 
the Radio Nr and the Dig Wnd Nr both to 1  

 Click on the Set button for the port you will use with VFO B and set 
the Radio Nr to 1 and the Dig Wnd Nr to 2  

 Select the Digital Modes tab  
o Under Digital Interface 1, TU Type, select Soundcard. Similarly for Digital 

Interface 2  
o Under DI-1 MMTTY Setup, select AFSK or FSK as appropriate for your 

setup and set the MMTTY Path to point to the copy of MMTTY.exe in the 
first folder  

o Under DI-2 MMTTY Setup, select AFSK or FSK as appropriate and set the 
MMTTY Path to point to the copy of MMTTY.exe in the second folder (this 
must be a different copy from the one in the DI-1 MMTTY Setup path)  

 Close the Configurer  
 Open the Digital Interface 1 Window (Window > Digital Interface menu item in the 

main VFO A Entry window). Make sure the program is in RTTY mode (if 
necessary, type RTTY into the Entry Window callsign box and press Enter)  

o If an MMTTY window does not appear (e.g. if you see an MMVARI 
window instead), then in the DI-1 Window select the Interface > MMTTY 
menu item to open the MMTTY window  

o Select the Setup > Settings menu item in the DI-1 window  
 Under Preferred RTTY Interface, select MMTTY  
 Under Alignment Frequency, enter your Mark audio frequency (e.g. 

2125)  
 Under MMTTY Window Settings, select either Normal or Control 

Menus, in order to have easy access to the MMTTY setup window  
 Click on Save Configuration  



o In the MMTTY window for the first copy of MMTTY (the title bar reads 
RTTY Engine 1), select the Option(O) > Setup(O) menu item  

 Select the TX tab and set the PTT & FSK port you will be using for 
the VFO A copy of MMTTY (this is the port with Dig Wnd Nr = 1 in 
the Configurer). If you are using AFSK and doing PTT from the 
main N1MM Logger program, set this port to None  

 Select the SoundCard tab (MMTTY version 1.66 or newer) and 
select the Reception sound card you will use with VFO A. If you are 
using AFSK, you must also select the Transmission sound card  

 Under the Misc tab, select the channel (left or right) under Source 
(usually the left channel for VFO A )  

 Close the MMTTY Setup window  
 Check the Config > Sub Receiver Always On option in the main Entry Window to 

ensure that both receivers will be on  
 If the second Entry window is not open, open it by pressing the Pause key, the 

backslash (\) key or Ctrl+Right Arrow  
 Open the Digital Interface 2 Window (Window > Digital Interface menu item in the 

VFO B Entry window). Make sure the program is in RTTY mode for VFO B (if 
necessary, type RTTY into the VFO B Entry Window callsign box and press 
Enter)  

o If an MMTTY window does not appear (e.g. if you see an MMVARI 
window instead), then in the DI-2 Window select the Interface > MMTTY 
menu item to open the MMTTY window  

o In the MMTTY window for the second copy of MMTTY (the title bar reads 
RTTY Engine 2), select the Option(O) > Setup(O) menu item  

 Select the TX tab and set the PTT & FSK port you will be using for 
the VFO B copy of MMTTY (the port with Dig Wnd Nr = 2 in the 
Configurer); this must be a different COM port from the one that is 
used for VFO A. If you are using AFSK and doing PTT from the 
main N1MM Logger program, set this port to None  

 Select the SoundCard tab (MMTTY version 1.66 or newer) and 
select the Reception sound card you will use with VFO B. If you are 
using AFSK, you must also select the Transmission sound card (in 
SO2V this will likely be the same as the Transmission sound card 
used for VFO A)  

 Under the Misc tab, select the channel (left or right) under Source 
(usually the right channel for VFO B )  

 Close the MMTTY Setup window  
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in-edit  
Previously, information about SO2V (Single Operator Two VFO) operation was 
somewhat randomly distributed between the SO2V and SO2R (Single Operator Two 
Radio) pages. We have combined the two topics into one main topic, while retaining 



information specific to one or the other in separate sections, in order to help users find 
what they need.  

1.1. Basics 

Many of the features of N1MM Logger+ work identically for SO2V and SO2R. They are 
discussed in this section. Unless specifically indicated, they will work in both SO2V and 
SO2R.  

1.1.1. Entry Windows 

In SO2V, if your radio simply has 2 VFOs, VFO A/B will be assigned to each of the two 
Entry Windows. If you have a radio with a sub-receiver, each of the receivers gets 
assigned to each of the Entry Windows. When developing the specs, we actually felt 
SO2V would be more widely used than SO2R.  

N1MM Logger's SO2V interface is essentially identical to the SO2R interface, but with 
SO2V you are using a single radio. Two windows can be displayed in SO2V, one for 
VFO A & B. SO2V makes better use of the 2nd receiver now present in most high-end 
radios. With the 2nd receiver, you can be tuning the band while you are listening for a 
response to your CQ. Since you cannot listen on the sub-receiver while transmitting, 
SO2V is not as efficient as SO2R.  

Entry windows can be placed anywhere on the screen. Typically people will position 
them similar to their equipment layout i.e. if the radios are positioned left/right, the 
windows are arranged reflect that. For those who stack their equipment top/bottom, you 
can position the screens so they logically mirror that radio setup too. Screen real estate 
is in short supply. To save space, you can shrink the Entry Windows compared to the 
default layout. Below is an example of the default Entry Window and a minimized 
version. Also the use of two monitors more screen real estate.  

 

 



 
 
To launch the 2nd Entry Window, hit the \ button.  

Most people who are comfortable with N1MM Logger+ tend to use the reduced size 
Entry Windows for the second radio or VFO.  

1.1.2. Core Features 

All of the central features that are available to the single radio operator also work in 
SO2R/SO2V. For example, when tuning the band with either VFO, spots that are in the 
bandmap are automatically inserted into each call-frame (above the callsign in the Entry 
window) as you tune across the frequency of the spot. Hitting the Space bar will pull the 
callsign from the call frame into the callsign field. If a station calls you on the run VFO or 
radio, toggling back and forth between Entry Windows with the \ key or Ctrl Left/Right 
arrows will maintain the all of the information in each Entry Window until the respective 
stations are logged, wiped clean via Alt+W or Ctrl+W, or you QSY and the callsign is 
entered into the bandmap (if "QSYing wipes the call && spots QSO in bandmap" is 
implemented).  

1.1.3. Entry Window Keyboard shortcuts 

Many of these features are shared between SO2R and SO2V operation.  

 Backslash ( \ ) - Launches a second Entry Window if only one Entry window is 
open  

o One radio - Moves RX focus between the 2 VFOs on the radio  
o Two radios - Moves RX focus between the 2 radios  

 Pause - Move both TX and RX Keyboard focus to other radio (or other VFO in 
SO2V). If TX and RX focus are split when you hit pause, TX focus will move to 
where the RX focus is  

 Ctrl+Enter - SO2R only. Send next ESM state on alternate radio(assuming ESM 
turned on)  

 Ctrl+F1 to F8 - Send Fn message on alternate radio or VFO (CW only, 
currently).  

 Ctrl+Left Arrow - In SO2R move both Transmit and Receive/Keyboard focus to 
left radio, or in SO2V move both TX and RX/Keyboard focus to VFO A  

 Ctrl+Right Arrow - In SO2R move both Transmit and Receive/Keyboard focus 
to right radio, or in SO2V move both TX and RX/Keyboard focus to VFO B  

 Alt+F5 - Swap radio frequency, mode, and callsigns between VFOs (SO2V) or 
radios (SO2R). In SO2R, the receive focus changes to the non-active radio.  

 Alt+F6 - SO2R only. Identical to Alt+F5 except the receive focus does not 
change. No effect in SO2V  

 Ctrl+B - SO2R only. Toggles dueling CQs on and off. Dueling CQ's will send CQ 
alternately on each radio, with the RX focus moving to the Entry window that is 
not transmitting. If Dueling CQ's is turned on, both radios become run radios. A 
delay can be inserted between each CQ by setting the "Set Dueling CQ Repeat 



Time" under the SO2R menu. An icon denoting Dueling CQs appears in the 
entry windows when dueling CQs are actually being transmitted.  

× 

 Don't Be Labeled a Lid 

The current consensus among contesters appears to be that the practice of alternating 
CQs on two frequencies in the same band is undesirable, because spectrum space is 
already scarce enough without multiple stations each taking up two Run frequencies. If 
your radio(s) can do it, better to reserve use of this feature for CQing on two different 
bands. 

 Backquote (grave accent or unshifted tilde key (~) - SO2R only. Toggle 
STEREO mode on/off, or toggle Auto/PTT modes with modified DXD . Notes: On 
US keyboards, the key we are talking about is the key just to the left of the 
number 1 key.  

 Ctrl+PgUp/Down - SO2R only. When changing band using Ctrl+PgUp/Down will 
skip the other radio's band  

o THIS IS NOT A SUBSTITUTE FOR HARDWARE LOCKOUT!  

 
 
 
 
 
Single Operator 2 Radio (aka SO2R) is an operating technique that when done 
properly, can add many extra QSOs and multipliers to your log. This is accomplished by 
increasing your efficiency during slow times, for example, when you are CQing on one 
radio, but getting few answers. Efficiency is increased by listening on a 2nd radio while 
you are transmitting on the 1st radio. On the 2nd radio you are scanning the bands for 
needed QSOs and multipliers. If you find a new station to work on the 2nd radio, you 
leave it staged on the 2nd Entry Window until you get a free moment to work this 
station. Even adding a few QSOs an hour will greatly boost your score.  

The philosophy for SO2R development is to allow any two radios to be used; they do 
not have to be identical. In its most simple form, two transceivers feed two separate 
antennas on two different bands. With sufficient attention to antenna separation and 
filtering, it is possible to do this without interference from a transmitting radio to a 
receiving radio. Many serious SO2R operators use identical radios to reduce the 
confusion factor, but having identical radios isn't necessary.  

The receiver on one band is used to locate new contacts during the time that the 
transmitter on the other band is active. This can mean that you tune the 2nd radio while 
N1MM Logger sends CQ on the 1st radio. The most critical requirement for SO2R is 
automated transmission — if you have to speak into a microphone or squeeze a paddle 
while you tune the receiver you will not make the most of the second radio. It's easy to 



reach a level of mental fatigue while operating SO2R that results in an overall score 
reduction rather than helping your score.  

If your radio is not supported by N1MM Logger, or it's an older radio with no computer 
interface, the radio can still be used, but you just don't get many of the advantages 
automated radio control offered by N1MM Logger.  
A maximum of two radios are supported with N1MM Logger using a single computer. 
There is a workaround for 2-computer 2-radio SO2R, explained below.  

For the new SO2R operator, we have 3 words for you: practice, practice, practice! 
SO2R is definitely a learned skill that takes time to learn, and even longer to master.  

 

1.2. Entry Windows 

Entry windows can be placed anywhere on the screen. Typically people will position 
them similar to their equipment layout i.e. if the radios are positioned left/right, the 
windows are arranged reflect that. For those who stack their equipment top/bottom, you 
can position the screens so they logically mirror that radio setup too.  

Screen real estate is in short supply. To minimize screen real estate, you can shrink the 
Entry Windows compared to the default layout. Below is an example of the default Entry 
Window and a minimized version. Also the use of two monitors more screen real estate.  

 

 

 
 
To launch the 2nd Entry Window, hit the \ button.  

Most people who are comfortable with N1MM Logger+ tend to use the reduced size 
Entry Windows for the second radio or VFO.  

All of the features that are available to the single radio operator also work in 
SO2R/SO2V. For example, when tuning the band with the S&P VFO, spots that are in 



the bandmap are automatically inserted into each call frame (above the callsign in the 
Entry window) when you tune across the frequency of the spot. Hitting the Space bar 
will pull the callsign from the call frame into the callsign field. If a station calls you on the 
run radio, toggling back and forth between Entry Windows with the \ key or Ctrl 
Left/Right arrows will maintain the all of the information in each Entry Window until the 
respective stations are logged, wiped clean via Alt+W or Ctrl+W, or you QSY and the 
callsign is entered into the bandmap (if "QSYing wipes the call && spots QSO in 
bandmap" is implemented).  

1.3. Entry Window Features 

Many of these features are shared between SO2R and SO2V operation.  

 Backslash ( \ ) - Launches a second Entry Window if only one Entry window is 
open  

o One radio - Moves RX focus between the 2 VFOs on the radio  
o Two radios - Moves RX focus between the 2 radios  

 Ctrl+Enter - Send next ESM state on alternate radio or VFO (assuming ESM 
turned on)  

 Ctrl+F1 to F8 - Send Fn message on alternate radio or VFO.  
 Ctrl+Left Arrow - In SO2R move both Transmit and Receive/Keyboard focus to 

left radio, or in SO2V move both TX and RX/Keyboard focus to VFO A  
 Ctrl+Right Arrow - In SO2R move both Transmit and Receive/Keyboard focus 

to right radio, or in SO2V move both TX and RX/Keyboard focus to VFO B  
 Pause - Move both TX and RX Keyboard focus to other radio (or other VFO in 

SO2V). If TX and RX focus are split when you hit pause, TX focus will move to 
where the RX focus is  

 Alt+F5 - Swap radio frequency, mode, and callsigns between VFOs (SO2V) or 
radios (SO2R). In SO2R, the receive focus changes to the non-active radio.  

 Alt+F6 - Identical to Alt+F5 except the receive focus does not change. No effect 
in SO2V  

 Ctrl+B - Toggles dueling CQs on and off. Dueling CQ's will send CQ alternately 
on each radio or VFO, with the RX focus moving to the Entry window that is not 
transmitting. If Dueling CQ's is turned on, both radios become run radios. A delay 
can be inserted between each CQ by setting the "Set Dueling CQ Repeat Time" 
under the SO2R menu. Dueling SSB and CW CQ's are supported too. An icon 

denoting Dueling CQs appears in the entry windows when dueling CQs are 
actually being transmitted.  

× 

 Don't Be Labeled a Lid 

The current consensus among contesters appears to be that the practice of alternating 
CQs on two frequencies in the same band is undesirable, because spectrum space is 
already scarce enough without multiple stations each taking up two Run frequencies. If 
your radio(s) can do it, better to reserve use of this feature for CQing on two different 
bands. 



 Backquote (grave accent or unshifted tilde key (~) - Toggle STEREO mode 
on/off, or toggle Auto/PTT modes with modified DXD . Notes: On US keyboards, 
the key we are talking about is the key just to the left of the number 1 key.  

 Ctrl+PgUp/Down - When changing band using Ctrl+PgUp/Down will skip the 
other radio's band  

o THIS IS NOT A SUBSTITUTE FOR HARDWARE LOCKOUT!  
 Ctrl+Shift+K - FocusOther, Another method of focus control (Focus on Other 

Radio), preferred by many contesters over "Advanced SO2R". When FocusOther 
is active, the RX focus is automatically shifted between the "Run" radio and the 
"S&P" radio, depending on whether the Run radio is transmitting. When the Run 
radio is transmitting, RX focus is shifted to the S&P radio. When the Run radio 
stops transmitting, RX focus shifts back to the Run radio, unless an unworked 
callsign has been entered in the S&P entry window. This allows a callsign to be 
entered in the S&P radio Entry Window while CQ is being sent on the Run radio.  

 Ctrl+Shift+L - This enables/disables the use of {CTRLFx} in function key 
macros. {CTRLFx} is a convenient way to automatically send a function key on 
the alternate radio. For example, by programming your S&P F4 key to "* 
{CTRLF1}", your call will be sent on the S&P radio, immediately followed by your 
CQ message on the Run radio.  

 
 
 
 
Single Operator 2 Radio (aka SO2R) is an operating technique that when done 
properly, can add many extra QSOs and multipliers to your log. This is accomplished by 
increasing your efficiency during slow times, for example, when you are CQing on one 
radio, but getting few answers. Efficiency is increased by listening on a 2nd radio while 
you are transmitting on the 1st radio. On the 2nd radio you are scanning the bands for 
needed QSOs and multipliers. If you find a new station to work on the 2nd radio, you 
leave it staged on the 2nd Entry Window until you get a free moment to work this 
station. Even adding a few QSOs an hour will greatly boost your score.  

The philosophy for SO2R development is to allow any two radios to be used; they do 
not have to be identical. In its most simple form, two transceivers feed two separate 
antennas on two different bands. With sufficient attention to antenna separation and 
filtering, it is possible to do this without interference from a transmitting radio to a 
receiving radio. Many serious SO2R operators use identical radios to reduce the 
confusion factor, but having identical radios isn't necessary.  

The receiver on one band is used to locate new contacts during the time that the 
transmitter on the other band is active. This can mean that you tune the 2nd radio while 
N1MM Logger sends CQ on the 1st radio. The most critical requirement for SO2R is 
automated transmission — if you have to speak into a microphone or squeeze a paddle 
while you tune the receiver you will not make the most of the second radio. It's easy to 
reach a level of mental fatigue while operating SO2R that results in an overall score 
reduction rather than helping your score.  



If your radio is not supported by N1MM Logger, or it's an older radio with no computer 
interface, the radio can still be used, but you just don't get many of the advantages 
automated radio control offered by N1MM Logger.  
A maximum of two radios are supported with N1MM Logger using a single computer. 
There is a workaround for 2-computer 2-radio SO2R, explained below.  

For the new SO2R operator, we have 3 words for you: practice, practice, practice! 
SO2R is definitely a learned skill that takes time to learn, and even longer to master.  

 

1.4. SO2V Operation 

 
in-edit  

1.4.1. Advanced SO2V for Radios with Separate Sub-Receivers 
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Additional SO2V features are available for radios that have dual receivers or Main/Sub 
receive. As of the last manual update the complete radio list is: IC-
756/Pro/Pro2/Pro3,IC-7600, IC7800, IC-781, Orion/2, K3, KX3, TS-990, FTdx9000, 
FTdx5000, FT2000, FT1000/D/MP/MKV/MPSteppIr, and the Flex Radios.  

In SO2V mode, the \ key changes the RX focus to the Sub receiver and enables the 
Sub audio if necessary (Orion). To use this feature  
set the CQ repeat time a longer than normal and start a repeating CQ using VFOA 
(Main). If nobody answers, press the \ key to enable the Sub receiver and tune the 
band. Pressing \ again will change the RX focus back to VFOA and turn off the Sub if 
Config > Dual Rx Always On is not checked. With Icom radios that only have one VFO 
knob, pressing the \ key also changes the knob association to the Sub VFO.  

If you do not find someone to call before the CQ timer expires, the program will call CQ 
again on VFOA. With RX focus on VFOB (Sub) Entry window, typing a letter will cancel 
the repeating CQ running on VFOA.  

Pressing a function key to call someone or send an exchange will automatically switch 
the TX focus to the proper VFO prior to transmitting. Some radios switch faster because 
they require fewer configuration commands. If the RX focus is on then VFOB (Sub) 
Entry window and the CQ repeat needs to start again on VFOA, simply press the 
CTRL+CQ-Key. The program default for the CQ-key is F1 and this is set in Configurer > 
Function Keys tab.  

If someone answers your CQ while the RX focus is on VFOB (Sub), press the \ key to 
change the RX focus prior to entering the callsign. If you want to change the TX and RX 
focus together press the PAUSE key.  

There is special functionality associated with the Ctrl+Alt+D and Grave accent 
keystrokes for the SO2V radios. See the appropriate radio model in the Supported 
Radios section.  

1.4.2. Approximating the Capability with Radios that do not have a Sub-Receiver 

http://n1mmplus.hamdocs.com/tiki-index.php?page=Supported+Radios
http://n1mmplus.hamdocs.com/tiki-index.php?page=Supported+Radios
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Some basic SO2V functionality has been implemented for all VFOA/B radios (those 
without a sub-receiver).  

You may find the CTRL+Shift+Up/Dn command useful. It programs VFOB with the next 
spot Up or Dn in the Bandmap. When you have time to listen or call the station, press 
the PAUSE (or Ctrl+RightArrow) key. To return to your Run frequency, press the 
PAUSE (or LeftArrow) key, it won't change your RUN frequency. Instead, the program 
will let you know that split is necessary with a status message at the bottom of the Entry 
window.  

See the Supported Radio section of the manual for radio specific information regarding 
general and SO2V operation.  

1.4.3. More advice on using SO2V - from VE3KI 
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SO2V is a kind of halfway point between SO2R (single-op two radios) and SO1V 
(standard single-receiver operation). The most efficient of the three is SO2R. The main 
advantage of SO2R over traditional one-radio one-VFO operation (SO1V) is that you 
can be listening in one QSO while you are transmitting in a different QSO. Ideally, you 
could be doing two QSOs at once on different bands even though you never have more 
than one transmitted signal at a time, interleaving between the two and doubling your 
overall speed (at least when things are going very well). This is simply not possible with 
only one radio, even if it has two receivers, but SO2V is an attempt to make use of the 
second receiver to gain at least some of the advantages of SO2R.  

In SO2V, you are deaf whenever you are transmitting, so the key advantage of SO2V 
over SO1V is to be able to receive two signals in parallel. You don't conduct two QSOs 
at once, but you can at least determine whether there is someone worth working on 
either of two frequencies at once. That would seem to require two receivers, one 
receiver in each ear, not just two VFOs. You need to be able to tell which signal is 
coming from which receiver (e.g. stereo headphones).  

I am by no means all that proficient, but the main way I use SO2V is CQing on one 
frequency while S&Ping elsewhere in the same band. Again, more to get this out of the 
way than to describe SO2V, note that if it's a good run, people are coming back to you 
right away and you don't have time for SO2V techniques. In fact, what you may need is 
LOGTHENPOP to cope with multiple callers, and when you are doing this in CW or SSB 
you don't need the distraction of a second receiver. Instead, you would leave the 
second receiver turned off while things are going this well.  

However, if things slow down, as they often do late at night or late in the contest, then 
while you are CQing on VFO A and find you have to send CQ several times before 
anyone shows up calling you back, you can turn your second receiver on and start 
using it to S&P up and down the band while you keep on CQing.  

After your transmitter stops at the end of the CQ message, in SO2V you have two 
receivers both active. One is on your transmit frequency, listening for someone calling 



you back. The other one is somewhere else on the band, looking for a station CQing 
that you can call.  

Suppose: (1) no-one answers your CQ (IMHO your first duty is always to answer 
someone who answers your CQ); and (2) you find someone on VFO B that you haven't 
worked yet, and they are calling CQ or just about at the end of a QSO. In that case, 
what you can do is switch to the VFO B entry window (with the mouse if you are 
mousing, e.g. in RTTY, or with the \ key if you are keyboarding) and have (or try to 
have) a QSO on the VFO B frequency. Once that QSO is completed (or as soon as the 
other guy comes back to someone else instead of you), you switch back to VFO A, 
hope that someone hasn't taken over your run frequency while you were away, and 
send a CQ again to repeat the whole process.  

In SO2R, you can keep listening to the other station on the S&P VFO even while you 
are transmitting on your CQ frequency in between transmissions on the S&P radio, but 
in SO2V you have to stay on the S&P frequency for the entire duration of the S&P QSO, 
which means you run a significant risk of losing your run frequency. You have to weigh 
the risk of this happening against the benefit of picking up the S&P QSO during a dead 
period on your run frequency.  

You will probably want to turn autoCQ off while you are doing this. If I leave autoCQ on, 
inevitably I find that the transmitter fires up at exactly the wrong time, just before the 
other station sends his call sign, or when his QSO is ending and it's time to drop in my 
call sign on the VFO B frequency.  

You can also use SO2V to S&P with two receivers at once. Tune one up the band and 
the other down the band at the same time, and simply decide which one to use based 
on where you hear a new station to work first. You can use the \ key to jump back and 
forth between the two entry windows.  

SO2V is more productive if you are in the Assisted class. You can use spots from the 
cluster or RBN to guide where you tune with VFO B, instead of just tuning up and down 
the band. Instead of turning the VFO B tuning knob to find the next station to work, you 
can jump VFO B to the next workable spotted station using Ctrl+Shift+Up/Down arrows. 
This greatly increases the odds of quickly finding someone to work on VFO B versus 
just randomly tuning and screening out the ones you have previously worked.  

You can also use the cluster this way in SO1V with only one receiver, but with a 
significant disadvantage. Once you tune away from your run frequency after listening for 
someone calling you back, you then often have to wait some more listening on the 
second frequency until the caller is at the right point for you to call him. With two 
receivers, you can time your CQs on VFO A so that you don't have to waste time 
listening first on VFO A and then on VFO B; you can listen to both at the same time and 
line up the times so you either respond to a caller on VFO A if one is there, or else send 
your call to a CQer on VFO B, in this way minimizing the time you are away from your 
run frequency.  

To set up for SO2V with a dual-receiver radio, you select the SO2V button in the 
Configurer, and in the Config menu you check the "Dual Rx always on" menu item. In 
RTTY, you can set up the two DI windows with two separate interfaces listening on 



different channels of the sound card and just leave both receivers on all the time. In 
CW/SSB, you will probably want to learn how to use the ` and Ctrl+Alt+D keys (see the 
documentation on Supported Radios) to turn the second receiver on and off.  

I am probably missing some important things, but this is how I use SO2V with my dual-
receiver K3.  

1.4.4. SO2V RTTY with MMTTY 
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Instructions for setting up two copies of MMTTY for use in SO2V (Note: there are more 
detailed instructions on setting up for digital modes in the Digital Modes section - this 
section focuses on the SO2V aspects):  

 Create two separate folders for the two copies of MMTTY. This allows each copy 
to have its own configuration  

 Copy the MMTTY.exe, MMTTY.ini and UserPara.ini files (plus extfsk.dll if you 
use EXTFSK, or extfsk64.fsk if you use EXTFSK64) from the main MMTTY 
program folder into each of the two folders you will use for SO2V  

 Start N1MM Logger and open the Configurer (Config > Configure Ports, Audio, 
Mode Control, Other)  

 Select the Hardware tab  
o Select the SO2V option  
o This next step is optional for many users, but mandatory for some. If you 

are using serial ports for PTT and/or FSK from MMTTY, you may wish or 
need to check the Digital check box beside the ports used by the two 
copies of MMTTY. This step is necessary if you use the same port for CW 
or PTT keying from N1MM Logger in CW or SSB modes; if the only place 
you use a port is from MMTTY, the step is optional; and if the port number 
is higher than 8, you have to skip this step and perform all of the setup for 
this port within MMTTY.  

 Note that you must use either two serial ports, one for each copy of 
MMTTY, or no serial ports (AFSK; PTT controlled either by the 
main N1MM Logger program or in hardware, e.g. PTT via radio 
command or by VOX). If you are using two serial ports, their FSK 
keying outputs must both be connected to the radio's FSK input  

 Click on the Set button for the port you will use with VFO A and set 
the Radio Nr and the Dig Wnd Nr both to 1  

 Click on the Set button for the port you will use with VFO B and set 
the Radio Nr to 1 and the Dig Wnd Nr to 2  

 Select the Digital Modes tab  
o Under Digital Interface 1, TU Type, select Soundcard. Similarly for Digital 

Interface 2  
o Under DI-1 MMTTY Setup, select AFSK or FSK as appropriate for your 

setup and set the MMTTY Path to point to the copy of MMTTY.exe in the 
first folder  



o Under DI-2 MMTTY Setup, select AFSK or FSK as appropriate and set the 
MMTTY Path to point to the copy of MMTTY.exe in the second folder (this 
must be a different copy from the one in the DI-1 MMTTY Setup path)  

 Close the Configurer  
 Open the Digital Interface 1 Window (Window > Digital Interface menu item in the 

main VFO A Entry window). Make sure the program is in RTTY mode (if 
necessary, type RTTY into the Entry Window callsign box and press Enter)  

o If an MMTTY window does not appear (e.g. if you see an MMVARI 
window instead), then in the DI-1 Window select the Interface > MMTTY 
menu item to open the MMTTY window  

o Select the Setup > Settings menu item in the DI-1 window  
 Under Preferred RTTY Interface (lower left), select MMTTY  
 Under Alignment Frequency (lower right), enter your Mark audio 

frequency (e.g. 2125)  
 Under MMTTY Window Settings, select either Normal or Control 

Menus, in order to have easy access to the MMTTY setup window  
 Click on Save Configuration  

o In the MMTTY window for the first copy of MMTTY (the title bar reads 
RTTY Engine 1), select the Option(O) > Setup(O) menu item  

 Select the TX tab and set the PTT & FSK port you will be using for 
the VFO A copy of MMTTY (this is the port with Dig Wnd Nr = 1 in 
the Configurer). If you are using AFSK and doing PTT from the 
main N1MM Logger program, set this port to None  

 Select the SoundCard tab (MMTTY version 1.66 or newer) and 
select the Reception sound card you will use with VFO A. If you are 
using AFSK, you must also select the Transmission sound card  

 Under the Misc tab, select the channel (left or right) under Source 
(usually the left channel for VFO A )  

 Close the MMTTY Setup window  
 If the second Entry window is not open, open it by pressing the Pause key, the 

backslash (\) key or Ctrl+Right Arrow  
 Open the Digital Interface 2 Window (Window > Digital Interface menu item in the 

VFO B Entry window). Make sure the program is in RTTY mode for VFO B (if 
necessary, type RTTY into the VFO B Entry Window callsign box and press 
Enter)  

o If an MMTTY window does not appear (e.g. if you see an MMVARI 
window instead), then in the DI-2 Window select the Interface > MMTTY 
menu item to open the MMTTY window  

o In the MMTTY window for the second copy of MMTTY (the title bar reads 
RTTY Engine 2), select the Option(O) > Setup(O) menu item  

 Select the TX tab and set the PTT & FSK port you will be using for 
the VFO B copy of MMTTY (the port with Dig Wnd Nr = 2 in the 
Configurer); this must be a different COM port from the one that is 
used for VFO A. If you are using AFSK and doing PTT from the 
main N1MM Logger program, set this port to None  



 Select the SoundCard tab (MMTTY version 1.66 or newer) and 
select the Reception sound card you will use with VFO B. If you are 
using AFSK, you must also select the Transmission sound card (in 
SO2V this will likely be the same as the Transmission sound card 
used for VFO A)  

 Under the Misc tab, select the channel (left or right) under Source 
(usually the right channel for VFO B )  

 Close the MMTTY Setup window  

 

1.5. SO2R - Single Operator Two Radio Operation 

1.5.1. Two-Computer SO2R 
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Some operators, particularly on RTTY, prefer to use separate computers for SO2R. This 
is not explicitly supported by N1MM Logger, but there is a way.  

First, be sure both computers are running the same version of N1MM Logger. Turn on 
Networked-Computer mode (Config >Networked-Computer Mode), and configure the 
network between your computers as explained in the section on Network Setup and 
Configuration?. Then set up your contest class as Multi-One.  

Set your lockout style under Config >Multi-User Tools as explained here?  

 First One Wins  
o UNCHECK >Multi-User Tools >Force Other Station to Stop Transmitting 

When I Transmit  
o UNCHECK >Multi-User Tools >Block My TX Only if Other Stn 

Transmitting on Same Band & Mode (Multi-One)  
 Last One Wins  

o CHECK >Multi-User Tools >Force Other Station to Stop Transmitting 
When I Transmit is CHECKED  

o UNCHECK >Multi-User Tools >Block my TX Only if Other Stn 
Transmitting on Same Band & Mode (Multi-One)  

 
Please note that a number of N1MM Logger's advanced SO2R features cannot be used 
in this style of SO2R operation,. The list includes Ctrl+Fx (send Fx on the opposite 
radio), {CtrlFx} (the same as a macro), dueling CQs, Advanced SO2R and FocusOther. 
All of these require both radios to be connected to the same computer. Serial 
numbering, if used, will conform to the Multi-Single rules for the contest in question.  

Don't forget to change your entry class back to Single Op or Single Op Assisted in the 
Contest Setup window before you generate your Cabrillo file.  

× 

 Users Please Note 

http://n1mmplus.hamdocs.com/tiki-editpage.php?page=Networked-Computer+Support
http://n1mmplus.hamdocs.com/tiki-editpage.php?page=SO2R


Please be aware that the developers will not implement Feature Requests or respond to 
Bug Requests that result from 2-computer SO2R's not conforming to single-computer 
SO2R expectations.  

1.5.2. Supported Features 
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N1MM Logger supports all of the features you would expect from any world-class SO2R 
software. In addition, there are a lot of unique features:  

 Two Entry windows are displayed that are fully interchangeable in functionality 
(windows are not dedicated to a specific task)  

 Running and S&P modes are maintained for each SO2R Entry window, such that 
the 2 windows can be used for  

o Running / S&P  
o S&P / Running  
o S&P / S&P  
o Running / Running  

 Entry windows can be arranged on screen as desired: typically left/right, or 
top/bottom, to represent physical station layout  

 Each Entry Window has a frequency readout in the top pane  
 'LEDs' identify which radio has focus. The sending radio has a red LED indicating 

TX Focus, a green LED identifies the radio that has RX and Keyboard focus 
(combined)  

 Background colors of the entry field change color depending on whether that 
radio is running or S&P: white = run; canary = S&P  

 Ability to change frequency of inactive radio from the active radio. Use the / 
before entering the frequency in the callsign field to enter frequency for other 
radio/VFO  

 Supports Enter Sends Messages Mode (ESM) on both windows  
 Typing a call in inactive radio Entry window does not abort sending on the active 

radio  
 Hitting Escape stops sending on either VFO or radio, but does not change 

keyboard focus  
 Changing transmit focus (for any function) stops sending before switching and 

sending on alternate radio  
 Ctrl+function keys and Ctrl+Enter sends messages on alternate radio 

(Concept is Ctrl = Alternate radio control)  
 "Hotkey's" for specific tasks and sending on alternate radio  
 All Key Assignments work on both radios (unless otherwise specified)  
 Supports Top Ten DX Doubler, WX0B Station Master, Microham MK2R, YCCC 

SO2R, and other SO2R controllers.  
 Support SO2R without interfaced radios.  
 Dueling CQ's will send CQ alternately on each radio (Ctrl+B)  

o If dueling CQ's is enabled, and CQ sent then both radios become Run 
radios  



o Ctrl+F1 or Ctrl+Enter will not start Dueling CQ  
o Dueling SSB and CW CQ's (different modes in each Entry window) are 

supported  
o When you disable Dueling CQs, the pre-existing SO2R options are 

restored  
 A SO2R software radio lockout for is implemented  
 CQ-repeat is terminated when a message is sent on the other radio  
 The macro {JUMPRX} changes the receive focus to the other input window  
 Supports 2 radios - No support for 3 or more radios  
 Support SO2R with zero, one or two sound cards (5$ SO2R)  
 When changing band using Ctrl+PgUp/Down key will skip the other radio's band  

o THIS IS NOT A SUBSTITUTE FOR HARDWARE LOCKOUT!!  
 The sent CW will echo in the status bar of the Entry Window (only when in 

SO2R)  
 During VOX operation, in "$5 SO2R" operation the TX audio should will track the 

TX focus all the time  

 

1.5.3. The SO2R Dots (LEDs) 

 
On the Entry Window a green and/or a red dot (LED) will be shown. The LEDs are 
visual aids that help you easily identify what is happening on each radio. This is part of 
N1MM's continuing philosophy of letting the operator easily know what's happening at 
any give time.  

The green LED indicates that the VFO or radio has receive/entry focus and the red LED 
indicates that VFO has transmit (TX) focus. In addition, the red TX LED changes 
between dark red (not transmitting) and yellow (VFO/radio is transmitting).  

1.5.3.1. Dot/LED Colors Used: 

Green dot/LED - This VFO/Radio has receive (RX) and entry focus. RX and entry focus 
are always together.  

 Receive focus can be toggled between the VFOs/radios by  
o using a mouse to click on the background of one of the two Entry windows  
o pressing the \ key (backslash)  

 To move both Transmit and Receive focus  
o Press Pause or Ctrl+Left-Arrow / Ctrl+Right-Arrow to move both foci 

between the left and right radios.  

Red dot/LED - This VFO/Radio has transmit (TX) focus. This means that the radio or 
VFO either is transmitting or was the last to transmit, and will be the one that transmits 
if you transmit by means other than pressing a function key. When the other window 
has entry focus and you press a function key to send a stored message, the transmit 
focus shifts to that radio as soon as the function key is executed.  



 Pressing Pause or Ctrl+Left-Arrow / Ctrl+Right-Arrow will move both foci 
between radios. If the foci are split, the first press of Pause moves the Transmit 
focus to the radio with the receive focus; thereafter, both foci will move together 
each time it is pressed.  

 When transmitting the TX focus can not be changed.  

1.5.4. Key Assignments (unique to SO2R) 

× 

 "Sticky" options  

The Focus Other (Ctrl+Shift+K) and Ctrl+Fx settings, whether controlled through 
keyboard shortcuts or through the SO2R sub-menu of the Configurer, are "sticky" - that 
is they are remembered the next time the program is opened. This can surprise you if 
you don't remember having set them. 

1.5.4.1. Bandmap Features 

 Shift+Click on frequency (SO2R only) - Jump to that frequency on the inactive 
radio, without changing TX or RX focus. This allows you to be active and sending 
on one radio and change the frequency on the other radio without making it the 
active radio.  

 Shift+Click on bandmap callsign (SO2R only) - Send the frequency to the 
inactive radio and place the callsign on the other radio's callsign frame, without 
making it the active radio.  

1.5.4.2. Using SO2R Key Assignments 

Backslash ( \ ) - Once you have launched your second Entry Window, the \ key will 
likely be your most widely used key in SO2R. The \ key will move RX and Entry focus 
between Entry Windows A & B (often referred to as Radio 1 & Radio 2 respectively). 
When using the \ key to control RX focus, you really don't have to worry where TX focus 
is. By using the \ key to control only RX focus, when you hit a Fn key or Enter (using 
ESM), the TX focus will move to where the RX focus is, and send the corresponding 
message.  

Example: You are CQing on Radio 1, and S&Ping on Radio 2. Both RX and TX focus 
start off in your Run Entry Window (Radio 1 in this example). You are S&Ping on Radio 
2, and you hear someone on the S&P radio you want to look up in your Check Window. 
Hit the \ key to move RX focus to the S&P Entry Window. You type in the call, and you 
need it, and are just waiting for a good time to send your call. If no one is answering 
your CQ on the Run Radio, just hit the Enter Key (assuming you are using ESM), and 
the TX focus will move from the Run Radio to the S&P radio (Radio 2), and send your 
callsign (actually the first ESM message in the S&P sequence). If the station comes 
back to you, then hit Enter again to send your exchange, and you just completed a S&P 
QSO. Now move the RX focus with the \ key to the Run radio, or just leave it in the S&P 
Entry Window if S&P is more productive.  



Now let's assume in the middle of the S&P QSO, someone answers your CQ on Radio 
1. Your exchange just happens to be sending on the S&P radio. To copy the call on the 
Run Radio (while your exchange is being sent on the S&P radio), hit the \ key to move 
RX focus to the Run Radio, and type his call in the Run Entry Window. Assuming your 
exchange is finished sending on Radio 2, just hit Enter again, and the TX focus will 
move back to the Run Radio, and the program will send his call and your exchange on 
the Run Radio. You now have QSOs going on both radios! Just move RX focus as 
needed to send/copy on what ever radio you need. This is easier said, than done during 
a contest !  

× 

 Tracking TX Focus 

In the above examples, you never have to control where TX focus is, since TX focus 
always moves automatically to where the RX focus is when Fn or Enter (ESM) is used. 
This should be your standard operating mode, as you only need to worry about using a 
single key to do most of your navigation between the two Entry Windows. 

 
Ctrl+Enter, or Ctrl+Fn - Using these commands will send the corresponding message 
on the alternate radio; with the alternate radio defined as the radio that does not have 
RX focus. Using Ctrl+Fn (or Ctrl+Enter) will only move the TX focus to send the 
message - RX focus will stay in it's current location. Once the message is sent, TX 
focus will remain on the alternate radio. This is done by design.  

The most common scenario would be if you are CQing on Radio 1, but you are not 
getting callers. You hit the \ key to copy a callsign on the S&P radio. Without moving the 
RX focus from the S&P radio, at some point you will probably want to send another CQ 
on the Run Radio. You do this by hitting Ctrl+F1 or Ctrl+Enter. You will also likely use 
these commands if you have a QSO in progress at the same time on both the Run and 
S&P radio. The easiest way to send a message at the right time on the other radio is to 
use these commands, and leave RX focus where it is. Alternatively, you can program 
function keys with the {CTRLFx} macro to send messages to the other radio.  

Pause Key - If both TX and RX focus are in the same Entry Window, hitting Pause will 
move both TX and RX focus to the other radio. If TX and RX focus are split between the 
Entry Windows, the pause key will move TX focus to where RX focus is. Mostly you will 
use this key in order to get your foci back in sync.  

Ctrl+Right Arrow and Ctrl+Left Arrow - These commands will force both TX and RX 
focus to the right or left radio.  

Ctrl+B - Toggle Dueling CQ's.  

{CTRLFn} macro - This macro allows the user to send on the other radio.  

 Make sure that "Toggle {CTRLFx}" macro is checked on in the Configurer SO2R 
submenu (or use Ctrl-Shift-L to enable/disable the use of {CTRLFx} macros. 
When disabled, the {CTRLFx} macro is ignored.  



 Thus, a CW Button might look like: "tu EXCH{CTRLF9}" Where F9 on the other 
radio is set to send a CQ.  

 Example: If your entry focus is on the S&P radio and you manually press 
Ctrl+F1, the program will send F1 on the OTHER radio. That's all the {CTRLFx} 
macro does. For a simple test, modify your S&P F4 key to read *{CTRLF1}. Now, 
when you press that key, the program sends your call on the S&P radio and then 
sends the contents of F1 on the Run radio. In a practical situation, you would 
probably not want to send a full-length CQ while trying to work someone on the 
S&P radio, because that will nearly always require you to interrupt it before it is 
done. So the idea of {CTRLFx} is that you can stash a short CQ (like "N1MM 
test"} in, for example, Run F12. Then make S&P F4 read "* {CTRLF12}. Now 
when you press F4 on the S&P radio, it will send your call, and immediately 
switch to the Run radio and send F12, that very short CQ. Should help hold your 
frequency.  

 Another way to use this: Make your S&P F2 read, for example, 5NN14{CTRLF1}. 
Then when you press F2 or Enter to send your exchange and/or log the S&P 
QSO, the program will automatically begin a CQ on the Run radio as soon as 
that is done.  

1.5.5. Mouse Assignments 

 Left mouse and Right mouse buttons_  
o On an empty space in one of the two Entry windows, these mouse buttons 

change the Receive focus to that radio/VFO  

1.5.6. SO2R Menu 

 SO2R  
o Dueling CQ's Ctrl+B - will send CQ alternately on each radio  
o Set Dueling CQ Repeat Time  
o Focus on Other Radio - A method of focus control, preferred by many 

contesters over "Advanced SO2R". When FocusOther is active, the RX 
focus is automatically shifted between the "Run" radio and the "S&P" 
radio, depending on whether the Run radio is transmitting. When the Run 
radio is transmitting, RX focus is shifted to the S&P radio. When the Run 
radio stops transmitting, RX focus shifts back to the Run radio, unless an 
unworked callsign has been entered in the S&P entry window. This allows 
a callsign to be entered in the S&P radio Entry Window while CQ is being 
sent on the Run radio.  

o FocusOther Always Swap - Used in conjunction with Focus on Other 
Radio. When FocusOther Always Swap is enabled, RX focus will always 
shift back to the Run radio when the Run radio stops transmitting.  

o Toggle CTRLFx Macro - This enables/disables the use of {CTRLFx} in 
function key macros.  

o TX Lockout ((Digital) - Select a lockout item ((Digital modes only)  
 Multi-TX - This is the default setting. Start CQ on radio A, Start CQ 

on radio B, both are active. (no lockout)  



 First one wins - Start CQ on radio A, pause, Start CQ on radio B. 
The radio B CQ is ignored since radio A is already active, so if you 
press a F-key for the second radio while radio1 is transmitting, the 
radio B F-key is ignored  

 Last one wins - Start CQ on radio A (CQ starts), pause, Start CQ 
on radio B. The CQ on radio A will aborted and the CQ on radio B 
will start so if you press a F-key for the second radio while radio A 
is transmitting, the radio A transmission is interrupted and radio B 
transmits  

1.5.7. Software Setup 

Setting up SO2R and SO2V starts in the Config menu:  

 Config > "Configure Ports, Telnet Address, Other" > Hardware Tab  

Then if SO2R: 

 Set up radios 
 Set up keying if necessary (Serial 

port, LPT port or Winkeyer) 
 Click SO2R button 
 Click OK to close out. 
 Launch N1MM Logger, set up 

contest etc. 
 If 2nd Entry Window is not shown, hit 

the \ key (backslash key) 
 SO2R - 1 computer radio + 1 manual 

radio (so two radios) 
 SO2V - 1 computer radio with 2 

VFOs and no manual radio (so one 
radio) 

Then if SO2V: 

 Set up radio 
 Set up keying if necessary (Serial 

port, LPT port or Winkeyer) 
 Click SO2V button 
 Click OK to close out. 
 Launch N1MM Logger, set up 

contest etc. 
 If 2nd Entry Window is not shown, hit 

the \ key (backlash key) 

Selected 
Mode 

Radios 
Attached 

Choices Selection 

SO2R none SO2R - Left Manual, Right Manual  
Automatically 

selected 

SO2R 
1 

(Kenwood) 

sO2R - Left Manual, Right 
Kenwood Com1 
SO2R - Left Kenwood Com1, Right 
Manual  

Select one 

SO2R 
2 

(Kenwood & 
FT847) 

SO2R - Left Kenwood Com 1, 
Right FT847 Com 2 
SO2R - Left FT847 Com1, Right 
Kenwood Com 2  

Select one 



Selected 
Mode 

Radios 
Attached 

Choices Selection 

SO2V 
1 

(Kenwood) 
SO2V - Kenwood  

Automatically 
selected 

1.5.7.1. LPT Keying 

When operating SO2V, and using LPT port keying, the Radio Nr in the LPT port 
configuration must be set to Both.  

When operating SO2R, and using a single LPT port for keying, the Radio Nr in the LPT 
port configuration must be set to Both. This configuration will require an external box to 
switch the keying line between the two radios. The external box can be controlled using 
LPT pin 14.  

When operating SO2R and using a separate LPT port for each radio, the Radio Nr in 
each LPT port configuration must be set to The corresponding radio, 1 or 2.  

1.5.7.2. Winkeyer and WinkeyerUSB keying 

When operating SO2R, and using Winkeyer, the Radio Nr in the Winkeyer COM port 
configuration must be set to Both.  

When operating SO2R, and using a single Winkeyer port for keying and PTT, the Radio 
Nr in the Winkeyer COM port configuration must be set to Both. This configuration will 
require an external box to switch the keying line between the two radios. The external 
box can be controlled using LPT pin 14.  

When operating SO2R and using Winkeyer's 2nd CW and PTT Outputs (available in 
later models), the Radio Nr in the Winkeyer COM port configuration must be set to Both.  

1.5.8. SO2R Radio Support 

All supported radios will work with SO2R. N1MM Logger will allow you to use any 
combination of computer controlled and non-computer controlled radios. If you use a 
radio that is not supported or has no radio control, do not set up a radio COM port. You 
only set up that information when you have a computer controlled radio.  

1.5.9. Using External SO2R Controllers 

N1MM Logger is compatible with most older hardware SO2R controllers using the LPT 
port such as the Top Ten Devices "DX Doubler", and the Array Solutions "SO2R 
Master". These products will automatically switch keying, PTT and audio lines between 
radios. New products like the microHAM MK2R can be fully controlled via USB or via an 
LPT port. The EZmaster from Ham Radio Solutions is only supported using its LPT port 
and not its USB port.  

Controllers using the LPT port will require a straight-through DB-25 cable from your LPT 
port of your computer to the input DB-25 connector.. For hooking up the rest of the 
keying and audio lines, consult their respective manuals. All products use the same pin-
outs on the LPT port.  



To get N1MM Logger to correctly key and control these devices, you need to set up 
your keying as follows:  

1.5.9.1. LPT Keying with External SO2R Controllers Using LPT Port 

 Open Config >Configure Ports, Mode Control, Other >Hardware tab  
 Check LPT keying box - check only one LPT box unless using another one for 

antenna selection control  
 Click on the corresponding "Set" button for the LPT port  
 Click on "Radio Nr" drop down box and select "Both"  
 Click on OK to set configuration  

× 

 Modifying the DX Doubler  

There were a couple of errors on the DX-doubler PC board. Go to: this site  to see the 
DX Doubler modifications. 

XXXXX  

1.5.9.2. Using Winkeyer and WinkeyerUSB 

The original Winkeyer, used a RS-232 COM port, and is not a USB device. Winkeyer 
has an internal pin 3 output, which is normally CW for 1 radio, and an internal pin 5 
which is normally PTT for a single radio. Under N1MM Logger software control, pin 3 
can set for Radio 1 CW output and Pin 5 can be set for Radio 2 CW output. The virtual 
serial port assigned to the Winkeyer USB device should have the "Hardware" tab "Set" 
and Winkeyer checked and Radio Nr set to 'Both'. Then go to the "Winkeyer" tab and 
set Pin 5 function to "2nd CW"  

The "K" output on the Winkeyer board goes to Radio 1 CW and the "P" output goes to 
Radio 2 CW. N1MM Logger takes care of all the switching provided you activate the 
proper radio.  

The WinkeyerUSB (sometimes called "Winkeyer 2") has separate CW and PTT outputs 
for each radio. The 2nd radio CW is enabled from the Winkeyer tab "Use 2nd Output".  

1.5.10. SO2R Using the DX Doubler 

old-edit  

1.5.10.1. Setting Internal DXD Jumpers to Enable Stereo Feature 

Thanks to W4NZ, long-time N1MM and DXDoubler user, for the following:  

Here is my baseline configuration - the one that has been working for me in contests for 
quite a while. This is also compatible with all the SO2R features in N1MM. Control of the 
DXD is from a hardware LPT port.  

Jumper 1: 2-3  
Jumper 2: 5-6  
Jumper 3: 9-10  

http://www.qth.com/topten/appnotes.htm


Coincidentally, these are the same as the jumper settings for the "NA" software as 
shown in the DXDoubler manual.  

If you change the jumper settings to those shown in the DXD manual for CT/TR/WL,  

Jumper 1: 1-2  
Jumper 2: 4-5  
Jumper 3: 8-9  

then testing the SO2R features, N1MM Entry window focus moves to the correct radio 
just as it should but the DXD does not automatically switch radios (RX audio/TX focus) 
to follow the window focus. However, the DXD can be switched manually by using the 
PAUSE key or CONTROL + Left/Right Arrow. The Backslash key (\) also moves focus 
without switching the DXD.  

With the NA jumper settings, now you can use the "tilde" key (~/`) to toggle stereo audio 
(Left radio-left ear/Right radio-right ear) on and off.  

You can use the macros {STEREOON} {END} {STEREOOFF} in Function Key 
Messages) to switch the audio automatically according to the operator's preference. 
Refer to this page for more details.  

Example for F1 - CQ Message: {STEREOON} CQ TEST * * TEST {END} 
{STEREOOFF}. This sequence will turn on Stereo during transmission of the CQ so 
that you can listen on the second radio, and then go back to both ears on the CQing 
radio when the CQ finishes. Note that the {END} macro is required, because otherwise 
the {STEREOOFF} macro will be executed before the CW is sent.  

1.5.11. LPT Port Basic SO2R Controller Design 

old-edit  

A basic SO2R controller design ... it's about as simple as there is but it works well with 
N1MM (or Writelog) in LPT mode. I decided to add support for CW from the LPT - the 
PTT relay can be replaced with a SPDT relay if CW is taken from two COM ports or 
Winkeyer USB is used (better). Joe, W4TV - 5/30/2009 - Revision 1.0  

1.5.11.1. Basic SO2R LPT Port - Receive Interface 

http://n1mmplus.hamdocs.com/tiki-index.php?page=Macros


 
 
 

1.5.11.2. Basic SO2R LPT Port - Transmit Interface 



 
 
 
 

1.5.12. Focus on Other Radio (FocusOther) 

old-edit  

A method of focus control, preferred by many contesters. When FocusOther is active, 
the RX focus is automatically shifted between the "Run" radio and the "S&P" radio, 
depending on whether the Run radio is transmitting. When the Run radio is transmitting, 



RX focus is shifted to the S&P radio. When the Run radio stops transmitting, RX focus 
shifts back to the Run radio, unless an unworked callsign has been entered in the S&P 
entry window. This allows a callsign to be entered in the S&P radio Entry Window while 
CQ is being sent on the Run radio.  

1.5.13. SO2R and MMTTY 

old-edit  

Instructions for setting up two copies of MMTTY for use in SO2R (Note: there are more 
detailed instructions on setting up for digital modes in the Digital Modes section - this 
section focuses on the SO2R aspects):  

 Create two separate folders for the two copies of MMTTY. This allows each copy 
to have its own configuration  

o Copy the MMTTY.exe, MMTTY.ini and UserPara.ini files (plus extfsk.dll if 
you use EXTFSK, or extfsk64.fsk if you use EXTFSK64) from the main 
MMTTY program folder into each of the two folders you will use for SO2R  

 Start N1MM Logger+ and open the Configurer (Config > Configure Ports, Audio, 
Mode Control, Other)  

 Select the Digital Modes tab  
o Under Digital Interface 1, TU Type, select Soundcard. Similarly for Digital 

Interface 2  
o Under DI-1 MMTTY Setup, select AFSK or FSK as appropriate for your 

setup and set the MMTTY Path to point to the copy of MMTTY.exe in the 
first folder  

o Under DI-2 MMTTY Setup, select AFSK or FSK as appropriate and set the 
MMTTY Path to point to the copy of MMTTY.exe in the second folder  

 Select the Hardware tab  
o Select the SO2R option  
o This next step is optional for many users, but mandatory for some. If you 

are using serial ports for PTT and/or FSK from MMTTY, you may need to 
check the Digital check box beside the ports used by the two copies of 
MMTTY. This step is necessary if you use the same port for CW or PTT 
keying from N1MM Logger in CW or SSB modes; if the only place you use 
a port is from MMTTY, this step is unnecessary  

 Click on the Set button for the port you will use with Radio 1 and set 
the Radio Nr and the Dig Wnd Nr both to 1  

 Click on the Set button for the port you will use with Radio 2 and set 
the Radio Nr and the Dig Wnd Nr both to 2  

 Close the Configurer  
 Open the Digital Interface 1 Window (Window > Digital Interface menu item in the 

main or Radio 1 Entry window)  
o If an MMTTY window does not appear (e.g. if you see an MMVARI 

window instead), then in the DI Window select the Interface > MMTTY 
menu item to open the MMTTY window  

o Select the Setup > Settings menu item  
 Under Preferred RTTY Interface (lower left), select MMTTY  



 Under Alignment Frequency (lower right), enter your Mark audio 
frequency (e.g. 2125)  

 Click on Save Configuration  
o In the DI Window, select the Setup > Setup MMTTY menu item  

 Select the TX tab and set the PTT & FSK port you will be using for 
the Radio 1 copy of MMTTY  

 Select the SoundCard tab (MMTTY version 1.66 or newer) and 
select the Reception sound card you will use with Radio 1. If you 
are using AFSK, you must also select the Transmission sound card  

 Under the Misc tab, select the channel (left or right) under Source. 
If you are using an older version of MMTTY, you may also have to 
set the Device numbers (this is not necessary if you have selected 
the sound card using the SoundCard tab)  

 Close the MMTTY Setup window  
 If the second Entry window is not open, open it by pressing the Pause key, the 

backslash (\) key or Ctrl+Right Arrow. In this window, select the Window > Digital 
Interface menu item to open the second Digital Interface window. Repeat the 
above steps using the COM port, sound card device and channel you will use 
with Radio 2  

 

1.5.13.1.1. SO2R RTTY with 1 Soundcard  
old-edit  

If you have a two-channel sound card and the necessary cabling to send audio output 
from both radios to the line input of the same sound card (left radio on the left channel, 
right radio on the right channel), you may be able to use a single sound card for SO2R 
RTTY. Just set both MMTTY instances to the same card, and in the configuration for 
each copy of MMTTY select the appropriate channel for that radio. Note that for AFSK 
transmit, MMTTY only uses the left channel regardless of which channel it is using on 
receive. Therefore if you are using AFSK for transmitting you will have to route the 
audio output from the left channel of the sound card to the audio inputs on both radios 
and rely on the SO2R switching to control which radio gets PTT.  

If your sound card does not support separate inputs for the two channels, such as a 
laptop sound card with only a mono mic input, you won't be able to do this and you will 
have to use two sound cards for SO2R.  

1.5.13.2. Example Screen Layouts 

old-edit  

Below two screen shots for SO2R. Notice the window symmetry for left and right VFO, 
as well as left and right band map. Essential information that is used by both radios was 
placed in the center: Check Window and Log Window. Of course other operators may 
have different preferences regarding window layout - but the most intuitive is to have the 
window layout reflect the equipment configuration.  



 
 
 
 
The screen above was taken by K2KW from a 17" screen.  

 
 
 
 
The screen shot above was taken by F6IRF and gives an example of a SO2R screen 
for RTTY.  

 

2.8.2 SO2R - Single Operator Two Radio Operation 
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o 14. Focus on Other Radio (FocusOther)  
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 15.1. SO2R RTTY with 1 Soundcard  

o 16. Example Screen Layouts  

1. SO2R Basics 

in-edit  
Single Operator 2 Radio (aka SO2R) is an operating technique that when done 
properly, can add many extra QSOs and multipliers to your log. This is accomplished by 
increasing your efficiency during slow times, for example, when you are CQing on one 
radio, but getting few answers. Efficiency is increased by listening on a 2nd radio while 
you are transmitting on the 1st radio. On the 2nd radio you are scanning the bands for 
needed QSOs and multipliers. If you find a new station to work on the 2nd radio, you 
leave it staged on the 2nd Entry Window until you get a free moment to work this 
station. Even adding a few QSOs an hour will greatly boost your score.  

The philosophy for SO2R development is to allow any two radios to be used; they do 
not have to be identical. In its most simple form, two transceivers feed two separate 
antennas on two different bands. With sufficient attention to antenna separation and 
filtering, it is possible to do this without interference from a transmitting radio to a 
receiving radio. Many serious SO2R operators use identical radios to reduce the 
confusion factor, but having identical radios isn't necessary.  

The receiver on one band is used to locate new contacts during the time that the 
transmitter on the other band is active. This can mean that you tune the 2nd radio while 
N1MM Logger sends CQ on the 1st radio. The most critical requirement for SO2R is 
automated transmission — if you have to speak into a microphone or squeeze a paddle 
while you tune the receiver you will not make the most of the second radio. It's easy to 
reach a level of mental fatigue while operating SO2R that results in an overall score 
reduction rather than helping your score.  

If your radio is not supported by N1MM Logger, or it's an older radio with no computer 
interface, the radio can still be used, but you just don't get many of the advantages 
automated radio control offered by N1MM Logger.  

N1MM Logger also supports "Single Operator 2 VFOs", or SO2V. If your radio simply 
has 2 VFOs, VFO A/B will be assigned to each of the two Entry Windows. If you have a 
radio with a sub-receiver, each of the receivers gets assigned to each of the Entry 
Windows. When developing the specs, we actually felt SO2V would be more widely 
used than SO2R.When operating SO2V (and SO2R), you also need to change your 
LPT or Winkeyer keying from Radio 1 (default) to BOTH. Otherwise, you will not get any 
keying on VFO B or Radio 2.  

N1MM Logger's SO2V interface is essentially identical to the SO2R interface, but with 
SO2V you are using a single radio. Two windows can be displayed in SO2V, one for 
VFO A & B. SO2V makes better use of the 2nd receiver now present in most high-end 
radios. With the 2nd receiver, you can be tuning the band while you are listening for a 



response to your CQ. Since you cannot listen on the sub-receiver while transmitting, 
SO2V is not as efficient as SO2R.  

A maximum of two radios are supported with N1MM Logger using a single computer. 
There is a workaround for 2-computer 2-radio SO2R, explained below.  

For the new SO2R operator, we have 3 words for you: practice, practice, practice! 
SO2R is definitely a learned skill that takes time to learn, and even longer to master.  

1.1. Two-Computer SO2R 

old-edit  

Some operators, particularly on RTTY, prefer to use separate computers for SO2R. This 
is not explicitly supported by N1MM Logger, but there is a way.  

First, be sure both computers are running the same version of N1MM Logger. Turn on 
Networked-Computer mode (Config >Networked-Computer Mode), and configure the 
network between your computers as explained in the section on Network Setup and 
Configuration?. Then set up your contest class as Multi-One.  

Set your lockout style under Config >Multi-User Tools as explained here?  

 First One Wins  
o UNCHECK >Multi-User Tools >Force Other Station to Stop Transmitting 

When I Transmit  
o UNCHECK >Multi-User Tools >Block My TX Only if Other Stn 

Transmitting on Same Band & Mode (Multi-One)  
 Last One Wins  

o CHECK >Multi-User Tools >Force Other Station to Stop Transmitting 
When I Transmit is CHECKED  

o UNCHECK >Multi-User Tools >Block my TX Only if Other Stn 
Transmitting on Same Band & Mode (Multi-One)  

 
Please note that a number of N1MM Logger's advanced SO2R features cannot be used 
in this style of SO2R operation,. The list includes Ctrl+Fx (send Fx on the opposite 
radio), {CtrlFx} (the same as a macro), dueling CQs, Advanced SO2R and FocusOther. 
All of these require both radios to be connected to the same computer. Serial 
numbering, if used, will conform to the Multi-Single rules for the contest in question.  

Don't forget to change your entry class back to Single Op or Single Op Assisted in the 
Contest Setup window before you generate your Cabrillo file.  

× 

 Users Please Note 

Please be aware that the developers will not implement Feature Requests or respond to 
Bug Requests that result from 2-computer SO2R's not conforming to single-computer 
SO2R expectations.  

http://n1mmplus.hamdocs.com/tiki-editpage.php?page=Networked-Computer+Support
http://n1mmplus.hamdocs.com/tiki-editpage.php?page=SO2R


2. Intuitive User Interface 

old-edit  

As you will quickly see, N1MM Logger's SO2R implementation is more intuitive than 
most other SO2R implementations:  

 Entry Windows can be arranged to reflect equipment layout  
 Entry Windows can be used for any function (not dedicated functions like others)  
 You always know what each VFO or radio is going to send next (when in ESM 

mode)  
 Visual cues identifying transmit focus, Run vs. S&P, and more!  

3. Supported Features 

old-edit  

N1MM Logger supports all of the features you would expect from any world-class SO2R 
software. In addition, there are a lot of unique features:  

 Two Entry windows are displayed that are fully interchangeable in functionality 
(windows are not dedicated to a specific task)  

 Running and S&P modes are maintained for each SO2R Entry window, such that 
the 2 windows can be used for  

o Running / S&P  
o S&P / Running  
o S&P / S&P  
o Running / Running  

 Entry windows can be arranged on screen as desired: typically left/right, or 
top/bottom, to represent physical station layout  

 Each Entry Window has a frequency readout in the top pane  
 'LEDs' identify which radio has focus. The sending radio has a red LED indicating 

TX Focus, a green LED identifies the radio that has RX and Keyboard focus 
(combined)  

 Background colors of the entry field change color depending on whether that 
radio is running or S&P: white = run; canary = S&P  

 Ability to change frequency of inactive radio from the active radio. Use the / 
before entering the frequency in the callsign field to enter frequency for other 
radio/VFO  

 Supports Enter Sends Messages Mode (ESM) on both windows  
 Typing a call in inactive radio Entry window does not abort sending on the active 

radio  
 Hitting Escape stops sending on either VFO or radio, but does not change 

keyboard focus  
 Changing transmit focus (for any function) stops sending before switching and 

sending on alternate radio  
 Ctrl+function keys and Ctrl+Enter sends messages on alternate radio 

(Concept is Ctrl = Alternate radio control)  



 "Hotkey's" for specific tasks and sending on alternate radio  
 All Key Assignments work on both radios (unless otherwise specified)  
 Supports Top Ten DX Doubler, WX0B Station Master, Microham MK2R, YCCC 

SO2R, and other SO2R controllers.  
 Support SO2R without interfaced radios.  
 Dueling CQ's will send CQ alternately on each radio (Ctrl+B)  

o If dueling CQ's is enabled, and CQ sent then both radios become Run 
radios  

o Ctrl+F1 or Ctrl+Enter will not start Dueling CQ  
o Dueling SSB and CW CQ's (different modes in each Entry window) are 

supported  
o When you disable Dueling CQs, the pre-existing SO2R options are 

restored  
 A SO2R software radio lockout for is implemented  
 CQ-repeat is terminated when a message is sent on the other radio  
 The macro {JUMPRX} changes the receive focus to the other input window  
 Supports 2 radios - No support for 3 or more radios  
 Support SO2R with zero, one or two sound cards (5$ SO2R)  
 When changing band using Ctrl+PgUp/Down key will skip the other radio's band  

o THIS IS NOT A SUBSTITUTE FOR HARDWARE LOCKOUT!!  
 The sent CW will echo in the status bar of the Entry Window (only when in 

SO2R)  
 During VOX operation, in "$5 SO2R" operation the TX audio should will track the 

TX focus all the time  

 
There is currently no support for two networked computers for SO2R.  

4. Entry Windows 

old-edit  

Entry windows can be placed anywhere on the screen. Typically people will position 
them similar to their equipment layout i.e. if the radios are positioned left/right, the 
windows are arranged reflect that. For those who stack their equipment top/bottom, you 
can position the screens so they logically mirror that radio setup too.  

Screen real estate is in short supply. To minimize screen real estate, you can shrink the 
Entry Windows compared to the default layout. Below is an example of the default Entry 
Window and a minimized version. Also the use of two monitors more screen real estate.  



 

 

 
 
To launch the 2nd Entry Window, hit the \ button.  

Most people who are comfortable with N1MM Logger+ tend to use the reduced size 
Entry Windows for the second radio or VFO.  

All of the features that are available to the single radio operator also work in 
SO2R/SO2V. For example, when tuning the band with the S&P VFO, spots that are in 
the bandmap are automatically inserted into each call frame (above the callsign in the 
Entry window) when you tune across the frequency of the spot. Hitting the Space bar 
will pull the callsign from the call frame into the callsign field. If a station calls you on the 
run radio, toggling back and forth between Entry Windows with the \ key or Ctrl 
Left/Right arrows will maintain the all of the information in each Entry Window until the 
respective stations are logged, wiped clean via Alt+W or Ctrl+W, or you QSY and the 
callsign is entered into the bandmap (if "QSYing wipes the call && spots QSO in 
bandmap" is implemented).  

5. The SO2R Dots (LEDs) 

 
On the Entry Window a green and/or a red dot (LED) will be shown. The LEDs are 
visual aids that help you easily identify what is happening on each radio. This is part of 
N1MM's continuing philosophy of letting the operator easily know what's happening at 
any give time.  

The green LED indicates that the VFO or radio has receive/entry focus and the red LED 
indicates that VFO has transmit (TX) focus. In addition, the red TX LED changes 
between dark red (not transmitting) and yellow (VFO/radio is transmitting).  

5.1. Dot/LED Colors Used: 



Green dot/LED - This VFO/Radio has receive (RX) and entry focus. RX and entry focus 
are always together.  

 Receive focus can be toggled between the VFOs/radios by  
o using a mouse to click on the background of one of the two Entry windows  
o pressing the \ key (backslash)  

 To move both Transmit and Receive focus  
o Press Pause or Ctrl+Left-Arrow / Ctrl+Right-Arrow to move both foci 

between the left and right radios.  

Red dot/LED - This VFO/Radio has transmit (TX) focus. This means that the radio or 
VFO either is transmitting or was the last to transmit, and will be the one that transmits 
if you transmit by means other than pressing a function key. When the other window 
has entry focus and you press a function key to send a stored message, the transmit 
focus shifts to that radio as soon as the function key is executed.  

 Pressing Pause or Ctrl+Left-Arrow / Ctrl+Right-Arrow will move both foci 
between radios. If the foci are split, the first press of Pause moves the Transmit 
focus to the radio with the receive focus; thereafter, both foci will move together 
each time it is pressed.  

 When transmitting the TX focus can not be changed.  

6. Key Assignments (unique to SO2R) 

× 

 "Sticky" options  

The Focus Other (Ctrl+Shift+K) and Ctrl+Fx settings, whether controlled through 
keyboard shortcuts or through the SO2R sub-menu of the Configurer, are "sticky" - that 
is they are remembered the next time the program is opened. This can surprise you if 
you don't remember having set them. 

6.1. Entry Window Features 

Many of these features are shared between SO2R and SO2V operation.  

 Backslash ( \ ) - Launches a second Entry Window if only one Entry window is 
open  

o One radio - Moves RX focus between the 2 VFOs on the radio  
o Two radios - Moves RX focus between the 2 radios  

 Ctrl+Enter - Send next ESM state on alternate radio or VFO (assuming ESM 
turned on)  

 Ctrl+F1 to F8 - Send Fn message on alternate radio or VFO.  
 Ctrl+Left Arrow - In SO2R move both Transmit and Receive/Keyboard focus to 

left radio, or in SO2V move both TX and RX/Keyboard focus to VFO A  
 Ctrl+Right Arrow - In SO2R move both Transmit and Receive/Keyboard focus 

to right radio, or in SO2V move both TX and RX/Keyboard focus to VFO B  



 Pause - Move both TX and RX Keyboard focus to other radio (or other VFO in 
SO2V). If TX and RX focus are split when you hit pause, TX focus will move to 
where the RX focus is  

 Alt+F5 - Swap radio frequency, mode, and callsigns between VFOs (SO2V) or 
radios (SO2R). In SO2R, the receive focus changes to the non-active radio.  

 Alt+F6 - Identical to Alt+F5 except the receive focus does not change. No effect 
in SO2V  

 Ctrl+B - Toggles dueling CQs on and off. Dueling CQ's will send CQ alternately 
on each radio or VFO, with the RX focus moving to the Entry window that is not 
transmitting. If Dueling CQ's is turned on, both radios become run radios. A delay 
can be inserted between each CQ by setting the "Set Dueling CQ Repeat Time" 
under the SO2R menu. Dueling SSB and CW CQ's are supported too. An icon 

denoting Dueling CQs appears in the entry windows when dueling CQs are 
actually being transmitted.  

× 

 Don't Be Labeled a Lid 

The current consensus among contesters appears to be that the practice of alternating 
CQs on two frequencies in the same band is undesirable, because spectrum space is 
already scarce enough without multiple stations each taking up two Run frequencies. If 
your radio(s) can do it, better to reserve use of this feature for CQing on two different 
bands. 

 Backquote (grave accent or unshifted tilde key (~) - Toggle STEREO mode 
on/off, or toggle Auto/PTT modes with modified DXD . Notes: On US keyboards, 
the key we are talking about is the key just to the left of the number 1 key.  

 Ctrl+PgUp/Down - When changing band using Ctrl+PgUp/Down will skip the 
other radio's band  

o THIS IS NOT A SUBSTITUTE FOR HARDWARE LOCKOUT!  
 Ctrl+Shift+K - FocusOther, Another method of focus control (Focus on Other 

Radio), preferred by many contesters over "Advanced SO2R". When FocusOther 
is active, the RX focus is automatically shifted between the "Run" radio and the 
"S&P" radio, depending on whether the Run radio is transmitting. When the Run 
radio is transmitting, RX focus is shifted to the S&P radio. When the Run radio 
stops transmitting, RX focus shifts back to the Run radio, unless an unworked 
callsign has been entered in the S&P entry window. This allows a callsign to be 
entered in the S&P radio Entry Window while CQ is being sent on the Run radio.  

 Ctrl+Shift+L - This enables/disables the use of {CTRLFx} in function key 
macros. {CTRLFx} is a convenient way to automatically send a function key on 
the alternate radio. For example, by programming your S&P F4 key to "* 
{CTRLF1}", your call will be sent on the S&P radio, immediately followed by your 
CQ message on the Run radio.  

6.2. Bandmap Features 



 Shift+Click on frequency (SO2R only) - Jump to that frequency on the inactive 
radio, without changing TX or RX focus. This allows you to be active and sending 
on one radio and change the frequency on the other radio without making it the 
active radio.  

 Shift+Click on bandmap callsign (SO2R only) - Send the frequency to the 
inactive radio and place the callsign on the other radio's callsign frame, without 
making it the active radio.  

6.3. Using SO2R Key Assignments 

Backslash ( \ ) - Once you have launched your second Entry Window, the \ key will 
likely be your most widely used key in SO2R. The \ key will move RX and Entry focus 
between Entry Windows A & B (often referred to as Radio 1 & Radio 2 respectively). 
When using the \ key to control RX focus, you really don't have to worry where TX focus 
is. By using the \ key to control only RX focus, when you hit a Fn key or Enter (using 
ESM), the TX focus will move to where the RX focus is, and send the corresponding 
message.  

Example: You are CQing on Radio 1, and S&Ping on Radio 2. Both RX and TX focus 
start off in your Run Entry Window (Radio 1 in this example). You are S&Ping on Radio 
2, and you hear someone on the S&P radio you want to look up in your Check Window. 
Hit the \ key to move RX focus to the S&P Entry Window. You type in the call, and you 
need it, and are just waiting for a good time to send your call. If no one is answering 
your CQ on the Run Radio, just hit the Enter Key (assuming you are using ESM), and 
the TX focus will move from the Run Radio to the S&P radio (Radio 2), and send your 
callsign (actually the first ESM message in the S&P sequence). If the station comes 
back to you, then hit Enter again to send your exchange, and you just completed a S&P 
QSO. Now move the RX focus with the \ key to the Run radio, or just leave it in the S&P 
Entry Window if S&P is more productive.  

Now let's assume in the middle of the S&P QSO, someone answers your CQ on Radio 
1. Your exchange just happens to be sending on the S&P radio. To copy the call on the 
Run Radio (while your exchange is being sent on the S&P radio), hit the \ key to move 
RX focus to the Run Radio, and type his call in the Run Entry Window. Assuming your 
exchange is finished sending on Radio 2, just hit Enter again, and the TX focus will 
move back to the Run Radio, and the program will send his call and your exchange on 
the Run Radio. You now have QSOs going on both radios! Just move RX focus as 
needed to send/copy on what ever radio you need. This is easier said, than done during 
a contest !  

× 

 Tracking TX Focus 

In the above examples, you never have to control where TX focus is, since TX focus 
always moves automatically to where the RX focus is when Fn or Enter (ESM) is used. 
This should be your standard operating mode, as you only need to worry about using a 
single key to do most of your navigation between the two Entry Windows. 



 
Ctrl+Enter, or Ctrl+Fn - Using these commands will send the corresponding message 
on the alternate radio; with the alternate radio defined as the radio that does not have 
RX focus. Using Ctrl+Fn (or Ctrl+Enter) will only move the TX focus to send the 
message - RX focus will stay in it's current location. Once the message is sent, TX 
focus will remain on the alternate radio. This is done by design.  

The most common scenario would be if you are CQing on Radio 1, but you are not 
getting callers. You hit the \ key to copy a callsign on the S&P radio. Without moving the 
RX focus from the S&P radio, at some point you will probably want to send another CQ 
on the Run Radio. You do this by hitting Ctrl+F1 or Ctrl+Enter. You will also likely use 
these commands if you have a QSO in progress at the same time on both the Run and 
S&P radio. The easiest way to send a message at the right time on the other radio is to 
use these commands, and leave RX focus where it is. Alternatively, you can program 
function keys with the {CTRLFx} macro to send messages to the other radio.  

Pause Key - If both TX and RX focus are in the same Entry Window, hitting Pause will 
move both TX and RX focus to the other radio. If TX and RX focus are split between the 
Entry Windows, the pause key will move TX focus to where RX focus is. Mostly you will 
use this key in order to get your foci back in sync.  

Ctrl+Right Arrow and Ctrl+Left Arrow - These commands will force both TX and RX 
focus to the right or left radio.  

Ctrl+B - Toggle Dueling CQ's.  

{CTRLFn} macro - This macro allows the user to send on the other radio.  

 Make sure that "Toggle {CTRLFx}" macro is checked on in the Configurer SO2R 
submenu (or use Ctrl-Shift-L to enable/disable the use of {CTRLFx} macros. 
When disabled, the {CTRLFx} macro is ignored.  

 Thus, a CW Button might look like: "tu EXCH{CTRLF9}" Where F9 on the other 
radio is set to send a CQ.  

 Example: If your entry focus is on the S&P radio and you manually press 
Ctrl+F1, the program will send F1 on the OTHER radio. That's all the {CTRLFx} 
macro does. For a simple test, modify your S&P F4 key to read *{CTRLF1}. Now, 
when you press that key, the program sends your call on the S&P radio and then 
sends the contents of F1 on the Run radio. In a practical situation, you would 
probably not want to send a full-length CQ while trying to work someone on the 
S&P radio, because that will nearly always require you to interrupt it before it is 
done. So the idea of {CTRLFx} is that you can stash a short CQ (like "N1MM 
test"} in, for example, Run F12. Then make S&P F4 read "* {CTRLF12}. Now 
when you press F4 on the S&P radio, it will send your call, and immediately 
switch to the Run radio and send F12, that very short CQ. Should help hold your 
frequency.  

 Another way to use this: Make your S&P F2 read, for example, 5NN14{CTRLF1}. 
Then when you press F2 or Enter to send your exchange and/or log the S&P 
QSO, the program will automatically begin a CQ on the Run radio as soon as 
that is done.  



7. Mouse Assignments 

 Left mouse and Right mouse buttons_  
o On an empty space in one of the two Entry windows, these mouse buttons 

change the Receive focus to that radio/VFO  

8. SO2R Menu 

 SO2R  
o Dueling CQ's Ctrl+B - will send CQ alternately on each radio  
o Set Dueling CQ Repeat Time  
o Focus on Other Radio - A method of focus control, preferred by many 

contesters over "Advanced SO2R". When FocusOther is active, the RX 
focus is automatically shifted between the "Run" radio and the "S&P" 
radio, depending on whether the Run radio is transmitting. When the Run 
radio is transmitting, RX focus is shifted to the S&P radio. When the Run 
radio stops transmitting, RX focus shifts back to the Run radio, unless an 
unworked callsign has been entered in the S&P entry window. This allows 
a callsign to be entered in the S&P radio Entry Window while CQ is being 
sent on the Run radio.  

o FocusOther Always Swap - Used in conjunction with Focus on Other 
Radio. When FocusOther Always Swap is enabled, RX focus will always 
shift back to the Run radio when the Run radio stops transmitting.  

o Toggle CTRLFx Macro - This enables/disables the use of {CTRLFx} in 
function key macros.  

o TX Lockout ((Digital) - Select a lockout item ((Digital modes only)  
 Multi-TX - This is the default setting. Start CQ on radio A, Start CQ 

on radio B, both are active. (no lockout)  
 First one wins - Start CQ on radio A, pause, Start CQ on radio B. 

The radio B CQ is ignored since radio A is already active, so if you 
press a F-key for the second radio while radio1 is transmitting, the 
radio B F-key is ignored  

 Last one wins - Start CQ on radio A (CQ starts), pause, Start CQ 
on radio B. The CQ on radio A will aborted and the CQ on radio B 
will start so if you press a F-key for the second radio while radio A 
is transmitting, the radio A transmission is interrupted and radio B 
transmits  

9. Software Setup 

Setting up SO2R and SO2V starts in the Config menu:  

 Config > "Configure Ports, Telnet Address, Other" > Hardware Tab  

Then if SO2R: Then if SO2V: 



 Set up radios 
 Set up keying if necessary (Serial 

port, LPT port or Winkeyer) 
 Click SO2R button 
 Click OK to close out. 
 Launch N1MM Logger, set up 

contest etc. 
 If 2nd Entry Window is not shown, hit 

the \ key (backslash key) 
 SO2R - 1 computer radio + 1 manual 

radio (so two radios) 
 SO2V - 1 computer radio with 2 

VFOs and no manual radio (so one 
radio) 

 Set up radio 
 Set up keying if necessary (Serial 

port, LPT port or Winkeyer) 
 Click SO2V button 
 Click OK to close out. 
 Launch N1MM Logger, set up 

contest etc. 
 If 2nd Entry Window is not shown, hit 

the \ key (backlash key) 

Selected 
Mode 

Radios 
Attached 

Choices Selection 

SO2R none SO2R - Left Manual, Right Manual  
Automatically 

selected 

SO2R 
1 

(Kenwood) 

sO2R - Left Manual, Right 
Kenwood Com1 
SO2R - Left Kenwood Com1, Right 
Manual  

Select one 

SO2R 
2 

(Kenwood & 
FT847) 

SO2R - Left Kenwood Com 1, 
Right FT847 Com 2 
SO2R - Left FT847 Com1, Right 
Kenwood Com 2  

Select one 

SO2V 
1 

(Kenwood) 
SO2V - Kenwood  

Automatically 
selected 

9.1. LPT Keying 

When operating SO2V, and using LPT port keying, the Radio Nr in the LPT port 
configuration must be set to Both.  

When operating SO2R, and using a single LPT port for keying, the Radio Nr in the LPT 
port configuration must be set to Both. This configuration will require an external box to 
switch the keying line between the two radios. The external box can be controlled using 
LPT pin 14.  

When operating SO2R and using a separate LPT port for each radio, the Radio Nr in 
each LPT port configuration must be set to The corresponding radio, 1 or 2.  

9.2. Winkeyer and WinkeyerUSB keying 



When operating SO2R, and using Winkeyer, the Radio Nr in the Winkeyer COM port 
configuration must be set to Both.  

When operating SO2R, and using a single Winkeyer port for keying and PTT, the Radio 
Nr in the Winkeyer COM port configuration must be set to Both. This configuration will 
require an external box to switch the keying line between the two radios. The external 
box can be controlled using LPT pin 14.  

When operating SO2R and using Winkeyer's 2nd CW and PTT Outputs (available in 
later models), the Radio Nr in the Winkeyer COM port configuration must be set to Both.  

10. SO2R Radio Support 

All supported radios will work with SO2R. N1MM Logger will allow you to use any 
combination of computer controlled and non-computer controlled radios. If you use a 
radio that is not supported or has no radio control, do not set up a radio COM port. You 
only set up that information when you have a computer controlled radio.  

11. Using External SO2R Controllers 

N1MM Logger is compatible with most older hardware SO2R controllers using the LPT 
port such as the Top Ten Devices "DX Doubler", and the Array Solutions "SO2R 
Master". These products will automatically switch keying, PTT and audio lines between 
radios. New products like the microHAM MK2R can be fully controlled via USB or via an 
LPT port. The EZmaster from Ham Radio Solutions is only supported using its LPT port 
and not its USB port.  

Controllers using the LPT port will require a straight-through DB-25 cable from your LPT 
port of your computer to the input DB-25 connector.. For hooking up the rest of the 
keying and audio lines, consult their respective manuals. All products use the same pin-
outs on the LPT port.  

To get N1MM Logger to correctly key and control these devices, you need to set up 
your keying as follows:  

11.1. LPT Keying with External SO2R Controllers Using LPT Port 

 Open Config >Configure Ports, Mode Control, Other >Hardware tab  
 Check LPT keying box - check only one LPT box unless using another one for 

antenna selection control  
 Click on the corresponding "Set" button for the LPT port  
 Click on "Radio Nr" drop down box and select "Both"  
 Click on OK to set configuration  

× 

 Modifying the DX Doubler  

There were a couple of errors on the DX-doubler PC board. Go to: this site  to see the 
DX Doubler modifications. 

http://www.qth.com/topten/appnotes.htm


XXXXX  

11.2. Using Winkeyer and WinkeyerUSB 

The original Winkeyer, used a RS-232 COM port, and is not a USB device. Winkeyer 
has an internal pin 3 output, which is normally CW for 1 radio, and an internal pin 5 
which is normally PTT for a single radio. Under N1MM Logger software control, pin 3 
can set for Radio 1 CW output and Pin 5 can be set for Radio 2 CW output. The virtual 
serial port assigned to the Winkeyer USB device should have the "Hardware" tab "Set" 
and Winkeyer checked and Radio Nr set to 'Both'. Then go to the "Winkeyer" tab and 
set Pin 5 function to "2nd CW"  

The "K" output on the Winkeyer board goes to Radio 1 CW and the "P" output goes to 
Radio 2 CW. N1MM Logger takes care of all the switching provided you activate the 
proper radio.  

The WinkeyerUSB (sometimes called "Winkeyer 2") has separate CW and PTT outputs 
for each radio. The 2nd radio CW is enabled from the Winkeyer tab "Use 2nd Output".  

12. SO2R Using the DX Doubler 

old-edit  

12.1. Setting Internal DXD Jumpers to Enable Stereo Feature 

Thanks to W4NZ, long-time N1MM and DXDoubler user, for the following:  

Here is my baseline configuration - the one that has been working for me in contests for 
quite a while. This is also compatible with all the SO2R features in N1MM. Control of the 
DXD is from a hardware LPT port.  

Jumper 1: 2-3  
Jumper 2: 5-6  
Jumper 3: 9-10  

Coincidentally, these are the same as the jumper settings for the "NA" software as 
shown in the DXDoubler manual.  

If you change the jumper settings to those shown in the DXD manual for CT/TR/WL,  

Jumper 1: 1-2  
Jumper 2: 4-5  
Jumper 3: 8-9  

then testing the SO2R features, N1MM Entry window focus moves to the correct radio 
just as it should but the DXD does not automatically switch radios (RX audio/TX focus) 
to follow the window focus. However, the DXD can be switched manually by using the 
PAUSE key or CONTROL + Left/Right Arrow. The Backslash key (\) also moves focus 
without switching the DXD.  

With the NA jumper settings, now you can use the "tilde" key (~/`) to toggle stereo audio 
(Left radio-left ear/Right radio-right ear) on and off.  



You can use the macros {STEREOON} {END} {STEREOOFF} in Function Key 
Messages) to switch the audio automatically according to the operator's preference. 
Refer to this page for more details.  

Example for F1 - CQ Message: {STEREOON} CQ TEST * * TEST {END} 
{STEREOOFF}. This sequence will turn on Stereo during transmission of the CQ so 
that you can listen on the second radio, and then go back to both ears on the CQing 
radio when the CQ finishes. Note that the {END} macro is required, because otherwise 
the {STEREOOFF} macro will be executed before the CW is sent.  

13. LPT Port Basic SO2R Controller Design 

old-edit  

A basic SO2R controller design ... it's about as simple as there is but it works well with 
N1MM (or Writelog) in LPT mode. I decided to add support for CW from the LPT - the 
PTT relay can be replaced with a SPDT relay if CW is taken from two COM ports or 
Winkeyer USB is used (better). Joe, W4TV - 5/30/2009 - Revision 1.0  

13.1. Basic SO2R LPT Port - Receive Interface 

 
 
 

13.2. Basic SO2R LPT Port - Transmit Interface 

http://n1mmplus.hamdocs.com/tiki-index.php?page=Macros


 
 
 
 

14. Focus on Other Radio (FocusOther) 

old-edit  

A method of focus control, preferred by many contesters over "Advanced SO2R". When 
FocusOther is active, the RX focus is automatically shifted between the "Run" radio and 
the "S&P" radio, depending on whether the Run radio is transmitting. When the Run 



radio is transmitting, RX focus is shifted to the S&P radio. When the Run radio stops 
transmitting, RX focus shifts back to the Run radio, unless an unworked callsign has 
been entered in the S&P entry window. This allows a callsign to be entered in the S&P 
radio Entry Window while CQ is being sent on the Run radio.  

15. SO2R and MMTTY 

old-edit  

Instructions for setting up two copies of MMTTY for use in SO2R (Note: there are more 
detailed instructions on setting up for digital modes in the Digital Modes section - this 
section focuses on the SO2R aspects):  

 Create two separate folders for the two copies of MMTTY. This allows each copy 
to have its own configuration  

o Copy the MMTTY.exe, MMTTY.ini and UserPara.ini files (plus extfsk.dll if 
you use EXTFSK, or extfsk64.fsk if you use EXTFSK64) from the main 
MMTTY program folder into each of the two folders you will use for SO2R  

 Start N1MM Logger+ and open the Configurer (Config > Configure Ports, Audio, 
Mode Control, Other)  

 Select the Digital Modes tab  
o Under Digital Interface 1, TU Type, select Soundcard. Similarly for Digital 

Interface 2  
o Under DI-1 MMTTY Setup, select AFSK or FSK as appropriate for your 

setup and set the MMTTY Path to point to the copy of MMTTY.exe in the 
first folder  

o Under DI-2 MMTTY Setup, select AFSK or FSK as appropriate and set the 
MMTTY Path to point to the copy of MMTTY.exe in the second folder  

 Select the Hardware tab  
o Select the SO2R option  
o This next step is optional for many users, but mandatory for some. If you 

are using serial ports for PTT and/or FSK from MMTTY, you may need to 
check the Digital check box beside the ports used by the two copies of 
MMTTY. This step is necessary if you use the same port for CW or PTT 
keying from N1MM Logger in CW or SSB modes; if the only place you use 
a port is from MMTTY, this step is unnecessary  

 Click on the Set button for the port you will use with Radio 1 and set 
the Radio Nr and the Dig Wnd Nr both to 1  

 Click on the Set button for the port you will use with Radio 2 and set 
the Radio Nr and the Dig Wnd Nr both to 2  

 Close the Configurer  
 Open the Digital Interface 1 Window (Window > Digital Interface menu item in the 

main or Radio 1 Entry window)  
o If an MMTTY window does not appear (e.g. if you see an MMVARI 

window instead), then in the DI Window select the Interface > MMTTY 
menu item to open the MMTTY window  

o Select the Setup > Settings menu item  
 Under Preferred RTTY Interface (lower left), select MMTTY  



 Under Alignment Frequency (lower right), enter your Mark audio 
frequency (e.g. 2125)  

 Click on Save Configuration  
o In the DI Window, select the Setup > Setup MMTTY menu item  

 Select the TX tab and set the PTT & FSK port you will be using for 
the Radio 1 copy of MMTTY  

 Select the SoundCard tab (MMTTY version 1.66 or newer) and 
select the Reception sound card you will use with Radio 1. If you 
are using AFSK, you must also select the Transmission sound card  

 Under the Misc tab, select the channel (left or right) under Source. 
If you are using an older version of MMTTY, you may also have to 
set the Device numbers (this is not necessary if you have selected 
the sound card using the SoundCard tab)  

 Close the MMTTY Setup window  
 If the second Entry window is not open, open it by pressing the Pause key, the 

backslash (\) key or Ctrl+Right Arrow. In this window, select the Window > Digital 
Interface menu item to open the second Digital Interface window. Repeat the 
above steps using the COM port, sound card device and channel you will use 
with Radio 2  

 

15.1. SO2R RTTY with 1 Soundcard 

old-edit  

If you have a two-channel sound card and the necessary cabling to send audio output 
from both radios to the line input of the same sound card (left radio on the left channel, 
right radio on the right channel), you may be able to use a single sound card for SO2R 
RTTY. Just set both MMTTY instances to the same card, and in the configuration for 
each copy of MMTTY select the appropriate channel for that radio. Note that for AFSK 
transmit, MMTTY only uses the left channel regardless of which channel it is using on 
receive. Therefore if you are using AFSK for transmitting you will have to route the 
audio output from the left channel of the sound card to the audio inputs on both radios 
and rely on the SO2R switching to control which radio gets PTT.  

If your sound card does not support separate inputs for the two channels, such as a 
laptop sound card with only a mono mic input, you won't be able to do this and you will 
have to use two sound cards for SO2R.  

16. Example Screen Layouts 

old-edit  

Below two screen shots for SO2R. Notice the window symmetry for left and right VFO, 
as well as left and right band map. Essential information that is used by both radios was 
placed in the center: Check Window and Log Window. Of course other operators may 
have different preferences regarding window layout - but the most intuitive is to have the 
window layout reflect the equipment configuration.  



 
 
 
 
The screen above was taken by K2KW from a 17" screen.  

 
 
 
 
The screen shot above was taken by F6IRF and gives an example of a SO2R screen 
for RTTY.  

 

2.8.3 Single Operator Split Operation 

old-edit  

XXX This page is simply a copy without screen shots of the corresponding page in the 
N1MM Logger Classic manual XXX  

 2.8.3 Single Operator Split Operation  

o 1. Am I Transmitting Split?  
o 2. Setting Split Transmit Frequencies Manually  
o 3. Split Mode and Frequencies Set Automatically from Cluster Spots  
o 4. Resetting to Non-Split Mode  
o 5. Split Operation Key Assignments  
o 6. Split mode vs. SO2V  

Split operation is when you transmit on a frequency different from the one where you 
are listening. This is often used when stations have huge pileups like some 
DXpeditions, or when frequency allocations do not allow people in different countries or 
IARU regions to make contact on the same frequency. An example is 40 meter SSB 
between Europe and the USA. Many European stations operate below 7.125 MHz, the 
bottom edge of the US allocation. When N1MM Logger is controlling a transceiver with 
split capability, the program enables you to split and "unsplit", to change frequencies, 
and perform other useful operations.  
When used in this manual, the term "split frequency" always refers to the transmitting 
frequency. The assumption is that you will listen first, either to identify a station to call or 
a clear listening frequency to use while running, and then set your transmit frequency.  

1. Am I Transmitting Split? 

old-edit  



There are a number of ways that the program tells you whether you are in Split mode, 
which can avoid some embarrassing moments or potentially, a citation for out-of-band 
operation. In the Entry window Split is displayed in the title bar. The receive frequency is 
always displayed first, and the transmit frequency in parentheses, as in this example.  

 

In the Bandmap, there are two sets of indicators, shown in this example.  

 

You'll notice that the receive frequency is shown in bold blue letters at the top of the 
Bandmap, and the transmit frequency is shown below it in smaller type. You are also 
reminded by the indicators for your receive frequency (always blue) and your separate 
transmit frequency (always red).  

Clicking on either the receive or transmit frequencies in the top part of the Bandmap will 
toggle split operation.  

× 

 Running While Split 

Some people prefer to be in Split mode while running, in order to use the main tuning 
knob to tune in calling stations that are off frequency. One drawback is that if you tune 
your receive frequency outside the tuning tolerance set on the "Other" tab in Config > 
Ports,Other, the program switches from Run mode to S&P. The way to avoid this is to 
use Alt+F11 to temporarily lock the program in the current mode. That is, if you press 
Alt+F11, the program will not automatically change modes when you tune. Press 
Alt+F11 again to return to normal operation.  

2. Setting Split Transmit Frequencies Manually 

old-edit  

The easiest way to set a split transmit frequency is to type the desired frequency in kHz 
into the Callsign textbox in the Entry window, and then hit Ctrl+Enter. Another 
alternative is to use Alt+F7 to open the Split dialog, type the transmit frequency, and hit 
Enter. The split frequency may be entered either in full (e.g. 7027), as a difference from 
the lower band edge (e.g. 27), or as a positive or negative difference from the receive 
frequency (e.g. +2) . Decimals are allowed (7032.3, or 7032,3 if your regional 
preferences in Windows use the comma as the decimal separator).  

3. Split Mode and Frequencies Set Automatically from Cluster Spots 

old-edit  

If you click on a station in the Bandmap which was spotted with a QSX (transmit) 
frequency specified — in the format "DX PA1T 7095 QSX 7130"), the radio will be put 
into split mode and the frequencies set automatically. You will be set up to transmit on 
7130 (in this example).  



4. Resetting to Non-Split Mode 

old-edit  

Resetting to non-split mode is done by moving to another frequency or band, using the 
program to do so. Simply turning the VFO on your transceiver will not do it. You can:  

 Click on another spot or frequency in the Bandmap  
 Click on a non-split spot in the Packet/Telnet window  
 Click on the transmit frequency or receive frequency in the top part of the 

Bandmap  
 Click on a band button in the Available Mult's & Q's window to change bands  
 Press Ctrl+PgUp or Ctrl+PgDn (which also changes bands)  

× 

 Icom Precautions 

Icom radios can't report VFO B without being set to VFO B, and don't report whether the 
radio is in Split mode. To operate split successfully, you need to set and cancel splits 
solely from the computer. Use Ctrl+Enter or Alt+F7, as above. Only turn Split on/off from 
the keyboard/program and not on the radio, to make sure it stays in sync with the 
program. 

5. Split Operation Key Assignments 

old-edit  

Alt+F7 - Set split frequency or offset from current frequency for the active radio. When 
hitting Enter or click OK with nothing on the line split will be cleared. Press ESC or click 
Cancel to exit.  

Alt+S - When your rig is in Split mode, Alt+S will reset the receive frequency back to 
your transmit frequency, but the split mode is preserved. This is used to run a pileup 
with the rig in split mode. With a radio which has VFO A/B they use the 2nd VFO as an 
RIT. This is done since many RIT knobs are small or hard to get at, while some find it 
more natural to use the main VFO to tune in a caller rather than use the RIT. By running 
split, you can use the main knob to tune in the caller, while your TX frequency doesn't 
change. The Alt+S acts like an "RIT clear" when you are running split.  

This operates on VFO-A only. With Main/Sub radios like the Icom 756/7800 series you 
can not RX on SUB without receiving on both VFOs. In this case put RX on Main and 
TX on SUB for Alt+S to work.  

"Reset RX freq when running split", an option found on the Entry window's Config menu, 
is a way of automating the Alt+S function. When this option is checked, the program will 
automatically do an Alt+S as you log each QSO. This gives you an automated 
ÃƒÂ¢Ã¢â€šÂ¬Ã…â€œRIT clear" after every QSO when you are running split.  

Ctrl+S - When not in split mode, the first press of this combination puts the radio and 
program into Split mode. After that Ctrl+S will toggle the RX frequency between the split 



RX frequency and the RX/TX frequency while maintaining split mode. Application: This 
was designed primarily to help SSB operators run on 40 or 80mM where split operation 
is widely used. For example, "CQ CQ de N1MM listening on this frequency (7183) and 
7068". Use the Ctrl+S key to toggle between 7183 and 7068 to check for both USA or 
DX callers.  

Ctrl+Alt+S - Toggle Split mode on the radio. 'Split' will be shown in the Entry window.  

Ctrl+Enter - Entering a frequency or offset in the callsign with Ctrl+Enter will set a split 
frequency.  

× 

 Using Split - Some Hints 

Click on a spot in the Bandmap or Available window. Then look at the Bandmap or the 
Entry window title bar to see if you are going to transmit out-of-band. If you SINGLE-
click on a spot on 40 or 80, and don't see the split indicator, then wait for the station to 
announce his listening frequency. If he says "listening 214.5", type 214.5 in the Callsign 
textbox and press Ctrl+Enter - you are then ready to call him.  

6. Split mode vs. SO2V 

old-edit  

With a dual-receiver radio, the difference between Split mode and dual receive 
operation can be tricky. If both receivers are on, the radio is set up exactly the same 
way for split from the VFO A Entry window (listen to the other station on VFO A, monitor 
your transmit frequency on VFO B, transmit on VFO B ) and for SO2V with the Entry 
window focus on VFO B (conduct a simplex QSO on VFO B while monitoring the VFO A 
receiver somewhere else on the band). However, although these two situations are 
identical on the radio, they are quite different in the logging software. In the split 
operation scenario, the QSO is logged from the VFO A Entry window, with different RX 
(VFO A ) and TX (VFO B ) frequencies in the log. In the SO2V scenario, the QSO is 
logged from the VFO B Entry window with the RX and TX frequencies the same (both 
from VFO B ).  

By changing the transmit VFO from VFO B to VFO A, you can switch to either one of 
two new situations - split from the VFO B Entry window (listen to the other station on 
VFO B, monitor your transmit frequency and transmit on VFO A ) or SO2V with the 
Entry window focus on VFO A (conduct a simplex QSO on VFO A while monitoring the 
VFO B frequency somewhere else on the band). Again, these two are the same on the 
radio, but different in the logging software - split logged from the VFO B Entry window 
with different RX and TX frequencies in the log vs. SO2V logged from the VFO A Entry 
window.  

Because there are four possible logging scenarios but only two different radio 
configurations, you cannot depend on making adjustments from the radio to get QSOs 
logged correctly. By default, in SO2V mode with both receivers active, N1MM Logger 
will assume you are operating in one of the two SO2V modes and will log QSOs using 



the callsign and exchange from the active Entry window and logging both TX and RX 
frequencies from the active Entry window's VFO.  

It is possible to work and log split mode QSOs in SO2V mode, but it takes care and 
practice to get it right. In order to work and log QSOs in split while the Logger is in 
SO2V mode, you must tell the Logger that you are operating split. Since you cannot do 
this from the radio, you must turn Split on or off from the keyboard/program, using 
Ctrl+S and Ctrl+Alt+S. You need to take care to do this from the correct entry window 
(the one whose VFO you are receiving the other station on), and to be aware at all 
times of which frequency you are transmitting on.  

 

2.8.4 Single Operator Call Stacking 

in-edit  

 2.8.4 Single Operator Call Stacking  

o 1. Call Stacking Overview  
o 2. Additional SOCALLSTACK Information  
o 3. Digital Call Stacking  
o 4. How to Tell Visually Which Call Will be Put in Next  

1. Call Stacking Overview 

in-edit  

Single Operator Call stacking allows a CQing operator to enter multiple call signs that 
are received in response to a CQ message, and work them one after the other 
sequentially without re-entering a new call sign for each QSO. Macros and keystrokes 
used for call stacking include {SOCALLSTACK}, {STACKANOTHER}, CTRL+ALT+G, 
{LOGTHENPOP}, and ALT+D. The first three are used to place calls onto the stack and 
the last two are used to take calls off the stack. The macros only operate in RUN mode. 
Stacked callsigns appear in the Bandmap on your RUN frequency. Single Operator Call 
Stacking is functional in CW, phone, and digital modes and is compatible with manual 
key operation or ESM. It can also be used in SO1V, SO2V and SO2R modes and in 
multi-station environments.  

{SOCALLSTACK} or {STACKANOTHER} or CTRL+ALT+G  
The operator can stack a full callsign or a partial callsign that may include a "?" that will 
be highlighted when that callsign is removed from the stack. The operation of the 
{SOCALLSTACK} and {STACKANOTHER} macros differ slightly:  

{STACKANOTHER} or the keystroke short cut, CTRL+ALT+G, simply pushes callsigns 
onto the stack and clears the Entry Window callsign box.  

{SOCALLSTACK} functions as a single level stack macro. The first execution of 
{SOCALLSTACK}, stacks the first callsign and clears the Entry Window callsign line. 
When a second callsign is entered and {SOCALLSTACK} is executed again, the two 



callsigns are exchanged. If the callsign window is empty when {SOCALLSTACK} is 
executed, the callsign is removed from the stack and placed into the callsign Entry 
Window. The user can thus control which call sign will be worked first, whereas with 
{STACKANOTHER} the last call sign entered is the first one to be worked.  

{LOGTHENPOP}, ALT+D  
The stacked callsigns can be removed from the stack with several methods: logging the 
current call, unstacking the next callsign with {LOGTHENPOP} or manually removing 
the stacked callsign with the keystroke ALT+D. The ALT+D keystroke is useful if a 
callsign appears on the stack via a telnet spot and is not one of the ones you want to 
work. The next callsign on the stack is displayed on the callframe when the CQ-Literal is 
not present. Pressing Space will move a stacked call from the Callframe to the callsign 
box and remove it from Bandmap.  

ESM Automation  
The Configurer, Function Key tab, Next Call Key is used to select the function key that 
contains the {LOGTHENPOP} macro along with the message string for ESM 
automation. If a Next Call Key has been specified, then when Enter is pressed to finish 
a QSO and there is another call sign on the callsign stack, the Next Call Key will be sent 
instead of the TU(F3) Key. The last option in the drop down menu for the Next Call Key 
allows the ESM SOCallstacking automation to be disabled.  

SOCALLSTACK ESM Example  
Program F9 key to: {STACKANOTHER} or {SOCALLSTACK}  
Program F10 key to: {LOGTHENPOP}TU NW {F5} {F2}  
The appropriate SSB wave file can be inserted into the F10 message in place of the " 
TU NW" letters above. 

Set >Config >Function Key tab >"Next Call Key" to F10  

Select RUN mode and turn ESM on. For this example two stations are calling, N2IC and 
K3CT  
Type K3CT, press F9, type N2IC and press Enter  
Copy N2IC's report and press Enter. This will log N2IC, and then instead of F3 it will 
invoke F10, which will send the TU, unstack K3CT, and send the exchange  

SOCALLSTACK Non-ESM Example  
Program the function keys as listed above.  
Select RUN mode.  
Type K3CT, press F9, type N2IC and press the exchange key programmed in 
Configurer, usually ";". This key is programmed to F5 & F2.  

Copy N2IC's report and press F10. This will log N2IC, unstack K3CT, and send the 
exchange.  

If multiple callsigns are stacked, ESM will continue to unstack the callsigns. The same is 
true in non-ESM mode as F10 is pressed. Should a logging error occur such as a bad 
call, the sequence will be interrupted until the error is corrected. When no calls remain 
on the stack, the normal TU message is sent (if not using ESM, you would normally 
press F3 instead of F10 at this point). If there are multiple callsigns on the stack, the 



order that they are removed or exchanged with {SOCALLSTACK} depends on the 
internal sorting order and not necessarily the order they were stacked.  

2. Additional SOCALLSTACK Information 

in-edit  

It is important that the contest callsign is entered in the Config, Station Information 
window. That way, the station callsign will not appear in the Bandmap via a telnet spot 
and the SOCALLSTACK code will not place the station callsign or the Busy literal 
(ALT+M) into the callsign box.  

If a callsign appears on the callsign stack via a telnet spot and you want to remove it, 
use the ALT+D keystroke to remove it without popping it off the stack into the Entry 
window.  

Single Operator Call Stacking does overlap slightly with multi-operator call stacking. 
Multi-operator call stacking is the program feature that allows a second operator to 
listen to the run radio and send calls to the run operator's Entry Window.  

3. Digital Call Stacking 

in-edit  

In digital modes there are two different ways to work stations one after the other in 
series when more than one station responds to your CQ. The first method is based on 
the Single Operator Call Stacking described in the previous sections, adapted to use the 
features of the DI window. The second method, using the Grab list, is unique to digital 
modes.  

LOGTHENPOP: To use this, you must program a function key using the 
{LOGTHENPOP} macro, e.g.:  
{TX} ! {LOGTHENPOP} TU NW {F5}{F2} {RX}  
When this function key is pressed or clicked on at the end of a QSO instead of the 
normal TU key, it will log the previous contact, pull the next call sign off the single 
operator call stack in the Bandmap window, and send the exchange to the new station. 
If you designate this function key as the Next Call Key in the Configurer under the 
Function Keys tab, ESM will automatically select this key instead of the TU key at the 
end of a QSO whenever there is an unworked call sign remaining on the call stack in 
the Bandmap. Note that you must use two different function keys for the TU and Next 
keys; do not put {LOGTHENPOP} into the TU key. Don't program the exchange (e.g. # 
in a serial number contest) directly into the Next key; use the {F2} macro to call up your 
regular exchange message, as in the example above. Using # in the Next key will send 
the wrong serial number.  

How do you get call signs onto the call stack in the bandmap? You can do this 
effectively in digital modes by selecting the Setup > Digital Call Stacking menu item in 
the Digital Interface window's menu bar. This enables an efficient way to place call signs 
on the single operator call sign stack in the Bandmap window. You have three choices, 
depending on which order you want calls to be popped off the stack ready to be worked: 
Enable using First In First Out (the first call to be worked will be the one that was placed 



on the stack first); Enable using Last In First Out (the first call to be worked will be the 
one that was most recently placed on the stack); and Enable using FIFO Mults First 
(callsigns will be taken off the stack in order of their multiplier value. In those contests 
where one QSO can yield 2 or 3 mults, the higher-mult calls will be taken first. Among 
calls with the same multiplier value, the first call to be worked will be the one that was 
placed on the stack first).  

When Digital Call Stacking is enabled and you are in Run mode:  

 If there is already a call sign in the call sign box in the Entry window when you 
mouse-click on another call sign in the RX window, clicking on the new call sign 
in the RX window will move the call sign that was formerly in the Entry window 
onto the stack in the Bandmap, and will bring the new call sign into the Entry 
window. The call sign that will be removed from the stack next will be put in the 
frame above the call sign box in the Entry window as a reminder that it is on the 
stack, ready to be used by {LOGTHENPOP} at the end of the QSO with the first 
station  

 Alt+left-clicking on a call sign in the RX window will move that call sign directly 
onto the stack in the Bandmap without changing the call sign in the call sign box 
in the Entry window. You can place any number of call signs on the stack ready 
for working one after the other  

 You can also use {GRAB} or Alt+G to pull the highlighted call sign off the Grab 
list into the Entry window. The call sign that was formerly in the Entry window will 
be moved onto the stack  

 Instead of using {GRAB} or Alt+G, you can use {STACKANOTHER} or 
Ctrl+Alt+G to move that call sign from the Grab list directly onto the stack without 
changing the call sign in the call sign box in the Entry window  

 
When Digital Call Stacking is enabled, left-click, Alt+left-click, {GRAB}/Alt+G and 
{STACKANOTHER}/Ctrl+Alt+G give you a variety of ways to choose which call signs 
you want to place onto the call sign stack and into the Entry window. Once there are 
one or more call signs on the call sign stack, after working the first station in the Entry 
window, the Next key (automated with ESM) lets you work the call signs from the stack 
rapidly one after the other.  

LOGTHENGRAB: There is a separate method that uses the Grab list in the DI window 
with the {LOGTHENGRAB} macro. You do not need to enable Digital Call Stacking to 
use this method. You can use any method you wish to get the first call sign into the 
Entry window so you can work that station. At the end of the QSO with the first station, if 
you want to work the call sign that is highlighted in the Grab list, you can use an F-key 
or message button that contains:  
{TX} ! {LOGTHENGRAB} TU NW {F5}{F2} {RX}  
This will log the contact with the first station, then grab the highlighted call sign from the 
Grab list and send the exchange to that station. You can repeat this for as long as there 
are workable call signs being highlighted in the Grab list. If the next highlighted call sign 
in the Grab list is invalid or not workable, you should press or click on the normal TU 



key instead, in order to avoid attempting to work a bad call sign. You can also program 
a {DELSEL} macro into an unused function key or DI message button for use in 
removing unwanted call signs from the Grab list. Don't program the exchange (e.g. # in 
a serial number contest) directly into the function key that has the {LOGTHENGRAB} 
macro in it (the # macro in this key will send the wrong serial number); use the {F2} 
macro to call up your regular exchange message, as in the example above, to get the 
correct exchange sent to the second station.  

Using this method, the Grab list is populated automatically, but you have to decide 
manually whether to use the normal TU function key or the message key containing the 
{LOGTHENGRAB} macro. This is because of the possibility of unwanted or incorrect 
call signs in the Grab list - it is up to you to decide whether the next call in the Grab list 
is one you want to work using {LOGTHENGRAB}, or whether you just want to end the 
QSO with a normal TU message. Do not put a {LOGTHENGRAB} macro in your normal 
TU function key, or in the Next Call function key if you are using one. {LOGTHENGRAB} 
must be in a separate function key or in one of the DI message buttons.  

4. How to Tell Visually Which Call Will be Put in Next 

in-edit  

If "CQ Frequency" is on the call frame, then look at the Bandmap.  

The {LOGTHENPOP} calls the {SOCALLSTACK} routine. {SOCALLSTACK} will remove 
the CQ-Literal ("CQ Frequency") and take the next callsign listed on the Bandmap's run 
frequency. There are cases where the CQ-Literal string will replace the callsign on the 
call frame. The stacked callsign isn't lost, look at the Bandmap.  

The same is true when you are spotted. Your callsign will appear in the call frame but 
the routine will not pop it into the callsign box. If you find that it does, you don't have 
"your callsign" entered into Station Data window. When you use {LOGTHENPOP}or 
{SOCALLSTACK} they remove the station callsign and discard the callsign, then grab 
the next call on the stack.  

If you have {SOCALLSTACK} programmed to an F-key, pressing it once at any time will 
exchange the current callsign with the next callsign on the stack. If there is no callsign 
on the stack, then it stacks the call and gives you an empty callsign window to enter 
one. Pressing the F-key again will reverse them again.  

 

 

2.9 Multiple Computer and Multi-op Contesting 
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o 4. Multiple Radios and Multiple Computers  

 4.1. Stored Voice Messages in a Multi-Op (Any multi-op)  
 4.2. "Distributed" Multi-Ops (IARU Headquarters stations, for 

example)  
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 5.2. Passing  

o 6. Managing A Multi-Op Station  

 6.1. Setting Up the Network  

1. Introduction 

There are major changes in N1MM Logger+ networking, as compared with N1MM 
Logger Classic, which will affect both multi-op contesting and those operators who 
network multiple computers for single-op categories, particularly on digital modes.  
.  

 You no longer need to enter computer names and IP addresses when networking 
on a typical LAN. When networking is turned on, N1MM Logger+ detects the 
presence of computers on the same subnet that are running the same version of 
N1MM Logger+, and automatically connects to them. You will be warned if there 
are discrepancies in contest or multi-op class among the computers, so that you 
can correct them.  

 The Network Status Window is brand new in N1MM Logger+.  

 
All network-related options and actions except for informational functions such 



as received Talk messages and band-change status have been moved to this new 
window. Those remain in the Info window.  

A full explanation of this window and each of its functions is found here.  

2. Key Features 

in-edit  

 Use of standard network interface cards (NIC's) and wireless interfaces  
 Point to point or broadcast Talk capability between networked stations  
 Automatic time synchronization (non-master stations must be Run as 

Administrator)  
 Pass frequencies displayed at all stations  
 DX Spots distributed by master station to all connected computers  

o Spotting commands can be sent by any station on the network  
 Extensive error trapping and diagnostics  
 Auto resync when a station comes on-line  

× 

 CAUTION about Software Lockouts 

The "Force Other Station to Stop Transmitting When I Transmit" and "Block my Tx 
Only if Other Stn Transmitting on Same Band&Mode (Multi-One)" items on the 
Options tab of the Network Status window are software lockouts. They are subject to 
network latencies and cannot be guaranteed to prevent simultaneous transmitting. 
Because of network latencies, lost packets, network dropouts or network failures there 
could be short overlaps in transmissions, or even complete failure of the lockout. For 
protection against damage from simultaneous transmitting, and/or to be absolutely 
certain that contest rules forbidding simultaneous transmissions are obeyed at all times, 
you must use a dependable hardware lockout system. Do not depend on software 
lockouts to prevent equipment damage and do not expect software lockouts to 
give you an ironclad guarantee of compliance with contest rules!  

3. The Simplest Multi-Op 

The simplest form of multi-operator contesting involves a single radio and a single 
computer, i.e. it is just like single-operator contesting except that two or more operators 
take turns, spelling each other. Of course, you have to ensure the correct entry class is 
entered in the Contest Setup dialog. From there on, if you wish to keep track of which 
contacts were made by which operator, you should use Ctrl+O, or the OPON direct 
entry command in the Entry window, and enter the call sign of the incoming operator 
every time the operator is changed. N1MM Logger+ will keep track of which operator 
made each contact, and that information will be displayed in the Log window. For the 
simplest setups, including CW and RTTY, and SSB without voice keying messages, this 
is almost all there is to it.  

http://n1mmplus.hamdocs.com/tiki-index.php?page=Network+Status+Window


4. Multiple Radios and Multiple Computers 

 
Most multi-operator setups will involve more than one radio and/or more than one 
networked computer. The details of how to set up a networked computer system are in 
the Network Status window section of this manual.  

4.1. Stored Voice Messages in a Multi-Op (Any multi-op) 

If you are using stored voice messages in a phone contest and you change operators 
while using the same stored voice messages, the voices heard over the air could vary 
during a single QSO between recorded messages and live voicing. This can be very 
confusing to the other station. To avoid this, it is best to have each operator record a 
separate complete set of voice keyer messages. To do this, create a separate subfolder 
for each operator within your wav files folder, labelled with that operator's call sign. 
Make sure the paths to your wav files in your function key messages includes the 
{OPERATOR} macro, as in "\{OPERATOR}\CQ.wav". Before the contest, have each 
operator enter his or her call sign with Ctrl+O or OPON and then record all of the voice 
keyer messages in his or her own voice. Once the messages are all set up, the Logger 
will use the operator call sign entered during the contest with Ctrl+O or OPON to select 
which set of recorded messages to use.  

If your multi-op uses multiple computers, and if any individual operator will use more 
than one of these computers during the course of the contest, that operator will need to 
create and populate a subfolder with his personal wav files on each of the computers 
that he or she will be using.  

4.2. "Distributed" Multi-Ops (IARU Headquarters stations, for example) 

in-edit  

It is possible to set up N1MM Logger to allow some or all of the other stations outside 
your LAN to communicate over the internet. Possible uses for this feature are: 
Headquarters (HQ) stations in the IARU contest and distributed special event stations.  

4.2.1. Configuration 

There are some caveats when trying this. You need more than basic computer 
knowledge for this. You need to know about IP-addresses, firewalls, routers, port 
settings, NAT etc.  

You need to know your computer (external) IP-address. When directly connected to the 
internet, this can be obtained using the program ipconfig. The command 'ipconfig' 
should be entered in a command (cmd) window to see the output. When your computer 
is in a LAN your connection to the internet will probably be made via a router. All 
computers will use internal IP-addresses; the router uses the external IP-address. This 
link  will give you your (external) ip-address.  

It is strongly recommended that static external IP addresses be used. When DHCP is 
used to obtain the external IP address from the Internet Service Provider (ISP), the 
external IP address can change at random and unexpected times. You should not 

http://n1mmplus.hamdocs.com/tiki-index.php?page=Network+Status+Window
http://whatsmyip.org/
http://whatsmyip.org/


depend on Dynamic DNS (dyndns.org) and similar services to provide the correct IP 
address to other computers in the extended network. Often, the domain name-to-IP 
address mapping is stored in your local computer or router, and may not be updated by 
Dynamic DNS.  

Your router should be set up to route incoming UDP and TCP traffic to your local PC IP 
address. This is done using a router feature that is typically called Network Address 
Translation (NAT), Port Forwarding or Port Redirection.  

The incoming port will be 12070 + Station Nr (0-15). 12070 is used for the first PC in the 
list, 12071 for the second etc. An example of how this might work out in practice is 
described XXXXXXX  

You must also configure your computer and router Firewall(s) to allow port 12070 + 
Station Nr (0-15) to be passed for incoming UDP and TCP traffic.  

The latencies when we tested were in the 100 mSec range.  

× 

 IP Addresses 

The list of IP addresses needs to be different on each machine. Make sure the remote 
machine has its external IP address, and the local machine(s) has its internal address 

 
Footswitch lockout support has been added for multiple distributed stations. 
 
In the IARU contest a headquarters station is allowed to use multiple stations located 
within one IARU zone, but the rule of one signal per band/mode is still in effect. So there 
could be 2 (one running station and another looking for multiplier) or more stations on 
the same band and same mode and they should keep only one TX signal on this band 
at any time. Now you can hook up a footswitch to the LPT port 15 (the LPT port must be 
enabled even if it is not being used for other purposes. There is no special check box to 
turn the footswitch feature on/off). If the station is not in multi-multi operator category the 
footswitch will directly control PTT just like Alt+T. If it is a multi-multi station (connected 
to other stations on LAN or via the Internet in Multi User mode) it will prevent two 
stations on the network from both transmitting on the same band/mode combination. 
 
This is a software lockout only, and is subject to network latencies. As such, it should be 
considered a backup. Multiple stations on the same band/mode should always 
coordinate operations (with the help of message passing over the network from the Info 
window), and not depend on software lockout to ensure compliance with contest rules.  

5. Multi-Operator Capabilities and Techniques 

N1MM Logger+ attempts to simplify and streamline important multi-operator functions. 
These are collected here to help the new multi-op participant quickly learn how to use 
N1MM logger+ effectively in this context.  



5.1. Messaging 

 
Frequently, in a multi-op situation, there is a need to communicate to other operators 
without shouting acrss the room. For this purpose, there is a Talk function, which can be 
used either one-to-one or one-to-many. It can be invoked in several ways:  

 Ctrl+E  
 The Talk button on the Actions tab of the Network Status window  

o either of these options assumes you want to send a message to all 
stations, so it enters an "*" to denote that your message will go to all 
stations.  

 Right-clicking on a line in the Stations tab of the Network Status window.  
o Doing this will open the Talk window and enter the computer name of the 

station you clicked on.  

 
In either case, you need to be sure and type a space before you begin your message, to 
keep the program from misunderstanding your message as part of the computer name.  

You'll note that the Talk window stays open until closed by clicking on the "X" at upper 
right. However, if you right-click in the window, it brings up a menu with a single self-
explanatoryoption, "Enter moves focus to Entry window".  

5.2. Passing 

 
Passing - referring stations you have worked to the operator on one or more other 
bands - is an essential tool for optimizing multiplier counts and total scores in a multi-op. 
There are two basic forms that this can take:  

 You are running, and you pass someone you work to another band where your 
station is also running.  

 You are running, and you pass someone you work to a specified frequency on 
another band. This might be useful, for example, if your station's operator on that 
band is searching and pouncing.  

 
Some basics - if the station on a given band is in Run mode, then his pass frequency 
will be his running frequency. If that station is in S&P mode, then he will want to set a 
pass frequency - perhaps somewhere high in the band he is on. To set a pass 
frequency, click on the Actions tab of the Network Status window, then click on "Set 
Your Pass Frequency." A dialog will open, where you can enter a frequency, or 0 (zero) 
to clear your pass frequency. If you switch from S&P to Run mode, your pass frequency 
will change automatically to your current frequency. Don't leave a zero in your pass 
frequency while you are in S&P mode, or other stations will not be able to pass to you. If 
you are not using an interfaced radio, be sure to enter your current frequency in the 
callsign field of the Entry window.  



You can pass the station currently in your Entry window, or the one you worked last, in 
one of two ways:  

 Right click on the station you want to pass to, in the Network Status window, and 
click on Pass Current/Last QSO.  

 Right click on the Band Button in the Entry window corresponding to where you 
want to pass the station. For example, if you've told him, "Please go to [your 20M 
station's Run or Pass Frequency]", then right-click the 20M Band Button.  

 
Either way, a pass message will be sent, in red to get the other operator's attention, and 
a message will be entered in black in your Info window confirming that it was sent.  

 

6. Managing A Multi-Op Station 

A smooth, trouble-free multi-op contest requires a good deal of systematic 
management. This section attempts to provide checklists for Before, During and After a 
contest.  

6.1. Setting Up the Network 

in-edit  

 Verify that all of the computers you intend to use are running, and that Windows 
networking is functional. It is a very good idea to have a "hot spare" on the 
network, just in case.  

 Install the same version of N1MM Logger+ on all of the computers.  
 Run N1MM Logger+ on each machine, using the right-click option to Run as 

Administrator on all machines except the one you will be designating as 
"master". This will enable the "master" station to keep all the other computer 



clocks in sync with Internet time. (Note: there are other ways to achieve this, but 
running non-master computers "as Administrator" is the simplest.)  

 Create a new empty database on each machine.  
 Start a new log for the contest on each machine, making sure to set the contest, 

operator category and transmitter category correctly.  
 Configure external interfaces at each operating position (radio control, CW, PTT, 

etc.)  
 Set up Function Key Messages on each computer. If using operator-specific wav 

files for SSB, make sure that each operator has his or her own wav file sub-folder 
on every computer that he or she will be using.  

 Make sure that Master.SCP and cty.dat files are up to date (on the Tools menu) 
on all computers  

 Turn off Windows Sounds (in SSB contests) to prevent transmitting odd noises 
(Control Panel - Sounds - Scheme: No Sounds)  

 Set N1MM+'s Networked Computer mode on - from the Network Status Window 
on each machine  

 

o At this point you should see the names of all the computers running on the 
network. Initially, i.e. for the first several seconds or so, they may display 
various red warning flags .  
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o This will only persist until the network finishes connecting, at which time 
the red flags will disappear, unless you have something wrong, such as a 
mismatch between N1MM+ versions, between the contests on the 
different computers, or between operator categories or transmitter 
categories. In this case, the red flag will remain on the Messages tab in 
the Network Status window, and you will find an explanation there of what 
needs to be fixed.  

 Click the box marked "Master" in the Network Status window of the machine you 
want designate to connect to the Internet (this is the one computer in which 
N1MM+ does not need to be "run as Administrator"). This will turn on time 
synchronization across the network.  

 If you wish to send and receive spots to/from all the stations on the network, 
open the Telnet windows in all computers, but only connect one of the computers 
to a Telnet cluster, namely the computer designated as "master". Other 
computers (non-"master" computers) receive cluster spots from the "master" 
computer, not from a DX cluster node.  

o Please note: if you want operating positions to receive spots, each of 
them must have its Telnet window open and the proper filters and 
bands/modes set.  

 
Now it's time to make some test QSOs. Verify that when a given station makes a QSO, 
the QSO appears on all of the networked computers. Repeat this process with each 
computer on the network, including the master, even if you do not anticipate making 
QSOs with it during the actual contest, in order to verify that network communications 
are working correctly.  

just before the contest start, have each operator type WIPELOG enter in the callsign 
field. This will remove all the test QSOs. Then have the starting operator use Ctrl+O to 
set his or her callsign for the first session.  

× 

 Make sure that... 

* You are running the same version of the program on all computers  

 You have set up the same contest and same operator and transmitter categories 
on all computers  

 All computers have the same version of wl_cty.dat installed  
 All computers have the same time zone and daylight savings offset  
 All computers have the same regional settings for numbers, dates, etc, and the 

same short and long date and time formats  

× 

 Multiple networks 

http://n1mmplus.hamdocs.com/enter


There are some situations in which there may be more than one network active at the 
same time on the same computer(s). One such situation might be one where the N1MM 
Logger+ network is a wired network (perhaps because some of the computers on the 
network do not have wireless adapters), but where there is a wireless network operating 
at the same location. On any computer where there are two network adapters 
connected and active, N1MM Logger+ will not be able to reliably detect which adapter 
you intend to use for the N1MM+ network, and 50% of the time it will guess wrong. A 
work-around for this is to temporarily disable the other network while you are starting up 
N1MM+ and connecting to the N1MM+ network, in order to ensure that the N1MM+ 
network connection uses the correct network adapter. Once the N1MM+ network 
connection is established, you can re-enable the other network on any computers that 
need it (for example, if the Internet gateway is on the other network, the Master 
computer will need to be connected to both networks).  

 

2.11 Error Messages (and what they mean) 

old-edit  

XXX This page is simply a copy of the corresponding page in the N1MM Logger Classic 
manual XXX  
XXX It will need significant revision once the beta-testing phase is over XXX  

Often, particularly for new users, the variety of error messages that may be seen when 
using N1MM Logger is intimidating. Some of them are produced by the program and 
some by Windows. In the table below, we have tried to de-mystify some of the most 
common ones by giving a plain-language explanation and providing links to relevant 
sections of the documentation.  

Clear Filters 
Error Message  Explanation  Solution 

8020 or Error 8020  

Appears in the lower left corner of the 
Entry Window, and is an indication that 
the USB-to-serial adapter driver you 
are using is not compatible with Visual 
Basic 6.0  

See USB Interface Devices for a summary of user 
experience with various adapters and their drivers. 
You may be able to find an updated driver for your 
adapter on the Internet. This is thought to be 
specific to adapters using Prolific chip sets. See 
also: this Microsoft Knowledge Base article  For 
prolific chip set adapters, try installing the latest 
driver from: 
http://www.prolific.com.tw/eng/downloads.asp?id=31

 

ADIF import error- message This file must 
be imported into a contest of type [contest 

If you have opened the right contest in 
N1MM before attempting an ADIF 
import from another program, this error 

The easiest way to trouble-shoot this is to create a 
log in N1MM Logger in the affected contest and 
export an ADIF file with at least one dummy QSO. 

http://n1mmplus.hamdocs.com/tiki-index.php?page=USB+Interface+Devices
http://support.microsoft.com/default.aspx?scid=kb;en-us;318784
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Error Message  Explanation  Solution 

name].  probably means that something in the 
incoming ADIF file is not in the format 
that N1MM Logger expects.  

Then compare the structure of the export with the 
ADIF you are trying to import, and correct as 
required. 

Another station is transmitting  

In certain multi-operator classes, in 
particular contests, transmitting more 
than one or more than two signals at 
the same time is not permitted. You 
may have selected the wrong class or 
contest.  

See Multi-User Support? 

Cabrillo not supported for this contest. 
Please use: Export to File (Generic)...  

Some contests do not accept Cabrillo, 
so if you try to generate a Cabrillo file 
you will get this error.  

Self-explanatory 

Entry Window (Station.Initialize) 48 Error 
in Loading DLL  

Indicates that the program cannot find 
a DLL it needs to run. This is usually a 
result of problems in the initial Full 
Install on Vista or Windows 7, often 
caused by installing to the Program 
Files folder. This can lead to problems 
with User Access Control (UAC).  

See Installing the Software. If installing the software 
doesn't eliminate the error, place a copy of 
DAO360.DLL V3.60.2521.8 in the program 
directory. Current program versions display this 
instruction in the error message box. 

EntryWindow (ValidateIniLookup) - 3159 
and Run time error 91 - Object variable or 
with block variable not set 

This typically occurs when just starting 
the program, and probably indicates 
that Windows has changed the 
enumeration of your audio devices or 
virtual port numbering, which now do 
not match the N1MM Logger.ini file 

Rename your N1MM Logger.ini file so that the 
program cannot find it, restart the program, and 
reset your port and audio device information, 
working with Device Manager to ascertain what 
Windows has done. 

EntryWindow(stn_WindowFocusSwapped) 
10014 - Invalid Argument  

Can occur when switching radios (in 
SO2R) or VFOs (in SO2V) with the 
keyboard hot-keys, if you are also 
using N1MM Rotor Control and if the 
version of the Microsoft Winsock 
control (mswinsck.ocx) on your 
computer is in the range from 
6.01.9812 to 6.01.9816  

This bizarre error is probably the result of a 
Microsoft update, and if so, a hotfix is available from 
Microsoft (see 
http://support.microsoft.com/kb/972877 for details). 
Try closing Rotor Control and see if the error stops 
happening. If so, search your machine for 
mswinsck.ocx. If it is in the range described in the 
Microsoft Knowledge Base, contact Microsoft 
Support for the hotfix. 

Err 8 - Error opening wav file  
Means that the program cannot find 
the WAV file named at the location 
specified in the table of SSB function 
key definitions. You can access and 

Refer to Interfacing Basics for help. 

http://n1mmplus.hamdocs.com/tiki-editpage.php?page=Networked-Computer+Support
http://n1mmplus.hamdocs.com/tiki-index.php?page=Installing+the+Software
http://n1mmplus.hamdocs.com/tiki-index.php?page=Interfacing+Basics#Phone_Interfacing


Error Message  Explanation  Solution 

edit this table by right-clicking on the 
Function Key buttons in the Entry 
Window.  

Err 14 - Device not found and the path to 
the wav file  

Appears in the lower left corner of the 
Entry Window. Means that the 
program could not find the sound card 
or other device used for playing back 
stored messages.  

See the Audio tab in the Configurer 

Err 429 - EntryWindow 
(Database_Initialize) - 429 - ActiveX 
component can't create object  

Unable to launch N1MM Logger from a 
fresh install  

From Windows >Start >Run, CMD. From the CMD 
window, enter the following commands: 
regsvr32 "C:\WINDOWS\System32\scrrun.dll" 
regsvr32 "C:\Program Files\Common Files\Microsoft 
Shared\DAO\dao360.dll" 
(Yes, the double-quotes are required) 

Error sending CW. Check port selection in 
the Configuration dialog.  

You didn't designate a CW port and/or 
method  

See the Configurer 

hamtemp.mdb already exists. Please 
rename it before proceeding  

Appears when trying to copy a 
database, if you have previously had 
some difficulty with the program that 
caused a temporary database file to 
be left in the program directory rather 
than deleted.  

Use Windows Explorer to delete hamtemp.mdb from 
the program directory. 

Invalid Sent Exchange value: Use File, 
Open Log in Database to correct.  

When generating a Cabrillo file, if the 
Sent Exchange is incorrectly set in the 
Contest Setup dialog, you'll see this 
message.  

Check Contest Setup Instructions for the current 
contest and correct as necessary 

Macro subscript out of range  
Typically seen when trying to load a 
set of function key definitions from a 
text file.  

Use Notepad to open the text file and check for line 
wraps. Each line in the table should be just one line, 
no matter how long (up to 255 character. Also check 
for extra lines at the end of the text file. Remove 
them, as well as any wraps, and re-try. 

Missing/Invalid Exch  

When this message appears in the 
lower left-hand corner of the Entry 
Window and the program will not log 
the QSO, the reason is that it does not 
believe your entered exchange is in 

Check what you have typed. Common errors 
include the letter "O" instead of zero in a serial 
number contest. If you can't find an answer, you can 
force logging by pressing Ctrl+Alt+Enter. 

http://n1mmplus.hamdocs.com/tiki-index.php?page=Configurer#Audio%20tab
http://n1mmplus.hamdocs.com/tiki-index.php?page=Configurer
http://n1mmplus.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions


Error Message  Explanation  Solution 

the proper format for the contest.  

Multi-User mode should not be disabled 
during a contest.Contacts made while in 
single-user mode may be deleted during a 
multi-user sync.To disable a non-working 
computer, right click its 'cue-ball' and 
choose 'Prevent Automatic Reconnect 
Attempts' from the other computers.  

DO NOT DISABLE multi-user mode 
and then make contacts on that 
computer. The contacts will be logged 
with the wrong computer/station 
number and will be deleted by the 
other station when you reconnect. This 
is a common operator error during 
multi-op contesting.  

See Multi-User Support? 

N1MM Logger.ini is read-only. No program 
settings or window settings will be saved. 
Use Windows Explorer to change its 
properties.  

Self-explanatory. This sometimes 
happens when using a USB drive or 
CD-ROM disk to transfer an ini file 
from one computer to another 

 

Not enough memory to complete this 
operation. Quit one or more applications to 
increase available memory and try again.  

This error message occurs with 
Windows Sound Recorder when trying 
to record with more than 2 GB of 
available memory (as in the case of 
many modern Windows 7 computers). 
See 
http://support.microsoft.com/kb/284893

.  

Use another application to record your messages. 
Audacity?is a particularly good choice for this 
purpose. 

Run-time error 383  

Reported when trying to open N1MM 
Logger when digital modes and 
MMVARI are selected. Typically, 
results because another program 
using an earlier version of 
MMVARI.ocx was installed after 
N1MM, causing the registry to be 
incorrectly modified.  

If you are comfortable with registering .dll and .ocx 
files, you can simply un-register and re-register the 
version of MMVARI.ocx supplied with N1MM Logger 
in the program directory. Otherwise, you will need to 
uninstall N1MM Logger, run the Full Install, and then 
run the Latest Update to register the right version of 
the .ocx in its proper place and return to proper 
operation. 

The radio mode is not set. The radio may 
not be connected.  

If your radio is not connected, or not 
communicating properly with the 
program, then N1MM Logger does not 
know what mode (CW, SSB or Digital) 
you want to log in.  

You can set the mode, even without a radio 
connected, by typing CW, USB, LSB or RTTY in the 
callsign field of the Entry Window, and pressing 
Enter. The mode will then show in the Entry 
Window's title bar. If you change modes, repeat this 
process. See the Configurer and the list of 
supported radios for help in interfacing your radio. 

This action cannot be completed because 
the other application is busy. Chose 

This usually results from a conflict 
between the main and CW sending 

Rename your N1MM Logger.INI file so that the 
program will start fresh, and check under Processes 

http://n1mmplus.hamdocs.com/tiki-editpage.php?page=Networked-Computer+Support
http://support.microsoft.com/kb/284893
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Error Message  Explanation  Solution 

'switch to' to activate the busy application 
and correct the problem  

components of the program, usually 
because of a configuration error. 
Please report all instances as a help to 
identifying the specific source(s).  

in Windows Task Manager to be sure that CW 
IF.EXE is not still running. If it is, stop it before 
restarting the program. If the program then restarts 
normally, reconfigure. 

This contact cannot be logged because it 
is not a mult. If you wish to log mults on 
this computer, turn off the option in the 
Config/Multi-User Tools menu. You have 
chosen to only work mults on this 
computer!  

In some contests, a second transmitter 
may only work new multipliers.  

See Multi-User Support?. 

You must install base version 10.0.0 
before installing this one  

Seen only when first installing the 
program. You must do a Base (also 
called "Full") installation before 
installing the latest update.  

See the installation instructions 

Error Message  Explanation  Solution 

 

2.12 VHF and Up Contesting 

old-edit  

XXX This page is simply a copy without screen shots of the corresponding page in the 
N1MM Logger Classic manual XXX  

 2.11 Error Messages (and what they mean)  
 2.12 VHF and Up Contesting  

o 1. VHF Options  

 1.1. Frequency display  
 1.2. Multiplier by Band Window  

o 2. Gridsquare Key Assignments (VHF and up)  
o 3. Call History Lookup  

 3.1. Updating the Call History File  

o 4. Transverter Support  
o 5. VHF Beacons  
o 6. Example Contest Setup  

 6.1. Create (Days Before the Contest)  
 6.2. Before Starting the Program  
 6.3. After Starting the Program  
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N1MM logger has some features which will be appreciated especially by VHF and up 
contesters. The program supports bands up to the SHF bands 10, 24, 47, 76, 142 and 
241 GHz  

1. VHF Options 

old-edit  

1.1. Frequency display 

old-edit  

The frequency is shown in the Bandmap and in the Entrywindow. When the frequency is 
above 1 GHz the band will be shown in cm, not the exact frequency in the Entry 
window. When entering QSOs it's easy this way to recognize the band in which you log.  

1.2. Multiplier by Band Window 

old-edit  

The Multiplier by Band window includes a Grid Square option. Start the program, open a 
VHF contest, open the Multiplier window and then click on the "Other" radio button at 
the bottom. You'll see the following display, centered on your grid square - the one 
entered on your Station Data window.  

 

The Grid Square display has a few additional features, in a right-click menu. Click 
somewhere in the grid array and the following menu appears:  

 

 Show Calls Worked - Grid squares you have already worked are colored pink. To 
see which calls you've worked in a given grid, right-click on that square to bring 
up the menu, and then left-click on this option. A separate window will open 
displaying the calls and times they were worked.  

 Set Grid Center - Right-click anywhere in the grid array, and then left-click on this 
option. Enter the four-character grid square you want in the dialog that appears, 
and hit Enter.  

 Show Bearing to Grid - Right-click on a grid square, left-click on this option, and a 
window will open displaying the bearing and distance from your QTH to the 
center of the square.  

 Turn Antenna to Grid - Right-click on a grid square, left click on this option, and if 
you have a rotator interfaced with the program, the antenna will be turned to the 
correct bearing.  

 Set Rover QTH - Right-click on the square you are in, and left-click on this 
option, and the program will temporarily reset the reference point for bearings, 
etc. to your current location. Works only if you select Rover as your class.  



 Minimum Grid Square Box - Right-click anywhere in the grid array, and then left-
click in this option to display a grid array with absolutely minimum-sized squares 
(just large enough to contain 2 letters and 2 numbers). You can toggle this off, or 
it will close automatically if you either close the Multiplier window or the program.  

 

2. Gridsquare Key Assignments (VHF and up) 

old-edit  

 Alt+equal (=) - Search entered info from both the Callsign field and the 
Gridsquare field in the call history table  

o The results will be shown in the Check window  
 Alt+minus (-) - Toggle through call history and entered grid squares (max 3) in 

the grid square entry field  
o When no grids are found in the call history there is nothing to toggle  

3. Call History Lookup 

old-edit  

More information about this can be found in the Before the Contest chapter.  

This feature is very useful in VHF contests. Lookup examples are lookups for names 
(Friends file in RTTY contests), gridsquares for VHF contests, ages in All Asian DX 
contests etc. With the importing and exporting options the call history table can be 
updated.  

Call history lookup is enabled with the option >Config >Call History Lookup. If enabled, 
it will look up in VHF contests: Grid Square (max 2) and Name.  

3.1. Updating the Call History File 

old-edit  

The program itself does have a function to export the log file to (update) the call history 
table under >Tools >Update Call History with current log'. This function will fill the call 
history table with the contents of the currently selected log.  

Another method used which gives more control is the separate program called 
Thucydides by Carel, PC5M. Check it out in the Links chapter chapter and the Third 
Party Software chapter..  

4. Transverter Support 

old-edit  
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N1MM logger has transverter support in the form that per band an offset frequency can 
be set. Right click on the bandmap and select >Set transceiver offset frequency. The 
offset value is saved by the program so after a restart the offset is still there.  

 
 

 
 
 

 Band (kHz) - enter the transmit frequency of the transverter  
 IF Freq (kHz) - the frequency used between the radio and the transverter  

 
An offset can also be added to adjust the transverteror radio to the exact frequency (like 
when the oscillator is a bit off).  
See the 432000,12 example where a correction is being made of 120 Hz. Great to have 
to be right on the packet cluster spots!  

Bandup/Banddown 
 
If you have a radio that has 160-2m, and you want to use bandup/banddown, you'll 
need to put entries in for bands that you do not have transverters for, if there are gaps in 
bands that the radio/transverters cover. You would really have to put a lot of 
transverters offsets in if you want the frequencies to "wrap".  

× 

 Next Offset Band 

If the next band is not defined as offset to a frequency that my radio can handle and 
bandup/down is used, it goes to an HF frequency (without offset). 

 It does not work if your radio does not accept the calculated frequency. For 
example, set up for Band: 144000 and IF freq: 28000 and you put in 146100 and 
your radio can't go to 30100, you will get strange results  

 Remember to enter the frequency of the transceiver and not that of the 
transverter when going into split mode (Alt+F7).  

5. VHF Beacons 
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N1MM logger is capable to show beacons in the bandmaps for a defined period of time. 
Normally every spot in the bandmaps will disappear after the 'Packet Spot Timeout' 
which is valid for every spot in the bandmap. The same for beacons coming in as spots. 
So an extra import option has been added for beacons with where the spot timeout can 
be set to a much higher value (like days or even weeks).  



Importing beacons and showing them in the bandmaps for the bands can be done by 
importing a text file in a specific format. Enter the text BEACONS in the Entry window 
callsign field and a file selection dialog will open where a .txt file (with beacons in the 
correct format) can be imported. An example beacons text file can be found in the 
N1MM logger program directory (called Beacons.txt). In the beacons text file lines with a 
# are remarks, the first line in the text is the timeout for all beacons in hours. Every line 
with a beacon must contain callsign, frequency (in kHz) and grid locator (4 or 6 digit). 
The frequency may be in either US (50000.25) or European (50000,25) format. A 
comment per beacon is optional. Note the ; as separator (don't forget one or it won't 
import). Below an example beacons.txt file.  

# Hours to stay in bandmap (mostly > 24 or > 48) 
 
60 
 
# Call beacon;Frequency;Grid;Comments 
 
OZ7IGY/B;144471,1;JO55WM; 
 
PI7CIS/B;144416,2;JO22DC;Should always be heard 
 
DL0PR/B;144486,3;JO44JH;Switches power! 
 
GB3VHF/B;144430.4;JO01DH;QRG with a . 
 
ON0VHF/B;144418,5;JO20;4 digit grid 

A file with beacons in the correct format for Europe (Region I) can be found on the 
N1MM website under 'Other Files' in the 'Download' menu.  

× 

 The NCDXF/IARU Beacon Network 

No need to add the NCDXF/IARU Beacon Network on 14.100, 18.110, 21.150, 24.930 
and 28.200. They are already incorporated in the program and the beacon transmitting 
at that time (when your PC clock is correct) will be shown in the Entry window statusbar 
when you are listening on one of these frequencies. 

6. Example Contest Setup 
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Additions are welcome!  

6.1. Create (Days Before the Contest) 

old-edit  

 New master.dta file  
o Use tool from Alex, VE3NEA, see the Links chapter  

http://n1mmplus.hamdocs.com/tiki-index.php?page=Links#N1MM_Logger_Documentation


 Create 'N1MM logger.ini' to use during the contest  
o Setup all the program setting and place the windows as you like them 

during the contest (on the computer to use)  
o Don't forget the tab 'Mode Control' in the Configurer.  
o After closing the program it has created a file called 'N1MM logger.ini 'with 

all the settings  
o Copy 'N1MM logger.ini' (not .init) to ' VHFsettings.ini'.  

 Text file with contents Function keys for SSB/CW  
o As a start:  

 'File | Export | Export Function Keys to file... | SSB Function Keys'  
 Give a name like: VHFssbfunctionkeys.mc  

 'File | Export | Export Function Keys to file... | CWFunction Keys'  
 Update these text files if needed  

o Check possible macros in the Macros chapter  
 Packet/Telnet button text file  

o As a start: >File >Export >Export Packet/Telnet Buttons to file...'  
o Update this text file if needed  
o Give a name like: VHFpacketbuttons.txt  
o Check possible macros in the Macros chapter like {GRIDSQUARE}  

 Lookup database text file for the VHF contests to use  
o Create a text file with callsign, name, locators etc.  
o Give a name like: VHFlookup.txt  
o See info about CallHist file  

 SSB: Wav files for CQ, rst, exchange etc.  
o Create wav files for all operators  
o See {OPERATOR} macro in the Macros chapter  

 Download up to date country file (cty.dat)  
o mostly a country file is not used for VHF and up contesting but the 

program gives information in the Info window about the logged callsign so 
download the latest version  

 Check if the selected contest is still ok, make some test QSOs  
o This should be done weeks before the contest!  

 ....  

6.2. Before Starting the Program 
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 Copy the created master.dta file in the N1MM logger program directory  
 Copy the wav files from all operators in the WAV directory  
 Turn off Windows sounds if using WAV files  

o Windows >Control Panel >Sounds - Scheme: No Sounds  
 Rename ' VHFsettings.ini'. to 'N1MM logger.ini' and copy it into the program 

directory  
o The program will start using the settings as set up days before the contest  

6.3. After Starting the Program 

http://n1mmplus.hamdocs.com/tiki-index.php?page=Macros#N1MM_Logger_Documentation
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 Select/Check if correct database is used  
o >File >Open Log in Database, select VHF database'.  

 Import  
o This has to be done only once if every time the same database is used!  
o Each database can handle many contests and thousands of QSOs, don't 

use a database for every contest!  
o Updated files (like the lookup file) have to be imported before every 

contest.  
 The function keys macros (SSB/CW)  

 >File >Import >Import Function Keys to file... >SSB Function 
Keys. Use file created above (Example: 
VHFssbfunctionkeys.mc)  

 >File >Import >Import Function Keys to file... >CW Function 
Keys. Use file created above (Example: 
VHFcwfunctionkeys.mc)  

 The packet/telnet buttons  
 >File >Import >Import Packet/Telnet Buttons from file... Use 

file created above (Example: VHFpacketbuttons.txt)  
 Lookup file  

 >File >Import >Import Call History File. Use file created 
above (Example: VHFlookup.txt)  

 Country file  
 >Tools >Import country list from downloaded file. Use file 

downloaded/updated above  
o Check Station dialog (>Config >Change your Station Data)  
o The locator from this dialog is used for distance calculation so needs to be 

entered!  
 Check contest ( >File >Choose Which Contest to Log)  

o Check if entered information is correct.  
o Enter Sent Exchange (this is contest specific, see Setup Contests 

chapter)  
 Setup configuration (Rig control, PTT, CW)  

o Check Configurer >Mode Control tab  
 When using a transverter, enter offset for bandmap A and bandmap B  
 ....  

 
Have fun during the contest!  
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3.1 Third Party Software 
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XXX This page is simply a copy without screen shots of the corresponding page in the 
N1MM Logger Classic manual XXX  

 3. References  
 3.1 Third Party Software  

o 1. AutoHotKey - AHK  

 1.1. Description  
 1.2. Examples  

 1.2.1. Simple key remapping  
 1.2.2. Using one key to send any multi-key combination  
 1.2.3. Using one key to send multiple keys at the same time  
 1.2.4. Add more functionality to an existing key  
 1.2.5. For SO2R, place a call in the inactive radio 

EntryWindow, emulating the TRLog Alt-D function  
 1.2.6. Set the numeric pad 8 & 2 keys to jump multipliers in 

the bandmap (normally a 3-finger combination)  
 1.2.7. Using single keys to grab multipliers on VFO A and B  
 1.2.8. Send a canned CW message from a non-Fkey  
 1.2.9. Tune your radio's VFO with the mouse wheel  
 1.2.10. Use extra mouse buttons for common keystrokes  

o 2. Morse Runner with AutoHotKey on N1MM Plus  
o 3. Athena (by Carel, PC5M)  
o 4. Thucydides (by Carel, PC5M)  
o 5. AB_Switcher (for SO2R without using an LPT-port)  
o 6. I8NHJ web interface  
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o 7. CC User (formerly AR Cluster User)  
o 8. Contest Reporting Application  
o 9. 2Tone (by David, G3YYD)  
o 10. QSOrder (by Vasily, K3IT)  
o 11. Real-time Log Backup - TRNMirror (by Larry, K8UT)  
o 12. Multiplier Map Display - Mult Chaser (by Patrick, NA0N)  

All programs below are freeware programs, except as noted.  

Unless otherwise noted, the instructions below have not been changed from N1MM 
Logger Classic. Some of these programs will continue to work as before, but others may 
need a rewrite or may no longer work at all with N1MM Logger+. This part of the manual 
will be updated later.  

1. AutoHotKey - AHK 

old-edit  

1.1. Description 

old-edit  

AutoHotKey  is extraordinarily powerful scripting and keyboard remapping freeware. 
You can remap keyboard, joystick, and mouse and run simple or very complex multi-
step scripts. Virtually any key, button, or combination can become a hotkey.  

AutoHotKey has no detectable performance impact on the operation of N1MM Logger.  

Once you have AutoHotkey installed, you create a script file in Notepad, name it with an 
.ahk extension, and double-click it. Windows knows that you want to run AHK, so an 
AHK logo for the script will appear in the system tray, and stay there until you actually 
exit from it. You can edit the script, read the help file, and reload the script from right-
clicks on that logo. Each time you edit the script you need to reload it - also through 
the right-click on the logo.  

1.2. Examples 
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Any of the following scripts can be copied verbatim and pasted into Notepad, then 
modified or saved with a new filename and an .ahk suffix.  

× 

 Special Characters in AutoHotKey Definitions 

Text after a semicolon is comments, and is not executed. The symbol "^" denotes the 
[Ctrl] key, and "!" denotes the [Alt] key. When one of those symbols is combined with a 
key (such as ^i), the effect is to send Ctrl+i (i.e., both keys pressed simultaneously). See 
the AutoHotKey help file and tutorials for further details.  

1.2.1. Simple key remapping 

http://www.autohotkey.com/
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NumpadEnter::F10 ;Remap the number pad Enter key to F10  

1.2.2. Using one key to send any multi-key combination 
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#UseHook  
#SingleInstance force  
#IfWinActive,,S&pot It ; makes script active only when N1MM Logger Entry window is 
active. This works because the word Spot occurs only in that window.  
SetNumlockState, AlwaysOn  
Numpad7::Send !{F9} ; Numeric key 7 - toggle antennas for a band  
Numpad8::Send ^i ; Numeric key 8 - toggle Advanced SO2R  
Numpad4::Send ^b ; Numeric key 4 - toggle dueling CQs  
Numpad9::Send !r ; Numeric key 9 - toggle repeat CQs  
Numpad5::Send ^{F1} ; Numeric key 5 - send CQ on radio that does not have entry 
focus  
Numpad6::Send !w ; Numeric key 6 - wipe  
Numpad0::Send {ESC}\`` ; Numeric key 0 - return from S&P to work station calling on 
run radio  
Numpad1::Send \``; Numeric key 1 - go back to S&P on opposite radio  

1.2.3. Using one key to send multiple keys at the same time 
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Numpad1:: ; Pressing number pad 1 invokes F5 and Pause  
Send {F5}  
Send {Pause}  
return  

1.2.4. Add more functionality to an existing key 
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$Pause:: ;Changes the Pause key to first do F5, then do the N1MM Pause key function. 
The $ keeps the script from calling itself.  
Send {F5}  
Send {Pause}  
return  

1.2.5. For SO2R, place a call in the inactive radio EntryWindow, emulating the TRLog Alt-D function 
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!d:: ;Alt-D  
InputBox call  
Send {\}  
Send ^w  
Sleep 200  
Send %call%  



Send {\}  
return  

1.2.6. Set the numeric pad 8 & 2 keys to jump multipliers in the bandmap (normally a 3-finger 

combination) 
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#SingleInstance force ; Force this script to replace the last one, not append  
SetNumlockState, AlwaysOn  
#ifWinActive,,S&pot It ; Look for the spot button on the entry window to see if entry 
window has focus  
Numpad8::sendinput, !^{up}  
Numpad2::sendinput, !^{down}  
#ifWinActive  

PrintScreen:: ; If printscreen is pressed, invoke N1MM Logger, or activate it if it is 
already running  
IfWinExist,,S&pot It ; look for the spot button on the entry window to see if the program 
is running  
WinActivate  
else  
Run, C:\N1MM Logger\N1MM Logger.exe, C:\N1MM Logger  

1.2.7. Using single keys to grab multipliers on VFO A and B 
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#UseHook  
#SingleInstance force  
#IfWinActive,,S&pot It ; makes script active only when N1MM Logger Entry window is 
active. This works because the word Spot occurs only in that window.  
SetNumlockState, AlwaysOn  
Numpad7::Send ^!{Up} ; Numeric key 7 - VFO A Go to next multiplier up the bandmap  
Numpad1::Send ^!{Down} ; Numeric key 1 - VFO A Go to next multiplier down the 
bandmap  
Numpad9::Send ^!{Up} ; Numeric key 9 - VFO B Go to next multiplier up the bandmap  
Numpad3::Send ^!{Down} ; Numeric key 3 - VFO B Go to next multiplier down the 
bandmap  

1.2.8. Send a canned CW message from a non-Fkey 
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#UseHook  
#SingleInstance force  
#IfWinActive,,S&pot It ; makes script active only when N1MM Logger Entry window is 
active. This works because the word Spot occurs only in that window.  
SetNumlockState, AlwaysOn  
Numpad1::Send ^k testing?^k ; Send a CW message from a designated hotkey 
(Numeric key 1 in the example).You'll see the Ctrl+K keyboard window appear and 



quickly disappear, but the CW continues to be sent until it is done (unless you hit ESC 
to interrupt it)  

1.2.9. Tune your radio's VFO with the mouse wheel 
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Script written by K8UT, with revisions by KU1T  

;next two lines are for testing the definition. uncomment them to make them work  
;WheelDown::MsgBox You turned the wheel DOWN  
;WheelUP::MsgBox You turned the wheel UP  

;This script works, but you lose the Bandmap zoom mouse wheel feature. Use the 
keypad + and - keys instead  

#UseHook  
#SingleInstance force  
#IfWinActive,,S&pot It ; makes script active only when N1MM Logger Entry window is 
active. This works because the word Spot occurs only in that window.  
SetNumlockState, AlwaysOn  

Numpad9::Send {Up} ; Numeric key 9 - toggle repeat CQs  

;--- x10 large frequency shift - hold down Left Shift, numeric pad 9 = 10 keypresses  
LShift & Numpad9::Send {Up}{Up}{Up}{Up}{Up}{Up}{Up}{Up}{Up}{Up}  

Numpad6::Send !w ; Numeric key 6 - wipe  

Numpad3::Send {Down} ;  

;--- x10 large frequency shift - hold down Left Shift button, Numeric pad 3 = 10 
keypresses  
LShift & Numpad3:: Send 
{Down}{Down}{Down}{Down}{Down}{Down}{Down}{Down}{Down}  

;and finally wheel works  
WheelUp::Send {Up} ; spin wheel forward, frequency moves UP  
WheelDown::Send {Down} ; spin wheel backward, frequency moves DOWN  
;--- x10 large frequency shift - hold Left SHift button, spin wheel = 10 keypresses  
LShift & WheelUp::Send {Up}{Up}{Up}{Up}{Up}{Up}{Up}{Up}{Up}{Up} ;  
LShift & WheelDown:: Send 
{Down}{Down}{Down}{Down}{Down}{Down}{Down}{Down}{Down} ;  

1.2.10. Use extra mouse buttons for common keystrokes 
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; Special keys using the Microsoft model 1007 mouse which has two additional aux 
buttons  
; Send N1MM common keystrokes from the mouse  
; Facilitates RTTY operation entirely from the mouse  
MButton:: Send {Enter} ; press wheel sends <Enter> for ESM  
XButton1:: Send {Enter} ; press wheel sends <Enter> for ESM  



XButton2:: Send {Esc} ; aux mouse button2 sends <Escape>  
Return  

2. Morse Runner with AutoHotKey on N1MM Plus 

These N1MM+ instructions provided by Andy KU7T dated 5 December 2014:  

I am getting quite a few requests for the instructions how to run MorseRunner with 
N1MM Logger+. Here is the info:  

The AHK script for N1MM Plus is already installed in your user folder under "<your user 
folder>\SupportFiles\MorseRunner-N1MMLPlus.ahk". There is no need to download it 
from anywhere. (NOTE: The original script written by K7OG only works for N1MM 
Classic).  

1. Install MorseRunner from VE3NEA: http://www.dxatlas.com/morserunner/  
2. Install AHK from http://www.autohotkey.com/  
3. Start new contest in N1MM Logger+ as WPX CW  
4. Turn off Rig control in N1MM Logger+  
5. Set ESM and run mode  
6. Launch MorseRunner  
7. Launch AutoHotKey script as Administrator (remember, the one in your user 

folders)  
8. In MorseRunner, start a WPX competition  
9. Put entry focus on N1MM EntryWindow and hit F1  
10. Make some Qs...  

 
Thanks  

Andy KU7T  

As of 8 Dec 2014, you can also view a step-by-step video by clicking HERE  

3. Athena (by Carel, PC5M) 
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Athena provides the following features:  

 Display of real-time contest statistics  
 Graphs will show hourly rate, cumulative totals and goal  
 Graphs selectable for number of QSO's and multipliers, points or score  
 Graphs per operator and band  
 All band numerical statistics with indication on how many minutes/qso's a new 

multiplier will be "worth"  
 Goal data can be imported from previous (n1mmlogger) contests and is text file 

based  
 Goals can easy manipulated to fit into current contest view  

http://n1mmplus.hamdocs.com/tiki-download_file.php?fileId=2417


 
Athena was developed to provide a (near) real-time insight in how the contest is 
progressing; How many qso's, multipliers have been worked and what the current score 
is. This data is presented per band and/or as a total view for all bands. Operator specific 
data can be shown to see how your operators are doing individually. In addition goal 
data can be added to the band graphics to get a feeling how thing are going. This goal 
can be imported from previous contest or build up from scratch. Goal data can be easily 
saved and read back as requested. Due to the fact that the current goal implementation 
of n1mmlogger is rudimentary the goal data of n1mmlogger is not used.  

Athena will only read data from n1mmlogger and will not make any alteration to any 
n1mmlogger file, including the precious database file (.mdb). Statistics will be calculated 
on the fly and stored in between. Only the created goal data will be stored on the file 
system in a XML file format. Athena user setting (a.o. last contest, or if operator data is 
enabled) will be stored per (windows) user in the user data application directory.  

 
 
 
 
Athena is freeware and can be downloaded from his web site .  

4. Thucydides (by Carel, PC5M) 
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Thucydides generates and updates Call History files for use with N1MM Logger.  

 
 
 
 
See PC5M's web site  for full documentation and the free download.  

 

5. AB_Switcher (for SO2R without using an LPT-port) 
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AB_Switcher is a program to allow radio a/b switching on a comport without the use of a 
parallel port on the host computer. Basically this program monitors that sound card 
mixer output levels and switches the DTR on the chosen COM port to reflect the current 
radio TX focus. For more details click HERE   

The program supports switching of the Receive as well as the Transmit Focus. This 
works under N1MM when in the "$5 S02R" mode. A second COM port is used to output 
on DTR and RTS the necessary data to switch external S02R boxes that support 

http://www.pc5m.net/projects/software/athena
http://www.pc5m.net/projects/software/thucydides
http://wr0dk.home.comcast.net/~wr0dk/abswitcher.html


Receive Focus switching. It does this by watching the sound card mute controls for the 
selected inputs. AB Switcher Version 2 can provide any combination of the three SO2R 
control signals. If only two of the three signals are needed, AB Switcher requires only a 
single serial port and can use a port above COM8.  

With Dan's driver, it is now possible to effectively use the microHAM MK2R/MK2R+ 
SO2R controllers with N1MM Logger and a "USB Only" computer. The SW Synth and 
CD Audio inputs on the second codec (USB Audio CODEC) in MK2R+ can be used as 
the Left/Right audio sources for "$5 SO2R" without effecting any of the other options 
making USB Audio CODEC an ideal "target" for $5 SO2R.  

NB. It is hoped that AB_Switcher will be an interim solution until the various contest 
programs make the SO2R control signals (TX Focus, RX Focus and Stereo) as options 
for the serial port DTR and RTS lines. 73, Joe, W4TV  

6. I8NHJ web interface 
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I8NHJ has created a very nice web Interface to the N1MM Logger Database. This 
interface gives statistics about the contest, worked stations and much all in real time 
when needed. See the file WebInterface_Howto.txt in the zip file for installation 
instructions. Tested on Windows NT/W2K/XP. You'll need MS Office and MS Access 
2000. MS Office is not needed to run N1MM Logger only needed for the web interface!  

From the HowTo.txt file and additional info from Max, I8NHJ  

This program was designed to allow an easy, powerful and versatile interface to the log 
generated by the N1MM Logger during a contest or DXpedition. It is distributed AS IS, 
under the GNU license terms. It can be freely used and distributed but please leave in 
place the references to me (I8NHJ) and to the programmer (AGO) who helped in 
developing the code. Version 1.0, November 2002  

The Web Interface is written using in-deep ASP techniques and it needs a full-asp 
support. This means that some investigation should be made to find a good ASP 
support for other platforms than Microsoft. Here we strongly use Linux but so far we still 
haven't found any working support for ASP and, moreover, this kind of solution could 
become too complex for the average user.  

To get the full functionality from the tool, the Microsoft Office package must be installed 
on the Server side. Ms Access is not really needed but some graphical features are 
performed by components from Excel and Word.  

To generate the graphics you need MS Office on the server side. If you haven't it, the 
Web Interface runs anyway but you will not get charts. NB.  

Below an explanation from Franki, ON5ZO  

Max I8NHJ has made an interface to go with the N1MMLogger software and it's 
database (*.mdb files).  



Max kindly offered this tool to us, the N1MM Logger users. You can download the 
program from the N1MM logger web site  under 'Downloads', select in the menu: 
'Other Files'. The file name is 'webinterface1-x.zip'. This is not a program that can run 
on its own. In fact, it is some kind of web site/web page (without getting into details). 
This requires that you run a web server on your own Windows PC at home. There are 
several possibilities:  

1. You know all about servers and ASP, and have an ASP capable server running. 
You're on your own, you're smarter than I am... 
 
2. You are running Windows 2000 / NT / XP Pro > there's this thing called IIS that you 
need to install by inserting the CD, and run Windows Setup > Add components (The 
names may vary according to what Windows version you are using). 
 
3. Win XP Home: too bad, IIS does not come with the 'light' version, so either you 

 Mess with XP Home, some did with success, others like me without any luck go 
to: http://www.15seconds.com/issue/020118.htm  

 install a FREE non-Microsoft server and add ASP support. (See information 
below from Dave, G3VGR) 

4. You run Windows 98 (and maybe this is good for Windows 95 too, did not test this): 
go to: http://coveryourasp.com/PWS.asp . Follow steps 1 to 7 (included)  

When you finished option 1 or 2 or 3 or 4 successfully, and the server (IIS or PWS) is up 
and running, follow Max his guidelines in the ZIP-file.  

73' Franki  

Below some additional information from Dave, G3VGR  

I've just successfully implemented the I8NHJ interface, using the freeware Abyss Web 
Server from http://www.aprelium.com/ .  
ASP support needs to be added using the freeware ActiveHTML software from seliSoft. 
http://www.selisoft.com/en/ahtml/   
The Aprelium web site gives a blow-by-blow account on how to add this support 
http://www.aprelium.com/abyssws/asp.html   

I only started using Logger today, so have only used a very small test log to verify all 
this.  

73, Dave  

Below some additional information from Uffe, PA5DD  

I recently re-installed my whole system to Windows 2000 (same goes for XP etc.). It all 
works fine until I want to use the I8NHJ Web interface when the Logger has the same 
.mdb database file open. Then access is refused. Reason is that the Logger opens the 
database file "exclusively". This is a question of access rights. After installation of the 
Web interface, Internet user access rights has to be awarded to the directory where the 

http://www.n1mm.com/
http://www.15seconds.com/issue/020118.htm
http://coveryourasp.com/PWS.asp
http://www.aprelium.com/
http://www.selisoft.com/en/ahtml/
http://www.aprelium.com/abyssws/asp.html


Web interface is, as well as the Logger directory. To see how, use the link: 
http://www.aspemporium.com/aspemporium/tutorials/permdenied.asp  

The Web server should have default.asp in its Default Document list. Alternatively you 
could address the page directly: http://localhost/logger/default.asp   

73 Uffe PA5DD  

Personal Web server  

If you have Windows 95 installed on your computer, you can install the Microsoft 
Personal Web Server from the Windows NT 4.0 Option Pack. You can download the 
Option Pack from the Microsoft Web site. Microsoft Personal Web Server can also be 
found in the "Add-on\pws" directory on the Win98SE install CD (at least on this 
Win98SE upgrade CD, US version).  

Below some additional PWS information from Frans, PA5CA  

I installed the PWS software for win98se, please note to install (over write) one of the dll 
files before executing the install. It took me some time before I got the ASP statistics to 
work, now I'm quit happy. I used the following links...  

http://support.microsoft.com:80/support/kb/articles/Q246/0/81.ASP   

http://support.microsoft.com/default.aspx?scid=fh;NL;w98   

73' Frans PA5CA  

7. CC User (formerly AR Cluster User) 
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CC User by Lee, VE7CC is a full featured Telnet and TNC program for use with AR 
Cluster, CC cluster or DX Spider Nodes.  
It has telnet and RS-232 outputs for logging and contest programs like N1MM logger. 
Runs under Windows 95 to Windows 8 and can auto reconnect and automatically gets 
missed spots. It can be used with telnet and TNC's.  
The program can receive spots both in connected and unconnected modes, this means 
it also recognizes spots when NOT connected to any packet node, just monitoring the 
RF channel where other users are receiving spots is good enough.  
CC User greatly simplifies the process of setting up spot filters at the cluster node.  

Setting up CC User with N1MM logger  

 Settings CC User  
o Connect to your packet node with CC User  
o Go to Configuration - Ports/Logger Program  
o Check "Telnet" Logging Program Connection, Apply for both the Node 

Connection and the Logging Program Connection  
 Open N1MM Logger  

o Go to Config - Change Telnet Cluster List  
 If there isn't already an entry, add CC User  

http://localhost/logger/default.asp
http://support.microsoft.com/support/kb/articles/Q246/0/81.ASP
http://support.microsoft.com/default.aspx?scid=fh;NL;w98


 Use 127.0.0.1:7300 if CC User and N1MM are on the same 
computer  

 Check the CC User website for instructions on using multiple 
computers  

o Open the Telnet Window and connect to CC User  
 You should see spots flow into N1MM Logger from CC User  

 
Check out the the CC User  website.  

8. Contest Reporting Application 
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The Contest Reporting Application (Realtime score reporting) can be started by 
checking "Start Contest Reporting Application" on the Other tab of the Configurer. With 
this application you can show your contest efforts in real time during a contest to the 
world. This application automatically uploads your scores from the current selected 
contest to the configured website. Starting with version 13.02.00, the default for this 
website is cqcontest.ru.  

× 

 Stop Score Reporting 

Note that this will keep reporting everything until you uncheck it. Doesn't matter if you 
are testing, or operating in a contest. It will be reported. So either close it or click "Stop 
Send" if you don't want that. 

When the application has been started the dialog below will be shown.  

 
 

 
 
 
 
In the middle a countdown counter in seconds will be shown which can be set in the 
Setup (see below). When the counter reaches 0 your score will be sent to the 
configured website.  
The status field next to it will give status information (like error messages). A small 
button to right of status field shows response from last upload and creates a file with 
sent and received data for debugging problems. Version information is shown in the 
middle of the dialog.  

 Stop Send / Send Score - Stop the sending of scores to the configured website.  
 Get Scores - Clicking this button will open the configured website in your browser 

so you can view your and other stations scores.  

http://www.ve7cc.net/


 Setup - will open the Setup dialog below.  

 
Note that the score will be send to the website for the first time at program startup.  

 
 
 
 
The setup dialog configures the realtime scoring application.  

 Score Post Time (min) - Set the timer how often your score will be uploaded to 
the configured website. The possible times to set are: 2, 5, 10,15,30 and 60 
minutes. Also a manual mode possibility can be selected. To send the score the 
'Send Score' button has to be pressed.  

 Score Posting URL - The url of the website to post your scores to.  
 Score Reading URL - The url where the scores are displayed.  
 Listening IP - Shows the IP address on which N1MM logger is running. By 

default this is the same computer as where the real time scoring application is 
running on. This setting is set by N1MM logger.  

 Listening Port - Shows the port from which N1MM logger will send the 
information to the real time scoring program. This setting is set by N1MM logger.  

 Defaults - Fill the dialog with default values.  
 Cancel - Cancel the entered values and close the dialog.  
 OK - Save the values and close the dialog.  

 
During major contests several real time score reporting web sites may be up and 
running. An example website from Gerry, W1VE below.  

 
 
 
 
By Gerry, W1VE: 
 
Through the encouragement of many, I decided to take on the project of creating a 
usable web portal for realtime score reporting. The result is now ready.You can view the 
portal at: http://live.getscores.org  

The scoring upload to the site is based on work by Bruce, WA7BMN, with his Contest 
XML schema, and scoring trials last year by Tom, N1MM and the N1MM logger.  

The latest version of N1MM fully supports score posting. If any other contest software 
vendor supports the HTTP POST method of score reporting, it is immediately 
compatible with getscores.org. Additionally, getscores.org supports a SOAP-based Web 



Service API. The success of the site will depend on participation and the support of 
software vendors. There are links on the live.getscores.org site for FAQs.  

The viewing site supports many filters, so that you can look at only what you want to 
look at. Filter by Class, Power, CQ Zone, IARU Zone, State/Prov and lots more. Your 
filter preferences are saved as a cookie by your browser for up to 7 days. The page 
automatically refreshes every 60 seconds with score information.  

the website will support many contests as listed on the site.  
The window is by Score with the highest score first within the operating class, Power 
Class and mode. The general idea here is not to look at everything: apply a filter and 
you'll get a more representative view of you are looking for.  

A scoring period is a rolling window of 72 hours. If you post for a particular contest 
during the 72 hour period, any time you post an update, you will simply update your 
score for that contest. This way, if there are two supported contests over a weekend, 
you can submit to both. The unique key is the name of the contest and the callsign.  

By the way, I want everyone to know that getscores.org is not an "N1MM" effort. In fact, 
I want to ensure it is not. I'm sure that Tom would agree. We must get as many of the 
contest authors to participate, otherwise, this type of site is useless. We need to see lots 
of scores, not just those from the N1MM logger. That said, BIG KUDOS to K1TTT and 
N1MM for getting the posting software in great shape quickly, and to all of you users for 
testing — that's a great way to get the site in good shape for CQWW.  

If you have any questions or suggestions about the site, please send them to me at the 
email addresses provided on the site, or via gerry@w1ve.com.  

The ethics  
Tom, N1MM: I don't see any issue with reporting your score. You are not "spotting" 
yourself, there is not a frequency specified other than the bands you have operated on.  

9. 2Tone (by David, G3YYD) 
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2Tone is a drop-in replacement for MMTTY using different decoding and encoding 
algorithms. It can be used in any of the Digital Interface or Additional RX digital windows 
in N1MM Logger in place of MMTTY. Many users have found that it decodes more 
accurately than MMTTY under difficult conditions.  

To obtain a copy, you must join the N1MMLogger-Digital user group at Yahoo. Go to the 
Yahoo web page for the group, select the Files page , find the folder named "G3YYD", 
and look in that folder for the latest version. Download the zip file containing the most 
recent version and unzip it into a suitable directory (such as a folder called "2Tone" 
inside the N1MM Logger program folder). Read the documentation that is included in 
the zip file for installation and operating instructions. Note that when configuring any of 
N1MM Logger's digital windows to use 2Tone, you set up the window as if you were 
using MMTTY, except that the fully qualified filename in the setup ends with 
"2Tone.exe" instead of "MMTTY.exe".  

http://groups.yahoo.com/group/N1MMLogger-Digital/files/


2Tone transmits using AFSK. If you use FSK when transmitting RTTY (e.g. in order to 
take advantage of better filtering in your radio in FSK mode), you can still take 
advantage of 2Tone's decoder on receive by configuring an additional RX window to 
use 2Tone instead of MMTTY, while leaving the main DI window using MMTTY in FSK 
mode. In fact, even when using AFSK you may wish to have decode windows for both 
MMTTY and 2Tone open simultaneously. For a step-by-step tutorial on setting up 
2Tone in an RX-only window, see step 4 of this tutorial by AA5AU . For a screen shot 
of multiple parallel decoder windows in action, see this web page posted by AA5AU . 
Note that if you wish to use 2Tone in more than one digital window, you should create a 
separate folder for each copy and configure the relevant digital window to point to that 
copy.  

10. QSOrder (by Vasily, K3IT) 
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QSOrder is a QSO recording program written by Vasily, K3IT, to enable N1MM Logger 
users to record contest QSOs on the fly and replay them. QSOs are stored individually 
in folders labelled with the contest name.  

Download QSOrder as a zip file from the QSOrder project area at Sourceforge.net . 
Create a folder in which you will store the contest recording folders (e.g. a Contest 
Recordings folder within your N1MM Logger program folder) and unzip the contents of 
the zip file into that folder.  

QSOrder uses N1MM Logger's UDP broadcasts. Follow the instructions in the 
downloaded readme.txt file to modify your N1MM Logger.ini file to include broadcasts of 
contact information from N1MM Logger to QSOrder. Note that the default port in the 
instructions is 12060. If you use other plugins that rely on UDP broadcasts from N1MM 
Logger, you may need to change the port number used by QSOrder in order to avoid 
conflicts. If you wish to use a different port number, change the port number used for 
contact broadcasts in the N1MM Logger.ini file and use QSOrder's PORT command-line 
flag to tell it to use the port number you have chosen (e.g. -P 12061).  

To use QSOrder for a particular contest, start the QSOrder program and run it at the 
same time as N1MM Logger. Each time a QSO is logged in the Logger, a UDP 
broadcast will trigger QSOrder to save a recording of that QSO. Recordings are saved 
in a sub-folder named by contest-name and year, and each QSO is saved in a file 
whose name includes the callsign of the station worked, the name of the contest, the 
date, time and band. The length of each recording is determined by the buffer length 
option, and the recordings are set to run until a specified delay time after the contact is 
logged; both of these time parameters are configurable using command-line flags. To 
use one of these command-line flags, insert it into the Target: line in the desktop 
shortcut you use to start QSOrder with, e.g. Target: "C:\N1MM 
Logger\Recordings\QSOrder.exe" "-P 12061" .  

11. Real-time Log Backup - TRNMirror (by Larry, K8UT) 
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http://rttycontesting.com/n1mm/n1mm-quickstart-index.html
http://rttycontesting.com/2Tone/AA5AU-9U4U-40M-QSO.html
http://sourceforge.net/projects/qsorder/


TRNMirror monitors the N1MM Logger log files and maintains a shadow copy of your 
contest log in a second location.  

Features  

 Provides a log recovery mechanism in the event of a hard drive or computer 
crash  

 Automatically tracks new transaction files from new logs and new contests  
 Creates mirror files on a second hard drive in the PC, a USB thumbdrive, or a 

networked drive  
 Copies the N1MM Logger TRN file based on events (when the TRN file changed) 

or time (after n minutes since last copy)  
 Only makes a mirror file when the TRN file has changed  
 Creates n versions of the transaction file, based on configuration settings  
 Renames the mirror files using version numbers (filename(1).trn, filename(2).trn, 

filename(3).trn...)  
 Stores latest settings and mirror version counts in INI files  

 
Documentation and download instructions: www.k8ut.com/tiki-
index.php?page=TRN+Mirror+Utility+Documentation   

12. Multiplier Map Display - Mult Chaser (by Patrick, NA0N) 
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Mult Chaser is a free add-on program for N1MM Logger that displays contest multipliers 
on a map of North America as they are worked. The program reads from the specified 
N1MM Logger database after each contact, provided that Mult Chaser and N1MM 
Logger are both configured appropriately. Mult Chaser supports contests with 
ARRL/RAC sections as multipliers (Sweepstakes, Field Day, ARRL 160), contests with 
states/provinces as multipliers (NAQP, ARRL RTTY), contests with grid squares as 
multipliers (Stew Perry), and US State QSO parties.  

Documentation: https://sites.google.com/site/korkowp1/mult-chaser-help   

Downloads: https://sites.google.com/site/korkowp1/mult-chaser-downloads   

 

3.2 Customizing the DXCC List 
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 3.2 Customizing the DXCC List  

o 1. Updating the country file - CTY.DAT  
o 2. Writelog country file  

http://www.k8ut.com/tiki-index.php?page=TRN+Mirror+Utility+Documentation
http://www.k8ut.com/tiki-index.php?page=TRN+Mirror+Utility+Documentation
https://sites.google.com/site/korkowp1/mult-chaser-help
https://sites.google.com/site/korkowp1/mult-chaser-downloads


This section of the manual may be outdated - will be reviewed and updated later.  

1. Updating the country file - CTY.DAT 
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× 

 The Country File 

The information that follows should rarely, if ever, be needed. Jim Reisert, AD1C, is 
very punctual in releasing new versions of the various country files, particularly before 
each major contest. 

The program uses a country file from which it takes all the information like the country 
name, CQ zone, ITU zone, continent, latitude and longitude etc. This file mostly called 
CTY.DAT is not directly used by the program but has to be read into the currently used 
database. The program will retrieve all information from the database (not from the 
cty.dat file). When importing the country file the program will ask for the file to import. 
this way several cty.dat files could be used for different contests.  
 
When entering a callsign the left pane of the Entry Window will give Prefix, country 
name, CQ zone and continent. The Info Window will also give this information and 
additional calculated information like beam heading, distance, sunset and sunrise.  

A number of high profile stations who are not in their own call area, have this built into 
the country file. The file will populate the correct zone, even though it looks out of place. 
An example is K2KW who we would expect in zone 5 but lives in California and is 
entered in the CTY.DAT file living in zone 3.  
How to update the country file.  

 Download the update using the menu item 'Download latest country file 
(wl_cty.dat)(Internet)' from the Tools menu.  

 This item will open your web browser to the web page where to download the 
latest wl_cty.dat file (Select the correct one..).  

 After downloading the new country file it has to be imported in the program by 
selecting 'Tools | Import country list from downloaded file'.  

 
CTY.DAT file format  
The format from CTY.DAT is as follows:  

Column Length Description  

1 26 Country name terminated by a colon character.  

27 5 CQ zone terminated by a colon character.  

32 5 ITU zone terminated by a colon character.  

37 5 2-letter continent abbreviation terminated by a colon character.  



42 9 Latitude in degrees, + for North terminated by a colon character.  

51 9 Longitude in degrees, + for West terminated by a colon character.  

61 9 Local time offset from GMT terminated by a colon character.  

69 6 Primary DXCC Prefix terminated by a colon character.  

next 
line(s)  

List of prefixes assigned to that country, each one separated by a 
comma and terminated by a semicolon. 

× 

  

The fields are aligned in columns and spaced out for readability only. It is the ":" at the 
end of each field that acts as a delimiter for that field. 

 
Alias DXCC prefixes (including the primary one) follow on consecutive lines, separated 
by ",". If there is more than one line, subsequent lines begin with the "&" continuation 
character. A ";" terminates the last prefix in the list.  

If the country spans multiple zones, then the prefix may be followed by a CQWW zone 
number in parenthesis, and it may also be followed by an ITU zone number in square 
brackets, or both, but the CQ zone number in parenthesis must precede the ITU zone 
number in square brackets.  

The following special characters can be applied to an alias prefix:  
(#) Override CQ zone where # is the zone number  
# Override ITU zone where # is the zone number  

2. Writelog country file 
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N1MM logger can also use the country file WL_CTY.DAT from WriteLog which has 
extra CQWW zone information for several countries including: Canada, Australia, and 
China. Because each of these countries is allocated a multitude of prefixes, but the 
CQWW zone is determined by the call area regardless of prefix, a very large number of 
entries would be necessary to spell out all the combinations. Instead, WL_CTY.DAT 
contains special "macro" commands that indicate how the CQWW zones are 
determined for that country. See the example below. See the update instructions.  

Importing the wl_cty.dat file as country file is preferred over the 'normal' cty.dat file 
because of the extra information it contains.  
Other info  

 You can override the continent, zone etc. on a prefix-by-prefix basis.  
 Primary prefixes preceded by an * are only valid for the CQWW and WAE 

contests. The logging program will ignore these lines otherwise. When updating 
the country file please don't remove the *.  



 The logging program doesn't handle prefixes such as FR5ZQ/J correctly. Listing 
FR/J as a prefix for Juan de Nova in the country file doesn't work unless a station 
signs "FR/J" as his callsign. If you work one of these islands, you'll have to add 
the callsign of the worked station to the country file manually before it is counted 
as the right country.  

 When updating the CTY.DAT file use a text editor, not a word processor. 
Notepad is fine, watch out for WordPad etc., always save as a text file!  

 After updating the CTY.DAT file it has to be reloaded. Reload the file via 
Tools/Import country list from downloaded file.  

 After a Reload the prefixes are imported into the database which you are using. 
When changing to another database you have to do a reload again to be sure 
that you use the most recent country file for that database (or the one you want).  

 When a database is copied, also the country list in it will be copied. So if the 
country file was updated in the original file after a copy you don't have to import 
the country list again.  

 
Note on KG4 stations: When a KG4 callsign is a 2x2 callsign it is assumed to be 
Guantanamo otherwise it is K (2x1 or 2x3). When the exact callsign appears in the 
loaded cty.dat the associated country will be used (K or KG4 are then not automatically 
assumed).  

Examples  

Netherlands: an easy example with nothing special. The program will assign all calls 
starting with PA, PB, PC, etc. to the country Netherlands in CQ zone 14, ITU zone 27 
and EU as continent. PA will be the the prefix shown in the multiplier window.  
Netherlands: 14: 27: EU: 52.40: -4.90: -1.0: PA:  
PA,PB,PC,PD,PE,PF,PG,PH,PI;  

Greenland: Normally only stations with OX are counted as Greenland. The callsign 
XP1AB has been added which normally belongs to Denmark (OZ). XP1AB will be valid 
as Greenland with standard Greenland parameters i.e. zones, continent etc.  
Greenland: 40: 05: NA: 62.50: 45.00: 3.0: OX:  
OX,XP1AB;  

African Italy: This is an example where a * is added before the primary prefix which 
means that the country only counts in CQ-sponsored contests.  
African Italy: 33: 37: AF: 35.40: -12.50: -1.0: *IG9:  
IG9,IH9,IQ9L,IZ9;  

Other nice examples with zone changes on calls are VE and UA9, see the CTY.DAT file 
in the program directory.  

Writelog macro example.  
The macro starts with # and ends with the next ; It means that for all the prefixes in 
China the zones are determined by the call area and first letter of the suffix.  
China: 24: 44: AS: 40.00: -116.40: -8.0: BY:  



1. BY: BY3G(23),BY3H(23),BY3I(23),BY3J(23),BY3K(23),BY3L(23),  

BY9A(23),BY9B(23),BY9C(23),BY9D(23),BY9E(23),BY9F(23),BY9G(23),  
BY9H(23),BY9I(23),BY9J(23),BY9K(23),BY9L(23),BY9T(23),BY9U(23),  
BY9V(23),BY9W(23),BY9X(23),BY9Y(23),BY9Z(23),BY0(23);  
3H,3I,3J,3K,3L,3M,3N,3O,3P,3Q,3R,3S,3T,3U,BG,BT,BW,BY,BZ,XS;  

 

3.3 Technical Information 
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The information on this page is applicable only to N1MM Logger Classic and 
much of it does NOT apply to Plus. The page will need to be completely rewritten 
for N1MM Logger+ - to be updated at a future date.  

 3.3 Technical Information  

o 1. Directory structure  
o 2. Where is the program information stored?  
o 3. The Access database  
o 4. The "N1MM logger.ini" file  

 4.1. Functions  
 4.2. Window Section  

o 5. Program files  
o 6. Database files  
o 7. Files created on your command:  
o 8. RTTY files  
o 9. PSK and other modes  
o 10. PSKCore files (all obsolete)  
o 11. ADIF fields  
o 12. Callsign checking in the Digital Interface  
o 13. Routers and Firewalls  

 13.1. Adding N1MM to the Windows firewall  

N1MM logger is a contest program written in Microsoft Visual Basic which uses a 
Microsoft Access 2000 database for storing information. Writing and retrieving data to 
and from the database is done with SQL (Structured Query Language).  
Running the program needs no more programs or files than supplied in the installation 
package and the program update (NewExeVx.x.x).  

Do you need all the information given below to use the program? NO  

× 

 Warning 



We recommend not to change any data in the database or any other files unless you 
are very sure what you are doing. It is possible to change the behavior of the program 
and get erroneous results. If you have changed the contents of the database and the 
program behaves strange go back to the original (unaltered) version of the database.  
 
No support will be given to users who change the database structure or contents. The 
same goes for changing other files used by the program.  

You are on your own! 

 
Note: Normally there is no need to access the database or ini files.  
Don't make changes if you are not very sure what you are doing. Second and last 
warning!  

When you are interested in the structure of the database you need to have installed 
Microsoft Access 2000 or the Access 2000 viewer or more recent versions.  

Note: When changing data always make a backup from the database (and preferably 
the whole N1MM logger directory).  

Why is this information given?  

Accessing information direct in the database sometimes gives possibilities not directly 
supported by the program.  

Examples:  

 You want to have reports which are not standard in the program. With some 
knowledge of SQL and Access it is possible to generate your own.  

 Changing information in the database can sometimes be done much easier this 
way than within the N1MM logger program.  

× 

 Note 

After changing QSO information always do a rescore! Multiplier information and QSO 
points will be updated after a rescore so any changes made direct in the database will 
be lost. Change multiplier and QSO points in the (Cabrillo) output files. The program 
updates the database and not the other way around.  

N.B. It is not possible to add a contest to the program this way.  
Contests and it's rules etc. are in the main program file (N1MM logger.exe) and are not 
stored in the database or any other files!  

1. Directory structure 
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The default directory where the program is installed is in the 'Program Files' directory on 
the first hard disk (C:). Below this directory two directories are (or can be) made to 
support Digital Voice Keying (DVK).  

C:\Program Files\N1MM 
Logger 

Program file directory  

C:\Program Files\N1MM 
Logger\Wav 

Directory to store all wav files used in the SSB function 
keys. You have to make these yourself. 

2. Where is the program information stored? 
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There are several places where program information is stored.  

 The Access database file  
o After a first install called HAM.MDB  
o You can rename it or add your own databases from within the program.  
o General contest information  

 Contests information  
 Station information  
 QSOs made in the contests  
 Packet spots  
 (Function) key information  
 Country information  
 Etc.  

 N1MM logger.ini file  
o Program settings from the configuration screens , these settings overrule 

the settings in 'Default Settings.ini'  
o Window settings (screen setup)  

 Default Settings.txt  
o Default settings file used by the program  

 Configuration files  
o Setting up your external TNC  
o MMTTY specific files  

 Other files  
o Wav files for CQ etc.  
o Exported Cabrillo, ADIF, generic log and summary sheet files  
o Section files used for specific contests (*.sec)  

3. The Access database 
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A database has tables with in it the data.  

Table Contents  



Antennas 
Antenna information 
('Config  

Configure Ports, Telnet 
Address, Others  

Tab: 
Antennas')  

BandModeFrequency 
Radio (vfo) number, frequency and mode information used when 
changing band.  

CallHist Table used for 'Call History Lookup' function.  

Contest All the available contests in the program  

ContestInstance The contests which are shown in the contest dialog  

CTYDAT 
Country information like 'master' prefix, name, CQ and IARU 
zone, latitude, longitude etc.  

DXLOG QSOs from all the contests in the table ContestInstance  

Lookup (Function) keys, States, Provinces etc  

PacketSpots 
Packet spots for all the bands. Spots from this table are shown 
on the bandmaps  

PacketSpotsTest Test packet spots (for program development)  

Prefixes Prefixes recognized by the program with default country prefix  

SectionsWorked 
Information to show the section multipliers in the Multipliers 
window  

Settings Settings used by the program  

Station Station information i.e. call, name, address etc.  

ValidCalls Not used any more (empty) 

4. The "N1MM logger.ini" file 
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Everything in the "N1MM logger.ini" file should be settable through the program's User 
Interface. Defaults are in the file "Default Settings.txt" . An item will not appear in the 
"N1MM logger.ini" file if its value is the same as in the 'Default Settings.txt' file. Both files 
can be found in the program directory.  

 The "N1MM logger.ini" file is organized by function (top of file) and windows 
(bottom of file).  

 The function section's attributes can be deleted, and defaults will be used by the 
program.  

 The window section contains position and other window information. Generally 
these values should not be changed unless a window disappears.  

 Try to keep the file in this order, it will make things easier to find during 
discussions on the user group.  

 To comment out a value in the file precede it with a semicolon (;)  
 Removing the 'N1MM logger.ini' file will use the defaults in 'Default Settings.txt', 

the 'N1MM logger.ini' file will be recreated.  



4.1. Functions 
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Functions are the name for labels within square brackets that are inserted in an .ini file 
to make for easy readability. When manually editing an .ini file, it is good practice to put 
your new lines under the appropriate function heading.  

Possible functions are:  

[Com1] [Com2] [Com3] [Com4] [Com5] [Com6] [Com7]  

[Com8] [Lpt1] [Lpt2] [Lpt3] [MutiplierWindow] [SO2R/V] [Files]  

[Digital1] [Digital2] [MMTTY] 
[Function 
Keys] 

[Other] [Winkeyer] 
[Mode 
Control]  

[Antennas] 
[SO2R/V 
Setup] 

[Available] [Packet] [Configurer] [ConfigurerDialog]  

[CW 
Window] 

[Digital 
Interface] 

[Digital 
Interface 
Setup] 

[DigitalIO2] [EditContact] [EditLookupTable] 

 
Examples  

[Packet]  

Packet Tab=1 - Telnet window is selected, if removed the Packet tab is selected.  

[Configurer]  

Database Name=C:\Program Files\N1MM Logger\PI4GN-Maart-2004.mdb Selected 
database  

Contest Type=VHFREG1 Selected contest in the selected database  

Contest NR=1 Selected contest number in the selected database  

Recent Contest 1=VHFREG1:6-3-2004:C:\Program Files\N1MM Logger\PI4GN-Maart-
2004.mdb Most recent opened contest  

4.2. Window Section 
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Possible windows are:  

EntryWindow EntryWindow2  GraphicalBandMap 1  

GraphicalBandMap 
2  

InfoWindow Log LogTypeSelectionDialog  MultsByBand  

PacketWindow PSKEngine  ScoreSummary StationDialog  

SuperCheckPartial AvailableMultsAndQs BandMap 

http://n1mmplus.hamdocs.com/EntryWindow
http://n1mmplus.hamdocs.com/EntryWindow2
http://n1mmplus.hamdocs.com/GraphicalBandMap%201
http://n1mmplus.hamdocs.com/GraphicalBandMap%202
http://n1mmplus.hamdocs.com/GraphicalBandMap%202
http://n1mmplus.hamdocs.com/InfoWindow
http://n1mmplus.hamdocs.com/Log
http://n1mmplus.hamdocs.com/LogTypeSelectionDialog
http://n1mmplus.hamdocs.com/MultsByBand
http://n1mmplus.hamdocs.com/PacketWindow
http://n1mmplus.hamdocs.com/PSKEngine
http://n1mmplus.hamdocs.com/ScoreSummary
http://n1mmplus.hamdocs.com/StationDialog
http://n1mmplus.hamdocs.com/SuperCheckPartial
http://n1mmplus.hamdocs.com/AvailableMultsAndQs
http://n1mmplus.hamdocs.com/BandMap


 
Examples  

[EntryWindow]  

Top=3825  

Left=2985  

Height=3330  

Width=5370  

[PacketWindow]  

WindowState=0 Window is open (default) or closed (0), the Entry window can not be 
closed  

Top=9000  

Left=3270  

Height=2550  

Width=12105  

Telnet Port=K1TTT.NET The selected telnet cluster from the list. Specific for this 
section.  

[BandMap]  

CW Wide - 1=*RMF400CW Narrow - 1=*RMF250  

[InfoWindow]  

WWVMessagesVisible=False ''WWV messages are not shown in the Info window  
Configuration files''  

After installation the files below are stored in the N1MM logger program directory.  

5. Program files 
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Never delete these (program) files!  

 arrow.bmp - arrow icon used in the bandmaps (non active bandmap)  
 ClearRegistry.bat - used to clear the contents of the registry used by the program 

(obsolete since version 4, can be deleted from the directory).  
 cty.dat - the default country file name used when the menu item 'Tools /Import 

country list from downloaded file' is selected.  
 CW IF.exe - this is the Active X component which generates the CW.  
 cyanarrow.bmp - arrow icon used in the bandmaps (active bandmap).  
 Default Settings.txt - the default settings for the program, differences are in 

N1MM Logger.ini.  



 dirswap.BAT - rename wav file directory (example).  
 empty.wav - file used to stop sending a wav file.  
 led_Red.bmp - icon used when a message is shown which needs attention.  
 master.dta - file used by the Check window with calls from many contesters.  
 N1MMLoggerHelp.chm - windows help file (shown when pressing Alt+H).  
 N1MM Logger.exe - the N1MM logger contest program.  
 N1MM logger.ini - configuration file for functions and windows. Be careful when 

editing.  
 N1MM logger.ini.init - configuration file from the NewExe file. Will be renamed to 

N1MM Logger.ini if not found.  
 N1MMlogger.pdf - the manual which is shown when selecting 'Help / Manual'.  
 N1mmWave.ocx - ocx used for recording and playing wav files.  
 reddot.gif - icon used when a warning message is shown in the Entry window 

pane.  
 RevisionHistory.htm - N1MM Logger Revision History overview.  
 *.sec - text files used for different contest (example: SAC.sec, REF.sec etc).  
 style.css - style sheet ued in the file 'RevisionHistory.htm'.  
 ST6UNST.LOG - file used by Windows when removing this program from your 

hard disk.  
 Suncalcs.dll - dll used by the program.  
 Update Log.wri - overview from the last program changes and updates. 

(obsolete, can be deleted from the directory).  
 Upgrade.bat - file to register CW IF.exe to Windows (normally automatically done 

by the program).  
 *.init - files used during installing which can be deleted but we recommend to 

leave them in.  

6. Database files 
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 ham.mdb - default database file (don't delete).  
 new.mdb - default database file used when a new database is created by the 

user (don't delete).  
 *. MDB - database files made when selecting 'File / New Database'.  

Deleting this file means losing all the contest QSOs in it. It's good practice to make a 
new file every (major) contest and name it after the contest. Example: PACC2002.MDB  

7. Files created on your command: 
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 <YOURCALL>.ADI - ADIF file made by the program when selecting 'File / Export 
/ Export ADIF to file...'  

 <YOURCALL>.LOG - Cabrillo file made by the program when selecting 'File / 
Export / Export Cabrillo to file...'  



 <YOURCALL>.SUM - Summary Sheet made by the program when selecting 'File 
/ Export / Print Score Summary to File'  

 <YOURCALL>.TXT - Log file made by the program when selecting 'File / Export / 
Export to File (Generic)...'  

 *.MC - Exported Function key files.  
 *.TXT - Exported other files (example: Packet/Telnet buttons)  

8. RTTY files 
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MMTTY files are not in the program installation package and should be downloaded 
separately when needed.  

 MMTTY.exe - the MMTTY program  
 MMTTY.ini - MMTTY configuration file  
 MMTTY.* - other files used by the MMTTY program  
 XMMT.ocx - needed file for MMTTY.exe  
 Settings.txt - example file for the AEA PK-232 external controller  
 UserPara.ini - MMTTY program settings  

9. PSK and other modes 

old-edit  

The MMVARI engine is used for most digital modes which is included in the N1MM 
installer. There is no need to download the MMVARI package for use with N1MM 
logger.  

 MMVARI.ocx - the MMVARI engine  
 Varicode.tbl - table used by the MMVARI engine  

10. PSKCore files (all obsolete) 
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All PSKCore files below are obsolete and not required for use with N1MM logger 
anymore.  

 PSKCore.dll (obsolete, can be deleted from the directory)  
 XMMT.ocx (obsolete, can be deleted from the directory)  
 PSK63.dll (obsolete, can be deleted from the directory)  
 WINPSKX.dll (obsolete, can be deleted from the directory)  
 PSK.pal - color setting file for the WINPSK dll (obsolete, can be deleted from the 

directory)  
 WINPSKX.oca - WINPSK support file (obsolete, can be deleted from the 

directory)  



11. ADIF fields 
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N1MM logger complies with the latest ADIF standard. However in the N1MM logger 
database there is more information stored then we can export (and import) using ADIF. 
That is why a few N1MM logger specific tags have been added so when exporting an 
ADIF file and importing it again all information from the DXLOG table will be available. A 
rescore will update the fields not imported and to get the score and multipliers shown 
correct on the screen.  

APP_N1MM_EXCHANGE1 - content of the Exchange1 field from the table DXLOG 
table.  
APP_N1MM_POINTS - content of the Points field from the table DXLOG table.  
APP_N1MM_RADIO_NR - content of the RadioNr field from the table DXLOG table.  
APP_N1MM_MISCTEXT - content of the MiscText field from the table DXLOG table.  
APP_N1MM_CONTINENT - content of the Continent field from the table DXLOG table.  
APP_N1MM_CONTACTTYPE - content of the ContactType field from the DXLOG table.  
APP_N1MM_RUN1RUN2:1 - content of the Run field from the DXLOG table.is the 
Run1/Run2 tag. 1 means radio 1 was the Run radio, 2 means radio 2 was the Run 
radio.  

12. Callsign checking in the Digital Interface 
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Below describes how callsign checking is done in the Digital Interface windows.  

It first checks to see if the callsign is of the right length (More than 2 less than 11). It 
then checks to see if someplace in the first 6 characters there is a number. 3rd it checks 
to see if there are no invalid characters in it. Then if it all that passes it goes through the 
Busted Call Checker. If the Busted Call Checker returns an Error message then the call 
is invalid. Anything else from the Busted Call Checker makes it a valid call.  

As text comes into the Receive screen of the Digital Interface it gets printed to the 
window and placed in a temp buffer. When a space or a CR or LF is encountered the 
program will send the text in the temp buffer to the check callsign routines. Iif it comes 
back as a valid callsign it is sent to another routine that looks back thru the last 25 
characters of the Receive screen and colors them accordingly. At the time the space is 
encountered the temp holding buffer is cleared and things get sent there all over again. 
The whole process above takes just over a millisecond to complete.  

Unlike other software DE before the call is not required,it looks for space mostly after 
callsign.  

Take a look at this sequence it explains how it picks up callsigns in the RX window:  

A QWSCFGTWA5TTT WA5TTT UR 599 XXXXXXXXXX  

The program sees the space between the TTT and the WA so it looks into its previous 
holding buffer which contains "QWSCFGTWA5TTT" that string does not equal a valid 



callsign even though there is one in it. So because it encountered the space the buffer 
is cleared and the next string starts being placed into it. When it hits the third space it 
goes back and checks the buffer again this time it finds WA5TTT and it says it is a valid 
call. The program now looks back 25 characters and any time it finds WA5TTT it will 
color it accordingly and also place it in the grab window.  

As for the clicking on callsigns it follows the same rule except there is a routine that 
looks to see the characters that are under the mouse. If it is a valid call then it gets sent 
through the routines to place it in the entry window. There is a ltrs/figs line of text that 
shows the actual text that is being converted. This will give you an idea of what text is 
getting selected etc.  

Problems will happen if the rules change in various countries and the rules in the 
Busted Call Checker can't keep up with the country changes so you get callsigns that do 
not come out of it OK. The main reason to add the Busted Call Checker routines in 
there is to cut down on a lot of garbage that would be getting colored that passed all of 
the check routines but were not really callsigns  

13. Routers and Firewalls 
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A router provides your principal defense against the wild, wooly Internet. Everyone who 
connects to a broadband Internet service should only do so through a router.  

A software firewall (like the Windows XP firewall, Zone Alarm, etc.) provides protection 
from the other computers behind your router. It's probably okay to turn off the Windows 
Firewall in a contest station.  

Routers provide an important function called network address translation (NAT). If you 
look at your computer's IP address and see 192.168.x.y (or 10.x.y.z), then you're 
golden. The 192.168.x.y (and 10.x.y.z) address ranges are defined as local only and 
cannot be routeable across the Internet. If your PC has one of these addresses, it's as if 
you're behind a telephone switchboard and do not have a direct dial number. That's a 
good defense.  

Software firewalls protect you from other computers behind your router. So if you take 
your laptop around with you and use various wireless networks, you absolutely need a 
software firewall. The other computers at Starbucks may be full of viruses, and you 
need a software firewall to protect you from them. Also, if you have a computer in your 
house that may be used for some less-than-safe surfing, you should have a software 
firewall. Kids may have permitted access for online gaming, peer-to-peer file sharing, or 
may have downloaded software that has spyware, etc. Protect your PC by running a 
software firewall. Finally, if you have a wireless network, make sure you control who 
access it. If your neighbor can access your network and has a bunch of malware on his 
machine, your machines could get infected, too.  

Robert K5PI.  

13.1. Adding N1MM to the Windows firewall 
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When you do not want to turn off the Windows Firewall you can leave your windows 
firewall on even though you are behind a router. Add N1MM to your exceptions list and 
better yet add the local subnet (usually 192.168.1.0 (255.255.255.0)) to the port 
exceptions.  

 

3.4 DX Clusters 
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 3.4 DX Clusters  

o 1. Overview  
o 2. Commands  

 2.1. SH/DX command set  

o 3. Filter and other examples/features  

 3.1. AR-cluster  
 3.2. CLX  
 3.3. DXSpider  
 3.4. Links  

o 4. Commands  

 4.1. SH/DX command set  

o 5. Filter and other examples/features  

 5.1. AR-cluster  
 5.2. CLX  
 5.3. DXSpider  

The information on this page should be the same for N1MM Logger+ as it was for 
N1MM Logger Classic. Any changes on this page are likely to be due to changes in the 
cluster software rather than in the Logger. However, this page has not been reviewed; 
to be done later.  

There are several types of DX clusters used during contests. Most of them have the 
same type of commands (SH/DX style by the original from AK1A).Below a summary of 
the most used DX cluster types with some sample commands how to use the DX 
cluster. For more information read the Help from the cluster you are using.  

There are several types of DX clusters used during contests. Most of them have the 
same type of commands (SH/DX style by the original from AK1A).Below a summary of 
the most used DX cluster types with some sample commands how to use the DX 
cluster. For more information read the Help from the cluster you are using.  

1. Overview 

old-edit  



 

Cluster  
AR-
Cluster  

CLX  DXnet  DXSpider  Wincluster  Clusse  PacketCluster(tm) 

By (author)  AB5K  
DJ0ZY 
and 
DL6RAI  

F5MZN  G1TLH  KH2D  OH7LZB  AK1A 

Operating 
System  

Windows 
32 bits  

Linux  
Linux, 
Dos 
Windows  

Linux 
Windows  

Windows 
32 bits  

Dos  Dos 

Command 
Set  

SH/DX  SH/DX  SH/DX  SH/DX  SH/DX  Own  SH/DX 

Version 
used 
for 
overview  

 
5.04  4.3b9  1.51  2.3.8  1.0  not found 

Still 
supported  

Yes  Yes  Yes  Yes  Yes  No  No 

Freeware  $$$  Freeware  Freeware  Freeware  $$  Freeware  $$ 

Multilingual  ?  ?  Yes  Yes  No  Yes  ? 

Website  
Website

  

Website

  

Website

  

Website

  

Website

  

Website

  
No 

Help file  Web   Web   not found  

Web 
help  
PDF 
help  
from 
FRC  

not found  not found  not found 

Help on DX 
spots  

Web   Web   not found  Web   not found  not found  not found 

Help on 
Filters  

Web   

Web pg1

 
Web pg2

  

not found  

Web 
help  
PDF 
help  
by 
W3BG  

not found  not found  not found 

Command 
Reference  

Web   Web   not found  Web   not found  not found  not found 

2. Commands 

http://www.ab5k.net/
http://www.ab5k.net/
http://clx.muc.de/
http://clx.muc.de/
http://www.dxnet.free.fr/
http://www.dxnet.free.fr/
http://www.dxcluster.org/
http://www.dxcluster.org/
http://kh2d.net/software/wc/
http://kh2d.net/software/wc/
http://hes.iki.fi/clusse/
http://hes.iki.fi/clusse/
http://www.ab5k.net/ArcDocs/UserManual/ArcUserManual.htm
http://clx.muc.de/user/english/html/userman.html
http://www.dxcluster.org/main/usermanual_en.html
http://www.dxcluster.org/main/usermanual_en.html
http://www.gofrc.org/pdf/dxspider.pdf
http://www.gofrc.org/pdf/dxspider.pdf
http://www.ab5k.net/ArcDocs/UserManual/ArcDx.htm
http://clx.muc.de/user/english/html/userman.html
http://www.dxcluster.org/main/usermanual_en-4.html
http://www.ab5k.net/ArcDocs/UserManual/ArcFilters.htm
http://clx.muc.de/user/english/html/userman-12.html
http://clx.muc.de/user/english/html/userman-12.html
http://clx.muc.de/user/english/html/userman-13.html
http://clx.muc.de/user/english/html/userman-13.html
http://www.dxcluster.org/main/usermanual_en-10.html
http://www.dxcluster.org/main/usermanual_en-10.html
http://www.gofrc.org/pdf/Filter%20Primer.pdf
http://www.gofrc.org/pdf/Filter%20Primer.pdf
http://www.ab5k.net/ArcDocs/UserManual/ArcCmdSummary.htm
http://clx.muc.de/user/english/html/userman-20.html
http://www.dxcluster.org/main/usermanual_en-12.html
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Action  AR-Cluster  CLX  DXnet  DXSpider  Wincluster  Clusse 

General 
command set  

SH/DX  SH/DX  SH/DX  SH/DX  SH/DX  List 

Show users  SH/USERS  SH/USERS  SH/USERS  SH/USERS  SH/USERS  
 

Show WWV  SH/WWV  SH/WWV  SH/WWV  SH/WWV  SH/WWV  
 

Configuration 
network    

SHow/Conf  
   

Show Filters  show/filters  show/filters  SHow/Filter  show/filter  
  

Set Filter  set/filter [..]  set/filter 5  
    

Reset 
Specific Filter   

set/nofilter 1  
 

clear/spots 
1    

Reset All 
Filters  

set/nofilter  set/nofilter  SET/NOFilter  
clear/spots 
all    

Set number 
of lines to 0      

SET/PAGE 
0   

Show DX 
Spot 
Origination 
Filters  

 
SHOW/DXDEDX  

    

Enable DX 
Spot 
Origination 
Filter  

 
SET/DXDEDX  

    

Disable DX 
Spot 
Origination 
Filter  

 
SET/NODXDEDX  

    

Show other 
languages        

Set other 
language      

-  
 

Search the 
help 
database  

   
apropos 
<string>    

2.1. SH/DX command set 
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 SET/FILTER  
 SHow/Filter  
 SET/NOFilter  
 SET/DX_announcements  
 SET/NODx_announcements  
 SET/Announcements  
 SET/NOAnnouncements  
 SET/nodx - You do not get spots from the cluster but you can send them out on 

the network (i.e for SO unassisted stations)  

3. Filter and other examples/features 
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Setting band/mode type filters are not recommended as they will often block split 
frequency operations on the low bands.  

Filter examples AR-Cluster and DX-spider by the Yankee Clipper Contest Club
(YCCC).  

3.1. AR-cluster 
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For full details see: http://www.ab5k.net/ArcDocs/UserManual/ArcFilters.htm   

You only want stateside generated spots and announces? Use: set/filter k/pass  

set/filter k,ve/pass - You will only see DX spots from spotters in the United States (K) 
and Canada (VE). 
 
set/filter dxbm/reject vhf,uhf - VHF and UHF spots will be suppressed.  

Remove all filters with: set/nofilter 
 
Examine your settings with: show/filters  

3.2. CLX 
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For full details see: http://clx.muc.de/user/english/html/userman.html   

SET/FILTER <nr1,nr2,..,nrX> 
 
This command lets you set reject filters as defined by your sysop. You first should look 
up which filters are defined at your CLX node. This is the default list:  

Filter Meaning 
 
------------- 
 

http://www.yccc.org/
http://www.ab5k.net/ArcDocs/UserManual/ArcFilters.htm
http://clx.muc.de/user/english/html/userman.html


1 VHF 144.000 MHz and up 
 
2 HF 30.000 MHz and down 
 
3 TOP 1.800-2.000 MHz 
 
4 all the CW band segments 
 
5 all the SSB band segments 
 
6 all the RTTY band segments 
 
7 all the WARC bands 
 
------------- 
 
Your sysop may or may not have defined further filters. You can find out by using the 
SHOW/FILTERS command. After you have decided which filters you would like to 
switch in, you use the command as follows: SET/FILTER 4,6 
 
This turns on the CW and RTTY filters, so will leave you only with SSB spots. To further 
narrow the filter settings, you can add more filters: SET/FILTER 1,3 
 
The setting is now 1,3,4 and 6 which eliminates all spots except SSB spots on the HF 
bands from 80 to 10 meters, including the WARC bands.  

SET/DXDEDX and SET/NODXDEDX 
 
This command is used to turn off so-called Internet spots. DX spots originating from 
specific WAZ zones are not forwarded to you when you have issued a 
SET/NODXDEDX command. This flag is saved in your user record so you will only have 
to specify it once to turn these (for you) annoying messages of. The default is to send all 
DX spots.For example, your sysop could have defined zones 03, 04, 05 and 25 as DX 
zones. If you then turn on the NO-DX-de-DX filter, you will never again receive any 
spots from these areas although other users probably will. 
 
To look up, which zones were being defined as DX zones, use the command 
SHOW/DXDEDX.  
When you have previously disabled DX spots from other continents with 
SET/NODXDEDX, you can re-enable them with _SET/DXDEDX__.  

SET/DX_ANNOUNCE and SET/NODX_ANNOUNCE 
 
This command turns the reception of DX spots on or off. This could, for example be 
used if you were reading a lengthy message and did not want DX spots in between the 
lines. This command is permanent, it will enable or disable the sending of DX spots. To 
enable the sending of DX-spots use SET/DX_ANNOUNCE  



SET/LOGIN_ANNOUNCE 
 
Set to see user logins and logouts locally. For each login or logout, a message is sent to 
you from the system. On a busy node this will generate a lot of traffic. 
 
Login at 1929Z: DL6RAI 
 
Logout at 1930Z: DK2OY 

3.3. DXSpider 
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For full details see: http://www.dxcluster.org/main/usermanual.html  or download it 
as PDF file (from FRC) at: http://www.gofrc.org/pdf/dxspider.pdf   

A great PDF file on User Configurable Spot Filters in DXSpider by Jim Samuels - W3BG 
can be found at: http://www.gofrc.org/pdf/Filter Primer.pdf   

SET/USSTATE is a feature where the US STATE is automatically added before or 
behind the time field. The information is taken from the FCC database.  

The basic format for a spot filter is: 

accept/spots <pattern> 
reject/spots <pattern>  
 
As you can see, there are fundamentally two broad classes of filter... accept & reject. A 
different way of looking at them is: 
 
accept - bandpass filter, as in, "Pass these spots to me" 
 
reject - bandreject filters, as in, "I don't want to see spots like this"  

The <pattern> has many, many different combinations. For now, I'm going to address 
just two classes... "by" and "call". "By" means that the spot is "by someone" as in a spot 
"by k1xx" or "by a VE" or "by someone in Maine"  
 
The exact syntax is: 
 
by_zone - spotter in the CQ Zones, 1-40 
 
by_dxcc - spotter is a W or VE or F or G 
 
by_state - spotter is in ME, CT, RI, NH 
 
Remember, spots "by" means callsign of the station doing the spotting, the spotter.  

"Call" on the other hand refers to the call, zone, state of station being spotted, the 
spottee. The syntax here is: 

http://www.dxcluster.org/main/usermanual.html
http://www.gofrc.org/pdf/dxspider.pdf
http://www.gofrc.org/pdf/Filter%20Primer.pdf


 
call_zone - the spottee's zone 
 
call_dxcc - the spottee's country 
 
call_state - the spottee's state  

Now, on to some simple examples. 
 
accept/spots by_dxcc w,ve - spots only by W & VE stations 
 
accept/spots by_zone 5 - spots only by stations in Zone 5 
 
accept/spots by_state me - spots only by stations in Maine...slow weekend 
 
reject/spots call_dxcc G - I don't want to see G stations spotted 
 
reject/spots call_zone 14 - No spots of stations in Zone 14 
 
reject/spots call_state md - Please, no more spots of Maryland stations  

With the following command I only get spots with "RTTY" in the comment field. This is 
nice during RTTY contests. 
 
accept/spot 0 info rtty - Only show spots with "RTTY" in the comment field  

If you want to get rid of a filter, use: clear/spots all 
 
Spot filters remain on a DXSpider node until you clear them out. No need to re-enter the 
same filter each time you log in.  

Just a couple words about frequency. You can combine frequency on the same line as 
an accept/reject filter. For example: 
 
accept/spots by_dxcc w,ve and on 10m - only 10 meter spots by W & VEs 
 
reject/spots call_zone 25 and on 160m - I don't want more spots of JAs on 160 
meters  

3.4. Links 
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DX PacketCluster WebNet http://www.dxcluster.info/  
 
Webclusters and other useful information http://hamgallery.com/clusters/  
 
OH2AQ WebCluster (DX-Summit) http://oh2aq.kolumbus.com/dxs/   

http://www.dxcluster.info/
http://hamgallery.com/clusters/
http://oh2aq.kolumbus.com/dxs/


4. Commands 
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Action  AR-Cluster  CLX  DXnet  DXSpider  Wincluster  Clusse 

General 
command set  

SH/DX  SH/DX  SH/DX  SH/DX  SH/DX  List 

Show users  SH/USERS  SH/USERS  SH/USERS  SH/USERS  SH/USERS  
 

Show WWV  SH/WWV  SH/WWV  SH/WWV  SH/WWV  SH/WWV  
 

Configuration 
network    

SHow/Conf  
   

Show Filters  show/filters  show/filters  SHow/Filter  show/filter  
  

Set Filter  set/filter [..]  set/filter 5  
    

Reset 
Specific Filter   

set/nofilter 1  
 

clear/spots 
1    

Reset All 
Filters  

set/nofilter  set/nofilter  SET/NOFilter  
clear/spots 
all    

Set number 
of lines to 0      

SET/PAGE 
0   

Show DX 
Spot 
Origination 
Filters  

 
SHOW/DXDEDX  

    

Enable DX 
Spot 
Origination 
Filter  

 
SET/DXDEDX  

    

Disable DX 
Spot 
Origination 
Filter  

 
SET/NODXDEDX  

    

Show other 
languages        

Set other 
language      

-  
 

Search the 
help 
database  

   
apropos 
<string>    

4.1. SH/DX command set 
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 SET/FILTER  
 SHow/Filter  
 SET/NOFilter  
 SET/DX_announcements  
 SET/NODx_announcements  
 SET/Announcements  
 SET/NOAnnouncements  
 SET/nodx - You do not get spots from the cluster but you can send them out on 

the network (i.e for SO unassisted stations)  

5. Filter and other examples/features 
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Setting band/mode type filters are not recommended as they will often block split 
frequency operations on the low bands.  

Filter examples AR-Cluster and DX-spider by the Yankee Clipper Contest Club
(YCCC).  

5.1. AR-cluster 
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For full details see: http://www.ab5k.net/ArcDocs/UserManual/ArcFilters.htm   

You only want stateside generated spots and announces? Use: set/filter k/pass  

set/filter k,ve/pass - You will only see DX spots from spotters in the United States (K) 
and Canada (VE). 
 
set/filter dxbm/reject vhf,uhf - VHF and UHF spots will be suppressed.  

Remove all filters with: set/nofilter 
 
Examine your settings with: show/filters  

5.2. CLX 
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For full details see: http://clx.muc.de/user/english/html/userman.html   

SET/FILTER <nr1,nr2,..,nrX> 
 
This command lets you set reject filters as defined by your sysop. You first should look 
up which filters are defined at your CLX node. This is the default list:  

Filter Meaning 
 

http://www.yccc.org/
http://www.ab5k.net/ArcDocs/UserManual/ArcFilters.htm
http://clx.muc.de/user/english/html/userman.html


------------- 
 
1 VHF 144.000 MHz and up 
 
2 HF 30.000 MHz and down 
 
3 TOP 1.800-2.000 MHz 
 
4 all the CW band segments 
 
5 all the SSB band segments 
 
6 all the RTTY band segments 
 
7 all the WARC bands 
 
------------- 
 
Your sysop may or may not have defined further filters. You can find out by using the 
SHOW/FILTERS command. After you have decided which filters you would like to 
switch in, you use the command as follows: SET/FILTER 4,6 
 
This turns on the CW and RTTY filters, so will leave you only with SSB spots. To further 
narrow the filter settings, you can add more filters: SET/FILTER 1,3 
 
The setting is now 1,3,4 and 6 which eliminates all spots except SSB spots on the HF 
bands from 80 to 10 meters, including the WARC bands.  

SET/DXDEDX and SET/NODXDEDX 
 
This command is used to turn off so-called Internet spots. DX spots originating from 
specific WAZ zones are not forwarded to you when you have issued a 
SET/NODXDEDX command. This flag is saved in your user record so you will only have 
to specify it once to turn these (for you) annoying messages of. The default is to send all 
DX spots.For example, your sysop could have defined zones 03, 04, 05 and 25 as DX 
zones. If you then turn on the NO-DX-de-DX filter, you will never again receive any 
spots from these areas although other users probably will. 
 
To look up, which zones were being defined as DX zones, use the command 
SHOW/DXDEDX.  
When you have previously disabled DX spots from other continents with 
SET/NODXDEDX, you can re-enable them with _SET/DXDEDX__.  

SET/DX_ANNOUNCE and SET/NODX_ANNOUNCE 
 
This command turns the reception of DX spots on or off. This could, for example be 
used if you were reading a lengthy message and did not want DX spots in between the 



lines. This command is permanent, it will enable or disable the sending of DX spots. To 
enable the sending of DX-spots use SET/DX_ANNOUNCE  

SET/LOGIN_ANNOUNCE 
 
Set to see user logins and logouts locally. For each login or logout, a message is sent to 
you from the system. On a busy node this will generate a lot of traffic. 
 
Login at 1929Z: DL6RAI 
 
Logout at 1930Z: DK2OY 

5.3. DXSpider 
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For full details see: http://www.dxcluster.org/main/usermanual.html  or download it 
as PDF file (from FRC) at: http://www.gofrc.org/pdf/dxspider.pdf   

A great PDF file on User Configurable Spot Filters in DXSpider by Jim Samuels - W3BG 
can be found at: http://www.gofrc.org/pdf/Filter Primer.pdf   

SET/USSTATE is a feature where the US STATE is automatically added before or 
behind the time field. The information is taken from the FCC database.  

The basic format for a spot filter is: 

accept/spots <pattern> 
reject/spots <pattern>  
 
As you can see, there are fundamentally two broad classes of filter... accept & reject. A 
different way of looking at them is: 
 
accept - bandpass filter, as in, "Pass these spots to me" 
 
reject - bandreject filters, as in, "I don't want to see spots like this"  

The <pattern> has many, many different combinations. For now, I'm going to address 
just two classes... "by" and "call". "By" means that the spot is "by someone" as in a spot 
"by k1xx" or "by a VE" or "by someone in Maine"  
 
The exact syntax is: 
 
by_zone - spotter in the CQ Zones, 1-40 
 
by_dxcc - spotter is a W or VE or F or G 
 
by_state - spotter is in ME, CT, RI, NH 
 
Remember, spots "by" means callsign of the station doing the spotting, the spotter.  

http://www.dxcluster.org/main/usermanual.html
http://www.gofrc.org/pdf/dxspider.pdf
http://www.gofrc.org/pdf/Filter%20Primer.pdf


"Call" on the other hand refers to the call, zone, state of station being spotted, the 
spottee. The syntax here is: 
 
call_zone - the spottee's zone 
 
call_dxcc - the spottee's country 
 
call_state - the spottee's state  

Now, on to some simple examples. 
 
accept/spots by_dxcc w,ve - spots only by W & VE stations 
 
accept/spots by_zone 5 - spots only by stations in Zone 5 
 
accept/spots by_state me - spots only by stations in Maine...slow weekend 
 
reject/spots call_dxcc G - I don't want to see G stations spotted 
 
reject/spots call_zone 14 - No spots of stations in Zone 14 
 
reject/spots call_state md - Please, no more spots of Maryland stations  

With the following command I only get spots with "RTTY" in the comment field. This is 
nice during RTTY contests. 
 
accept/spot 0 info rtty - Only show spots with "RTTY" in the comment field  

If you want to get rid of a filter, use: clear/spots all 
 
Spot filters remain on a DXSpider node until you clear them out. No need to re-enter the 
same filter each time you log in.  

Just a couple words about frequency. You can combine frequency on the same line as 
an accept/reject filter. For example: 
 
accept/spots by_dxcc w,ve and on 10m - only 10 meter spots by W & VEs 
 
reject/spots call_zone 25 and on 160m - I don't want more spots of JAs on 160 
meters  

 

3.5 External UDP Broadcasts 

 3.5 External UDP Broadcasts  

o 1. Setting Up UDP Broadcasts  



 1.1. IsBroadcastAppInfo=True  
 1.2. IsBroadcastContact=True  
 1.3. IsBroadcastRadio=True  
 1.4. IsBroadcastAllQSOs=True  

o 2. Rotator Control  

External UDP broadcasts pass information from N1MM Logger+ about the contest in 
progress to various third-party software programs. UDP broadcasts stay in the same 
network (same subnet) and cannot be broadcast directly over the Internet.  

There are additional UDP broadcasts built into N1MM Logger+, which are sent by 
default, but (except as noted) they are not very useful for general users. One example is 
the real-time score reporting application.  

1. Setting Up UDP Broadcasts 

 
To enable external UDP broadcasts some lines need to be added manually to the 
N1MM Logger.ini file, which (unless you selected a custom directory at time of 
installation) is located in the user directory at c:\users\<login name>\My 
Documents\N1MM Logger+. You must close N1MM+ before editing its ini file. Use an 
external text editor, such as Notepad or Wordpad (there is no UI for this option). Do not 
use a word processing program, such as Microsoft Word.  

Begin by searching the ini file for the [ExternalBroadcast] header. Creating a second 
header will produce unpredictable results.  
If the INI file lacks an [ExternalBroadcast] section it must be added. An example is:  

[ExternalBroadcast]  
DestinationIPs=127.0.0.1 192.168.1.56  
DestinationPort=12060  
IsBroadcastAppInfo=True  
IsBroadcastContact=True  
IsBroadcastRadio=True  

Setting  Comment 

DestinationIPs=  

Start with IP address 127.0.0.1 (the pc you are running 
on) and add other PC's IP-addresses (space delimited). 
You can send to multiple IP addresses in the subnet by 
specifying 255 for the last octet. E.g. 192.168.1.255 will 
send to all computers that are in the 192.168.1 subnet. 
Do not specify 255 in the higher order octets, or you will 
risk broadcasting to the internet. While eventually the 
packets will be discarded by the internet, it will not endear 

http://n1mmplus.hamdocs.com/tiki-index.php?page=Third+Party+Software


Setting  Comment 

you to your ISP. 

DestinationPort=  The UDP port to use. Defaults to 12060 

IsBroadcastAppInfo=True  Broadcast Application Info. Defaults to False 

IsBroadcastContact=True  Broadcast Contact Info. Defaults to False 

IsBroadcastRadio=True  Broadcast Radio Info. Defaults to False 

IsBroadcastAllQSOs=True 
Broadcast all contact info from all stations on a network. 
Both this and IsBroadcastContact must be set True on 
Station 0 for the broadcast to be made. 

 
Optional External Broadcast statements allow different external broadcast types to be 
sent to different IP addresses, multiple IP addresses, and multiple port numbers. When 
these optional statements are added to the INI file, their settings override the settings 
for DestinationIPs and DestinationPort.  

Setting  Comment 

BroadcastRadioAddr= 
Addresses and port numbers for the broadcast radio 
external broadcast. 

BroadcastAppAddr= 
Addresses and port numbers for the broadcast application 
info external broadcast. 

BroadcastContactAddr= 
Addresses and port numbers for the broadcast contact 
external broadcast. 

BroadcastScoreAddr= 
Addresses and port numbers for the broadcast score 
external broadcast. 

BroadcastRotorAddr= 
Addresses and port numbers for broadcasting rotor 
activation commands. 

 
The format is:  
BroadcastXXXAddr=IPAddr1:port1 IPAddr2:port2 ...  

Example:  
BroadcastContactAddr=127.0.0.1:12060 192.168.1.100:12062  

If a Broadcast... field is not found in N1MM Logger.ini, the UDP broadcasts use the 
fields:  
DestinationIPs  
DestinationPort  

1.1. IsBroadcastAppInfo=True 



This code is broadcast on the DestinationPort (default: 12060) at the moment that the 
Contest Setup dialog is closed with OK, when IsBroadcastAppInfo=True in the 
[ExternalBroadcast] section of the N1MM logger.ini file.  

<?xml version="1 .0"?> 

      <appinfo> 

            <dbname>SampleLog.s3db</dbname> 

            <contestnr>71</contestnr> 

            <contestname>CQWWSSB</contestname> 

      </appinfo> 

1.2. IsBroadcastContact=True 

This code is broadcast on the DestinationPort (default: 12060) at the moment a qso is 
logged, when IsBroadcastContact=True in the [ExternalBroadcast] section of the 
N1MM logger.ini file.  

<?xml version="1.0"?> 

      <contactinfo> 

            <contestname>CQWWSSB</contestname> 

            <contestnr>71</contestnr> 

            <timestamp>22-6-2008 7:04:00</timestamp> 

            <mycall>PA1M</mycall> 

            <band>14</band> 



            <rxfreq>1420100</rxfreq> 

            <txfreq>1420100</txfreq> 

            <operator>PA1M</operator> 

            <mode>USB</mode> 

            <call>K1TTT</call> 

            <countryprefix>K</countryprefix> 

            <wpxprefix>K1</wpxprefix> 

            <stationprefix>PA1M</stationprefix> 

            <continent>NA</continent> 

            <snt>59</snt> 

            <sntnr>233</sntnr> 

            <rcv>59</rcv> 

            <rcvnr>123</rcvnr> 

            <gridsquare></gridsquare> 

            <exchange1></exchange1> 

            <section></section>. 

            <comment></comment> 

            <qth></qth> 



            <name></name> 

            <power></power> 

            <misctext></misctext> 

            <section>14</section> 

            <zone>5</zone> 

            <prec></prec> 

            <ck>0</ck> 

            <ismultiplier1>1</ismultiplier1> 

            <ismultiplier2>0</ismultiplier2> 

            <ismultiplier3>0</ismultiplier3> 

            <points>3</points> 

            <radionr>1</radionr> 

            <RoverLocation>GHM</RoverLocation> 

            <RadioInterfaced>1</RadioInterfaced> 

            <NetBiosName>CW-STATION</NetBiosName> 

            <IsRunQSO>0</IsRunQSO> 

      </contactinfo> 

1.3. IsBroadcastRadio=True 



This code is broadcast when IsBroadcastRadio=True in the [ExternalBroadcast] 
section of N1MM logger.ini, at the moment the frequency of the radio changes or every 
ten seconds if the VFO is stationary.  

<?xml version="1.0"?> 

   <RadioInfo> 

      <StationName>CW-STATION</StationName>    * 

      <RadioNr>2</RadioNr>    ** 

      <Freq>2120000</Freq> 

      <TXFreq>2120000</TXFreq> 

      <Mode>CW</Mode> 

      <OpCall>PA1M</OpCall> 

      <IsRunning>False</IsRunning> 

      <FocusEntry>hWnd</FocusEntry> 

      <Antenna>2</Antenna> 

      <Rotors>tribander</Rotors> 

      <FocusRadioNr>2</FocusRadioNr> 

   </RadioInfo> 

 
Note *: StationName is the Windows Computer Name and is only included when 
Network Mode is enabled  
Note **: RadioNr is the radio number when in SO2R or the VFO number when in SO1V 
or SO2V  



1.4. IsBroadcastAllQSOs=True 

This command is useful only in Networked Computer mode. When set True (together 
with IsBroadcastContact) at any station, that station will rebroadcast every contact that it 
receives to the UDP port specified. The XML format is the same as for 
IsBroadcastContact=True. Exercise caution when using this feature. Multiple, 
misconfigured stations with IsBroadcastAllQSOs=True could result in a circular network 
path.  

2. Rotator Control 

Broadcasts to operate the separate Rotator Control program are sent automatically 
when the user selects >Tools >Turn Rotor (alt+J), and do not require configuration 
settings or modifications to the N1MM Logger.ini file. The broadcasts are always sent 
on port 12040.  

The Entry Window >Tools >Turn Rotor command produces the following UDP message 
on UDP port 12040:  

<N1MMRotor> 

     <rotor>rotor name</rotor> 

     <goazi>55.0</goazi> 

     <offset>0.0</offset> 

     <bidirectional>0</bidirectional> 

     <freqband>14</freqband>   * 

</N1MMRotor> 

Note *:Examples of freqband encoding are 1.8, 3.5, 7, 14, 21, 28  

The Entry Window >Tools >Stop Rotor (ctrl+alt+J) command produces the following 
UDP message on UDP port 12040:  

<N1MMRotor> 

http://n1mmplus.hamdocs.com/tiki-index.php?page=Rotator+Control


      <stop> 

            <rotor>YaesuCom9</rotor> 

            <freqband>21.0</freqband> 

      </stop> 

</N1MMRotor> 

 
Rotor status update messages sent from the separate N1MM Rotor program on UDP 
port 13010 are in this format:  

rotorname@rotorheading  

 

3.6 Off Topic, But Nice to Know 
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o 1. RFI, Grounding, Shielding and All That  
o 2. Work Dupes or Not?  
o 3. Types of Operating  

 3.1. Running  
 3.2. Search and Pounce  
 3.3. The 'New' Packet Assisted S&amp;P Mode  

o 4. A QSO Speedup Tip (How is Your Typing Speed?)  
o 5. GMT is GMT, or Not?  
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This chapter gives general information about contesting coming from discussions on the 
N1MM Logger reflector. Should this be placed in a help/manual for a contest program? 
We don't know but as the title says: Off topic, but nice to know. We thank the authors for 
their approval so we could add this to the help/manual.  

1. RFI, Grounding, Shielding and All That 



As our radios, computers, and other peripheral equipment become more and more 
interconnected, it seems as if many calls for help on the reflector are traceable to 
system problems of this sort. RFI gets into computers, radio control, keyers, and other 
equipment. Equipment is needlessly damaged by EMP (electro-magnetic pulse) from 
lightning nearby. The list goes on.  

We can't solve these problems here. Following are two links to the extensive work of 
two experts in the field. Read, try and see for yourself.  

A Ham's Guide to RFI, Ferrites, Baluns, and Audio Interfacing  by Jim Brown, K9YC  

Common Mode Chokes  by Chuck Counselman, W1HIS  

2. Work Dupes or Not? 

In paper log days you used to get penalized for too many dupes that weren't marked as 
such in the log. I don't know of any contest that has ever penalized you for working too 
many dupes as long as you marked them in your log and didn't try to claim points for 
them.  

Its kind of ironic that the Cabrillo log format has no way to mark dupes, the sponsor's log 
processing software automatically rescores all the logs so you don't have to worry about 
even recognizing dupes or worrying about not claiming points for them.  

On your specific question. You log by2a but 6y2a properly logs on5zo... 6y2a would get 
credit because the log checking software would properly match up the one-off call by2a 
with their log entry of on5zo. If there really is a by2a and they send in a log you would 
lose credit for a confirmed not-in-log. If there is no such callsign as by2a issued you 
would lose credit and penalty and lose the multiplier (assuming you didn't work any 
other by) as a bad call. If there is a by2a but they didn't send in a log you might get to 
keep the credit if the log checking software and manual checkers don't recognize the 
busted call.  

Lets take it one step further. Say you really screwed up and logged by2et so the log 
checking software can't figure out that it was really 6y2a that you worked... now 6y2a 
loses qso credit and penalties for being not in the on5zo log. You may or may not lose 
credit as above based on the by2et log and callsign status.... now, later on you hear 
6y2a and call them again. If they recognize you are a dupe and come back 'qso b4' and 
refuse to work you, THEY LOSE! They will never get credit for on5zo and will lose the 
penalty points. If instead they ignore the dupe and work you again the original not-in-log 
doesn't matter as they are now in your log and everyone gets credit... so NOT logging 
the dupe is bad.  

The same holds for other combinations of them busting your call, or both of you busting 
each other, etc. It is always better to just log the dupe and move on. There is actually 
less of a chance you will get penalized if you work the dupe than if you don't.  

David Robbins, K1TTT 
 
e-mail: k1ttt@arrl.net 

http://audiosystemsgroup.com/RFI-Ham.pdf
http://www.yccc.org/Articles/W1HIS/CommonModeChokesW1HIS2006Apr06.pdf
mailto:k1ttt@arrl.net


 
web: http://www.k1ttt.net   

3. Types of Operating 

3.1. Running 

- In this mode you normally only want to only see new multipliers so the Check spot 
window serves well. You can set the filters to only see new multipliers so you can easily 
go grab them and get right back to your run frequency.  

3.2. Search and Pounce 

- The traditional S&P mode. In this mode you dial up the band checking each signal you 
hear. In this mode the bandmaps work well as they can help you quickly identify each 
station you hear and determine their status as a new QSO or multiplier or dupe.  

3.3. The 'New' Packet Assisted S&P Mode 

- In this mode you start at one end of the band and quickly go from spot to spot and 
work all the new stuff on a band. With today's high spotting rates you often find that 
almost every station you would hear doing the traditional S&P is already in the band 
map so for an operator in a hurry to work out a band and move on this could be very 
useful. Also for an operator working a 2nd VFO while still running, or running SO2R to 
tune one band while CQing on another one this could be useful as you typically have 
less time to spend figuring out who someone is and would rather have a screen full of 
new stuff than a screen full of dupes to tune through.  

David Robbins, K1TTT  

4. A QSO Speedup Tip (How is Your Typing Speed?) 

Being raised as a contester using CT, I was taught this trick (drill exercises on PED CT 
trainer, tnx to my contesting elmer ON5YR). By pressing "Insert" to send RST (CT uses 
"insert" to send call+RST).  

I type the prefix, copy suffix in head, start sending RST while typing the suffix. 
 
Saves a lot of time and the calling station does not have to wait that extra split second, 
as soon as his TRX goes from TX to RX, he hears me coming back to him already.  

So although I use ESM a lot, whenever I use this trick I still press "Insert", works FB!  

Try it, it works FB in combination with ESM.  

73 es CU in contest! 
 
Franki ON5ZO  

NB. N1MM logger can be set up to send call+rst when pressing 'Insert'.  

http://www.k1ttt.net/


5. GMT is GMT, or Not? 

Not quite. Some of Bill Gates' boys didn't know the difference between Greenwich Mean 
Time and the local time in Greenwich, England. In some versions of Windows, one of 
the choices for time zone is labeled (GMT) Greenwich Mean Time : Dublin, Edinburgh, 
Lisbon, London, but unfortunately, despite what the time zone list says this setting is 
NOT repeat NOT Greenwich Mean Time; it's local time in Greenwich (and Dublin, 
Edinburgh, Lisbon and London), which in the summer is daylight savings time, i.e. GMT 
+ 1:00 .  

There's an often published workaround. If you absolutely gotta put your computer on 
GMT because you're tired of resetting some old DOS software that doesn't know any 
better, you can set the computer for (GMT) Casablanca, Monrovia. Those places never 
go on daylight savings time, so their local time really is the same as GMT all year round, 
not like Greenwich.  

But you know what? If you're using Windows software like N1MM Logger, it's a lot 
easier to set your computer to your own local time zone and let the operating system 
take care of all that time zone and daylight savings time stuff automagically.  

73, Rich VE3IAY 

6. Which Monitor to Choose 

I have also been evaluating choices for more screen real estate. A couple of pointers 
that may be of interest.  

Once you get into the bifocal stage of life, pixel size ends up being as important as 
screen resolution, if not more-so. You will find that most 17" and 19" monitors are at 
1280 by 1024 resolution. The difference between 17" and 19" is not more real estate but 
the size of the pixels. Both 17" and 19" monitors will show the same number of pixels, 
but with the smaller pixels on the 17" monitor, you may end up having to increase font 
sizes to make the text readable, so you end up with less effective screen real estate. I 
recommend 19" over 17" monitors for this reason.  

As far as economics is concerned, the wide angle format monitors appear to generally 
be the best bang for your buck. But keep in mind that a widescreen 19" monitor which is 
1680 by 1050 resolution will have smaller pixels than a 19 inch 1280 * 1024 resolution 
monitor. If you are considering a widescreen monitor, make sure your video card can 
drive it. The video card in my almost two year old Dell box can't!  

Prices start to go up rapidly once you get into 1600 * 1200 resolution, which becomes 
available in the 20" and 21" sizes. At this size and bigger, there are also wide screen 
versions. Again, make sure the resolution is supported by your video card.  

Another thing to consider is whether or not you are going to be using an analog or 
digital interface. I find that driving a 1280 * 1024 monitor in analog mode gives very fine 
lines and makes text difficult to read. Using the same monitor with a digital interface 
usually gives better results. Microsoft's ClearType software also helps somewhat in this 
regard.  



To summarize, for our application, you want to look for displays with big (0.27mm) 
pixels. For me, that narrows the choices down to the following, in order of increasing 
cost/pixel for monitors:  

Two 19" 1280 * 1024 monitors 
 
One 20" or 21" 1600 * 1200 monitor 
 
One large 22" and up widescreen monitor  

Gerald Boutin, VE6WA  
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4.1 FAQ - Installing and Upgrading N1MM Logger 

 

 4. Frequently Asked Questions  
 4.1 FAQ - Installing and Upgrading N1MM Logger  

o 1. Should I upgrade each time there is an update announcement? Would it 
be more prudent to lag by a few months, as I commonly do with other 
software?  

o 2. Should I update every version, or is the latest update enough?  

http://n1mmplus.hamdocs.com/tiki-index.php?page=FAQ+-+Installing+or+Upgrading+N1MM&structure=N1MM+Logger+Documentation
http://n1mmplus.hamdocs.com/tiki-index.php?page=FAQ+-+Program+Features&structure=N1MM+Logger+Documentation
http://n1mmplus.hamdocs.com/tiki-index.php?page=FAQ+-+Digital+Modes&structure=N1MM+Logger+Documentation
http://n1mmplus.hamdocs.com/tiki-index.php?page=FAQ+-+Program+Errors+and+Requests&structure=N1MM+Logger+Documentation
http://n1mmplus.hamdocs.com/tiki-index.php?page=FAQ+-+Troubleshooting+Soundcard+Issues&structure=N1MM+Logger+Documentation
http://n1mmplus.hamdocs.com/tiki-index.php?page=FAQ+-+Other+Questions...&structure=N1MM+Logger+Documentation
http://n1mmplus.hamdocs.com/tiki-index.php?page=FAQ+-+Website+Questions+and+Answers&structure=N1MM+Logger+Documentation


o 3. Where can I get the latest master.scp and country files? How do I get 
them into the program?  

o 4. My security software detected a virus in an N1MM Logger download 
from the website. What should I do?  

1. Should I upgrade each time there is an update announcement? Would 

it be more prudent to lag by a few months, as I commonly do with other 

software? 

The N1MM Logger team has implemented the concept of "agile development." What 
this means, for the user, is that you should generally plan to use the latest release. 
Typically there is one each Tuesday. If you wait a day or two, and there is no uproar on 
the reflector, you should be fine, because hundreds, if not thousands, of people will 
have downloaded and tried it already. We have a firm policy of slowing down the pace 
of development before major contests, and avoiding risky changes that may have 
undesirable side-effects.  

Sometimes, a change published on Tuesday will be important for a contest on the 
coming weekend. Much less frequently, we hope, a change made in the latest release 
will cause a problem affecting the upcoming contest. If the change is important to 
successful use in that contest, we will make every effort to fix it in time for a re-release 
before the weekend. If it is not, the best strategy will be for you to revert to the last 
previous version.  

Typically, we keep at least 6 months' worth of prior versions in the "Latest Updates" 
under the Files menu of the web site. You can always re-install a last previous version, 
unless that is explicitly warned against - which is very rare. You need not be concerned 
about uninstalling.  

If you report a problem with an earlier release, our first response will likely be to ask you 
to install the latest version and test with that. Often, we will have fixed a problem, 
particularly one involving multipliers or scoring in a given contest, even before you 
report it.  

2. Should I update every version, or is the latest update enough? 

In almost all circumstances, it is fine to skip versions and only install the latest update 
before your planned contest operation. However, when a new Full Install has been 
released - which only happens rarely - you will need to go through the sequence of 
instal;ling the Full Install followed by the Latest Update.  

3. Where can I get the latest master.scp and country files? How do I get 

them into the program? 

The master.scp file(super check partial, by another name) is used in common by all 
major contest logging programs, and is updated shortly before major contests. The 
update will be announced on the N1MM Logger reflector and on CQ-Contest.  



This file comes in several different versions. You can download it from the author's web 
site . A good strategy is to download the zipped file containing all of the variants, and 
extract them into your C:\User\[[login]]\Documents\N1MM Logger+\SupportFiles 
directory. The master.scp file does not have to be uploaded to your database, but check 
the Associated Files tab in the Contest Setup dialog for the contest you plan to operate, 
to make sure that the correct master file will be used.  

The country file used by the program is WL_CTY.DAT which also needs to be put in the 
C:\User\[[login]]\Documents\N1MM Logger+\SupportFiles Directory. Updates are 
frequent and are announced on the N1MM Logger reflector. The CTY files are available 
from the author's web site . Once downloaded, the file must be loaded into the 
database using the Tools menu. If the WL_CTY file in the directory is newer than the 
one in your current database, you will be reminded of that each time the program starts. 
It takes only seconds to get up to date.  

4. My security software detected a virus in an N1MM Logger download 

from the website. What should I do? 

You should probably refresh your anti-virus definitions, ignore the warning, and/or get a 
new anti-virus package. Although it could happen some day, the N1MM Logger team 
uses a variety of anti-virus packages and has never inflicted a virus upon N1MM Logger 
users. Due to the fact that the software has frequent releases and makes calls on the 
Internet (telnet and web pages), it is not uncommon for anti-virus programs to report 
false positives. Before creating yet-another false virus scare on the reflector, we 
recommend that you test the file against the on-line scanning site 
http://www.virustotal.com/index.html  . If you receive a positive report from one anti-
virus product, you may be the first person to test that file (due to frequent releases of 
updates). Run the scan again and the positive report should clear.  

 

4.2 FAQ - Program Features 

old-edit  

 4.2 FAQ - Program Features  

o 1. When I tune close to a station in the bandmap, the call appears in the 
frame above the callsign field. Do I have to retype the call to enter it?  

o 2. Is there any way I can avoid having the tab key jump to fields (like RST) 
that don't normally need to be changed?  

o 3. Why Doesn't CQ repeat work on VFO B? I already set it on VFO A.  
o 4. In ESM mode, the cursor jumps to the report field after the first time you 

press Enter, but what if the station doesn't come back to you, and now the 
program is in the wrong state to call him again? How can I change this 
behavior?  

http://www.supercheckpartial.com/
http://www.supercheckpartial.com/
http://www.country-files.com/
http://www.virustotal.com/index.html


o 5. Can I customize the bands listed in the Available Mults and Qs 
("Available") window?  

o 6. How can I modify the bands that are used for general logging? Normally 
I am QRV from 160m up to 3 cm (10 GHz).  

o 7. The program just skipped a serial number (or sent a number out of 
order). Is this a problem?  

o 8. I started operating a serial number contest sending serial numbers by 
hand because the program wasn't incrementing. A little later I discovered 
that I hadn't entered "001" in the Sent Exchange. Now I'd like to re-start 
with my correct serial number and have it increment. How can I do that?  

o 9. When I change a callsign in mid-contact, the pre-filled exchange (if 
there is any) does not change. Is there a way to change this behavior?  

o 10. What will the program send when the exchange is a number? 
Sometimes, I don't get what I'm expecting.  

o 11. While sending CW my keying speed slowed but the display did not 
change. What is happening?  

o 12. I connect to packet, but no spots show up in the bandmaps. What's 
up?  

o 13. How do I spot stations?  
o 14. My friend wishes to use the same digital/SSB/cw button legends and 

contents as me. Is there a quick way of copying my buttons into his profile 
or do I need to re-type them in?  

o 15. There is a missing section, county, oblast, etc. or a missing 
abbreviation for a section. Can I add it?  

o 16. Is the score displayed anywhere?  
o 17. Is my Sunrise and Sunset shown anywhere?  
o 18. I'm sure the score shown by the program is not correct. What can I 

do?  
o 19. When I start the program it changes the mode on my transceiver. 

Sometimes it is correct for the contest, sometimes not. What can I do?  
o 20. How do you delete contests you don't want any more, such as those 

used for testing purposes?  
o 21. I added notes to some QSOs. How do I find them again?  
o 22. Why is offtime 31 minutes and not 30?  
o 23. What does it mean when a callsign is colored yellow in the Log 

window, or an exchange is green or red?  

These have not been changed from the FAQs for N1MM Logger Classic. Updating for 
N1MM Logger+ to be done later.  

 

1. When I tune close to a station in the bandmap, the call appears in the 

frame above the callsign field. Do I have to retype the call to enter it? 

old-edit  



No. If you press F4, or press Enter (in ESM mode), the call in the call-frame will be 
entered in the call-sign field and your call will be sent.  

2. Is there any way I can avoid having the tab key jump to fields (like 

RST) that don't normally need to be changed? 

old-edit  

Yes. Use the Space bar to jump from field to field, and it will skip the fields that normally 
do not need to be changed. Use the Tab key to stop at each field.  

3. Why Doesn't CQ repeat work on VFO B? I already set it on VFO A. 

old-edit  

CQ Repeat must be set on each VFO or radio independently. With the Entry focus on 
each VFO or radio, press Alt+R to toggle repeat mode on and off, and Ctrl+R to set the 
repeat interval. When repeat mode is set on a VFO, the letter "R" in white appears in 
the center of the red Transmit Focus LED.  

4. In ESM mode, the cursor jumps to the report field after the first time 

you press Enter, but what if the station doesn't come back to you, and 

now the program is in the wrong state to call him again? How can I 

change this behavior? 

old-edit  

If you don't usually get a station on the first call, go to the Config > Configure Ports, 
etc.> Function Keys tab, and un-check the so-called "Big Gun switch", titled "ESM only 
sends your call once in S&P, then ready to copy received exchange". .The cursor will 
then remain in the Callsign field, ready to send your call again the next time you press 
Enter. To go to the Exchange field, hit the Space bar.  

5. Can I customize the bands listed in the Available Mults and Qs 

("Available") window? 

old-edit  

Appropriate band buttons will appear in the Available depending on which contest you 
select. WARC bands are only shown in the DX and DXSerial "contests", and VHF 
bands are shown when you select a VHF contest.  

6. How can I modify the bands that are used for general logging? 

Normally I am QRV from 160m up to 3 cm (10 GHz). 

old-edit  



If the program is connected to your radio, the program will track the radio's frequency. 
Alternatively, type the frequency in KHz in the call-sign field of the Entry window and 
press Enter.  

7. The program just skipped a serial number (or sent a number out of 

order). Is this a problem? 

old-edit  

In SO2V, SO2R and multi-op modes,serial numbers are reserved during the QSO 
sequence, before the number is actually transmitted. Because of this, it is possible for 
serial numbers to be skipped or sent out of order, if a number is reserved and not used 
immediately, or never used at all.  
Major contest sponsors (all sponsors of serial number contests, so far as we know) do 
not object. The important thing to them (and to you) is that the program will never send 
a serial number that differs from that which is logged.  

8. I started operating a serial number contest sending serial numbers by 

hand because the program wasn't incrementing. A little later I 

discovered that I hadn't entered "001" in the Sent Exchange. Now I'd 

like to re-start with my correct serial number and have it increment. 

How can I do that? 

old-edit  

In the Log window, select your last previous QSO. On the right-click menu, select Edit 
QSO and change the sent serial number to what it should be. Click Update, and when 
you enter the next QSO in the Entry window, you'll see the Sent Nr field increment 
properly.  

 

9. When I change a callsign in mid-contact, the pre-filled exchange (if 

there is any) does not change. Is there a way to change this behavior? 

old-edit  

Yes. Go to Config > Configure Ports, etc. and open the Other tab. At lower left, check 
the box labeled "Clear populated exchange on callsign change".  

10. What will the program send when the exchange is a number? 

Sometimes, I don't get what I'm expecting. 

old-edit  



There are two possibilities. Let's assume the last QSO you logged had QSO number 
133. If the Callsign field is filled with a call, the next number will be sent. Example: 599 
134. If the Callsign field is empty, the last number will be sent.  

The reason it is this way is that in our experience, before you have added a new 
callsign, you are most likely to be responding to a request for a fill from the last station 
you worked.  

11. While sending CW my keying speed slowed but the display did not 

change. What is happening? 

old-edit  

Check the message you are sending for "<" or ">" characters, which decrease or 
increase CW speed. If the number of these characters in a message is unbalanced (like 
<<<5NN>>), then the speed will either increase or decrease each time you send that 
message. Annoying, at best.  

12. I connect to packet, but no spots show up in the bandmaps. What's 

up? 

old-edit  

The first thing to check is the packet filters. There is some useful help for this on the 
right-click menu of the Bandmap, labeled "Why don't I see spots?  
In addition to filters set at the cluster node, N1MM Logger provides two primary tiers of 
filters. They are selectable from the Packet/Telnet right-click menu. In order to see any 
spots at all, you must first select at least one of the Allow HF, Allow WARC, or Allow 
VHF options.  

After spots pass through the first filter layer, additional optional filters may be applied to 
pass only spots from your own continent or country, from selected call areas, or certain 
contest mode(s).  

The use of the Digital mode filter requires that Digital sub-band frequencies be added 
with the  
Config > Change Digital Sub-bands window.  

Regardless of the filtering selections, the Bandmap frequency bar displays the three 
mode frequency ranges in different colors on every band. CW is blue, Digital is 
magenta, and SSB is black.  

This sub-window also displays your current filter settings, as in this sample:  

"The current user selections are:  
Spots are removed when older than 60 minutes.  
Allow VHF is not checked, No VHF spots allowed.  
Spots allowed from these call areas: K3 K4  
Filtering (removing) blacklisted spots is enabled for:  



EW1OP  
EW1SJ"  

If you do a SH/DX and nothing appears, check your program settings to ensure that the 
spots are not too old (Packet Spot Timeout, on the Bandmap right-click menu), and that 
your system clock is properly set, so that the correct GMT time is displayed at the top of 
the Log window.  

13. How do I spot stations? 

old-edit  

Spotting stations may be done from the Entry window. The station entered in the 
Callsign field will be spotted. If the Callsign field is empty, the last QSO with its correct 
frequency will be spotted.  

 Alt+P spots stations  
 Ctrl+P spots them with a comment  

If you wish, you can also check "Spot all S&P QSOs" on the Config menu. This will 
cause every S&P QSO to be spotted as soon as it is logged, provided someone else 
has not spotted it recently, on the same frequency,  

This setting is not "sticky" - that is, it will be unchecked every time you start the 
program, so that you will not accidentally be spotting all your S&P QSOs when you don't 
want to  

14. My friend wishes to use the same digital/SSB/cw button legends and 

contents as me. Is there a quick way of copying my buttons into his 

profile or do I need to re-type them in? 

old-edit  

First export your function keys. Select: >File >Export >Export Function keys to file, 
choose the mode you want, and save the .mc file in your program directory. Then send 
that file to your friend and have him put it in his program directory.  

At this point he can either import it into his current database by using File >Import 
>Import function keys, or he can change the relevant file on the Associated Files tab of 
his Contest Setup dialog, and that file will then be loaded into the database whenever 
that contest is selected.  

 

15. There is a missing section, county, oblast, etc. or a missing 

abbreviation for a section. Can I add it? 

old-edit  



Yes. For QSO parties, you can edit the county list from the Contest Setup dialog, by 
clicking the Edit Section List button if it appears. Most other national contest have 
various lists of multipliers. These can be updated by finding the correct list and editing it 
with any text editor, and then clicking the Import Section List button in the Contest Setup 
dialog. Finally, the list of ARRL sections and their recognized abbreviations can be 
edited from the  
Config Menu item labeled "Change Exchange Abbreviations."  

16. Is the score displayed anywhere? 

old-edit  

Yes, the right-most pane in the status line at the bottom of the Entry Window is the 
score. The middle pane shows QSOs and multipliers. For a more detailed score 
summary, open the Score Summary window from the Windows menu.  

17. Is my Sunrise and Sunset shown anywhere? 

old-edit  

No. However, we keep track of sunrise/sunset times of stations you might wish to work. 
On the Bandmap, a "sun" symbol appears next to the callsigns of stations that are close 
to local sunrise or sunset. Also, when you enter a callsign or prefix, you have the option 
of displaying that station's sunrise/sunset times in the Info window. Check its right-click 
window to enable that and other options  

18. I'm sure the score shown by the program is not correct. What can I 

do? 

old-edit  

Don't over-rate the importance of this. Most major contests now require your log in 
Cabrillo format, and the sponsors will be re-scoring your log anyway. If you want to try 
to get closer to what you think is correct, you can try "Rescore Current Contest" on the 
Tools menu after the contest. Before you do so, we urge you to back up the current 
database and put the backup in a safe place. Problems are unlikely, but you've invested 
a lot of effort in your contest log, so why take chances. Then run Rescore, which can 
take some time for a large log. That, plus the advisability of a backup, is why we don't 
recommend running Rescore during a contest.  

19. When I start the program it changes the mode on my transceiver. 

Sometimes it is correct for the contest, sometimes not. What can I do? 

old-edit  

Go to Config > Config Ports, etc and look on the Mode Control tab. Select "Use Radio 
Mode" - it's the default, and is intended to avoid such confusion. Use the other options 
only if you must, and only after a thorough reading of the relevant manual portions.  



20. How do you delete contests you don't want any more, such as those 

used for testing purposes? 

old-edit  

Each contest created in a database is what we call a contest "instance." There is no 
reason why you can't have a dozen ARRLDX instances in the same database, and the 
only reason to delete any test versions is neatness. That said, deleting a contest 
instance is simple. Go to File > Open Log in Database, and Open the Contest Setup 
dialog. In the drop-down list of contests in the database, click on one you want to delete. 
Now press the Delete key, and double-check in the pop-up confirmation box to make 
sure it is the one you meant to delete, before you click OK or hit Enter.  

21. I added notes to some QSOs. How do I find them again? 

old-edit  

You can select Notes on the View menu to review any notes you have entered.  

 

22. Why is offtime 31 minutes and not 30? 

old-edit  

Let's say you worked the following stations, at the indicated times: N2IC 21:20:59 
W5OV 21:50:01  
If you leave out the seconds, like Cabrillo does, then it looks like you were off for exactly 
30 minutes. However, a closer examination of the actual QSO times shows you have 
only taken a 29 minute, 2 second time-off. This is an example of "rubber clocking". And, 
yes, the log checkers have been this picky ! The CW and SSB NAQP log checker and 
the SS log checker will ding you if your log only shows a 30 minute time-off.  

73, Steve, N2IC  

23. What does it mean when a callsign is colored yellow in the Log 

window, or an exchange is green or red? 

 
Yellow simply means that the callsign was not found in the master.scp file. That color is 
the same as the highlight for ESM in the Function Keys area of the Entry window, and 
can be changed on the Config Menu by the Manage Skins, Colors and Fonts function. 
Red means that you worked the station before and he gave you a different exchange 
the first time. Green is special for CQWW, and means that the zone you logged is 
different from the one the call should be in, according to wl_cty.dat.  

 

 



4.3 FAQ - Digital Modes 

old-edit  

 4.3 FAQ - Digital Modes  

o 1. The callsign to grab already scrolled off the screen (RX window); how 
do I grab it now?  

o 2. In Digital contests the window "Available multipliers and QSOs" does 
not show any multipliers or QSOs. In Digital contests below the "Multiplier 
List box" no callsigns are shown.  

o 3. A message "lost sound" briefly appears in the MMTTY waterfall.  
o 4. Why do I have a long delay going from Transmit to Receive?  
o 5. The MMTTY RTTY Engine panel is always on top of the other windows.  
o 6. Strange things are happening on my 'slow' computer.  
o 7. When exiting the program an "Error" window pops up with "C:/Program 

Files/MMTTY/061010(*)&amp;&amp;%^%$%$@#".  
o 8. Digital Interface file not found error  
o 9. I am able to transmit PSK or RTTY with MMTTY but I do not see any 

received signals displayed on the waterfall or any other screen.  
o 10. The frequency readout does not match the incoming spots in the 

bandmap on my transceiver  
o 11. It appears that CRLF's are displayed as a block character rather than 

going to the next line.  
o 12. How can I make MMTTY/MMVARI remember my com port selection?  
o 13. Pressing a function key gives me a "wav file not found" error message  

These have not been changed from the FAQs for N1MM Logger Classic. Updating for 
N1MM Logger+ to be done later.  

1. The callsign to grab already scrolled off the screen (RX window); how 

do I grab it now? 

old-edit  

You can pause the RX screen by clicking on the green strip on the left edge. This will 
pause the input so you can scroll back to where you need to and click on the callsign. 
The green strip will turn yellow while the input is paused. To turn input to the window 
back on, click in the yellow strip and everything that was held waiting to be printed to the 
window will now be displayed in the window and normal processing will resume.  

2. In Digital contests the window "Available multipliers and QSOs" does 

not show any multipliers or QSOs. In Digital contests below the 

"Multiplier List box" no callsigns are shown. 

old-edit  



The Digital sub bands are not defined ('Config | Change Sub bands | Digital Sub 
Bands'). If they are not defined then nothing will show up in this window in a Digital 
contest.  

3. A message "lost sound" briefly appears in the MMTTY waterfall. 

old-edit  

Try to bring up the sound card buffers under Misc settings in the MMTTY setup or the 
combination of MMTTY and N1MM Logger may be too much for your processor.  

4. Why do I have a long delay going from Transmit to Receive? 

old-edit  

It could be there are several spaces after the {RX} and by reducing those to just one 
space (or none) , the drop out from TX to RX shoudl be almost instant. Evidently by 
putting several spaces after the RX it will cause a longer delay before dropping out.  

5. The MMTTY RTTY Engine panel is always on top of the other 

windows. 

old-edit  

This can be changed in the Digital Interface window setup (Setup>Settings, under the 
General/MMTTY Setup tab). If you don't want MMTTY to be always on top, uncheck the 
MMTTY Always on Top checkbox. There is also the ability to choose between Full-size 
(Normal) MMTTY window and Small window (no control panel or menu bar), or you can 
choose to have only the control panel or only the menu bar displayed in the MMTTY 
window.  

6. Strange things are happening on my 'slow' computer. 

old-edit  

Example: Occasionally, the RTTY receiver screen would flicker during reception. 
Reason: MMTTY requires a minimum of a 133 MHz processor that combined with the 
main logger which Tom sets as a minimum needed as a 500-800 MHz Pentium II/III 
computer with 128 MB memory and you could get strange things happening.  

7. When exiting the program an "Error" window pops up with 

"C:/Program Files/MMTTY/061010(*)&&%^%$%$@#". 

old-edit  

It seems that one of the saved logged files for MMTTY has become corrupt. Go to the 
directory that you have pointing to that contains MMTTY. Double click on the 
MMTTY.exe file and open it up in stand alone then click file and uncheck Log RX File. 
That will stop the file trying to be written to.. Go in to the the MMTTY directory and look 



for text file that looks like 06xxxx these are the files that were recorded while using 
MMTTY each indicating the date .I would delete them.  

73's Rick N2AMG  

8. Digital Interface file not found error 

old-edit  

If you are experiencing a file not found error when trying to load the digital interface 
please look and see that you have the following files in these locations:  

MMVARI.ocx This needs to be in the N1MM logger program directory  
MMTTY.exe This file needs to be in the directory where MMTTY has been installed, and 
which is pointed to by the Path in the Configurer under the Digital Modes tab  
MMTTY.ini This file should be in the directory where MMTTY has been installed. If not 
found, MMTTY will create it  
Userpara.ini This file should be in the directory where MMTTY has been installed. If not 
found, MMTTY will create it  

9. I am able to transmit PSK or RTTY with MMTTY but I do not see 

any received signals displayed on the waterfall or any other screen. 

old-edit  

Review your hookup. For starters, plug a jumper from your transceiver's "line out" to 
your soundcard microphone input...no interface required. If that works, then you have a 
problem interfacing. If it doesn't work it looks like a more fundamental problem, like the 
microphone input on the soundcard is not working. As a last resort, make sure you can 
receive PSK with another program.  

Maybe just the microphone input is deselected. Check the following in Windows:  
Open Control Panel, Open Multimedia, Click on Recording and make sure the 
microphone is selected and the slider not at the bottom..  

10. The frequency readout does not match the incoming spots in the 

bandmap on my transceiver 

old-edit  

In RTTY, it is the Mark frequency that is spotted and should be entered in your log. If 
you are using a transceiver with a dedicated RTTY mode (typically for FSK, and 
sometimes also for AFSK), the radio's dial displays the Mark frequency, and that is the 
frequency that should be spotted. However, if you are using a transceiver with no 
dedicated RTTY mode (e.g. with the radio in LSB or USB mode), the frequency readout 
on the radio will be the (suppressed) carrier frequency. This does not match the 
incoming spots in the bandmap, and the frequency will not be correct when spotting 
stations to the DX-cluster.  



To correct for the offset in LSB or USB mode, open the DI window's Digital Setup 
window (Setup>Settings) and check the Use Auto TRX Offset in DI1/2 check box for 
that DI window. If you are using a dedicated RTTY mode that displays the Mark 
frequency on the radio's dial, make sure this box is unchecked.  

If you use USB for PSK and FSK for RTTY, you may have to check this box when using 
PSK or other soundcard digital modes, and uncheck it when using FSK RTTY.  

11. It appears that CRLF's are displayed as a block character rather 

than going to the next line. 

old-edit  

There is a replacement richtext file on the website ('Download | Other files') that might 
correct seeing the block characters that represent a linefeed. This is why there are 2 
macros: {ENTER} and {ENTERLF}. Some Windows versions would not properly show a 
linefeed. If something scrolls off the screen because of the use of many linefeeds it is 
easy to click on the Pause strip and scroll back to see what was missed. One more click 
brings you back to where you were. There is also a checkbox in the Digital Setup 
window to "Remove Excess Linefeeds from RX Window" that helps prevent this.  

12. How can I make MMTTY/MMVARI remember my com port 

selection? 

old-edit  

In the Configurer (Config>Configure Ports, Telnet Address, Other menu item), under the 
Hardware tab (where you setup your radio, etc.) place a check in the Digital box for the 
desired com port. Click the Set button for that port. On the right side of the settings 
window there will be a box labelled Dig Wnd Nr. Set this to 1 for DI-1, or 2 for DI-2. This 
will automatically send the com port info to the selected digital engine whenever that DI 
window is opened.  

 

13. Pressing a function key gives me a "wav file not found" error 

message 

old-edit  

This may happen if you are using AFSK for RTTY, or in sound card modes like PSK31. 
It indicates that the program is in SSB mode rather than Digital mode (e.g. Mode 
Control is set to use radio mode and the radio mode is SSB in sound card digital 
operating modes). Type RTTY or PSK into the call sign box in the Entry window and 
press Enter to put the program into the requested digital mode - this should change the 
function key message set from SSB messages (containing the names of wav files) to 
digital messages (containing {TX} and {RX} macros).  



 

4.4 FAQ - Program Errors and Requests 

old-edit  

 4.4 FAQ - Program Errors and Requests  

o 1. Where can I download the program?  
o 2. Why is all the data is in a database?  
o 3. What is the best way to learn about the program?  
o 4. The program displays an error or just stops working. What should I do?  
o 5. The program gives an error opening the database. What should I do?  
o 6. What can I do if the contest I want to participate in is not listed?  
o 7. Errors and possible solutions <Obsolete>  
o 8. CW stutters (using lpt or serial port keying) or Voice keying stutters  
o 9. The radio locks up in transmit  
o 10. Suddenly Function Key F2 is sending my CQ, instead of F1. Why?  

These have not been changed from the FAQs for N1MM Logger Classic. Updating for 
N1MM Logger+ to be done later.  

1. Where can I download the program? 

old-edit  

Full instructions for downloading and installing the software can be found here.  

2. Why is all the data is in a database? 

old-edit  

Here is another reason why I put the data into Access. You can easily query the data 
and import into Microsoft Excel.  

If you have Excel, look in the data menu for the option "Get External Data". You will 
want to use "New Database Query". The database type to choose is "MS Access 
Database" and I would recommend leaving "Use the Query Wizard to create/edit 
queries" checked if you are not a programmer. This will display a list of databases. 
Navigate to your N1MM directory and choose the one you want. The table you want to 
look at is DXLOG. Press > to move that to the right hand column. Here is the tricky part. 
You need to select rows to be included. The column that filters that is ContestNR. You 
could also use ContestName, but if you have two contests witht the same name, you 
will have to filter some more. You could also filter with TS (timestamp) using greater 
than and less than. Choose your Sort by columns in the next window and continue. You 
will want to choose the option to return the data to Microsoft Excel. You now have the 
contest data in a spreadsheet.  

http://n1mmplus.hamdocs.com/tiki-index.php?page=Downloading+the+Software


The other way to get data into a spreadsheet is to open the contest log in the program, 
then right click on the log window. Choose "select all", then right click and choose 
Copy/Generic Print String. The data in the clipboard can be pasted into Excel, and the 
put into columns using Data/Text to Columns.  

73, Tom Wagner - N1MM  

Yet another way is simply to generate your Cabrillo file and then load it into Excel. The 
Cabrillo fields are fixed width, which makes it easy to get the data into the columns you 
want.  

3. What is the best way to learn about the program? 

old-edit  

 Read the Getting Started section of the manual. It takes you through the whole 
process from downloading the software to operating a first contest and 
generating your log file for submission. After that, you will probably want to 
known more about some areas. That's what the Digging Deeper section is for. 
You can look things up by window, or by the function you're interested in. Often, 
using the search function will give you what you need.  

 Print out the ((Key Assignments (Keyboard Shortcuts)|Key Assignments)) or the 
Key Assignments Short List? and keep it by your radio. Even long-time users will 
discover new keyboard shortcuts this way.  

 Set up your next contest well in advance. That will give you a chance to iron out 
any wrinkles in the contest setup. Maker some dummy QSOs before the contest. 
When it's time to go, you can either create a new instance of the contest or clear 
out your dummy QSDOs before "Zero Hour".  

 If you have problems and you can't find the answer, don;'t hesitate to ask on the 
N1MM Logger Plus reflector . That's what it is for. In addition to the N1MM 
Development Team, there are many experienced users there who will pitch in to 
get you going.  

4. The program displays an error or just stops working. What should I 

do? 

old-edit  

When the program displays an error or suddenly ends, this may be a bug in the 
program or a problem on your computer. Here are some hints on how to determine if it 
is a bug, what information to collect, and how to report it.  

 Try to record step-by-step what you were doing when it happened. Record the 
exact error message, if any. If the program just failed, make note of when and 
under what circumstances  

 Restart Windows, and then N1MM. Go back where you were when the problem 
happened. Particularly in cases where RFI is involved, Windows can easily 

http://n1mmplus.hamdocs.com/tiki-index.php?page=Getting+Started
http://n1mmplus.hamdocs.com/tiki-index.php?page=Digging+Deeper
http://n1mmplus.hamdocs.com/tiki-editpage.php?page=Key+Assignments+Short+List
http://n1mmplus.hamdocs.com/tiki-index.php?page=Supported+Contests
http://groups.yahoo.com/group/n1mmloggerplus


become corrupted. If your problems with RFI are particularly severe, try a 
complete cold restart of your computer.  

 After this, if you do the same thing again does it happen again?  
 Do not immediately re-install the program; this rarely solves anything. Instead, 

rename your N1MM Logger.ini file (N1MM Logger.old, for example) and re-start 
the program. This will create another minimal .ini file, eliminating any user-
selected options. Try the steps that caused the problem - does it still happen? 
Add back your radios, keying setup and other parts of your usual configuration, 
one by one.. Does the error recur? At what point?  

 If the problem still exists, submit a bug report and fill in the form completely. A 
majority of the bug reports we currently receive are not program bugs at all, but 
problems with the user's understanding of the problem or in a particular set-up. 
Going through the steps above will help you know which your problem is, and 
filling out the form completely will help us help you without a lot of back-and-forth 
to fill in important details.  

 If you need help with setup or how the program operates, you should refer to the 
manual, and if you don't find what you need, ask on the reflector. That's what it is 
for.  

5. The program gives an error opening the database. What should I do? 

old-edit  

This may mean that your database is corrupt. A first step is to try opening the program 
using another existing database (File >Open database). If the error only occurs with 
one database, then it is possible that the database has become corrupted.  
There are two approaches you can take:  

 Use N1MM Logger's File >Copy(and Compact) Database function to make a new 
database from your old one. This process opens the database, checks for many 
common errors, and fixes them.  

 If you can't do it this way - if, for example, the database won't open - then you 
should try the Microsoft Jetcomp  utility. Before using any utility like this, make 
a backup copy of the database. In extreme cases, we may be able to help 
you recover a database that just won't work, but not if you have lost it or 
damaged it further.  

6. What can I do if the contest I want to participate in is not listed? 
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 First, double-check the supported contests listing. If you have just been looking 
at the short contest names in the Contest Setup dialog, you may have 
overlooked the one you want.  

 NA3M has developed a User Defined Contest feature , and over 100 contest 
definitions have been created. They are stored here . Please note, though, that 

http://n1mmplus.hamdocs.com/tiki-index.php?page=TRACKER+-+N1MM+Logger+Bug+Report
http://support.microsoft.com/default.aspx?scid=kb;EN-US;q273956
http://n1mmplus.hamdocs.com/tiki-index.php?page=Supported+Contests
http://n1mmplus.hamdocs.com/tiki-index.php?page=Supported+Contests#User%20Defined%20Contests
http://n1mm.hamdocs.com/tiki-list_file_gallery.php?galleryId=18


while NA3M will try to help with these contests, the definition files were 
developed mainly by other hams, and we lack the resources to support them.  

 If you do not find the contest you want, you have two options:  
o Use the UDC editor to develop your own definition file. The process may 

seem intimidating at first, but there is real satisfaction in adding another 
contest to the USC roster, one that you programmed yourself. In the 
process, you'll learn a lot about what is involved in programming even the 
simplest contest so that all features of N1MM Logger operate correctly.  

o Request that we add the contest to the roster of supported contests. If you 
do this, be sure to give us several months' lead-time for coding and 
debugging, and plan on being available yourself to help us test. 
Depending on the level of user interest, we may well suggest that you go 
the UDC route instead; there simply isn't enough time for everything 
people would like us to do.  

 

7. Errors and possible solutions <Obsolete> 
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EntryWindow (Program_Initialize) - 3265 The database is corrupt. Select a new one or 
repair.  

Run time error 32555 "Radio number error" Corrupt / bad entries in N1MM logger.ini, 
select a 'clean' version.  

Run-time error - Automation error Windows 95 - This is mostly a problem with 
OLEAUT32.DLL. The version on the computer is to old for N1MM logger, replace it with 
a newer version. Use a version from Windows 98 or download VBRUN60SP6.EXE from 
the N1MM website ('Download | Other Files) or download it from the Microsoft 
Download center.  

Windows 98 - This is mostly a problem with OLEAUT32.DLL. The version on the 
computer is to new for N1MM logger (probably a XP version).  
1. Select Start -> Programs -> Accessories -> System Tools -> System Information  
2. Select Tools / System File Checker from the System Information menu bar,  
3. A dialog box appears, select "Extract one file from installation disk" and type 
OLEAUT32.DLL and click OK.  
4. Insert your Microsoft Windows 98 installation disk, verify the default locations of 
Windows directory and CD drive are correct, and click OK.  
5. The file will be replaced, and you will be prompted to restart the PC.  
NB The same procedure works for Windows 95.  

- Try using using a clean N1MM Logger.ini file. You will reset many of your configuration 
settings, but this often fixes the problem. Sometimes this has something to do with 
wrong configuration of ports.  



When upgrading I get 'Error 429' The 429 error is usually caused by having the wrong 
version of CW IF.exe in the directory where the logging program is installed. All the files 
in the NewexeV.x.xx.exe have to be installed in the program directory.  

Run Time error 339 - Component RICHTX32.OCX Install Richtx32.zip from the N1MM 
website ('Download | Other Files). Please read the instructions in the zip file.  

Error message" DLPORTIO.DLL missing Download Port95nt.exe, this is a port driver. A 
link to this file can be found in the installation section. To install just run the exe as the 
administrator of your computer.  

A Telnet Communications Error Occurred. Error: 10061 Connection is forcefully rejected 
The selected Telnet cluster declines your request to log in for some reason. Reasons 
could be:  
- The maximum number of users are already connected.  
- You are trying to telnet to the wrong port.  
- The firewall on your pc (like ZoneAlarm) or in your router is blocking the program  
- The DX cluster's software isn't working properly.  
- The DX cluster has just rebooted and it not yet ready for users.  
- bad dns from your router that is sending the requests to an internal machine that isn't 
set up for telnet.  

Runtime error 339 - Component N1MMWave.ocx or one of its dependencies not 
correctly registered: a file is missing or invalid Win98 (as opposed to win98se) doesn't 
have the proper version of a couple dll's like mfc42.dl/msvcrt.dll etc.  

A work around could be to install Internet Explorer 5, then upgrade to version 6, and 
maybe next to install Office 97 and if that doesn't fix it upgrade to Office 2000. One or 
the other of those would add those dll's as they are common ones used by most 
Microsoft products.  

Runtime error 4 - Opening recording device - flagging Record QSOs Configurer - Audio 
Tab: Select a lower bitrate for your soundcard. 8 or 16 bits will probably always work, 24 
is probably to high for the selected soundcard.  

Err 3 - Format not supported. Use PCM. This error message occurs when trying to play 
a Wav recording that was made with some other sound recorder that saves the file in a 
non supported Wav recordingformat. Try to record with: Ctrl+Shift+Fx (Fx is a 
functionkey like F1)  

429 - ActiveX component can't create object" and "91 - Object variable or With block 
variable not set" When running Windows Fundamentals for Legacy PCs (Windows FLP) 
you have to add and register "dao360.dll. This file does not exist at all on Windows FLP. 
See below in this FAQ how to fix this.  

__When creating a new database the error below occurs:  
HamTemp.mdb already exists, rename__ This happens because at some time in the 
past, something did happen during the create new database process that left a 
hamtemp.mdb file in the program directory. This is a temporary file needed during the 
database creation process but should be automatically removed when done. If it is 
already there, the database creation process fails.  



The solution is to use Windows explorer to locate and delete hamtemp.mdb from the 
N1MM logger program directory. After that creating a database from inside N1MM will 
work again.  

Err10 "playback fmt (format) not supported" The OCX used to play .wav files in N1MM 
only supports uncompressed, basic .wav recordings. There are a number of other 
CODECs out there that produce files it doesn't recognize which gives this error 
message. Try to record using N1MM logger or record using Windows Sound Recorder 
and its default CODEC.  

8. CW stutters (using lpt or serial port keying) or Voice keying stutters 
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Mostly this means your pc is too busy handling other stuff during transmit or is 
underpowered. This could be outside N1MM logger. What to do? Some 'tricks'.  

Try not to run other programs not needed for contesting.  
Try filtering spots at your packet cluster node so as to reduce the traffic that must be 
handled by N1MM logger.  
Set your telnet filters for the minimum number of spots consistent with your needs, 
particularly including only the current contest's mode and maybe only spots from areas 
near your own  
Zoom the bandmap in so that it covers only a relatively small frequency range around 
your current frequency.  
Limit the number of bands you try to cover with the Available Mults and Qs window's 
spot pane (for the band that the particular PC is on).  

9. The radio locks up in transmit 

old-edit  

This may result from an invalid PTT configuration.  

Do not use more than one method of PTT control at the same time. Having two 
methods active, while it may look like a "belt and suspenders" approach, is less reliable 
than using only one method. The two methods can interfere with one another in such a 
way that the radio gets hung up in transmit when it receives two "switch to RX" 
commands simultaneously.  
In particular, do not use "PTT via radio command" if you have another (hardware-
based) PTT method working and active.  
In digital modes, if you are able to do PTT from the main N1MM Logger program, do not 
also configure the digital engine (MMTTY or Fldigi) to do PTT; the only time you need to 
configure PTT in the digital engine is when you are not using any method of PTT control 
from N1MM Logger itself.  

Another possibility is having a PTT keying line connected to a serial port control line 
(DTR or RTS) and having that control line set to "Always On"; this will result in the radio 
locking up in transmit whenever the Logger is started up.  



10. Suddenly Function Key F2 is sending my CQ, instead of F1. Why? 
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N1MM Logger assigns messages to function keys based on their position in the table, 
not on how they are labeled. Hence, the first non-comment line (one that doesn't start 
with #)is Run F1, the 13th line is S&P F1, and so on. Moreover, you can insert 
comments in your function key file, and the program skips over them in deciding which 
message goes to which function key.  

The label you put on the function key button (the part to the left of the comma in each 
line) is strictly for the buttons in the Entry Window - it does not control which message 
goes to which key.  

Most likely you accidentally omitted a # or made some other typo in one of the lines in 
the file, causing the program to skip one. Try counting lines, or play safe by deleting all 
comment lines from your file. Also, make sure that each Fkey line has a comma before 
the start of the text to be sent.  

 

4.5 FAQ - Troubleshooting Soundcard Issues 
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 4.5 FAQ - Troubleshooting Soundcard Issues  

o 1. Step-by-step soundcard troubleshooting from Dave, K1TTT  
o 2. MMTTY Soundcard Alignment by Joe, W4TV  

 2.1. Calibration on Windows Vista or Windows 7  
 2.2. Calibration with Multiple Soundcards on Windows XP  

These have not been changed from the FAQs for N1MM Logger Classic. Updating for 
N1MM Logger+ to be done later.  

1. Step-by-step soundcard troubleshooting from Dave, K1TTT 
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0. Close Audacity, Winamp, and any other sound recording or playback programs you 
may have open.  
DO NOT OPEN THEM AGAIN DURING THIS PROCESS.  

1. There is apparently an interaction between the windows control panel and N1MM 
logger that I hadn't noticed before. The key is, select the default device with the 
windows control panel to the one you want windows to use... then don't change it. If you 
change it windows apparently renumbers the devices so the device index number that 
n1mm saves isn't valid any more. So if you ever change the windows default playback 



or recording devices you MUST go back into the n1mm configurer and reselect the 
cards AND ports if you use specific devices and not the 'default' card option.  

The same rule also applies to MMTTY setup if you have selected a device other than -1 
(default) in the Option/Setup/Misc tab.  

2. Start N1MM logger and go into the 'Configurer / Audio' tab. Select '1 zero or single 
card' in the top list, then 'default' in the first 'select device' list. Save that settings. Close 
N1MM logger.  

3. Plug your microphone directly into the mic input on the sound card, plug your headset 
directly into the speaker output.  

4. Open the windows volume control, on the playback controls that come up first set all 
the sliders to mid range, and un-mute everything. You may have to go into 
options/properties to check the box to let you see the microphone and other sound 
sources.  

5. In the volume control select options/properties, check the 'recording' box then make 
sure 'microphone' is checked in the list of controls. Do ok.  
Check the box to 'select' the microphone and set it's slider mid range. On the advanced 
microphone settings check the 'mic boost' box if you have one.  

6. Now, when you talk in your mic you should be able to hear yourself in the headset. If 
you can't then something is wrong with your hardware or drivers. Recheck volume and 
mute settings, check that the mic is plugged into the right spot, try a different mic, try 
different speakers, try playing other wave files using the sounds control panel app to 
make sure your headphones are working, get your 8 year old kid to help.  
DO NOT PASS THIS POINT UNTIL YOU CAN HEAR YOURSELF!  

7. Open the windows sound recorder, it is usually found in the 
accessories/entertainment, DO NOT open audacity, the tools that came with your sound 
card, or your other favorite tool... some of them play with the mixer settings and we don't 
want that now that they are set.  

8. Press the record button, say a couple words, then press the stop button. Press the 
play button and you should hear what you just said. If you didn't there is something 
wrong with your hardware or drivers. Check recording control settings, adjust volume, 
make sure the mic is selected as the recording source, get that 8 year old back to help 
again!  
DO NOT PASS THIS POINT UNTIL YOU CAN RECORD AND PLAY.  

9. Close the windows sound recorder.  
DO NOT PASS THIS POINT UNLESS YOU CAN HEAR YOURSELF IN 6 AND 8 
ABOVE.  
If those don't work then N1MM likely won't work and since n1mm is much more 
complicated it is harder to troubleshoot.  

10. Start n1mm. Put the radio on ssb, make sure the entry window title bar says either 
USB or LSB. If you don't have a radio connected type in 14000 and then USB.  



11. Right click on the f1 button. In the wav file column make sure it says "C:\Program 
Files\N1MM logger\wav\cq-1.wav"... if not, type that in (without the quotes of course). 
Press ok to save it.  

12. Watch the bottom of the entry window status bar. Press Ctrl+Shift+F1, status line 
should say 'recording started in C:\Program Files\N1MM logger\wav\cq-1.wav', if it 
doesn't then check the error message and see if that helps and NOW you can ask for 
more help on the reflector or direct to me, but don't change any settings or open another 
sound program or be prepared to go back through this again to make sure everything is 
set properly for the defaults.  

13. If you got the 'recording started' message say a few words and press Ctrl+Shift+F1 
again. Bottom of status bar should say 'recording saved in C:\Program Files\N1MM 
logger\wav\cq-1.wav'. If it gives an error message check out that or contact the reflector 
or me.  

14. Press f1. you should hear what you just recorded. If not, check the status bar for an 
error message and check that one or contact the reflector or me. Now, if all that worked 
it is up to you to figure out how to get the audio to/from your sound card through 
whatever adapters, sound blasters, cabling, to the radio... I can't help with that except in 
very specific cases. But at this point if 11,12,13 worked then you have a working n1mm 
logger recording and playback system. Find the C:\Program Files\N1MM logger\wav\cq-
1.wav file which should be under the n1mm logger installation folder and that is where 
to put other recordings, and the f1 line in the setup is how the other paths should look to 
the files. If you are going to do multi-op look up in the manual how to set up the macros 
to let each operator record their own voices separately.  

2. MMTTY Soundcard Alignment by Joe, W4TV 

old-edit  

2.1. Calibration on Windows Vista or Windows 7 

old-edit  

If you are using Vista or Windows 7, the operating system does not  
allow individual applications which share the sound card to set the  
sound card's sample rate. Instead the operating system's hardware  
abstraction layer (HAL) will *resample* the data stream (interpolate  
data values) to provide audio samples to the application at the rate  
the application requires.  

When the sound card's default format (Windows Control Panel, Sound,  
Recording Devices, <device>, Advanced) is 48000 and an application  
requests a sample rate that is not an integral divisor of the default  
sample rate the clock rate will not be exact - resulting in differences  
from transmit to receive.  

The default format for most "motherboard" or add-in cards (PCI/PCI-E)  
is set by their custom drivers (supplied by the manufacturer) and is  



generally 44,100 Hz (CD Quality). However, the default format for  
external (USB) sound cards is set to 48,000 Hz (DVD Quality) by the  
Microsoft driver built into he operating system.  

There are two solutions:  

1) Set the clock rate in MMTTY (and MMVARI) to 12,000 - this removes  
the offset (48000 Hz Receive, 44100 Hz transmit) between the sample  
rates.  

2) Reset the Windows "Default format" to 44100 Hz (CD Quality). This  
also removes the offset.  

Either solution will work if your only sound card digital program  
is MMTTY. If you use other software - particularly if you use  
multiple programs at the same time or switch between programs,  
changing the MMTTY/MMVARI sample rate to 12000 may be a better idea  
since there are some programs that use fixed 48000 Hz sample rates.  

2.2. Calibration with Multiple Soundcards on Windows XP 
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If you are running multiple soundcard applications, Windows XP will  
behave just like Vista/Win 7. That is, the *first* to open the sound  
card will set the sample rate and XP will then virtualize the sound  
card to the second and subsequent applications. If the first app  
uses 48 KHz, the remaining apps will get 48 KHz samples.  

The offset is because MMTTY/MMVARI/etc. think they are decoding the  
requested sample rate so they transmit at the assumed rate ... the  
calculations are off "by that much."  

73,  

... Joe, W4TV  

 

4.6 FAQ - Other Questions... 

 4.6 FAQ - Other Questions...  

o 1. How do I make a file to upload to LoTW?  
o 2. I Logged some QSOs in the wrong mode. How to find them?  
o 3. How can I best handle multiple contests the same weekend?  
o 4. I want to import an ADIF file (not generated by N1MM Logger), but find 

it does not import all the information I need, or imports it improperly. 
What's the solution?  

o 5. Why do so many people recommend using a Winkeyer with N1MM 
Logger, instead of serial or parallel port keying?  



o 6. I can't get the program to accept the exchange I received. What can I 
do?  

o 7. Why doesn't parallel port keying (or control of a band decoder or SO2R 
box) work?  

o 8. Shouldn't I set my logging computer to GMT(UTC) rather than local 
time?  

o 9. I have accidentally logged a contest using the wrong selection from the 
Contest Setup dialog. What can I do?  

o 10. How can I import my contest log into my general logging program?  
o 11. How can I transfer a single contest from one database to another?  
o 12. I am using a USB-to-serial port adapter to control my radio, but 

frequency display and control are erratic or stop altogether.  

These have not been changed from the FAQs for N1MM Logger Classic. Updating for 
N1MM Logger+ to be done later.  

1. How do I make a file to upload to LoTW? 

Generate an ADIF file (File >Export >ADIF) from within N1MM and then process it using 
the TQSL program. That program will generate an encrypted *.TQ8 file which is the 
format for uploading to LOTW.  

2. I Logged some QSOs in the wrong mode. How to find them? 

For some contest types, the mode is shown in the Log window. If it is not, right-click in 
the Log window and check the menu option called "Show Mode". An additional column 
containing the mode will show up in the Log window. To make finding the wrong-mode 
contacts easier, you can click on this column heading to sort the contacts in your log by 
mode. Once you have found and edited the contacts in question, you can click on the 
TS column heading to restore the log display to the normal date/time order, and/or 
uncheck the "Show Mode" right-click menu option to remove the mode column.  

3. How can I best handle multiple contests the same weekend? 

By Ted, W4NZ. If there are multiple QSO parties or contests that I want to work during 
the same weekend, I create a database for each QSO party or contest. And here's the 
key - name the database with the QSO party name, ie. CQP.mdb, PAQP.mdb, 
TnQP.mdb, etc. Then I build only the contest I want to work in the appropriate database. 
By doing this, when you open the menu, it will list the last 9 contests including the 
current one. Included in the listing is the name of the database that contains the contest 
log. Simply choose the listing with the database named for the contest you want to 
switch to and the proper log will be loaded. It only takes a few seconds to do this. When 
you select a new contest which is in its own database, the correct function key 
messages are automatically loaded with it.  



4. I want to import an ADIF file (not generated by N1MM Logger), but 

find it does not import all the information I need, or imports it 

improperly. What's the solution? 

Unfortunately, there is a lot of variation in ADIF file output, depending on the logging 
program. Here's what to do:  

Open the contest into which you want to import. Now log one or more imaginary 
contacts in that contest; if the contest has different exchanges from different categories 
of stations (e.g. HQ stations in IARU or W/VE vs. DX stations in ARRL 10), log an 
imaginary contact of each type. Export an ADIF file with those contacts. Now compare 
the ADIF tags in your file with the ones in the file you want to import. Make sure that the 
tags are the same as in N1MM Logger's ADIF output. If not, use a text editor to do a 
global search and replace to bring them into agreement. Also, make sure that the length 
modifiers in the ADIF tags are correct (i.e. in <tag:n>data, make sure that the number n 
is equal to the number of characters in the data in that record).  

A couple of things to look out for in particular: First, the Logger will look for a field 
tagged with the CONTEST_ID tag to ensure that the log you are importing is for the 
correct contest type (this is necessary to ensure that the exchange information is 
imported into the correct field(s) in the database). Make sure this field appears, in the 
same format, in the file you are importing. Second, for some contests N1MM Logger 
uses an ADIF field called APP_N1MM_EXCHANGE1 for part of the exchange. This field 
is not exported by other programs; you will have to figure out what goes into this field 
and insert it into each applicable record in the ADIF file. In some cases, you may find 
the same data in two fields in the ADIF file exported from the Logger. In these cases, 
you may have to duplicate the data in the file you wish to import so that it can be 
imported into both fields.  

After doing this, you can either delete the imaginary contacts from the contest before 
importing, or you can delete the entire imaginary contest and create a new empty 
contest of the correct type to import the ADIF file into. After importing the ADIF file, you 
should rescore the contest in N1MM Logger (Tools > Rescore Current Contest).  

The N1MM Logger database can not contain QSO's with identical time stamps. 
Therefore, it will not be possible to import the same ADIF file into the same database 
more than once. Simply open another database and contest prior to importing.  

5. Why do so many people recommend using a Winkeyer with N1MM 

Logger, instead of serial or parallel port keying? 

The Winkeyer offloads the process of generating CW, so that even older, slower 
computers can be used. It also provides CW and PTT for two radios, and the PTT 
functions in all modes. Finally, with Winkeyer you can interrupt stored CW messages 
with a simple touch of the paddle, which is all too often invaluable.  



6. I can't get the program to accept the exchange I received. What can I 

do? 

N1MM Logger checks the exchange in most contests against what it "expects." That, in 
turn, is dictated by the requirements of the contest - for example, in a serial number 
contest like WPX, it will not accept letters in the exchange field. In contests with defined 
lists of multipliers, you may be using an outdated list, or the other station may have sent 
it incorrectly.  
Either way, the most efficient solution is to hit Ctrl+Alt+Enter, which will "force" the 
program to log the exchange as received. A note window will pop up, and if you put 
something in there to flag it, you'll be able to find it easily after the contest.  

7. Why doesn't parallel port keying (or control of a band decoder or 

SO2R box) work? 

With parallel ports on the way out, those of us who choose to continue using them will 
often have to resort to after-market parallel port cards on the computer's PCI or PCIe 
bus. All too often, these port cards seem to use non-standard memory locations, so if 
your parallel port isn't working, you will need to check in Device Manager. Find the 
problem port, and check on its Resources tab. Typically you will see one or two memory 
ranges listed. Note the first number of the first memory range. Now go to Config 
>Configure Ports, etc., and on the hardware tab, click SET on the port. You'll see a 
place to enter the port address. If the one you see there (a default) differs from what you 
saw in Device Manager, change the address on the Hardware tab to match  

8. Shouldn't I set my logging computer to GMT(UTC) rather than local 

time? 

No. The program understands how to make the translation. It even does the transition to 
and from DST automatically if it happens in the middle of the contest. It's easiest to just 
tell your computer what time zone you are in, including whether or not it uses DST, and 
just set the computer to the correct local time. The software does the rest. This saves 
having to change the time when you want to do e-mail or other things that use local 
computer time.  

9. I have accidentally logged a contest using the wrong selection from the 

Contest Setup dialog. What can I do? 

It's not easy but it can be done. This example assumes that you logged CQWWSSB in 
the general DX "contest".  

 As with any operation that could potentially endanger the contents of your 
database, back up your database. Omit this step at your peril.  

 Export the log in ADIF format.  
 Create an instance of the correct contest and export a log with a couple of 

imaginary contacts, also in ADIF format.  



o If the correct contest has varying exchanges for different categories of 
stations (e.g. ARRL10, where W/VE/XE stations send state/province and 
DX stations send a serial number), make sure you include examples of 
both kinds of contacts.  

 Change all contest IDs in the entire ADIF file to match the contest type you wish 
to import into. For example, if the original log used the general DX log, each QSO 
record will contain the field <CONTEST_ID:2>DX . In order to import this into a 
CQWWSSB log, you will have to change all of these to <CONTEST_ID:9>CQ-
WW-SSB .  

 Edit the ADIF log of your misplaced contest so that it has the same set of tags as 
the imaginary log you exported. You want the fields in the edited log to use the 
same tags as the corresponding fields in the sample log. A text editor is the best 
tool for this.  

o The field type you are most likely to have problems with is the 
APP_N1MM_EXCHANGE1 field. This field is used for different purposes 
in different contest types; depending on the contest types you are 
exporting from and importing to, you may need to remove or add this field 
in the edited ADIF file.  

o There is a number included with each tag in an ADIF file. This number is a 
count of the number of characters in the field. If you change the field name 
without changing the data, don't change the number. On the other hand, if 
you change the actual data, make sure the new number is the correct 
character count for the new data.  

 Start a new CQWWSSB contest log in another N1MM+ database. The start date 
in the Contest Setup dialog does not matter, but you must do this in a different 
database, because the same contact (same datestamp) cannot exist in two 
contests in the same database.  

 Import the modified ADIF file into the new contest log.  
 Use the Tools > Rescore Current Contest menu item to update the score.  

10. How can I import my contest log into my general logging program? 

Export your contest log in ADIF. Compare the format (tags and lengths) with that which 
your general logger expects. Edit your exported file to match, if necessary, using a word 
processor .  

11. How can I transfer a single contest from one database to another? 

To copy a single contest from one database to another, you can either use the File > 
Copy This Contest to Another Database menu item, or you can:  

 Export the log (Export ADIF to file...).  
 Create an empty instance of the same contest (e.g., CQWWSSB)  
 Import the ADIF file (Import ADIF from file...)  



12. I am using a USB-to-serial port adapter to control my radio, but 

frequency display and control are erratic or stop altogether. 

Four things to check:  

 Make sure that your computer is not powering down its USB ports. You need to 
check both in the Control Panel, under Power Options, and in Device Manager, 
in the properties of each USB hub (generic and root), on their Power 
Management tabs.  

 If your USB-to-serial adapter is connected to a level converter which is in turn 
connected to a TTL-level input on the radio, and if that level converter is powered 
by one of the serial port control lines (DTR or RTS), make sure that or those 
control lines are set to Always On in the Configurer.  

 If you are using a radio that requires RTS/CTS handshaking on its serial port 
(e.g. most Kenwood radios), make sure that RTS on that port is set either to 
Always On or to Handshake.  

 If you are using an adapter which has a Prolific chipset, there are problems with 
Prolific drivers. At one time we suggested updating to the latest driver, but this is 
no longer the case, as a number of users have reported problems with the latest 
drivers that were resolved by switching to an older driver (specifically 3/12/2010 
version 3.3.11.152). If the problem persists, you may need to switch adapters. 
Some versions of the Prolific chipset and/or some versions of the drivers are not 
compatible with programs (like N1MM Logger) written in Visual Basic.  
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 4.7 FAQ - Website Questions and Answers  

o 1. Who operates the N1MM Logger Documentation website?  
o 2. Do I need an account to access the documents on this website?  
o 3. What is the advantage of registering and logging in to this website?  
o 4. Who maintains the contents of the documents on the website?  
o 5. This website is described as a wiki. What does that mean?  
o 6. I think I'd like to help. How do I volunteer?  

These have not been changed from the FAQs for N1MM Logger Classic. Updating for 
N1MM Logger+ to be done later.  

1. Who operates the N1MM Logger Documentation website? 

This website was built and is maintained by K8UT - Larry Gauthier. Inquiries regarding 
the operation of the website (website bugs, website features, website enhancements) 
should be directed to him.  



2. Do I need an account to access the documents on this website? 

No and Yes. Anonymous users can connect to the website and read or download all of 
the wiki website contents. However, you will need to register (free) in order to submit 
Bug Reports or Feature Requests.  

3. What is the advantage of registering and logging in to this website? 

Registered users will be able to submit Bug Reports or Feature Requests, and set 
preferences for various options. For example, registered users can be notified of 
changes to specific pages in the wiki via a Watch List feature. Registered users can 
also maintain a list of wiki Bookmarks - making navigation to frequently visited portions 
of the wiki very fast and easy.  

4. Who maintains the contents of the documents on the website? 

The contents of the Manuals are maintained by a group of volunteer Editors who 
contribute their time and efforts to the program. You can see the names of the most 
recent editors at the bottom of each section when viewing the manuals on-line.  

5. This website is described as a wiki. What does that mean? 

A wiki is a special kind of website designed to allow a community of editors to 
collaborate and write a single piece of work (a manual, in this case). Let's compare the 
wiki model to the encyclopedia model.  

Perhaps a door-to-door Encyclopedia Britannica salesman sold your parents a 
subscription to the encyclopedia. Each month, a new book - usually the next letter of the 
alphabet (A, B, C...) - arrived at your house. After 24 months you'd have the complete 
set. Each subsequent year you'd receive "updates" to information contained in the 
original series.  

A wiki is the exact opposite of an encyclopedia. Rather than an expensive, tightly 
controlled, slow method of dispersing information; a wiki is a free, open participation, 
fast process for making information available. The content in a wiki is contributed by 
dozens, hundreds, maybe even thousands of authors whose work is immediately 
available to web browsers worldwide. The Wikipedia wiki is an excellent example of the 
power of a wiki.  

6. I think I'd like to help. How do I volunteer? 

If you'd like to volunteer as an Editor, send an email to N4ZR, Pete Smith.  
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